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Introduction
The Dentrix Enterprise Reports Reference is designed to help your office get the most out of 
Dentrix Enterprise reporting.  Detailed explanations, along with sample screenshots, are provided 
to help your office learn why and when to use each report and how to read each report.

For additional help with Dentrix Enterprise reports, consult the Dentrix Enterprise User’s Guide, 
refer to the Dentrix Enterprise Help (in any module, from the Help menu, click Contents), or 
contact Technical Support at 1-800-459-8067.

How to Use this Book
Reports are listed alphabetically in this book.  If you do not know the name of a report, do not 
know which report contains the data you are looking for, or want to know the filters of each report, 
use the Table of Contents or one of the following indexes located at the end of the manual:

•	 Index by Report Name –  Lists all the reports alphabetically.

•	 Index by Symbol –  Categorizes reports by Quick Reference symbol.

•	 Index by When to Run a Report –  Groups reports by when it is recommended to run each 
report.

•	 Index by Module –  Groups reports by the Dentrix Enterprise modules from which you run each 
report.

•	 Index of Filters by Report – For each report, the available filters are listed.

•	 Index by Filter –  For each available filter, the reports that use that particular filter are listed.

•	 Index by Report Item –  Groups reports by the items found on each report.  The report items 
are arranged in categories to help you find the report items you are looking for.

How to Read this Book
After each report is introduced, a Quick Reference section summarizes why and when to run the 
report. In the Quick Reference section, you’ll find Quick Reference symbols that represent how your 
office can benefit from using the report.
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Quick Reference Symbols
Quick Reference Symbols represent how your office will benefit from a report.  Use the Quick 
Reference symbols and the “Index by Symbol” section (at the end of this manual) to help your 
office focus on specific aspects of the practice.

You will find the following Quick Reference symbols in this book:

Symbol Category Explanation

Patient Care Helps your practice provide patient care services.

Information
Gathers Dentrix Enterprise information together so that 
you can review it without opening multiple dialog boxes.

Financial Helps you track , monitor, or project financial data.

Production Helps you track, monitor, or project production.

Time Saves you time.

Tips for Understanding Dentrix Enterprise Reports
Procedure Date vs. Entry Date

Many Dentrix Enterprise reports can be run by Procedure Date or Entry Date.  Because the type 
of date by which you run a report can filter out desired data, it is essential that you understand the 
difference between these two options.

•	 Entry Date –  The actual date a procedure is entered.

•	 Procedure Date –  The date a procedure is completed.  Because  the clinical chart must always 
be accurate, this date can be back-dated.

Scenario:  You have to enter last Friday’s procedures on Monday.  The Entry Date would be 
Monday. The Procedure Date would be Friday.

Consequence: If you run a report, such as the Day Sheet, by Entry Date for Monday, the 
procedures would be included in the report. However, if you run the same report by Procedure 
Date, the procedures would not be included.

Additionally, if Friday was a previous month, the MTD totals would be affected by the option used 
to run the report.

Year-to-date vs. Month-to-date

Many Dentrix Enterprise reports include Year-to-date and Month-to-date totals.  It is important to 
understand how each total is calculated.

•	 Year-to-date –  The total amount since the start of the current year (January 1).

•	 Month-to-date –  The total amount since the start of the current month.

Note:  Month-to-date and Year-to-date values can be affected by whether a report is run by Entry 
Date or Procedure Date.



Dentrix Enterprise 11.0.2 Reports Reference

Dentrix Enterpris Reports    3

Dentrix Enterprise Reports



Dentrix Enterprise 11.0.2 Reports Reference
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Adjustment Summary Report
The Adjustment Summary Report displays adjustment totals by adjustment type.

Why:	 To assist in preparing tax documents (to view charity care and other tax 
deductible totals), and to view the amount of bad debt written off

When:	 Yearly and quarterly

Adjustment Summary
01/01/2018 - 04/05/2018 Procedure Date

Clinics: <ALL>
Providers: <ALL>

Billing Type: <ALL>
Adjustment Types: <ALL>

Page 1 of 1Report Date: 04/05/2018 Report Generated By: enterprise

Quantity Total Average PercentDescription

100.002 %100.0050.00+Debit Adjustment
-75.002 %51.72-37.50-Credit Adjustment
-70.004 %48.28-17.50-Professional Discount
332.003 %100.00110.67Finance Charge

7,951.004 %100.001,987.75Late Charge

Grand Totals
Total Credit Adjustments -145.006 -24.17
Total Debit Adjustments 100.002 50.00
Total Finance Charges 110.673 332.00
Total Late Charges 7,951.004 1,987.75

15 8,238.00Totals 549.20

DCBA

E
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How do I run the Adjustment Summary Report?
From the DXOne Reporting module, select Analysis, and then double-click Adjustment Summary. 
For additional details about running this report, see the “Adjustment Summary Report“ topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
A.	Quantity – The number of adjustments posted.

B.	 Total – The total dollar amount of adjustments.

C.	 Average – The average dollar amount of adjustments (Total / Quantity).

D.	Percent – The adjustment total divided by the combined total of all adjustments in the same 
category.

Note: There are four adjustment categories: credit adjustments, debit adjustments, finance 
charges, and late charges.

E.	 Grand Totals – The Grand Totals section includes the quantity, total, and average for all 
the credit adjustments, debit adjustments, finance charges, late charges, and totals (of all 
adjustments) on the report.
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Aging/Credit Balance Report
The Aging/Credit Balance Report lists guarantors with outstanding balances or credit balances, 
along with their contact information.

Why:	 To identify guarantors with outstanding balances so that they can be targeted for 
collections, or to view and/or contact guarantors with a credit balance

When:	 Monthly

AGING REPORT
Balance as of: 04/23/2018  Procedure Date

Last Payment Before: <ALL>
Balance Range: <ALL>

Guarantor Range: Abbott, James  - Farrer, Lisa
Days Past Due: 0 - <No Limit>

Clinics: <ALL>
Provider: <ALL>

Billing Types: <ALL>

Report Generated By: enterprise Page 1 of 1Report Date: 04/23/2018

Guarantor Name Phone BT
Last Pmt

Date
Last Pmt

Amt
Last Stmt

Date 0-30 31-60 91-12061-90 121-150 151-180
Sus
Cred

Ins
Est.

Guar
Portion BalanceOver 180

0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00             0.00          0.00           0.00 Abbott, James

397.00 0.00 230.00 4,516.00 1,302.64 0.00          118.40 0.00     1,772.00    4,792.04        6,564.04Brown, Mary

(404)555-5445      1

(404)555-1586      2    04/22/2018            125.00        04/03/2018        
- Tue - Jan 20,2018 -account note here

0.00 0.00 0.00 0.00 0.00 0.00 0.000.00 0.00Crosby, Brent R  0.00          0.00

0.00 0.00 0.00 0.00 0.00 0.00 -104.000.00 -104.00Cross, Jill T             116.00         0.00          0.00

0.00 0.00 0.00 0.00 0.00 0.00 0.00360.70 360.70Davis, Harmon J              83.70        0.00      360.70

0.00 0.00           0.00 0.00 0.00 0.00          208.00  0.00             0.00      208.00         208.00Edwards, John 24.00 24.00

0.00 0.00 0.00 0.00 0.00 0.00 0.000.00 0.00Edwards, Kelly      0.00          0.00

0.00 0.00 0.00 0.00 0.00 0.00 0.0092.00                    0.00         92.00         92.00 Farrer, Lisa

(919) 555-1432     1

(919) 555-3784     1     02/21/2018 

(919) 555-3781     1    11/29/2017 

(919) 555-3778     1     02/21/2018 

(919) 555-3775     1

(212) 555-3333     1     11/24/2017

7,120.74

0-30 Guar
Portion BalanceIns

Est.
Sus
CredOver 180151-180121-15091-12061-9031-60

TOTALS

PERCENT

397.00 0.00 230.00 4,516.00 1,302.64 0.00 779.10

%5.58 %0.00 %3.23 %63.42 %18.29 %0.00 %10.94

1,772.00

%76.58%24.89

5,452.74-104.00

%-1.46

A B

C
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AGING REPORT
Balance as of: 04/23/2018  Procedure Date

Last Payment Before: <ALL>
Balance Range: <ALL>

Guarantor Range: Abbott, Patricia  - Davis, Harmon Q 
Days Past Due: 0 - <No Limit>

Clinics: <ALL>
Provider: AMCCLURE, DDS1

Billing Types: <ALL>

Report Generated By: enterprise Page 1 of 1Report Date: 04/23/2018

Guarantor Name Phone BT
Last Pmt

Date
Last Pmt

Amt
Last Stmt

Date 0-30 31-60 91-12061-90 121-150 151-180
Ins
Est.

Guar
Portion BalanceOver 180

0.00 0.00  0.00          100.00 0.00              0.00 0.00 100.00AMCCLURE
0.00 0.00 0.00 100.00 0.00 0.00 0.00 1,772.00     4,792.04 100.00Abbott, Patricia            125.00         04/03/2018

326.00 0.00  230.00            22.00 0.00             0.00           252.00 830.00DDS1
326.00 0.00 230.00 22.00 0.00 0.00 0.00 1,772.00     4,792.04 578.00Brown, Mary            125.00                   04/03/2018

0.00 0.00 0.00 0.00 0.00 0.00 208.00 0.00        208.00 208.00Crosby, Brent G              24.00
0.00 0.00 0.00 0.00 0.00 0.00 44.00 0.00          92.00 44.00Davis, Harmon Q

(919)555-1586     2      04/22/2018

(919)555-1586     2      04/22/2018
(919)555-3778    1     02/21/2018 
(212)555-3333     1      11/24/2017 0.00

930.00

0-30 Guar
Portion BalanceIns

Est.Over 180151-180121-15091-12061-9031-60

TOTALS

PERCENT

326.00 0.00 230.00 122.00 0.00 0.00 252.00

%35.05 %0.00 %24.73 %13.12 %0.00 %0.00 %27.10 %1,062.80%381.08

3,544.00 9,884.08

D

AGING REPORT
Balance as of: 04/23/2018  Procedure Date

Last Payment Before: <ALL>
Balance Range: <ALL>

Guarantor Range: Abbott, Patricia  - Abbott, Patricia
Days Past Due: 0 - <No Limit>

Clinics: <ALL>
Provider: <ALL>

Billing Types: <ALL>

Report Generated By: enterprise Page 1 of 1Report Date: 04/23/2018

Guarantor Name Phone BT
Last Pmt

Date
Last Pmt

Amt
Last Stmt

Date 0-30 31-60 91-12061-90 121-150 151-180
Sus
Cred

Ins
Est.

Guar
Portion BalanceOver 180

0.00 230.00 4,516.00 1,302.64 0.00 38.40 0.00 6,484.04CENTRAL
0.00 230.00 4,516.00 1,302.64 0.00 0.0038.40 6,484.04Abbott, Patricia ()555-1586 2 1,772.00 4,792.0404/22/2018 125.00

397.00
04/03/2018 397.00

6,484.04

0-30 Guar
Portion BalanceIns

Est.
Sus
CredOver 180151-180121-15091-12061-9031-60

TOTALS

PERCENT

397.00 0.00 230.00 4,516.00 1,302.64 0.00 38.40

%6.12 %0.00 %3.55 %69.65 %20.09 %0.00 %0.59 %73.91%27.33

0.00

%0.00

1,772.00 4,792.04

E

How do I run the Aging/Credit Balance Report?
From the DXOne Reporting module, select Ledger, and then double-click Aging/Credit Balance. 
For additional details about running this report, see the “Aging/Credit Balance Report“ topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
The report can be grouped and subtotaled by provider. Or, the report can be grouped and 
subtotaled by clinic. The following information appears on the report:

A.	Guarantor Details – The name, phone number, billing type, last payment, and last statement of 
each guarantor.

B.	 Balances – The guarantor’s aged balances.

C.	 Totals – The combined totals of aged balances listed on the report. Use aged balance totals to 
quickly ensure the practice is current on collection efforts.

D.	By Provider – The guarantors and corresponding balances are shown for the provider, along 
with a subtotal for the provider.

E.	 By Clinic – The guarantors and corresponding balances are shown for the clinic, along with a 
subtotal for the clinic.
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Analysis Summary Report - Daily
The Analysis Summary - Daily Report lists transaction totals. This report includes much of the same 
information as the Day Sheet Report, but formats it in a way that helps you compare provider and/
or clinic totals for each day in a given date range.

Why:	 To review production totals and compare provider and/or clinic totals

When:	 Monthly

Analysis Summary - Daily
04/22/2018 - 04/29/2018 Entry Date

Clinics: <ALL>
Providers: <ALL>

Billing Type: <ALL>

Page 1 of 1Report Generated By: enterpriseReport Date: 04/29/2018

Charge
Adj

Finance
Charges

Net
ChangeCharges

Beginning 
Balance

Debit Initial 
Balances

Applied
Payments

Applied
Credit Adj

Applied Ins
Payments

Credit
Special Adj

Pats
Seen

Avg Prod 
Per Pat

Ending
Balance

Suspended 
Payments

Suspended 
Credit Adj

Suspended
Ins Payments

Credit
Initial Balances

Late 
Charges

Debit
Special Adj

Billed
to Ins

New
Pats

Avg Chrg 
Per Proc

OTH Applied
Payments

OTH Applied Ins
Payments

OTH Applied
Credit Adj

OTH Credit
Special Adj

OTH Credit
Initial Balances

04/22/2018
0.000.0010.00386.00 2 193.00 249.00249.000.00 0.00-148.00 0.00 -20.00
0.0021.000.00 0 64.330.000.00 0.00 0.00

0.00 0.00 0.00 0.00 0.00

04/23/2018
0.00332.000.003,376.56 10 337.66 11,618.5611,867.56249.00 0.00-20.00 0.00 0.00
0.007,930.000.00 3 281.380.000.00 0.00 0.00

0.00 0.00 0.00 0.00 0.00

04/24/2018
0.000.000.00105.00 1 105.00 105.0011,972.5611,867.56 0.000.00 0.00 0.00
0.000.00105.00 1 35.000.000.00 0.00 0.00

0.00 0.00 0.00 0.00 0.00

04/27/2018
0.000.000.00973.00 3 324.33 149.6012,122.1611,972.56 0.00-100.00 -698.40 0.00
0.000.00898.00 0 243.250.000.00 0.00 -25.00

0.00 0.00 0.00 0.00 0.00

GRAND TOTALS
10.00 332.00 30,062.20 12,122.16302.54164,840.56 -268.00 -20.00-698.400.0017,940.04 0.00

1,003.00 7,951.00 4 193.620.00 0.000.00 0.00 -25.00
0.00 0.00 0.00 0.000.00

A

B
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Analysis Summary - Daily
04/23/2018 - 04/29/2018 Entry Date

Clinics: CENTRAL
Providers: DDS1

Billing Type: <ALL>

Page 1 of 1Report Generated By: enterpriseReport Date: 04/29/2018

Pats
Seen

Avg Prod 
Per Pat

Ending
Balance

Net
Change

Applied
PaymentsCharges

Applied
Credit Adj

Applied Ins
Payments

Beginning
Balance

Charge
Adj

Finance
Charges

Debit Initial 
Balances

Avg Chrg 
Per Proc

New
Pats

Credit
Initial Balances

Billed
to Ins

Credit
Special Adj

Late 
Charges

Debit
Special Adj

Provider: DDS1

Clinic: CENTRAL 
04/23/2018

2,586.56 0.00 332.00 10,848.56517.31 12,237.5651,389.00 0.00 0.000.00 0.00
7,930.000.00 431.0910.00 0.000.00

04/27/2018
898.00 0.00 0.00 816.00449.00 13,053.56212,237.56 -82.00 0.000.00 -698.40

0.00898.00 299.3300.00 0.000.00

Clinic: CENTRAL
3,484.56 0.00 332.00 12,355.16 10,966.16497.791,389.00 -82.00 0.000.00 -698.40 7

7,930.00898.00 387.170.00 0.000.00 1

Provider: DDS1
3,484.56 0.00 332.00 12,355.16 10,966.16497.791,389.00 0.00-82.00 70.00 -698.40

7,930.00898.00 387.1710.00 0.000.00

GRAND TOTALS
0.00 332.00 12,355.16 10,966.16497.791,389.00 3,484.56 -82.00 0.00 70.00 -698.40

898.00 7,930.00 387.1710.00 0.000.00

A

B

C

Analysis Summary - Daily
04/23/2018 - 04/29/2018 Entry Date

Clinics: CENTRAL
Providers: DDS1

Billing Type: <ALL>

Page 1 of 1Report Generated By: enterpriseReport Date: 04/29/2018

Pats
Seen

Avg Prod 
Per Pat

Ending
Balance

Net
Change

Applied
PaymentsCharges

Applied
Credit Adj

Applied Ins
Payments

Beginning
Balance

Charge
Adj

Finance
Charges

Debit Initial 
Balances

Avg Chrg 
Per Proc

New
Pats

Credit
Initial Balances

Billed
to Ins

Credit
Special Adj

Late 
Charges

Debit
Special Adj

Clinic: CENTRAL

Prov: DDS1
04/23/2018

2,586.56 0.00 332.00 10,848.56517.31 12,237.5651,389.00 0.00 0.000.00 0.00
7,930.000.00 431.0910.00 0.000.00

04/27/2018
898.00 0.00 0.00 816.00449.00 13,053.56212,237.56 -82.00 0.000.00 -698.40

0.00898.00 299.3300.00 0.000.00

Prov: DDS1
3,484.56 0.00 332.00 12,355.16 10,966.16497.791,389.00 -82.00 0.000.00 -698.40 7

7,930.00898.00 387.170.00 0.000.00 1

Clinic: CENTRAL
3,484.56 0.00 332.00 12,355.16 10,966.16497.791,389.00 0.00-82.00 70.00 -698.40

7,930.00898.00 387.1710.00 0.000.00

GRAND TOTALS
0.00 332.00 12,355.16 10,966.16497.791,389.00 3,484.56 -82.00 0.00 70.00 -698.40

898.00 7,930.00 387.1710.00 0.000.00

A

B

D
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How do I run the Analysis Summary Report - Daily?
From the DXOne Reporting module, select Management, and then double-click Analysis 
Summary. For additional details about running this report, see the “Analysis Summary Report“ 
topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any 
module, click Contents).

What important information does this report provide?
The report can be grouped by clinic and then by provider, or you can have the report grouped by 
provider and then by clinic.

A.	Daily Summary – The transaction totals for each day in the date range.

B.	 Grand Totals – The grand total of transactions for the given date range.

C.	 Provider Summary

•	 Clinic Subtotals – The daily transaction totals for a provider by clinic.

•	 Provider Totals – The transaction totals for a provider.

D.	Clinic Summary

•	 Provider Subtotals – The daily transaction totals for a clinic by provider.

•	 Clinic Totals – The transaction totals for a clinic.
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12   Analysis Summary Report - Standard

Analysis Summary Report - Standard
The Analysis Summary - Standard report lists transaction totals. This report includes much of the 
same information as the Day Sheet report, but formats it in a way that helps you compare provider 
and/or clinic totals.

Why:	 To review production totals and compare provider and/or clinic totals

When:	 Monthly

Analysis Summary - Standard
05/01/2018 - 05/01/2018 Entry Date

Clinics: CENTRAL
Providers: DDS1

Billing Type: <ALL>

Page 1 of 1Report Generated By: enterpriseReport Date: 05/01/2018

Pats
Seen

Avg Prod 
Per Pat

Ending
Balance

Net
Change

Beginning
Balance Charges

Charge
Adj

Finance
Charges

Debit Initial 
Balances

Applied
Payments

Applied Ins
Payments

Applied
Credit Adj

Late 
Charges

Debit
Special Adj

Billed
to Ins

Credit
Special Adj

Credit
Initial Balances

Avg Chrg 
Per Proc

New
Pats

GRAND TOTALS
1,011.00 10.00 22.00 1,389.00 919.00126.388470.00 -30.00 -10.000.00 -105.00

425.00 21.00 48.1420.00 0.00 0.00A

Analysis Summary - Standard
05/01/2018 - 05/01/2018 Entry Date

Clinics: CENTRAL
Providers: DDS1

Billing Type: <ALL>

Page 1 of 1Report Generated By: enterpriseReport Date: 05/01/2018

Pats
Seen

Avg Prod 
Per Pat

Ending
Balance

Net
Change

Beginning
Balance Charges

Charge
Adj

Finance
Charges

Debit Initial 
Balances

Applied
Payments

Applied Ins
Payments

Applied
Credit Adj

Late 
Charges

Debit
Special Adj

Billed
to Ins

Credit
Special Adj

Credit
Initial Balances

Avg Chrg 
Per Proc

New
Pats

Provider: DDS1

Clinic: CENTRAL
1,011.00 10.00 1,389.00 919.008 126.3822.00 -30.00470.00 -10.000.00 -105.00

21.00425.00 48.1420.00 0.00 0.00

Provider: DDS1
-10.001,011.00 10.00 22.00 1,389.00 919.00126.38-30.00470.00 0.00 -105.00 8

21.00425.00 48.140.00 0.00 0.00 2

GRAND TOTALS
1,011.00 10.00 22.00 1,389.00 919.00126.388470.00 -30.00 -10.000.00 -105.00

425.00 21.00 48.1420.00 0.00 0.00

B

A
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Analysis Summary - Standard
05/01/2018 - 05/01/2018 Entry Date

Clinics: CENTRAL
Providers: DDS1

Billing Type: <ALL>

Page 1 of 1Report Generated By: enterpriseReport Date: 05/01/2018

Pats
Seen

Avg Prod 
Per Pat

Ending
Balance

Net
Change

Beginning
Balance Charges

Charge
Adj

Finance
Charges

Debit Initial 
Balances

Applied
Payments

Applied Ins
Payments

Applied
Credit Adj

Late 
Charges

Debit
Special Adj

Billed
to Ins

Credit
Special Adj

Credit
Initial Balances

Avg Chrg 
Per Proc

New
Pats

Clinic: CENTRAL

Prov: DDS1
1,011.00 10.00 1,389.00 919.008 126.3822.00 -30.00470.00 -10.000.00 -105.00

21.00425.00 48.1420.00 0.00 0.00

Clinic: CENTRAL
-10.001,011.00 10.00 22.00 1,389.00 919.00126.38-30.00470.00 0.00 -105.00 8

21.00425.00 48.140.00 0.00 0.00 2

GRAND TOTALS
1,011.00 10.00 22.00 1,389.00 919.00126.388470.00 -30.00 -10.000.00 -105.00

425.00 21.00 48.1420.00 0.00 0.00A

C

How do I run the Analysis Summary Report - Standard?
From the DXOne Reporting module, select Management, and then double-click Analysis 
Summary. For additional details about running this report, see the “Analysis Summary Report“ 
topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any 
module, click Contents).

What important information does this report provide?
The report can be grouped by clinic and then by provider, or you can have the report grouped by 
provider and then by clinic.

A.	Grand Totals – The grand total of transactions in the given date range.

B.	 Provider Summary

•	 Clinic Subtotals – The transaction totals for a provider by clinic.

•	 Provider Totals – The transaction totals for a provider.

C.	  Clinic Summary

•	 Provider Subtotals – The transaction totals for a clinic by provider.

•	 Clinic Totals – The transaction totals for a clinic.
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14   Appointment Book View Printout

Appointment Book View Printout
The Appointment Book View printout displays a graphical representation of your appointment 
schedule.

Why:	 To print daily appointments by appointment view and to have printouts of the 
schedule to hang up in operatories

When:	 Daily or as needed

APPOINTMENT BOOK VIEW(06/26/2018)
PMTS - DENTRIX DENTAL SYSTEMS

Date: Page:���26����8
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Tuesday - June 26, 2018
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How do I run the Appointment Book View Printout?
1.	 From the Appointment Book, select the view you want to print (for example, press F1), and 

navigate to the day you want to print (if not the day currently being displayed).

2.	 From the File menu, click Print Appointment Book View to open the Print Appointment 
Book View dialog box.

3.	 Click Print or Batch to generate the Appointment Book View printout. The report can be 
printed in color (if you are using a color printer).

For additional details about running this report, see the “Appointment Book View Report“ topic in 
the Appointment Book portion of the Dentrix Enterprise Help (from the Help menu of any module, 
click Contents).

What important information does this report provide?
A.	Appointments – The appointments in each operatory of the view.

B.	 Day Note – The note for the day, which can be entered by clicking the Note box in the upper-
left corner of the Appointment Book.
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16   Appointment Cycle Time Report

Appointment Cycle Time Report
The Appointment Cycle Time Report helps you analyze changes in appointments’ statuses. The 
report provides statistics regarding how long patients wait to be treated and how long they spend 
in treatment.

Why:	 To generate a report of appointment information, total visit times, and in-clinic 
wait times to monitor daily activity

When:	 Daily

Server Name: <Default>

Appointment Cycle Time
Date Range: 12/19/2018 - 12/19/2018

Clinics: <ALL>

Providers: <ALL>

Patients: <ALL> - <ALL>

Appt Time Start Status: READY
Appt Time End Status: CHKOUT

In Operatory Tracking Statuses: SEATED, SEDATE, TX, WAKE

Appt Clinic Appt Date Appt Type Provider

Patient

Name Chart# ADA Code(s)

Current

Status

Event Start 

Time

Changed

Status

Event End 

Time

Event Total 

Time

General DESMITH Morales, Debbie MO0001C D9110 READY SEATEDAF 12/19/2018 3:21PM 3:21PM  0

SEATED CHKOUT3:21PM 3:25PM  4

Total Time 

Total Time ICWT

 4

 0

General DESMITH Reyes, Jose RE140 D9310 READY SEATEDAF 12/19/2018 3:21PM 3:23PM  2

SEATED CHKOUT3:23PM 3:27PM  4

Total Time 

Total Time ICWT

 6

 2

General MHAYES Tran, Thomas TR0031 D0330 READY SEATEDAF 12/19/2018 3:25PM 3:27PM  2

SEATED CHKOUT3:27PM 3:35PM  8

Total Time 

Total Time ICWT

 10

 2

1

Appt Clinic Appt Date Appt Type Provider

Patient

Name Chart# ADA Code(s)

Current

Status

Event Start 

Time

Changed

Status

Event End 

Time

Event Total 

Time

General DESMITH Reed, Sandy RE0019C D9310 READY SEATEDAF 12/19/2018 4:45PM 4:46PM  1

SEATED SEDATE4:46PM 4:48PM  2

SEDATE TX4:48PM 4:49PM  1

TX WAKE4:49PM 4:51PM  2

WAKE CHKOUT4:51PM 4:52PM  1

Total Time 

Total Time ICWT

 7

 1

ICWT

Average 

ICWT Median

 1

 1

3

A

E

F

B

C

D
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How do I run the Appointment Cycle Time Report?
From the DXOne Reporting module, select Management, and then double-click Appointment 
Cycle Time. For additional details about running this report, see the “Appointment Cycle Time 
Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu 
of any module, click Contents).

What important information does this report provide?
For each appointment listed, the report displays the following information:

A.	Appointment details – The clinic, date, type, provider, patient name, chart number, and ADA 
code (or “Multiple” if there is more than one ADA code) associated with the appointment.

B.	 Status change (waited) – When the patient’s time in the waiting room started and stopped, 
and how long the patient waited.

C.	 Status change (treated) – When the patient’s time in an operatory started and stopped, and 
how long the patient was being treated.

D.	In-operatory statuses – If In Oper Tracking Statuses were set when setting up options for this 
report, one or more status changes during treatment (such as imaging, sedation, treatment, and 
awake) may appear.

E.	 Appointment subtotals – The length of the appointment, according to the specified starting 
status and ending status. Also, the in-clinic wait time (ICWT) for the appointment.

F.	 Average and median – The average wait time and median wait time for all the appointments 
on the report.
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18   Appointment Reminder Cards

Appointment Reminder Cards
Appointment Reminder Cards display a patient’s next appointment date and time, along with a 
custom message.

Why:	 To print reminder post cards

When:	 Monthly, semi-monthly, or as needed

PMTS - DENTRIX DENTAL SYSTEMS
Ken I Fillem, DDS

123 E. Valley Dr.
Suite 500

American Fork, UT 84003
(801)555-9300

Kirk O Baber
11 Maple Leaf Ln.
Colmar, PA 18915

Your next appointment with us is: 

Tuesday - June 26, 2018 at  9:00 am

Present this card at your next appointment and 
receive 10% off your next tooth whitening.

A
B
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How do I run the Appointment Reminder Cards?
In the Ledger, from the Print menu, click Walkout, select Appointment Card, and then click Print. 
For additional details about running this report, see the “Walkout statements” topic in the Ledger 
portion of the Dentrix Enterprise Help (from the Help menu of any module, click Contents).

What important information does this report provide?
A.	Next Appointment Date and Time – The patient’s next scheduled appointment.

B.	 Custom Message – The custom message entered when setting options for this report.
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20   Appointment Statistics Report

Appointment Statistics Report
The Appointment Statistics Report displays statistics for late appointments, on-time appointments, 
wait/will call appointments, broken appointments, appointments that remained in specified 
statuses for a specified length of time, and appointment durations based on specified statuses.

Why:	 To view the productivity and efficiency of your practice regarding patient visits

When:	 As needed

Appointment Date Range: 01/01/2017 - 12/31/2017
Clinics: <ALL>
Providers: <ALL> 
Remained in Statuses: APTSET
Avg Appt

Appt
Time Start Statuses: APTSET
End Statuses: <COMPLETE>

A

B

C

D
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How do I run the Appointment Statistics Report?
In DXOne Reporting, select Management, and then double-click Appointment Statistics. Enter 
a date range, select the desired clinics and appointment providers, select appointment statuses, 
type your goal, select a beginning and an ending appointment status, and then click OK.

For additional details about running this report, see the “Appointment Statistics Report” topic in 
the  DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, 
click Contents).

What important information does this report provide?
This report relies on the same underlying functionality as the Appointment Book “Late Appt” 
Tracking feature to monitor changes in appointment statuses, 
but you do not have to enable late appointment tracking to run 
this report (of course, the report will not show late appointment 
statistics).

Important: If any appointments within the date range for which you 
are running this report have been purged using the purge utility in 
the Appointment Book or Office Manager, the report data may not 
be accurate.

A.	Number of Appointments

•	 The number of late and on-time appointments that were 
scheduled.

•	 The number of wait/will call and broken appointments.

B.	 Broken and Late Appointment Percentages

•	 The number of broken appointments divided by the sum 
of the number of  broken appointments and scheduled 
appointments.

•	 The number of late appointments divided by the number of  scheduled appointments.

C.	 Remained in Status

•	 The number of appointments that remained in the specified statuses for more time than the 
specified goal but for less time than the specified number of minutes.

•	 The number of appointments that remained in the specified statuses for less time than the 
specified goal.

•	 The percentage of appointments that remained in the specified statuses for more time than 
the specified goal but for less time than the specified number of minutes.

D.	Average Length – The average length of time in between the specified starting and ending 
statuses for appointments lasting up to the specified number of minutes.
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22   As Soon As Possible List

As Soon As Possible List
The As Soon As Possible List displays patients who want to move up their appointment time should 
an opening occur in the practice schedule.

Why:	 To assist in filling cancellations

When:	 Weekly or daily

AS SOON AS POSSIBLE LIST
Date Range: 05/06/2011 - 05/06/2018

Primary Providers: <ALL>
Appointment Providers: <ALL>

Report Date: 05/06/2018 Report Generated By: enterprise Page 1 of 1

Date Time Patient Name Appointment ReasonPROV/OP Length PhoneStatus

05/06/2018 9:00 AM      xAPTSE  Brown, Mary DDS1/OP1 NP Ex                                                      1h 30m   (919) 555-1234 
05/06/2018 10:30 AM    xLMTape Perkins, Shelly DDS1/OP1 4BWX, Emerg Ex                                         40m   (919) 555-4457 
05/06/2018 9:00 AM      xEMER    Abbott, James S DDS1/OP2 FabPtCr+B#7 10m   (919) 555-2345
05/06/2018 9:10 AM      xLMwrk   Crosby, Brent J DDS2/OP2                             LbVnPorLm#7                                             40m   (919) 555-4531
05/06/2018 10:00 AM Smith, Michael DDS2/OP2 CCAdult, ExtEval                                    1h 10m   (919) 555-6278

5Total Listed:

A

B C D E
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How do I run the As Soon As Possible List?
From the DXOne Reporting module, select List, and then double-click ASAP List. For additional 
details about running this report, see the “As Soon As Possible (ASAP) List” topic in the DXOne 
Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
A.	Patient and Appointment Information – Each patient’s name, status, and appointment date 

and time.

B.	 Prov/Op – The provider and operatory assigned to the appointment.

C.	 Appointment Reason – The description of procedures for the appointment.

D.	Length – The appointment length.

E.	 Phone – The patient’s phone number.
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Assigned Rights Report
The Assigned Rights report lists the specified security rights assigned to users.

Why:	 To ensure security rights have been set up correctly for users across clinics

When:	 After Dentrix Enterprise setup, and as needed

ASSIGNED RIGHTS
Clinics: <ALL>

Users: <ALL>
Rights: Selected

Page 1 of 1Report Generated By: enterpriseReport Date: 04/29/2018

RIGHTSCLINICUSER

ENTERPRISE AF Appointments - Delete, Appointments - Edit, Appointments - Purge
ENTERPRISE CENTRAL Appointments - Delete, Appointments - Edit, Appointments - Purge
ENTERPRISE DRAPER Appointments - Delete, Appointments - Edit, Appointments - Purge
ENTERPRISE MESA Appointments - Delete, Appointments - Edit, Appointments - Purge
ENTERPRISE PINEDALE Appointments - Delete, Appointments - Edit, Appointments - Purge
ENTERPRISE PROVO Appointments - Delete, Appointments - Edit, Appointments - Purge
ENTERPRISE SPRING Appointments - Delete, Appointments - Edit, Appointments - Purge
MCCLURE AF Appointments - Delete, Appointments - Edit, Appointments - Purge
MCCLURE CENTRAL Appointments - Delete, Appointments - Edit, Appointments - Purge
MCCLURE DRAPER Appointments - Delete, Appointments - Edit, Appointments - Purge
MCCLURE MESA Appointments - Delete, Appointments - Edit, Appointments - Purge
MCCLURE PINEDALE Appointments - Delete, Appointments - Edit, Appointments - Purge
MCCLURE PROVO Appointments - Delete, Appointments - Edit, Appointments - Purge
MCCLURE SPRING Appointments - Delete, Appointments - Edit, Appointments - Purge
MSMITH CENTRAL Appointments - Delete, Appointments - Edit, Appointments - Purge
MSMITH MESA Appointments - Delete, Appointments - Edit, Appointments - Purge
SLAUGH AF Appointments - Delete, Appointments - Edit, Appointments - Purge
SLAUGH DRAPER Appointments - Delete, Appointments - Edit, Appointments - Purge

A B C
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How do I run the Assigned Rights Report?
From the DXOne Reporting module, select Management, and then double-click Assigned Rights 
Report - Current. For additional details about running this report, see the “Assigned Rights 
Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu 
of any module, click Contents).

What important information does this report provide?
A.	Users – The providers and staff listed in 

the Clinic Resource Setup and Security 
Rights Setup dialog boxes. (You can 
choose to group the users on the report 
by clinic when setting up the options for 
running the report.)

B.	 Clinics – The clinics to which the user has 
been assigned security rights.

C.	 Rights – The security rights assigned to 

the user.

C

B

A

A

A
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Audit Report - Appointments
The Audit - Appointments Report lists appointments that were created, altered, and deleted 
during the specified date range.

Why:	 To ensure that appointments are being scheduled, edited, and deleted in 
accordance with the desired security restrictions for each user, and to inform the 
doctor, office manager, and business owner of any situations so that appropriate 
action can be taken if necessary

When:	 Monthly and as needed

Page 7 of 8Report Generated By: enterprise

������������ ���������������������������������

Report Date: 4/22/2018

DATE CHANGED

����������
� ���� ��
� ���� ������ ������� ��� � ���� �
���� ��������� ��������������

User Changed: Enterprise ���

FIXED8:00 AM No Answer03/14/2018 180 High Production 1,110.00 HYG_1 DDS1

User Changed: Enterprise ���

FIXED1:00 PM No Answer03/14/2018 200 High Production 2,470.00 HYG_1 DDS1

User Changed: Enterprise ���

FIXED8:00 AM No Answer03/14/2018 50 High Production 1,540.00 OP_3 DDS1

User Changed: Enterprise ���

FIXED9:00 AM No Answer03/14/2018 30 Low Production 111.00 OP_3 DDS1

User Changed: Enterprise ���

FIXED10:00 AM No Answer03/14/2018 10 Medium Production 274.00 OP_3 DDS1

User Changed: Enterprise ���

FIXED8:00 AM No Answer03/28/2018 30 High Production 218.00 OP_3 DDS1

User Changed: Enterprise ���

FIXED8:30 AM No Answer03/28/2018 50 Low Production 148.00 OP_3 DDS9

User Changed: Enterprise ���
FIXED8:30 AM No Answer03/28/2018 50 Low Production 148.00 OP_3 DDS9

User Changed: Enterprise ���

FIXED8:30 AM No Answer03/28/2018 40 High Production 1,000.00 OP_3 DDS9

User Changed: Enterprise ���

FIXED9:10 AM No Answer03/28/2018 50 Low Production 0.00 OP_3 DDS1

User Changed: Enterprise ���

FIXED10:00 AM No Answer03/28/2018 60 High Production 100.00 OP_3 DDS1

Date/Time: 3/8/2018  11:59:57AM
<INSERTED>
Little, Brian

Date/Time: 3/8/2018  12:00:16PM
<INSERTED>
Little, Carol

Date/Time: 3/8/2018  12:00:30PM
<INSERTED>
Little, Chad

Date/Time: 3/8/2018  12:00:48PM
<INSERTED>
Little, Dean

Date/Time: 3/8/2018  12:01:19PM
<INSERTED>
Little, Kevin

Date/Time: 3/23/2018  12:10:09PM
<INSERTED>
Davis, Karen

Date/Time: 3/23/2018  12:11:20PM
<INSERTED>
Crosby, Brent L

Date/Time: 3/23/2018  12:12:12PM
Crosby, Brent L
<DELETED>

Date/Time: 3/23/2018  12:12:33PM
<INSERTED>
Crosby, Brent

Date/Time: 3/23/2018  12:13:33PM
<INSERTED>
Edwards, Anna

Date/Time: 3/23/2018  12:13:56PM
<INSERTED>
Edwards, John

B

D

C

A
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How do I run the Audit Report - Appointments?
From the DXOne Reporting module, select Audit, and then double-click Audit - Appointments. 
For additional details about running this report, see the “Audit - Appointments Report” topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
A.	Date/Time – The date and time of the insertion, alteration, or deletion.

B.	 Changing Users – The user who made the change appears. Also, if another user (user B) 
entered his or her credentials to allow the user (user A) to make a change because user A didn’t 
have the appropriate rights, user B and the security option being overridden appear.

C.	 Original Value – Details of the record in its original state. (For new records, this line will read, 
“<INSERTED>.”)

D.	New Value – Details of the record after the change. (For deleted records, this line will read, 
“<DELETED>.”)
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Audit Report - Audit Log Status
The Audit - Audit Log Status Report lists the changes to the “patient access logging” and “patient 
print logging” settings during the specified date range.

Why:	 To ensure that patient access and print logging is set up in accordance with 
the desired security restrictions for each user, and to inform the doctor, office 
manager, and business owner of any situations so that appropriate action can be 
taken if necessary

When:	 Monthly and as needed

Date Range: 1/1/2018 - 1/9/2018

Report Date: 01/09/2018

01/03/2018 08:47:10 AM 

01/03/2018 08:47:10 AM

DCBA
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How do I run the Audit Report - Audit Log Status?
From the DXOne Reporting module, select Audit, and then double-click Audit - Audit Log Status. 
For additional details about running this report, see the “Audit - Audit Log Status Report” topic in 
the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, 
click Contents).

What important information does this report provide?
A.	Date/Time – The date and time of the setting change.

B.	 Audit Log Option – The Enable Patient Access Logging or 

Enable Patient Print Logging option.

C.	 Status – Enabled or disabled.

D.	User – The user who made the change.

B
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Audit Report - Clinics
The Audit - Clinics Report lists changes to clinic information during the specified date range.

Why:	 To ensure that practice information is being changed in accordance with the 
desired security restrictions for each user, and to inform the doctor, office 
manager, and business owner of any situations so that appropriate action can be 
taken if necessary

When:	 Monthly and as needed

AUDIT REPORT - CLINIC
Date Range: 05/11/2018 - 05/11/2018

Clinics: <ALL>
Users: <ALL>

Page 1 of 1Report Generated By: enterprise

USER CHANGED OVERRIDING USER - SECURITY OPTION

Report Date: 05/11/2018

DATE CHANGED 
OLD RECORD TYPE 
NEW RECORD TYPE

EXTERNAL ID PRACT ICE  T I TLE F I SCAL  YEAR MONTH BANK  DEPOS I T  #

Date/Time: 05/11/2018  11:50:18AM User Changed: enterprise
JanuaryCENTRAL The Dentist Group 43331677-1146
JanuaryCENTRAL The Dentist Group 43331677-1148

Date/Time: 05/11/2018  11:51:46AM User Changed: enterprise
JanuaryCENTRAL The Dentist Group 43331677-1148
AprilCENTRAL The Allied Dentist Group 43331677-1148

Date/Time: 05/11/2018  11:52:28AM User Changed: enterprise
AprilCENTRAL The Allied Dentist Group 43331677-1148
FeburaryCENTRAL The Allied Dentist Group 43331677-1148

C

D

BA
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How do I run the Audit Report - Clinics?
From the DXOne Reporting module, select Audit, and then double-click Audit - Clinics. For 
additional details about running this report, see the “Audit - Clinics Report” topic in the  DXOne 
Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
This report tracks the changes made to the practice title, fiscal year month, and bank deposit 
number in the Clinic Information dialog box.

A.	Date/Time – The date and time of the change of the clinic 
information.

B.	 Changing Users – The user who made the change appears. 
Also, if another user (user B) entered his or her credentials 
to allow the user (user A) to make a change because user A 
didn’t have the appropriate rights, user B and the security 
option being overridden appear.

C.	 Original Value – Details of the record in its original state.

D.	New Value – Details of the record after the change.
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Audit Report - Combined
The Audit - Combined Report lists patient information that was created, altered, deleted, viewed, 
printed, and exported during the specified date range.

Why:	 To ensure that patient information is being inserted, edited, deleted, accessed, 
printed, and exported in accordance with the desired security restrictions for 
each user, and to inform the doctor, office manager, and business owner of any 
situations so that appropriate action can be taken if necessary

When:	 Monthly and as needed

12/03/2017 - 12/03/2017 
Crosby, Brent  - Crosby, Brent 
<ALL>
<ALL>
Date/Time

12/09/2017

7

7

7

7

12/03/2017 12/03/2017

12/03/201712/03/2017

12/03/2017 12/03/2017

7

 

7

 

7

7
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How do I run the Audit Report - Combined?
From the DXOne Reporting module, select Audit, and then double-click Audit - Combined. For 
additional details about running this report, see the “Audit - Audit Log Status Report” topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
A.	Date/Time – The date and time of the insertion, alteration, deletion, accessing, printing, or 

exporting.

B.	 User – The user who made the change.

C.	 Override User – If another user (user B) entered his or her credentials to allow the user (user A) 
to make a change because user A didn’t have the appropriate rights, user B appears.

D.	Patient Name (Chart #) – The patient whose record was accessed.

E.	 Action Type – What action was performed, such as a module was accessed or a C-CDA 
document was exported.

F.	 Data Accessed – The module or area of Dentrix Enterprise that was accessed.

G.	Original Value – Details of the record in its original state.

H.	New Value – Details of the record after the change.



Dentrix Enterprise 11.0.2 Reports Reference

34   Audit Report - Patients

Audit Report - Patients
The Audit - Patients Report lists when patient information and medical consultations notes were 
created, altered, and deleted during the specified date range.

Why:	 To ensure that patient information is being changed in accordance with the 
desired security restrictions for each user, and to inform the doctor, office 
manager, and business owner of any situations so that appropriate action can be 
taken if necessary

When:	 Monthly and as needed


 88

 
 
 

8 

  OVERRIDING USER - SECURITY OPTION 

      




 
   

2/16/2018 

    

2/16/2018   
    
    

 
   

2/16/2018 

    

2/21/2018  
 0000000           A C          D
    

 
   

2/21/2018 

    

2/21/2018  
    
    

D

E

BA
C
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How do I run the Audit Report - Patients?
From the DXOne Reporting module, select Audit, and then double-click Audit - Patients. For 
additional details about running this report, see the“Audit - Patients Report” topic in the  DXOne 
Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
This report tracks when changes have been made to the patient information, which can be 
accessed by double-clicking the Patient Information block in the Family File, and to medical 
consultations notes, which can be accessed by clicking the Medical Consultations button in the 
Family File.

A.	Date/Time – The date and time of the change.

B.	 Changing Users – The user who made the change appears. Also, if another user (user B) 
entered his or her credentials to allow the user (user A) to make a change because user A didn’t 
have the appropriate rights, user B and the security option being overridden appear.

C.	 Record Type – The type of change made, such as a change to the patient information or 
medical consultation notes.

D.	Original Value – Details of the record in its original state. (For new records, this line will read, 
“<INITIAL ENTRY>.”)

E.	 New Value – Details of the record after the change. (For deleted records, this line will read, 
“<DELETED>.”)
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Audit Report - Providers/Staff
The Audit - Providers/Staff Report lists changes to provider and staff information during the 
specified date range.

Why:	 To ensure that provider/staff information is being changed in accordance with 
the desired security restrictions for each user, and to provide a legal document 
to inform the doctor, office manager, and business owner of any situations so that 
appropriate action can be taken

When:	 Monthly and as needed

AUDIT REPORT - PROVIDER\STAFF
Date Range: 05/12/2018 - 05/12/2018

Clinics: <ALL>
Users: <ALL>

Providers: <ALL>

Page 1 of 1Report Generated By: enterprise

USER CHANGED OVERRIDING USER - SECURITY OPTION

Report Date: 05/12/2018

DATE CHANGED 
OLD RECORD TYPE 
NEW RECORD TYPE

EXTERNAL ID PROV I DER\ STAFF  NAME SS  # CLINICFEE SCHEDULE LOGIN NAMECLASS

Date/Time: 05/12/2018   9:51:07AM User Changed: enterprise
Provider DDS01      Smith, Dennis                                                         Primary 1            -- CENTRAL DDS01

Smith. DennisProvider DDS01                       Primary 2  -- CENTRAL DDS01

Date/Time: 05/12/2018   9:52:00AM User Changed: enterprise
Provider Smith, DennisDDS01                        Primary 6 -- CENTRAL DDS01

Smith, DennisProvider DDS01                       Primary 1 -- CENTRAL DDS01

Date/Time: 05/12/2018   9:53:18AM User Changed: enterprise
Staff                                       HYG01                          McClure, Angie Primary -- CENTRAL        

McClure, AngiStaff HYG01                        Primary -- MESA

Date/Time: 05/12/2018   9:54:25AM User Changed: enterprise
Staff                                       McClure, AngiHYG01                     Primary -- MESA

McClure, AngiStaff HYG01                        Primary -- CENTRAL

Date/Time: 05/12/2018   9:55:14AM User Changed: enterprise
Provider Smith, DennisDDS01                        Primary 1 -- CENTRAL DDS01

Smith, DennisProvider DDS01                        Secondary 1             -- CENTRAL DDS01

Date/Time: 05/12/2018   9:56:13AM User Changed: enterprise
Provider Smith, DennisDDS01                        Secondary 1            -- CENTRAL DDS01

Smith, DennisProvider DDS01                        Primary 1              -- CENTRAL DDS01

User Changed: enterpriseDate/Time: 05/12/2018  10:06:51AM
<INSERTED>

Brown, Mary     Staff STF04                      Primary -- CENTRAL

BA

C

D
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How do I run the Audit Report - Providers/Staff?
From the DXOne Reporting module, select Audit, and then double-click Audit - Providers/Staff. 
For additional details about running this report, see the“Audit - Providers/Staff Report” topic in the  
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
This report tracks the changes made to the provider’s or staff member’s name, provider’s class, 
provider’s fee schedule selection, provider’s or staff member’s assigned clinic, and provider’s or 
staff member’s login information in the Provider Information (or Staff Information) dialog box.

A.	Date/Time – The date and time of the change of the provider/staff information.

B.	 Changing Users – The user who made the change appears. Also, if another user (user B) 
entered his or her credentials to allow the user (user A) to make a change because user A didn’t 
have the appropriate rights, user B and the security option being overridden appear.

C.	 Original Value – Details of the record in its original state. (For new records, this line will read, 
“<INSERTED>.”)

D.	New Value – Details of the record after the change.
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Audit Report - Transactions
The Audit - Transactions Report lists transactions (completed procedures, guarantor payments, 
insurance payments, and adjustments) that were posted, changed, and deleted during the 
specified date range.

Why:	 To ensure that transactions are being posted, altered, and deleted in accordance 
with GAAP (Generally Accepted Accounting Principles) and the desired security 
restrictions for each user, and to provide a legal document to inform the doctor, 
office manager, and business owner of any situations so that appropriate action 
can be taken

When:	 Monthly and as needed

Page 1 of 3

AUDIT REPORT - TRANSACTIONS
Date Range: 05/01/2018 - 05/01/2018

Patient Range: <ALL> - <ALL>
Clinics: <ALL>
Users: <ALL>

Report Generated By: enterpriseReport Date: 06/26/2018

DATE CHANGED USER CHANGED OVERRIDING USER - SECURITY OPTION

O l d  Re c o r d  T y p e
New  Re c o r d  T y p e

Patient Name (Chart) Entry Date P r o c  Da t e De s c r i p t i o n Ch e c k  # Amo u n t Encounter # Clinic Provider

User Changed: ENTERPRISE

+Patient Refund05/01/201 05/01/201                 8                          8                                                                                                                   50.00 CENTRAL        DDS1

User Changed: ENTERPRISE
+Patient Refund05/01/201 05/01/201

Date Changed: 05/01/2018  11:04:48
                                             <INSERTED>
Adjustment Crosby, Brent ()

Date Changed: 05/01/2018  11:05:27 
Adjustment Crosby, Shirley ()                             8                       8                                  50.00 CENTRAL       DDS1

<DELETED>

User Changed: ENTERPRISEDate Changed: 05/01/2018  11:05:53
<INSERTED>

-Credit AdjustmentAdjustment 05/01/201 05/01/201Perkins, Dave ()                   8                       8                                                                                                                 -50.00 CENTRAL       <MULTIPLE>

User Changed: ENTERPRISEDate Changed: 05/01/2018  12:06:16
Completed Procedure Prophylaxis-adult04/22/201 04/22/201Abbott, James S (ABB101)                           8                       8                                                                                                                    0.00 CENTRAL        <MULTIPLE>

Prophylaxis-adultCompleted Procedure 04/22/201 04/22/201Abbott, James S (ABB101)                           8                       8                                                                                                                  90.00 CENTRAL        DDS1

User Changed: ENTERPRISEDate Changed: 05/01/2018  12:06:26
Completed Procedure Periodic oral evaluation04/22/201 04/22/201Abbott, James S (ABB101)                           8                       8                                                                                                                    0.00 CENTRAL        <MULTIPLE>

Periodic oral evaluationCompleted Procedure 04/22/201 04/22/201Abbott, James S (ABB101)                           8                       8                                                                                                                  30.00 CENTRAL        DDS1

User Changed: ENTERPRISEDate Changed: 05/01/2018  12:06:37
Completed Procedure Bitewings-four films04/22/201 04/22/201Abbott, James S (ABB101)                           8                       8                                                                                                                    0.00 CENTRAL        <MULTIPLE>

Bitewings-four filmsCompleted Procedure 04/22/201 04/22/201Abbott, James S (ABB101)                           8                       8                                                                                                                250.00 CENTRAL        DDS1

User Changed: ENTERPRISEDate Changed: 05/01/2018  12:06:52
Completed Procedure Panoramic film04/22/201 04/22/201Abbott, James S (ABB101)                           8                       8                                0.00 CENTRAL        <MULTIPLE>

Panoramic filmCompleted Procedure 04/22/201 04/22/201Abbott, James S (ABB101)                           8                       8                                                                                                                158.00 CENTRAL        DDS1

User Changed: ENTERPRISEDate Changed: 05/01/2018  12:07:17
Insurance Payment Insurance Payment04/27/201 04/27/201Abbott, James S (ABB101)                           8                       8                                                                              44587 -698.40 CENTRAL        <MULTIPLE>

<DELETED>

User Changed: ENTERPRISE

Extraction crnl remnts-decid th05/01/201 05/01/201

Date Changed: 05/01/2018  12:21:36
<INSERTED>

Completed Procedure Winters, Beth (PA0007)                 8                       8                                                                                                                 500.00 CENTRAL        DDS01

BA

C

D
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How do I run the Audit Report - Transactions?
From the DXOne Reporting module, select Audit, and then double-click Audit - Transactions. 
For additional details about running this report, see the “Audit - Transactions Report” topic in the  
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
A.	Date/Time – The date and time of the change of the provider/staff information.

B.	 Changing Users – The user who made the change appears. Also, if another user (user B) 
entered his or her credentials to allow the user (user A) to make a change because user A didn’t 
have the appropriate rights, user B and the security option being overridden appear.

C.	 Original Value – Details of the record in its original state. (For new records, this line will read, 
“<INSERTED>.”)

D.	New Value – Details of the record after the change. (For deleted records, this line will read, 
“<DELETED>.”)
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Audit Rights Report - Assigned 
Individually
The Audit Rights - Assigned Individually Report lists security rights that were granted to or 
removed from users during the specified date range.

Why:	 To ensure that security rights are being assigned in accordance with the desired 
security restrictions for each user, and to inform the doctor, office manager, 
and business owner of any situations so that appropriate action can be taken if 
necessary

When:	 Monthly and as needed

Audit Rights - Assigned Individually
Date Range: 12/12/2017 - 12/12/2017

Users: DSMITH

Clinics: <ALL>

Users who made change: DSMITH

Display Date Changed value in: Logged on Clinic

Page 1 of 5Report Generated By: DSMITHReport Date: 12/12/2017

ACTIONDATE CHANGED USER CHANGED OLD SECURITY RIGHT

NEW SECURITY RIGHT

OLD USEROLD CLINIC

NEW CLINIC NEW USER

12/12/2017  12:45:30PM Removed DSMITH My Clinics, View AF DSMITH

12/12/2017  12:45:30PM Removed DSMITH Integration Settings, File Exchange AF DSMITH

12/12/2017  12:45:30PM Added DSMITH

Treatment Request, Open AF DSMITH

12/12/2017  12:45:30PM Added DSMITH

Treatment Request, Add/Edit AF DSMITH

12/12/2017  12:45:30PM Added DSMITH

Treatment Request, Delete AF DSMITH

12/12/2017  12:47:31PM Added DSMITH

My Clinics, View AF DSMITH

12/12/2017  12:47:53PM Removed DSMITH Audit, Clear CENTRAL DSMITH

12/12/2017  12:47:53PM Removed DSMITH  Dentrix, Log on CENTRAL DSMITH

12/12/2017  12:47:53PM Removed DSMITH Print Insurance Aging Reports CENTRAL DSMITH

12/12/2017  12:47:53PM Removed DSMITH Audit, Send To Batch CENTRAL DSMITH

12/12/2017  12:47:53PM Removed DSMITH Transactions, Delete CENTRAL DSMITH

12/12/2017  12:47:53PM Removed DSMITH Transactions, Edit CENTRAL DSMITH

12/12/2017  12:47:53PM Removed DSMITH Transactions, Enter CENTRAL DSMITH

12/12/2017  12:47:53PM Removed DSMITH ODBC Data Access CENTRAL DSMITH

12/12/2017  12:47:53PM Removed DSMITH Clinical Record, Modify CENTRAL DSMITH

12/12/2017  12:47:53PM Removed DSMITH Month End Wizard CENTRAL DSMITH

12/12/2017  12:47:53PM Removed DSMITH Practice Assistant CENTRAL DSMITH

12/12/2017  12:47:53PM Removed DSMITH Password, Multi-Clinics CENTRAL DSMITH

12/12/2017  12:47:53PM Removed DSMITH PA, Assigned Permissions Report CENTRAL DSMITH

12/12/2017  12:47:53PM Removed DSMITH Procedure-Instructor, Enter/Edit CENTRAL DSMITH

12/12/2017  12:47:53PM Removed DSMITH Patients, Archive CENTRAL DSMITH

12/12/2017  12:47:53PM Removed DSMITH Custom Utilities CENTRAL DSMITH

12/12/2017  12:47:53PM Removed DSMITH Custom Utilities Setup CENTRAL DSMITH

12/12/2017  12:47:53PM Removed DSMITH HL7 Patient Check Out CENTRAL DSMITH

A B C
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How do I run the Audit Rights Report - Assigned 
Individually?
From the DXOne Reporting module, select Audit, and then double-click Audit Rights - Assigned 
Individually. For additional details about running this report, see the “Audit Rights - Assigned 
Individually Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the 
Help menu of any module, click Contents).

What important information does this report provide?
A.	Date/Time – The date and time of the security right assignment or removal.

B.	 Action – Whether the right was added or removed.

C.	 Changing User  – The user who made the change.

D.	Original Value – Details of the record before being removed.

E.	 New Value – Details of the record after being added.
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Audit Rights Report - Assigned to 
Groups
The Audit Rights - Assigned to Groups Report lists security rights that were granted to or removed 
from user groups during the specified date range.

Why:	 To ensure that security rights are being assigned in accordance with the desired 
security restrictions for each user group, and to inform the doctor, office 
manager, and business owner of any situations so that appropriate action can be 
taken if necessary

When:	 Monthly and as needed

Audit Rights - Assigned to Groups
Date Range: 1/1/2017 - 12/12/2017

Group Names: <ALL>

Users who made change: DSMITH

Display Date Changed value in: Logged on Clinic

Page 1 of 2Report Generated By: DSMITHReport Date: 12/12/2017

ACTIONDATE CHANGED USER CHANGED OLD SECURITY RIGHT

NEW SECURITY RIGHT

OLD GROUP NAME

NEW GROUP NAME

1/31/2017   4:12:25PM Removed DSMITH Password, Multi-ClinicsDoctors

1/31/2017   4:12:25PM Removed DSMITH Chart, OpenDoctors

1/31/2017   4:13:40PM Added DSMITH

Chart, OpenDoctors

3/20/2017   4:51:03PM Added DSMITH

My Clinics, ViewDoctors

3/20/2017   4:51:03PM Added DSMITH

My Clinics, Select ProviderDoctors

3/20/2017   4:51:03PM Added DSMITH

My Clinics, ViewDoctors

3/20/2017   4:51:03PM Added DSMITH

My Clinics, ViewDoctors

3/20/2017   4:51:03PM Added DSMITH

Security Rights Setup, View All UsersDoctors

3/20/2017   4:51:32PM Removed DSMITH Password, Multi-ClinicsAdmins

3/20/2017   4:51:32PM Added DSMITH

My Clinics, ViewAdmins

3/20/2017   4:51:32PM Added DSMITH

My Clinics, Select ProviderAdmins

3/20/2017   4:51:32PM Added DSMITH

My Clinics, ViewAdmins

3/20/2017   4:51:32PM Added DSMITH

My Clinics, ViewAdmins

3/20/2017   4:51:32PM Added DSMITH

Security Rights Setup, View All UsersAdmins

3/20/2017   4:51:42PM Removed DSMITH Password, Multi-ClinicsBilling

3/20/2017   4:51:42PM Added DSMITH

My Clinics, ViewBilling

3/20/2017   4:51:42PM Added DSMITH

My Clinics, Select ProviderBilling

3/20/2017   4:51:42PM Added DSMITH

My Clinics, ViewBilling

3/20/2017   4:51:42PM Added DSMITH

My Clinics, ViewBilling

3/20/2017   4:51:42PM Added DSMITH

Security Rights Setup, View All UsersBilling

3/20/2017   4:51:48PM Removed DSMITH Password, Multi-ClinicsFrontDesk

3/20/2017   4:51:48PM Added DSMITH

My Clinics, ViewFrontDesk

3/20/2017   4:51:48PM Added DSMITH

My Clinics, Select ProviderFrontDesk

3/20/2017   4:51:48PM Added DSMITH

My Clinics, ViewFrontDesk

3/20/2017   4:51:48PM Added DSMITH

My Clinics, ViewFrontDesk

A B C
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How do I run the Audit Rights Report - Assigned to 
Groups?
From the DXOne Reporting module, select Audit, and then double-click Audit Rights - Assigned 
to Groups. For additional details about running this report, see the “Audit Rights - Assigned to 
Groups Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the 
Help menu of any module, click Contents).

What important information does this report provide?
A.	Date/Time – The date and time of the security right assignment or removal.

B.	 Action – Whether the right was added or removed.

C.	 Changing User  – The user who made the change.

D.	Original Value – Details of the record before being removed.

E.	 New Value – Details of the record after being added.
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Audit Rights Report - Group Names
The Audit Rights - Group Names Report lists new, deleted, and renamed user groups during the 
specified date range.

Why:	 To ensure that security user groups are being managed in accordance with the 
desired policies, and to inform the doctor, office manager, and business owner of 
any situations so that appropriate action can be taken if necessary

When:	 Monthly and as needed

Audit Rights - Group Names
Date Range: 12/12/2017 - 12/12/2017

Users Changed: DSMITH

Group Names: <ALL>

Display Date Changed value in: Logged on Clinic

Page 1 of 1Report Generated By: DSMITHReport Date: 12/12/2017

ACTIONDATE CHANGED USER CHANGED OLD NAME/CREATED NEW NAME/DELETED

12/12/2017   1:25:29PM Edited DSMITH Billing BillingCoords

12/12/2017   1:26:19PM Created DSMITH Created IT

12/12/2017   1:26:39PM Deleted DSMITH IT Deleted

12/12/2017   1:26:51PM Edited DSMITH BillingCoords Billing

A B C
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How do I run the Audit Rights Report - Group Names?
From the DXOne Reporting module, select Audit, and then double-click Audit Rights - Group 
Names. For additional details about running this report, see the “Audit Rights - Group Names 
Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu 
of any module, click Contents).

What important information does this report provide?
A.	Date/Time – The date and time of the security right assignment or removal.

B.	 Action – The type of change made.

C.	 Changing User  – The user who made the change.

D.	Original/New Values – Details of the record before and after the change. If the record was 
created, the original value displayed is “Created.” If the record was deleted, the new value 
displayed is “Deleted.”
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Audit Rights Report - Users to 
Groups
The Audit Rights - Users to Groups Report lists users who were added to or removed from user 
groups during the specified date range.

Why:	 To ensure that users are being assigned to user groups in accordance with the 
desired security restrictions for each user group, and to inform the doctor, office 
manager, and business owner of any situations so that appropriate action can be 
taken if necessary

When:	 Monthly and as needed

Audit Rights - Users to Groups
Date Range: 1/1/2017 - 12/12/2017

Group Names: <ALL>

Users who made change: DSMITH

Users Changed: DSMITH

Clinics Changed: AF, ALPINE, CENTRAL

Display Date Changed value in: Logged on Clinic

Page 1 of 1Report Generated By: DSMITHReport Date: 12/12/2017

ACTIONDATE CHANGED USER CHANGED OLD USER

NEW USER

OLD GROUP NAME

NEW GROUP NAME

OLD CLINIC

NEW CLINIC

3/20/2017   4:57:36PM Removed DSMITH DSMITHDoctors CENTRAL

3/20/2017   4:57:36PM Removed DSMITH DSMITHDoctors ALPINE

3/20/2017   4:57:36PM Added DSMITH

DSMITHDoctors CENTRAL

3/20/2017   4:57:36PM Added DSMITH

DSMITHDoctors ALPINE

3/20/2017   5:01:31PM Removed DSMITH DSMITHDoctors AF

3/20/2017   5:01:36PM Removed DSMITH DSMITHDoctors ALPINE

3/20/2017   5:01:45PM Removed DSMITH DSMITHDoctors CENTRAL

3/20/2017   5:03:49PM Added DSMITH

DSMITHAdmins CENTRAL

3/20/2017   5:03:49PM Added DSMITH

DSMITHAdmins ALPINE

3/20/2017   5:03:49PM Added DSMITH

DSMITHAdmins AF
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How do I run the Audit Rights Report - Users to Groups?
From the DXOne Reporting module, select Audit, and then double-click Audit Rights - Users to 
Groups. For additional details about running this report, see the “Audit Rights - Users to Groups 
Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu 
of any module, click Contents).

What important information does this report provide?
A.	Date/Time – The date and time of the security right assignment or removal.

B.	 Action – Whether the user was added or removed.

C.	 Changing User  – The user who made the change.

D.	Original Value – Details of the record before being removed.

E.	 New Value – Details of the record after being added.
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Billing Statement
Billing statements provide guarantor’s with a record of their financial transactions with the practice.

Why:	 To keep patients informed of their financial standing

When:	 Monthly or semi-monthly

PLEASE PAY
THIS AMOUNT

©DENTRIX 1987-2018 DLSTM 2

-

CURRENT BALANCE OVER 30 DAYS OVER 60 DAYS OVER 90 DAYS TOTAL BALANCE INSURANCE EST.

PLEASE RETAIN THIS PORTION OF THE STATEMENT FOR YOUR RECORDS

TO INSURE PROPER CREDIT, PLEASE DETACH AND RETURN THIS PORTION OF THE STATEMENT WITH YOUR PAYMENT

CHART NO. PAGE NO.

BILLING DATE

AMOUNT ENCLOSED

$

GUARANTOR NAME AND MAILING ADDRESS

STATEMENT OF ACCOUNT

DATE DESCRIPTION PATIENT'S NAME CHARGES CREDITS

CREDIT CARD #

NAME
(As it appears on card)

SIGNATURE

EXP.

TYPE OF CARD

DAV100 1

06/10/2018

The Dentist Group
123 East Valley Drive

American Fork, UT 84003

(801)555-9300

Karen Davis
1234 N Pine St
Provo, UT  84601

02/10/2018 Balance Forward 1428.80
Root canal therapy - anterior Karen 333.00
Therapeutic pulpotomy(exc rest) Kelly 92.00

* 02/26/2018
* 02/27/2018
* 02/27/2018 Extraction-single tooth Robert 71.00

* Indicates that insurance has been billed for the procedure.

Charges on account over 90 days.  PLEASE PAY IMMEDIATELY!

0.00 0.00 0.00 1924.80 1924.80 0.00

1924.80

Payment is Due on July 1, 2018

The Dentist Group - 123 East Valley Drive  American Fork, UT 84003 (801)555-9300

A

B

C

D

E
F
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How do I generate billing statements?
In the Office Manager, from the Reports menu, click Billing. Or, for a specific family, in the Ledger, 
from the Print menu, click Statement. For additional details about running this report, see the 
“Billing statements” topic in the Office Manager and Ledger portions of the Dentrix Enterprise 
Help (from the Help menu of any module, click Contents).

What important information does the statement provide?
A.	Payment Slip – The portion of the billing statement that can be cut off and returned with the 

payment.

B.	 Financial Transactions – The financial transactions posted to the guarantor’s account since the 
previous billing statement.

C.	 Financial Summary – The guarantor’s current balance, prior balance, and total of credits and 
charges applied during the current billing cycle.

Note: If you select Print Account Aging when setting options for generating statements, this 
section displays the guarantor’s aged balances.

D.	Credit Card Information – If you select Allow Credit Card Payments when setting options for 
generating statements, the credit card information lines appear on the payment slip.

E.	 Dunning Message/Guarantor Note – If a guarantor note has been entered for a guarantor, 
the note prints on the guarantor’s billing statements. If no guarantor note has been entered, 
the appropriate dunning message is printed. For details about how to enter guarantor notes or 
dunning messages, see the “Working with guarantor notes” or “Dunning messages” topics in 
the Ledger or Office Manager portions of the Dentrix Enterprise Help (from the Help menu of 
any module, click Contents).

F.	 Insurance Estimate Box – If you select Print Dental Insurance Estimate when setting options 
for billing statements, the insurance estimate box appears on the statement.

G.	Statement Note – If you entered a note in the Statement Message field when setting options 
for billing statements, the text of that note appears on each statement.

H.	Please Pay This Amount Box – If you select Print Agreed Payment when setting options for 
billing statements, the Please Pay This Amount box appears on the statement.
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Birthday List
The Birthday List displays patients whose birthdays fall on a selected month, day, and/or year. This 
report can also be run for a given date or date range.

Why:	 To assist in preparing birthday cards for patients

When:	 As needed

BIRTHDAY LIST
Birthday Range: Month: 5 - Month: 6   

Clinics: <ALL>
Provider: <ALL>

Billing Types: <ALL>
Patient Range:<ALL> - <ALL>

Page 1 of 37Report Date: 05/06/2018 Report Generated By: enterprise

PATIENT NAME BIRTHDATE

11/11/1930
123 Pine Drive
Atlanta, GA. 30361

Abbott, James

11/11/1965
123 Pine Drive
Yardley, PA. 19067

Abbott, Patricia

11/11/1965
1234 Maple Avenue
Springfield, PA. 19064

Brown, Mary J

11/11/1955
12345 Oak St.
Media, PA. 19063

Crosby, Brent G

11/11/1974
123 Hickory Place
Kailua, TN. 77301

Crosby, Shirley

11/11/1969
1234 Black Road
Barstow, RI. 95765

Davis, Harmon

11/11/1996
1234 Grove Way
Elk Grove, RI. 95750

Edwards, Johnathan

11/11/1960
1234 West Pond Dr.
Kailua, TN. 77301

Edwards, John

11/11/1927
12 Clover Ln
Kailua, TN. 77301

Farrer, Lisa E.

11/11/1955
12345 Hope Rd
Lowland Heights, IN. 40870

Gleason, Alice F

11/11/1926
123 Wild Rd
Kailua, TN. 77301

Gleason, Gary O.

11/11/1957
123 Pinetree Lane
Ortonville, IN. 40462

Perkins, Shelly L

11/11/1947
12345 Stone
Lowland Heights, IN. 40877

Smith, Michael

BA



Dentrix Enterprise 11.0.2 Reports Reference

Birthday List   51

How do I run the Birthday List?
From the DXOne Reporting module, select List, and then double-click Birthday List. For additional 
details about running this report, see the “Birthday List” topic in the DXOne Reporting portion of 
the Dentrix Enterprise Help (from the Help menu of any module, click Contents).

What important information does this report provide?
A.	Patient Details – The patient’s name and mailing address.

B.	 Birth Date – The patient’s birth date.
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Caries Prevalence and Periodontal 
Index Report
The Caries Prevalence and Periodontal Index Report indicates, for various ages and age ranges, 
the percent of patients who have caries and how many do not, the percent of patients with certain 
conditions, and the percent of patients with certain pocket depths and clinical attachment levels.

Why:	 To print a record of patient statistics for caries, conditions, and perio 
measurements

When:	 Quarterly

Report Date: 05/28/2018

Caries Prevalence and Periodontal Index Report
Date Range: 05/27/2018 - 05/28/2018

Clinics: <ALL>

Report Generated By: enterprise Page 1 of 3

Preschool children (2-5 years):

dmfs / dmft 20 / 12

Mean dmfs for Max. Incisors & Posterior teeth
Percent with history of decay on...

anterior teeth
posterior teeth
both anterior and posterior teeth

133.33

%66.67
%66.67
%66.67

Percent with caries history on >= 1 maxillary incisors %33.33
Percent with caries history on >= 2 maxillary incisors %0.00
Percent with caries history on >= 1 maxillary incisors or dmft >= 6 %66.67
Percent with dmfs > 0

maxillary incisor decay only
posterior decay only
both posterior and incisor decay

%66.67
%66.67
%66.67

Percent caries free children by individual ages and age cohorts
2 Years:
3 Years:
4 Years:
5 Years:
2-4 Years:
3-5 Years:
2-5 Years:

%50.00
%0.00
%0.00
%0.00
%50.00
%0.00
%50.00

A
B

C
D
E

F

Page 1
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How do I run the Caries Prevalence and Periodontal 
Index Report?
From the DXOne Reporting module, select List, and then double-click Caries Prevalence and 
Periodontal Index Report. For additional details about running this report, see the “Caries 
Prevalence and Periodontal Index Report” topic in the DXOne Reporting portion of the Dentrix 
Enterprise Help (from the Help menu of any module, click Contents).

What important information does this report provide?
This report prints on three pages with statistics for five age groups:

•	 The age group 2 - 5 years is on the first page.

•	 The age groups 6 - 14 years and 15 - 19 years are on the second page.

•	 The age groups 35 - 44 years and 55 years and older are on the third page.

Terms Used
You need to be familiar with the following terms before reading this report:

•	 Caries Free – No decayed, missing, or filled teeth

•	 CPITN – Community Periodontal Index of Treatment Needs

•	 Dmfs – Decayed, missing, or filled surfaces on primary teeth

•	 DMFS – Decayed, missing, or filled surfaces on permanent teeth

•	 Dmft – Decayed, missing, or filled primary teeth

•	 DMFT – Decayed, missing, or filled permanent teeth

•	 Dentate – Having teeth (i.e. a patient who does not have a full set of dentures)

•	 Fluorosis – An abnormal condition of the tooth enamel caused by excessive exposure to 
fluoride

Age Group 2 - 5 Years
The data for each of the following statistics is listed by individual ages and age ranges:

A.	dmfs / dmft

•	 dmfs – The total number of surfaces with one or more untreated caries for all patients in 
the age group, total number of surfaces with one or more fillings, and total number of 
teeth (multiplied by 5 surfaces) that have been extracted (using the oral surgery procedures 
D7111, D7140, D7210, D7220, D7230, D7240, D7241, D7250). A surface with a code posted 
for untreated followed by a code posted for restoration or extraction only counts once.

•	 dmft – The total number of teeth with one or more untreated caries for all patients in the 
age group, the total number of teeth with one or more fillings, and the total number of teeth 
that have been extracted (using the oral surgery procedures D7111, D7140, D7210, D7220, 
D7230, D7240, D7241, D7250) or are missing. A tooth with a code posted for untreated 
followed by a code posted for restoration or extraction only counts once.
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B.	 Mean dmfs – The mean dmfs for maxillary incisors and posterior teeth, which is the dmfs of 
maxillary incisors (c - h) and posterior teeth (a, b, i, j, k, l, s, and t) for all patients in the age 
group divided by the number of patients in the age group. A surface with an untreated caries 
code that has been fixed later is counted only once.

C.	 Decay History – The percent of patients in the age group with a history of decay. The statistics 
are broken down by decay on anterior teeth, posterior teeth, and both. Each value is the 
total number of patients in the age group with a caries code (15104, 15105, 15106, or 15107) 
or restorative code on any anterior, posterior, or anterior and posterior teeth divided by the 
number of patients in the age group.

D.	Caries History – The percent of patients in the age group with caries history. The statistics 
are broken down by one or more caries on any maxillary incisor, two or more caries on any 
maxillary incisor, and one or more caries on any maxillary incisors or where dmft is greater than 
or equal to 6. Each value is the total number of patients in the age group with a caries code 
(15104, 15105, 15106, or 15107) or restorative code on the given number of caries on any of the 
maxillary incisors (or the total number of patients in the age group with a dmft greater than or 
equal to 6) divided by the number of patients in the age group.

E.	 dmfs > 0 – The percent of patients in the age group with a dmfs that is greater than 0.

F.	 Caries Free – The percent of patients of each given age (or in each given age range) without 
caries. To be considered caries free, a patient cannot have any of the following conditions or 
codes posted in the Chart:

•	 Caries conditions – 15104, 15105, 15106, or 15107.

•	 Missing teeth conditions – 15100 or 15101.

•	 Procedure codes D2000 – D4276, D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, 
or D7999.

An explanation of the next page
of the report begins on page 56.
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Report Date: 05/28/2018 Report Generated By: enterprise Page 2 of 3

Ages 6-14 Years:

<----Percent Caries Free----> <----------------------------------------------------------------------------Percent with---------------------------------------------------------------------------->
Untreated Decay

Prim & Perm teeth
Untreated Decay

Perm teeth
Using Tobacco SealantsDental

Fluorosis
Mean

dmft / DMFT
Sealants
1st Molar

Mean # of 
sealed teeth

Sealants 2nd 
molar

Sealants 1st
or 2nd Molar

Prim & Perm
Teeth

Perm Teeth
Only

0.00 0.00 100.00 100.00 0.00 100.00100.00 100.00 100.00 100.00 1.00 0.00 / 8.006 Years:
0.00 0.00 0.00 0.00 0.00 0.000.00 0.00 0.00 0.00 0.00 0.00 / 0.007 Years:
0.00 0.00 0.00 0.00 0.00 0.000.00 0.00 0.00 0.00 0.00 0.00 / 0.008 Years:

100.00 100.00 0.00 0.00 0.00 0.000.00 0.00 0.00 0.00 0.00 0.00 / 0.009 Years:
0.00 0.00 100.00 100.00 0.00 100.00100.00 100.00 100.00 100.00 1.00 0.00 / 2.0010 Years:

100.00 100.00 0.00 0.00 0.00 0.000.00 0.00 0.00 0.00 0.00 0.00 / 0.0011 Years:
100.00 100.00 0.00 0.00 0.00 0.000.00 0.00 0.00 0.00 0.00 0.00 / 0.0012 Years:
100.00 100.00 0.00 0.00 0.00 0.000.00 0.00 0.00 0.00 0.00 0.00 / 0.0013 Years:
100.00 100.00 0.00 0.00 0.00 0.000.00 0.00 0.00 0.00 0.00 0.00 / 0.0014 Years:

6-8 Years: 0.00 0.00 100.00 100.00 0.00 100.00 100.00 100.00 100.00 100.00 1.00 0.00 / 8.00
9-11 Years: 80.00 80.00 20.00 20.00 0.00 20.00 20.00 20.00 20.00 20.00 0.20 0.00 / 0.40

12-14 Years: 100.00 100.00 0.00 0.00 0.00 0.00 0.00 0.00 0.000.00 0.00 0.00 / 0.00
6-14 Years: 86.67 86.67 13.33 13.33 46.67 13.33 13.33 13.33 13.33 13.33 0.13 0.00 / 0.67

Ages 15-19 Years:

<-------------------------------------------------------------------------------------------Percent with------------------------------------------------------------------------------------------->
Untreated Decay

Prim & Perm teeth
Using Tobacco SealantsDental

Fluorosis
Sealants
1st Molar

Mean # of 
sealed teeth

Sealants 2nd 
molar

Sealants 1st
or 2nd Molar

Caries Free
Prim & Perm teeth

Mean DMFT

15 Years: 92.31 7.69 7.69 7.69 7.69 7.69 7.69 7.69 0.08 0.38
16 Years: 100.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
17 Years: 96.67 3.33 3.33 3.33 3.33 3.33 3.33 3.33 0.03 0.13
18 Years: 96.00 4.00 4.00 4.00 4.00 4.00 4.00 4.00 0.04 0.16
19 Years: 96.15 3.85 3.85 3.85 3.85 3.85 3.85 3.85 0.04 0.12

<----------------------------------------------------------------------------------------------Percent with---------------------------------------------------------------------------------------------->
Perio Pockets

< 4mm
Perio Pockets

>= 4mm & < 6mm
Perio Pockets

>= 6mm
Loss of Attachment

< 3mm
Loss of Attachment
>= 3mm and < 5mm

Loss of Attachment
>= 5mm

15 Years: 0.00 0.00 0.00 0.00 0.00 0.00
16 Years: 0.00 0.00 0.00 0.00 0.00 0.00
17 Years: 3.33 3.33 3.33 3.33 3.33 3.33
18 Years: 4.00 4.00 4.00 4.00 4.00 4.00
19 Years: 3.85 0.00 0.00 3.85 3.85 0.00

Percent with Highest CPITN of 0,1,2,3,4 CPITN Percent
4
3
2
1
0

1.77
0.00
0.88

0.00
0.00

HGF J K L

IHGF J K L

M N

V

I

Page 2
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Age Group 6 - 14 Years
The data for each of the following statistics is listed by individual ages and age ranges:

F.	 Caries Free – The percent of patients of each given age (or in each given age range) without 
caries. This statistic is broken down by primary and permanent teeth and permanent teeth only. 
To be considered caries free, a patient cannot have any of the following conditions or codes 
posted in the Chart:

•	 Caries conditions 15104, 15105, 15106, or 15107.

•	 Missing teeth conditions 15100 or 15101.

•	 Procedure codes D2000 – D4276, D4910, D4999, D6000 – D6079, D6100, D6199 – D7259, or 
D7999.

G.	Untreated Decay – The percent of patients of each given age (or in each given age range) 
with untreated decay. An untreated caries is any caries condition code (15104, 15105, 15106, or 
15107) that has not had either a procedure that covers the same surface posted after the caries 
condition code was posted or has not had the corresponding tooth extracted (an existing, 
existing other, or missing tooth condition is considered extracted for the purposes of this 
report). This statistic is broken down by primary and permanent teeth and permanent teeth 
only. A restoration code on a tooth followed chronologically by an untreated caries condition 
indicates that the tooth decayed again after it was fixed and is counted as untreated decay.

H.	Using Tobacco – The percent of patients of each given age or in each given age range (with 
caries) who are using tobacco (patients who have the condition code “15203 Tobacco Use” 
posted in the Chart).

I.	 Dental Fluorosis – The percent of patients of each given age or in each given age range 
(with caries) who have dental fluorosis (patients who have the condition code “15200 Dental 
Fluorosis” posted in the Chart).

J.	 Sealants – The percent of patients of each given age or in each given age range (with caries) 
who have dental sealants (patients who have the sealant code D1351 posted in the Chart).

K.	 Mean # of Sealed Teeth – The total number of sealed teeth for all patients of each given age 
(or in each given age range) divided by the number of patients of each given age (or in each 
given age range).

L.	 Mean dmft/DMFT – The dmft/DMFT for all patients of each given age (or in each given age 
range) divided by the number of patients of each given age (or in each given age range). A 
tooth with an untreated caries code that has been fixed later is counted only once.

Age Group 15 - 19 Years
The data for each of the following statistics is listed by individual ages:

F.	 Caries Free – The percent of patients of each given age without caries. This statistic applies to 
both primary and permanent teeth. To be considered caries free, a patient cannot have any of 
the following conditions or codes posted in the Chart:

•	 Caries conditions – 15104, 15105, 15106, or 15107.

•	 Missing teeth conditions – 15100 or 15101.

•	 Procedure codes – D2000 to D4276, D4910, D4999, D6000 to D6079, D6100, D6199 to 
D7259, or D7999.
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G.	Untreated Decay – The percent of patients of each given age with untreated decay. An 
untreated caries is any caries condition code (15104, 15105, 15106, or 15107) that has not had 
either a procedure that covers the same surface posted after the caries condition code was 
posted or has not had the corresponding tooth extracted (an existing, existing other, or missing 
tooth condition is considered extracted for the purposes of this report). This statistic applies to 
both primary and permanent teeth. A restoration code on a tooth followed chronologically by 
an untreated caries condition indicates that the tooth decayed again after it was fixed and is 
counted as untreated decay.

H.	Using Tobacco – The percent of patients of each given age (with caries) who are using tobacco 
(i.e. patients who have the condition code “15203 Tobacco Use” posted in the Chart).

I.	 Dental Fluorosis – The percent of patients of each given age (with caries) who have dental 
fluorosis (i.e. patients who have the condition code “15200 Dental Fluorosis” posted in the 
Chart).

J.	 Sealants – The percent of patients of each given age (with caries) who have dental sealants (i.e. 
patients who have the sealant code D1351 posted in the Chart).

K.	 Mean # of Sealed Teeth – The total number of sealed teeth for all patients of each given age 
divided by the number of patients of each given age.

L.	 Mean dmft/ DMFT – The dmft/ DMFT for all patients of each given age divided by the number 
of patients of each given age. A tooth with an untreated caries code that has been fixed later is 
counted only once.

M.	Perio Pockets – The percent of patients of each given age with the specified perio pocket 
measurements.

N.	Loss of Attachment – The percent of patients of each given age with the specified clinical 
attachment level.

V.	 CPITN – The percent of patients in both age groups combined (ages 6 – 19) with the highest 
CPITN of 0, 1, 2, 3, and 4. CIPTN is calculated from periodontal exams within the date range of 
the report:

•	 Any patients who have a Probing Depth (PD or Pocket Depth) for any tooth higher than 6 
mm are counted towards the 4 category and are not counted towards any other category.

•	 Any patients who have a Probing Depth (PD or Pocket Depth) for any tooth of 4 - 6 mm are 
counted towards the 3 category and are not counted towards any other category.

•	 Any patients that are marked as having Plaque (not set to “0 - None”) and a Probing Depth 
(PD or Pocket Depth) for any tooth less than 4 for any tooth are counted towards the 2 
category and are not counted towards any other category.

•	 Any patients that have bleeding marked for any tooth are counted towards the 1 category 
and are not counted towards any other category.

•	 Any remaining patients should be counted towards the 0 category.

An explanation of the next page
of the report begins on page 60.
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Report Generated By: enterprise Page 3 of 3Report Date: 05/28/2018

Ages 35-44 & 55+ Years:

<-------------------------------------------------------------------------------------------Percent with------------------------------------------------------------------------------------------->
Untreated Decay

Prim & Perm teeth
Using Tobacco SealantsDental

Fluorosis
Sealants
1st Molar

Mean # of 
sealed teeth

Sealants 2nd 
molar

Sealants 1st
or 2nd Molar

Caries Free
Prim & Perm teeth

Mean DMFT

35 Years: 100.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
36 Years: 100.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
37 Years: 100.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
38 Years: 98.04 0.00 1.96 1.96 0.00 0.00 0.00 0.00 0.00 0.08
39 Years: 100.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
40 Years: 97.78 2.22 2.22 2.22 0.00 0.00 0.00 0.00 0.00 0.22
41 Years: 100.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
42 Years: 100.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
43 Years: 100.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
44 Years: 100.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
55 Years: 1,600.00 1.27 1.27 0.00 0.00 0.00 0.00 0.00 0.00 0.10

>= 4
and < 6mm

>= 3mm
and < 5mm Diabetes

All 28
Teeth

20+
Teeth

Need
Biopsy

No Natural
Teeth

<--------Percent with Perio Pockets--------> <----Percent with Loss of Attachment---->

< 4mm >= 6mm < 3mm >= 5mm

Percent of Dentate Adults with
Untreated 

Decay
Root

Caries

<----------------------------------Percent with---------------------------------->

35 Years: 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 100.00 100.00 0.00 0.000.00
36 Years: 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 100.00 100.00 0.00 0.000.00
37 Years: 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 100.00 100.00 0.00 0.000.00
38 Years: 1.96 1.96 1.96 1.96 1.96 1.96 0.00 1.96 100.00 100.00 0.00 0.000.00
39 Years: 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 100.00 100.00 0.00 0.000.00
40 Years: 2.22 2.22 2.22 2.22 2.22 2.22 2.22 2.22 97.78 100.00 0.00 0.002.22
41 Years: 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 100.00 100.00 0.00 0.000.00
42 Years: 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 100.00 100.00 0.00 0.000.00
43 Years: 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 100.00 100.00 0.00 0.000.00
44 Years: 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 100.00 100.00 0.00 0.000.00
55 Years: 1.27 1.27 1.27 1.27 1.27 1.27 0.00 0.00 1,600.00 1,601.27 0.00 0.001.27

Percent with Highest CPITN of 0,1,2,3,4 CPITN Percent

Ages 35-44 Years: Ages 55+ Years:

Percent with Highest CPITN of 0,1,2,3,4 CPITN Percent
4
3
2
1
0

4
3
2
1
00.00

0.00
0.00
0.00
0.52

0.00
0.00
0.00
0.00
0.15

F G H I J K L

M N O P Q R S T U

V

Page 3
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Age Group 35 - 44 Years and Age Group 55 Years and Older
The data for each of the following statistics is listed by individual ages:

F.	 Caries Free – The percent of patients of each given age without caries. To be considered caries 
free, a patient cannot have any of the following conditions or codes posted in the Chart:

•	 Caries conditions – 15104, 15105, 15106, or 15107.

•	 Missing teeth conditions – 15100 or 15101.

•	 Procedure codes – D2000 to D4276, D4910, D4999, D6000 to D6079, D6100, D6199 to 
D7259, or D7999.

G.	Untreated Decay – The percent of patients of each given age with untreated decay. An 
untreated caries is any caries condition code (15104, 15105, 15106, or 15107) that has not had 
either a procedure that covers the same surface posted after the caries condition code was 
posted or has not had the corresponding tooth extracted (an existing, existing other, or missing 
tooth condition is considered extracted for the purposes of this report). A restoration code 
on a tooth followed chronologically by an untreated caries condition indicates that the tooth 
decayed again after it was fixed and is counted as untreated decay.

H.	Using Tobacco – The percent of patients of each given age (with caries) who are using tobacco 
(patients who have the condition code “15203 Tobacco Use” posted in the Chart).

I.	 Dental Fluorosis – The percent of patients of each given age (with caries) who have dental 
fluorosis (patients who have the condition code “15200 Dental Fluorosis” posted in the Chart).

J.	 Sealants – The percent of patients of each given age (with caries) who have dental sealants (i.e. 
patients who have the sealant code D1351 posted in the Chart).

K.	 Mean # of Sealed Teeth – The total number of sealed teeth for all patients of each given age 
divided by the number of patients of each given age.

L.	 Mean DMFT – The DMFT for all patients of each given age divided by the number of patients 
of each given age. A tooth with an untreated caries code that has been fixed later is counted 
only once.

M.	Perio Pockets – The percent of patients of each given age with the specified perio pocket 
measurements.

N.	Loss of Attachment – The percent of patients of each given age with the specified clinical 
attachment level.

O.	Diabetes – The percent of patients of each given age (with perio measurements that appear on 
this report) who have diabetes (patients who have the condition code “15201 Diabetes” posted 
in the Chart).

P.	 Need Biopsy – The percent of patients of each given age (with perio measurements that 
appear on this report) who need biopsies (patients who have the condition code “15202 Needs 
Biopsy” posted in the Chart).

Q.	All 28 Teeth – The percent of patients of each given age who have all 28 natural teeth (patients 
who do not have any Existing, Existing Other, or Completed extractions, other than wisdom 
teeth, or condition codes “15100 Missing Tooth > 1 year” or “15101 Missing Tooth” posted in 
the Chart).
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R.	 20+ Teeth – The percent of patients of each given age who have 20 or more natural teeth. A 
patient has a missing tooth if an extraction, appropriate condition, or appropriate Existing/ 
Existing Other code is posted in the patient’s Chart.

S.	 No Natural Teeth – The percent of patients of each given age who have no natural teeth.

T.	 Untreated Decay (Dentate Adults) – The percent of dentate patients of each given age with 
untreated decay (patients who do not have both D5110 and D5120 and have untreated decay—
any condition code 15104 –15107—posted in the Chart). A restoration code on a tooth followed 
chronologically by an untreated caries condition indicates that the tooth decayed again after it 
was fixed and is counted as untreated decay.

U.	Root Caries (Dentate Adults) – The percent of dentate patients of each given age with root 
caries (i.e. patients who have the condition code “15104 Deep Dentinal/Cemental Caries” 
posted in the Chart).

V.	 CPITN – The percent of patients in each age group (ages 35 – 44, and 55 and older) with the 
highest CPITN of 0, 1, 2, 3, and 4. CIPTN is calculated from periodontal exams within the date 
range of the report:

•	 Any patients who have a Probing Depth (PD or Pocket Depth) for any tooth higher than 6 
mm are counted towards the 4 category and are not counted towards any other category.

•	 Any patients who have a Probing Depth (PD or Pocket Depth) for any tooth of 4 - 6 mm are 
counted towards the 3 category and are not counted towards any other category.

•	 Any patients that are marked as having Plaque (i.e. not set to “0 - None”) and a Probing 
Depth (PD or Pocket Depth) for any tooth less than 4 for any tooth are counted towards the 
2 category and are not counted towards any other category.

•	 Any patients that have bleeding marked for any tooth are counted towards the 1 category 
and are not counted towards any other category.

•	 Any remaining patients should be counted towards the 0 category.
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Clinical Notes Report
The Clinical Notes report displays a clinical note for a patient on a specified date.

Why:	 To print a patient’s clinical notes on a specific day

When:	 As needed

PATIENT CLINICAL NOTE(ABBOTT, JAMES S)
The Allied Dentist Group

Date: Page:05/13/2018 1
Billing Types 1 - 254

PATIENT NAME CHART NUM SS# HOME PHONE WORK PHONE LAST VISIT

Abbott, James S ABB101 000-00-0000            555-1586                                                           05/05/2009
CLINICAL NOTES

Note Date:  01/28/2018
-----<Wed - Jan 28,2018>----------<10:04:46>----- <ENTERPRISE>----------<Wed - Jan 28,2018>----------<10:05:10>----- <ENTERPRISE>-----[ ] I have 
seen and examined the patient with the resident.  I have discussed the case with the resident.[ ] I agree  with the diagnosis and treatment plan as 
documented in the resident's note.[ ] Straight forward[ ] Low Complexity[ ] Moderate Complexity[ ] High Complexity[ ] Greater than 50% of the visit 
was spent counseling the patient and discussing the treatment plan.-----<Wed - Jan 28,2018>----------<11:21:09>----- <ENTERPRISE>----------<Wed 
- Jan 28,2018>----------<11:21:50>----- <ENTERPRISE>-----

A
B
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How do I run the Clinical Notes Report?
In the Family File, Patient Chart, or Ledger, from the File menu, click Clinical Notes, and then click 
the Print button;  or in DXOne Reporting, select Lists, and then double-click Clinical Notes. For 
more detailed instructions on how to generate this report, see the “Clinical Notes Report” and 
“Printing clinical notes” topics of the Dentrix Enterprise Help (from the Help menu of any module, 
click Contents).

What important information does this report provide?
A.	Patient Details – The patient’s name, chart number, Social Security number, home and work 

phone numbers, and last visit date.

B.	 Note Details – The creation date and text of the clinical note.
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Clinical Quality Measures List
The Clinical Quality Measures List displays each Meaningful Use measure, the corresponding 
results (the population, the denominator and numerator used for calculating the actual percentage 
for a result, exclusions, and exceptions), and the details of the requirement for that measure.

Why:	 To view the calculated results of Meaningful Use clinical measures

When:	 As needed

 

A
C D EB

F
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How do I run the Clinical Quality Measures List?
In the Office Manager, from the Analysis menu, point to Meaningful Use, and then click Clinical 
Quality Measures. After opening CQMsolution, click Create Report. For additional details about 
running this report, see the “Clinical Quality Measures List” topic in the Office Manager portion of 
the Dentrix Enterprise Help (from the Help menu of any module, click Contents).

What important information does this report provide?
The CQM report results include all the measures that were defined for the report.

A.	Measures – The list of measures.

B.	 Results – The calculated results.

C.	 Population – The patients.

D.	Denominator – The denominator used in the calculation.

E.	 Numerator – The numerator used in the calculation.

F.	 Exclusions and Exceptions – Exclusions and exceptions that were not taken into account 
during the calculation.

Note: To view details of any of the measures in the report, click View Detail.

The following tables explain the calculations and requirements for each measure.

68 Documentation of Current Medications in the Medical Record

Requirement: Percentage of patient visits for patients aged 18 years and older for which the 
eligible professional (EP) attests to documenting a list of current medications using all immediate 
resources available on the date of the encounter. This list must include all known prescriptions, 
over-the-counter drugs, herbal supplements/medicines, and vitamin/mineral/dietery (nutritional) 
supplements and must contain the medications’ name, dosage, frequency, and route of 
administration.

Exception: Patient is in an urgent or emergent medical situation where time is of the essence and 
to delay treatment would jeopardize the patient’s health status.

Initial Patient 
Population

The number of patients 18 years old or older before the start of the specified 
Measurement Period who have visits occurring during the 12-month reporting 
period.

Denominator The number of patients in the Initial Patient Population.

Numerator The number of patients (from the Denominator) for whom the EP attests to 
documenting a list of current medications for those patients.
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74 Primary Caries Prevention Intervention as Offered by Primary Care Providers, Including 
Dentists
Requirement: Percentage of children who are less than 20 years of age and who received a 
fluoride varnish application during the specified Measurement Period.

Initial Patient 
Population

The number of children who are less than 20 years old with a visit during the 
specified Measurement Period.

•	 Stratum 1 – Patients 0 to 5 years old.

•	 Stratum 2 – Patients 6 to 12 years old.

•	 Stratum 3 – Patients 13 to 19 years old.

Denominator The number of patients in the Initial Patient Population.

Numerator The number of patients (from the Denominator) who receive a “Fluoride Varnish” 
(a procedure posted from the Chart with the appropriate CDT code).

75 Children Who Have Dental Decay or Cavities

Requirement: Percentage of children who are less than 20 years old who have tooth decay or 
cavities during the specified Measurement Period.

Initial Patient 
Population

The number of children who are less than 20 years old with a visit during the 
specified Measurement Period.

Denominator The number of patients in the Initial Patient Population.

Numerator The number of patients (from the Denominator) who have “Tooth Decay” or 
“Cavities” (a condition/diagnosis with the appropriate ICD-9-CM code).

138 Preventive Care and Screening: Tobacco Use: Screening and Cessation Intervention

Requirement: Percentage of patients aged 18 years or older who were screened for tobacco 
use one or more times within 24 months and who received cessation counseling intervention if 
identified as a tobacco user.

Exception: Documentation of medical reason(s) for not screening for tobacco use (for example, 
limited life expectancy or other medical reason).

Initial Patient 
Population

All patients aged 18 years old or older.

Denominator The number of patients in the Initial Patient Population.

Numerator The number of patients (from the Denominator) who have been identified as a 
“Tobacco User” (a patient with the appropriate SNOMED-CT code) or “Non-
Tobacco User” (a patient with the appropriate SNOMED-CT code) within 24 
months of a patient’s health assessment or medical encounter being entered 
within the specified Measurement Period.
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156 Use of High-risk Medications in the Elderly

Requirement: Percentage of patients 66 years of age or older who were ordered high-risk 
medications.

Initial Patient 
Population

Patients 66 years old or older who had a visit during the specified Measurement 
Period.

Denominator The number of patients in the Initial Patient Population.

Numerator 1 Patients with an order for at least one “High-risk Medication” (a prescription with 
the appropriate RxNorm code) during the specified Measurement Period.

Numerator 2 Patients with an order for at least two different “High-risk Medications” 
(prescriptions with the appropriate RxNorm codes) during the specified 
Measurement Period.

165 Controlling High Blood Pressure

Requirement: The percentage of patients 18-85 years of age who had a diagnosis of 
hypertension and whose BP was adequately controlled during the measurement year.

Initial Patient 
Population

The number of patients who were 18 years old or older and less than or equal to 
85 years old before the beginning of the specified Measurement Period.

Denominator The number of patients in the Initial Patient Population who were diagnosed with 
“Hypertension” (a medical alert with the appropriate ICD-9-CM or SNOMED-CT 
code) up to 6 months after the specified Measurement Period and who have an 
“Encounter Outpatient” (a patient health assessment or medical encounter with 
the appropriate AMA-CPT code) with one of the selected Providers within the 
specified Measurement Period and who do not have one of the following:

•	 Evidence of end stage renal disease (ESRD) (an “active” medical alert with the 
appropriate ICD-9-CM or SNOMED-CT code).

•	 One or more procedures, such as dialysis or a renal transplant, that were 
performed for ESRD (a procedure posted from the Chart with the appropriate 
AMA-CPT code).

•	 Active diagnosis of “Pregnancy” (an “active” medical alert with the 
appropriate ICD-9-CM or SNOMED-CT code).

•	 “Encounter Pregnancy” (a medical encounter with the appropriate ICD-9-CM 
code).

Numerator The number of patients (from the Denominator) who have had a diastolic blood 
pressure reading less than 90 mmHg and a systolic blood pressure reading 
greater than 140 mmHg during the most recent patient health assessment with 
one of the selected Providers within the specified Measurement Period.
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Collections Manager List
The Collections Manager List is a highly customizable report that lists guarantors with outstanding 
balances.

Why:	 To identify guarantors with outstanding balances so they can be targeted for 
collections

When:	 Monthly

�����������������������

�����
���
�	�����
�����������
�a��� ��/��/��17 ����� �
���	�
��� ����
�� �
��� ��
��� ��
� �  �
� ���	�� �­��
� �
�����

GUAR EST LAST PMT PMT AMT AMT DUE # PRV OJ PRV TYPE REMINDER REM TYPE

NOTE
�bbott�James�� ������ ���� ���� ���� ������ 
�� ���� ����

117.42 0.00 0.00 0

James is divorced from Cathy Davis and is the primary insurance provider for their three children.
Brown�Mary�� ������ ���� ���� ���0 ������ 
�� ���� ����

144.20 0.00 0.00 0

Crosby�Brent�­ ��  ��� ������� ���� ���� ������� ������� � ���� ������
3014.60 12/29/2017 125.00 0.00 0

Davis�Janet � ��� � �� � ���� ���� ����� 
�� ���� ����
66.96 0.00 0.00 0

Edwards��ohn�� ������� ���� ���� ���� ������� ������� ���� ����
1115.00 0.00 129.90 1

Farrer�Lisa� ��� � �� � ���� ���� ����� 
�� ���� ����
66.96 0.00 0.00 0

Gleason�Gary�� ������ ����� ���� ���� ������ 
�� ���� ����
786.00 11/18/2017 65.00 0.00 0

Hayes�Sally� ������ ������ ���� ���� ����� 
�� ����� �����
146.12 11/18/2017 0.00 0.00 0

Perkins�Shelly���� ��� � �� � ���� ���� ����� 
�� ���� ����
66.96 0.00 0.00 0

Smith�Michael� ��� � �� � ���� ���� ����� 
�� ���� ����
66.96 0.00 0.00 0

Winters�C������ ���� � �� � ���� ���� ������ 
�� ���� ����
133.90 0.00 0.00 0

�­�����
����
�� �
��� ��
��� ��
� �  �
� ���	�� �­��
� �
����� ���	���� ������� ������� �
������� ������� ���� ���� ������� �������  ����� ������ ������� � ���� �� � � �
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How do I run the Collections Manager List?
1.	 From the Collections Manager, click View Setup on the menu bar to open the Collections 

Manager View dialog box.

2.	 Configure the view filters as needed.

3.	 Click Show Columns to open the Show Columns dialog box.

4.	 Add/remove the data you want included/excluded on the report in the Show these columns in 
this order list box.

5.	 Click OK to save the settings and close the Show Columns dialog box.

6.	 Click OK to save the settings and close the Collections Manager View dialog box.

7.	 From the Print menu, click Collections Manager List.

8.	 Click Yes to run the report.
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For additional details about running this report, see the “Printing the Collections Manager List” 
topic in the Collections Manager portion of the Dentrix Enterprise Help (from the Help menu of 
any module, click Contents).

What important information does this report provide?
A.	Guarantor Details – The information displayed in this section is highly customizable and 

depends on the settings configured in step 4 of the How do I run this report? section. The 
following is a comprehensive list of the possible data:

•	 # Pmts Missed •	 Guarantor City
•	 0-30 Balance •	 Guarantor Estimate
•	 31-60 Balance •	 Guarantor Name
•	 61-90 Balance •	 Guarantor State
•	 >91 Balance •	 Guarantor Zip Code
•	 Account Clinic •	 Home Phone
•	 Account Provider •	 Insurance Estimate
•	 Acct Balance •	 Last Payment Amount
•	 Amt Billed to Ins •	 Last Payment Date
•	 Best Time to Call •	 Last Statement Date
•	 Billing Type •	 PA Amount Due
•	 Birthday & Age •	 PA Rem Balance
•	 Chart # •	 Prev Office Journal Entry
•	 Email Address •	 Prev OJ Entry Type
•	 Family Position •	 Soc Sec #
•	 Future Rem. Type •	 Suspended Credit
•	 Future Reminder Date •	 Work Phone & Ext

B.	 Guarantor Notes – If you select Include Guarantor Account Notes when setting options for 
this report, guarantor notes appear on the report.

C.	 Report Totals – Combined totals for all guarantors.
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Continuing Care Cards - No 
Appointment
The Continuing Care Cards - No Appointment letter merge generates continuing care reminder 
cards for patients who have continuing care attached in the Family File but are not scheduled for a 
continuing care appointment.

Why:	 To generate continuing care reminder cards

When:	 Monthly

Dental Practice 
1234 Oak St 

Suite 500 
American Fork, UT 84003 

(801) 555-1234

Dear Brent 

This is just to remind you that it’s time 
for your next dental examination!  
Please call us at your convenience to 
schedule an appointment.  Your last 
exam was February 5, 2017.  We look 
forward to hearing from you soon. 

Brent Crosby 
123 Actor Lane 

Beverly Hills, CA 90210 

How do I run the Continuing Care Cards - No 
Appointment?
1.	 From the Office Manager, click Letters on the menu bar to open the Letters dialog box.

2.	 Click Continuing Care to open the Continuing Care Letters dialog box.

3.	 Select Continuing Care - W/O Appt, and click Create/Merge to open the Create/Merge 
Options dialog box.

4.	 Select Create Data File and Merge Letters, and click OK to create the reminder cards.

For additional details about running this report, see the “Creating cards for patients without 
appointments” topic in the Office Manager portion of the Dentrix Enterprise Help (from the Help 
menu of any module, click Contents).
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Continuing Care Cards - with 
Appointment
The Continuing Care Cards - with Appointment letter merge creates reminder cards for patients 
who have a continuing care appointments scheduled.

Why:	 To generate continuing care reminder cards

When:	 Monthly

Dental Practice 
1234 Oak St 

Suite 500 
American Fork, UT 84003 

(801) 555-1234

Dear James 

This is to remind you that it is time for 
your Perio Maint.  You have scheduled an 
appointment on Friday, February 22, 2018 
at 8:00am.  Please call us today if you 
need to re-schedule.  We look forward to 
seeing you soon. 

James Abbott 
123 Oak St 

Murray, UT 84123 

How do I run the Continuing Care Cards - with 
Appointment?
1.	 From the Office Manager, click Letters on the menu bar to open the Letters dialog box.

2.	 Click Continuing Care to open the Continuing Care Letters dialog box.

3.	 Select Continuing Care - With Appt, and click Create/Merge to open the Create/Merge 
Options dialog box.

4.	 Select Create Data File and Merge Letters, and click OK to create the reminder cards.

For additional details about running this report, see the “Creating appointment reminder cards” 
topic in the Office Manager portion of the Dentrix Enterprise Help (from the Help menu of any 
module, click Contents).
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Continuing Care Display List
The Continuing Care Display list displays continuing care appointments based on the continuing 
care views set up in the Appointment Book.

Why:	 To view continuing care appointments

When:	 Monthly or as needed

CONTINUING CARE DISPLAY LIST
The Dentist Group

Date: Page:03/23/2018 1

DATE TYPE APPOINTMENT STATUS PRIOR TREAT. NAME AGE PROV. INSURANCE CARRIER
H PHONE SUS. CR.31-600-30CLINIC
W PHONE BALANCE90 ->61-90

05/15/2018 PROPHY 03/28/2011+ 11/11/2017 *Davis, Karen 65 Prov1 Acme Benefits Assoc
555-1530 DRAPER 0.000.000.00

1924.801924.800.00

09/02/2018 PROPHY + 6M Crosby, Jill 30 Prov2 Allied Group Insurance Trust
(743)555-2381 CENTRAL 0.000.000.00

0.000.000.00

10/23/2018 Pmt Promis 03/28/2011+ 11/11/2016 *Crosby, Brent 64 Prov1 Allied Group Insurance Trust
(743)555-2381 DRAPER 0.000.000.00
(743)555-4900 0.000.000.00

11/11/2018 PROPHY 03/28/2011+ 11/11/2017 Edwards, Anna 57 Prov1 Utah Acme Insurance Plan
555-7101 DRAPER 0.000.000.00

21.0021.000.00

11/11/2018 PROPHY 03/28/2011+ *Edwards, John 61 Prov1 Utah Acme Insurance Plan
555-7101 DRAPER 0.000.000.00

21.0021.000.00

11/28/2018 PROPHY 03/28/2011+ 6M       11/11/2017 Davis, Harmon 68 Prov2 Utah Acme Insurance Plan
555-3452 DRAPER 0.000.000.00

1924.801924.800.00

11/28/2018 PERIO + 11/11/2017 *Davis, Karen 65 Prov1 Acme Benefits Assoc
555-1530 DRAPER 0.000.000.00

1924.801924.800.00

A B C D E F
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How do I run the Continuing Care Display List? 
1.	 From any module, click the Continuing Care button to open the Continuing Care window.

2.	 From the View menu, click a continuing care view.

3.	 From the File menu, click Print to print the continuing care view.

For additional details about running this report, see the “Printing from Continuing Care” topic in 
the Other Features portion of the Dentrix Enterprise Help (from the Help menu of any module, 
click Contents).

What important information does this report provide?
The following information (with the exception of letter F) is found in the Edit Continuing Care 
dialog box, which can be accessed by double-clicking the Continuing Care block in the Family File 
and then double-clicking a continuing care type.

A.	Date – The continuing care due date.

B.	 Type – The continuing care type.

C.	 Appointment – The date of the patient’s scheduled continuing care appointment (if one exists).

D.	Status – The appointment status.

E.	 Prior Treatment – The date of the patient’s last posted procedure.

F.	 Aged Balance – The patient’s account balances.

A

B

C

D

E
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Coupon Book - Future Due 
Payments
The Future Due Payments coupon book creates a payment slip for each payment a patient will 
make during a payment plan.

Why:	 To provide your patients with a packet of payment slips customized for their 
future due payment plan

When:	 After creating a future due payment plan and as needed

PAYMENT NUMBER PAYMENT NUMBER

AMOUNT PAID AMOUNT DUE DATE DUE

CHECK NO.

DATE PAID

BALANCE DUE AMOUNT ENCLOSED

REMIT TO:

PATIENT:

CHANGE OF ADDRESS:

PLEASE RETURN THIS PORTION WITH YOUR PAYMENT

INSTALLMENT PLAN COUPON

Chart: Soc.Sec:

PMTS - DENTRIX DENTAL SYSTEMS
123 E. Valley Dr.
Suite 500
American Fork, UT 84003

(801)555-9300

Kirk O Baber BA0001 000-00-0000
11 Maple Leaf Ln.
Colmar, PA 18915

1 of 15 1 of 15

76.74 12/30/2017

1174.26

PAYMENT NUMBER PAYMENT NUMBER

AMOUNT PAID AMOUNT DUE DATE DUE

CHECK NO.

DATE PAID

BALANCE DUE AMOUNT ENCLOSED

REMIT TO:

PATIENT:

CHANGE OF ADDRESS:

PLEASE RETURN THIS PORTION WITH YOUR PAYMENT

INSTALLMENT PLAN COUPON

Chart: Soc.Sec:

PMTS - DENTRIX DENTAL SYSTEMS
123 E. Valley Dr.
Suite 500
American Fork, UT 84003

(801)555-9300

Kirk O Baber BA0001 000-00-0000
11 Maple Leaf Ln.
Colmar, PA 18915

2 of 15 2 of 15

76.74 01/30/2018

1097.52

PAYMENT NUMBER PAYMENT NUMBER

AMOUNT PAID AMOUNT DUE DATE DUE

CHECK NO.

DATE PAID

BALANCE DUE AMOUNT ENCLOSED

REMIT TO:

PATIENT:

CHANGE OF ADDRESS:

PLEASE RETURN THIS PORTION WITH YOUR PAYMENT

INSTALLMENT PLAN COUPON

Chart: Soc.Sec:

PMTS - DENTRIX DENTAL SYSTEMS
123 E. Valley Dr.
Suite 500
American Fork, UT 84003

(801)555-9300

Kirk O Baber BA0001 000-00-0000
11 Maple Leaf Ln.
Colmar, PA 18915

3 of 15 3 of 15

76.74 02/28/2018

1020.78

How do I run the Coupon Book - Future Due Payments?
1.	 In the Ledger, from the Transaction menu, click Process Future Due Payment Plan to open 

the Payment Plan dialog box.

2.	 Enter the payment plan details.

3.	 Select the Print Payment Book check box.

4.	 Click OK to open the Payment Book dialog box.

5.	 Set print options, and click Send to Batch or Print to generate the Future Due Payments 
coupon book.

For additional details about running this report, see the “Creating future due patient plans” topic 
in the Ledger portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).
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Coupon Book - Payment 
Agreements
The Payment Agreement coupon book creates a payment slip for each payment a patient will make 
throughout the course of a payment agreement.

Why:	 To provide your patients with a packet of payment slips customized for their 
payment agreement

When:	 After creating a payment agreement, and as needed

�����������������������

AMOUNT PAID

CHECK NO.

DATE PAID

BALANCE DUE

PAYMENT NUMBER

���������

��������

�����������

�����

PLEASE RETURN THIS PORTION WITH YOUR PAYMENT

PAYMENT NUMBER

AMOUNT ENCLOSED

DATE DUEAMOUNT DUE

�����������������������

AMOUNT PAID

CHECK NO.

DATE PAID

BALANCE DUE

PAYMENT NUMBER

���������

��������

�����������

�����

PLEASE RETURN THIS PORTION WITH YOUR PAYMENT

PAYMENT NUMBER

AMOUNT ENCLOSED

DATE DUEAMOUNT DUE

�����������������������

AMOUNT PAID

CHECK NO.

DATE PAID

BALANCE DUE

PAYMENT NUMBER

���������

��������

�����������

�����

PLEASE RETURN THIS PORTION WITH YOUR PAYMENT

PAYMENT NUMBER

AMOUNT ENCLOSED

DATE DUEAMOUNT DUE
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How do I run the Coupon Book - Payment Agreements?
1.	 From the Ledger, click the Payment Agreement button to open the Billing/Payment 

Agreement Information dialog box.

2.	 Enter the payment agreement details.

3.	 Click Print to open the Print for Payment Agreement dialog box.

4.	 Select Coupon Book for Scheduled Payments, and click Send to Batch or Print to generate 
the Payment Agreement coupon book.

For additional details about running this report, see the “Printing payment agreement documents” 
in the Ledger portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).
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Credit Card Transaction Report
The Credit Card Transaction Report displays a list of transactions that were processed using the 
integration of Axia (the third-party provider of the credit card processing service) with Dentrix 
Enterprise.

Why:	 To review the credit card transactions that were processed through Axia, and to 
ensure transaction totals balance out over a variety of reports

When:	 Daily and as needed

7 7

7

7

7

7

7  

7  

7

A

B
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How do I run the Credit Card Transaction Report?
From the DXOne Reporting module, select Management, and then double-click Credit Card 
Transaction. For additional details about running this report, see the “Credit Card Transaction 
Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu 
of any module, click Contents).

What important information does this report provide?
A.	Transaction – For each transaction on the report, the following information appears: date 

and time, cardholder’s name, terminal name, payment type (such as charge or credit), card 
type (such as VISA or MasterCard), payment status (such as processed or void), transaction ID, 
logged-in user who posted it, billing type of patient’s family, and amount of transaction (positive 
or negative).

B.	 Totals – The total number of transactions on the report and the sum of those transactions
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Custom Practice Information Report
The Custom Practice Information Report displays customizable information entered during Dentrix 
Enterprise setup (for example, billing types and payment types).

Why:	 To ensure custom practice information has be entered properly

When:	 After Dentrix Enterprise setup and as needed

CUSTOM PRACTICE INFORMATION
The Dentist Group

Date: Page:04/22/2018 1

ID BILLING TYPE

1 Standard Billing - finance charges
2 Standard Billing - no finance charges
3 Insurance Family - delay finance charges
4 Insurance Family - finance charges
5 Payment Plan - finance charges
6 Payment Plan - no finance charges
7 No Statement and No Finance Charges
8 Bad Debt - at risk
9 Bad Debt - to collections

PAYMENT TYPES

 Check Payment - Thank You
 Cash Payment - Thank You
 Credit Card Payment -Thank You

ADJUSTMENT TYPES

-Professional Discount
-Cash Discount
-Credit Adjustment
+Debit Adjustment
+Patient Refund
-Write-Off

CUSTOM NOTES

Consulted with patient about dental hygiene
Patient has excellent dental hygiene
Patient has normal dental hygiene

MEDICAL ALERT NAME

*Premedicate
Allergies
Anemia
Arthritis
Artificial Joints
Asthma
Blood Disease
Cancer
Diabetes
Dizziness
Epilepsy
Excessive Bleeding
Fainting
Glaucoma
Growths
Hay Fever
Head Injuries
Heart Disease
Heart Murmur

A

B

C

D
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CUSTOM PRACTICE INFORMATION
The Dentist Group

Date: Page:04/22/2018 2

MEDICAL ALERT NAME   (continued)

Hepatitis
High Blood Pressure
Jaundice
Kidney Disease
Liver Disease
Mental Disorders
Nervous Disorders
Pacemaker
Pregnancy
Radiation Treatment
Respiratory Problems
Rheumatic Fever
Rheumatism
Sinus Problems
Stomach Problems
Stroke
Tuberculosis
Tumors
Ulcers
Venereal Disease
Codeine Allergy
Penicillin Allergy
Other

APPOINTMENT STATUS TYPES

xAPTSET    Appointment Set
2FIRM      Appointment Confirmed
xLMTape    Left message on tape
xLMpers    Left message w/person
xLMwrk     Left message at work
xNOansw    No answer
xEMER      Emergency appt
xCANC      Cancelled
xMISSED    Missed Appointment

APPOINTMENT CHECK LIST DESCRIPTIONS

Appointment Verified
Personal Information
Insurance Coverage
Referred By
Consent Form Signed
Follow Up?
Cont. Care Set
Other Family Appts
Next Appointment

E

F

How do I run the Custom Practice Information Report?
In the Office Manager, from the Reports menu, point to Reference, and then click Custom 
Practice Information.

What important information does this report provide?
The following report information is found in the Practice Definitions dialog box, which can be 
accessed in the Office Manager. See the topics for “Practice Definitions” in the Office Manager 
portion of the Dentrix Enterprise Help for details about how to edit this information.

A.	Billing Types

B.	 Payment Types

C.	 Adjustment Types

D.	Custom Notes

E.	 Appointment Status Types

F.	 Appointment Check List Descriptions
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Daily Appointment List (DX1)
The Daily Appointment List displays the practice’s daily appointments. The report displays 
details of each appointment and corresponding patient information. Also, you can specify how 
appointments on the report are sorted.

Why:	 To assist with appointment confirmation phone calls, to use as a quick reference 
list for the current day’s patients

When:	 Daily

Server Name: <Default>

Daily Appointment List
Date Range: 04/11/2019 - 04/11/2019

Clinics: <ALL>

Providers: <ALL>

Appointment Providers: <ALL>

Operatories: <ALL>

Sorted By: Appt Date/Time

Page 1 of 1Report Generated By: ENTERPRISEReport Date: 4/10/2019

Status Appointment Reason LengthDate Patient Name PhonePROV/OPTime

NOansw08:00am04-11-2019

NOansw08:10am04-11-2019

2BWX, ProphyAd 60m        (801) 555-1586 

ExtSingTh#1, ExtEchAdd#32          60m 

FluoridCh                                         50m        (801) 555-1586LMpers08:40am04-11-2019

 60mProphyAdNOansw

TTRAN/AF-02 

DSMITH/AF-01

DSMITH/AF-03 

AMCCLURE/AF-0109:00am04-11-2019

 50mConsult (046) 555-6919NOansw09:20am04-11-2019

 40mAmalg3Per#5NOansw10:00am04-11-2019

 50mSilicate#1 (942) 555-4952FIRM11:10am04-11-2019

 70m (919) 555-1069PeriodicXNOansw01:00pm04-11-2019

DSMITH/AF-04 

MHAYES/AF-01 

MHAYES/AF-03 

TTRAN/AF-02 

Abbott, Patricia 

Cox, Sara

Abbott, James S 

Larson, Jennifer 

Smith, Donald L 

Winters, Carl

Smith, Albert C 

Abbott, Patricia S

A B C D FE
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How do I run the Daily Appointment List (DX1)?
From the DXOne Reporting module, select List, and then double-click Daily Appointment List. 
For additional details about running this report, see the “Daily Appointment List” topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
The appointments on the report can be sorted by one of the various primary sort options available 
(appointment date and time, appointment status, patient name, appointment provider name, or 
operatory name) and then by a secondary sort option (if specified). Each clinic’s appointments can 
start on a new page.

A.	Time - The appointment start time.

B.	 Status - The appointment status (whether the appointment has been confirmed or not).

C.	 Patient Name - The patient for whom the appointment has been scheduled.

D.	Prov/Op - The provider and operatory assigned to the appointment.

E.	 Appointment Reason - The procedures to be performed.

F.	 Phone - The patient’s phone number.
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Daily Appointment List Report
The Daily Appointment List Report displays the practice’s daily appointments. Appointments are 
sorted by appointment date and time.

Why:	 To assist with appointment confirmation phone calls, to use as a quick reference 
list for the current day’s patients

When:	 Daily

Date: Page:04/23/2018 1

DAILY APPOINTMENT LIST
The Dentist Group

Providers <ALL> - <ALL>
Operatories <ALL> - <ALL>

Sorted By:  Appt Date/Time, Operatory Name 
04/24/2018  -  04/24/2018

DATE TIME STATUS PATIENT NAME PROV/OP APPT. REASON LENGTH PHONE

04/24/2018    10:00am Abbott, James S           DDS1/DEF_OP1          CCAdult, ProphyAd 110m            (   )555-1586
04/24/2018    11:00am     <CMPL>            Little, Brian R DDS1/DEF_OP2       ResCmP2s#15 10m (   )
04/24/2018    11:00am     <CMPL>            Taylor, Mark DDS1/DEF_OP3       Sealant#15, Sealant#1           30m (   )
04/24/2018    11:40am     <CMPL>            Abbott, Patricia             DDS2/DEF_OP1        ExtErpTh#16, ExtErpT           50m           (   )555-1586
04/24/2018    11:40am     NOansw            Brown, Mary DDS1/DEF_OP2       ExtEval 10m                    (   )555-1586
04/24/2018      1:00pm     NOansw            Johnson, Rachelle        DDS1/DEF_OP1        ProphyAd 60m        (801)555-5266
04/24/2018      1:10pm    NOansw             Crosby, Brent DDS1/DEF_OP2        NutriCnsl      10m           (   )555-1586
04/24/2018      1:00pm     NOansw            Crosby, Shirley             DDS01/DEF_OP3      2BWX, LwParMtBs#2      50m           (   )555-1586
04/24/2018     2:20pm     NOansw             Little, Carol DDS1/DEF_OP2       ExtEval 40m (   )
04/24/2018    3:00pm     NOansw             Edwards, John S          DDS1/DEF_OP1        4BWX 10m           (   )555-1586
04/24/2018      3:50pm    NOansw             Edwards, Anna             DDS1/DEF_OP2       FabPtCr+B#5 90m           (   )555-1586
04/24/2018      5:00pm     <CMPL>            Farrer, Lisa DDS1/DEF_OP1       CCAdult, Pano, FabPt             80m           (   )375-1586

A B C D FE
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How do I run the Daily Appointment List Report? 
In the Office Manager, from the Reports menu, point to Lists, and then click Daily Appointment 
List. Ensure the Daily Appointment List option is selected, and click OK. For additional details 
about running this report, see the “Daily Appointment List” topic in the Office Manager portion of 
the Dentrix Enterprise Help (from the Help menu of any module, click Contents).

What important information does this report provide?
A.	Time – The appointment start time.

B.	 Status – The appointment status (whether the appointment has been confirmed or not).

C.	 Patient Name – The patient for whom the appointment has been scheduled.

D.	Prov/Op – The provider and operatory assigned to the appointment.

E.	 Appointment Reason – The procedures to be performed.

F.	 Phone – The patient’s phone number.
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Daily Summary Report
The Daily Summary Report displays statistics for new guarantors, new patients, total patients seen, 
appointments made, production, collections, and adjustments.

Why:	 To generate a report of patient, appointment, and financial statistics to monitor 
daily activity

When:	 Daily

Daily Summary
9/20/2017 - 9/20/2017 Entry Date

Clinics: <ALL>

Billing Types: <ALL>

Payment Types: <ALL>

Adjustment Types: <ALL>

Page 1 of 1Report Date: 9/20/2017 Report Generated By: DSMITH

New Guarantors (New families in Family File) 4
New Patients (New patients in Family File) 10
Total Patients Seen 24
New Appointments 12
Charges from Procedures 9105.00
Patient Payments

100.00
3256.00

250.00
120.00
964.00

60.00
4960.00

620.00
758.00

2150.00
100.00

Total:  11088.00
Adjustments

Amex

Care Credit
Cash Payment 
Check Payment 
Credit Card Payment

Discover

Insurance Payment

Master Card

Visa

Credit

Debit

Total:  21600.00
G

F

A
B
C
D
E
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How do I run the Daily Summary Report?
From the DXOne Reporting module, select Management, and then double-click Daily Summary. 
For additional details about running this report, see the “Daily Summary Report” topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
The report can be grouped by clinic. The following information can be used to monitor daily 
activity:

A.	New Guarantors – The number of new families that were created in the Family File.

B.	 New Patients – The number of new patients that were created in the Family File.

C.	 Total Patients Seen – The number of patients who had procedures completed.

D.	New Appointments – The total number of appointments made. An appointment is counted 
if it was newly created, rescheduled from the unscheduled list, or moved from another day. An 
appointment with multiple changes is counted only once.

E.	 Charges from Procedures – The total amount of charges. This does not include adjustments, 
finance charges, or late charges.

F.	 Patient Payments – For each payment type, the total amount posted. The total amount of all 
payment types also appears.

G.	Adjustments – For each adjustment type, the total amount posted. The total amount of all 
adjustment types also appears.
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Day Sheet (Adjustments) Report
The Adjustments Day Sheet report lists credit adjustments, charge adjustments, finance charges, 
and late charges that have been posted to the Ledger.

Why:	 To print a record of adjustments each day, to review adjustment totals for a date 
or date range, and to ensure adjustment totals balance out over a variety of 
reports

When:	 Daily

Adjustment Day Sheet
04/22/2018 - 04/22/2018 Procedure Date

Clinics: <ALL>
Providers: <ALL>

Billing Type: <ALL>
Adjustment Types: <ALL>

Page 1 of 1Report Date: 04/22/2018 Report Generated By: enterprise

Operator ID AmountEntry Date Proc Date Patient Name Provider ClinicBTChart

+Debit Adjustment
04/22/2018 04/22/2018       Abbott, Patricia  <Family> ABB102 2       DDS1 CENTRAL          ENTERPRISE 10.00

TOTAL:  10.00QUANTITY: 1 AVERAGE: 10.00

Late Charge
04/22/2018 04/22/2018       Abbottt, Patricia  <Family> ABB102 2       DDS1 CENTRAL          ENTERPRISE 21.00

TOTAL:  21.00QUANTITY: 1 AVERAGE: 21.00

-Professional Discount
04/22/2018 04/22/2018       Abbott, Patricia <Family> ABB102 2       DDS1 CENTRAL          ENTERPRISE -10.00
04/22/2018 04/22/2018       Crosby, Brent  <Family> CRO987 1     DDS1 CENTRAL          ENTERPRISE -10.00

TOTAL:  -20.00QUANTITY: 2 AVERAGE: -10.00

Grand Totals Quantity Amount Average
Total Credit Adjustments -20.002 -10.00
Total Debit Adjustments 10.001 10.00
Total Finance Charges 0.000 0.00
Total Late Charges 21.001 21.00

11.00Totals 2.754

A B

C

Adjustment Day Sheet
04/22/2018 - 04/22/2018 Procedure Date

Clinics: <ALL>
Providers: <ALL>

Billing Type: <ALL>
Adjustment Types: <ALL>

Page 1 of 1Report Date: 04/22/2018 Report Generated By: enterprise

Operator ID AmountEntry Date Proc Date Patient Name Provider ClinicBTChart

Provider: DDS1
Clinic: CENTRAL

+Debit Adjustment
2 DDS1 CENTRAL ENTERPRISEABB102 10.00

TOTAL:  10.00AVERAGE: 10.00

2 DDS1 CENTRAL ENTERPRISEABB102 21.00
TOTAL:  21.00

04/22/2018 04/22/2018 Abbott, Patricia  <Family>
QUANTITY: 1

Late Charge
04/22/2018 04/22/2018 Abbott, Patricia  <Family>
QUANTITY: 1 AVERAGE: 21.00

-Professional Discount
1 DDS1 CENTRAL ENTERPRISE -10.00

TOTAL:  -10.00AVERAGE: -10.00

CLINIC TOTAL:  21.00

04/22/2018 04/22/2018 Larson, Bill  <Family>
QUANTITY: 1

QUANTITY: 3 AVERAGE: 7.00

PROVIDER TOTAL:  21.00QUANTITY: 3 AVERAGE: 7.00

Provider: DDS2
Clinic: CENTRAL

-Professional Discount
2 DDS2 CENTRAL ENTERPRISEABB102 -10.00

TOTAL:  -10.00AVERAGE: -10.00

CLINIC TOTAL:  -10.00

04/22/2018 04/22/2018 Abbott, Patricia  <Family>
QUANTITY: 1

QUANTITY: 1 AVERAGE: -10.00

PROVIDER TOTAL:  -10.00QUANTITY: 1 AVERAGE: -10.00

Grand Totals Quantity Amount Average
Total Credit Adjustments -20.002 -10.00
Total Debit Adjustments 10.001 10.00
Total Finance Charges 0.000 0.00
Total Late Charges 21.001 21.00

11.00Totals 2.754

D
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Adjustment Day Sheet
04/22/2018 - 04/22/2018 Procedure Date

Clinics: <ALL>
Providers: <ALL>

Billing Type: <ALL>
Adjustment Types: <ALL>

Page 1 of 1Report Date: 04/22/2018 Report Generated By: enterprise

Operator ID AmountEntry Date Proc Date Patient Name Provider ClinicBTChart

Clinic: CENTRAL
Provider: DDS1

+Debit Adjustment
2 DDS1 CENTRAL ENTERPRISEABB102 10.00

TOTAL:  10.00AVERAGE: 10.00

2 DDS1 CENTRAL ENTERPRISEABB102 21.00
TOTAL:  21.00

04/22/2018 04/22/2018 Abbott, Patricia  <Family>
QUANTITY: 1

Late Charge
04/22/2018 04/22/2018 Abbott, Patricia  <Family>
QUANTITY: 1 AVERAGE: 21.00

-Professional Discount
1 DDS1 CENTRAL ENTERPRISE -10.00

TOTAL:  -10.00AVERAGE: -10.00

PROVIDER TOTAL:  21.00

04/22/2018 04/22/2018 Larson, Bill  <Family>
QUANTITY: 1

QUANTITY: 3 AVERAGE: 7.00

Provider: DDS2

-Professional Discount
2 DDS2 CENTRAL ENTERPRISEABB102 -10.00

TOTAL:  -10.00AVERAGE: -10.00

PROVIDER TOTAL:  -10.00

04/22/2018 04/22/2018 Abbott, Patricia  <Family>
QUANTITY: 1

QUANTITY: 1 AVERAGE: -10.00

CLINIC TOTAL:  11.00QUANTITY: 4 AVERAGE: 2.75

Grand Totals Quantity Amount Average
Total Credit Adjustments -20.002 -10.00
Total Debit Adjustments 10.001 10.00
Total Finance Charges 0.000 0.00
Total Late Charges 21.001 21.00

11.00Totals 2.754

E

How do I run the Day Sheet (Adjustments) Report? 
From the DXOne Reporting module, select Management, and then double-click Day Sheet - 
Adjustments. For additional details about running this report, see the “Day sheet - adjustments” 
topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any 
module, click Contents).

What important information does this report provide?
The report can be grouped and subtotaled by provider with a breakdown by clinic. Or, the report 
can be grouped and subtotaled by clinic with a breakdown by provider. The following information 
can be used to monitor adjustments for each provider and/or clinic:

A.	Adjustments – The adjustments (grouped and totaled by type) posted to the Ledger.

B.	 Adjustment Details – Each adjustment provides the following information:

•	 Entry Date – The date an adjustment is posted to the Ledger.

•	 Procedure Date – The backdated or postdated date of an adjustment. (This date is usually 
the same as the entry date.)

Note: It is essential that you understand the difference between Entry Dates and Procedure 
Dates. For details on these dates, see the Frequent Problems to Understanding Dentrix 
Enterprise Reports section in the Introduction of this book.

•	 Amount – The amount of the adjustment.

C.	 Grand Totals – The following information appears in the Grand Totals section:

•	 Credit Adjustments – The quantity, total amount, and average amount of the credit 
adjustments.

•	 Debit Adjustments – The quantity, total amount, and average amount of the debit 
adjustments.

•	 Finance Charges – The quantity, total amount, and average amount of the finance charges.
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•	 Late Charges – The quantity, total amount, and average amount of the late charges.

•	 Totals – The quantity, total amount, and average amount of all adjustments.

D.	Provider Totals – The adjustments are shown for the provider with a breakdown of the 
adjustments for each clinic the provider works in. Each clinic’s adjustments for that provider are 
subtotaled. The adjustment totals for the provider appear below the clinic subtotals.

E.	 Clinic Totals – The adjustments are shown for the clinic with a breakdown of the adjustments 
by each provider at that clinic. Each provider’s adjustments for that clinic are subtotaled. The 
adjustment totals for the clinic appear below the provider subtotals.
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Day Sheet (Charges and Receipts) 
Report
The Day Sheet (Charges and Receipts) report lists financial transactions (charges, payments, credit 
adjustments, and charge adjustments) that have been posted to the Ledger.

Why:	 To print a record of transactions each day, to review transactions and production 
totals for a date or date range, and to ensure transaction totals balance out over a 
variety of reports

When:	 Daily

Date: Page:04/22/2018 1

DAY SHEET (CHRONOLOGICAL)
04/22/2018

Providers <ALL> - <ALL>

ENTRY
DATE

PROCEDURE
DATE PATIENT NAME TH CODE DESCRIPTION CHARGES PMTS. BT PROV PHONE #

04/22/2018   04/22/2018     Abbott, James S        5    D6970   Post/core + brdg retainer, fabr      230.00 2            DDS1 (   )555-1586 
04/22/2018 04/22/2018     Abbott, James S             D1110    Prophylaxis-adult 0.00    2            DDS1 (   )555-1586 
04/22/2018 04/22/2018     Abbott, James S             D0120    Periodic oral evaluation 0.00 2            DDS1 (   )555-1586 
04/22/2018 04/22/2018     Abbott, James S             D0274    Bitewings-four films 0.00 2           DDS1 (   )555-1586 
04/22/2018 04/22/2018     Abbott, James S             D0330    Panoramic film 0.00 2            DDS1 (   )555-1586 
04/22/2018 04/22/2018     Abbott, Patricia <Fa -Professional Discount -10.00            2            DDS2             (   )555-1586 
04/22/2018 04/22/2018     Abbott, Patricia <Fa +Debit Adjustment 10.00 2            DDS1 (   )555-1586 
04/22/2018 04/22/2018     Abbott, Patricia <Fa Check Payment - Thank You -125.00           2         <MPL> (   )555-1586 

GRAND TOTALS:
CURRENT MONTH-TO-DATE YEAR-TO-DATE PREVIOUS MONTH

CHARGES: 230.00 230.00 5902.00 0.00
COMPARED TO OFFICE: 393.00

NET DIFFERENCE: 163.00
APPLIED PAYMENTS: -125.00 -125.00 -709.00 0.00

SUSPENDED PAYMENTS: 250.00 250.00 1418.00 0.00
APPLIED CREDIT ADJUSTMENTS: -10.00 -10.00 -10.00 0.00

SUSPENDED CREDIT ADJUSTMENTS: 20.00 20.00 20.00 0.00
CHARGE ADJUSTMENTS: 10.00 10.00 10.00 0.00

FINANCE CHARGES: 0.00 0.00 22.00 0.00
LATE CHARGES: 21.00 21.00 21.00 0.00

CHARGES BILLED TO INSURANCE: 0.00 0.00 1964.00 0.00

NEW PATIENTS: 0 0 0 0
PATIENTS SEEN: 1 1

AVG PROD PER PATIENT: 230.00 230.00
AVG CHG PER PROCEDURE: 46.00 46.00

168146.34
168272.34

PREVIOUS BALANCE 
BALANCE AS OF 04/22/2018 

NET CHANGE 126.00
SMITH, DENNIS D - DDS1 TOTALS:

CURRENT MONTH-TO-DATE YEAR-TO-DATE PREVIOUS MONTH
CHARGES: 230.00 230.00 460.00 0.00

COMPARED TO OFFICE: 393.00
NET DIFFERENCE: 163.00

APPLIED PAYMENTS: 0.00 0.00 -7.00 0.00
APPLIED CREDIT ADJUSTMENTS: 0.00 0.00 0.00 0.00

CHARGE ADJUSTMENTS: 10.00 10.00 10.00 0.00
FINANCE CHARGES: 0.00 0.00 22.00 0.00

LATE CHARGES: 21.00 21.00 21.00 0.00

CHARGES BILLED TO INSURANCE: 0.00 0.00 0.00 0.00

NEW PATIENTS: 0 0 0 0
PATIENTS SEEN: 1 1

AVG PROD PER PATIENT: 230.00 230.00
AVG CHG PER PROCEDURE: 46.00 46.00

616707.30
616968.30

PREVIOUS BALANCE 
BALANCE AS OF 04/22/2018 

NET CHANGE 261.00

C E

F

D

B
A

G
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How do I run the Day Sheet (Charges and Receipts) 
Report?
In the Office Manager, from the Reports menu, point to Management, and then click Day Sheet 
(Charges and Receipts). For additional details about running this report, see the “Day sheet 
(charges and receipts)” topic in the Office Manager portion of the Dentrix Enterprise Help (from 
the Help menu of any module, click Contents).

What important information does this report provide?
A.	Transactions – The transactions posted to the Ledger. Transaction can be sorted by running one 

of the following report options:

Note: Each of the following options prints as a separate report to the Batch Processor.

•	 Chronological Day Sheet – Lists all transactions in the order they were posted (the most 
recent transactions appear at the top of the report).

•	 Alphabetical Day Sheet – Lists all transactions alphabetically by the patients’ last name.

B.	 Transaction Details – Each transaction provides the following information:

•	 Entry Date – The date a transaction is posted to the Ledger.

•	 Procedure Date – The date a procedure is posted to the Chart.

Note: It is essential that you understand the difference between Entry Dates and Procedure 
Dates. For details on these dates, see the Frequent Problems to Understanding Dentrix 
Enterprise Reports section in the Introduction of this book.

•	 TH – The tooth number(s) associated with a procedure.

•	 BT – Billing type.

C.	 Grand Totals Information (Default) – Regardless of the report options you select, the following 
information appears in the Grand Totals section:

•	 Charges Billed to Insurance – The total amount billed to insurance.

•	 Average Prod Per Patient – The average value of procedures per patient (the total charged 
for procedures divided by the total number of patients seen).

•	 Average Chg Per Procedure – The average charge per procedure (the total charged for 
procedures divided by the total number of procedures performed).

D.	Fee Schedule Details – If you select Compare to Fee Schedule when setting options for this 
report, you can compare the actual total of charges with the estimated total, had all charges 
been applied using the selected fee schedule.

•	 Compared to [Fee Schedule] – The estimated total of charge,s had all procedures been 
billed using the selected fee schedule.

•	 Net Difference – The difference between the actual total and the estimated total. A 
negative value indicates that the practice would have lost revenue, had all procedures been 
billed using the selected fee schedule. A positive value indicates the office would have 
increased revenue.
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E.	 MTD and YTD Totals – If you select Include MTD and YTD Totals when setting options for this 
report, the month-to-date and year-to-date totals appear on the report. You can use these totals 
to ensure the practice is on track to meet its production goals for the month and year. You can 
also use these totals to compare the current production levels with the previous month.

Note: MTD and YTD totals only appear when running the report by Entry Date.

F.	 Extended MTD Totals – If you select Include Extended MTD Totals when setting options for 
this report, the Avg Prod Per Patient and Avg Chg Per Procedure appears in the Month-to-date 
column. The Extended MTD Totals help you determine whether the current day’s production 
average is higher or lower than the current month’s average.

G.	Provider Totals – If you select Include Provider Totals when setting options for this report, the 
transaction totals for each provider appear on the report. Providers can use this information to 
monitor their daily production.
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Day Sheet (Receipts) Report
The Receipts Day Sheet report lists receipts by payment type.

Why:	 To print a record of receipts each day, to review receipt totals for a date or date 
range, and to ensure receipt totals balance out over a variety of reports

When:	 Daily

Receipts Day Sheet
04/22/2018 - 04/22/2018 Procedure Date 

Clinics: <ALL>
Providers: <ALL>

Billing Type: <ALL>
Payment Types: <ALL>

Page 1 of 1Report Date: 04/22/2018 Report Generated By: enterprise

Operator ID AmountEntry Date Proc Date Patient Name Provider ClinicBTChart

 Check Payment - Thank You
ABB102 2       <MULTIPLE>      CENTRAL          ENTERPRISE          -125.00

1       DDS1                CENTRAL          ENTERPRISE -23.00
TOTAL:  -148.00AVERAGE: -74.00

TOTAL:  -148.00

04/22/2018 04/22/2018      Abbott, Patricia  <Family> 
04/22/2018 04/22/2018      Crosby, Brent  <Family>
QUANTITY: 2

Grand Totals
QUANTITY: 2 AVERAGE: -74.00

A

C

B

Receipts Day Sheet
04/22/2018 - 04/22/2018 Procedure Date 

Clinics: <ALL>
Providers: DDS1, DDS2

Billing Type: <ALL>
Payment Types: <ALL>

Page 1 of 1Report Date: 04/22/2018 Report Generated By: enterprise

Operator ID amountEntry Date Proc Date Patient Name Provider ClinicBTChart

Provider: DDS1
Clinic: CENTRAL

 Check Payment - Thank You
1 DDS1 CENTRAL ENTERPRISE -23.00

TOTAL:  -23.00AVERAGE: -23.00

CLINIC TOTAL:  -23.00

04/22/2018 04/22/2018 Larson, Bill  <Family>
QUANTITY: 1

QUANTITY: 1 AVERAGE: -23.00

PROVIDER TOTAL:  -23.00QUANTITY: 1 AVERAGE: -23.00

Provider: DDS2
Clinic: CENTRAL

 Check Payment - Thank You
2 DDS2 CENTRAL ENTERPRISEABB102 -7.20

TOTAL:  -7.20AVERAGE: -7.20

CLINIC TOTAL:  -7.20

04/22/2018 04/22/2018 Abbott, Patricia  <Family>
QUANTITY: 1

QUANTITY: 1 AVERAGE: -7.20

PROVIDER TOTAL:  -7.20QUANTITY: 1 AVERAGE: -7.20

Grand Totals
GRAND TOTAL:  -30.20QUANTITY: 2 AVERAGE: -15.10

D

Receipts Day Sheet
04/22/2018 - 04/22/2018 Procedure Date 

Clinics: <ALL>
Providers: DDS1, DDS2

Billing Type: <ALL>
Payment Types: <ALL>

Page 1 of 1Report Date: 04/22/2018 Report Generated By: enterprise

Operator ID amountEntry Date Proc Date Patient Name Provider ClinicBTChart

Clinic: CENTRAL
Provider: DDS1

 Check Payment - Thank You
1 DDS1 CENTRAL ENTERPRISE -23.00

TOTAL:  -23.00AVERAGE: -23.00

PROVIDER TOTAL:  -23.00

04/22/2018 04/22/2018 Larson, Bill  <Family>
QUANTITY: 1

QUANTITY: 1 AVERAGE: -23.00

Provider: DDS2

 Check Payment - Thank You
2 DDS2 CENTRAL ENTERPRISEABB102 -7.20

TOTAL:  -7.20AVERAGE: -7.20

PROVIDER TOTAL:  -7.20

04/22/2018 04/22/2018 Abbott, Patricia  <Family>
QUANTITY: 1

QUANTITY: 1 AVERAGE: -7.20

CLINIC TOTAL:  -30.20QUANTITY: 2 AVERAGE: -15.10

Grand Totals
GRAND TOTAL:  -30.20QUANTITY: 2 AVERAGE: -15.10

E
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4/20/2015 - 4/20/2015 Procedure Date

Receipts Day Sheet

Clinics: <ALL>

Providers: DESMITH, DSMITH

Billing Type: <ALL>

Payment Types: <ALL>

Chart Number Range: <ALL>

Page 1 of 1Report Date: 4/22/2015 Report Generated By: enterprise

Operator ID amountEntry Date Proc Date Patient Name Provider ClinicBTChart

DSMITHInitial Provider:

DESMITHProvider:

 Visa

04/20/2015 04/20/2015  1Winters, Carl DESMITH AF DSMITHWI211 -72.80

TOTAL:  -72.80QUANTITY: 1 AVERAGE: -72.80

PROVIDER TOTAL:  -72.80QUANTITY: 1 AVERAGE: -72.80

DSMITHProvider:

 Check Payment - Thank You

04/20/2015 04/20/2015  1Crosby, Brent  <Family> DSMITH AF DSMITHCR93 -38.00

TOTAL:  -38.00QUANTITY: 1 AVERAGE: -38.00

Primary Dental Insurance Check Payment  0

04/20/2015 04/20/2015  1Crosby, Brent DSMITH CENTRAL DSMITHCR93 -168.00

TOTAL:  -168.00QUANTITY: 1 AVERAGE: -168.00

 Visa

04/20/2015 04/20/2015  1Crosby, Brent  <Family> DSMITH CENTRAL DSMITHCR93 -42.00

TOTAL:  -42.00QUANTITY: 1 AVERAGE: -42.00

PROVIDER TOTAL:  -248.00QUANTITY: 3 AVERAGE: -82.67

INITIAL PROVIDER TOTAL: -320.80

Grand Totals
GRAND TOTAL:  -320.80QUANTITY: 4 AVERAGE: -80.20

F

How do I run the Day Sheet (Receipts) Report?
From the DXOne Reporting module, select Management, and then double-click Day Sheet - 
Receipts. For additional details about running this report, see the “Day sheet - receipts” topic in 
the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, 
click Contents).

What important information does this report provide?
The report can be grouped and subtotaled by provider with a breakdown by clinic. The report can 
be grouped and subtotaled by clinic with a breakdown by provider. The report can be grouped and 
subtotaled by initial provider with a breakdown by rendering provider. The following information 
can be used to monitor receipts for each provider, clinic, and initial provider.

A.	Receipts – The receipts (grouped and totaled by payment type) posted to the Ledger.

B.	 Receipt Details – Each receipt provides the following information:

•	 Procedure Date – The date of a payment posted to the Ledger.

•	 Provider – The provider of procedures that a payment was applied to.

•	 Clinic – The rendering or collecting clinic (depending on the selected option for the report).

•	 Amount – The amount of the payment.

C.	 Grand Total – The grand total of receipts listed.

D.	Provider Totals – The receipts are shown for the provider with a breakdown of the receipts 
for each clinic the provider works in. Each clinic’s receipts for that provider are subtotaled. The 
receipts totals for the provider appear below the clinic subtotals.

E.	 Clinic Totals – The receipts are shown for the clinic with a breakdown of the receipts by each 
provider at that clinic. Each provider’s receipts for that clinic are subtotaled. The receipts totals 
for the clinic appear below the provider subtotals.

F.	 Initial Provider Totals – The receipts are shown for the initial provider with a breakdown of the 
receipts by each rendering provider. Each rendering provider’s receipts are subtotaled. The 
receipts totals for the initial provider appear below the rendering provider subtotals.
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Day Sheet Report
The Day Sheet report lists financial transactions (charges, payments, credit adjustments, charge 
adjustments, finance charges, and late charges) that have been posted to the Ledger.

Why:	 To print a record of transactions each day, to review transactions and production 
totals for a date or date range, and to ensure transaction totals balance out over a 
variety of reports

When:	 Daily

Alphabetical Day Sheet
04/22/2018 - 04/22/2018 Entry Date

Clinics: <ALL>
Providers: <ALL>

Billing Type: <ALL>

Page 1 of 1Report Generated By: enterpriseReport Date: 04/22/2018

Entry Date Proc Date Patient Name Description Charges Credits BT ClinicProv Phone

Abbott, James S 2D6970 : 5 : Post/core + brdg retainer, fabr 555-1586230.00       DDS104/22/2018 04/22/2018                                                                                                                                         CENTRAL
Abbott, James S 2D1110 : 0 : Prophylaxis-adult 555-15860.00       DDS104/22/2018 04/22/2018                                                                                                    CENTRAL
Abbott, James S 2D0120 : 0 : Periodic oral evaluation 555-15860.00       DDS104/22/2018 04/22/2018                                                                                                              CENTRAL
Abbott, James S 2D0274 : 0 : Bitewings-four films 555-15860.00       DDS104/22/2018 04/22/2018                                                                                                       CENTRAL
Abbott, James S 2D0330 : 0 : Panoramic film 555-15860.00       DDS104/22/2018 04/22/2018                                                                                                CENTRAL
Abbott, Patricia <Family> 2-Professional Discount -10.00 555-1586DDS204/22/2018 04/22/2018                                                                                                                      CENTRAL
Abbott, Patricia <Family> 2Check Payment - Thank You {}   -125.00 555-1586<MULTIPLE>04/22/2018 04/22/2018                                                                                                                                                       CENTRAL
Abbott, Patricia <Family> 2+Debit Adjustment 555-158610.00       DDS104/22/2018 04/22/2018                                                                                                         CENTRAL

1D2150 : 12(OD)  : Amalgam-2 surf. prim/perm 156.00 DDS1                                                                                                          CENTRAL
1-Professional Discount -10.00 DDS1                                                                    CENTRAL
1Check Payment - Thank You -23.00 DDS1

04/22/2018 04/22/2018                      Larson, Bill 
04/22/2018 04/22/2018                                       Larson, Bill <Family>            
04/22/2018 04/22/2018                                       Larson, Bill <Family>                                                                                          CENTRAL

GRAND TOTALS

Charges: Patients Seen:386.00 2Applied Payments: -148.00
Charge Adjustments: New Patients:10.00 0Suspended Payments: 0.00
Finance Charges: Avg Prod Per Patient:0.00 193.00Applied Ins Payments: 0.00
Late Charges: Avg Chg Per Proc:21.00 64.33Suspended Ins Payments: 0.00
Debit Special Adj: 0.00 Applied Credit Adj: -20.00 OTH Applied Payments: 0.00
Debit Initial Balances: 0.00 Suspended Credit Adj: OTH Applied Ins Payments: 0.000.00
Billed to Insurance: 0.00 Credit Special Adj: OTH Applied Credit Adj: 0.000.00
Previous Balance: Credit Initial Balances: OTH Applied Credit Special Adj: 0.0017,388.04 0.00
Balance as of 04/22/2009 17,637.04 OTH Applied Credit Initial Bal: 0.00
Net Change: 249.00

{} Partial credit amount

C

A
B
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Alphabetical Day Sheet
04/22/2018 - 04/22/2018 Entry Date

Clinics: CENTRAL
Providers: DDS01

Billing Type: <ALL>

Page 1 of 2Report Generated By: enterpriseReport Date: 04/22/2018

Entry Date Proc Date Patient Name Description Charges Credits BT ClinicProv Phone

Provider: DDS01

Clinic: CENTRAL
D1110 : 0: Prophylaxis-adult 48.00 DDS01                                                                          CENTRAL1
D0120 : 0: Periodic oral evaluation 25.00 DDS01                                                                                    CENTRAL1
D0274 : 0: Bitewings-four films 32.00 DDS01

04/22/2018 04/22/20 Smit18                              h, Brandon 
04/22/2018 04/22/20 Smit18                              h, Brandon 
04/22/2018 04/22/20 Smit18                              h, Brandon                                                                               CENTRAL1

Clinic: CENTRAL

Provider: DDS01

TOTALS

Provider: DDS01

Patients Seen:105.00 1Applied Payments: 0.00
New Patients:0.00 1Applied Ins Payments: 0.00

Applied Credit Adj: Avg Prod Per Patient:0.000.00 105.00
Avg Chg Per Proc:0.00 35.00Credit Special Adj: 0.00

Credit Initial Balances: 0.000.00
0.00

105.00
70.00

175.00

Clinic: CENTRAL
Charges:
Charge Adj:
Finance Charges:
Late Charges:
Debit Special Adj:
Debit Initial Balances: 
Billed to Insurance: 
Previous Balance: 
Balance as of 04/22/2018 
Net Change: 105.00

Patients Seen:105.00 1Applied Payments: 0.00
New Patients:0.00 1Applied Ins Payments: 0.00

Applied Credit Adj: Avg Prod Per Patient:0.000.00 105.00
Avg Chg Per Proc:0.00 35.00Credit Special Adj: 0.00

Credit Initial Balances:0.00 0.00
0.00

105.00
70.00

175.00

Provider: DDS01
Charges:
Charge Adj:
Finance Charges:
Late Charges:
Debit Special Adj:
Debit Initial Balances: 
Billed to Insurance: 
Previous Balance: 
Balance as of 04/22/2018 
Net Change: 105.00

{} Partial credit amount

D
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Alphabetical Day Sheet
04/22/2018 - 04/24/2009 Entry Date

Clinics: CENTRAL
Providers: DDS01

Billing Type: <ALL>

Page 1 of 2Report Generated By: enterpriseReport Date: 04/22/2018

Entry Date Proc Date Patient Name Description Charges Credits BT ClinicProv Phone

Clinic: CENTRAL

Prov: DDS01
D1110 : 0: Prophylaxis-adult 48.00 DDS01                                                                          CENTRAL1
D0120 : 0: Periodic oral evaluation 25.00 DDS01                                                                                    CENTRAL1
D0274 : 0: Bitewings-four films 32.00 DDS01

04/22/2018 04/22/20 Smit18                              h, Brandon 
04/22/2018 04/22/20 Smit18                              h, Brandon 
04/22/2018 04/22/20 Smit18                              h, Brandon                                                                               CENTRAL1

Prov: DDS01

Clinic: CENTRAL

TOTALS

Clinic: CENTRAL

Patients Seen:105.00 1Applied Payments: 0.00
New Patients:0.00 1Applied Ins Payments: 0.00

Applied Credit Adj: Avg Prod Per Patient:0.000.00 105.00
Avg Chg Per Proc:0.00 35.00Credit Special Adj: 0.00

Credit Initial Balances: 0.000.00
0.00

105.00
70.00

175.00
105.00

Patients Seen:0.00 0Applied Payments: 0.00
New Patients:0.00 0Applied Ins Payments: 0.00

Applied Credit Adj: Avg Prod Per Patient:0.000.00 0.00
Avg Chg Per Proc:0.00 0.00Credit Special Adj: 0.00

Credit Initial Balances: 0.000.00
0.00
0.00
0.00
0.00

Prov: DDS01
Charges:
Charge Adj:
Finance Charges:
Late Charges:
Debit Special Adj:
Debit Initial Balances: 
Billed to Insurance: 
Previous Balance: 
Balance as of 04/22/2018 
Net Change:

SUSPENDED CREDITS
Charges:
Charge Adj:
Finance Charges:
Late Charges:
Debit Special Adj:
Debit Initial Balances: 
Billed to Insurance: 
Previous Balance: 
Balance as of 04/22/2018 
Net Change: 0.00

Patients Seen:105.00 1Applied Payments: 0.00
New Patients:0.00 1Applied Ins Payments: 0.00

Applied Credit Adj: Avg Prod Per Patient:0.000.00 105.00
Avg Chg Per Proc:0.00 35.00Credit Special Adj: 0.00

Credit Initial Balances:0.00 0.00
0.00

105.00
70.00

175.00

Clinic: CENTRAL
Charges:
Charge Adj:
Finance Charges:
Late Charges:
Debit Special Adj:
Debit Initial Balances: 
Billed to Insurance: 
Previous Balance: 
Balance as of 04/22/2018 
Net Change: 105.00

{} Partial credit amount

E
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How do I run the Day Sheet Report?
From the DXOne Reporting module, select Management, and then double-click Day Sheet. For 
additional details about running this report, see the “Day sheet” topic in the DXOne Reporting 
portion of the Dentrix Enterprise Help (from the Help menu of any module, click Contents).

What important information does this report provide?
The report can be grouped and subtotaled by provider with a breakdown by clinic. Or, the report 
can be grouped and subtotaled by clinic with a breakdown by provider. The following information 
can be used to monitor production for each provider and/or clinic:

A.	Transactions – The transactions posted to the Ledger.

B.	 Transaction Details – Each transaction provides the following information:

•	 Entry Date – The date a transaction is posted to the Ledger.

•	 Procedure Date – The date a procedure is posted to the Chart.

Note: It is essential that you understand the difference between Entry Dates and Procedure 
Dates. For details on these dates, see the Frequent Problems to Understanding Dentrix 
Reports section in the Introduction of this book.

•	 Patient Name – The patient’s name.

•	 Description – The ADA code and description, or transaction description.

•	 Charges or Credits – Any charges or credits.

•	 Clinic – The clinic where the transaction was posted.

•	 Phone – The patient’s phone number.

•	 BT – Billing type.

C.	 Grand Totals – The following information appears in the Grand Totals section:

•	 Charges and Adjustments – The total amounts billed to insurance, charged to patients, 
and adjusted on an account.

•	 Balances – The balance prior to the date of the day sheet, the balance for the date of the 
day sheet, and the net change between the two balances.

•	 Payments – The total amounts of payments received from insurance and patients or 
adjusted on an account.

•	 Average Prod Per Patient – The average value of procedures per patient (the total charged 
for procedures divided by the total number of patients seen).

•	 Average Chg Per Procedure – The average charge per procedure (the total charged for 
procedures divided by the total number of procedures performed).

D.	Provider Totals – The transactions are shown for the provider with a breakdown of the 
procedures for each clinic the provider works in. Each clinic’s transactions for that provider are 
subtotaled. The transaction totals for the provider appear below the clinic subtotals.

E.	 Clinic Totals – The transactions are shown for the clinic with a breakdown of the procedures 
performed by each provider at that clinic. Each provider’s transactions and suspended credits 
for that clinic are subtotaled. The transaction totals for the clinic appear below the provider 
subtotals.
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Dental Diagnostic Code List
The Procedure Code List allows you to view and print the dental diagnostic codes entered in 
Dentrix Enterprise.

Why:	 To ensure Dentrix Enterprise dental diagnostic codes match current dental 
diagnostic codes, and to view any custom dental diagnostic codes

When:	 After Dentrix Enterprise setup, after dental diagnostic codes are updated

DENTAL DIAGNOSTIC CODE LIST
The Dentist Group

Date: Page:04/22/2018 1

CODE DESCRIPTION PAINT TYPE TREATMENT AREA

01234 Dental Diagnostic Code Other
D5-10000 Dental Disease NOS Other
D5-10001 Disease of Teeth NOS Other
D5-10002 Tooth Disorder NOS Other
D5-10578 Tooth Sensitivity Other
D5-22071 Painful Lips Other
F-51540 Expectoration of bloody sputum Other
F-51541 Expectoration of hemorr sputum Other
F-A3610 Facial Nerve Function NOS Other
T-53120 Dorsal Surface of Tongue Other

A B C
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How do I run the Dental Diagnostic Code List?
In the Office Manager, from the Reports menu, point to Reference, and then click Diagnostic 
Code List. For additional details about running this report, see the “Dental Diagnostic Code List” 
topic in the Office Manager portion of the Dentrix Enterprise Help (from the Help menu of any 
module, click Contents).

What important information does this report provide?
The following report information is found in the Dental Diagnostic Code Editor dialog box, which 
can be accessed in the Office Manager. See the “Dental Diagnostic Code Setup” topic in the 
Office Manager portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents) for details on how to edit this information.

A.	Diagnostic Code – The 
code associated with the 
dental diagnosis.

B.	 Description – The 
dental diagnostic code’s 
description.

C.	 Treatment Area – The 
dental diagnostic code’s 
treatment area.

BA

A
B

C
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Dental Encounters Report
The Dental Encounters Report lists procedures posted during a specified date range (each 
procedure must be attached to a claim to appear on the report), along with the amount that is 
expected to be paid by insurance.

Why:	 To submit dental encounters to Medicaid

When:	 As needed


4/11/2018 - 4/12/2018 Entry Date




Carrier Range: <ALL> - <ALL>

Patient Range: <ALL> - <ALL>

Report Date: 4/13/2018 Report Generated By: enterprise Page 1 of 1

   




  

Abbott, James 123456789 D2387 0.00 4/11/2018  12 0 0

Brown, Mary 123456789 D2387 0.00 4/11/2018  12 0 0

Crosby, Brent 123456789 D3310 0.00 4/11/2018  12 0 0

Davis, Harmon 123456789 D2792 0.00 4/11/2018  12 0 0

Farrer, Lisa 123456789 D1205 78.00 4/12/2018  12 0 0

Gleason, Alice 123456789 D5915 365.00 4/12/2018  12 0 0

Smith, Michael 123456789 D3330 189.00 4/12/2018  12 0 0

Winters, Carl 123456789 D3330 85.40 4/12/2018  12 0 0

A
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How do I run the Dental Encounters Report?
From the DXOne Reporting module, select Management, and then double-click Dental 
Encounters. For additional details about running this report, see the “Dental Encounters Report” 
topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any 
module, click Contents).

What important information does this report provide?
A.	Procedures – For each procedure, the date of service, the name of the patient who received 

treatment, the subscriber ID (Beneficiary ID) of the subscriber of the patient’s insurance plan, 
and the appropriate NPI numbers are shown.
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Deposit Slip
The Deposit Slip allows you to view payments by payment type, and you can use the Deposit Slip 
to deposit cash and checks at your bank.

Why:	 To save time by automatically generating deposit slips and to ensure cash, 
check, and credit card totals match up at the end of each day (in other words, the 
amount of cash left in the till is correct, each check has been accounted for, and 
the total charges processed on your credit card machine are correct)

When:	 Daily

Deposit Slip
04/22/2018 - 04/29/2018 Procedure Date 

Clinics: <ALL>
Operator: <ALL>

Billing Type: <ALL>

Page 1 of 1Report Generated By: enterpriseReport Date: 04/29/2018

Name BT Provider Bank Check # AmountClinicProcedure Date

Cash Payment - Thank You
Crosby, Brent L<Family> 2      DDS0104/22/2018                                                                       CENTRAL -20.00

04/22/2018           Little, Brian<Family>  2      <MULTIPLE>        CENTRAL -100.00
2 ITEMS TOTAL:  -120.00

              Check Payment - Thank You
04/22/2018            Abbott, Patricia<Family> 2      DDS01 CENTRAL -45.00
04/22/2018            Davis, Janet<Family> 1       DDS01 CENTRAL -23.00
04/23/2018            Winters, Carl<Family> 2       <MULTIPLE>        CENTRAL -100.00

3 ITEMS TOTAL:  -168.00

Dental Insurance Check Payment
           Metropolitan Life DDS1 44587 -698.402 CENTRAL04/27/2018

1 ITEM TOTAL:  -698.40

-986.40TOTAL DEPOSIT:

PAID IN BY

The Dentist Group
FOR CREDIT OF

43331677-1146
BANK ACCOUNT

A
B

C

D
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Deposit Slip
04/22/2018 - 04/29/2018 Procedure Date 

Clinics: <ALL>
Operator: <ALL>

Billing Type: <ALL>

Page 1 of 1Report Generated By: enterpriseReport Date: 04/29/2018

Name BT Provider Bank Check # AmountClinicProcedure Date

Operator: ENTERPRISE

Clinic: CENTRAL

Cash Payment - Thank You
Payne, Mildred<Family> <MULTIPLE> -100.001 CENTRAL04/27/2018

1 ITEM TOTAL:  -100.00

Check Payment - Thank You
Abbott, Patricia<Family> <MULTIPLE> -125.002 CENTRAL04/22/2018
Larson, Bill<Family> DDS1 -23.001 CENTRAL04/22/2018
Payne, Mildred<Family> DDS01 -20.001 CENTRAL04/23/2018

3 ITEMS TOTAL:  -168.00

Dental Insurance Check Payment
Metropolitan Life DDS1 44587 -698.402 CENTRAL04/27/2018

1 ITEM TOTAL:  -698.40

5 ITEMS CLINIC TOTAL:  -966.40

5 ITEMS OPERATOR TOTAL:  -966.40

-966.40TOTAL DEPOSIT:

PAID IN BY

The Dentist Group
FOR CREDIT OF

BANK ACCOUNT

E

F
G

Deposit Slip
04/22/2018 - 04/29/2018 Procedure Date 

Clinics: <ALL>
Operator: <ALL>

Billing Type: <ALL>

Page 1 of 1Report Generated By: enterpriseReport Date: 04/29/2018

Name BT Provider Bank Check # AmountClinicProcedure Date

Clinic: CENTRAL

Operator: ENTERPRISE

Cash Payment - Thank You
Payne, Mildred<Family> <MULTIPLE> -100.001 CENTRAL04/27/2018

1 ITEM TOTAL:  -100.00

Check Payment - Thank You
Abbott, Patricia<Family> <MULTIPLE> -125.002 CENTRAL04/22/2018
Larson, Bill<Family> DDS1 -23.001 CENTRAL04/22/2018
Payne, Mildred<Family> DDS01 -20.001 CENTRAL04/23/2018

3 ITEMS TOTAL:  -168.00

Dental Insurance Check Payment
Metropolitan Life DDS1 44587 -698.402 CENTRAL04/27/2018

1 ITEM TOTAL:  -698.40

5 ITEMS OPERATOR TOTAL:  -966.40

5 ITEMS CLINIC TOTAL:  -966.40

-966.40TOTAL DEPOSIT:

PAID IN BY

The Dentist Group
FOR CREDIT OF

BANK ACCOUNT

I
J

H

How do I run the Deposit Slip?
From the DXOne Reporting module, select Management, and then double-click Day Sheet - 
Deposit Slip. For additional details about running this report, see the “Day sheet - deposit slip” 
topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any 
module, click Contents).

What important information does this report provide?
The following information can be used to monitor payments for each provider and/or clinic:

A.	Payments – The payments (grouped and totaled by type) posted to the Ledger.

B.	 Payment Details – Each payment provides the following information:

•	 Procedure Date – The date of a payment posted to the Ledger.

•	 Amount – The amount of the payment.
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C.	 Total Deposit – The total of all payment types.

D.	Account Information – The following report information 
(except for the first item) is found in the Clinic Information 
dialog box:

•	 Paid in By – The name of the employee making the 
deposit.

•	 For Credit Of – The name of the practice for which the 
deposit is being made.

•	 Bank Account – The practice’s bank deposit number.

E.	 Operator Payments – The payments for an operator by 

clinic.

F.	 Clinic Subtotal – The total for an operator by clinic.

G.	Operator Total – The total for an operator.

H.	Clinic Payments – The payments for a clinic by operator.

I.	 Operator Subtotal – The total for a clinic by operator.

J.	 Clinic Total – The total for a clinic.

D
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Document Center - Documents List 
Report
Document Center - Documents List Report displays the list of documents that were acquired 
within a specified date range and their corresponding details. You can filter the list of documents 
to include documents that are associated with patients, providers/staff, referrals (inbound and 
outbound), insurance plans (dental and medical), and employers.

Why:	 To view details regarding documents that are attached to entities

When:	 As needed

Server Name: <Default>

Document Center - Documents List

Date Range: 10/12/2020 - 10/12/2020

User: <ALL>

Clinic: <ALL>

Locked/Signed Date: <ALL>

Document Path: <ALL>

Page 1 of 1Report Date: 10/12/2020 Report Generated By: DSMITH

Date File 

Attached

File 

Attached To

Type of 

File

File 

Description

User ID 

Attaching 

File

Clinic оf 

User ID

Date 

Locked/ 

Signed

Signed 

By

DC File 

Path

Attachment 

Type

10/12/2020 Crosby, Brent Miscellaneous Agreement DSMITH AF 10/12/2020 Dennis Smith, D.M.D;

Brent Crosby

\\gwinn17215\E\DXONE\Data\DocF

iles\
Patient

10/12/2020 Smith, Dennis Miscellaneous Agreement DSMITH AF 10/12/2020 Dennis Smith, D.M.D;

Brent Crosby

\\gwinn17215\E\DXONE\Data\DocF

iles\
Provider/Staff

10/12/2020 Smith, Dennis Miscellaneous NPI DSMITH AF \\gwinn17215\E\DXONE\Data\DocF

iles\
Provider/Staff

10/12/2020 Smith, Dennis Miscellaneous EFT Pay DSMITH AF 10/12/2020 Dennis Smith, D.M.D \\gwinn17215\E\DXONE\Data\DocF

iles\
Provider/Staff

A B C D E F G H I J
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How do I run the Document Center - Documents List 
Report?
From the DXOne Reporting module, select List, and then double-click Document Center - 
Documents List. For additional details about running this report, see the “Document Center - 
Documents List Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from 
the Help menu of any module, click Contents).

What important information does this report provide?
The documents on the report can be sorted by the acquisition date of documents, by the type of 
entity that the documents are associated with, or by the name of the entity that documents are 
associated with.

Note: A document may appear more than once on the report, depending on the number of 
attachments and the specified filters.

For each document, the report displays the following information:

A.	Date File Attached – The document’s acquisition date.

B.	 Attachment Type – The type of entity that the document is associated with: Patient, Provider/
Staff, Referred BY, Referred TO, Dental Insurance Plan, Medical Insurance Plan, or Employer.

C.	 File Attached To – The name of the entity that the document is associated with.

D.	Type of File – The document’s type (the folder name in the document tree).

E.	 File Description – The document’s description (the file name in the document tree).

F.	 User ID Attaching File – The user who acquired the document.

G.	Clinic of User ID – The clinic that the user who acquired the document was logged in to when 
he or she acquired the document.

H.	Date Locked/Signed – The date when the document was signed.

I.	 Signed By – The name of each person who signed the document.

J.	 DC File Path – The location of the repository that contains the document.
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Document Center Audit Documents 
Report
Document Center Audit Documents Report displays.

Why:	 To view statistics regarding the auditing of documents

When:	 Monthly and as needed

Date Run:Scan Date Range: Attached Documents By:

Patient, Provider 10/20/2020From: 10/1/2020

To: 10/31/2020 Page 1 of 1

Date

Total 

Documents

Total 

Audited

% 

Audited

Total 

Errors

% of   

Errors

Poor 

Scan 

Errors

Incorrect

Locations

Errors

Incorrect

Record

Errors

Other

Errors Comments/Follow-Up:

10/12/2020  3  2 67%  1 50%  1  0  0  0 May need to re-scan

10/20/2020  2  2 100%  1 50%  0  1  0  0

Totals:  5  4  2  1  1  0  080% 50% I

A B C D E F G H
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How do I run the Document Center Audit Documents 
Report?
In the Office Manager, from the Analysis menu, click Document Center Audit Documents. On 
the Reporting tab, set up the filters as desired, and then click Print Data Grid. For additional 
details about running this report, see the “Document Center Audit Documents utility” topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
For each date that documents were acquired on, the report displays the following information:

A.	Date – The acquisition date.

B.	 Total Documents – The total number of documents in the Scan Date Range. A document is 
counted once, regardless of the number of associated entities.

C.	 Total Audited – Of the documents included in the Total Documents count, the total number 
that have been audited (documents with an Audited status).

D.	% Audited – Of the documents included in the Total Documents count, the percentage that 
have been audited (documents with an Audited status). This is calculated by dividing Total 
Audited by Total Documents.

E.	 Total Errors – Of the documents included in the Total Audited count, the total number that 
have been marked as having an error (Poor Scan, Incorrect Location, Incorrect Record, or any 
user-defined error type).

F.	 % of Errors – Of the documents included in the Total Audited count, the percentage that have 
been marked as having an error (Poor Scan, Incorrect Location, Incorrect Record, or any user-
defined error type). This is calculated by dividing Total Errors by Total Audited.

G.	Error types:

•	 Poor Scan Errors – Of the documents included in the Total Errors count, the total number 
that have been marked with the Poor Scan error type.

•	 Incorrect Location Errors – Of the documents included in the Total Errors count, the total 
number that have been marked with the Incorrect Location error type.

•	 Incorrect Record Errors – Of the documents included in the Total Errors count, the total 
number that have been marked with the Incorrect Record error type.

•	 Other Errors – Of the documents included in the Total Errors count, the total number that 
have been marked with any user-defined error type.

H.	Comments/Follow-Up – A comment that you entered in the data grid regarding the 
documents included on this line.

The report also includes totals for all dates (refer to I).
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Document Center Document
You can print documents that have been attached to a patient’s or provider’s Document Center.

Why:	 To print documents that have been attached to a patient or provider

When:	 As needed

3/1/2018 [DDS1] Smith, Dennis , D.D.S. 1A B
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How do I run the Document Center Document?
From a patient’s or provider’s Document Center, from the File menu, point to Print, and then click 
Print Document(s). For additional details about running this report, see the “Printing documents” 
topic in the Document Center portion of the Dentrix Enterprise Help (from the Help menu of any 
module, click Contents).

What important information does this report provide?
A.	Date Attached – The date the document was attached to the patient, provider, referral, 

employer, or insurance plan.

B.	 Name – The name of the patient, provider, referral, employer, or insurance plan.
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Document Center Documents 
Audited Report
Document Center Documents Audited Report displays.

Why:	 To view details regarding audited documents

When:	 Daily and as needed

User that Audited Document(s): <ALL>

Scan Date Range: 10/1/2020 - 10/31/2020

Attached Documents By: Patient, Provider 

Error Type: <ALL>

Audit Date Range: 10/12/2020 - 10/12/2020

User Document Created By: <ALL>

User Clinic: <ALL>

Page 1 of 1Report Date: 10/12/2020

Document 

Status

Document 

Creation 

Date Audited By User

Attached 

Documents By Name Attached To Document Type

Document 

Audited 

Date Document Errors Description

Attached By User 

ID User Clinic

Audited 10/12/2020 Dennis  Smith, D.M.D Provider/Staff Dennis  Smith, D.M.D Miscellaneous 10/12/2020 Poor Scan Agreement Dennis  Smith, 

D.M.D

AF

Audited 10/12/2020 Dennis  Smith, D.M.D Patient Crosby, Brent Miscellaneous 10/12/2020 Poor Scan Agreement Dennis  Smith, 

D.M.D

AF

Audited 10/12/2020 Dennis  Smith, D.M.D Provider/Staff Dennis  Smith, D.M.D Miscellaneous 10/12/2020 No Errors NPI Dennis  Smith, 

D.M.D

AF

A B C D E F G H I J K
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How do I run the Document Center Documents Audited 
Report?
In the Office Manager, from the Analysis menu, click Document Center Audit Documents. On the 
Review Documents Audited tab, set up the filters as desired, and then click Print Data Grid. For 
additional details about running this report, see the “Document Center Audit Documents utility” 
topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any 
module, click Contents).

What important information does this report provide?
Note: A document may appear more than once in the data grid, depending on the number of 
attachments, the number of associated error types, the number of auditors, and the specified 
filters.

For each document, the report displays the following information:

A.	Document Status – The document’s audit status: Audited or Not Audited.

B.	 Document Creation Date – The document’s acquisition date.

C.	 Audited By User – The name of the user who audited the document.

D.	Attached Documents By – The type of entity that the document is associated with: Patient, 
Provider/Staff, Referred 
BY, Referred TO, Dental 
Insurance Plan, Medical 
Insurance Plan, or Employer.

E.	 Name Attached To – The 
name of the entity that the 
document is associated with.

F.	 Document Type – The 
document’s type (the folder 
name in the document tree).

G.	Document Audited Date – The date when the document was audited.

H.	Document Errors – The error type that is associated with the document (No Errors, Poor Scan, 
Incorrect Location, Incorrect Record, or a user-defined error type).

I.	 Description – The document’s description (the file name in the document tree).

J.	 Attached By User ID – The name of the user who acquired the document.

K.	 User Clinic – The clinic that the user who acquired the document was logged in to when he or 
she acquired the document.

D
H

I

F
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Document Center List
The Document Center List displays the documents that have been attached to patients. This report 
can be run for a patient or provider.

Why:	 To print documents that have been attached to a patient or provider

When:	 As needed
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How do I run the Document Center List?
From a patient’s or provider’s Document Center, from the File menu, point to Print, and then click 
Document Center List. For additional details about running this report, see the “Printing the 
Document Center List” topic in the Document Center portion of the Dentrix Enterprise Help (from 
the Help menu of any module, click Contents).

What important information does this report provide?
A.	Name – The name of the patient, provider, referral, employer, or insurance plan.

B.	 Document Type – The document type.

C.	 Date Attached – The date the document was attached.

D.	Document Description – The document’s description. Any notes appear below the description.
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Employers and Employed Patients 
Report
The Employers and Employed Patients Report allows you to view and print the employers entered 
in Dentrix Enterprise. Depending on how you run the report, the employees associated with each 
employer may also appear on this report.

Why:	 To identify individuals whose insurance information needs to be updated when 
an employer changes insurance carriers

When:	 As needed

Employers and Employed Patients
Employers: <ALL> - <ALL>

Clinics: <ALL>
Providers: <ALL>

Page 1 of 6Report Generated By: enterpriseReport Date: 04/22/2018

Employer Name:
Address:

Phone:
# Employed: 4

(408) 555-3000A.C.S.
Divsion Of Acme Computer Services
1234 LAKESIDE DRIVE
Santa Clara, CA 95052

EMPLOYEE BIRTHDATE CHART# FAMILY SOCIAL SECURITY # 
Abbott, Patricia 11/11/1970          ABB123 Single                   000-00-0000
Baber, Kirk O 11/11/1970          BAB123 Single                   000-00-0000
Gleason, Alice 11/11/1970          GLE123                             Single                   000-00-0000
Little, Brian 11/11/1970          LIT123 Single                   000-00-0000

Employer Name:
Address:

Phone:
# Employed: 24

Acme Insurance Plan
1233 Rodeo Drive

Beverly Hills, CA 90210

EMPLOYEE BIRTHDATE CHART# FAMILY SOCIAL SECURITY # 
Abbott, James 11/11/1970           ABB123 Single 000-00-0000
Brown, Mary 11/11/1970           BRO123 Single 000-00-0000
Crosby, Brent 11/11/1970           CRO123 Single 000-00-0000
Davis, Janet 11/11/1970           DAV123 Single                   000-00-0000
Farrer, Lisa 11/11/1970          FAR123  Single 000-00-0000
Gleason, Alice 11/11/1970          GLE123 Single 000-00-0000
Gleason, Gary 11/11/1970           GLE123 Single 000-00-0000
Hansen, George                                                    11/11/1970          HAN123 Single 000-00-0000
Hayes, Sally 11/11/1970           HAY123 Single 000-00-0000
Jensen, Linda 11/11/1970           JEN123 Single 000-00-0000
Johnson, Rachelle 11/11/1970          JOH123 Single 000-00-0000
Jones, John 11/11/1970          JON123 Single 000-00-0000
Keller, Nina       11/11/1970          KEL123 Single 000-00-0000
Little, Brian        11/11/1970           LIT123   Single 000-00-0000
Little, Kevin 11/11/1970          LIT124 Single 000-00-0000
Myers, Henry 11/11/1970          MEY123 Single 000-00-0000
Nelson, Chris 11/11/1970           NEL123 Single 000-00-0000
Olsen, Paul  11/11/1970           OLS123 Single                   000-00-0000
Perkins, Allen 11/11/1970           PER123 Single                  000-00-0000
Reeves, Elisabeth 11/11/1970           REE123 Single 000-00-0000
Schow, Lawrence 11/11/1970          SCH123 Single 000-00-0000
Taylor, Kerri 11/11/1970          TAY123 Single 000-00-0000
Winters, Carl 11/11/1970           WIN123 Single 000-00-0000
Young, Tina 11/11/1970          YOU123 Single 000-00-0000

A B

C
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How do I run the Employers and Employed Patients 
Report?
From the DXOne Reporting module, select Reference, and then double-click Employers and 
Employed Patients. For additional details about running this report, see the “Employers and 
Employed Patients Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help 
(from the Help menu of any module, click Contents).

What important information does this report provide?
A.	Employer Details – The name, mailing address, and 

phone number of the employer. This information is found 
in the Employer Information dialog box, which can be 
accessed in the Office Manager module. See the “Adding 
and editing employers” topic in the Office Manager 
portion of the Dentrix Enterprise Help for details about 
this information (from the Help menu of any module, click 
Contents).

B.	 Number employed – If you select Include Employees 
when setting options for this report, the number of patients 
employed by the employer appears on the report.

C.	 Employee Details – If you select Include Employees when 
setting options for this report, the name, birth date, chart number, family status, and Social 
Security number of each patient employed by the employer appears on the report.

A
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Family Ledger Report
The Family Ledger Report displays transactions posted for a family. Depending on report settings, 
the current balance of each patient in the family is also displayed on the report.

Why:	 To provide a family with a record of their transactions

When:	 As needed

FAMILY LEDGER REPORT 
The Dentist Group

Page:Date: 04/23/2018 1

Guar Name: Chart Number:

Billing Type:

Peggy Perkins
123 Street
Philadelphia, PA  19102 1

DATE TEETH DESCRIPTION PATIENT CHARGE PAYMENT BALANCE

04/23/2018 Balance Forward 90.00 90.00
04/23/2018 Finance Charge Peggy 100.00 190.00
04/23/2018 Late Charge Peggy 7840.00 8030.00
04/23/2018  8*12       Mand partial-metal base w/sdls Peggy 452.00 8482.00
04/23/2018  9            Surg place implant: endosteal Shelly 780.00 9262.00
04/23/2018  4            Crown-porc fuse high noble mtl Shelly 78.00 9340.00
04/23/2018 Check Payment - Thank You <Family> -20.00 9320.00

TOTAL FAMILY BALANCE AS OF 04/23/2011: 9320.00

YTD Finance Charges:
YTD Late Charges:
YTD Payments:
YTD Insurance Payments:

100.00
7840.00

-20.00
0.00

A

B
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How do I run the Family Ledger Report?
In the Office Manager, from the Reports menu, point to Ledger, and then click Family Ledger 
Report. For additional details about running this report, see the “Family Ledger Report” topic in 
the Office Manager portion of the Dentrix Enterprise Help (from the Help menu of any module, 
click Contents).

What important information does this report provide?
A.	Family History – Displays all financial transactions posted to the Ledger for all family members.

B.	 Family Totals – Displays year-to-date totals for the family.
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Family Ledger Report (Single 
Family)
The Single Family Ledger Report displays transactions posted for a family.

Why:	 To provide a family with a record of their transactions

When:	 As needed

SINGLE FAMILY LEDGER 
The Allied Dentist Group

Page:Date: 05/14/2018 1

Guar Name: Chart Number:

Billing Type:

Peggy Perkins
123 Street
Philadelphia, PA  19102 1

DATE TEETH DESCRIPTION PATIENT CHARGE PAYMENT BALANCE

04/22/2018 Balance Forward 90.00 90.00
04/23/2018 Finance Charge Peggy 100.00 190.00
04/23/2018 Late Charge Peggy 7840.00 8030.00
04/23/2018  8*12       Mand partial-metal base w/sdls Peggy 452.00 8482.00
04/23/2018  9            Surg place implant: endosteal Shelly 780.00 9262.00
04/23/2018  4            Crown-porc fuse high noble mtl Shelly 78.00 9340.00
04/23/2018 Check Payment - Thank You <Family> -20.00 9320.00
04/27/2018   Cash Payment - Thank You <Family> -100.00 9220.00
05/01/2018 15           Mand partial-metal base w/sdls Shelly 801.00 10021.00
05/01/2018  9            Extraction crnl remnts-decid th Shelly 501.00 10522.00
05/05/2018  9            Retainer crn-porc fused-hi nob            Peggy 200.00 10722.00
05/05/2018 12           Retainer crn-porc fused-hi nob         Peggy 200.00 10922.00
05/05/2018 10           Pontic-porcelain fused to hnob Peggy 200.00 11122.00
05/05/2018 11           Pontic-porcelain fused to hnob Peggy 200.00 11322.00

TOTAL FAMILY BALANCE AS OF 05/14/2009: 11322.00

YTD Finance Charges:
YTD Late Charges:
YTD Payments:
YTD Insurance Payments:

100.00
7840.00
-120.00

0.00

A

B
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How do I run the Family Ledger Report (Single Family)?
In the Ledger, from the Print menu, click Family Ledger. For additional details about running this 
report, see the “Family Ledger Report” topic in the Ledger portion of the Dentrix Enterprise Help 
(from the Help menu of any module, click Contents).

What important information does this report provide?
A.	Family History – All financial transactions posted to the Ledger (starting with the specified first 

transaction date) for all family members.

B.	 Family Totals – Year-to-date totals for the family.
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Fee Schedules Report
The Fee Schedules Report lists procedure fees for selected fee schedules. This report also lists the 
lab expenses and material expenses associated with each procedure.

Why:	 To ensure each fee schedule is set up properly, to compare multiple fee 
schedules side by side, and to ensure lab expenses and material expenses are up 
to date

When:	 After Dentrix Enterprise setup, and as needed

FEE SCHEDULE 
ADA Code Selection: <ALL> 

Report Date: 04/22/2018 Report Generated By: enterprise Page 3 of 11 

CODE DESCRIPTION Office PULLEM DONTIST DMO FEE 5 
LAB 

MATERIAL EXPENSE 

D2331 Resin-two surfaces, anterior 90.00 85.00 78.00 74.00 69.00 0.00 25.00 
D2332 Resin-three surfaces, anterior 115.00 105.00 95.00 89.00 85.00 0.00 35.00 
D2335 Resin-4+ w/incis angle-anterior 150.00 133.00 125.00 115.00 105.00 0.00 70.00 
D2336 Compos resin crwn-anterior-prim 170.00 150.00 142.00 125.00 115.00 100.00 150.00 
D2380 Resin-1 surface, poster-primary 71.00 65.00 60.00 58.00 55.00 0.00 21.00 
D2381 Resin-2 surface, poster-primary 92.00 85.00 79.00 74.00 70.00 0.00 34.00 
D2382 Resin-3 surface, poster-primary 119.00 105.00 95.00 88.00 85.00 0.00 84.00 
D2385 Resin-1 surface, post-permanent 80.00 75.00 69.00 65.00 61.00 0.00 15.00 
D2386 Resin-2 surface, post-permanent 110.00 98.00 92.00 87.00 84.00 0.00 30.00 
D2387 Resin-3 surface +, post-perm 146.00 128.00 115.00 106.00 100.00 0.00 86.00 
D2390 Resin composite crown, anterior 0.00 0.00 0.00 0.00 0.00 0.00 18.00 
D2391 Resin composite-1 s, posterior 0.00 0.00 0.00 0.00 0.00 0.00 18.00 
D2392 Resin composite-2s, posterior 0.00 0.00 0.00 0.00 0.00 0.00 39.00 
D2393 Resin composite-3s, posterior 0.00 0.00 0.00 0.00 0.00 0.00 88.00 
D2394 Resin composite-4+s, posterior 0.00 0.00 0.00 0.00 0.00 0.00 121.00 
D2410 Gold foil-one surface 331.00 300.00 246.00 225.00 200.00 0.00 0.00 
D2420 Gold foil-two surfaces 398.00 390.00 367.00 350.00 338.00 0.00 0.00 
D2430 Gold foil-three surfaces 450.00 432.00 393.00 374.00 344.00 0.00 0.00 
D2510 Inlay-metallic-one surface 406.00 390.00 375.00 345.00 319.00 0.00 0.00 
D2520 Inlay-metallic-two surfaces 468.00 438.00 421.00 395.00 366.00 0.00 0.00 
D2530 Inlay-metallic-three + surfaces 520.00 495.00 474.00 440.00 420.00 0.00 0.00 
D2542 Onlay-metallic-two surfaces 0.00 0.00 0.00 0.00 0.00 0.00 0.00 
D2543 Onlay-metallic-three surfaces 503.00 475.00 428.00 393.00 302.00 0.00 0.00 
D2544 Onlay-metallic-four + surfaces 553.00 522.00 470.00 432.00 332.00 0.00 0.00 
D2610 lnlay-porcel/ceramic-1 surface 460.00 414.00 393.00 372.00 350.00 0.00 0.00 
D2620 lnlay-porcel/ceramic-2 surface 493.00 450.00 440.00 419.00 560.00 0.00 0.00 
D2630 lnlay-porcel/ceramic-3+ surface 553.00 500.00 468.00 440.00 445.00 0.00 0.00 
D2642 Onlay-porcel/ceram-2 surface 553.00 500.00 468.00 440.00 325.00 0.00 0.00 
D2643 Onlay-porcel/ceram-3 surface 583.00 527.00 493.00 464.00 343.00 0.00 0.00 
D2644 Onlay-porcel/ceram-4 + surface 608.00 550.00 515.00 484.00 357.00 0.00 0.00 
D2650 Inlay-resin based composite-1 s 440.00 410.00 388.00 350.00 323.00 0.00 0.00 
D2651 Inlay-resin based composite-2s 473.00 435.00 390.00 375.00 359.00 0.00 0.00 
D2652 Inlay-resin based composite-3+s 515.00 468.00 450.00 433.00 400.00 0.00 0.00 
D2662 Onlay-resin based composite-2s 458.00 440.00 413.00 335.00 227.00 0.00 0.00 
D2663 Onlay-resin based composite-3s 488.00 468.00 440.00 357.00 242.00 0.00 0.00 
D2664 Onlay-resin based composite-4+s 505.00 485.00 455.00 369.00 250.00 0.00 0.00 
D2710 Crown-resin composite(indirect) 395.00 350.00 320.00 287.00 251.00 0.00 0.00 
D2712 Crown-3/4 resin-based comp-ind 0.00 0.00 0.00 0.00 0.00 0.00 0.00 
D2720 Crown-resin w/high noble metal 542.00 600.00 573.00 499.00 478.00 0.00 0.00 
D2721 Crown-resin w/ most base metal 573.00 546.00 493.00 454.00 413.00 0.00 0.00 
D2722 Crown-resin with noble metal 630.00 590.00 508.00 463.00 444.00 0.00 0.00 
D2740 Crown-porcelain/ceramic substr 630.00 570.00 525.00 500.00 487.00 0.00 0.00 
D2750 Crown-pore fuse high noble mtl 613.00 575.00 534.00 500.00 487.00 0.00 0.00 
D2751 Crown-pore fused to base metal 563.00 503.00 485.00 465.00 449.00 0.00 0.00 
D2752 Crown-pore fused noble metal 590.00 548.00 515.00 495.00 472.00 0.00 0.00 
D2761 Crown Insert 0.00 0.00 0.00 0.00 0.00 0.00 0.00 
D2780 Crown-3/4 cast high noble metal 0.00 0.00 0.00 0.00 0.00 0.00 0.00 
D2781 Crown-3/4 cast most base metal 0.00 0.00 0.00 0.00 0.00 0.00 0.00 
D2782 Crown-3/4 cast noble metal 0.00 0.00 0.00 0.00 0.00 0.00 0.00 
D2783 Crown-3/4 porcelain/ceramic 0.00 0.00 0.00 0.00 0.00 0.00 0.00 
D2790 Crown-full cast high noble mtl 600.00 567.00 525.00 500.00 480.00 0.00 0.00 
D2791 Crown-full cast base metal 518.00 492.00 450.00 435.00 403.00 0.00 0.00 
D2792 Crown-full cast noble metal 572.00 531.00 498.00 476.00 450.00 0.00 0.00 
D2794 Crown-titanium 0.00 0.00 0.00 0.00 0.00 0.00 0.00 
D2799 Provisional crown 0.00 0.00 0.00 0.00 0.00 0.00 0.00 
D2810 Crown-3/4 cast metallic 589.00 550.00 516.00 485.00 468.00 0.00 0.00 
D2910 Recement inlav/onlav/oartial 53.00 48.00 45.00 40.00 38.00 0.00 0.00 

A B C D
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How do I run the Fee Schedules Report?
From the DXOne Reporting module, select Reference, and then double-click Fee Schedule. For 
additional details about running this report, see the “Fee Schedule Report” topic in the DXOne 
Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
The following report information is found in the Procedure Code Editor dialog box, which can be 
accessed in the Office Manager. See the “Procedure Code Setup” or “Auto fee schedule changes” 
topic in the Office Manager portion of the Dentrix Enterprise Help for details on how to edit this 
information.

A.	Code – The procedure 

code.

B.	 Fee – The fee assigned 

to a procedure.

C.	 Lab Expense – The 

estimated lab expense 
associated with the 
procedure.

D.	Material – The 

estimated materials 
expense for the 
procedure.

A

C D

B
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Finance Charge Report
The Finance Charge Report lists the finance charges the practice has issued for a selected date or 
date range.

Why:	 To keep a record of the finance charges the practice issues each month, and to 
ensure finance charges are not duplicated

When:	 Monthly

FINANCE CHARGE REPORT
04/20/2018 - 04/23/2018 Procedure Date

Clinics: <ALL>
Provider: <ALL>

Billing Types: <ALL>

Page 1 of 1Report Date: 04/23/2018 Report Generated By: enterprise

DATE GUARANTOR NAME AMOUNT BILLING TYPE PROVIDER CLINIC

04/20/2018 Abbott, Patricia <Family>                                                     22.00 2     DDS1 CENTRAL
04/23/2018 Abbott, Patricia <Family>                                                     45.00 2      DDS1 CENTRAL
04/23/2018 Little, Brian <Family>                                                         187.00 1                 DDS1 CENTRAL
04/23/2018 Perkins, Shelly <Family>                                                    100.00 1                 DDS1 CENTRAL

TOTAL CHARGES:

* family has payment agreement

354.00

BA

C

FINANCE CHARGE REPORT
04/20/2018 - 04/23/2018 Procedure Date

Clinics: <ALL>
Provider: DDS1

Billing Types: <ALL>

Page 1 of 1Report Date: 04/23/2018 Report Generated By: enterprise

DATE GUARANTOR NAME AMOUNT BILLING TYPE PROVIDER CLINIC

Provider: DDS1 354.00

354.00Clinic: CENTRAL
04/20/2018 Abbott, Patricia <Family>                                                     22.00 2      DDS1 CENTRAL
04/23/2018 Abbott, Patricia <Family>                                                     45.00 2      DDS1 CENTRAL
04/23/2018 Little, Brian <Family>                                                          187.00 1     DDS1 CENTRAL
04/23/2018 Perkins, Shelly <Family>                                                    100.00 1 DDS1 CENTRAL

TOTAL CHARGES:

* family has payment agreement

354.00

D FINANCE CHARGE REPORT
04/20/2018 - 04/23/2018 Procedure Date

Clinics: <ALL>
Provider: DDS1

Billing Types: <ALL>

Page 1 of 1Report Date: 04/23/2018 Report Generated By: enterprise

DATE GUARANTOR NAME AMOUNT BILLING TYPE PROVIDER CLINIC

Clinic: CENTRAL 354.00

354.00Provider: DDS1
04/20/2018 Abbott, Patricia <Family>                                                     22.00 2     DDS1 CENTRAL
04/23/2018 Abbott, Patricia <Family>                                                     45.00 2   DDS1 CENTRAL
04/23/2018 Little, Brian <Family>                                                         187.00 1     DDS1 CENTRAL
04/23/2018 Perkins, Shelly <Family>                                                    100.00 1    DDS1 CENTRAL

TOTAL CHARGES:

* family has payment agreement

354.00

E
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How do I run the Finance Charge Report?
From the DXOne Reporting module, select Management, and then double-click Finance/Late 
Charge. For additional details about running this report, see the “Finance Charge Report” topic in 
the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, 
click Contents).

What important information does this report provide?
The report can be grouped and subtotaled by provider with a breakdown by clinic. Or, the report 
can be grouped and subtotaled by clinic with a breakdown by provider. The report contains the 
following information.

A.	Guarantor Name – The guarantor to which a finance charge has been applied.

Note: Finance charges are applied to the guarantor of an account, not the patient.

B.	 Amount – The amount of the finance charge.

C.	 Total Charges – The total finance charges within the date range of the report.

D.	Provider Totals – The finance charges are shown for the provider with a breakdown of the 
finance charges for each clinic the provider works in. Each clinic’s finance charges for that 
provider are subtotaled. The finance charge totals for the provider appear below the clinic 
subtotals.

E.	 Clinic Totals – The finance charges are shown for the clinic with a breakdown of the finance 
charges by each provider at that clinic. Each provider’s transactions for that clinic are subtotaled. 
The finance charge totals for the clinic appear below the provider subtotals.
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Future Due Payment Plan Report - 
Monthly Totals
The Future Due Payment Plan - Monthly Totals Report displays future due payment totals by month.

Why:	 To project future revenue from future due payment plans

When:	 Monthly or at the beginning of each budgeting cycle

Date: Page:05/30/2018 1

MONTHLY TOTALS REPORT
The Dentist Group

04/01/2017 - 05/01/2018

MONTH NUMBER OF CHARGES TOTAL CHARGE AMOUNT

1. April 2017 2 4005.56
2. May 2017 1                                                                                       105.56
3. June 2017 1 105.56
4. July 2017 1                                                                                       105.56
5. August 2017 1 105.56
6. September 2017 1                                                                                       105.56
7. October 2017 1 105.56
8. November 2017 1                                                                                       105.56
9. December 2017 1                                                                                       105.56

10. January 2018 1                                                                                       105.56
11. February 2018 1                                                                                       105.56
12. March 2018 1                                                                                       105.56
13. April 2018 1                                                                                       105.56
14. May 2018 1 105.56

TOTAL NUMBER OF CHARGES: 15 TOTAL AMOUNT: 5377.84
AVERAGE NUMBER OF CHARGES: 2 AVERAGE MONTHLY CHARGE AMOUNT: 384.14

REMAINING AFTER MAY 2010
NUMBER OF CHARGES: TOTAL AMOUNT:0 0.00

NEXT CHARGE AMOUNT: 0.00

A B
C

D
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How do I run the Future Due Payment Plan Report - 
Monthly Totals?
In the Office Manager, from the Reports menu, point to Ledger, and then click Future Due 
Payment Plan Report. For additional details about running this report, see the “Future Due 
Payment Plan Report” topic in the Office Manager portion of the Dentrix Enterprise Help (from the 
Help menu of any module, click Contents).

What important information does this report provide?
The following report information is found in the Payment Plan dialog box. To access this dialog 
box, in the Ledger, from the Transaction menu, click Process Future Due Payment Plan. Select a 
future due payment plan, and then click OK. The report contains the following information:

A.	Number of Payments – The number of payments anticipated during a month.

B.	 Total Payment Amount – The projected revenue total from future due treatment plans.

C.	 Report Totals – The combined totals for all months.

D.	Remaining – The number of charges, total amount, and next charge amount that will remain for 
all future due payment plans in a year from the current month.
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Future Due Payment Plan Report - 
Standard
The Future Due Payment Plan Report displays patients with future due payment plans. Patients are 
listed alphabetically by the guarantor.

Why:	 To review future due payment plans by patient

When:	 Monthly or at the beginning of each budgeting cycle

Date: Page:04/23/2018 1

FUTURE DUE PAYMENT PLAN REPORT
The Dentist Group

01/01/2018 - 01/01/2018

GUARANTOR NAME PHONE NUM. BILLING TYPE
PATIENT NAME DATE TOTAL REMAINING MONTHS CHARGE AMT

Abbott, Patricia 555-1586 Last Payment:         
Abbott, Patricia 

2 Last Claim Date:   
01/01/2018 5000.00 3900.00 1 3900.00

Winters, Carl Last Payment:         
Winters, Carl

1    Last Claim Date:    
01/01/2018 2000.00 1900.00            18 105.56

TOTAL AMOUNT REMAINING:
TOTAL MONTHLY CHARGES:

5800.00
4005.56

A
B

Date: Page:04/23/2018 1

FUTURE DUE PAYMENT PLAN REPORT
The Dentist Group

01/01/2018 - 01/01/2018

GUARANTOR NAME PHONE NUM. BILLING TYPE
PATIENT NAME DATE TOTAL REMAINING MONTHS CHARGE AMT

Abbott, Patricia 555-1586 Last Payment:         
Abbott, Patricia 

2 Last Claim Date:   
01/01/2018 5000.00 3900.00 1 3900.00

Winters, Carl Last Payment:         
Winters, Carl

1    Last Claim Date:    
01/01/2018 2000.00 1900.00            18 105.56

TOTAL AMOUNT REMAINING:
TOTAL MONTHLY CHARGES:

5800.00
4005.56

C D

E F G H I
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How do I run the Future Due Payment Plan Report?
In the Office Manager, from the Reports menu, point to Ledger, and then click Future Due 
Payment Plan Report. For additional details about running this report, see the “Future Due 
Payment Plan Report” topic in the Office Manager portion of the Dentrix Enterprise Help (from the 
Help menu of any module, click Contents).

What important information does this report provide?
The following report information is found in the Payment Plan dialog box. To access this dialog 
box, in the Ledger, from the Transaction menu, click Process Future Due Payment Plan. Select a 
future due payment plan, and then click OK. The report contains the following information:

A.	Total Amount Remaining – The total balance of future due payment plans.

B.	 Total Monthly Charges – The total monthly revenue expected from future due payment plans 
listed in the report.

C.	 Last Claim Date – The date of the last claim for the procedures associated with the future due 
payment plan (if applicable).

D.	Last Payment – The date and amount of the last payment (if any) posted to the patient’s 
Ledger.

E.	 Date – The date the payment agreement was created.

F.	 Total – The total future due payment plan amount.

G.	Remaining – The remaining amount to be paid.

H.	Months – The number of remaining months for the plan.

I.	 Payment – The monthly amount charged to the patient.
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Initial Health History Report
The Initial Health History Report displays the percentage of new oral health patients who have a 
First Visit Date in the Family File that is within a specified time frame and who had an initial health 
history (determined by specified ADA and/or condition codes) entered into their electronic records 
during the same time frame.

For example, you may want to track new patients who received a comprehensive oral exam (ADA 
code D0150)—the denominator code—and who have a history of smoking or tobacco use (a 
condition code; for example, 15995)—the numerator code.

Why:	 To view statistics regarding the oral health history of new patients

When:	 Yearly

8 8

8

A B

E
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How do I run the Initial Health History Report?
From DXOne Reporting, select Lists, and then double-click Initial Health History. For additional 
details about running this report, see the “Initial Health History Report” topic in the DXOne 
Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
The report contains the following information:

A.	Numerator – The specified ADA codes and/or conditions.

B.	 Denominator – The specified ADA codes and/or conditions.

C.	 Clinic Totals – The Numerator, Denominator, and Percent totals for the providers at a given 
clinic on the report.

D.	Provider Totals – The Numerator, Denominator, and Percent totals for a given provider who is 
attached to the Numerator and/or Denominator codes.

E.	 Details –  If you select Include Details when setting options for this report, patient names, chart 
numbers, and procedures codes (numerators and denominators) appear on the report.

F.	 Totals – The Numerator, Denominator, and Percent grand totals for all clinics on the report.
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Insurance Carrier List
The Insurance Carrier List displays a list of the dental/medical insurance carriers entered in Dentrix 
Enterprise. Depending on how you run the report, the subscribers and patients, or providers 
associated with each carrier can also appear on this report.

Why:	 To ensure insurance carriers are properly set up in Dentrix Enterprise

When:	 After Dentrix Enterprise setup, and as needed

Insurance Carriers: <ALL>    -    <ALL>

DENTAL INSURANCE CARRIERS AND PROVIDER IDs
Financial Class Types: <ALL>

Page 1 of 10Report Date: 04/27/2018 Report Generated By: enterprise

DED S/P/O:GROUP NAME:CARRIER: LT, 0/0/0 
ADDRESS: GROUP NUM: IND, 0/0/0 

UNION NUM:
32465 Street Name

City, UT  84003
FAM,

CLAIM FORMAT: BENEFITS:
PHONE:

IND,  0.00
TIME LIMIT:

BENEFIT RENEWAL: January
ALT CODE:

 0.00FAM,

LAST UPDATE:EMPLOYER:
PAYOR ID: # PROVIDERS:

CONTACT: SOURCE OF PMT:

0/0/0 

1
ADA Code

Aetna HSPS A

0 days

12/15/2017
FINANCIAL CLASS:

[ ] Do Not Bill To Dental Insurance
[ ] Replace Initial Zero of Procedure Code on Claims [ ] Do Not Bill To Dental Insurance if 0% Coverage
[ ] Do Not Print Dental Diagnostic Codes on Claim

PROVIDER PROVIDER ID CODE PROVIDER ID NUMBER
DDS01  Smith, Dennis 0B State License Number                                                    12345abc678def

DED S/P/O:GROUP NAME:CARRIER: LT, 0/0/0 
ADDRESS: GROUP NUM: IND, 0/0/0 

UNION NUM:
32465 Street Name

City, UT  84003
FAM,

CLAIM FORMAT: BENEFITS:
PHONE:

IND,  0.00
TIME LIMIT:

BENEFIT RENEWAL: January
ALT CODE:

 0.00FAM,

LAST UPDATE:EMPLOYER:
PAYOR ID: # PROVIDERS:

CONTACT: SOURCE OF PMT:

0/0/0 

1
ADA Code

Aetna HSPS B

0 days

12/15/2017
FINANCIAL CLASS:

[ ] Do Not Bill To Dental Insurance
[ ] Replace Initial Zero of Procedure Code on Claims [ ] Do Not Bill To Dental Insurance if 0% Coverage
[ ] Do Not Print Dental Diagnostic Codes on Claim

PROVIDER PROVIDER ID CODE PROVIDER ID NUMBER
DDS01  smith, Dennis 0B State License Number                                                    abcde1234fg56

DED S/P/O:GROUP NAME:CARRIER: LT, 0/0/0 
ADDRESS: GROUP NUM: IND, 25/0/0 

UNION NUM:
P.O. Box 12345

Fort Wayne, IN  46801
FAM,

(800) 555-6444
CLAIM FORMAT: BENEFITS:

PHONE:
IND,  2000.00

TIME LIMIT:
BENEFIT RENEWAL: January

ALT CODE:

 9000.00FAM,

LAST UPDATE:EMPLOYER:
PAYOR ID: # PROVIDERS:

CONTACT: SOURCE OF PMT:

0/0/0 

0
ADA Code

Aetna Life and Casualty

Claims Office

Aetna
321863

DX2007      DX2007
180 days

Acme Clothing                             12/31/2017
FINANCIAL CLASS:

[ ] Do Not Bill To Dental Insurance
[ ] Replace Initial Zero of Procedure Code on Claims [ ] Do Not Bill To Dental Insurance if 0% Coverage
[ ] Do Not Print Dental Diagnostic Codes on Claim

DED S/P/O:GROUP NAME:CARRIER: LT, 0/0/0 
ADDRESS: GROUP NUM: IND, 50/0/0 

UNION NUM:
P.O. Box 123459

St. Louis, MO  63126
FAM,

(800) 555-7635
CLAIM FORMAT: BENEFITS:

PHONE:
IND,  1500.00

TIME LIMIT:
BENEFIT RENEWAL: January

ALT CODE:

 0.00FAM,

LAST UPDATE:EMPLOYER:
PAYOR ID: # PROVIDERS:

CONTACT: SOURCE OF PMT:

150/0/0 

0
ADA Code

Allied Group Insurance Trust Allied Group Insurance Trust
     16023

DX2007      DX2007
0 days

12/13/2017
FINANCIAL CLASS:

[ ] Do Not Bill To Dental Insurance
[ ] Replace Initial Zero of Procedure Code on Claims [ ] Do Not Bill To Dental Insurance if 0% Coverage
[ ] Do Not Print Dental Diagnostic Codes on Claim

A

B

Insurance Carriers: Aetna - HSPS B -     -    Aetna - HSPS B - 

DENTAL INSURANCE CARRIERS AND SUBSCRIBERS
Financial Class Types: <ALL>

Page 1 of 1Report Date: 04/27/2018 Report Generated By: enterprise

DED S/P/O:GROUP NAME:CARRIER: LT, 0/0/0 
ADDRESS: GROUP NUM: IND, 0/0/0 

UNION NUM:
32465 Street Name

City, UT  84003
FAM,

CLAIM FORMAT: BENEFITS:
PHONE:

IND,  0.00
TIME LIMIT:

BENEFIT RENEWAL: January
ALT CODE:

 0.00FAM,

LAST UPDATE:EMPLOYER:
PAYOR ID: # SUBSCRIBERS:

CONTACT: SOURCE OF PMT:

0/0/0 

2
ADA Code

Aetna HSPS B

0 days

12/15/2017
FINANCIAL CLASS:

# INSURED PATIENTS: 3

[ ] Do Not Bill To Dental Insurance
[ ] Replace Initial Zero of Procedure Code on Claims [ ] Do Not Bill To Dental Insurance if 0% Coverage
[ ] Do Not Print Dental Diagnostic Codes on Claim

CHART# EMPLOYER FAMILY BENEFITSDED MET SUBSCRIBER #SUBSCRIBER NAME BIRTHDATE
(P)Little, Patrick R  11/11/1975         P32143              000-00-0000    Single                          0/0/0 105.00
(S)Little, Patrick R  11/11/1975         P32143              000-00-0000    Single                          0/0/0 0.00

A

C
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Insurance Carriers: Aetna - HSPS B -     -    Aetna - HSPS B - 

DENTAL INSURANCE CARRIERS, SUBSCRIBERS AND PATIENTS
Financial Class Types: <ALL>

Page 1 of 1Report Date: 04/27/2018 Report Generated By: enterprise

DED S/P/O:GROUP NAME:CARRIER: LT, 0/0/0 
ADDRESS: GROUP NUM: IND, 0/0/0 

UNION NUM:
32465 Street Name

City, UT  84003
FAM,

CLAIM FORMAT: BENEFITS:
PHONE:

IND,  0.00
TIME LIMIT:

BENEFIT RENEWAL: January
ALT CODE:

 0.00FAM,

LAST UPDATE:EMPLOYER:
PAYOR ID: # SUBSCRIBERS:

CONTACT: SOURCE OF PMT:

0/0/0 

2
ADA Code

Aetna HSPS B

0 days

12/15/2017
FINANCIAL CLASS:

# INSURED PATIENTS: 3

[ ] Do Not Bill To Dental Insurance
[ ] Replace Initial Zero of Procedure Code on Claims [ ] Do Not Bill To Dental Insurance if 0% Coverage
[ ] Do Not Print Dental Diagnostic Codes on Claim

CHART# EMPLOYER FAMILY BENEFITSDED MET SUBSCRIBER #NAME BIRTHDATE
*(P)Little, Brian R   11/11/1975        P32143              000-00-0000    Single                       105.000/0/0
*(S)Smith, Michael  11/11/1975        P32143              000-00-0000    Single          0.000/0/0
(P)Smith, Maggie 11/11/2000 Single

A

C
D

How do I run the Insurance Carrier List?
From the DXOne Reporting module, select Reference, and then double-click Insurance Carrier 
List. For additional details about running this report, see the “Insurance Carrier List” topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).
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What important information does this report provide?
When running the report, you can choose to include subscribers, subscribers and patients, or 
providers on the report. Of the following items, only the relevant ones appear on the report, 
depending on which option is selected when setting up options to run the report.

A.	 Insurance Carrier Details – The first four items that follow are found in the Dental/Medical 
Insurance Plan Information dialog box, which can be accessed in the Office Manager. The 
remaining items are found in the Insurance Coverage dialog box (dental only).

•	 Claim Format – The claim form used to send printed 
claims.

•	 Alt Code – Indicates whether ADA or alternate 
procedure codes are used when sending claims to the 
insurance carrier (dental only).

•	 Payor ID – A unique number used to identify an 
insurance carrier when submitting claims electronically. 
Payor IDs are updated regularly by the eServices 
clearinghouse.

•	 Source of Payment – The category used to identify 
payments received from the insurance carrier.

•	 Claim Deadline – The number of days/weeks/months/
years in which a claim must be submitted to the 
insurance carrier.

•	 Ded S/P/O

•	 LT – The lifetime deductible of a policy (if any).

•	 Ind – The annual deductible 
for an individual.

•	 Fam – The annual 
deductible for a family.

•	 Benefits

•	 Ind – Yearly benefits for 
individuals.

•	 Fam – Yearly benefits for 
families.

A

A
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B.	 Provider Details – The name, ID code, and ID number for each provider with an identification 
code entered for an insurance carrier. This information is found in the Provider ID Setup dialog 
box (see the “Setting up provider IDs for dental insurance” topic in the Family File portion of 
the Dentrix Enterprise Help for details on how to edit this information).

C.	 Subscriber Details – The name, birth date, chart number, subscriber number, employer, 

and family status of each subscriber. The report also includes the portion of the subscriber’s 
deductible that has currently been met and the total benefits that have been used year-to-date.

Notes:

•	 “(P)” indicates a primary subscriber. “(S)” indicates a secondary subscriber.

•	 When viewing subscribers and patients on the report, subscribers are denoted with an 
asterisk.

D.	Patient Details – The name, birth date, chart number, employer, and family status for each 
patient associated with the insurance carrier.  The report also includes the portion of the 
patient’s deductible that has currently been met and the total benefits that have been used 
year-to-date.

Notes:

•	 “(P)” indicates a primary subscriber. “(S)” indicates a secondary subscriber.

•	 When viewing subscribers and patients on the report, subscribers are denoted with an 
asterisk.

B
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Insurance Carrier Production - Full 
Report
The Insurance Carrier Production - Full Report lists the insurance carriers to which claims have been 
submitted. The production, payments, and adjustments appear individually for each carrier.

Why:	 To compare the amount of payments received from insurance carriers with the 
production billed to the corresponding carriers

When:	 Monthly and quarterly

Dental Insurance Carrier Production Report
04/23/2018 - 04/23/2018 Entry Date

Clinics: <ALL>
Providers: <ALL>

Financial Class Types: Plans with no Financial Class Assigned
Patient Range: <ALL>    -    <ALL>

Insurance Carriers: Aetna - HSPS A -     -    Aetna Life and Casualty - Aetna - 321863

Page 1 of 1Report Generated By: enterpriseReport Date: 04/23/2018

Patient Name Provider Description Primary
Production

Amount

Insurance
Payment
Amount

ClinicEntry Date Secondary
Production

Amount

Credit
Adjustments

Debit
Adjustments

Aetna

Little, Brian R 04/23/2018 DDS1 CENTRAL          D0120 - Periodic oral evaluation                             25.00 0.00                 -25.00
Little, Brian R DDS1 CENTRAL          D0274 - Bitewings-four films                                   32.00 0.00                 -32.00
Little, Brian R DDS1 CENTRAL          D1110 - Prophylaxis-adult                                       48.00 0.00                 -48.00

Aetna Insurance Plan Totals: 105.00 0.00 -105.00 0.00 0.00

Aetna Life and Casualty

Abbott, James S DROBB CENTRAL          D5212 - Mandibular partial - resin 
base

0.00 690.00 0.00

Aetna Life and Casualty Insurance Plan Totals: 0.00 690.00 0.00 0.00 0.00

105.00 690.00 -105.00 0.00 0.00Grand Totals:

04/23/2018
04/23/2018

04/23/2018

A B
C

D
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How do I run the Insurance Carrier Production - Full 
Report?
From the DXOne Reporting module, select Management, and then double-click Insurance Carrier 
Production. For additional details about running this report, see the “Insurance Carrier Production 
Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu 
of any module, click Contents).

What important information does this report provide?
A.	 Insurance Carrier – The primary and secondary insurance carrier that has production within the 

date range of the report:

B.	 Procedure Details – The procedures for which a claim has been created appear with the 
following information:

•	 Patient Name – The name of the patient on whom the service was performed.

•	 Entry Date – The date the procedure was posted to the Ledger.

•	 Primary Production – The amount of production for which a primary claim has been 
created.

•	 Secondary Production – The amount of production for which a secondary claim has been 
created.

•	 Insurance Payment – The amount of the payment received from the insurance carrier for 
the procedure.

•	 Credit – The credit adjustments made to the production.

•	 Debit – The debit adjustments made to the production.

C.	 Plan Totals – The production, payment, and adjustment totals for the insurance carrier.

D.	Grand Totals – The combined production, payment, and adjustment totals for the insurance 
carriers on the report.
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Insurance Carrier Production - 
Summary Report
The Insurance Carrier Production - Summary Report lists the insurance carriers to which claims have 
been submitted. The production, payments, and adjustments appear for each carrier.

Why:	 To compare the amount of payments received from insurance carriers with the 
production billed to the corresponding carriers

When:	 Monthly and quarterly

Dental Insurance Carrier Production Report
04/23/2018 - 04/23/2018 Entry Date

Clinics: <ALL>
Providers: <ALL>

Financial Class Types: <ALL>
Patient Range: <ALL>    -    <ALL>

Insurance Carriers: <ALL>    -    <ALL>

Page 1 of 1Report Generated By: enterpriseReport Date: 04/23/2018

Insurance Carrier
Primary

Production
Amount

Secondary
Production

Amount

Insurance
Payment
Amount

Credit
Adjustments

Debit
Adjustments

Aetna 105.00 0.00 -105.00 0.00 0.00

Aetna Life and Casualty 0.00 690.00 0.00 0.00 0.00

Met Life 90.00 0.00 0.00 0.00 0.00

Metropolitan Life 2,304.00 0.00 -532.00 0.00 0.00
2,499.00 690.00 -637.00 0.00 0.00Grand Totals:

BA

C
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How do I run the Insurance Carrier Production - Summary 
Report?
From the DXOne Reporting module, select Management, and then double-click Insurance Carrier 
Production. For additional details about running this report, see the “Insurance Carrier Production 
Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu 
of any module, click Contents).

What important information does this report provide?
A.	 Insurance Carriers – The primary and secondary insurance carriers that have production within 

the date range of the report.

B.	 Production

•	 Primary Production – The amount of production for which primary claims have been 
created.

•	 Secondary Production – The amount of production for which secondary claims have been 
created.

•	 Insurance Payments – The amount of the payments received from the insurance carrier.

•	 Adjustments – The following adjustments:

•	 Credit – The credit adjustments made to the production.

•	 Debit – The debit adjustments made to the production.

C.	 Grand Totals – The combined production, payment, and adjustment totals for the insurance 
carriers on the report.
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Insurance Claim Aging Report
The Insurance Claim Aging Report lists outstanding insurance claims, grouped by insurance carrier, 
along with the aged balances of each claim.

Why:	 To identify unpaid claims so they can be targeted for collections

When:	 Monthly

Over 0
<ALL> - <ALL>

Dental Insurance Claim Aging
Days Past Due:
Patient Range:

<ALL>    -    <ALL>Carrier Range:
<ALL>Clinics:
<ALL>Providers:
<ALL>Billing Types:

Page 1 of 1Report Generated By: enterpriseReport Date: 05/04/2018

SUBSCRIBER

INSURANCE COMPANY/GROUP PLAN PHONE # GROUP NUM.

ID NUM TRACERSENT ON HOLD RE-SENT PATIENT NAME BIRTHDAY 1-30 31-60 61-90 91-120 TOTALTYPE ESTIMATE 121-150 151-180 181+SERV.

Aetna Life and Casualty/Aetna (800) 555-6444   321863
Kenner, Spencer A 000-00-0000   PRM    5/1/18     5/2/18         5/3/18        5/3/18         11/11/1977       391.20          0.00       0.00       0.00       0.00        0.00      0.00          514.00    514.00
Perkins, Shelly 000-00-0000   PRM    5/1/18     5/2/18          5/3/18        5/3/18         

5/4/18     Kenner, Spencer A 
5/4/18     Perlins, Shelly 11/11/1975       341.60      452.00       0.00       0.00       0.00        0.00      0.00              0.00    452.00

Allied Group Insurance Trust/Allied Group Insurance Trust (800) 555-7635 16023
Smith, Dorothy 000-00-0000   PRM    5/1/18      5/2/18         5/3/18         5/3/18         5/4/18     Smith, Dorothy 11/11/1929       206.40          0.00       0.00       0.00       0.00        0.00      0.00         308.00    308.00

Butchers Local  551/Butchers Local  551        SS#
Crosby, Brent 000-00-0000   PRM    5/1/18      5/2/18         5/3/18        5/3/18         5/4/18      Crosby, Brent 11/11/1975        183.00          0.00       0.00       0.00       0.00        0.00      0.00         183.00     183.00
Crosby, Carol 000-00-0000   PRM    5/1/18      5/2/18         5/3/18         5/3/18        5/4/18      Crosby, Carol     11/11/1975       183.00          0.00       0.00       0.00       0.00         0.00      0.00         183.00    183.00
Crosby, Shirley 000-00-0000   PRM    5/1/18      5/2/18        5/3/18        5/3/18         5/4/18      Crosby, Shirley                        11/11/1975       292.00          0.00       0.00       0.00       0.00        0.00       0.00         292.00    292.00
Crosby, Tommy 000-00-0000   PRM    5/1/18      5/2/18         5/3/18        5/3/18         5/4/18      Crosby, Tommy                           11/11/1975        905.00          0.00       0.00       0.00      0.00         0.00      0.00         905.00    905.00

Acme Parts Insurance/A.c.s.        SS#
Little, Brian 000-00-0000   PRM    5/1/18      5/2/18        5/3/18        5/3/18         5/4/18      Little, Brian 11/11/1975    3,093.00          0.00       0.00      0.00       0.00         0.00      0.00      6,186.00 6,186.00

Met Life/Murphy's Trucking
Taylor, Mark 000-00-0000   PRM    5/1/18      5/2/18        5/3/18        5/3/18 5/4/18      Taylor, Mark  11/11/1975         90.00          0.00       0.00      0.00       0.00       90.00      0.00            90.00      90.00

Metropolitan Life Insurance/Dental (800) 555-8484 0027186
Smith, Michael 000-00-0000   PRM    5/1/18      5/2/18         5/3/18         5/3/18         5/4/18      Little, Brian                                   11/11/1975         64.00      105.00       0.00      0.00       0.00         0.00      0.00         180.00    105.00

TOTAL ALL CLAIMS:

PRIMARY CLAIM TOTALS:

SECONDARY CLAIM TOTALS:

1 - 30 31 - 60 61 - 90 181+ TOTAL

557.00 0.00 0.00 0.00 9,218.005,749.20

557.00 0.00 0.00 0.00

0.00 0.00 0.00 0.00

9,218.00

0.00

ESTIMATE

5,749.20

0.00

91-120 121-150 151-180

90.00

0.00

0.00

0.00

8,571.00

0.00

8,571.000.0090.00

Over 0
<ALL> - <ALL>

Dental Insurance Claim Aging
Days Past Due:
Patient Range:

<ALL>    -    <ALL>Carrier Range:
<ALL>Clinics:
<ALL>Providers:
<ALL>Billing Types:

Page 1 of 1Report Generated By: enterpriseReport Date: 05/04/2018

SUBSCRIBER

INSURANCE COMPANY/GROUP PLAN PHONE # GROUP NUM.

ID NUM TRACERSENT ON HOLD RE-SENT PATIENT NAME BIRTHDAY 1-30 31-60 61-90 91-120 TOTALTYPE ESTIMATE 121-150 151-180 181+SERV.

Aetna Life and Casualty/Aetna (800) 555-6444   321863
Kenner, Spencer A 000-00-0000   PRM    5/1/18     5/2/18         5/3/18        5/3/18         11/11/1977       391.20          0.00       0.00       0.00       0.00        0.00      0.00          514.00    514.00
Perkins, Shelly 000-00-0000   PRM    5/1/18     5/2/18          5/3/18        5/3/18         

5/4/18     Kenner, Spencer A 
5/4/18     Perlins, Shelly 11/11/1975       341.60      452.00       0.00       0.00       0.00        0.00      0.00              0.00    452.00

Allied Group Insurance Trust/Allied Group Insurance Trust (800) 555-7635 16023
Smith, Dorothy 000-00-0000   PRM    5/1/18      5/2/18         5/3/18         5/3/18         5/4/18     Smith, Dorothy 11/11/1929       206.40          0.00       0.00       0.00       0.00        0.00      0.00         308.00    308.00

Butchers Local  551/Butchers Local  551        SS#
Crosby, Brent 000-00-0000   PRM    5/1/18      5/2/18         5/3/18        5/3/18         5/4/18      Crosby, Brent 11/11/1975        183.00          0.00       0.00       0.00       0.00        0.00      0.00         183.00     183.00
Crosby, Carol 000-00-0000   PRM    5/1/18      5/2/18         5/3/18         5/3/18        5/4/18      Crosby, Carol     11/11/1975       183.00          0.00       0.00       0.00       0.00         0.00      0.00         183.00    183.00
Crosby, Shirley 000-00-0000   PRM    5/1/18      5/2/18        5/3/18        5/3/18         5/4/18      Crosby, Shirley                        11/11/1975       292.00          0.00       0.00       0.00       0.00        0.00       0.00         292.00    292.00
Crosby, Tommy 000-00-0000   PRM    5/1/18      5/2/18         5/3/18        5/3/18         5/4/18      Crosby, Tommy                           11/11/1975        905.00          0.00       0.00       0.00      0.00         0.00      0.00         905.00    905.00

Acme Parts Insurance/A.c.s.        SS#
Little, Brian 000-00-0000   PRM    5/1/18      5/2/18        5/3/18        5/3/18         5/4/18      Little, Brian 11/11/1975    3,093.00          0.00       0.00      0.00       0.00         0.00      0.00      6,186.00 6,186.00

Met Life/Murphy's Trucking
Taylor, Mark 000-00-0000   PRM    5/1/18      5/2/18        5/3/18        5/3/18 5/4/18      Taylor, Mark  11/11/1975         90.00          0.00       0.00      0.00       0.00       90.00      0.00            90.00      90.00

Metropolitan Life Insurance/Dental (800) 555-8484 0027186
Smith, Michael 000-00-0000   PRM    5/1/18      5/2/18         5/3/18         5/3/18         5/4/18      Little, Brian                                   11/11/1975         64.00      105.00       0.00      0.00       0.00         0.00      0.00         180.00    105.00

TOTAL ALL CLAIMS:

PRIMARY CLAIM TOTALS:

SECONDARY CLAIM TOTALS:

1 - 30 31 - 60 61 - 90 181+ TOTAL

557.00 0.00 0.00 0.00 9,218.005,749.20

557.00 0.00 0.00 0.00

0.00 0.00 0.00 0.00

9,218.00

0.00

ESTIMATE

5,749.20

0.00

91-120 121-150 151-180

90.00

0.00

0.00

0.00

8,571.00

0.00

8,571.000.0090.00

A

B

C

E

D
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How do I run the Insurance Claim Aging Report?
From the DXOne Reporting module, select Ledger, and then double-click Insurance Claim Aging. 
For additional details about running this report, see the “Insurance Claim Aging Report” topic in 
the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, 
click Contents).

What important information does this report provide?
A.	Aged Balances – The claim’s aged balances.

B.	 Service Date – The service 
date (the date of the 
procedure) is found in the 
Primary (or Secondary) 
Insurance Claim dialog box, 
which can be accessed by 
double-clicking a claim in the 
Ledger. The service date is 
automatically entered when a 
claim is created.

C.	 Dates associated with the 
claim – If you have entered 
dates in the Insurance Claim 
Status dialog box, the 
corresponding dates appear 
on the report.

•	 Sent – The date the claim 
was sent. If you send a 
claim electronically, the 
Sent date is automatically entered in the Insurance Claim Status 
dialog box.

•	 Tracer – The date the tracer was sent (if any).

•	 On Hold – Indicates the date the claim was placed on hold (if any).

•	 Re-Sent – The date the claim was re-sent to the insurance carrier (if 
applicable). If you re-send a claim electronically, the Re-sent date is 
automatically entered in the Insurance Claim Status dialog box.

D.	ID Num – A unique number that Dentrix Enterprise assigns to the claim. This number is not the 
same number that the insurance carrier assigns to the claim.

E.	 Totals – Totals for all insurance carriers listed.

C

B
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Insurance Claims Not Sent Report
The Insurance Claims Not Sent Report lists insurance claims that have been created from the 
Ledger but not sent to the Batch Processor, printed, or sent through eClaims.

Why:	 To ensure claims are processed after being created from the Ledger

When:	 Daily or weekly

04/23/2018 - 04/23/2018 
<ALL> - <ALL>

Dental Insurance Claims Not Sent
Date Range:

Patient Range:
<ALL>    -    <ALL>Carrier Range:
<ALL>Clinics:
<ALL>Providers:
<ALL>Billing Types:

Page 1 of 1Report Generated By: enterprise

INSURANCE COMPANY NAME AMOUNT EXPIRESPROVIDER CLINIC

Report Date: 04/23/2018

CLAIM DATE TYPE PATIENT NAME  

04/23/2018         SEC         Abbott, James S Aetna Life and Casualty DDS2 CENTRAL 71.00      10/20/2018
 04/23/2018         PRM        Abbott, James S Metropolitan Life DDS1 CENTRAL 230.00      07/22/2018

TOTAL OF CLAIMS NOT SENT: 301.00

TOTAL OF PRIMARY NOT SENT:

TOTAL OF SECONDARY NOT SENT:

230.00

71.00

B

A D C
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How do I run the Insurance Claims Not Sent Report?
From the DXOne Reporting module, select Ledger, and then double-click Insurance Claims Not 
Sent. For additional details about running this report, see the “Insurance Claims Not Sent Report” 
topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any 
module, click Contents).

What important information does this report provide?
A.	Claim Date – The date on which the claim was created from the Ledger.

B.	 Amount – The claim amount.

C.	 Expires – The deadline by which the insurance carrier must receive the claim after the service 
date.

D.	Totals – The amount of the primary, secondary, and all claims not sent.
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Insurance Coverage Tables Report
The Insurance Coverage Tables Report allows you to view and print the coverage tables that have 
been set up for each insurance plan.

Why:	 To ensure coverage tables have been set up properly for each insurance plan

When:	 After Dentrix Enterprise setup, and as needed

INSURANCE COVERAGE TABLES
The Dentist Group

Date: Page:04/22/2018 19

CONNECTICUT GENERAL Group Name: Acme Electric
P.O. Box 123456 Group #:    0443737
Hartford, CT   06104

BEGIN END COV CO PRE
PROC PROC   CATEGORY  % DEDUCTIBLE PAY AUTH?

D0100 D1999 Diag/Preventive 90 Standard 0.00 N
D2000 D2699 Basic Restor 80 Standard 0.00 N
D2700 D2899 Crowns 50 Standard 0.00 N
D2900 D2999 Restorative 80 Standard 0.00 N
D3000 D3999 Endodontics 80 Standard 0.00 N
D4000 D4999 Periodontics 80 Standard 0.00 N
D5000 D5999 Prostho, remov 50 Standard 0.00 N
D6000 D6999 Prostho, fixed 50 Standard 0.00 N
D7000 D7999 Oral Surgery 80 Standard 0.00 N
D8000 D8999 Orthodontics 100 Standard 0.00 N
D9000 D9999 General Service 80 Standard 0.00 N

Co-Payments Used in Calculations? ( No )
Co-Pay Calculation For Ins Portion: (None)

CONNECTICUT GENERAL Group Name: Actors Guild
P.O. Box 1234 Group #:    0443737
Hartford, CT   06104

BEGIN END COV CO PRE
PROC PROC   CATEGORY  % DEDUCTIBLE PAY AUTH?

D0100 D1999 Diag/Preventive 90 Standard 0.00 N
D2000 D2699 Basic Restor 80 Standard 0.00 N
D2700 D2899 Crowns 50 Standard 0.00 N
D2900 D2999 Restorative 80 Standard 0.00 N
D3000 D3999 Endodontics 80 Standard 0.00 N
D4000 D4999 Periodontics 80 Standard 0.00 N
D5000 D5999 Prostho, remov 50 Standard 0.00 N
D6000 D6999 Prostho, fixed 50 Standard 0.00 N
D7000 D7999 Oral Surgery 80 Standard 0.00 N
D8000 D8999 Orthodontics 100 Standard 0.00 N
D9000 D9999 General Service 80 Standard 0.00 N

Co-Payments Used in Calculations? ( No )
Co-Pay Calculation For Ins Portion: (None)

CONNECTICUT GENERAL Group Name: Actors Guild - Top Grossers
P.O. Box 1234 Group #:    0443737
Hartford, CT   06104

BEGIN END COV CO PRE
PROC PROC   CATEGORY  % DEDUCTIBLE PAY AUTH?

D0100 D1999 Diag/Preventive 90 Standard 0.00 N
D2000 D2699 Basic Restor 80 Standard 0.00 N
D2700 D2899 Crowns 50 Standard 0.00 N
D2900 D2999 Restorative 80 Standard 0.00 N
D3000 D3999 Endodontics 80 Standard 0.00 N
D4000 D4999 Periodontics 80 Standard 0.00 N
D5000 D5999 Prostho, remov 50 Standard 0.00 N
D6000 D6999 Prostho, fixed 50 Standard 0.00 N
D7000 D7999 Oral Surgery 80 Standard 0.00 N
D8000 D8999 Orthodontics 100 Standard 0.00 N
D9000 D9999 General Service 80 Standard 0.00 N

Co-Payments Used in Calculations? ( No )
Co-Pay Calculation For Ins Portion: (None)

A

B C D E
F
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How do I run the Insurance Coverage Tables Report?
In the Office Manager, from the Reports menu, point to Reference, and then click Insurance 
Coverage Tables. For additional details about running this report, see the “Insurance Coverage 
Tables Report” topic in the Office Manager portion of the Dentrix Enterprise Help (from the Help 
menu of any module, click Contents).

What important information does this report provide?
All of the following information (except for letter A) is found in the Insurance Coverage dialog 
box, which can be accessed in the Office Manager. For details on how to edit a carrier’s coverage 
information, see the “Assigning coverage tables” topic in the Family File portion of the Dentrix 
Enterprise Help.

A.	 Insurance Carrier Details – The 
name, mailing address, group 
name, and group number of the 
insurance plan.

B.	 Cov % – The percentage of 
a procedure covered by the 
insurance plan.

C.	 Deductible – The type of 
deductible (such as, None, 
Standard, Preventive, or Other).

D.	Co Pay – The co-pay amount.

E.	 Pre Auth? – Indicates whether 
or not a procedure group 
requires pre-authorization from 
the insurance carrier.

F.	 Co-Payments Used in 
Calculations? – Indicates whether or not co-payments are considered when calculating the 
insurance portion of a procedure.

G.	Co-Pay Calculated For Ins Portion – The method used to calculate the insurance portion of a 
procedure when taking into consideration co-payments: Total Fee X Coverage %, (Total Fee - 
Co-Pay) x Cov %, or (Total Fee x Cov %) - Co-Pay.

B C D E

F
G
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Insurance Eligibility Report
The Insurance Eligibility Report displays patients with appointments who are eligible for coverage.

Why:	 To ensure the practice has checked insurance eligibility for patients with 
upcoming appointments

When:	 Daily

INSURANCE ELIGIBILITY REPORT
The Dentist Group

Appointment Date Range 04/01/2018 - 04/25/2018
Date: Page:04/24/2018 1

INSURANCE COMPANY/GROUP PLAN GROUP# PHONE # STREET ADDRESS CITY ST
Elig Date Patient Chart # DOB Prim/Sec Subscriber Subscriber ID Appt Date/Time

321863 (800)555-6444 P.O. Box 12345,
11/11/1957        Primary Perkins, Peggy 000-00-0000

Aetna Life and Casualty / Aetna 
04/22/2018 Perkins, Peggy 

Aetna Life and Casualty / Aetna 321863 (800)555-6444         P.O. Box 40945, 
Perkins, Shelly PA00070     11/11/1980         Primary Perkins, Peggy 000-00-000004/22/2018 

04/22/2018 Perkins, John PA0008       11/11/1960         Primary Perkins, Peggy 000-00-0000
ABB101       11/11/1962        Secondary          Abbott, Patricia 000-00-0000

0027186 (800)555-8484          P.O. Box 480, 
SM0010       11/11/1970         Primary             Smith, Michael 000-00-0000

74170 (415)555-3222            P.O. Box 2978, 

Abbott, James S
Metropolitan Life Insurance / Dental

Smith, Michael 
Metropolitan Life / Metropolitan 
04/22/2018 Abbott, Shirley ABB102      11/11/1962         Primary Abbott, James S 000-00-0000

Fort Way
        04/24/2018 9:00 AM

Fort Way          
        04/24/2018 9:10 AM
        04/24/2018 9:20 AM 
        04/24/2018 9:10 AM
                                Warwick
        04/24/2018 10:10 AM
                                Englewo
       04/24/2018 9:10 AM

A

BC
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How do I run the Insurance Eligibility Report
In the Office Manager, from the Reports menu, point to Lists, and then click Insurance Eligibility 
Report. For additional details about running this report, see the “Insurance Eligibility Report” topic 
in the Office Manager portion of the Dentrix Enterprise Help (from the Help menu of any module, 
click Contents).

What important information does this report provide?
A.	 Insurance – The insurance company and group plan information.

B.	 Patient – The patient’s information and the next scheduled appointment.

C.	 Eligibility Date – Indicates the date that insurance eligibility was last checked for the patient. 
Use this date to ensure all patients with appointments on a given day are currently eligible for 
coverage. If no date appears, eligibility has never been checked and entered for the patient. 
The Last Eligibility Check is found in the Insurance Information dialog box, which can be 
accessed from the Family File. For details about how to enter the date when insurance eligibility 
is verified, see the topics for “Working With Insurance” in the Family File portion of the Dentrix 
Enterprise Help.

C
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Insurance Transaction Analysis 
Report
The Insurance Transaction Analysis Report displays charges (claims) and payments posted for a 
selected date range. Charges and payments are grouped by insurance carrier.

Why:	 To view the claims and payment issued for a selected date range for an insurance 
carrier, and to view the total value of claims posted for all insurance carriers

When:	 As needed

8 8

8

8
8
8
8
8
8
8

8 8
8
8
8
8

8 8
8
8
8

8 8
8
8
8
8
8
8

8 8
8
8
8
8
8
8

8 8
8
8

8
8
8

A

B

E

C

D

Report Generated By: DSMITH Page 6 of 6Report Date: 6/30/2015

Smile Saver Group Name: Ge 400

Group #: Financial Class: 

Patient Name Chart Sent Received Claim Amt Estimate Birthdate SS# Subscriber #

Transaction Date Provider ClinicDescription Charge Amt Payment Amt

Abbott, James 333-22-444405/05/1944AB0030 05/27/2015  400.00  0.00 382-42-6073P

04/20/2015 D4342 Scaling & Rootplaning 1-3 Teeth  100.00 CENTRALDSMITH

04/20/2015 Visa -100.00 AFDSMITH

04/20/2015 D4342 Scaling & Rootplaning 1-3 Teeth  100.00 CENTRALDSMITH

04/20/2015 D4342 Scaling & Rootplaning 1-3 Teeth  100.00 CENTRALDSMITH

04/20/2015 D4342 Scaling & Rootplaning 1-3 Teeth  100.00 CENTRALDSMITH

Total Claims Sent:

Total Claims Received:

Insured Charges:

Total Patient Payments:

Total Credit Adjustments:

Total Charge Adjustments:

Total Insurance Payments:

 1

 0

 4  400.00

 400.00 0

 0.00 0

 1 -100.00

 0  0.00

Total Claims Sent:

Total Claims Received:

Insured Charges:

Total Patient Payments:

Total Credit Adjustments:

Total Charge Adjustments:

Total Insurance Payments:

 11

 8

 23

 7,080.00 4

-3,166.20 8

 6 -1,192.30

 3 -231.00

TOTALS

 6,130.00

Report Generated By: DSMITH Page 2 of 6Report Date: 6/30/2015

ACME Insurance Group Name: HSPS1

Group #: 1112223Financial Class: 

Patient Name Chart Sent Received Claim Amt Estimate Birthdate SS# Subscriber #

Transaction Date Provider ClinicDescription Charge Amt Payment Amt

Crosby, Brent 111-11-111111/11/1970CR93 04/20/2015 04/20/2015  210.00  0.00 111111111P

04/20/2015 D2392 [TH:15] Resin-2 surface, poster  210.00 CENTRALDSMITH

04/20/2015 Visa -42.00 AFDSMITH

04/20/2015 Insurance Payment -168.00 CENTRALDSMITH

Crosby, Brent 111-11-111111/11/1970CR93 05/14/2015 06/30/2015  950.00  425.00 111111111P

05/14/2015 D2750 [TH:6] Crown-porc fuse high noble mtl  850.00 CENTRALDSMITH

05/14/2015 -Write-Off -20.00 CENTRALDSMITH

05/14/2015 Insurance Payment -405.00 CENTRALDSMITH

05/14/2015 Insurance Payment -20.00 CENTRALDSMITH

05/14/2015 POCHK Post Operative Check  100.00 CENTRALDSMITH

05/14/2015 Visa -100.00 CENTRALDSMITH

Test, Patient 111-11-111111/11/1970TE81 03/30/2015 03/31/2015  365.00  300.00 111111111P

03/30/2015 D0120 Periodic oral evaluation  125.00 AFDESMITH

03/30/2015 Insurance Payment -125.00 AFDESMITH

03/30/2015 D1110 Prophylaxis-adult  175.00 AFDESMITH

03/30/2015 Insurance Payment -175.00 AFDESMITH

03/30/2015 D1204 Fluoride w/o prophylaxis-adult  65.00 AFDESMITH

03/30/2015 Check Payment - Thank You -65.00 AFDESMITH

Test, Spouse 111-11-111111/11/1973TE82 03/30/2015 03/31/2015  175.00  140.00 111111111P

03/30/2015 D2332 [TH:8] Resin-three surfaces, anterior  175.00 AFDESMITH

03/30/2015 Insurance Payment -140.00 AFDESMITH

Total Claims Sent:

Total Claims Received:

Insured Charges:

Total Patient Payments:

Total Credit Adjustments:

Total Charge Adjustments:

Total Insurance Payments:

 4

 4

 7  1,700.00

 1,700.00 0

-1,033.00 5

 3 -207.00

 1 -20.00

F
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How do I run the Insurance Transaction Analysis Report?
From the DXOne Reporting module, select Analysis, and then double-click Insurance Transaction 
Analysis. For additional details about running this report, see the “Insurance Transaction Analysis 
Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help ( from the Help menu 
of any module, click Contents).

What important information does this report provide?
A.	Claim Details

Note: If a patient has multiple claims posted during the date range of the report, each claim 
appears separately.

•	 Sent – The date the claim was posted.

Note: If a report is filtered by procedure date, the sent date can fall outside the date range 
of the report.

•	 Received – The date a payment was received for the claim.

Secondary/Tertiary/Quaternary Claims – If you select Include Secondary Claims, Include 
Tertiary Claims, and/or Include Quaternary Claims when setting options for this report, 
secondary, tertiary, and/or quaternary claims appear on the report.

Note: For secondary, tertiary, and quaternary claims, claim charges are not itemized.

B.	 Charges – If you select Include Charges when setting options for this report, the procedures 
billed on a claim appear on the report.

C.	 Insurance Payments – If you select Include Claim Charges and Payments when setting 
options for this report, payments made by the insurance carrier are itemized on the report.

D.	Adjustments – If you select Include Charge Adjustments and/or Include Credit Adjustments 
when setting options for this report, adjustments appear on the report.

E.	 Patient Payments – If you select Include Patient Payments when setting options for this 
report, patient payments appear on the report.

F.	 Totals – If you select Include SubTotals by Carrier and/or Include Grand Totals when setting 
options for this report, totals for each carrier appear on the report, and/or totals for all carriers 
appear at the end of the report. The following totals appear, according to the information you 
choose to include when setting options for this report:

•	 Total Claims Sent & Received – The number of claims sent and received.

•	 Insured Charges – The number and dollar amount of charges billed to insurance.

•	 Total Insurance & Patient Payments – The number and dollar amount of insurance 
payments and patient payments.

•	 Total Credit & Charge Adjustments – The number and dollar amount of credit and charge 
adjustments.
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Late Charge Report
The Late Charge Report lists the late charges the practice has issued for a selected date or date 
range.

Why:	 To keep a record of the late charges the practice issues each month, and to 
ensure late charges are not duplicated

When:	 Monthly

04/22/2011 - 04/23/2011 Procedure Date

LATE CHARGE REPORT

Clinics: CENTRAL
Provider: DDS1

Billing Types: <ALL>

Page 1 of 1Report Date: 04/23/2011 Report Generated By: enterprise

DATE GUARANTOR NAME AMOUNT BILLING TYPE PROVIDER CLINIC

04/22/2011 Abbott, Patricia <Family>                                                     21.00                           2      DDS1                      CENTRAL
04/23/2011 Abbott, Patricia <Family>                                                     20.00                           2 DDS1                      CENTRAL
04/23/2011 Little, Brian <Family>                                                           70.00                           1                 DDS1                      CENTRAL
04/23/2011 Perkins, Shelly <Family>                                                 7,840.00                           1     DDS1                      CENTRAL

TOTAL CHARGES:

* family has payment agreement

7,951.00

BA

C

04/22/2011 - 04/23/2011 Procedure Date

LATE CHARGE REPORT

Clinics: CENTRAL
Provider: DDS1

Billing Types: <ALL>

Page 1 of 1Report Date: 04/23/2011 Report Generated By: enterprise

DATE GUARANTOR NAME AMOUNT BILLING TYPE PROVIDER CLINIC

Provider: DDS1 7,951.00

7,951.00Clinic: CENTRAL
04/22/2011 Abbott, Patricia <Family>                                                     21.00                           2     DDS1                      CENTRAL
04/23/2011   Abbott, Patricia <Family>                                                     20.00                           2                 DDS1                      CENTRAL
04/23/2011 Little, Brian <Family>                                                           70.00                           1                 DDS1                      CENTRAL
04/23/2011   Perkins, Shelly <Family>                                                 7,840.00                           1     DDS1                      CENTRAL

TOTAL CHARGES:

* family has payment agreement

7,951.00

D
04/22/2011 - 04/23/2011 Procedure Date

LATE CHARGE REPORT

Clinics: CENTRAL
Provider: DDS1

Billing Types: <ALL>

Page 1 of 1Report Date: 04/23/2011 Report Generated By: enterprise

DATE GUARANTOR NAME AMOUNT BILLING TYPE PROVIDER CLINIC

Clinic: CENTRAL 7,951.00

7,951.00Provider: DDS1
04/22/2011                    Abbott, Patricia <Family>                                                     21.00                          2 DDS1                      CENTRAL
04/23/2011  Abbott, Patricia <Family>                                                    20.00                           2     DDS1                      CENTRAL
04/23/2011 Little, Brian <Family>                                                            70.00                          1   DDS1                      CENTRAL
04/23/2011 Perkins, Shelly <Family>                                                 7,840.00                           1     DDS1                      CENTRAL

TOTAL CHARGES:

* family has payment agreement

7,951.00

E
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How do I run the Late Charge Report?
From the DXOne Reporting module, select Management, and then double-click Finance/Late 
Charge. For additional details about running this report, see the “Finance/Late Charge” topic in 
the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, 
click Contents).

What important information does this report provide?
The report can be grouped and subtotaled by provider with a breakdown by clinic. Or, the report 
can be grouped and subtotaled by clinic with a breakdown by provider. The report contains the 
following information.

A.	Guarantor Name – The guarantor to which a late charge has been applied.

Note: Late charges are applied to the guarantor of an account, not the patient.

B.	 Amount – The amount of the late charge.

C.	 Total Charges – The total late charges within the date range of the report.

D.	Provider Totals – The late charges are shown for the provider with a breakdown of the late 
charges for each clinic the provider works in. Each clinic’s late charges for that provider are 
subtotaled. After the clinic subtotals, the late charge totals for the provider appear.

E.	 Clinic Totals – The late charges are shown for the clinic with a breakdown of the late charges by 
each provider at that clinic. Each provider’s late charges for that clinic are subtotaled. The late 
charge totals for the clinic appear below the provider subtotals.
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Letter Merge Reports
The Dentrix Enterprise Letter Merge feature allows you to create custom reports and letters.

Why:	 To create custom reports

When:	 As needed
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How do I run the Letter Merge Reports?
From the Office Manager, select Letters, and then set up a letter merge. For additional details 
about merging letters, see the “Merging Dentrix Enterprise letters” and “Other create and merge 
options” topics in the Office Manager portion of the Dentrix Enterprise Help (from the Help menu 
of any module, click Contents).

What important information does this report provide?
The information displayed in this reports is customizable and depends on letter setup 
configurations. The following is a comprehensive list of possible data you can display:

Patient

Last Name Status
First Name Birth Date
Middle Initial Family Position
Address Preferred Name
City First Visit Date
State Last Visit Date
Zip Last Referral Date
Home Phone Salutation
Work Phone Title
Work Phone Extension Other ID
Social Security Number Language
Chart Number E-mail Address
Gender

Practice

Name Phone
Address Phone Extension
City, State, and Zip

Billing

Billing Type Balance
Aging 0-30 Last Payment Date
Aging 30-60 Last Payment Amount
Aging 60-90 Guarantor Last Name
Aging >90 Guarantor First Name

Insurance

Primary Insurance Name Secondary Insurance Name
Primary Remaining Benefits Secondary Remaining Benefits
Primary Subscriber ID Secondary Subscriber ID
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Employer

Name City, State, and Zip
Address Phone

Referred By

Referral Source Last Name Salutation
Referral Source First Name Address
Middle Initial City, State, and Zip
Title Phone

Referred To

Referral Last Name Address
Referral First Name City, State, and Zip
Middle Initial Phone
Title Date
Salutation

Payment Plan

Total Payment
Balance Payment Date

Provider

Name
Title

Appointment

Date Provider ID
Time Phone
Reason Address
Name City, State, and Zip
Provider

Continuing Care

Due Date Appointment Date
Type Name Appointment Time
Type Description Appointment Reason
Note Appointment Provider
Prior Work Date

Date of Service

Procedure Date Insurance Payments
Total Charges
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Meaningful Use Measure Calculation 
List
The Meaningful Use Measure Calculation List displays the result of each Meaningful Use measure, 
the denominator and numerator used for calculating the actual percentage for that result, and the 
details of the requirement for that result.

Why:	 To view the calculated results of Meaningful Use measures for eligible providers

When:	 As needed

A

F

B C D E
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How do I run the Meaningful Use Measure Calculation 
List?
In the Office Manager, from the Analysis menu, point to Meaningful Use, and then click 
Meaningful Use Measure Calculation. Select the desired report options, and then click Calculate 
and Print or Calculate Only. For additional details about running this report, see the “Meaningful 
Use Measure Calculation List” topic in the Office Manager portion of the Dentrix Enterprise Help 
(from the Help menu of any module, click Contents).

What important information does this report provide?
You can view the list of calculations for all providers or a specific provider.

A.	Measures – The list of measures.

B.	 Numerator – The numerator used in the calculation. Double-click to view a list of patients.

C.	 Denominator – The denominator used in the calculation. Double-click to view a list of patients.

D.	Required – The percentage required.

E.	 Actual – The calculated actual percentage.

F.	 Details – An explanation of the requirements for a selected measure.

The tables on the pages that follow explain the calculations and requirements for each measure.
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Stage 1

Measure Requirement Denominator Numerator
Computerized 
Provider Order Entry 
(CPOE)

Standard measure 
for CPOE

 
 

More than 30 percent 
of unique patients 
with at least one 
medication in their 
medication list seen 
by the EP during 
the EHR reporting 
period have at least 
one medication order 
entered using CPOE.

 
 

The number of patients 
who have at least one 
medication (active 
or inactive) and who 
have a patient health 
assessment, medical 
encounter, or dental 
procedure with one of 
the selected Providers 
and with a procedure 
date that falls within 
the specified Date 
Range.

 
 

The number of 
patients (from the 
Denominator) who 
have at least one 
medication that was 
ordered using CPOE.

Alternate measure 
for CPOE

More than 30 percent 
of medication orders 
created by the EP 
during the EHR 
reporting period are 
recorded using CPOE 
(Alternative measure - 
effective 2013 onward).

The number of patients 
who have at least one 
medication (active 
or inactive) and who 
have a patient health 
assessment, medical 
encounter, or dental 
procedure with one of 
the selected Providers 
and with a procedure 
date that falls within 
the specified Date 
Range.

The number of 
prescriptions that were 
ordered using CPOE 
by one of the selected 
Providers within the 
specified Date Range.

Problem List More than 80 percent 
of all unique patients 
seen by the EP during 
the EHR reporting 
period have at 
least one entry or 
an indication that 
no problems are 
known for the patient 
recorded as structured 
data.

The number of patients 
who were seen by 
one of the selected 
Providers within the 
specified Date Range.

The number of 
patients (from the 
Denominator) who 
have at least one 
medical alert/problem 
or an indication that 
the patient has no 
known problems.



Dentrix Enterprise 11.0.2 Reports Reference

Meaningful Use Measure Calculation List   165

Measure Requirement Denominator Numerator
Electronic Prescribing 
(eRx)

More than 40 percent 
of all permissible 
prescriptions written 
by the EP during 
the EHR reporting 
period are transmitted 
electronically using 
Certified EHR 
Technology.

The number of 
prescriptions (except 
for OTC drugs and 
controlled substances) 
that were written by 
one of the selected 
Providers within the 
specified Date Range.

The number of 
prescriptions (from 
the Denominator) that 
were written by one of 
the selected Providers 
and transmitted 
electronically within 
the specified Date 
Range.

Medication List More than 80 percent 
of all unique patients 
seen by the EP during 
the EHR reporting 
period have at least 
one medication entry 
(or an indication that 
the patient is not 
currently prescribed 
any medication) 
recorded as structured 
data.

The number of patients 
who have a patient 
health assessment, 
medical encounter, or 
dental procedure with 
one of the selected 
Providers and with 
a procedure date 
that falls within the 
specified Date Range.

The number of 
patients (from the 
Denominator) who 
have at least one 
medication with an 
active status or an 
indication that no 
medications are known 
for the patient.

Medication Allergy List More than 80 percent 
of all unique patients 
seen by the EP during 
the EHR reporting 
period have at least 
one medication allergy 
entry (or an indication 
that the patient has 
no known medication 
allergies) recorded as 
structured data.

The number of patients 
who were seen by 
one of the selected 
Providers within the 
specified Date Range.

The number of 
patients (from the 
Denominator) who 
have at least one 
medical alert/problem 
or an indication that 
the patient has no 
known medication 
allergies.

Demographics More than 50 percent 
of all unique patients 
seen by the EP 
have demographics 
recorded as structured 
data.

The number of patients 
who were seen by 
one of the selected 
Providers within the 
specified Date Range.

The number of 
patients (from 
the Denominator) 
who have data in 
their records for 
all the required 
demographics 
(including any specific 
exclusions if the 
patient declined 
to provide that 
information or if 
recording that element 
is contrary to state 
law).
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Measure Requirement Denominator Numerator
Vital Signs

Standard measure 
for vital signs

More than 50 percent 
of all unique patients 
age 2 and over seen 
by the EP have height, 
weight and blood 
pressure recorded as 
structured data.

The number of patients 
who are at least two 
years old and who 
have a patient health 
assessment, medical 
encounter, or dental 
procedure with one of 
the selected Providers 
and with a procedure 
date within the 
specified Date Range.

The number of 
patients (from the 
Denominator) for 
whom height/length, 
weight, and blood 
pressure have been 
recorded in a patient 
health assessment 
within the specified 
Date Range.

Alternate measure 
for vital signs 
with no vital sign 
exclusions

More than 50 percent 
of all unique patients 
seen by the EP during 
the EHR reporting 
period have blood 
pressure (for patients 
age 3 and over only) 
and height/length and 
weight (for all ages) 
recorded as structured 
data (Optional 
effective 2013/
Required 2014).

The number of patients 
who have a patient 
health assessment, 
medical encounter, or 
dental procedure with 
one of the selected 
Providers and with a 
procedure date within 
the specified Date 
Range.

The number of 
patients (from the 
Denominator) who 
are at least 3 years 
old and for whom 
height/length, weight, 
and blood pressure 
have been recorded 
in a patient health 
assessment within the 
specified Date Range; 
and the number of 
patients younger than 
3 years of age for 
whom height/length 
and weight have been 
recorded in a patient 
health assessment 
within the specified 
Date Range.

Alternate measure 
for vital signs with 
blood pressure 
exclusion

More than 50 percent 
of all unique patients 
seen by the EP during 
the EHR reporting 
period have height/
length and weight 
(for all ages) recorded 
as structured data 
(Optional effective 
2013/Required 2014).

The number of patients 
who have a patient 
health assessment, 
medical encounter, or 
dental procedure with 
one of the selected 
Providers and with a 
procedure date within 
the specified Date 
Range.

The number of 
patients (from the 
Denominator) for 
whom height/length 
and weight have been 
recorded in a patient 
health assessment 
within the specified 
Date Range.
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Measure Requirement Denominator Numerator
Vital Signs (cont’d)

Alternate measure 
for vital signs with 
height/length and 
weight exclusion

More than 50 percent 
of all unique patients 
seen by the EP during 
the EHR reporting 
period have blood 
pressure (for patients 
age 3 and over only) 
recorded as structured 
data (Optional 
effective 2013/
Required 2014).

The number of patients 
who are at least 3 
years old and who 
have a patient health 
assessment, medical 
encounter, or dental 
procedure with one of 
the selected Providers 
and with a procedure 
date within the 
specified Date Range.

The number of 
patients (from the 
Denominator) who are 
at least 3 years old 
and for whom blood 
pressure has been 
recorded in a patient 
health assessment 
within the specified 
Date Range.

Smoking Status More than 50 percent 
of all unique patients 
13 years old or older 
seen by the EP have 
smoking status 
recorded as structured 
data.

The number of patients 
who are at least 13 
years old and who 
have a patient health 
assessment, medical 
encounter, or dental 
procedure with one of 
the selected Providers 
and with a procedure 
date within the 
specified Date Range.

The number of 
patients (from the 
Denominator) who 
have a smoking status 
set.

VDT - View, Download, 
or Transmit Health 
Information

Measure A

 
 

More than 50 percent 
of all unique patients 
seen by the EP during 
the EHR reporting 
period are provided 
timely (available to 
the patient within 4 
business days after the 
information is available 
to the EP) online 
access to their health 
information subject 
to the EP’s discretion 
to withhold certain 
information.

 
 

The number of unique 
patients who were 
seen by n EP within the 
specified Date Range.

 
 

The number of 
patients (from the 
Denominator) who 
have timely (within 4 
business days after the 
information is available 
to the EP) online 
access to their health 
information.
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Measure Requirement Denominator Numerator
VDT - View, Download, 
or Transmit Health 
Information (cont’d)

Measure B

 
 

More than 5 percent 
of all unique patients 
seen by the EP 
during the EHR 
reporting period 
(or their authorized 
representatives) view, 
download, or transmit 
to a third party their 
health information.

 
 

The number of unique 
patients who were 
seen by n EP within the 
specified Date Range.

 
 

The number of 
unique patients, 
or their authorized 
representatives, (from 
the Denominator) 
who have viewed 
online, downloaded, 
or transmitted the 
patient’s health 
information to a third 
party.

Clinical Summary Clinical summaries 
provided to patients 
for more than 50 
percent of all office 
visits within 3 business 
days.

The number of 
office visits that were 
performed by the EP 
within the specified 
Date Range.

The number of 
office visits (from 
the Denominator) 
for which the 
corresponding patient 
was provided a clinical 
summary within three 
business days.

Summary Of Care

Measure A The EP that transitions 
or refers their patient 
to another setting 
of care or provider 
of care provides a 
summary of care 
record for more 
than 50 percent of 
transitions of care and 
referrals during the 
EHR reporting period.

 
Number of transitions 
of care and referrals for 
which the EP was the 
transferring or referring 
provider within the 
specified Date Range.

 
The number of 
transitions of care and 
referrals (from the 
Denominator) where 
a summary of care 
record was provided 
electronically.

Patient Reminders More than 20 percent 
of all unique patients 
65 years or older 
or 5 years old or 
younger were sent an 
appropriate reminder 
during the EHR 
reporting period.

The number of patients 
who are 5 years old or 
younger or who are 65 
years old or older. If 
the EP does not have 
any patients that meet 
the age criteria, that 
EP is excluded from 
the requirement (the 
EP must select No next 
to the appropriate 
exclusion and then 
click Apply to attest to 
the exclusion).

The number of 
patients (from 
the Denominator) 
that were sent the 
appropriate reminder.
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Measure Requirement Denominator Numerator
Patient Education More than 10 percent 

of all unique patients 
seen by the EP during 
the EHR reporting 
period are provided 
patient-specific 
education resources.

The number of patients 
who were seen by the 
EP within the specified 
Date Range.

The number of 
patients (from the 
Denominator) who 
were provided patient-
specific education 
resources.

Medication 
Reconciliation

The EP performs 
medication 
reconciliation for more 
than 50 percent of 
transitions of care in 
which the patient is 
transitioned into the 
care of the EP.

The number of 
transitions of care 
within the specified 
Date Range for 
which the EP was the 
receiving party of the 
transition. If an EP was 
not on the receiving 
end of any transition 
of care within the 
specified Date Range, 
that EP is excluded 
from the requirement 
(the EP must select No 
next to the appropriate 
exclusion and then 
click Apply to attest to 
the exclusion).

The number of 
transitions of 
care (from the 
Denominator) 
where medication 
reconciliation was 
performed.

Stage 2

Measure Requirement Denominator Numerator
Demographics More than 80 percent 

of all unique patients 
seen by the EP 
have demographics 
recorded as structured 
data.

The number of 
patients who were 
seen by one of the 
selected Providers 
within the specified 
Date Range.

The number of 
patients (from 
the Denominator) 
who have data in 
their records for 
all the required 
demographics 
(including any specific 
exclusions if the 
patient declined 
to provide that 
information or if 
recording that element 
is contrary to state 
law).
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Measure Requirement Denominator Numerator
Computerized 
Provider Order Entry 
(CPOE) - Medications

More than 60 percent 
of medication orders 
created by the EP 
during the EHR 
reporting period 
are recorded using 
computerized provider 
order entry.

The number of 
prescriptions that were 
ordered by one of the 
selected Providers 
within the specified 
Date Range.

The number of 
prescriptions (from 
the Denominator) that 
were ordered using 
CPOE by one of the 
selected Providers 
within the specified 
Date Range.

Computerized 
Provider Order Entry 
(CPOE) - Laboratory

More than 30 percent 
of laboratory orders 
created by the EP 
during the EHR 
reporting period 
are recorded using 
computerized provider 
order entry.

The number of 
laboratory orders that 
were created by an EP 
and that have an order 
date that is within the 
specified Date Range.

The number of 
laboratory orders (from 
the Denominator) that 
were recorded using 
CPOE and that have 
an order date that is 
within the specified 
Date Range.

Computerized 
Provider Order Entry 
(CPOE) - Radiology

More than 30 percent 
of radiology orders 
created by the EP 
during the EHR 
reporting period 
are recorded using 
computerized provider 
order entry.

The number of 
radiology orders that 
were created by an 
EP and that have a 
creation date that is 
within the specified 
Date Range.

The number of 
radiology orders (from 
the Denominator) that 
were recorded using 
CPOE and that have 
a creation date that 
is within the specified 
Date Range.

Electronic Prescribing 
(eRx)

More than 50 percent 
of all permissible 
prescriptions, or all 
prescriptions written 
by the EP are queried 
for a drug formulary 
and transmitted 
electronically using 
Certified EHR 
Technology.

The number of 
prescriptions written 
by one of the selected 
Providers (except 
for OTC drugs and 
controlled substances) 
within the specified 
Date Range.

The number of 
prescriptions (from 
the Denominator) 
that were queried 
for a drug formulary 
and transmitted 
electronically.
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Measure Requirement Denominator Numerator
Vital Signs

No vital sign 
exclusions

More than 80 percent 
of all unique patients 
seen by the EP during 
the EHR reporting 
period have blood 
pressure (for patients 
age 3 and over only) 
and height/length and 
weight (for all ages) 
recorded as structured 
data.

The number of 
patients who have 
a patient health 
assessment, medical 
encounter, or dental 
procedure with one of 
the selected Providers 
and with a procedure 
date within the 
specified Date Range.

The number of 
patients (from the 
Denominator) who 
are at least 3 years 
old and for whom 
height/length, weight, 
and blood pressure 
have been recorded 
in a patient health 
assessment within the 
specified Date Range; 
and the number of 
patients younger than 
3 years of age for 
whom height/length 
and weight have been 
recorded in a patient 
health assessment 
within the specified 
Date Range.

Blood pressure 
exclusion

More than 80 percent 
of all unique patients 
seen by the EP during 
the EHR reporting 
period have height/
length and weight (for 
all ages) recorded as 
structured data.

The number of 
patients who have 
a patient health 
assessment, medical 
encounter, or dental 
procedure with one of 
the selected Providers 
and with a procedure 
date within the 
specified Date Range.

The number of 
patients (from the 
Denominator) for 
whom height/length 
and weight have been 
recorded in a patient 
health assessment 
within the specified 
Date Range.

Height/length and 
weight exclusion

More than 80 percent 
of all unique patients 
seen by the EP during 
the EHR reporting 
period have blood 
pressure (for patients 
age 3 and over only) 
recorded as structured 
data.

The number of 
patients who are at 
least 3 years old and 
who have a patient 
health assessment, 
medical encounter, or 
dental procedure with 
one of the selected 
Providers and with a 
procedure date within 
the specified Date 
Range.

The number of 
patients (from the 
Denominator) who are 
at least 3 years old 
and for whom blood 
pressure has been 
recorded in a patient 
health assessment 
within the specified 
Date Range.
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Measure Requirement Denominator Numerator
Smoking Status More than 80 percent 

of all unique patients 
13 years old or older 
seen by the EP have 
smoking status 
recorded as structured 
data.

The number of 
patients who are at 
least 13 years old and 
who have a patient 
health assessment, 
medical encounter, or 
dental procedure with 
one of the selected 
Providers and with a 
procedure date within 
the specified Date 
Range.

The number of 
patients (from the 
Denominator) who 
have a smoking status 
set.

VDT - View, Download, 
or Transmit Health 
Information

Measure A

 
 

More than 50 percent 
of all unique patients 
seen by the EP during 
the EHR reporting 
period are provided 
timely (available to 
the patient within 4 
business days after the 
information is available 
to the EP) online 
access to their health 
information subject 
to the EP’s discretion 
to withhold certain 
information.

 
 

The number of unique 
patients who were 
seen by n EP within the 
specified Date Range.

 
 

The number of 
patients (from the 
Denominator) who 
have timely (within 4 
business days after the 
information is available 
to the EP) online 
access to their health 
information.

Measure B More than 5 percent 
of all unique patients 
seen by the EP 
during the EHR 
reporting period 
(or their authorized 
representatives) 
view, download, or 
transmit their health 
information to a third 
party.

The number of unique 
patients who were 
seen by n EP within the 
specified Date Range.

The number of 
unique patients, 
or their authorized 
representatives, (from 
the Denominator) 
who have viewed 
online, downloaded, 
or transmitted the 
patient’s health 
information to a third 
party.
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Measure Requirement Denominator Numerator
Clinical Summary Clinical summaries 

provided to patients 
or patient-authorized 
representatives within 
1 business day for 
more than 50 percent 
of office visits during 
the EHR reporting 
period.

The number of office 
visits conducted by the 
EP within the specified 
Date Range.

The number of 
office visits (from 
the Denominator) 
where the patient or 
a patient-authorized 
representative is 
provided a clinical 
summary of the 
patient’s visit within 
1 business day (or 
patient declined 
clinical summary).

Patient Reminders More than 10 percent 
of all unique patients 
who have had two or 
more office visits for 
preventive or follow-up 
care with the EP within 
the 24 months before 
the beginning of the 
EHR reporting period 
were sent a reminder 
per patient preference 
(if available).

The number of unique 
patients who have had 
two or more office 
visits with an EP in the 
24 months prior to 
the beginning of the 
specified Date Range.

Exclusion: A unique 
patient with less 
than two office visits 
with the EP in the 
24 months prior to 
the beginning of the 
specified Date Range.

The number of 
patients (from the 
Denominator) who 
were sent a reminder 
per patient preference 
(if available) within the 
specified Date Range.

Patient Education Patient-specific 
education resources 
identified by Certified 
EHR Technology are 
provided to patients 
for more than 10 
percent of all unique 
patients with office 
visits seen by the 
EP during the EHR 
reporting period.

The number of unique 
patients with office 
visits who were seen 
by the EP within the 
specified Date Range.

The number of 
patients (from the 
Denominator) who 
were provided patient-
specific education 
resources identified by 
the EHR technology.
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Measure Requirement Denominator Numerator
Medication 
Reconciliation

The EP performs 
medication 
reconciliation for more 
than 50 percent of 
transitions of care in 
which the patient is 
transitioned into the 
care of the EP during 
the EHR reporting 
period.

The number of 
transitions of care 
(defined as first 
encounters with a new 
patient and encounters 
with existing patients 
where a summary of 
care record of any 
type is provided to the 
receiving provider as 
a hard copy, scanned 
copy, or electronic 
C-CDA) for which the 
EP was the receiving 
party of the transition 
within the specified 
Date Range.

The number of 
transitions of 
care (from the 
Denominator) 
where medication 
reconciliation was 
performed.

Summary Of Care

Measure A

 

The EP that transitions 
or refers their patient 
to another setting 
of care or provider 
of care provides a 
summary of care 
record for more 
than 50 percent of 
transitions of care and 
referrals during the 
EHR reporting period.

 

Number of transitions 
of care and referrals 
for which the EP was 
the transferring or 
referring provider 
within the specified 
Date Range.

 

The number of 
transitions of care and 
referrals (from the 
Denominator) where 
a summary of care 
record was provided 
electronically.
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Measure Requirement Denominator Numerator
Summary Of Care 
(cont’d)

Measure B

 

The EP that transitions 
or refers their patient 
to another setting 
of care or provider 
of care provides a 
summary of care 
record for more 
than 10 percent of 
such transitions and 
referrals during the 
EHR reporting period 
either: (a) electronically 
transmitted using 
Certified EHR 
Technology to a 
recipient; or (b) 
where the recipient 
receives the summary 
of care record via an 
exchange facilitated 
by an organization 
that is a Nationwide 
Health Information 
Network (NwHIN) 
Exchange participant 
or in a manner that 
is consistent with 
the governance 
mechanism ONC 
establishes for the 
NwHIN.

 

The number of 
transitions of care and 
referrals for which the 
EP was the transferring 
or referring provider 
within the specified 
Date Range.

 

The number of 
transitions of care 
and referrals (from 
the Denominator) 
where the recipient 
receives the summary 
of care record 
electronically—via an 
exchange facilitated 
by an organization 
that is a NwHIN 
Exchange participant, 
or in a manner that 
is consistent with 
the governance 
mechanism ONC 
establishes for the 
nationwide health 
information network.

Secure Electronic 
Messaging

A secure message 
was sent using the 
electronic messaging 
function of Certified 
EHR Technology by 
more than 5 percent 
of unique patients 
(or their authorized 
representatives) seen 
by the EP during the 
EHR reporting period.

The number of unique 
patients who were 
seen by an EP within 
the specified Date 
Range.

The number 
of patients or 
patient-authorized 
representatives (from 
the Denominator) 
who send a secure 
electronic message to 
the EP.
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Measure Requirement Denominator Numerator
Electronic Notes Enter at least one 

electronic progress 
note created, edited, 
and signed by an 
EP for more than 30 
percent of unique 
patients with at least 
one office visit during 
the EHR reporting 
period. The text of the 
electronic note must 
be text-searchable and 
may contain drawings 
and other content.

Number of unique 
patients with at least 
one office visit with 
EPs with the specified 
Date Range.

The number of unique 
patients (from the 
Denominator) who 
have at least one 
electronic progress 
note from an eligible 
professional recorded 
as text-searchable 
data.

Family Health History More than 20 
percent of all unique 
patients seen by the 
EP during the EHR 
reporting period have 
a structured data 
entry (health history 
or unknown) for one 
or more first-degree 
relatives (parents, 
siblings, and children).

Number of unique 
patients seen by the 
EP within the specified 
Date Range.

The number of 
patients (from the 
Denominator) with 
a structured data 
entry (health history 
or unknown) for one 
or more first-degree 
relatives.

Modified Stage 2

Measure Requirement Denominator Numerator
Computerized 
Provider Order Entry 
(CPOE) - Medications

More than 60 percent 
of medication orders 
created by the EP 
during the EHR 
reporting period 
are recorded using 
computerized provider 
order entry.

The number of 
prescriptions that were 
ordered by one of the 
selected Providers 
within the specified 
Date Range.

The number of 
prescriptions (from 
the Denominator) that 
were ordered using 
CPOE by one of the 
selected Providers 
within the specified 
Date Range.

Computerized 
Provider Order Entry 
(CPOE) - Laboratory

More than 30 percent 
of laboratory orders 
created by the EP 
during the EHR 
reporting period 
are recorded using 
computerized provider 
order entry.

The number of 
laboratory orders that 
were created by an EP 
and that have an order 
date that is within the 
specified Date Range.

The number of 
laboratory orders (from 
the Denominator) that 
were recorded using 
CPOE and that have 
an order date that is 
within the specified 
Date Range.
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Measure Requirement Denominator Numerator
Computerized 
Provider Order Entry 
(CPOE) - Radiology

More than 30 percent 
of radiology orders 
created by the EP 
during the EHR 
reporting period 
are recorded using 
computerized provider 
order entry.

The number of 
radiology orders that 
were created by an 
EP and that have a 
creation date that is 
within the specified 
Date Range.

The number of 
radiology orders (from 
the Denominator) that 
were recorded using 
CPOE and that have 
a creation date that 
is within the specified 
Date Range.

Electronic Prescribing 
(eRx)

More than 50 percent 
of all permissible 
prescriptions, or all 
prescriptions written 
by the EP are queried 
for a drug formulary 
and transmitted 
electronically using 
Certified EHR 
Technology.

The number of 
prescriptions written 
by one of the selected 
Providers (except 
for OTC drugs and 
controlled substances) 
within the specified 
Date Range.

The number of 
prescriptions (from 
the Denominator) 
that were queried 
for a drug formulary 
and transmitted 
electronically.

VDT

Measure A - 

Timely Online 
Access

More than 50 percent 
of all unique patients 
seen by the EP during 
the EHR reporting 
period are provided 
timely (available to 
the patient within 4 
business days after the 
information is available 
to the EP) online 
access to their health 
information subject 
to the EP’s discretion 
to withhold certain 
information.

The number of unique 
patients who were 
seen by n EP within the 
specified Date Range.

The number of 
patients (from the 
Denominator) who 
have timely (within 4 
business days after the 
information is available 
to the EP) online 
access to their health 
information.

Measure B - 

View, Download, 
or Transmit Health 
Information

At least one patient 
seen by the EP 
during the EHR 
reporting period 
(or their authorized 
representative) 
views, downloads, or 
transmits their health 
information to a third 
party.

Yes or No answer.

The number of unique 
patients who were 
seen by n EP within the 
specified Date Range.

The number of 
unique patients, 
or their authorized 
representatives, (from 
the Denominator) 
who have viewed 
online, downloaded, 
or transmitted the 
patient’s health 
information to a third 
party.
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Measure Requirement Denominator Numerator
Patient Education Patient-specific 

education resources 
identified by Certified 
EHR Technology are 
provided to patients 
for more than 10 
percent of all unique 
patients with office 
visits seen by the 
EP during the EHR 
reporting period.

The number of unique 
patients with office 
visits who were seen 
by the EP within the 
specified Date Range.

The number of 
patients (from the 
Denominator) who 
were provided patient-
specific education 
resources identified by 
the EHR technology.

Medication 
Reconciliation

The EP performs 
medication 
reconciliation for more 
than 50 percent of 
transitions of care in 
which the patient is 
transitioned into the 
care of the EP during 
the EHR reporting 
period.

The number of 
transitions of care 
(defined as first 
encounters with a new 
patient and encounters 
with existing patients 
where a summary of 
care record of any 
type is provided to the 
receiving provider as 
a hard copy, scanned 
copy, or electronic 
C-CDA) for which the 
EP was the receiving 
party of the transition 
within the specified 
Date Range.

The number of 
transitions of 
care (from the 
Denominator) 
where medication 
reconciliation was 
performed.
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Measure Requirement Denominator Numerator
Summary Of Care The EP that transitions 

or refers their patient 
to another setting 
of care or provider 
of care provides a 
summary of care 
record for more 
than 10 percent of 
such transitions and 
referrals during the 
EHR reporting period 
(or 5 percent if the 
reporting period 
is in 2017). The 
provider of care must 
(1) use a Certified 
EHR Technology to 
create a summary of 
care record; and (2) 
electronically transmit 
such summary of care 
record to a receiving 
provider.

The number of 
transitions of care and 
referrals for which the 
EP was the transferring 
or referring provider 
within the specified 
Date Range.

The number of 
transitions of care and 
referrals (from the 
Denominator) where 
the summary of care 
record is created 
using a Certified 
EHR Technology 
and electronically 
transmitted.

Secure Electronic 
Messaging

For at least one patient 
seen by the EP during 
an EHR reporting 
period in 2016 (or 5 
percent if the report 
period is in 2017), a 
secure message was 
sent to the patient 
either: (a) using the 
electronic messaging 
function of a Certified 
EHR Technology; or (b) 
in response to a secure 
message sent by the 
patient.

Yes or No answer.

The number of unique 
patients who were 
seen by an EP within 
the specified Date 
Range.

The number of 
patients (from the 
Denominator) who 
were sent a secure 
electronic message.
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Modified Stage 3

Measure Requirement Denominator Numerator
Computerized 
Provider Order Entry 
(CPOE) - Medications

More than 60 percent 
of medication orders 
created by the EP 
during the EHR 
reporting period 
are recorded using 
computerized provider 
order entry.

The number of 
prescriptions that were 
ordered by one of the 
selected Providers 
within the specified 
Date Range.

The number of 
prescriptions (from 
the Denominator) that 
were ordered using 
CPOE by one of the 
selected Providers 
within the specified 
Date Range.

Computerized 
Provider Order Entry 
(CPOE) - Laboratory

More than 60 percent 
of laboratory orders 
created by the EP 
during the EHR 
reporting period 
are recorded using 
computerized provider 
order entry.

The number of 
laboratory orders that 
were created by an EP 
and that have an order 
date that is within the 
specified Date Range.

The number of 
laboratory orders (from 
the Denominator) that 
were recorded using 
CPOE and that have 
an order date that is 
within the specified 
Date Range.

Computerized 
Provider Order Entry 
(CPOE) - Radiology/
Diagnostic Imaging

More than 60 percent 
of diagnostic imaging 
orders created by 
the EP during the 
EHR reporting period 
are recorded using 
computerized provider 
order entry.

The number of 
diagnostic imaging 
orders that were 
created by an EP and 
that have a creation 
date that is within the 
specified Date Range.

The number of 
diagnostic imaging 
orders (from the 
Denominator) that 
were recorded using 
CPOE and that have 
a creation date that 
is within the specified 
Date Range.

Electronic Prescribing 
(ePrescribing)

More than 60 percent 
of all permissible 
prescriptions written 
by the EP are queried 
for a drug formulary 
and transmitted 
electronically using 
Certified EHR 
Technology.

The number of 
prescriptions written 
by one of the selected 
Providers (except 
for OTC drugs and 
controlled substances) 
within the specified 
Date Range.

The number of 
prescriptions (from 
the Denominator) 
that were queried 
for a drug formulary 
and transmitted 
electronically.
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Measure Requirement Denominator Numerator
Patient Electronic 
Access

For more than 80 
percent of all unique 
patients seen by the 
EP during the EHR 
reporting,  
(1) the patient (or the 
patient-authorized 
representative) is 
provided timely 
(available to the 
patient within 48 hours 
after the information 
is available to the 
EP) access to view 
online, download, and 
transmit their health 
information;  
and (2) the provider 
ensures the patient’s 
health information 
is available for 
the patient (or 
patient-authorized 
representative) 
to access using 
any application of 
their choice that 
is configured to 
meet the technical 
specifications of the 
API in a Certified EHR 
Technology.

The number of unique 
patients who were 
seen by n EP within the 
specified Date Range.

The number 
of patients, or 
their authorized 
representatives, (from 
the Denominator) who 
have timely (within 
48 hours after the 
information is available 
to the EP) online 
access to their health 
information, or who 
have access to their 
health information 
through an application 
that uses the API 
for a Certified EHR 
Technology.
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Measure Requirement Denominator Numerator

View, Download, or 
Transmit

More than 10 percent 
of all unique patients 
(or their authorized 
representatives) seen 
by the EP during the 
EHR reporting period 
actively engage 
with the electronic 
health record made 
accessible by the 
provider and either: 
(1) views, downloads, 
or transmits to a 
third- party their 
health information; 
or (2) accesses their 
health information 
through the use of 
an API that can be 
used by applications 
chosen by the patient 
and configured to the 
API in a Certified EHR 
Technology; or (3) 
does a combination of 
(1) and (2).

The number of unique 
patients who were 
seen by n EP within the 
specified Date Range.

The number of 
unique patients, 
or their authorized 
representatives, (from 
the Denominator) 
who have viewed 
online, downloaded, 
or transmitted to 
a third party the 
patient’s health 
information; who have 
accessed their health 
information through an 
API; or both.

Patient Education For more than 
35 percent of all 
unique patients with 
office visits seen 
by the EP during 
the EHR reporting 
period, patient-
specific education 
resources identified 
by a Certified EHR 
Technology are 
provided to patients.

The number of unique 
patients with office 
visits who were seen 
by the EP within the 
specified Date Range.

The number of 
patients (from the 
Denominator) who 
were provided patient-
specific education 
resources identified 
by a Certified EHR 
Technology.
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Measure Requirement Denominator Numerator
Medication/
Clinical Information 
Reconciliation

For more than 80 
percent of transitions 
or referrals received 
and patient 
encounters in which 
the provider has never 
before encountered 
the patient, the 
EP performs a 
clinical information 
reconciliation for the 
following three clinical 
information sets:  
(a) a review of the 
patient’s medications, 
including the name, 
dosage, frequency, 
and route of each 
medication;  
(b) a review of the 
patient’s known 
medication allergies; 
and  
(c) a review of the 
patient’s current and 
active diagnoses.

Within the specified 
Date Range, the 
number of transitions 
of care or referrals 
received for which 
the EP was the 
receiving party, and 
the number of the 
EP’s first encounters 
(encounters with a new 
patient).

The number of 
transitions of 
care (from the 
Denominator) where 
medication and 
clinical information 
reconciliation was 
performed.

Transitions of Care For more than 
50 percent of the 
transitions to another 
setting of care or 
referrals to another 
provider of care 
during the EHR 
reporting period, the 
EP transitioning or 
referring their patients 
(1) creates a summary 
of care record using 
a Certified EHR 
Technology; and 
(2) electronically 
exchanges such 
summary of care 
record.

The number of 
transitions of care and 
referrals for which the 
EP was the transferring 
or referring provider 
within the specified 
Date Range.

The number of 
transitions of care and 
referrals (from the 
Denominator) where 
the summary of care 
record is created 
using a Certified 
EHR Technology 
and electronically 
exchanged.
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Measure Requirement Denominator Numerator
Secure Messaging For more than 25 

percent of all unique 
patients seen by the 
EP during the EHR 
reporting period, a 
secure message was 
sent to the patient 
(or their authorized 
representative) 
either: (a) using the 
electronic messaging 
function of a Certified 
EHR Technology; or 
(b) in response to 
a secure message 
sent by the patient 
(or their authorized 
representative).

The number of unique 
patients who were 
seen by an EP within 
the specified Date 
Range.

The number of 
patients (from the 
Denominator) who 
were sent a secure 
electronic message.

Patient Generated 
Health Data

For more than 5 
percent of all unique 
patients seen by the 
EP during the EHR 
reporting period, 
patient-generated 
health data or data 
from a non-clinical 
setting is incorporated 
into a Certified EHR 
Technology.

The number of unique 
patients who were 
seen by an EP within 
the specified Date 
Range.

The number of 
patients (from the 
Denominator) who 
had health data from 
patient-generated or 
non-clinical sources 
incorporated into 
a Certified EHR 
Technology.

Receive and 
Incorporate

For more than 40 
percent of transitions 
or referrals received 
and patient encounters 
in which the provider 
has never before 
encountered the 
patient, the EP 
incorporates into 
the patient’s EHR an 
electronic summary of 
care document.

The number of 
transitions of care 
or referrals received 
by the EP, and the 
number of patient 
encounters in which 
the provider has never 
before encountered 
the patient, within the 
specified Date Range.

The number of 
electronic summary 
of care documents 
incorporated into 
patient records.
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Medical Code List
The Medical Code List allows you to view and print the medical codes entered in Dentrix 
Enterprise. Codes are grouped by code type (AMA, ICD, Modifier, Place of Service, and Type of 
Service).

Why:	 To ensure medical codes are up to date, and to view the ICD-9-CM codes 
associated with each AMA CPT code

When:	 After Dentrix Enterprise setup, and as needed

MEDICAL CODE LIST - AMA CPT CODES
The Dentist Group

Date: Page:04/23/2018 1

CODE DESCRIPTION

INCLUDED ICD-9-CM CODES

473.0 Chr Maxillary Sinusitis
053.12 Postherpes Trigem Neural
053.13 Postherpes Polyneuropath
053.19 H ZosterNerv Syst NEC

478.22 Parapharyngeal Abscess
478.24 Retropharyngeal Abscess

A

B

MEDICAL CODE LIST - ICD-9-CM DIAGNOSTIC CODES
The Dentist Group

Date: Page:04/23/2018 2

CODE DESCRIPTION

053.12 Postherpes Trigem Neural
053.13 Postherpes Polyneuropath
053.19 H ZosterNerv Syst NEC

C

MEDICAL CODE LIST - MODIFIER CODES
The Dentist Group

Date: Page:04/23/2018 3

CODE DESCRIPTION

21 Prolonged Evaluation and Management Service
22 Unusual Procedural Services
23 Unusual Anesthesia

D

MEDICAL CODE LIST - PLACE OF SERVICE
The Dentist Group

Date: Page:04/23/2018 4

CODE DESCRIPTION

11 Office
12 Home
13 Mobile Unit

E
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MEDICAL CODE LIST - TYPE OF SERVICE
The Dentist Group

Date: Page:04/23/2018 5

CODE DESCRIPTION

0 Whole blood or packed red cells
1 Medical Care
2 Surgery

F

How do I run the Medical Code List?
From the DXOne Reporting module, select Reference, and then double-click Medical Code 
List. For additional details about running this report, see the “Medical Code List” topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
The following report information is found in the Medical/Cross Code Setup dialog box, which can 
be accessed in the Office Manager. See the “Adding, editing, and deleting medical codes” topic 
in the Office Manager portion of the Dentrix Enterprise Help for details on how to edit codes listed 
on this report.

A.	AMA CPT Codes – If you select AMA CPT when 
setting options for this report, AMA CPT codes 
appear on the report.

B.	 Included ICD-9-CM Codes – If you select List 
Included ICD-9-CM when setting options for 
this report, the ICD-9 codes associated with each 
AMA CPT code appear on the report.

C.	 ICD-9 Codes – If you select ICD-9-CM when 
setting options for this report, ICD-9 codes 
appear on the report.

D.	Modifier Codes – If you select Modifier when 
setting options for this report, Modifier codes 
appear on the report.

E.	 Place of Service – If you select Place of Service 
when setting options for this report, Place of 
Service codes appear on the report.

F.	 Type of Service – If you select Type of Service 
when setting options for this report, Type of 
Service codes appear on the report.

A

C

D
E

F
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Multi-Code List
The Multi-Code List allows you to view and print the multi-codes entered in Dentrix Enterprise.

Why:	 To ensure treatment planning services that require multiple steps/appointments 
(for example, dentures) have multi-codes that have been setup properly, to 
ensure each multi-code contains the proper procedure codes, and to ensure 
each multi-code reserves a proper length of time in the Appointment Book

When:	 After Dentrix Enterprise setup, and as needed

MULTI-CODE LIST
The Dentist Group

Date: Page:04/22/2018 1

CODE DESCRIPTION ABBREV DESC UNITS CODE TYPE APPT TYPE ENABLED PERMANENT
PROC/DIAG DESCRIPTION

xx111 Crn, Pst & Core, Insert CrnPCIns 31 Standard High Production YES NO
D2752 Crown-porc fused noble metal
D2954 Prefab post&core in add to crn
D2761 Crown Insert
D5-10578 Tooth Sensitivity
D5-10002 Tooth Disorder NOS
F-A3610 Facial Nerve Function NOS

xx2sA DO Amalgam, permanent DO Amalg. 3 Standard High Production YES NO
D2150 OD Amalgam-2 surf. prim/perm

xx2sC DO Composite, post-permanent DO Comp. 3 Standard High Production YES NO
D2386 OD Resin-2 surface, post-permanent

xx3sA MOD Amalgam MOD Amal 4 Standard High Production YES NO
D2160 MOD Amalgam-3 surf. prim/perm

xx3sC MOD Composite, post-permanent MOD Comp 4 Standard High Production YES NO
D2387 MOD Resin-3 surface +, post-perm

xxBRG Bridge Bridge 4 Bridge High Production YES NO
D6240 MOD Pontic - Pontic-porcelain fused to hnob
D6750 MOD Retainer-Crown - Retainer crn-porc fused-hi nob

xxCCA Cont. Care - Prophy, Adult CCAdult 6 Standard Low Production YES NO
D1110 Prophylaxis-adult
D0120 Periodic oral evaluation
D0274 Bitewings-four films

xxCCP Cont. Care - Prophy, Child CCChild 3 Standard High Production YES NO
D0120 Periodic oral evaluation
D1120 Prophylaxis-child
D0272 Bitewings-two films

xxCIm Crown/Implant CrnImp 28 Standard High Production YES NO
D6010 Surg place implant: endosteal
D2750 Crown-porc fuse high noble mtl

xxNPX New Patient Exam NP Ex 9 Standard Low Production YES NO
D0150 Comp oral eval-new/estab pat
D1110 Prophylaxis-adult
D0274 Bitewings-four films
D0210 Intraoral-complete series (bw)

xxOAM O Amalgam, permanent Oamalg 5 Standard High Production YES NO
D2140 O Amalgam-1 surf. prim/perm

xxORS O Resin, post-perm Oresin 6 Standard High Production YES NO
D2385 O Resin-1 surface, post-permanent

xxPDX Partial Mand PartMand 10 Standard High Production YES NO
D5214 Mand partial-metal base w/sdls
15101 Missing tooth

xxPex Initial Perio Exam PerioExam 5 Standard High Production YES NO
D0150 Comp oral eval-new/estab pat
D0210 Intraoral-complete series (bw)
D4341 Perio scale&root pln-4+per quad
D4341 Perio scale&root pln-4+per quad
D4341 Perio scale&root pln-4+per quad
D4341 Perio scale&root pln-4+per quad

xxPMx Partial Max PartMax 10 Standard High Production YES NO
15101 Missing tooth
D5213 Maxil partial-metal Base W/sdls

xxRCC Root Canal and Crown RC/Crwn 4 Standard High Production YES NO
D3310 Root canal therapy - anterior
D2792 Crown-full cast noble metal

A B C D E F
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How do I run the Multi-Code List?
In the Office Manager, from the Reports menu, point to Reference, and then click Multi-Code 
List. For step-by-step instructions on how to run this report, see the “Multi-Code List” topic in the 
Office Manager portion of the Dentrix Enterprise Help.

What important information does this report provide?
The following report information (with the exception of letter F) is found in the Multi-Code Editor 
dialog box, which can be accessed in the Office Manager. See the “Multi-Code Setup” topic in the 
Office Manager portion of the Dentrix Enterprise Help for information about how to edit multi-
codes.

A.	Codes – The multi-code’s code.

B.	 Description – The multi-code description.

C.	 Units – The units of time reserved for the 
multi-code when the code is scheduled in the 
Appointment Book.

D.	Code Type – The multi-code type (i.e. 
Standard or Bridge).

E.	 Enabled – Indicates whether or not the multi-
code is enabled for selection when posting a 
procedure.

F.	 Permanent – Due to the 2004 ADA code 
update, the data in this column is no longer 
relevant. All codes should have a “No.”

A
B

C D

E
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New Patient List
The New Patient List displays patients whose first visit date falls within a selected date range.

Why:	 To view how many new patients the practice has acquired, to keep track of how 
many new patients went inactive, to keep track of how many new patients were 
archived, and to view the total number of non-patients that had an appointment 
within the date range

When:	 Yearly and monthly

Date: Page:0�������18 �

NEW PATIENT LIST (STANDARD LIST)
PMTS - DENTRIX DENTAL SYSTEMS

01/16/2017 - 12/23/2017

PATIENT NAME FIRST VISIT DATE FIRST PROCEDURE PROVIDER PATIENT STATUS REFERRED BY

�rosby��Brent�� 1�������17 1�������17 D��� N����������
�234�
�����
�����	�
�����������������

�rosby��Patricia 0�������17 0�������17 D��� P������
1234������������

����o� ��
� A�
0�������17

Bu���n� ����� � 
0��09���17

 �­�������������

 ansen���Corey 0�������17 0�������17 D��� P������ B�­����������
�23��������������� ��������17
����������������

��������Rachel 0�������17 0�������17 D��� I�����	� �������������
123����������­������� 0�������17
��������������

�yers��������� 0�������17 0�������17 D��� P������
123����������

Y���o� ��
� A� 
0�������17

��������������

�lsen��Paul 0�������17 0�������17 D��� P������ Y��������
����
�234������ood���                                                                                                                                                                       0���3/2017

  ��nna�oli�� �A 20007

Perkins��Shelly��                            1�������17                  1�������17                  DR��                  P����n� O����������������
12345 �� ����­orn R�                                                                                                                                                                 ���������7
 �n����� �� �����

Reeves� Elizabeth                           1�������17                  1�������17                  DR10                  P����n�                               M������� 
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How do I run the New Patient List?
In the Office Manager, from the Reports menu, point to Lists, and then click New Patient List. For 
additional details about running this report, see the “New Patient List” topic in the Office Manager 
portion of the Dentrix Enterprise Help (from the Help menu of any module, click Contents).

What important information does this report provide?
The information for letters A and C are found in the Patient Information dialog box, which can be 
accessed by double-clicking the Patient Information block in the Family File.

A.	First Visit Date – The patient’s first appointment date. This report can be sorted by the First 
Visit Date.

B.	 First Procedure Date – The date of the patient’s first completed procedure.

C.	 Patient Status – The patient’s status.

D.	Totals

•	 Total Active New Patients – The total number of new patients that are still active.

•	 Total Inactive New Patients – The total number of new patients that are now inactive.

•	 Total “Non-Patient” New Patients – The total number of “non-patients” that came in for 
an appointment. Patients that were changed from a non-patient status to a patient status.

•	 Total Archived New Patients – The total number of new patients that are now archived.

•	 Total New Patients – The total number of new patients.

A
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Office Journal Report
The Office Journal Report itemizes each Office Journal correspondence by date, time, medium, 
provider, type of service rendered, or transaction made. This report can be run for a patient, 
provider, or referral provider.

Why:	 To view Office Journal history

When:	 As needed

Office Journal
Patient: Abbott, James S[Jim] Date: 05/13/2018  Page: 1
05/13/20�8
Appointment:  Date: 05/13/20�8,  Time: 1:00:00 PM,  Provider: DDS1
PntcCtHNM#19, PntcCtHNM#20, PntcCtHNM#21, PntcCtHNM#22

Reminder: reminder  Date: 05/13/20�8, Clinic: CENTRAL
Reason: called to remind him of upcoming appt

Phone: Post-op  Date: 05/13/20�8, Clinic: CENTRAL
Reason: Checked in with patient - doing fine he says

04/27/20�8
Appointment:  Date: 04/27/20�8,  Time: 10:00:00 AM,  Provider: DDS1
LwParMtBs#25*26

04/24/20�8
Appointment:  Date: 04/24/20�8,  Time: 9:10:00 AM,  Provider: DDS1
CCAdult

04/22/20�8
Broken Appointment  Date: 04/22/20�8, Provider: DDS1, Clinic: CENTRAL
CCAdult, Pano, FabPtCr+B#5

03/02/20�8
Appointment:  Date: 03/02/20�8,  Time: 11:00:00 AM,  Provider: DDS1
ExtEval
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How do I run the Office Journal Report?
In the Office Journal, from the File menu, click Print. For additional details about running this 
report, see the “Printing from the Office Journal” topic in the Office Journal portion of the Dentrix 
Enterprise Help (from the Help menu of any module, click Contents).

What important information does this report provide?
The information displayed in this report is highly customizable and depends on the settings 
configured in the Office Journal. The following is a comprehensive list of possible data:

•	 HIPAA Privacy Entries

•	 Journal Entry Notes

•	 Miscellaneous Journal Entries

•	 Patient Archived Appointments

•	 Patient Billing Statements

•	 Patient Broken Appointments

•	 Patient Financing Requests

•	 Patient letters

•	 Patient Perio Letters

•	 Patient Purged Appointments

•	 Phone Calls

•	 Referral Gratuities

•	 Referral Recaps

•	 Referral Slips

•	 Reminders
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Operator Day Sheet Report
The Operator Day Sheet Report lists financial transactions (charges, payments, credit adjustments, 
charge adjustments, and finance charges) that have been posted to the Ledger, as well as some 
patient and practice statistics.

Why:	 To print a record of transactions for the current date

When:	 Daily

OPERATOR DAY SHEET(ENTERPRISE) ALPHABETICAL

Date: Page:04/27/2018 1
04/27/2018

ENTRY
DATE

PROCEDURE
DATE PATIENT NAME TH CODE DESCRIPTION CHARGES PAYMENTS BT PROV CLINIC CHART ENC

04/27/2018 04/27/2018 Abbott, James Insurance Payment -698.40      2 CENT     ABB101
04/27/2018 04/27/2018 Abbott, James 25* D5214    Mand partial-metal base w/sdls            898.00 2    DDS1      CENT     ABB101
04/27/2018 04/27/2018 Perkins, Shelly D9110    Emerg treatment, palliative 0.00 1    DDS1      CENT
04/27/2018 04/27/2018 Perkins, Shelly D0330    Panoramic film 0.00            1    DDS1      CENT
04/27/2018 04/27/2018 Perkins, Peggy  Cash Payment - Thank You -100.00      1       CENT
04/27/2018 04/27/2018 Reeves, Joshua -Professional Discount -25.00      1   CENT
04/27/2018 04/27/2018 Smith, Michael D9310    Consultation-per session    75.00 1    DDS0      CENT     SM0010

GRAND TOTALS:
TOTAL CHARGES: 973.00  Check Payment - Thank You 0.00

MEDICAID CHARGES: 0.00  Cash Payment - Thank You -100.00
TOTAL PAYMENTS: -798.40  Credit Card Payment -Thank Y 0.00

INSURANCE PAYMENTS: -698.40
MEDICAID PAYMENTS: 0.00

CREDIT ADJUSTMENTS: -25.00
CHARGE ADJUSTMENTS: 0.00

FINANCE CHARGES: 0.00

UNIQUE COUNTERS:
ENCOUNTERS: 0

PATIENTS: 5
PATIENTS WITH MEDICAID: 0

* Medicaid Insurance without a Medicaid Number
---   Medicaid Number without Medicaid Insurance

BA
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How do I run the Operator Day Sheet Report?
From the Office Manager, click the Operator Day Sheet Report button  on the toolbar. To find 
out which button this is, see the “Using the Office Manager toolbar” topic in the Office Manager 
portion of the Dentrix Enterprise Help (from the Help menu of any module, click Contents).

What important information does this report provide?
A.	Transactions – The transactions posted to the Ledger (including the patient’s name, procedure 

code and description, charge or payment, provider, and clinic).

B.	 Transaction Details – Each transaction provides the following additional information:

•	 Entry Date – The date a transaction is posted to the Ledger.

•	 Procedure Date – The date a procedure is posted to the Chart.

Note: It is essential that you understand the difference between Entry Dates and Procedure 
Dates. For details on these dates, see the Frequent Problems to Understanding Dentrix 
Reports section in the Introduction of this book.

•	 TH – The tooth number(s) associated with a procedure.

•	 BT – Billing type.

C.	 Grand Totals – The following information appears in the Grand Totals section for the current 
date:

•	 Charges – The total amount of the procedures posted, the amount of the procedures that 
were posted for patients with Medicaid (included in the total charges), and the total amount 
of the finance charges posted.

•	 Payments –  The total amount of all payments made (the payments are broken down by 
type), and the amount of the payments made by Medicaid.

•	 Adjustments – The total credit and charge adjustments.

•	 Statistics – The number of unique encounters, patients, and number of patients with 
Medicaid (included in the Patients total) appear.
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Operatory Appointment List Report
The Operatory Appointment List Report displays appointments scheduled each day and the 
operatories assigned to each appointment. Appointments are sorted by appointment time.

Why:	 To quickly view which operatory a patient is assigned to when the patient checks in

When:	 Daily

Date: Page:04/24/2018 1

OPERATORY APPOINTMENT LIST (<ALL>)
The Dentist Group

Providers <ALL> - <ALL>
Operatories <ALL> - <ALL>

01/01/2018  -  04/24/2018

DATE TIME STATUS PATIENT NAME PROV/OP APPT. REASON LENGTH

01/08            1:00p Abbott, James S DDS1/DEF_OP1      CCAdult, ProphyAd 110m

01/09 11:00a       <CMPL>        Little, Brian R DDS1/DEF_OP1      ResCmP2s#15 10m

01/09 11:00a       <CMPL>        Taylor, Mark DDS1/DEF_OP2      Sealant#15, Sealant#18, Seal... 30m

01/09 11:00a       <CMPL>        Abbott, Shirley DDS2/DEF_OP3      ExtErpTh#16, ExtErpTh#32, Ex... 50m

01/10  8:00a       NOansw        Brown, Mary DDS1/DEF_OP1     ExtEval 10m

01/10  8:10a       NOansw        Johnson, Rachelle             DDS1/DEF_OP1      ProphyAd 50m

01/10            8:20a       NOansw        Crosby, Brent DDS1/DEF_OP2     NutriCnsl 10m

01/10            8:30a       NOansw        Crosby, Shirley DDS01/DEF_OP3    2BWX, LwParMtBs#25*26 50m

01/10  9:00a       NOansw        Little, Carol DDS1/DEF_OP2     ExtEval 40m

01/10  1:00p       NOansw        Reeves, Elisabeth DDS1/DEF_OP2      4BWX 10m

01/10  1:50p       NOansw        Reeves, Joshua DDS1/DEF_OP1      FabPtCr+B#5 90m

01/10  2:00a       <CMPL>     Winters, Carl DDS1/DEF_OP1      CCAdult, Pano, FabPtCr+B#5 80m

A B C
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How do I run the Operatory Appointment List Report?
In the Office Manager, from the Reports menu, point to Lists, and then click Daily Appointment 
List. Ensure the Operatory Appointment List option is selected, and then click OK. For additional 
details about running this report, see the “Daily Appointment List” topic in the Office Manager 
portion of the Dentrix Enterprise Help (from the Help menu of any module, click Contents).

What important information does this report provide?
A.	Time – The appointment start time.

B.	 Prov/Op – The provider and operatory assigned to the appointment.

C.	 Length – The appointment length.
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Oral Health Education Report
The Oral Health Education Report displays the percentage of oral health patients who received 
oral health education (determined by specified ADA and/or condition codes) at least once during a 
specified time frame.

For example, you may want to track patients who received a comprehensive oral exam (ADA code 
D0150) or a periodic recall oral evaluation (ADA code D0120)—the denominator codes—and then 
received oral hygiene instructions (ADA code D1330) or tobacco counseling (ADA code D1320)—
the numerator codes.

Why:	 To view statistics regarding the oral health education of patients

When:	 Yearly

8 8
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How do I run the Oral Health Education Report?
From DXOne Reporting, select Lists, and then double-click Oral Health Education. For additional 
details about running this report, see the “Oral Health Education Report” topic in the DXOne 
Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
The report contains the following information:

A.	Numerator – The specified ADA codes and/or conditions.

B.	 Denominator – The specified ADA codes and/or conditions.

C.	 Clinic Totals – The Numerator, Denominator, and Percent totals for the providers at a given 
clinic on the report.

D.	Provider Totals – The Numerator, Denominator, and Percent totals for a given provider who is 
attached to the Numerator and/or Denominator codes.

E.	 Details –  If you select Include Details when setting options for this report, patient names, chart 
numbers, and procedures codes (numerators and denominators) appear on the report.

F.	 Totals – The Numerator, Denominator, and Percent grand totals for all clinics on the report.
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Oral Health Status Report
The Oral Health Status (OHS) Report displays OHS survey data within a specified date range and 
can include patient details.

Why:	 To track oral health, leading to early diagnosis and timely intervention

When:	 As needed

A
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How do I run the Oral Health Status Report?
From the DXOne Reporting module, select Custom, and then double-click Oral Health Status 
Report. For additional details about running this report, see the “Oral Health Status Report” 
topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any 
module, click Contents).

What important information does this report provide?
The appointments on the report can be grouped by provider and then by clinic or grouped by 
clinic and then by provider. Each clinic’s statistics can start on a new page.

A.	Oral Health Statuses – The number of patients of a given age for each of the oral health 
statuses.

B.	 No OHS – The number of patients of a given age without OHS survey data.

C.	 Age Total – The number of patients of a given age.

D.	Total Number of Patients – The total number of patients in each OHS column, the No OHS 
column, and the Age Total column.
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Patient Chart and Progress Notes 
Printout
The Patient Chart and Progress Notes Printout allows you to print a patient’s graphical chart and 
progress notes.

Why:	 To print a patient’s dental chart and progress notes as a clinical record for the 
patient

When:	 As needed

Patient Progress Notes
Patient: James S. Abbott Date: 05/13/2018

Birthdate: SS#: 11/11/1960 000-00-0000Chart #: ABB101
Provider: Dennis Smith 

Phone: (480)555-6525
Office: 1234 South Pine

Mesa, AZ  85210

 1  2  3  4  5  6  7  8  9 10 11 12 13 14 15 16

17181920212223242526272829303132

Progress Notes

Date      Tooth Surf Proc  Prov Description Stat   AP  Amount  

MOD  D2160 DDS2 Amalgam-3 surf. prim/perm     C       90.00
D7110 DDS1 Extraction-single tooth       C       71.00
D1110 DROBBProphylaxis-adult            » C     48.00

10/15/2016 14   
10/15/2016 16   
07/07/2017     
07/28/2017     Clinical Note

D8670 DROBBPeriodic ortho visit (contract C      950.00
D7140 DROBBExtract,erupted th/exposed rt» C    P2    135.00

test note-
12/15/2017     
12/15/2017 1   
12/15/2017 16   D7140 DDS2 Extract,erupted th/exposed rt C      135.00

D7230 DDS2 Extraction-impacted/part bony C    P1    213.00
D7140 DDS2 Extract,erupted th/exposed rt C    P1    135.00

DLB  D2160 DROBBAmalgam-3 surf. prim/perm    » C       90.00
95831 DROBBMuscle testing C        0.00
90620 DROBBExam and consultation         C        0.00
95868 DROBBElectromyography C        0.00
D0270 DROBBBitewing-single film          C       15.00
D0350 DROBBOral/Facial Photographic Image C        0.00
D5110 DROBBComplete denture - maxillary  C      850.00
D7250 DROBBSurgic removl resid tooth roo» C       25.00
D2110 DROBBAmalgam-1 surface, primary   » C       51.00
D2110 DROBBAmalgam-1 surface, primary   » C       51.00
D5120 DROBBComplete denture - mandibular C      828.00

12/15/2017 17   
12/15/2017 32   
01/07/2018 30   
01/09/2018
01/09/2018
01/09/2018
01/09/2018
01/09/2018
01/09/2018 2-15 
01/09/2018 5   
01/09/2018 S1   
01/09/2018 S1   
01/09/2018 LR   
01/15/2018     90620 DROBBExam and consultation         C      500.00

Continued on Next Page
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How do I run the Patient Chart and Progress Notes 
Printout?
In the Patient Chart, from the File menu, point to Print, and then click Patient Chart. For more 
detailed instructions on how to run this report, see the “Printing progress notes with the chart” 
topic in the Patient Chart portion of the Dentrix Enterprise Help (from the Help menu of any 
module, click Contents).

What important information does this report provide?
A.	Patient Information – The patient’s name, birth date, chart number, and Social Security number 

appear on the report.

B.	 Graphic Chart – The graphical chart appears on the report.

C.	 Progress Notes – The following is a comprehensive list of what can appear in the progress 
notes section:

Columns Filters
•	 Procedure Date •	 Treatment Plans

•	 Tooth •	 Completed Work

•	 Surface •	 Existing Work

•	 Procedure Code •	 Conditions

•	 Provider •	 Exams

•	 Procedure Description •	 Procedure Notes

•	 Procedure Status •	 Clinical Notes

•	 Approval Status

•	 Procedure Amount
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Patient Chart Printout
The Patient Chart Printout allows you to print a patient’s graphical chart and treatment plan.

Why:	 To print a patient’s dental chart with a treatment plan to give to the patient

When:	 As needed

Chart
Patient: James S. Abbott Date: 05/14/2018

Birthdate: SS#: 11/11/1960 000-00-0000Chart #: ABB101
Provider: Dennis Smith 

Phone: (480)555-6525
Office: 1234 South Pine

Mesa, AZ  85210

 1  2  3  4  5  6  7  8  9 10 11 12 13 14 15 16

17181920212223242526272829303132

Today's Completed Work

Tooth      Description Amount

   27 Amalgam-1 surf. prim/perm 55.00

Charges for this Visit    55.00

Treatment Plan Estimate

Tooth      Description Amount Pat. Dental Ins.

      Periodic oral evaluation   25.00    0.00   25.00
      Prophylaxis-child   34.00    0.00   34.00
      Bitewings-two films   21.00    0.00   21.00
   UR Perio scale&root pln-4+per quad  131.00    0.00  131.00
    7 Post/core + brdg retainer, fabr  230.00    0.00  230.00
12*14 Maxil partial-metal Base W/sdls  890.00    0.00  890.00
   18 Reimplantation/stabilization    0.00    0.00    0.00
   19 Pontic-cast high noble metal  603.00    0.00  603.00
   20 Pontic-cast high noble metal  603.00    0.00  603.00
   21 Pontic-cast high noble metal  603.00    0.00  603.00
   22 Pontic-cast high noble metal  603.00    0.00  603.00
   23 Cast post/part of brdg retainer  218.00    0.00  218.00
   24 Cast post/part of brdg retainer  218.00    0.00  218.00
   25 Cast post/part of brdg retainer  218.00    0.00  218.00
   31 Extraction-single tooth   71.00    0.00   71.00

Treatment Plan Totals  4468.00     0.00  4468.00

* Treatment Plans Are Estimates Only
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How do I run the Patient Chart Printout?
In the Patient Chart, from the File menu, point to Print, and then click Patient Chart. For more 
detailed instructions on how to run this report, see the “Printing a patient’s chart” topic in the 
Patient Chart portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
A.	Patient Information – The patient’s name, birth date, chart number, and Social Security number 

appear on the report.

B.	 Dental Chart – If Print Chart as Displayed is selected when setting options for this report, the 
graphical chart appears on the report.

C.	 Today’s Work – If Print Today’s Work is selected when setting up options to run this report, the 
procedures that were completed on the current date are displayed and totaled.

D.	Treatment Plan Estimate – If Print Treatment Plan and Print TP Estimate Details are selected 
when setting up options to run this report, the patient’s treatment-planned procedures and total 
estimate appear below the dental chart.
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Patient Health Assessment Report
The Patient Health Assessment Report displays health information entered for a patient, a family, 
or a range of patients in specified clinics. The blood pressure, pulse rate, age, height, weight, and 
body mass index (BMI) of each patient appears on the report.

Why:	 To print a patient’s or multiple patients’ health assessments, such as blood 
pressure, weight, and body mass index

When:	 As needed

Page 1 of 1

������� H��L� �SS�SSM���
Assessment Date: 8/22/2017 - 8/22/2017
Patient Range: <ALL> to <ALL>
����������������

Date: 8/22/2017  1:57:54PM

��

����
��	�
 �	��
 ��
 �
���� ��� ��
���
� �������
����

128/76 63 64 5ft 10in 185lbs 27 DDS1 CENTRAL
166/70 60 52 5ft 4in 110lbs 19 DDS1 CENTRAL
112/80 65 0 6ft 0in 200lbs 27 DDS1 CENTRAL

���
      ����
���N��


08/22/2017�C��������������C�� ­�� 
08/22/2017�C�������S��������C�� �­� 
08/22/2017 ��������������
����A   � 
08/22/2017 ����������������������L ��� 187/75 66 55 5ft 9in 153lbs 23 DDS1 CENTRAL
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How do I run the Patient Health Assessment Report?
For a range of patients, from DXOne Reporting, select Reference, and then double-click Patient 
Health Assessment Report. Or, for an individual patient or that patient’s entire family, in the 
Patient Chart, from the File menu, click Patient Health Assessment, and then click Print. For 
additional details about running this report, see the “Patient Health Assessment Report” topic in 
the DXOne Reporting portion and the “Printing patient health assessments “ topic in the Patient 
Chart portion of the Dentrix Enterprise Help (from the Help menu of any module, click Contents).

What important information does this report provide?
For each patient in the date range of the report, the following appear: blood pressure, pulse rate, 
age, height, weight, and body mass index (BMI). The provider and clinic attached to each health 
assessment also appear.
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Patient Information Accessed 
Report
The Patient Information Accessed Report helps you track when any patient’s record has been 
viewed.

Why:	 To ensure that patient information is being viewed in accordance with patient 
privacy standards in your office, and to inform the doctor, office manager, and 
business owner of any situations so that appropriate action can be taken if 
necessary

When:	 Monthly and as needed

Patient Information Accessed
Date Range: 2/1/2018 - 3/1/2018

Family of Patient: Abbott, James S
��������ALL>
C��������ALL>

Page 1 of 1Report Date: 3/1/2018

 ���������
��������
���
�������
�� 
������ ������ �����	�����
���� ����
�

���������������� CENTRAL ENTERPRISE������ ������
�������������
� CENTRAL ENTERPRISE������ ������
��������������� CENTRAL ENTERPRISE������ ������
���������������� CENTRAL ENTERPRISE������ ������
�������������
� CENTRAL ENTERPRISE������ ������
��������������� CENTRAL ENTERPRISE������ ������
���������������� CENTRAL ENTERPRISE������ ������
���������������� CENTRAL ENTERPRISE������ ������
���������������� CENTRAL ENTERPRISE������ ������
���������������� CENTRAL ENTERPRISE������ ������
���������������� CENTRAL ENTERPRISE������ ������
���������������� CENTRAL ENTERPRISE������ ������
���������������� CENTRAL ENTERPRISE������ ������
���������������� CENTRAL ENTERPRISE������ ������
���������������� CENTRAL ENTERPRISE������ ������
���������������� CENTRAL ENTERPRISE

2/21/2018  12:16:51PM  ����l����l�
2/21/2018  12:31:28PM  ����l����l�
2/21/2018  12:45:17PM  ����l����l�
2/21/2018   3:31:18PM   ����l����l�
2/21/2018   3:35:28PM   ����l����l�
2/21/2018   3:46:45PM   ����l����l�
2/22/2018  11:21:14AM  C
���
2/22/2018  12:28:59PM  L�� ��
2/28/2018  10:27:44AM  ����l����l�
2/28/2018  10:27:54AM  
o�	�����C����� 
2/28/2018  11:31:02AM  C
���
2/28/2018  11:31:14AM  �����������l����� 
2/28/2018  12:09:17PM  A­­����������ook
2/28/2018   3:03:58PM   ����l����l�
2/28/2018   3:04:02PM   
o�	�����C����� 
3/1/2018     8:43:28AM   
o�	�����C����� ������ ������
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How do I run the Patient Information Accessed Report?
From DXOne Reporting, select Audit, and then double-click Patient Information Accessed. For 
additional details about running this report, see the “Patient Information Accessed Report” topic in 
the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, 
click Contents).

What important information does this report provide?
The report contains the following information:

A.	Patient – The patient whose record was accessed.

B.	 Status – An indicator that the patient’s information was viewed. A patient record is considered 
to have been viewed in the following situations:

•	 When you select a patient in the Select Patient dialog box and then click OK.

•	 When you select a patient in the Select Patient dialog box and then click More Patient 
Information.

•	 When you double-click a patient’s appointment and then click Patient Info.

•	 When you switch from one module to another (patient-specific modules only) with a patient 
selected. For example, if you open a patient’s Patient Chart and then switch to that patient’s 
Family File record, Dentrix Enterprise logs two entries for the report.

•	 When accessing the same patient record in the same module, at the same clinic, on the 
same date, and/or by the same user after a specified number of minutes has elapsed since 
the last time that patient’s record was accessed in the same module, at the same clinic, on 
the same date, and/or by the same user.

C.	 Other information – Each entry on the report provides the date and time when the patient 
information was accessed, the module from which it was accessed, the clinic from which it was 
accessed, the user that accessed it, and the chart number of the patient whose record it was.
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Patient Ledger Report
The Patient Ledger report displays transactions posted for a patient.

Why:	 To provide a patient with a record of his/her transactions

When:	 As needed

SINGLE PATIENT LEDGER 
The Allied Dentist Group

Page:Date: 05/14/2018 1

Patient Name: Chart Number:

Billing Type:

Shelly Perkins
123 Street
Philadelphia, PA  19102

PA0007

1

DATE TEETH DESCRIPTION PATIENT CHARGE PAYMENT BALANCE

04/22/2018   Balance Forward 0.00 0.00
04/23/2018  9            Surg place implant: endosteal Shelly 780.00 780.00
04/23/2018  4            Crown-porc fuse high noble mtl Shelly 78.00 858.00
05/01/2018 15           Mand partial-metal base w/sdls Shelly 801.00 1659.00
05/01/2018  9            Extraction crnl remnts-decid th Shelly 501.00 2160.00

TOTAL PATIENT BALANCE AS OF 05/14/2018: 2160.00

A
B
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How do I run the Patient Ledger Report?
In the Ledger, from the Print menu, click Patient Ledger. For more detailed instructions on how to 
generate this report, see the “Patient Ledger Report” topic in the Ledger portion of the Dentrix 
Enterprise Help (from the Help menu of any module, click Contents).

What important information does this report provide?
A.	Family History – All financial transactions posted to the Ledger (starting with the specified first 

transaction date) for the patient.

B.	 Patient Total Balance – The patient balance as of the current date.
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Patient List
The Patient List allows you to view patients entered into Dentrix Enterprise. To sort patients 
alphabetically, run the Patient List (Standard List) report. To sort patients by chart number, run the 
Patient List (Chart Number Report).

Why:	 To view active patients, inactive patients, non-patients, and archived patients 
entered in Dentrix Enterprise, to view patients who prefer a specific provider, and 
to view patients with a specific billing type

When:	 As needed

PATIENT LIST
<ALL>
Active, Inactive, Non-Patient, Archived
<ALL> - <ALL>

Last Visit Before:
Patient Status:
Patient Range:

CENTRALClinics:
<ALL>Providers:
<ALL>Billing Types:

Page 1 of 4Report Generated By: enterprise

E-mail:

Home Phone: ()375-1586
Work Phone: 
Other: 
Fax: 
Pager: 

Prov/Clin: DROBB/CENTRAL Status: Active
Gender: Male
Position: Married
Billing Type: 002

Report Date: 05/06/2018

Abbott, James S
1234 Pine Ave
Murray, UT  84123

Dental Pri: Metropolitan Life
Dental Sec:Aetna Life and Casualty
Medical Pri:Aetna Medical 
Medical Sec:

Birthdate: 11/11/1962 
SS: 000-00-0000
Chart: ABB101
Drivers Lic#: 
Med/Other ID: 
First Visit Date: 12/15/2008 
Last Visit Date: 05/05/2018

Medical Sec:

Davis, Harmon P

E-mail:

Dental Pri: Delta Dental
Dental Sec:
Medical Pri:

Home Phone: 
Work Phone: 
Other: 
Fax: 
Pager: 

Prov/Clin: DDS7/CENTRAL Birthdate: 11/11/1970
SS: 000-00-0000
Chart: 
Drivers Lic#: 
Med/Other ID: 

Status: Active
Gender: Male
Position: Single
Billing Type: 001

12345 Oak Drive
East Granby, CT  06026

Last Visit Date: 
First Visit Date: 12/15/2008

Medical Sec:

Hansen, Cory S

E-mail:

Dental Pri: BLUE SHIELD PA
Dental Sec:CIGNA
Medical Pri:

Home Phone: (919) 555-2656
Work Phone: (808) 555-5864
Other: 
Fax: 
Pager: 

Prov/Clin: DDS1/CENTRAL Status: Active
Gender: Male
Position: Single
Billing Type: 001

1234 Amhurst Street
Brooklyn, NY  11215

Birthdate: 11/11/1957 
SS: 000-00-0000
Chart: HA0002
Drivers Lic#: 
Med/Other ID: 
First Visit Date: 11/18/2015 
Last Visit Date: 

Medical Sec:

Kenner, Spencer

E-mail:

Dental Pri: MLB Insurance Plan
Dental Sec:
Medical Pri:

Home Phone: (781) 555-9616
Work Phone: (701) 555-9885
Other: 
Fax: 
Pager: 

Prov/Clin: DDS1/CENTRAL Birthdate: 11/11/1949
SS: 000-00-0000
Chart: 
Drivers Lic#: 
Med/Other ID: 

Status: Active
Gender: Male
Position: Single
Billing Type: 001

12345 Lindon Place
Miami, WA  20226

Last Visit Date: 
First Visit Date: 

Medical Sec:

Little, Brian

E-mail: guarantor@gmail.com

Dental Pri: Metropolitan Life
Dental Sec:Metropolitan Life
Medical Pri:

Home Phone: 
Work Phone: 
Other: 
Fax: 
Pager: 

Prov/Clin: DDS1/CENTRAL Status: Active
Gender: Male
Position: Single
Billing Type: 001

1234 Oak Street
Glen Rock, PA  17327

Birthdate: 11/11/1955 
SS: 000-00-0000
Chart: 
Drivers Lic#: 
Med/Other ID: 
First Visit Date: 01/08/2009 
Last Visit Date: 05/05/2018

Medical Sec:

Nelson, Shawna

E-mail: guarantor@gmail.com

Dental Pri: 
Dental Sec:
Medical Pri:

Home Phone: 
Work Phone: 
Other: 
Fax: 
Pager: 

Prov/Clin: DDS1/CENTRAL Birthdate: 11/11/1977
SS: 000-00-0000
Chart: 
Drivers Lic#: 
Med/Other ID: 

Status: Active
Gender: Female
Position: Single
Billing Type: 001

12345 Maple Street
Glen Rock, PA  17327

Last Visit Date: 
First Visit Date: 01/13/2009

A
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PATIENT LIST (CHART NUMBER REPORT)
<ALL>
Active, Inactive, Non-Patient
<ALL> - <ALL>

Last Visit Before:
Patient Status:
Patient Range:

CENTRALClinics:
<ALL>Providers:
<ALL>Billing Types:

Page 1 of 1Report Date: 05/06/2018 Report Generated By: enterprise

PATIENT NAME BIRTH DATE SOC.SEC.# CHART #

Abbott, James S                                                                                    11/11/1962             000-00-0000 ABB101
Crosby, Brent P  11/11/1962             000-00-0000 CRO101
Davis Harmon S                                                                                    11/11/1962             000-00-0000                DAV101
Davis, Karen 11/11/1962             000-00-0000 DAV102
Edwards, Anna 11/11/1962             000-00-0000 EDW101
Edwards, John 11/11/1962            000-00-0000 EDW102
Edwards, Kimberly 11/11/1962             000-00-0000 EDW103
Farrer, Lisa R                                                                                         11/11/1962           000-00-0000 FAR101
Gleason, Alice 11/11/1962            000-00-0000 GLE101
Hansen, Corey                                                                                      11/11/1962             000-00-0000                HAN101
Hayes, Sally                                                                                          11/11/1962             000-00-0000                HAY101
Johnson, Rachelle 11/11/1962             000-00-0000 JOH101
Little, Brian 11/11/1962             000-00-0000 LIT101
Little, Carol 11/11/1962            000-00-0000 LIT101
Perkins, Allen                                                                                         11/11/1962           000-00-0000 PER101
Perkins, Peggy M                                                                                  11/11/1962             000-00-0000                PER101
Reeves, Elisabeth 11/11/1962             000-00-0000 REE101
Smith, Michael 11/11/1962             000-00-0000 SMI101
Taylor, Kerri 11/11/1962             000-00-0000 TAY101
Winters, Carl 11/11/1962             000-00-0000 WIN101
Young, Tina                                                                                           11/11/1962             000-00-0000               YOU101

A

How do I run the Patient List?
From the DXOne Reporting module, select List, and then double-click Patient/Inactive Patient 
List. For step-by-step instructions on how to run this report, see the “Patient and Inactive Patient 
List” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of 
any module, click Contents).

What important information does this report provide?
A.	Patient Details – The Patient List (Chart Number Report) displays the name, birth date, Social 

Security number, and chart number of each patient. The Patient List (Standard List) includes 
all of the information covered by the Patient List (Chart Number Report), plus general patient 
information (such as, address, phone numbers, and insurance information).
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Patient List (Filtered)
The Patient List (Filtered) displays a list of patients according to specified criteria, such as 
information from their medical alerts/problems, medications, prescriptions, demographics, and 
laboratory test results.

Why:	 To view and sort a list of patients according to specified criteria

When:	 As needed

A

How do I run the Patient List (Filtered)?
In the Office Manager, from the Analysis menu, click Patient List. For as many filters as you want to 
set up, under Double click on filter below, double-click each desired item to specify the criteria of 
that filter. Click the OK button . Click the Next button . In the desired categories, double-click 
the data fields that you want to include. Click the Next button . Then, click the Run button .

For additional details about running this report, see the “Patient List (Filtered)” topic in the 
Office Manager portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
A.	Patient – The specified patient information:

•	 Allergies – Description and/or Discovery Date.

•	 Appointments – Appt Date/Time, Next Appt Date/Time, and/or Provider.

•	 Completed Procedures – ADA Code, Amount, Clinic, Entry Date, Procedure Date, and/or 
Provider.

•	 Continuing Care – Due Date and/or Name.

•	 ICD-9-CM – Code, Entry Date, and/or Procedure Date.

•	 Immunizations – Administered Date/Time and/or Vaccine Abbr Desc.

•	 Laboratory Test Results – Test Date, Test Name, and/or Test Result.

•	 Medical Alerts/Problems – Date Diagnosed and/or Description.

•	 Medications – Description and/or Prescribed Date.

•	 Patient Information – Age, Birth Date, Chart, City, Clinic, Contact, County, Email, Ethnicity, 
Gender, Home Phone, Homeless Status, Language, Mobile Phone, OtherID, Pat ExtID, 
Patient Name, Poverty Level, Pref Contact, Prim Prov, Race, Religion, State, Street 1, Street 
2, User Def Cat, Veteran, Work Phone, Worker Status, and/or ZIP Code.

•	 Prescriptions – Drug Name and/or Rx Date.
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A patient will show in the results list according to the setup of the selected filters:
•	 Age – A patient who is older or younger than the specified age or who is between the 

specified ages (inclusive).

•	 Allergies – A patient who has all or any one of the specified allergies that were entered on any 
date, before a specified date, after a specified date, or between specified dates (inclusive).

•	 Appointment Date – A patient who has an appointment on or before a specified date, on 
or after a specified date, or between specified dates (inclusive).

•	 Assigned Clinic – A patient who is assigned to the specified clinic.

•	 Completed Procedures – 

•	 Continuing Care – A patient who has the specified continuing care types attached to his or 
her records and who is due for a continuing care visit on any date, on or before a specified 
date, on or after a specified date, or between specified dates (inclusive).

•	 Ethnicity – A patient of the specified ethnicity.

•	 Gender – A patient of the specified gender.

•	 Homeless Status – A patient with the specified homeless status.

•	 ICD-9-CM Diagnostic Codes – A patient who has been diagnosed with all or any one of the 
specified diagnoses that were entered on any date, before a specified date, after a specified 
date, or between specified dates (inclusive).

•	 Laboratory Test Results – A patient who has lab test results that are equal to, greater than, 
greater than or equal to, less than, or less than or equal to the specified test result that was 
received on any date, before a specified date, after a specified date, or between specified 
dates (inclusive).

•	 Language – A patient who speaks the specified language.

•	 Medical Alerts/Problems – A patient who has all or any one of the specified medical alerts 
that were entered on any date, before a specified date, after a specified date, or between 
specified dates (inclusive).

•	 Medications – A patient who has all or any one of the specified medications that were 
entered on any date, before a specified date, after a specified date, or between specified 
dates (inclusive).

•	 Poverty Level – A patient with the specified poverty level.

•	 Preferred Contact – A patient with the specified preferred contact method.

•	 Prescriptions – A patient who has all or any one of the specified prescriptions that were 
entered on any date, before a specified date, after a specified date, or between specified 
dates (inclusive)

•	 Primary Provider – A patient with the specified primary provider.

•	 Race – A patient of the specified race.

•	 Religion – A patient of the specified religion.

•	 User Defined Category – A patient with the specified user-defined category.

•	 Veteran – A patient with the specified veteran status.

•	 Worker Status – A patient with the specified worker status.

Note: A patient may show up more than once if he or she meets the search criteria for multiple 
filter types (for example, medical alerts, medications, and prescriptions).
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Patient Notes Report
The Patient Notes Report displays notes and alerts attached to patients.

Why:	 To view notes and alerts by patient

When:	 As needed

PATIENT NOTE REPORT
Dentrix Dental Practice

Date: Page:03/08/2018 1

PATIENT NAME CHART NUM SS# HOME PHONE WORK PHONE LAST VISIT

Abbott, Timothy AB0003 000-00-0003 (801)555-1586 (801)555-1487 11/11/2017
PATIENT ALERT NOTES

- Require Payment - Always
Payment must be at time of service.

Brown, Mary BR0001 000-00-0004 (801)555-4509 (801)555-2000 07/02/2017
PERIO EXAM NOTES

Perio Date:  03/08/2018
The patient is suffering from severe suppurration and was advised to begin treatment immediately.

Crosby, Brent L CR001 000-00-0005 (801)555-5969 (801)555-6600 07/02/2017
APPOINTMENT NOTES

Appointment Date:  03/08/2018 
The patient has a sever tooth ache.

Davis, Harmon DA0007 000-00-1234 (801)555-1530 (   ) 03/22/2018
MEDICAL ALERTS

Allergy - Aspirin

Davis, Karen DA0003 000-00-0007 (801)555-1530 (   ) 01/01/2018
PATIENT NOTE

- Tue - Mar 8, 2018 -
Karen is divorced from Harmon Davis who is listed in her file as a non-patient to provide insurance coverage for their children.  He is also set up in his 
own Family File.

CONTINUING CARE NOTES
 03/08/2018 PROPHY
Come in for your cleaning and receive a free tooth whitening treatment.

Davis, Kelly DA0004 000-00-0123 (801)555-1530 (   ) 03/08/2018
INSURANCE CLAIM STATUS NOTES

Claim Date:  03/08/2018
The claim was lost somewher between our office and the insurance carrier. We are consequently re-sending it.- Tue - Mar 8, 2011 - GW

Davis, Lyle DA0005 000-00-0234 (801)555-1530 (   ) 03/22/2018
PAYMENT PLAN NOTES

Provider DDS1:
Since the first payment was set on the weekend. we agreed to push it back to the following Monday.

Edwards, John ED0002 000-00-9876 (801)555-7101 (   ) 01/01/2018
GUARANTOR NOTE - Edwards, John

John has been out of work for several weeks - Tue - Mar 8, 2018 - GW

GUARANTOR STATEMENT NOTE - Edwards, John; Print Until 04/08/2018
We appreciate your prompt payment.

A

B

C
D

E

F

G

H
I
J
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How do I run the Patient Notes Report?
From the Office Manager, from the Reports menu, point to Lists, and then click Patient Notes 
Report. For step-by-step instructions on how to run this report, see the “Patient Notes Report” 
topic in the Office Manager portion of the Dentrix Enterprise Help (from the Help menu of any 
module, click Contents).

What important information does this report provide?
A.	Patient Alert Notes – The patient alerts 

assigned to a patient. Patient alerts are found 
in the Patient Alerts dialog box. To access this 
dialog box, select a patient in the Family File, 
and then click the Patient Alerts button.

B.	 Perio Exam Notes – The notes attached to 
a patient’s perio exam. Perio exam notes are 
found in the Perio Clinical Notes dialog box. 
To access this dialog box, select an exam in 
the Perio Chart, and then click Diagnostics 
on the menu bar.

C.	 Appointment Notes – The notes 
attached to a patient’s appointment. 
Appointment notes are found in the 
Appointment Information dialog 
box. To access this dialog box, 
double-click an appointment in the 
Appointment Book.

A

B

C
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D.	Medical Alerts – The problems, medications/
prescriptions, allergies, and devices that are 
attached to a patient. Medical alerts are found 
in the Medical Alerts window. To access this 
window, select a patient in the Family File, and 
then double-click the Medical Alerts block.

E.	 Patient Notes – The notes attached to a patient. 
Patient notes are found in the Patient Note dialog 
box. To access this dialog box, select a patient in 
the Family File, and then double-click the Patient 
Notes block.

F.	 Continuing Care Notes – The notes 
attached to a patient’s continuing care type. 
Continuing care notes are found in the Edit 
Continuing Care dialog box. To access this 
dialog box, select a patient in the Family 
File, double-click the Continuing Care 
block, and then double-click a continuing 
care type.

E

D

F
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G

G.	Insurance Claim Notes – The notes attached to an 
insurance claim. Insurance claim notes are found in 
the Insurance Claim Notes dialog box, which can 
be accessed by clicking the Note menu option in 
the insurance claim window.

H.	Payment Plan Notes – The notes 
attached to a future due payment 
plan. Payment plan notes are found 
in the Payment Plan dialog box. 
To access this dialog box, from the 
Transaction menu in the Ledger, 
click Process Future Due Payment 
Plan, select a future due payment 
plan, and then click Edit.

I.	 Guarantor Note – The notes attached 
to a guarantor. Guarantor notes are 
found in the Guarantor Notes dialog 
box. To access this dialog box, select a 
patient in the Ledger, and then click the 
Guarantor Notes button.

J.	 Guarantor Statement Note – The 
notes attached to guarantor statements. 
Guarantor statement notes are found 
in the Guarantor Notes dialog box. 
To access this dialog box, select a 
patient in the Ledger, and then click the 
Guarantor Notes button.

H

J

I
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Patient Proposed Treatment Case 
Report (Your Care Plan)
The Patient Proposed Treatment Case Report displays only treatment plan cases with “Proposed” 
statuses. This report is patient-specific (can be generated for one patient at a time). The report lists 
the patient’s proposed treatment plan cases and financial data regarding those cases.

Why:	 To generate a list of proposed treatment plan cases along with cost information 
to give to a patient

When:	 As needed

Your Care Plan
Patient:

Provider:

2/1/2018
Phone:

Office:

Date:

Chart #:

SS #:

Birthdate:

Brent Crosby

Dennis Smith

CR93

111-11-1111

11/11/1970

TX CaseTreatment 

Required

Total TX Case 

Amount

Estimated 

Patient 

Portion

Estimated 

Insurance 

Portion

1 Eval  0.00  155.00 155.00

2 Restore  38.00  152.00 190.00

Total :  307.00 38.00 345.00

Page 1 of 1

B

A

C
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How do I run the Patient Proposed Treatment Case 
Report (Your Care Plan)?
In the Treatment Planner module, from the File menu, point to Print, and then click Patient 
Proposed Tx Case Report. For additional details about running this report, see the “Patient 
Proposed Treatment Case Report” topic in the Treatment Planner portion of the Dentrix Enterprise 
Help (from the Help menu of any module, click Contents).

What important information does this report provide?
A.	Patient Information – The patient’s name, chart number, Social Security Number, birth date, 

and primary provider (from the Family File).

B.	 Treatment Case Details – The name of each proposed treatment plan case and a subtotal of 
the fees, estimated patient portions, and estimated insurance portions for all treatment in each 
case.

C.	 Totals – The total fee, estimated patient portion, and estimated insurance portion for all 
treatment in all proposed treatment plan cases.
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Patient Questionnaire
You can print a hard copy of the patient questionnaire, which contains the patient’s personal, 
referral, guarantor/spouse, employment, and insurance information along with any custom 
questions (for example, questions regarding medical or dental history).

Why:	 To provide the patient with a printout from which he or she can review personal 
and insurance information and medical and dental history

When:	 At patient check-in

ABB101

Abbott, James S Jim 03/08/2018

M Married 11/11/1982 000-00-0041

1234 S Oak, 

Murray UT 84123

555-1586

Crosby,Brent L

Abbott, James S Jim 03/08/2018

M Married 11/11/1982 000-00-0041

1234 S Oak, 

Murray UT 84123

555-1586

x

Acme Bank

123 Hill Dr Provo UT 84604 555-4701

000-00-0000                  16023

Murray UT 84123
Acme Bank

123 Hill Dr Provo UT 84604
x

Allied Group Insurance Trust, P.O. Box 29109, 

St. Louis, MO, 63126
Abbott, Timothy 

11/11/1984 321863

1234 S Oak Murray UT 84123

x
Aetna Life and Casualty, P.O. Box 12345, 

Fort Wayne, IN, 46801
©DENTRIX 1987-2018

Patient Information

Referral Information

Spouse or Responsible Party Information

Employment Information

Insurance Information

Patient Name: Date:

Gender(M/F):

Driver's License #:

Address:

Phone #'s:

Marital Status: Birth Date: Social Security #:

E-Mail Address:

Ext Best time to call:

OtherOther

Home Work

FAX Pager

Last First MI (Preferred Name)

Street

City

Apartment #

State

Chart#:
FOR OFFICE USE ONLY

Name of person, office or other source referring you to our practice:

Name: Date:

Gender(M/F):

Driver's License #:

Address:

Phone #'s:

Marital Status: Birth Date: Social Security #:

E-Mail Address:

Ext Best time to call:

OtherOther

Home Work

FAX Pager

Last First MI (Preferred Name)

Street

City

Apartment #

State

Employer Name:

Zip Code

Zip Code

Address:

The following is for: the patient the person responsible for payment

Street

Phone

Insured's Employer Name:

Insurance Plan Name and Address:

Address:

Patient's relationship to insured:

ID #: Group #:

the patient

Self

the person responsible for payment

Spouse Child Other

First MI

Street City State Zip Code

Street City State Zip Code

Primary
Name of Insured: Abbott, James S

Last

Insured's Birth Date: 11/11/1982

Insured's Address: 1234 S Oak

City State Zip CodeStreet

Name of Insured:

Insured's Birth Date:

Insured's Address:
Insured's Employer Name:

Insurance Plan Name and Address:

Address:

Patient's relationship to insured:

ID #: Group #:

Self Spouse Child Other

Last First MI

Street City State Zip Code

Secondary

City State Zip Code

A
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Patient Information
Patient: Abbott, James S
Birth Date: 11/11/1982 Chart#: ABB101

Date: 03/08/2018 
SS#: 000-00-0041

Provider: DDS9
Phone: 555-1586
Address: 1234 S Oak
        Murray, UT 84123

Patient Questionaire

Date of Questionnaire 03/08/2018

Do you have any medical conditions that we should be aware of? No

If yes, please explain: 

Have you ever had any complications following dental treatment? No

If yes, please explain: 

A

B

How do I run the Patient Questionnaire?
1.	 From any module (except the Office Manager), click the Patient Questionnaire button to open 

the Patient Questionnaire History window.

2.	 Select an existing questionnaire, and click View or Edit. Or, select a questionnaire type from 
the list, and click New.

3.	 To print the full questionnaire (all the patient information and custom questions), click Print. 
To print just the custom questions, click Print Questions. The responses to the questions will 
print if you are viewing or editing an existing questionnaire; new questionnaires don’t have any 
responses, yet.

For more detailed instructions on printing a patient questionnaire, see the “Printing 
questionnaires” topic in the Other Features portion of the Dentrix Enterprise Help (from the Help 
menu of any module, click Contents).

What important information does this report provide?
A.	Patient Information

•	 Full Questionnaire – The patient’s personal, referral, guarantor/spouse, employment, and 
insurance information stored in the Family File.

•	 Questions Only – The patient’s name, birth date, chart number, and Social Security number 
stored in the Family File.

B.	 Questions – Questions regarding medical/dental history and/or other custom questions, and 
the patient’s responses (if any).
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Patient Revenue List by Payer 
Report
The Patient Revenue List by Payer Report displays the total amount of charges, payments, and 
adjustments that have been posted to a given patient’s record, on a given service date or entry 
date, and for a given payer.

Why:	 To track revenue by payer

When:	 As needed

Patient Revenue List By Payer

Date Range: 2/25/2020 - 2/25/2020 Procedure Date

Clinics: AF

Patient Range: <ALL> - <ALL>

Patient Status: <ALL>

Page 1 of 1Report Generated By: ENTERPRISEReport Date: 2/25/2020

Clinic Chart NumberPatient Name Date of ServicePayer Name Total Charges by Date 

of Service

Total Payments by Date 

of Service

Total Adjustments by Date 

of Service

AF CRO101Crosby, Brent Delta PMI  128.00 -128.0002/25/2020

AF Reed, Sandy Acme Insurance Co  128.00 -128.0002/25/2020

AF WIN100Winters, Carl Lincoln National  286.40 -200.40 -86.0002/25/2020

A B C D
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How do I run the Patient Revenue List by Payer Report?
From the DXOne Reporting module, select List, and then double-click Patient Revenue List By 
Payer. For additional details about running this report, see the “Patient Revenue List by Payer 
Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu 
of any module, click Contents).

What important information does this report provide?
You can hide the patient names by selecting the Do not display Patient Name check box when 
setting up the options to run this report. You can also display this report in a format that you can 
easily export to a spreadsheet program. The list is sorted by patient, date, and then payer.

A.	Payer Name, Patient Name, and Date of Service/Entry Date – The following details appear:
•	 The name of the primary dental insurance carrier of claim that has the completed procedure 

attached to it. If the procedure is not attached to a primary dental claim, the payer is blank. 
If the procedure is attached to a primary medical claim and then to primary dental claim, the 
payer is blank. For a transaction on a date that is not associated with a payer, the payer is 
blank.

•	 The last name, first name, and middle initial of the patient.
•	 The date of service (if the report was run by Procedure Date) or entry date (if the report was 

run by Entry Date).

B.	 Total Charges by Service Date/Entry Date – The sum of the charges affecting the family 
balance:
•	 Completed procedures
•	 Charge adjustments
•	 Insurance charge adjustments

•	 Finance and late charges
•	 Charge initial balances
•	 Charge special adjustments

C.	 Total Payments by Service Date/Entry Date – The sum of the payments affecting the family 
balance:
•	 Guarantor payments •	 Insurance payments

D.	Total Adjustments by Service Date/Entry Date – The sum of the other credits affecting the 
family balance:
•	 Credit adjustments
•	 Credit initial balances

•	 Credit special adjustments

Notes:
•	 Allocation date as it relates to showing a portion of a payment should not be considered on the 

report however allocations as they tie back to charges should be considered.

For example, a given patient has the following on a given date:

•	 A completed procedure for $100.00 that is attached to a claim for a given payer (Aetna).

•	 A guarantor payment of $50.00, with $25.00 of it being applied to the completed 
procedure, and the remaining $25.00 is suspended.

Then, the $25.00 that was applied the completed procedure and is attached to a claim appears 
on the line where Aetna is the payer. The guarantor payment of $25.00 appears on a line where 
the payer is blank because this portion is not associated with a payer.

•	 Allocated credits should inherit from the associated charge clinic. This essentially means that 
the report is run by “rendering clinic.”  Any portion of a credit not associated with a charge will 
use the clinic associated with that credit.
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Patient Route Slip
The Patient Route Slip report allows you to print route slips for each appointment scheduled on a 
selected date or date range.

Why:	 To review patient details prior to an appointment, and to communicate work 
between the back office and front office

When:	 Daily, and as needed

TOTAL:

APPOINTMENT INFORMATION

PATIENT INFORMATION

ACCOUNT INFORMATION INSURANCE INFORMATION

HOME:

SOC SEC NUMBER:
EMPLOYER:

MEDICAL ALERTS:

LAST REFERRED BY:

Patient Notes:

WORK:

SECONDARY PROVIDER:
FIRST VISIT DATE:

LAST PROPHYLAXIS:

YEARS AS A PATIENT:
LAST VISIT DATE: CCDATES:

MISSED APPT NUM:

0==>30 31==>60 61==>90 91==> INS EST BALANCE

FAMILY CLAIMS PENDING

NOTES:

DATE TIME PROVIDER REASON

CHART NUMBER: LAST REFERRED TO:

LAST GRATUITY:
LAST REFERRAL:# REFERRALS:

EMPLOYER:
SOC SEC NUMBER:

DATE ORDER TOOTH CODE PROCEDURE AMOUNT

LAST PAYMENT: LAST PMT AMT:
BILLING TYPE: LAST STATEMENT:

HOME: WORK:

NAME POSITION GEN BIRTHDAY AGE LAST VISIT LAST PROPHY CCDATE NEXT APPT TP

APPT STATUS:

SCHEDULED TIME:

OPERATORY: PROVIDER:

APPT DATE: TIME: APPT AMOUNT:

PRIMARY PROVIDER:PATIENT NAME: PATIENT CLAIMS PENDING 

PRIMARY CARRIER:
SUBSCRIBER:
EMPLOYER:
GROUP NUMBER:

SECONDARY CARRIER:

MAXIMUM BENEFITS:

PREV: BASIC: MAJOR: ORTHO:

SUBSCRIBER:
EMPLOYER:

BENEFITS REMAINING:
DED OWED S/P/O:
BENEFITS USED:

GROUP NUMBER:
BENEFITS REMAINING:

DED OWED S/P/O:
BENEFITS USED:

MAXIMUM BENEFITS:

PREV: BASIC: MAJOR: ORTHO:

GUARANTOR NAME:

PATIENT ROUTE SLIP

Copyright © 1987-2018 Henry Schein, Inc. DLRTE 1

NEXT PAYMENT: PAYMENT DUE:

Tuesday - March 8, 2018 at 9:50am For Mr. Brent L Crosby

Mr. Brent L Crosby
123 E Everberry Ln
Eastside, NV 11111

(801)555-5969 (801)555-6600

Allied Plumbing

000-00-0005 CR001

DDS1

04/14/2015 5
07/02/2017 01/03/2018 BITEWINGS

07/02/2017 01/03/2018 PROPHY
LAST MISSED APPT:0

0

Mr. Brent L Crosby
123 E Everberry Ln
Eastside, NV 11111

(801)555-5969 (801)555-6600
Allied Plumbing

000-00-0005

 1
0.00

NA NA

133.00 0.00 0.00 0.00 0.00 133.00

Ameritas
Brent L Crosby (Self)

Allied Plumbing
11220 2000.00
1340.00 Jan 660.00
PAT--50/50/0, FAM-0/0/0

100% 80% 50% 50%

Connecticut General
Shirley H Crosby (Spouse)

65001 2000.00
0.00 Jan 2000.00
PAT-0/25/0, FAM-0/0/0

100% 80% 50% 50%

03/08/2018  9:50am 120 Minutes 587.00

OP-4 DDS1
The patient has a sever tooth ache.

*Mr. Brent L Crosby Married M 11/11/1967 43 07/02/2017 07/02/2017 01/03/2018(+)
Mrs. Shirley H Crosby Married F 11/11/1969 41 01/01/2018 01/06/2018 01/07/2019 (+)

04/04/2018(+)   S  
N

(2 of 2)

03/08/2018  1 30 D7140 Extract,erupted th/exposed rt 587.00
 2 30 D2750 Crown-porc fuse high noble mtl 749.00
 2 30 D6010 Surg place implant: endosteal 1540.00

04/04/2018 D0160 Detail/extensive oral eval, B/R 91.00
04/04/2018 D7260 Oroantral fistula closure 369.00
05/02/2018 90620 Exam and consultation 583.00

3919.00

04/04/2018 10:00am DDS1 ExtEval, OrlAntFsC
05/02/2018 11:00am DDS1 ExConsult

A

B C

D

E

F
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How do I run the Patient Route Slip?
1.	 In the Office Manager, from the Reports menu, point to Lists, and then click Daily 

Appointment List.

2.	 Ensure the Patient Route Slips option is selected.

3.	 Click OK.

OR

From the Appointment Book, right-click an appointment, and select Print Route Slip.

For step-by-step instructions on how to run this report, see the “Daily Appointment List” and 
“Route slip” topics in the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
A.	Patient Information – The patient’s contact information, employer, preferred provider(s), 

number of years as a patient, number of missed appointments, and referral information.

If a certain clinic setting is enabled, this section also 
includes the patient’s financial information: aged 
balances, estimated insurance portion, suspended 
credits, balance, and estimated patient portion 
(Balance + Appt Amount – Ins Est). The estimated 
insurance portion is the insurance estimate for the 
procedures attached to the appointment for which 
the route slip is generated. However, if the clinic 
setting is not enabled, the financial information does 
not appear.

B.	 Account Information – The guarantor’s information and the financial information for the 
account: aged balances, estimated insurance portion, suspended credits, and balance.

If a certain clinic setting is enabled, this section 
also includes the estimated guarantor portion 
(Balance + Appt Amount – Ins Est). The estimated 
insurance portion includes the insurance estimate 
for other family members’ completed procedures 
(whether or not they are attached to a claim) and 
includes the insurance estimate for the procedures 
attached to the appointment for which the route 
slip is generated. However, if the clinic setting is not 
enabled, the estimated guarantor portion does not 
appear, and the estimated insurance portion is the 
insurance estimate for the patient’s and the other family members’ completed procedures.

C.	 Insurance Information – The patient’s primary and secondary insurance information.

D.	Continuing Care – The patient’s continuing care due date and next appointment date.

E.	 Appointment Information – The procedures to be completed during the current appointment.

F.	 Future Appointments – The dates and times of the patient’s future appointments.
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Patient Treatment Case Report
The Patient Treatment Case Report displays treatment plan cases for a specific patient within 
specific procedure and case expiration dates. The report may also include items, such as patient 
and family account balances and dental insurance plan maximums and deductibles.

Why:	 To print the treatment cases created for a patient

When:	 As needed
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How do I run the Patient Treatment Case Report?
1.	 In the Treatment Planner, select the appropriate patient.

2.	 From the File menu, point to Print, and then click Patient Treatment Case Report.

For additional details about running this report, see the “Printing the Patient Treatment Case 
Report” topic in the Treatment Planner portion of the Dentrix Enterprise Help (from the Help menu 
of any module, click Contents).

What important information does this report provide?
A.	Treatment – The treatment-planned procedures are grouped by visit. A subtotal of fees, patient 

portions, and insurance estimates for each visit are given.

B.	 Case Totals – The total fees, patient portions, and insurance estimates totals for all visits in the 
case.

C.	 Other Totals – The treatment plan total, estimated insurance portion, deductible to be applied, 
estimated patient portion, and patient and family account balances.

D.	Insurance Benefits – Details of the current insurance plan maximums and deductibles for the 
patient are shown.



Dentrix Enterprise 11.0.2 Reports Reference

230   Patient’s Ledger Report

Patient’s Ledger Report
The Patient’s Ledger Report displays all transactions posted to the Ledger for an individual patient. 
Depending on report settings, the total family balance, individual family balances, and guarantor 
payments and adjustments also appear on this report.

Why:	 To provide a patient with a record of his or her transactions

When:	 As needed

PATIENT'S LEDGER REPORT 
The Dentist Group

Page:Date: 04/23/2018 1

Patient Name: Chart Number:

Billing Type:

James S Abbott
123 S Oak St
Murray, UT  84123

ABB101

2

DATE TEETH DESCRIPTION PATIENT CHARGE PAYMENT BALANCE

03/23/2018 Balance Forward 6407.84 6407.84
04/22/2018  5            Post/core + brdg retainer, fabr James 230.00 6637.84
04/22/2018 Prophylaxis-adult James 0.00 6637.84
04/22/2018 Periodic oral evaluation James 0.00 6637.84
04/22/2018 Bitewings-four films James 0.00 6637.84
04/22/2018 Panoramic film James 0.00 6637.84
04/22/2018 Professional Discount <Family> -10.00 6627.84
04/22/2018 Check Payment - Thank You <Family> -125.00 6502.84
04/23/2018  6            Extraction-single tooth James 71.00 6573.84

TOTAL PATIENT BALANCE AS OF 04/23/2018:   6573.84

A

B

C
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How do I run the Patient’s Ledger Report?
In the Office Manager, from the Reports menu, point to Ledger, and then click Patient’s Ledger 
Report. For additional details about running this report, see the “Patient’s Ledger Report” topic 
in the Office Manager portion of the Dentrix Enterprise Help (from the Help menu of any module, 
click Contents).

What important information does this report provide?
A.	Patient Details – The patient’s name, street address, chart number, and billing type.

B.	 Patient History – All transactions posted to the patient’s Ledger during the date range of the 
report.

C.	 Total Patient Balance – The patient’s current balance.
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Payment Agreement Amortization 
Schedule
The Payment Agreement Amortization schedule displays an amortization schedule for a patient’s 
payment agreement. You might want to print this report and provide it to patients at the time a 
payment agreement is created.

Why:	 To provide patients with an amortization schedule

When:	 After creating a payment agreement, and as needed

PAYMENT AGREEMENT AMORTIZATION
The Allied Dentist Group

Date: Page:05/15/2018 1

Guarantor Name: Chart Number:
Payment Interval:

Abbott, Patricia ABB102
Monthly

 # DATE DUE AGREED INTEREST PRINCIPAL BALANCE
PAYMENT 12 % Annual
AMOUNT f / 12 = f 5956.04

1 04/30/2018   1000.00 59.56 940.44         5015.60
2 05/30/2018 1000.00 50.16 949.84 4065.76
3 06/30/2018 1000.00 40.66  959.34 3106.42
4 07/30/2018 1000.00 31.06   968.94 2137.48
5 08/30/2018 1000.00 21.37 978.63 1158.85
6 09/30/2018   1000.00 11.59 988.41 170.44

TOTALS 6000.00 214.40 5785.60

A
B
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How do I run the Payment Agreement Amortization 
Schedule?
1.	 From the Ledger, click the Payment Agreement button to open the Billing/Payment 

Agreement Information dialog box.

2.	 Click Print to open the Print for Payment Agreement dialog box.

3.	 Select Amortization of Payments and Finance Charges.

4.	 Click Print or Send to Batch.

For additional details about running this report, see the “Printing payment agreement documents” 
topic in the Ledger portion of the Dentrix Enterprise Help (from the Help menu of any module, 
click Contents).

What important information does this report provide?
A.	Payment Details – The payment due date, amount, interest to be applied, amount to be 

applied to principal, and balance of the financed amount.

B.	 Totals – The total amount paid by the end of the finance period, interest to be paid, and 
principal to be paid.
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Payment Agreement Report
The Payment Agreement Report lists the payment agreements that have not been completed.

Why:	 To ensure the practice follows up with guarantors that fail to make payments, to 
identify and assist guarantors prone to default on the agreement, and to reduce 
the amount of bad debt the practice writes off

When:	 As frequently as your patients are required to make payments

PAYMENT AGREEMENT REPORT
For Provider(s):  <ALL> - <ALL>

Date:  04/23/2018 Page: 1

GUARANTOR NAME PHONE# PA DATE BAL FOR PA AGREE AMT NEXT PMT DATE LAST PMT DATE
BT/PROV FC%/GRACE 1st PMT BAL REMAIN TOT.# PMTS NEXT AMT DUE LAST PMT AMT

LAST LATE CHARGE DATE/AMOUNT PA INTERVAL ACCT BAL REM.# PMTS AMT PAST DUE # PMTS MISSED
Reeves, Joshua                 (919)555-1978    04/23/2018 7800.00 1000.00 05/01/2018

1/DDS2 12.000/0 05/01/2018 7800.00 9 1000.00 0.00
none monthly 0.00 9 0.00 0

Jeff has paid once a month and will begin payments 13 days from the date of this payment agreement to coincide with his monthly pay check.
Taylor, Mark L (919)555-1045   04/23/2018 180.00 20.00 04/30/2018

1/DDS2 12.000/0 04/30/2018 180.00 10 20.00 0.00
none monthly 180.00 10 0.00 0

TOTAL # OF PAYMENT AGREEMENTS: 2
TOTAL BALANCES REMAINING: 7980.00

TOTAL ACCOUNT BALANCES: 180.00
TOTAL AGREED PAYMENT AMOUNTS: 1020.00

TOTAL AMOUNTS PAST DUE: 0.00
TOTAL AMOUNTS DUE: 1020.00

PAYMENT AGREEMENT REPORT
For Provider(s):  <ALL> - <ALL>

Date:  04/23/2018 Page: 1

GUARANTOR NAME PHONE# PA DATE BAL FOR PA AGREE AMT NEXT PMT DATE LAST PMT DATE
BT/PROV FC%/GRACE 1st PMT BAL REMAIN TOT.# PMTS NEXT AMT DUE LAST PMT AMT

LAST LATE CHARGE DATE/AMOUNT PA INTERVAL ACCT BAL REM.# PMTS AMT PAST DUE # PMTS MISSED
Reeves, Joshua                 (919)555-1978    04/23/2018 7800.00 1000.00 05/01/2018

1/DDS2 12.000/0 05/01/2018 7800.00 9 1000.00 0.00
none monthly 0.00 9 0.00 0

Jeff has paid once a month and will begin payments 13 days from the date of this payment agreement to coincide with his monthly pay check.
Taylor, Mark L (919)555-1045   04/23/2018 180.00 20.00 04/30/2018

1/DDS2 12.000/0 04/30/2018 180.00 10 20.00 0.00
none monthly 180.00 10 0.00 0

TOTAL # OF PAYMENT AGREEMENTS: 2
TOTAL BALANCES REMAINING: 7980.00

TOTAL ACCOUNT BALANCES: 180.00
TOTAL AGREED PAYMENT AMOUNTS: 1020.00

TOTAL AMOUNTS PAST DUE: 0.00
TOTAL AMOUNTS DUE: 1020.00

A B C
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How do I run the Payment Agreement Report?
In the Office Manager, from the Reports menu, point to Ledger, and then click Payment 
Agreement Report. For additional details about running this report, see the “Payment Agreement 
Report” topic in the Office Manager portion of the Dentrix Enterprise Help (from the Help menu of 
any module, click Contents).

What important information does this report provide?
A.	Original Agreement Details – In addition to the name and phone number of the guarantor, the 

following information is included:

•	 PA Date – The date of the payment agreement.

•	 Bal For PA – The original balance of the payment agreement.

•	 Agree Amt – The monthly payment amount.

B.	 Future Transactions

•	 Next Pmt Date – The next payment due date.

•	 Next Amt Due – The next payment amount.

C.	 Current Status:

•	 Last Pmt Date – The guarantor’s last payment date.

•	 Last Pmt Amt – The amount of the guarantor’s last payment.

•	 Rem # Pmts – The number of payments remaining.

•	 Bal Remain – The remaining balance of the payment agreement.

•	 Acct Bal – The guarantor’s current account balance.

D.	PA Notes – If you check Print Last PA Note when setting options for the report, the last 
payment agreement note prints on the report.
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Payment Summary Report
The Payment Summary Report displays totals by payment type.

Why:	 To verify bank and credit processing statements, to compare collection agencies, 
and to view payment totals by payment types

When:	 As needed

Payment Summary
05/01/2018 - 05/05/2018 Procedure Date 

Clinics: <ALL>
Providers: <ALL>

Billing Type: <ALL>
Payment Types: <ALL>

Page 1 of 1Report Date: 05/05/2018 Report Generated By: enterprise

Quantity Total Average PercentDescription

3 -140.00 -46.67 %25.93Cash Payment - Thank You
4 -200.00 -50.00 %37.04Check Payment - Thank You
2 -23.96 -11.98 %4.44Credit Card Payment -Thank You
4 -176.00 -44.00 %32.60Dental Insurance - Primary

Grand Totals
13 -539.96Totals -41.54

DCB
E

A
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How do I run the Payment Summary Report?
From the DXOne Reporting module, select Analysis, and then double-click Payment Summary. 
For additional details about running this report, see the “Payment Summary Report” topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
A.	Quantity – The number of payments received.

B.	 Total – The total dollar amount of payments received.

C.	 Average – The average payment amount (Total / Quantity).

D.	Percent – The payment total compared to all payments (Total / Total Of All Payments). The 
percent column assists you in comparing the most popular payment types. The higher the 
percentage, the more revenue was brought in by the payment type.

E.	 Grand Totals – The Grand Totals section includes the quantity, total, and average for all the 
payments on the report.
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Perio - Combined Graphic & Data 
Chart Report
The Perio - Combined Graphic & Data Chart Report is a data chart and graphical representation of 
all periodontal data collected during a perio examination.

Why:	 To provide a patient with the results of his/her perio exam

When:	 After completing a perio exam, and as needed

Perio Examination
Patient: James S. Abbott Date: 05/15/2018

Birthdate: SS#: 11/11/1960 000-00-0000Chart #: ABB101
Provider: Dennis D. Smith D.D.S.

Phone: (801)555-9300
Office: 123 E. Valley Drive # 500

American Fork, UT  84003

Provider's Signature: Date:

DCM DCM DCM DCM DCM DCM DCM DCM MCD MCD MCD MCD MCD MCD MCD MCD
PD 1 1 1 4 1 4 1 1 2 2 2 2 3 2 3 3 3 2 3 2 3 3 3 3 3 2 2 2 1 3 1 1 1 PD
GM GM
CAL 1 1 1 4 1 4 1 1 2 2 2 2 3 2 3 3 3 2 3 2 3 3 3 3 3 2 2 2 1 3 1 1 1 CAL
MG MG

DCM DCM DCM DCM DCM DCM DCM DCM MCD MCD MCD MCD MCD MCD MCD MCD
PD 1 3 2 1 3 3 2 3 1 3 2 1 3 2 3 3 3 3 4 3 2 4 3 2 1 3 2 4 3 1 2 3 2 PD
GM GM
CAL 1 3 2 1 3 3 2 3 1 3 2 1 3 2 3 3 3 3 4 3 2 4 3 2 1 3 2 4 3 1 2 3 2 CAL
MG MG

 RIGHT LEFT 

MG MG
CAL 1 1 3 2 1 2 2 1 2 3 3 3 3 2 1 4 3 2 1 3 2 2 2 3 1 4 3 3 2 1 4 4 3 2 3 2 1 3 2 1 1 3 CAL
GM GM
PD 1 1 3 2 1 2 2 1 2 3 3 3 3 2 1 4 3 2 1 3 2 2 2 3 1 4 3 3 2 1 4 4 3 2 3 2 1 3 2 1 1 3 PD

DCM DCM DCM DCM DCM DCM DCM DCM MCD MCD MCD MCD MCD MCD MCD MCD

© Dentrix 1990 - 2018

MG MG
CAL 3 4 1 3 1 2 3 2 3 4 1 2 1 3 2 3 2 2 2 3 4 1 2 3 2 2 3 1 2 3 2 3 1 2 3 1 2 1 2 3 1 2 CAL
GM GM
PD 3 4 1 3 1 2 3 2 3 4 1 2 1 3 2 3 2 2 2 3 4 1 2 3 2 2 3 1 2 3 2 3 1 2 3 1 2 1 2 3 1 2 PD

DCM DCM DCM DCM DCM DCM DCM DCM MCD MCD MCD MCD MCD MCD MCD MCD

 9 8

2425

10 7

2326

11 6

2227

12 5

2128

13 4

2029

14 3

1930

15 2

1831

16 1

1732

M
A
N
D
I
B
U
L
A
R

M
A
X
I
L
L
A
R
Y

L
I
N
G
U
A
L

L
I
N
G
U
A
L

F
A
C
I
A
L

F
A
C
I
A
L

D = Distal 
C = Central 
M = Mesial 

GM = Gingival Margin CAL = Clinical Attachment Level MG = Mucogingival Junction
Bleeding Suppuration Bleeding and Suppuration

Furcation: F1 F2 F3 F4 Mobility: 1 2 3 4 PD = Prb Depth
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How do I run the Perio - Combined Graphic & Data Chart 
Report?
From the Perio Chart, from the File menu, click Print. For additional details about running this 
report, see the “Printing Perio Chart reports” topic in the Perio Chart portion of the Dentrix 
Enterprise Help (from the Help menu of any module, click Contents).

Note: This report prints in a landscape format.

What important information does this report provide?
This report contains the following perio exam results:

•	 Probing Depth

•	 Bleeding/Suppuration

•	 Gingival Margin

•	 Clinical Attachment Level

•	 Mucogingival Junction

•	 Plaque/Mobility/Bone Loss

•	 Furcation Grade

•	 Maxillary/Mandibular Tooth Codes

Note: A legend is provided below the chart.
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Perio - Data Chart Report
The Perio - Data Chart Report is a table of all periodontal data collected during a periodontal 
examination.

Why:	 To provide a patient with the results of his/her periodontal exam

When:	 After completing a periodontal exam, and as needed

The Allied Dentist Group
123 East Valley Dr

American Fork, UT 84003
(801)555-9300

Patient: James S. Abbott Report Date: 05/15/2018
Exam by: Dennis D. Smith D.D.S. Exam Date:  05/15/2018

MAXILLARY TOOTH NUMBER:  1  2  3  4  5  6  7  8  9 10 11 12 13 14 15 16
D C M D C M D C M D C M D C M D C M D C M D C M M C D M C D M C D M C D M C D M C D M C D M C D

Probing Depth            - Facial   -  1 1 1 4 1 4 1 1 2 2 2 2   -  3 2 3 3 3 2 3 2 3   -  3 3 3 3 2 2   -  2 1 3 1 1 1   -  
 - Lingual   -  1 3 2 1 3 3 2 3 1 3 2 1   -  3 2 3 3 3 3 4 3 2   -  4 3 2 1 3 2   -  4 3 1 2 3 2   -  

Bleeding/Suppuration      - Facial   - -    - -    - 
- Lingual   - -    - -    - 

Gingival Margin           - Facial   - -    - -    - 
- Lingual   - -    - -    - 

Clinical Attachment Level  - Facial   -  1 1 1 4 1 4 1 1 2 2 2 2   -  3 2 3 3 3 2 3 2 3   -  3 3 3 3 2 2   -  2 1 3 1 1 1   -  
 - Lingual   -  1 3 2 1 3 3 2 3 1 3 2 1   -  3 2 3 3 3 3 4 3 2   -  4 3 2 1 3 2   -  4 3 1 2 3 2   -  

Mucogingival Junction     - Facial   - -    - -    - 
- Lingual   - -    - -    - 

Plaque/Mobility/Bone Loss   -    -    -    -    -  

Furcation Grade          - Buccal   -    -    -    -    -  
 - Lingual   -    -    -    -    -  

Maxillary Tooth Codes M C M C M M M

MANDIBULAR TOOTH NUMBER: 32 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17
D C M D C M D C M D C M D C M D C M D C M D C M M C D M C D M C D M C D M C D M C D M C D M C D

Probing Depth            - Facial   -  3 4 1 3 1 2 3 2 3 4 1 2 1 3 2 3 2 2 2 3 4 1 2 3 2 2 3 1 2 3 2 3 1 2 3 1 2 1 2 3 1 2   -  
 - Lingual   -  1 1 3 2 1 2 2 1 2 3 3 3 3 2 1 4 3 2 1 3 2 2 2 3 1 4 3 3 2 1 4 4 3 2 3 2 1 3 2 1 1 3   -  

Bleeding/Suppuration      - Facial   - -  
 - Lingual   - -  

Gingival Margin           - Facial   - -  
 - Lingual   - -  

Clinical Attachment Level  - Facial   -  3 4 1 3 1 2 3 2 3 4 1 2 1 3 2 3 2 2 2 3 4 1 2 3 2 2 3 1 2 3 2 3 1 2 3 1 2 1 2 3 1 2   -  
 - Lingual   -  1 1 3 2 1 2 2 1 2 3 3 3 3 2 1 4 3 2 1 3 2 2 2 3 1 4 3 3 2 1 4 4 3 2 3 2 1 3 2 1 1 3   -  

Mucogingival Junction     - Facial   - -  
 - Lingual   - -  

Plaque/Mobility/Bone Loss   -    -  

Furcation Grade          - Buccal   -    -  
- Lingual   -    -  

Mandibular Tooth Codes M M
LEGEND

TOOTH CODES GINGIVA PROBING CODES PLAQUE BONE LOSS OTHER CODES
M Missing  0 to 9  mm below the CEJ   1 - Light 1 - Mild  B  Bleeding
U Unerupted >   >9  mm below the CEJ 2 - Moderate 2 - Moderate  S  Suppuration
P Pontic A    1  mm above the CEJ 3 - Heavy 3 - Severe * Bleeding & Suppuration
I Implant B    2  mm above the CEJ
C Crown C    3  mm above the CEJ > Greater than 9 mm
IC Implant+Crown D    4  mm above the CEJ
ID Impacted Distal E   >4  mm above the CEJ
IM Impacted Mesial
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How do I run the Perio - Data Chart Report?
From the Perio Chart, from the File menu, click Print. For additional details about running this 
report, see the “Printing Perio Chart reports” topic in the Perio Chart portion of the Dentrix 
Enterprise Help (from the Help menu of any module, click Contents).

Note: This report prints in a landscape format.

What important information does this report provide?
This report contains the following perio exam results:

•	 Probing Depth

•	 Bleeding/Suppuration

•	 Gingival Margin

•	 Clinical Attachment Level

•	 Mucogingival Junction

•	 Plaque/Mobility/Bone Loss

•	 Furcation Grade

•	 Maxillary/Mandibular Tooth Codes

Note: A legend is provided below the chart.
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Perio - Exam Comparison Report
The Perio - Exam Comparison Report compares the results of two or more periodontal 
examinations using data and graphical charts (depending on the data being compared).

Why:	 To provide the patient with the results of a periodontal examination

When:	 After completing a periodontal exam, and as needed

The Allied Dentist Group
123 East Valley Dr

American Fork, UT 84003
(801)555-9300

Patient: James S. Abbott Report Date: 05/15/2018

Probing Depth Comparison

MAXILLARY TOOTH #

MANDIBULAR TOOTH #

 1

32

 2

31

 3

30

 4

29

 5

28

 6

27

 7

26

 8

25

 9

24

10

23

11

22

12

21

13

20

14

19

15

18

16

17

DCM

DCM

DCM

DCM

DCM

DCM

DCM

DCM

DCM

DCM

DCM

DCM

DCM

DCM

DCM

DCM

MCD

MCD

MCD

MCD

MCD

MCD

MCD

MCD

MCD

MCD

MCD

MCD

MCD

MCD

MCD

MCD

Facial                12/15/2017 5 4 5 6 1 1 1 8 8 8 1 8 9 1 2 1 6 5 1 3 1 6 5 1 3 2 1 6 1 6 5 1 1 6 5 1 5 6 1 3 1 6 3 5 1   M
Change

05/15/2018    M 1 1 1 4 1 4 1 1 2 2 2 2    M 3 2 3 3 3 2 3 2 3    M 3 3 3 3 2 2    M 2 1 3 1 1 1   M
Lingual               12/15/2007 3 3 6 6 1 5 1 1 1 1 2 5 6 1 3 4 5 6 1 2 3 1 5 3 4 6 5 1 3 5 1 1 5 1 5 3 1 3 1 1 5 1 3 1 5   M

Change
05/15/2018    M 1 3 2 1 3 3 2 3 1 3 2 1    M 3 2 3 3 3 3 4 3 2    M 4 3 2 1 3 2    M 4 3 1 2 3 2   M

Facial                12/15/2017 3 1 1 5 1 5 1 1 5 1 6 3 1 5 6 1 5 3 2 1 2 3 1 6 6 6 1 6 1 6 1 3 2 1 3 1 3 1 6 5 4 6 5 1 3 1 6 5
Change

05/15/2018    M 3 4 1 3 1 2 3 2 3 4 1 2 1 3 2 3 2 2 2 3 4 1 2 3 2 2 3 1 2 3 2 3 1 2 3 1 2 1 2 3 1 2   M
Lingual               12/15/2017 4 4 4 4 5 1 4 5 1 4 5 1 1 4 4 4 5 1 2 1 5 6 6 3 5 5 6 2 2 1 1 5 1 2 1 2 4 4 5 3 1 2 3 1 6 5 6 4

Change
05/15/2018    M 1 1 3 2 1 2 2 1 2 3 3 3 3 2 1 4 3 2 1 3 2 2 2 3 1 4 3 3 2 1 4 4 3 2 3 2 1 3 2 1 1 3   M

LEGEND
TOOTH CODES GINGIVAL MARGIN (GM) PROBING CODES CHANGE SYMBOLS

M  Missing
U  Unerupted
P  Pontic
I  Implant
C  Crown
IC Implant+Crown
ID Impacted Distal            
IM Impacted Mesial            

 0 to 9  mm below the CEJ     
>   >9  mm below the CEJ
A    1  mm above the CEJ
B    2  mm above the CEJ
C    3  mm above the CEJ
D    4  mm above the CEJ
E   >4  mm above the CEJ

>1mm and 2mm worse
>2mm worse
>1mm and 2mm better
>2mm better
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How do I run the Perio - Exam Comparison Report?
From the Perio Chart, from the File menu, click Print. For additional details about running this 
report, see the “Printing Perio Chart reports” topic in the Perio Chart portion of the Dentrix 
Enterprise Help (from the Help menu of any module, click Contents).

Note: This report prints in a landscape format.

What important information does this report provide?
Printing a comparison of exams is only possible if you are viewing a comparison. To indicate the 
exams you want to compare, from the Options menu in the Perio Chart, click Exam Comparison. 
This report displays the following changes since the previous perio exam:

•	 Probing Depths are presented in a data chart.

•	 Gingival Margins are presented in a data or graphical chart.

•	 Clinical Attachment Levels are presented in a data or graphical chart.

•	 Mobility is presented in a data chart.

•	 Furcation Involvement is presented in a data chart.

Note: A legend is provided below the chart.
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Perio - Graphic Chart Report
The Perio - Graphic Chart Report is a graphical representation of all periodontal data collected 
during a periodontal examination.

Why:	 To provide a patient with the results of his or her periodontal exam

When:	 After completing a periodontal exam, and as needed

Perio Examination
Patient: James S. Abbott Date: 05/15/2018

Birthdate: SS#: 11/11/1960 000-00-0000Chart #: ABB101
Provider: Dennis D. Smith D.D.S.

Phone: (801)555-9300
Office: 123 E. Valley Drive # 500

American Fork, UT  84003

Provider's Signature: Date:

 9 8
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Gingival Margin Clinical Attachment Level
Bleeding Suppuration Bleeding and Suppuration

Furcation: F1 F2 F3 F4 Mobility: 1 2 3 4 Prb Depth

© Dentrix 1990 - 2018 
Mucogingival Junction
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How do I run the Perio - Graphic Chart Report?
From the Perio Chart, from the File menu, click Print. For additional details about running this 
report, see the “Printing Perio Chart reports” topic in the Perio Chart portion of the Dentrix 
Enterprise Help (from the Help menu of any module, click Contents).

Note: This report prints in a landscape format.

What important information does this report provide?
This report contains the following perio exam results:

•	 Probing Depth

•	 Bleeding/Suppuration

•	 Gingival Margin

•	 Clinical Attachment Level

•	 Mucogingival Junction

•	 Mobility

•	 Furcation Grade

Note: A legend is provided below the chart.
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Perio - Pocket Depths Only Report
The Perio - Pocket Depths Only Report is a table of the pocket depths recorded during a 
periodontal examination.

Why:	 To provide a patient with the results of his/her periodontal exam

When:	 After completing a periodontal exam, and as needed

The Allied Dentist Group
123 East Valley Dr

American Fork, UT 84003
(801)555-9300

Patient: James S. Abbott
Exam by: Dennis D. Smith D.D.S.

Report Date: 05/15/2018  
Exam Date:   05/15/2018

MAXILLARY TOOTH NUMBER:  1  2  3  4  5  6  7  8  9 10 11 12 13 14 15 16
D C M D C M D C M D C M D C M D C M D C M D C M M C D M C D M C D M C D M C D M C D M C D M C D

Probing Depth            - Facial   -  1 1 1 4 1 4 1 1 2 2 2 2   -  3 2 3 3 3 2 3 2 3   -  3 3 3 3 2 2   -  2 1 3 1 1 1   -  
 - Lingual   -  1 3 2 1 3 3 2 3 1 3 2 1   -  3 2 3 3 3 3 4 3 2   -  4 3 2 1 3 2   -  4 3 1 2 3 2   -  

Maxillary Tooth Codes M C M C M M M

MANDIBULAR TOOTH NUMBER: 32 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17
D C M D C M D C M D C M D C M D C M D C M D C M M C D M C D M C D M C D M C D M C D M C D M C D

Probing Depth            - Facial   -  3 4 1 3 1 2 3 2 3 4 1 2 1 3 2 3 2 2 2 3 4 1 2 3 2 2 3 1 2 3 2 3 1 2 3 1 2 1 2 3 1 2   -  
 - Lingual   -  1 1 3 2 1 2 2 1 2 3 3 3 3 2 1 4 3 2 1 3 2 2 2 3 1 4 3 3 2 1 4 4 3 2 3 2 1 3 2 1 1 3   -  

Mandibular Tooth Codes M M
LEGEND

TOOTH CODES OTHER CODES
M Missing > Greater than 9 mm
U Unerupted
P Pontic
I Implant
C Crown
IC Implant+Crown
ID Impacted Distal
IM Impacted Mesial
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How do I run the Perio - Pocket Depths Only Report?
From the Perio Chart, from the File menu, click Print. For additional details about running this 
report, see the “Printing Perio Chart reports” topic in the Perio Chart portion of the Dentrix 
Enterprise Help (from the Help menu of any module, click Contents).

Note: This report prints in a landscape format.

What important information does this report provide?
This report contains the following periodontal exam results:

•	 Probing Depth

•	 Maxillary/Mandibular Tooth Codes

Note: A legend is provided below the chart.
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Perio Exam List
The Perio Exam List displays the periodontal exams the practice has performed for a selected date 
and/or patient range.

Why:	 To see if the office is using the Perio Chart feature, and to view periodontal exams 
the practice has performed for a selected date and/or patient range

When:	 As needed

PERIO EXAM LIST
Dentrix Dental Practice

Date: Page:03/08/2018 1

DATE NAME

03/08/2018 Abbott, Ken S
03/08/2018 Abbott, Patricia
03/08/2018 Abbott, Timothy
03/08/2018 Brown, Mary
03/08/2018 Crosby, Brent L
03/08/2018 Crosby, Shirley H
03/08/2018 Davis, Harmon
03/08/2018 Davis, Karen
03/08/2018 Davis, Kelly
03/08/2018 Davis, Lyle
03/08/2018 Edwards, Anna
03/08/2018 Edwards, John
03/08/2018 Edwards, Kimberly
03/08/2018 Farrer, Lisa
03/08/2018 Gleason, Alice
03/08/2018 Gleason, Gary N
03/08/2018 Hansen, Corey L
03/08/2018 Hayes, Sally
03/08/2018 Little, Brian
03/08/2018 Little, Carol
03/08/2018 Little, Chad
03/08/2018 Little, Dean
03/08/2018 Little, Kevin
03/08/2018 Myers, Teresa
03/08/2018 Myers, Timothy
03/08/2018 Perkins, Allen
03/08/2018 Perkins, Peggy
03/08/2018 Perkins, Shelly
03/08/2018 Reeves, Elisabeth M
03/08/2018 Reeves, Joshua
03/08/2018 Schow, Lawrence P
03/08/2018 Smith, Michael
03/08/2018 Taylor, Kerri
03/08/2018 Taylor, Mark
03/08/2018 Young, Tina

BA
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How do I run the Perio Exam List?
From the Office Manager, from the Reports menu, point to Lists, and then click Perio Exam 
List. For additional details about running this report, see the “Perio Exam List” topic in the 
Office Manager portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
A.	Date – The date of the perio exam.

B.	 Name – The patient for which the perio exam was performed.
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Periodontal Exam Report
The Periodontal Exam Report displays the percentage of oral health patients who received a 
periodontal exam (determined by specified ADA and/or condition codes) at least once during a 
specified time frame.

For example, you may want to track patients who received a comprehensive oral exam (ADA code 
D0150) or a periodic recall oral evaluation (ADA code D0120)—the denominator codes—and then 
received a periodontal exam (ADA code D0180)—the numerator code.

Why:	 To view statistics regarding the periodontal examinations for patients

When:	 Yearly

8 8

8

A B

C D

E

F
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How do I run the Periodontal Exam Report?
From DXOne Reporting, select Lists, and then double-click Periodontal Exam. For additional 
details about running this report, see the “Periodontal Exam Report” topic in the DXOne Reporting 
portion of the Dentrix Enterprise Help (from the Help menu of any module, click Contents).

What important information does this report provide?
The report contains the following information:

A.	Numerator – The specified ADA codes and/or conditions.

B.	 Denominator – The specified ADA codes and/or conditions.

C.	 Clinic Totals – The Numerator, Denominator, and Percent totals for the providers at a given 
clinic on the report.

D.	Provider Totals – The Numerator, Denominator, and Percent totals for a given provider who is 
attached to the Numerator and/or Denominator codes.

E.	 Details –  If you select Include Details when setting options for this report, patient names, chart 
numbers, and procedures codes (numerators and denominators) appear on the report.

F.	 Totals – The Numerator, Denominator, and Percent grand totals for all clinics on the report.
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Practice Analysis Report
The Practice Analysis report provides statistical data for production, receivables, patients, and 
financial contracts (payment agreements and future due payment plans).

Why:	 To view general practice vitality for the current day, month, year, and past three 
months

When:	 After closing out the month

Practice Analysis
Date Type: Procedure Date

Clinics: <ALL>
Providers: <ALL>

Report Generated By: enterpriseReport Date: 05/05/2018

Production Analysis Range 04/01/2017 - 05/05/2018 MTD 05/01/2018 - 05/05/2018            Avg 02/01/2018 - 04/30/2018          YTD 01/01/2018 - 05/05/2018

Beginning Balance

Charges
Non-insured Charges
Insured Charges

Sub-Total
Finance Charges
Late Charges
Debit Adjustments

TOTAL CHARGES

Credits
Guarantor Payments

Sub-Total
Credit Adjustments

TOTAL CREDITS

Ending Balance

Production Analysis is calculated according to the provider attached to transactions.

Insurance Payments

-1,609.96

-539.96

15,546.56 3,405.00 13,648.56

-141.00 -1,456.00

-411.00-91.00

28,469.56 26,291.565,957.00

188,492.90 188,492.90 188,492.90

161,633.30 182,676.90 163,657.34

%5.66 %8.40%2.37 %5.54

168,846.67

173,507.86

-363.96 -20.00 -340.00

-170.00 -50.00 -145.00

Other Debits

Other Credits

-176.00

-900.00

2,923.00
18,469.56

354.00
7,951.00

185.00
1,510.00

2,552.00
5,957.00

0.00
0.00
0.00
0.00

-71.00

0.00

2,728.00
16,376.56

354.00
7,951.00

100.00
1,510.00

-71.00

-900.00

1,732.52
58.67

1,791.19
110.67

2,650.33
33.33

503.33

5,088.85

-96.00
0.00

-96.00
-31.67

-300.00

-427.67

Current

31-60 Days

61-90 Days

Over 90 Days

Total Receivables

Credit Balances as of: 05/05/2009

Receivables Analysis

Suspended Credits

188,492.90

20,787.56

0.00

0.00

188,073.64

-20,368.30

-20,368.30

%11.03

%0.00

%0.00

%99.78

%-10.81

Activity Analysis
New Patients:

Referred Patients:

Range 04/01/2017 - 05/05/2018         MTD 05/01/2018 - 05/05/2018           Avg 02/01/2018 - 04/30/2018         YTD 01/01/2018 - 05/05/2018

18 0 122
3 0 20

Number of Missed Payments:
Number Of Families:

Insured Active Patients:
Active Patients:

Activity Analysis is calculated according to the primary provider attached to the patients.

4,593
216

3,060
83

Contract Analysis
Payment Agreements

Future Due Payment Plans

Contract Analysis is calculated according to the provider attached to the payment plans.

18,323.04

28,314.44

A

B

C

D
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How do I run the Practice Analysis Report?
From the DXOne Reporting module, select Analysis, and then double-click Practice Analysis. 
For additional details about running this report, see the “Practice Analysis Report” topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
The report is divided into the following sections:

A.	Production Analysis – Provides an overview of charges, payments, and adjustments. The 
following columns appear in this section:

•	 Range – Totals for the date range of the report.

•	 MTD – Month-to-date totals.

•	 AVG – The average for the past three months.

•	 YTD – Year-to-date totals.

B.	 Receivables Analysis – Displays outstanding balance totals. Balances are broken down by 
current, 31-60, 61-90, over 90, and suspended credits.

C.	 Activity Analysis – Breaks down the number of new patients and referred patients seen. The 
number of active patients, active patients with insurance, families, and missed payments figures 
are calculated according to the primary providers attached to patients’ records from the Family 
File. The following columns appear in this section:

•	 Range – Totals for the date range of the report.

•	 MTD – Month-to-date totals.

•	 AVG – The average for the past three months.

•	 YTD – Year-to-date totals.

D.	Contract Analysis – Displays the total of future due payment plans and payment agreements.
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Practice Organization List
The Practice Organization List displays provider information.

Why:	 To ensure provider information has been entered properly, and to keep a printed 
record of provider identification numbers on hand

When:	 After Dentrix Enterprise setup, and as needed

PRACTICE ORGANIZATION  LIST
Clinics: MESA

Providers/Staff: <ALL>

Report Date: 05/16/2018 Page 1 of 2Report Generated By: DSMITH

Clinic: MESA

Fee Schedule:
RVU Schedule:

SS#:
State ID#:

111-11-1111

1: Office
1

12345
12345

Office#:

Medicaid#:
DrugID#:

Provider#:
2222

112233
987654

TIN#:<Default>: 460909000

McClure, Angela 
Title: Dr.

ID: AMCCLURE
Clinic: MESA

Provider Name:

Address: 7856 South State
Mesa, AZ  85210

Phone: (480)555-6525  
NPI: 1234567890

BC/BS ID#: 345678
Specialty: Dentist

Provider Class: Primary

Fee Schedule:
RVU Schedule:

SS#:
State ID#:

111-11-1111

1: Office
1

1234
12345

Office#:

Medicaid#:
DrugID#:

Provider#:
4444

123456
3333

TIN#:

Hayes, Deborah 
Title: DDS

ID: DHAYES
Clinic: MESA

Provider Name:

Address: 1234
Oak St
Mesa, AZ  12345

Phone: (801)555-1234  
NPI: 123456789

BC/BS ID#: 2222
Specialty: Dentist

Provider Class: Primary

Fee Schedule:
RVU Schedule:

SS#:
State ID#:

111-11-1111

1: Office
1

154896
65491835984

Office#:

Medicaid#:
DrugID#:

Provider#:
123456

TIN#:

Robbins, David 
Title:

ID: DROBB
Clinic: MESA

Provider Name:

Address: 7856 South Marigold
Mesa, AZ  85210

Phone: (480)555-6525  
NPI: 0

BC/BS ID#: 154863
Specialty: Dentist

Provider Class: Primary

Fee Schedule:
RVU Schedule:

SS#:
State ID#:

460-93-9333

1: Office
1

123345
123541

Office#:

Medicaid#:
DrugID#:

Provider#:

TIN#:<Default>: 460939333

Kimball, Jacob A
Title:

ID: JKD1
Clinic: MESA

Provider Name:

Address: 789 W Acorn St
Mesa, AZ  84601

Phone: (801)555-7845  
NPI: 1234567890

BC/BS ID#: 132456
Specialty: Dentist

Provider Class: Primary

Smith, Mary Kaye 
Title: Office Manager

ID: MSMITH
Clinic: MESA

111-11-1111SS#:Staff Name:

Address: 76555 South State
Mesa, AZ  85210

Phone: (480)555-6525  

BA
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How do I run the Practice Organization List?
From the DXOne Reporting module, select Reference, and then double-click Practice 
Organization List. For additional details about running this report, see the “Practice Organization 
List” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of 
any module, click Contents).

What important information does this report provide?
The following report information is found in the Provider Information dialog box, which can be 
accessed in the Office Manager. For details about how to edit this information, see the “Adding, 
editing, inactivating, and reactivating providers” topic in the Office Manager portion of the Dentrix 
Enterprise Help.

A.	Provider Details – The provider’s name, title, provider ID, address, phone number, specialty, 
and provider class (primary or secondary).

B.	 Provider Numbers and Fee Schedule – The provider’s TIN, Social Security Number, state ID, 
Medicaid number, DEA number, NPI, BC/BS IDs, provider number, office number, and other ID. 
This section also includes the provider’s default fee and RVU schedules.

A

B
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Practice Statistics Report
The Practice Statistics Report allows you to review statistical information about your patients.

Why:	 To view patient demographics, and to assist you in developing strategic business 
plans

When:	 As needed

Practice Statistics
Clinics: <ALL>

Providers: <ALL>

Page 1 of 19Report Generated By: enterpriseReport Date: 04/23/2018

Total Number Entered in Family File (any status) 4,592

Number of guarantors that are active patients 3,054
Number of patients that are not guarantors 1,533

Number of guarantors that are not patients 3

Number of male patients
Number of female patients
Number of other patients
Number of unknown patients

2,818
1,769

0
0

Number of single patients
Number of married patients
Number of child patients
Number of other patients
Number of widowed patients
Number of divorced patients
Number of seperated patients

3,714
833

40
0
0
0
0

Number of patients that do not have dental insurance
Number of patients that have primary dental insurance only
Number of patients that have secondary dental insurance

Number of patients that do not have medical insurance
Number of patients that have primary medical insurance only
Number of patients that have secondary medical insurance

Number of patients that have dental and medical insurance
Number of patients that do not have dental or medical insurance

4,375
191

21

4,586
0
0

1
4,375

Patient Statistics Total Percent

100.00%
%0.07

%33.38
%66.51

%61.37
%38.52
%0.00
%0.00

%80.88
%18.14
%0.87
%0.00
%0.00
%0.00
%0.00

%95.27
%4.16
%0.46

%99.87
%0.00
%0.00

%0.02
%95.27

Age Statistics Total Percent

Patient(s) that are 0 to 2 years old
Patient(s) that are 3 to 4 years old
Patient(s) that are 5 to 6 years old
Patient(s) that are 7 to 8 years old
Patient(s) that are 9 to 10 years old
Patient(s) that are 11 to 12 years old
Patient(s) that are 13 to 14 years old
Patient(s) that are 15 to 16 years old
Patient(s) that are 17 to 20 years old
Patient(s) that are 21 to 30 years old
Patient(s) that are 31 to 40 years old
Patient(s) that are 41 to 50 years old
Patient(s) that are 51 to 60 years old
Patient(s) that are 61 to 70 years old
Patient(s) that are 71 to 80 years old
Patient(s) that are 81 years and older

1
0
0
2
1
5
9

30
123
487
287
707
881
418
124
216

%0.02

%0.11
%0.20
%0.65
%2.68
%10.61

%0.00

%6.25
%15.40

%0.00

%19.19
%9.10

%0.04

%2.70
%4.70

%0.02

Patient(s) without a birthday entered 22 %0.48
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%0.04

%2.70
%4.70

%0.02
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Continuing Care Statistics Total Percent

Number of patients that are eligible for Prophy Continuing Care 3 %0.07

Due for prophy October 2018 
Due for prophy November 2018 
Due for prophy December 2018 
Due for prophy January 2019 
Due for prophy February 2019 
Due for prophy March 2019

Due for prophy April 2018
Due for prophy May 2018
Due for prophy June 2018
Due for prophy July 2018
Due for prophy August 2018 
Due for prophy September 2018

0

0
0
0
0
0
1

0
0
0
2
0

Number of patients who are not on Prophy Continuing Care or are past due 4,632

%0.00
%0.00
%0.04
%0.00
%0.00
%0.00

%0.02
%0.00
%0.00
%0.00
%0.00
%0.00

%100.87

New Patient Statistics

New Referred New New NewReferred Referred Referred

Apr/2018
Mar/2018
Feb/2018

Jan/2018
Dec/2017
Nov/2017

Oct/2017
Sep/2017
Aug/2017

Jul/2017
Jun/2017
May/2017

0

0
0
0

0
0
0

0
6
5

0
0

0
0
0

0
0
0

0
1
0

0
0
0

Number of new patients and number of new patients who were referred, by month for the past year.

Total PercentProvider Statistics

Number of patients that prefer each provider

2 %0.04Abbott, James  (DDS7)
370 %8.06Brown, Mary D (DDS2)

1 %0.02Kenner, Spencer A (JKD1)
8 %0.17Little, Brian  (AMCCLURE)

14 %0.30Perkins, Peggy  (DROBB)
4,192 %91.29Smith, Michael D (DDS1)

Total PercentPatient by Zip Code Statistics

44 %0.96Number of patients with no zip code on file
1 %0.026447
1 %0.027828
1 %0.0200720
1 %0.0200731
3 %0.0701111
1 %0.0201129
2 %0.0401291
1 %0.0202030
2 %0.0402125
1 %0.0206001
1 %0.0206002
3 %0.0706010
2 %0.0406013
2 %0.0406026
1 %0.0206029
1 %0.0206032
1 %0.0206033
1 %0.0206034
1 %0.0206037
1 %0.0206040
1 %0.0206050
1 %0.0206066
1 %0.0206070
1 %0.0206071
1 %0.0206074
2 %0.0406078
1 %0.0206082
1 %0.0206085
1 %0.0206088
1 %0.0206089
1 %0.0206095
1 %0.0206096
1 %0.0206103
1 %0.0206105
1 %0.0206107

C

D
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1
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0
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E

F

How do I run the Practice Statistics Report?
From the DXOne Reporting module, select Management, and then double-click Practice 
Statistics. For additional details about running this report, see the “Practice Statistics Report” 
topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any 
module, click Contents).

What important information does this report provide?
A.	Patient Statistics

•	 Total number of patients.

•	 Number of guarantors that are not patients.

•	 Number of guarantors/non-guarantors.

•	 Number of male/female patients.

•	 Number of married/single/child/other/widowed/divorced/separated patients.

•	 Breakdown of patients by insurance status.

B.	 Age Statistics – A breakdown of the patients by age group.

C.	 Continuing Care Statistics – A breakdown of the number of patients due for prophy in the next 
12 months and the number of patients not on Prophy Continuing Care.

D.	New Patients – A breakdown of the number of new patients entered in the Family File in the 
past 12 months.

E.	 Provider Statistics – A breakdown of the number of patients that prefer each provider.

F.	 Patient by Zip Code Statistics – A breakdown of patients by ZIP Code.
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Practice Treatment Case Report
The Practice Treatment Case Report displays treatment plan cases for a range of patients within 
specific procedure and case expiration dates. The report may also include items, such as procedure 
details, case status history, and patient and insurance estimates.

Why:	 To print the treatment cases created in the practice

When:	 As needed
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How do I run the Practice Treatment Case Report?
In the Treatment Planner, from the File menu, point to Print, and then click Practice Treatment 
Case Report. For additional details about running this report, see the “Printing the Practice 
Treatment Case Report” topic in the Treatment Planner portion of the Dentrix Enterprise Help 
(from the Help menu of any module, click Contents).

What important information does this report provide?
A.	  Case Information – The report displays the case name, status, and severity; and a history of 

changes made to the status of the treatment plan case.

B.	 Treatment – The treatment-planned procedures are grouped by visit. A subtotal of fees, patient 
portions, and insurance estimates for each visit are given.

C.	 Case Totals – The total fees, patient portions, and insurance estimated totals for all visits in the 
case. The expiration date of the case is also shown.

D.	Other Totals – The report displays the percentage of accepted, pre-authorized, scheduled, 
completed, and referred treatment plan cases on the report in decimal format; the number of 
scheduled and unscheduled appointments for cases on the report, the total number of cases on 
the report; and the total treatment-planned amount of all cases on the report.



Dentrix Enterprise 11.0.2 Reports Reference

260   Prescription Printout

Prescription Printout
A prescription printout is a copy of a prescription for a patient, including dosage, date, refills, and 
instructions or notes for the patient.

Why:	 To quickly print a prescription

When:	 As needed

Copyright 1997-2009 Henry Schein, Inc.  RX01

PRESCRIBER: Dennis Smith
TELEPHONE: (801)555-9300
DEA NO:
NPI: 0

The Allied Dentist Group
123 East Valley Dr
American Fork UT 84003

cut here

PATIENT: James S. Abbott
ADDRESS: 123 S Pine St

Murray, UT 84123

TELEPHONE:555-1586 
DOB:     11/11/1980 
DATE: 12/22/2017

RX Erythromycin 250 mg

Disp: 24

1 tab TID

Refills: zero

DISPENSE AS WRITTEN
SIGNATURE OF PRESCRIBER

X GENERIC SUBSTITUTION PERMITTED

PATIENT: James S. Abbott DATE: 12/22/2017
PRESCRIPTION: Erythromycin 250 mg
PRESCRIBED BY: David Robb

Please advise our office immediately if you
experience an adverse reaction.  Our emergency
phone number is (555)555-5555
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How do I print a prescription?
1.	 From any module (except the Office Manager), click the Prescriptions button to open the 

Patient Prescriptions window.

2.	 Select a prescription, and click Edit to view an existing prescription (skip step 3). Or, click New 
to open the New Patient Prescription dialog box.

3.	 Enter the prescription details.

4.	 Click Print to print the prescription.

For additional details about running this report, see the topics for “Prescriptions” in the Other 
Features portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).
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Pre-Treatment Estimate Aging 
Report
The Pre-treatment Estimate Aging Report allows you to view pre-treatment estimates sent to 
insurance carriers.

Note: This report does not show pre-treatment estimates entered the same day as the report.

Why:	 To view pre-treatment estimates sent to insurance carriers

When:	 As needed

Over 0
<ALL> - <ALL>

Dental Pre-Treatment Estimate Aging
Days Past Due:
Patient Range:

<ALL>    -    <ALL>Carrier Range:
<ALL>Clinics:
<ALL>Providers:
<ALL>Billing Types:

Page 1 of 1Report Generated By: enterpriseReport Date: 04/23/2018

SUBSCRIBER

INSURANCE COMPANY/GROUP PLAN PHONE # GROUP NUM.

ID NUM TRACERSENT ON HOLD RE-SENT PATIENT NAME BIRTHDAY 1-30 31-60 61-90 91-120 TOTALTYPE ESTIMATE 121-150 151-180 181+

Allied Group Insurance Trust/Allied Group Insurance Trust (800) 555-7635 16023
Smith, Dorothy PRM       4/12/18                                                                        Smith, Dorothy  11/11/1979      600.00          0.00       0.00       0.00       0.00        0.00       0.00        900.00   900.00 

Blue Cross Blue Shield of Fl./Dental Claims (800) 555-3398 45067
Smith, Michael K PRM       4/12/18                                                                        Smith, Michael  11/11/1979      872.00          0.00       0.00       0.00       0.00        0.00       0.00        900.00   900.00

Acme Company/A.c.s. SS#
Little, Brian PRM       4/12/18                                                                       Little, Brian  11/11/1979      262.00          0.00       0.00       0.00       0.00        0.00      0.00        524.00    524.00

Insurance/Group Plan
Winters, Carl PRM       4/12/18                                                                        Winters, Carl  11/11/1979       301.00          0.00       0.00       0.00       0.00    301.00      0.00            0.00    301.00

Metropolitan Life/Metropolitan (415) 555-3222 74170
Abbott, James S PRM       4/12/18 Abbott, James S 11/11/1979      108.00          0.00       0.00       0.00   135.00        0.00      0.00            0.00   135.00

TOTAL ALL CLAIMS:

PRIMARY CLAIM TOTALS:

SECONDARY CLAIM TOTALS:

1 - 30 31 - 60 61 - 90 181+ TOTAL

0.00 0.00 0.00 135.00 2,760.002,143.00

0.00 0.00 0.00 135.00

0.00 0.00 0.00 0.00

2,760.00

0.00

ESTIMATE

2,143.00

0.00

91-120 121-150 151-180

301.00

0.00

0.00

0.00

2,324.00

0.00

2,324.000.00301.00

A

B

C
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How do I run the Pre-Treatment Estimate Aging Report?
From the DXOne Reporting module, select Ledger, and then double-click Pre-Estimate Aging. 
For additional details about running this report, see the “Pre-Estimate Aging Report” topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
A.	 Insurance Carrier – The insurance carrier name, group number, and phone number.

B.	 Estimate – The pre-treatment estimate submitted to the insurance carrier.

C.	 Aging Totals – The aged balances pre-treatment estimates included on the report.
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Pre-Treatment Estimates Not Sent 
Report
The Pre-treatment Estimates Not Sent Report lists estimates that have been created from the 
Ledger but not sent to the Batch Processor, printed, or sent through eClaims. Estimates are sorted 
by claim expiration date.

Why:	 To ensure estimates are processed after being created from the Ledger

When:	 Daily or weekly

04/23/2018 - 04/23/2018 
<ALL> - <ALL>

Dental Pre-Treatment Estimates Not Sent
Date Range:

Patient Range:
<ALL>    -    <ALL>Carrier Range:
<ALL>Clinics:
<ALL>Providers:
<ALL>Billing Types:

Page 1 of 1Report Generated By: enterprise

INSURANCE COMPANY NAME AMOUNT EXPIRESPROVIDER CLINIC

Report Date: 04/23/2018

CLAIM DATE TYPE PATIENT NAME  

04/23/2018         SEC         Abbott, James S Aetna Life and Casualty DDS01             CENTRAL
 04/23/2018         PRM        Abbott, James S Metropolitan Life DDS01 CENTRAL

898.00      10/20/2018 
654.00      07/22/2018

TOTAL OF CLAIMS NOT SENT: 1,552.00

TOTAL OF PRIMARY NOT SENT:

TOTAL OF SECONDARY NOT SENT:

654.00

898.00

B

A D C
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How do I run the Pre-treatment Estimates Not Sent 
Report?
From the DXOne Reporting module, select Ledger, and then double-click Pre-Estimates Not 
Sent. For additional details about running this report, see the “Pre-Estimates Not Sent Report” 
topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any 
module, click Contents).

What important information does this report provide?
A.	Claim Date – The date on which the estimate was created from the Ledger.

B.	 Amount – The estimate amount.

C.	 Expires – The deadline by which the claim (not the estimate) must be submitted to the 
insurance carrier after the service date. The expiration date is found in the Insurance Coverage 
dialog box. To access the Insurance Coverage dialog box, double-click the Insurance block in 
the Family File, and then click Coverage Table.

D.	Totals – The amount of the primary, secondary, and all pre-treatment estimates not sent.
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Procedure Code List
The Procedure Code List allows you to view and print the procedure codes entered in Dentrix 
Enterprise.

Why:	 To ensure Dentrix Enterprise procedure codes match current ADA codes, to 
view AMA and CPT codes associated with each procedure, and to view dental 
diagnostic codes associated with each procedure

When:	 After Dentrix Enterprise setup, and after ADA codes are updated

PROCEDURE CODE LIST
The Dentist Group

Date: Page:04/22/2018 1
Codes D0120 - D9999

CODE DESCRIPTION ABBREV DESC CPT MEDICAI CODE 5 TIME APPT TYPE PAINT TYPE TREAT. INS?
INCLUDED DIAGN. CODES INCLUDED AMA CPT CODES

D0120 Periodic oral evaluation PeriodicX 1 Low Product Mouth
D0140 Limited oral evaluation LimitedEx 2 High Produc Mouth

D5-10000 Dental Disease NOS 99201 Office Visit
D5-10001 Disease of Teeth NOS 99202 Office Visit New Patient
D5-10002 Tooth Disorder NOS 99211 Office Visit Est Patient
D5-10578 Tooth Sensitivity 99281 Emergency Dept Visit
D5-22071 Painful Lips
F-51540 Expectoration of bloody sputum
F-51541 Expectoration of hemorr sputum
F-A3610 Facial Nerve Function NOS
T-53120 Dorsal Surface of Tongue

D0145 Oral evaluation < 3 yrs of age Eval<3yrs 1 High Produc Mouth
D0150 Comp oral eval-new/estab pat CompEx 1 High Produc Mouth
D0160 Detail/extensive oral eval, B/R ExtEval 1 High Produc Mouth
D0170 Limited re-evaluation estab pat ReEval 1 Medium Pro Mouth
D0180 Comprehensive perio evaluation CmpPerEvl 1 Medium Pro Mouth
D0210 Intraoral-complete series (bw) FMX 2 High Produc Mouth
D0220 Intraoral-periapical-1st film PA1st 1 High Produc Mouth
D0230 Intraoral-periapical-each add'l PAadd 1 High Produc Mouth
D0240 Intraoral-occlusal film OcclusalX 1 High Produc Mouth
D0250 Extraoral-first film Extraor1s 1 High Produc Mouth
D0260 Extraoral-each additional film ExtraorX+ 1 High Produc Mouth
D0270 Bitewing-single film BW1Xray 1 High Produc Mouth
D0272 Bitewings-two films 2BWX 1 High Produc Mouth
D0273 Bitewings-three films 3BWX 1 High Produc Mouth
D0274 Bitewings-four films 4BWX 1 Low Product Mouth
D0277 Vertical bitewings-7 to 8 films VertBWX 1 Medium Pro Mouth
D0290 Skull &facial bone survey film SurvXray 1 High Produc Mouth
D0310 Saliography Salio 1 High Produc Mouth
D0320 TMJ arthrogram, incl injection TMJarthro 1 High Produc Mouth
D0321 Other TMJ films, by report OtherTMJX 1 High Produc Mouth
D0322 Tomographic survey Tomograph 1 High Produc Mouth
D0330 Panoramic film Pano 1 High Produc Mouth
D0340 Cephalometric film Cephalo 1 High Produc Mouth
D0350 Oral/Facial Photographic Images OralImags 1 Medium Pro Mouth
D0360 Cone beam-CT/craniofacial data CnCTReco 1 High Produc Mouth
D0362 Cone beam-2D multi img reconst Cn2dImgRc 1 High Produc Mouth
D0363 Cone beam-3D multi img reconst Cn3dImgRc 1 High Produc Mouth
D0415 Collection of microorg culture BactStud 1 High Produc Mouth
D0416 Viral Culture VrlCultr 1 High Produc Mouth
D0417 Collection of saliva sample CltSaliva 1 High Produc Mouth
D0418 Analysis of saliva sample AnlSaliva 1 High Produc Mouth
D0421 Genetic test-suscept oral dis GenetTest 1 High Produc Mouth
D0425 Caries susceptibility tests CarisTest 1 High Produc Mouth
D0431 Adjunc pre-diag test-detect muc TestMucAb 1 High Produc Mouth
D0460 Pulp vitality tests PulpVitTe 1 High Produc Mouth
D0470 Diagnostic casts DiagCasts 1 High Produc Mouth
D0471 Diagnostic photographs DiagPhoto 1 High Produc Mouth
D0472 Accession of tiss, gr exam/rpt AcTisExam 1 Medium Pro Mouth
D0473 Acc of tissue, gr mic exam/rpt AcTisGrEx 1 Medium Pro Mouth
D0474 Acc of tiss-gr mic ex surg mar AcTisDsEx 1 Medium Pro Mouth
D0475 Decalcification Procedure DecalcPrc 1 High Produc Mouth
D0476 Special stains for microorg StnsMicro 1 High Produc Mouth
D0477 Special stains-not for microorg StnsNotMi 1 High Produc Mouth
D0478 Immunohistochemical stains ImmunStns 1 High Produc Mouth

Current Dental Terminology (CDT) Copyright © 2002, 2004, 2007 American Dental Association (ADA).  All rights reserved.

A B C D
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How do I run the Procedure Code List?
From the Office Manager, from the Reports menu, point to Reference, and then click Procedure 
Code List. For additional details about running this report, see the “Procedure Code List” topic 
in the Office Manager portion of the Dentrix Enterprise Help (from the Help menu of any module, 
click Contents).

What important information does this report provide?
The following report information (with the exception of letters E and F) is found in the Procedure 
Code Editor dialog box, which can be accessed in the Office Manager. See the topics for 
“Procedure Code Setup” in the Office Manager portion of the Dentrix Enterprise Help for details 
on how to edit this information.

A.	Code – The ADA code associated with a 
procedure.

B.	 Description – The procedure’s description.

C.	 Treat – The procedure’s treatment area.

D.	INS – Indicates whether or not a procedure is set 
to be billed to insurance.

E.	 Included Dental Diagnostic Codes – The 

dental diagnostic codes associated with each 
procedure code. This information is found in 
the Medical/Cross Code Setup 
dialog box. Dental diagnostic cross 
coding must be set up for dental 
diagnostic codes to appear on this 
report. See the “Dental diagnostic 
cross coding” topic in the Dentrix 
Enterprise Help for details about 
how to set up dental diagnostic 
cross coding.

F.	 Included AMA CPT Codes – The 

AMA and CPT codes associated 

with each procedure code. This 
information is found in the Medical/
Cross Code Setup dialog box. 
Medical cross coding must be 
set up for AMA and CPT codes 
to appear on this report. See the 
“Medical cross coding” topic in the 
Dentrix Enterprise Help for details 
on how to set up medical cross 
coding.

E

F

A

B

C

D
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Procedures by Contracted Amount 
Report
The Procedures by Contracted Amount Report displays completed procedures (and other charges) 
and the payments and adjustments that are associated with those procedures (or charges). For 
each completed procedure, the contracted rate with the patient’s insurance carrier (payer) also 
appears.

Why:	 To analyze contracted rates for payers

When:	 As needed

Procedures By Contracted Amount
Date Range: 2/25/2020 - 2/25/2020 Procedure Date

Clinics: AF

Patient Range: <ALL> - <ALL>

Patient Status: <ALL>

Page 1 of 1Report Generated By: ENTERPRISEReport Date: 2/25/2020

Clinic Chart Number Patient Name ADA

Procedure

ADA

Description

Provider Name Payer Name Charge Contracted

Rate

Payment Adjustments Remainig

Balance

Date Of 

Service

AF CRO101 Crosby, Brent D0220 Intraoral-periapical-1st 

film
Dennis Smith Delta PMI  128.00 -128.00  0.0002/25/2020

AF Reed, Sandy D0120 Periodic oral evaluation Dennis Smith Acme Insurance 

Co
 128.00  80.00 -128.00  0.0002/25/2020

AF WIN100 Winters, Carl D0160 Detail/extensive oral 

eval, B/R
Dennis Smith Lincoln National  128.00 -128.00  0.0002/25/2020

AF WIN100 Winters, Carl D2391 Resin composite-1s, 

posterior
Dennis Smith Lincoln National  158.40 -72.40 -86.00  0.0002/25/2020

A B C D E F
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How do I run the Procedures by Contracted Amount 
Report?
From the DXOne Reporting module, select List, and then double-click Procedures By Contracted 
Amount. For additional details about running this report, see the “Procedures by Contracted 
Amount Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the 
Help menu of any module, click Contents).

What important information does this report provide?
You can hide the patient names by selecting the Do not display Patient Name check box when 
setting up the options to run this report. You can also display this report in a format that you can 
easily export to a spreadsheet program. The list is sorted by patient, payer, and then date (of the 
completed procedure, of the charges not applied, and then of the credits not applied).

A.	Procedure Information – Details regarding the procedure, such as the Date of Service (if the 
report was run by Procedure Date) or Entry Date (if the report was run by Entry Date), Patient 
Name, ADA Procedure Code and Description, and Payer Name (based on the primary dental 
insurance carrier of the claim with the completed procedure attached to it; or if there is not a 
claim, the payer is blank).

B.	 Charge – Consists of one of the following:
•	 The amount charged for the completed procedure.
•	 The sum of other charges:

•	 Charge adjustments
•	 Insurance charge adjustments
•	 Finance and late charges

•	 Charge initial balances
•	 Charge special adjustments

C.	 Contracted Rate – The amount allowed by the payer. This amount based on the insurance 
carrier’s fee schedule. If the procedure is not attached to a primary dental claim, the contracted 
rate is blank. If the procedure is not associated with the insurance carrier’s fee schedule (or the 
insurance carrier does not have a fee schedule), the contracted rate is blank.

D.	Payment – The sum of the payments associated with the completed procedure regardless of 
the allocation date:
•	 Guarantor payments
•	 Insurance payments

E.	 Adjustment – The sum of any adjustments associated with the completed procedure regardless 
of the allocation date:
•	 Credit adjustments
•	 Credit initial balances

•	 Credit special adjustments

F.	 Remaining Balance – The difference of the Charge and the Payment and Adjustment amounts.
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Procedures Not Attached to 
Insurance Report
The Procedures Not Attached to Insurance Report displays insured patients with completed 
procedure(s) that have not had an insurance claim created for the procedure(s).

Why:	 To ensure procedures are billed to a patient’s insurance

When:	 Daily

04/01/2018 - 05/04/2018

Procedures Not Attached to Insurance

Date Range:
<ALL>    -    <ALL>Patient Range:

Either

<ALL>Clinics:
<ALL>Providers:
<ALL>Billing Types:

Page 1 of 1Report Generated By: enterpriseReport Date: 05/04/2018

DATE
PATIENT NAME

TOOTH CODE AMOUNTDESCRIPTION EXPIRES CLINIC PROVIDER
BT

Abbott, James S 2 3,029.00Total:
04/22/2018 5     D6970 Post/core + brdg retainer, fabr                               230.00        07/21/2018                                    DDS1CENTRAL
04/22/2018 D1110 Prophylaxis-adult 90.00        07/21/2018                                    DDS1CENTRAL
04/22/2018 D0120 Periodic oral evaluation                                           30.00        07/21/2018                                    DDS1CENTRAL
04/22/2018 D0274 Bitewings-four films                                               250.00        07/21/2018                                    DDS1CENTRAL
04/22/2018 D0330 Panoramic film                                                       158.00        07/21/2018                                    DDS1CENTRAL
04/23/2018 6     D7110 Extraction-single tooth                                              71.00       07/22/2018                                    DDS2   CENTRAL
04/27/2018 25*26     D5214      Mand partial-metal base w/sdls                             898.00        07/26/2018                                    DDS1CENTRAL
05/01/2018 12     D5214      Mand partial-metal base w/sdls                             801.00        07/30/2018                                    DDS2    CENTRAL
05/01/2018 13     D7111     Extraction crnl remnts-decid th                              501.00        07/30/2018                                    DDS2    CENTRAL

Abbott, Patricia 2 1,100.00Total:
04/23/2018 D3221 Pulpal debridemnt-prim/perm th 1,100.00       04/23/2019                                    DDS1CENTRAL

Gleason, Gary                                                      1                 300.00Total:
04/23/2018 D1110 Prophylaxis-adult 300.00        07/22/2018                     DDS1DRAPER

Little, Brian 1                125.00Total:
04/23/2018 D1110 Prophylaxis-adult 125.00        07/22/2018                     DDS1DRAPER

Litle, Carol                                                            1                 127.00Total:
04/22/2018 12     D2150    Amalgam-2 surf. prim/perm                                   156.00       04/22/2019                                    DDS1CENTRAL
04/23/2018 12     D7120      Extraction-each additional                                        71.00       04/23/2019                                    DDS1CENTRAL

Perkins, Peggy                                                     1                    2,160.00Total:
04/23/2018 9     D6010 Surg place implant: endosteal                                780.00       10/20/2018                                    DDS1CENTRAL
04/23/2018 4     D2750 Crown-porc fuse high noble mtl                               78.00       10/20/2018                                     DDS1CENTRAL
05/01/2018 15     D5214      Mand partial-metal base w/sdls                             801.00        10/28/2018                       DDS3 CENTRAL
05/01/2018 9     D7111 Extraction crnl remnts-decid th                              501.00       10/28/2018                                     DDS3  CENTRAL

Smith, Michael 1             1,377.00Total:
04/27/2018 D9310 Consultation-per session                                         75.00       10/24/2018                                    DDS1  CENTRAL
05/01/2018 12     D5214      Mand partial-metal base w/sdls                             801.00        10/28/2018                                    DDS1  CENTRAL
05/01/2018   7     D7111 Extraction crnl remnts-decid th                              501.00        10/28/2018                       DDS1 CENTRAL

Taylor, Kerri L                                                      1                   69.00Total:
04/23/2018 4     D2386 Resin-2 surface, post-permanent 69.00        10/20/2018                                    DDS2CENTRAL

Winters, Carl                                                        1                 105.56Total:
04/23/2018 D8690 Ortho treatment (bill/contract) 105.56        04/23/2019                                    DDS1CENTRAL

8,492.56COMPLETED PROCEDURES TOTAL:

A

B

C



Dentrix Enterprise 11.0.2 Reports Reference

Procedures Not Attached to Insurance Report   271

How do I run the Procedures Not Attached to Insurance 
Report?
From the DXOne Reporting module, select Ledger, and then double-click Procedures Not 
Attached to Insurance. For additional details about running this report, see the “Procedures Not 
Attached to Insurance Report” topic in the DXOne Reporting portion of the Dentrix Enterprise 
Help (from the Help menu of any module, click Contents).

What important information does this report provide?
A.	Procedure Details – The patient’s name, procedure date, tooth number(s) involved in the 

procedure, procedure code, description, and procedure total.

B.	 Expires – The deadline for submitting a claim for the procedure.

C.	 Total – The total amount of the completed procedures included on the report.
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Production Summary Report
The Production Summary Report displays production for procedures that have been posted to the 
Ledger.

Why:	 To compare procedure production statistics, to print a record of transactions 
each day, to review production totals for a date or date range

When:	 Yearly, at the beginning of each budgeting cycle, or daily (the frequency depends 
on how the report is run)

Production Summary
05/05/2018 - 05/05/2018  Procedure Date

Clinics: <ALL>
Provider: <ALL>

Billing Types: <ALL>

Page 1 of 1Report Date: 05/05/2018 Report Generated By: enterprise

Procedure Date Entry Date Patient Name BT Description Amount

Quantity Total Average Percent

Abbott, James S                               2     D5214 - Mand partial-metal base w/sdls05/05/2018 05/05/2018                                                                                                   801.00
Little, Brian                                       1      D2386 - Resin-2 surface, post-permanent05/05/2018 05/05/2018                                                                                             120.00
Little, Brian                                       1      D2761 - Crown Insert05/05/2018 05/05/2018                                                             110.00
Little, Brian                                       1      D2752 - Crown-porc fused noble metal05/05/2018 05/05/2018                                                                                         110.00
Little, Brian                                       1      D2954 - Prefab post&core in add to crn05/05/2018 05/05/2018                                                                                         110.00
Perkins, Peggy                                 1      D6240 - Pontic-porcelain fused to hnob05/05/2018 05/05/2018                                                                                               200.00
Perkins, Peggy                                 1      D6750 - Retainer crn-porc fused-hi nob05/05/2018 05/05/2018                                                                                               200.00
Perkins, Peggy                                 1      D6750 - Retainer crn-porc fused-hi nob05/05/2018 05/05/2018                                                                                               200.00
Perkins, Peggy                                 1      D6240 - Pontic-porcelain fused to hnob05/05/2018 05/05/2018                                                                                               200.00

GRAND TOTALS:
Medicaid %0.000.000 0.00
Non-Medicaid %100.002,051.009 227.89

Total 100.00%9 2,051.00 227.89B

A
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Production Summary
05/05/2018 - 05/05/2018  Procedure Date

Clinics: <ALL>
Provider: <ALL>

Billing Types: <ALL>

Page 1 of 1Report Date: 05/05/2018 Report Generated By: enterprise

Procedure Date Entry Date Patient Name BT Description Amount

Quantity Total Average Percent

DDS1

CENTRAL
Little, Brian                                       1      D2386 - Resin-2 surface, post-permanent05/05/2018 05/05/2018                                                                                                    120.00
Little, Brian                                       1      D2761 - Crown Insert05/05/2018 05/05/2018                                                             110.00
Little, Brian                                       1      D2752 - Crown-porc fused noble metal05/05/2018 05/05/2018                                                                                         110.00
Little, Brian                                       1      D2954 - Prefab post&core in add to crn05/05/2018 05/05/2018                                                                                         110.00
Perkins, Peggy                                 1      D6240 - Pontic-porcelain fused to hnob05/05/2018 05/05/2018                                                                                               200.00
Perkins, Peggy                                 1      D6750 - Retainer crn-porc fused-hi nob05/05/2018 05/05/2018                                                                                               200.00
Perkins, Peggy                                 1      D6750 - Retainer crn-porc fused-hi nob05/05/2018 05/05/2018                                                                                               200.00
Perkins, Peggy                                 1      D6240 - Pontic-porcelain fused to hnob05/05/2018 05/05/2018                                                                                                200.00

CENTRAL
Medicaid %0.000.000 0.00
Non-Medicaid %100.001,250.008 156.25
Total %100.008 1,250.00 156.25

DDS1
Medicaid %0.000.000 0.00
Non-Medicaid %100.001,250.008 156.25
Total %60.958 1,250.00 156.25

DDS2

CENTRAL
Abbott, James S                               2     D5214 - Mand partial-metal base w/sdls05/05/2018 05/05/2018                                                                                                  801.00

CENTRAL
Medicaid %0.000.000 0.00
Non-Medicaid %100.00801.001 801.00
Total %100.001 801.00 801.00

DDS2
Medicaid %0.000.000 0.00
Non-Medicaid %100.00801.001 801.00
Total %39.051 801.00 801.00

GRAND TOTALS:
Medicaid %0.000.000 0.00
Non-Medicaid %100.002,051.009 227.89

Total 100.00%9 2,051.00 227.89

C

Production Summary
05/05/2018 - 05/05/2018  Procedure Date

Clinics: <ALL>
Provider: <ALL>

Billing Types: <ALL>

Page 1 of 1Report Date: 05/05/2018 Report Generated By: enterprise

Procedure Date Entry Date Patient Name BT Description Amount

Quantity Total Average Percent

CENTRAL

DDS1
Little, Brian                                       1      D2386 - Resin-2 surface, post-permanent05/05/2018 05/05/2018                                                                                             120.00
Little, Brian                                       1      D2761 - Crown Insert05/05/2018 05/05/2018                                                             110.00
Little, Brian                                       1      D2752 - Crown-porc fused noble metal05/05/2018 05/05/2018                                                                                         110.00
Little, Brian                                       1      D2954 - Prefab post&core in add to crn05/05/2018 05/05/2018                                                                                         110.00
Perkins, Peggy                                 1      D6240 - Pontic-porcelain fused to hnob05/05/2018 05/05/2018                                                                                               200.00
Perkins, Peggy                                 1      D6750 - Retainer crn-porc fused-hi nob05/05/2018 05/05/2018                                                                                               200.00
Perkins, Peggy                                 1      D6750 - Retainer crn-porc fused-hi nob05/05/2018 05/05/2018                                                                                               200.00
Perkins, Peggy                                 1      D6240 - Pontic-porcelain fused to hnob05/05/2018 05/05/2018                                                                                               200.00

DDS1
Medicaid %0.000.000 0.00
Non-Medicaid %100.001,250.008 156.25
Total %60.958 1,250.00 156.25

DDS2
Abbott, James S                               2     D5214 - Mand partial-metal base w/sdls05/05/2018 05/05/2018                                                                                                  801.00

DDS2
Medicaid %0.000.000 0.00
Non-Medicaid %100.00801.001 801.00
Total %39.051 801.00 801.00

CENTRAL
Medicaid %0.000.000 0.00
Non-Medicaid %100.002,051.009 227.89
Total %100.009 2,051.00 227.89

GRAND TOTALS:
Medicaid %0.000.000 0.00
Non-Medicaid %100.002,051.009 227.89

Total 100.00%9 2,051.00 227.89

D
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How do I run the Production Summary Report?
From the DXOne Reporting module, select Analysis, and then double-click Production Summary. 
For additional details about running this report, see the “Production Summary Report” topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
The report can be grouped and subtotaled by provider with a breakdown by clinic. Or, the report 
can be grouped and subtotaled by clinic with a breakdown by provider. The following information 
can be used to monitor production for each provider and/or clinic:

A.	Procedures – The procedures posted to the Ledger are listed if Include Patient Detail is 
selected when setting up the options to run this report. Each procedure provides the following 
information:

•	 Entry Date – The date a procedure is posted to the Ledger.

•	 Procedure Date – The date a procedure is posted to the Chart.

Note: It is essential that you understand the difference between Entry Dates and Procedure 
Dates. For details about these dates, see the “Tips for Understanding Dentrix Enterprise 
Reports” section in the Introduction of this book.

•	 Patient Name – The name of the patient on whom the procedure was performed.

•	 Code and Description – The ADA code and description of the procedure.

•	 Amount – The fee for the procedure posted in the Ledger.

B.	 Grand Totals – The Grand Totals section displays the following information:

•	 Quantity – The number of procedures posted during the date range of the report.

•	 Total – The total amount of the procedures billed for the procedures.

Note: This amount is not affected by payment adjustments (for example, if $500 was 
posted for a procedure, but the patient was given a $400 charity care adjustment, $500 
would be used to calculate the procedure total).

•	 Average – The average amount charged for a procedure (Total / Quantity).

•	 Percent – The Total divided by the Total Production Charges. The percent column assists 
you in comparing procedures. The higher the percentage, the more money the procedure is 
bringing into the office.

•	 Medicaid Totals – If Separate Totals for Medicaid and Non-Medicaid Patients is selected 
when setting up options to run this report, the Grand Totals section will divide up the Totals 
to reflect production from patients with Medicaid and those without Medicaid.

•	 Totals – The combined amounts of the Medicaid and Non-Medicaid totals.

C.	 Provider Totals – The production is shown for the provider with a breakdown of the procedures 
for each clinic the provider works in. Each clinic’s production is subtotaled. After the clinic 
subtotals, a totals summary for the provider appears.

D.	Clinic Totals – The production is shown for the clinic with a breakdown of the procedures 
performed by each provider at that clinic. Each provider’s production is subtotaled. After the 
provider subtotals, a totals summary for the clinic appears.
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Provider A/R Totals - Daily Report
The Provider A/R Totals - Daily Report displays daily production totals. For additional information 
on this report, see the “Provider A/R Totals - Standard Report” on page 278.

Why:	 To view daily production totals for a date range

When:	 As needed

Report Date: 04/23/2018 Report Generated By: enterprise Page 1 of 2 

Beginning < ----------Production -----> <------------------------------Co I lecti on > Ending Net % 
Balance Charges +Adj -Adj Total Payments +Adj -Adj Total Balance Change Collected 

Debit Initial Debit Special Finance Late Insurance Credit Initial Credit Special 
Balances Adjustments Charges Charges Payments Balances Adjustments 

04/22/2018 
2,205.00 386.00 10.00 0.00 417.00 -30.20 0.00 -20.00 -50.20 2,571.80 366.80 12.04% 

0.00 0.00 0.00 21.00 0.00 0.00 0.00
04/23/2018 

2,571.80 0.00 0.00 0.00 8,262.00 0.00 0.00 0.00 0.00 10,833.80 8,262.00 0.00% 
0.00 0.00 332.00 7,930.00 0.00 0.00 0.00

GRAND TOTALS 
2,205.00 386.00 10.00 0.00 8,679.00 -30.20 0.00 -20.00 -50.20 10,833.80 8,628.80 0.58% 

0.00 0.00 332.00 7,951.00 0.00 0.00 0.00

E

A

B
C

D
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How do I run the Provider A/R Totals - Daily Report?
From the DXOne Reporting module, select Management, and then double-click Provider A/R 
Totals. For additional details about running this report, see the Provider Accounts Receivable 
Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu 
of any module, click Contents).

What important information does this report provide?
The report can be grouped and subtotaled by initial or rendering provider with a daily A/R 
breakdown. The report contains the following information.

A.	Daily Break Down – A daily breakdown of production totals.

B.	 Standard Provider A/R Totals – Standard provider accounts receivable totals. See the 
“Provider A/R Totals - Standard Report” on page 278 for details about each column on this 
report.

C.	 Grand Totals – The combined daily production totals for all providers on the report.

D.	Provider Totals – If Initial Provider or Rendering Provider is selected when setting up options 
to run this report, the totals are grouped and subtotaled by initial or rendering provider.

E.	 Adjustment Types List – If you select Include Adjustment Types List when setting options for 
running this report, the Adjustment Types List appears on the report. This list identifies whether 
an adjustment type has been set as a Production or Collections adjustment for the report.
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Provider A/R Totals - Standard 
Report
The Provider A/R Totals - Standard Report displays production totals. This report is more 
accurate than other production reports because it takes into account production and collection 
adjustments. For example, if a procedure was posted for $1000, but a $900 Charity Care credit was 
given to the patient, the Production A/R Totals Report will show the procedure produced $100 in 
revenue, rather than $1000.

Why:	 To view production totals for a date range

When:	 Yearly, and monthly or weekly

Note: For accurate reporting, follow these recommendations:

•	 Post charge (production) and credit (collections) adjustments properly.

•	 Close your books nightly.

•	 Look at the net production figures within the date range of the report.

•	 To see where allocations occur, you can run the Provider Revenue Report.

Report Date: 04/30/2018 

PROVIDER A/R - STANDARD 
04/30/2018 - 04/30/2018 Procedure Date 

Clinics: <ALL> 
Providers: AMCCLURE, DOS01, DOS1, DOS2 

Billing Type: <ALL> 

Report Generated By: enterprise 

Beginning 
Balance 

<---------------Production-----------> <------------------------------Collection--------> 

AMCCLURE 

7,843.00 

DDS01 

90.00 

DDS1 

1,187.00 

DDS2 

0.00 

Charges 

Debit Initial 
Balances 

100.00 
0.00 

180.00 
1.510.00 

4,920.56 
0.00 

552.00 
0.00 

GRAND TOTALS 
9,120.00 5,752.56 

1.510.00 

+Adj -Adj Total 

Debit Special 
Adjustments 

0.00 
0.00 

0.00 
0.00 

100.00 
0.00 

0.00 
0.00 

100.00 
0.00 

Finance 
Charges 

0.00 
0.00 

0.00 
0.00 

0.00 
354.00 

0.00 
0.00 

0.00 
354.00 

Late 
Charges 

100.00 
0.00 

1,690.00 
0.00 

13,325.56 
7,951.00 

552.00 
0.00 

15,667.56 
7,951.00 

Payments 

Insurance 
Payments 

0.00 
0.00 

-38.00
0.00

-132.00
-803.40

-7.20
0.00

-177.20
-803.40

+Adj 

Credit Initial 
Balances 

0.00 
0.00 

0.00 
0.00 

0.00 
0.00 

0.00 
0.00 

0.00 
0.00 

-Adj 

Credit Special 
Adjustments 

0.00 
0.00 

0.00 
0.00 

-10.00
0.00

-10.00
0.00

-20.00
0.00

Total

0.00 

-38.00 

-945.40

-17.20

-1,000.60

Ending 
Balance 

7,943.00 

1,742.00 

13,567.16 

534.80 

23,786.96 

Net 
Change 

100.00 

1,652.00 

12,380.16 

534.80 

14,666.96 

Page 1 of 2 

% 
Collected 

0.00% 

2.25% 

7.09% 

3.12% 

6.39% G

A B C ED F

H
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How do I run the Provider A/R Totals - Standard Report?
From the DXOne Reporting module, select Management, and then double-click Provider A/R 
Totals. For additional details about running this report, see the “Provider A/R Totals Report” 
topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any 
module, click Contents).

What important information does this report provide?
A.	Beginning Balance – The outstanding amount that is owed to the provider/clinic at the end of 

the day prior to the beginning date range of the report.

B.	 Production

•	 Charges – The total charges for the provider/office within the date range.

•	 Debit Initial Balances – The total positive initial balances entered from the Ledger.

•	 + Adj – The total production adjustments that increase (debit) accounts receivable. This 
amount does not include debit initial balances, debit special adjustments, finance charges, 
and late charges.

•	 Debit Special Adjustments – The total debit adjustments made during the editing of family 
relations from the Family File.

•	 - Adj – The total production adjustments that reduce (credit) accounts receivable.

•	 Finance Charges – The total finance charges for payment agreements.

•	 Late Charges – The total late fees for delinquent payments.

•	 Total – The total production.

C.	 Collection

•	 Payments – The total payments for the provider/office within the date range.

•	 Insurance Payments – The total payments from insurance companies for the provider/office 
within the date range.

•	 + Adj – The total collection adjustments that increase (debit) accounts receivable.

•	 Credit Initial Balances – The total negative initial balances entered from the Ledger.

•	 - Adj – The total collection adjustments that decrease (credit) accounts receivable.

•	 Credit Special Adjustments – The total credit adjustments made during the editing of 
family relations from the Family File.

D.	Ending Balance – The outstanding amount that is owed to the provider/clinic at the end date 
of the report.

E.	 Net Change – The difference between the Beginning Balance and Ending Balance (or between 
Production and Collections).

F.	 % Collected – The percentage of collections (the Production Total divided by the Collections 
Total) within the date range of the report.

G.	Provider and Grand Totals – According to the Group By option selected when setting options 
for this report, the totals can be grouped by initial or rendering provider. The grand totals of all 
providers on the report also appear.

H.	Adjustment Types List – If you select Include Adjustment Types List when setting options for 
running this report, the Adjustment Types List appears on the report. This list identifies whether 
an adjustment type has been set as a production or collections adjustment for the report.
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Grouping and Clinic Selection Scenarios
Keep the following in mind when setting up the options for the Provider A/R Totals Report:

•	 When grouping the report by Initial Provider:

•	 The Collecting Clinic and Rendering Clinic options are 
not available.

•	 The report uses the Collecting Clinic for credits and the 
Rendering Clinic for charges.

•	 When grouping the report by something other than the 
initial provider (such as No Group By):

•	 Regardless of whether Collecting Clinic or Rendering 
Clinic is selected, the report always uses the Rendering 
Clinic for charges.

•	 With Collecting Clinic selected, the report uses the 
Collecting Clinic for credits.

•	 With Rendering Clinic selected, the report uses the 
Rendering Clinic for credits.

•	 Make sure the Adjustment Types for the report are set up 
correctly:

•	 The adjustment types that affect production are 
assigned to Production Adjustments.

•	 The adjustment types that affect collections are assigned to Collection Adjustments.
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Beginning Balance
A charge or applied credit is included according to the following criteria:

Initial Provider No Group By
Collecting Clinic Rendering Clinic

Ending Balance, 
plus Credits, 
minus Charges

Ending Balance, 
plus Credits, 
minus Charges

One of the following types:
•	 Completed Procedure Codes
•	 Charge Adjustments
•	 Finance Charges
•	 Charge Special Adjustments
•	 Charge Initial Balances

Charges minus Applied Credits

(Charge only) The provider is one of the specified 
providers

(Charge only) The amount is greater than zero

(Charge only) The entry date or procedure date is before 
the beginning date of the specified range

(Credit only) The allocation date is before the beginning 
date of the specified range (Entry or procedure date is 
ignored)

The corresponding charge meets the criteria to be 
included on the report

(Credit only) Applied to a completed procedure for an 
ADA code not being excluded

The corresponding procedure meets the criteria to be 
included on the report
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Charges (Production)
A transaction is included as a charge on the report according to the following criteria:

Initial Provider No Group By
Collecting Clinic Rendering Clinic

One of the following types:
•	 Completed Procedures
•	 Charge Adjustments (+Adj or –Adj, depending on production adjustment types specified)
•	 Finance Charges
•	 Debit Special Adjustments
•	 Late Charges
•	 Debit Initial Balances

The amount is greater than zero

The entry date or procedure date is within the specified range

The billing type of the family is one of the specified billing types

The rendering clinic is one of the specified clinics

The patient has an initial 
provider

The provider is one of the 
specified providers

The provider is one of the 
specified providers

(Completed procedure only) The ADA code is not being excluded

Credits (Collection)
A transaction is included as a credit on the report according to the following criteria:

Initial Provider No Group By
Collecting Clinic Rendering Clinic

One of the following types:
•	 (Guarantor) Payments
•	 Credit Adjustments (+Adj or –Adj, depending on the collection adjustment types specified)
•	 Insurance Payments
•	 Credit Special Adjustments
•	 Credit Initial Balances

The amount is less than zero 
(The full amount of the credit)

The amount is less than zero 
(The applied amount only)

The amount is less than zero 
(The applied amount only)

The entry date or procedure 
date is within the specified 
range

The allocation date is within 
the specified range  (Entry or 
procedure date is ignored)

The allocation date is within 
the specified range  (Entry or 
procedure date is ignored)

The billing type of the family is one of the specified billing types

The rendering clinic is one of 
the specified clinics

The collecting clinic is one of 
the specified clinics

The rendering clinic is one of 
the specified clinics

The patient has an initial 
provider

The provider is one of the 
specified providers

The provider is one of the 
specified providers

Ignores ADA code exclusions Applied to a completed 
procedure for an ADA code 
not being excluded

Applied to a completed 
procedure for an ADA code 
not being excluded
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Ending Balance
A charge or credit is included according to the following criteria:

Initial Provider No Group By
Collecting Clinic Rendering Clinic

One of the following types:
•	 Completed Procedure Codes
•	 Guarantor Payments
•	 Charge Adjustments
•	 Credit Adjustments
•	 Insurance Payments
•	 Finance Charges
•	 Charge Special Adjustments
•	 Credit Special Adjustments
•	 Late Charges
•	 Charge Initial Balances

One of the following types:
•	 Completed Procedure Codes
•	 Charge Adjustments
•	 Finance Charges
•	 Charge Special Adjustments
•	 Charge Initial Balances

Beginning Balance, 
minus Credits,  
plus Charges

Charges plus Credits Charges minus Applied Credits

The patient has an initial provider (Charge only) The provider is one of 
the specified providers

(Charge only) The amount is greater 
than zero

The entry date or procedure date is 
on or before the ending date of the 
specified

(Charge only) The entry date or 
procedure date is on or before the 
ending date of the specified range

(Credit only) The allocation date is 
on or before the ending date of the 
specified range (Entry or procedure 
date is ignored)

The corresponding charge meets the 
criteria to be included on the report

The billing type of the family is one 
of the specified billing types

The rendering clinic is one of the 
specified clinics

The collecting clinic is one of the 
specified clinics

(Completed procedure only) The 
ADA code is not being excluded

(Completed procedure only) The 
ADA code is not being excluded

(Credit only) Applied to a completed 
procedure for an ADA code not 
being excluded

The corresponding procedure meets 
the criteria to be included on the 
report
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Provider IDs List
The Provider IDs List displays information about each provider and the insurance carriers for which 
each provider has an ID.

Why:	 To ensure claim forms populate with the correct provider ID

When:	 After Dentrix Enterprise setup, and as needed

PROVIDER IDS LIST
Insurance Carriers: <ALL>    -    <ALL>

Clinics: <ALL>
Providers: <ALL>

Report Date: 04/22/2018 Page 1 of 4Report Generated By: enterprise

Dr.Title:
ID: AMCCLURE

Clinic: MESA
Phone: (800) 555-4343  

NPI: 0

BC/BS ID#: 1234567
Specialty: Dentist

Provider Class: Primary

State ID#:
TIN#:

Medicaid#:
DrugID#:

Provider#:
Office#:

123456
000000000
12345

RVU Schedule: <Not Assigned>
Address: P.O. Box 123456

Hartford, CT  06104
FEE Schedule: 1: Office

Provider Name: McClure, Angela SS#: 000-00-0000

Clinic TIN#:CENTRALClinic:

Address:

Phone:
Contact:

Group Name:
Group #:

Local (Union):

Employer:
Payor ID:

Dental Carrier: Connecticut General
P.O. Box 1234

Hartford, CT  06104

(800) 555-4343

Acme Insurance Group
1234567

Acme Inc

Provider ID Code: Provider ID Number:
0B State License Number 1234a1234b

DrTitle:
ID: DDS01

Clinic: CENTRAL
Phone:

NPI:

BC/BS ID#:
Specialty: Dentist

Provider Class: Primary

State ID#:
TIN#:

Medicaid#:
DrugID#:

Provider#:
Office#:

RVU Schedule: 1
Address: 123456 Street Name

City, UT  84003
FEE Schedule: 1: Office

Provider Name: Smith, Dennis SS#:

Clinic TIN#:CENTRALClinic:

Address:

Phone:
Contact:

Group Name:
Group #:

Local (Union):

Employer:
Payor ID:

Dental Carrier: Aetna
123456 Street Name

City, UT  84003

HSPS A

Provider ID Code: Provider ID Number:
0B State License Number 12345abc678def

Address:

Phone:
Contact:

Group Name:
Group #:

Local (Union):

Employer:
Payor ID:

Dental Carrier: Aetna
12345 Street Name

City, UT  84003

HSPS B

Provider ID Code: Provider ID Number:

A

B

C

D
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How do I run the Provider IDs List?
From the DXOne Reporting module, select Reference, and then double-click Provider IDs List. 
For additional details about running this report, see the “Provider IDs List” topic in the DXOne 
Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
A.	Provider Details – Displays general 

information about each provider, 
including important numbers 
associated with the provider. This 
information is found in the Provider 
Information dialog box, which 
can be accessed from the Office 
Manager module. For details about 
how to edit this information, see the 
“Adding, editing, inactivating, and 
reactivating providers” topic in the 
Dentrix Enterprise Help.

B.	 Clinics – The clinics to which a 
provider has been assigned.

C.	 Carrier Details – Displays general information about 
each insurance carrier for which a provider ID has been 
entered. Insurance carrier information is found in the 
Dental Insurance Plan Information dialog box, which can 
be accessed from the Office Manager. For details about 
how to enter provider IDs, see the “Adding and editing 
insurance plans” topic in the Dentrix Enterprise Help.

D.	Provider ID Details – Displays the provider’s ID code 
and number that has been entered for the insurance 
carrier. Provider ID information is found in the Provider ID 
Setup dialog box, which can be accessed from the Office 
Manager. For details on how to enter provider IDs, see the 
“Adding and editing insurance plans” topic in the Dentrix 
Enterprise Help.

A

C

D
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Provider Revenue - Allocations 
Report
The Provider Revenue Detail for Allocations Report lists payments and credits allocated to charges 
that have been posted for each provider.

Why:	 To have a record of revenue generated by each provider, to view the payments 
and adjustments that are being applied to charges, and to ensure correct 
allocation of payments and credits to procedures that have been performed

When:	 Daily

Report Date: 04/23/2018

Provider Revenue Detail for Allocations
Date Range: 01/07/2018 - 04/23/2018

Include Allocations: <ALL>
Guarantor Range: <ALL> - <ALL>

Clinics: <ALL>(Collecting)
Providers: <ALL>

Billing Type: <ALL>
Adjustment Type(s): <ALL>
Payment Type(s): <ALL>

Report Generated By: enterprise Page 1 of 1

Entry Date Proc Date Patient Name Description Amount BT Clinic

Provider: DDS1
Allocate Date: 04/22/2018 Allocated Amount: 10.00

D2150:Amalgam-2 surf. prim/perm 156.00 1 CENTRAL04/22/2018 04/22/2018 Larson, Bill 
04/22/2018 04/22/2018 Larson, Bill <Family> -Professional Discount -10.00 1 CENTRAL

Allocate Date: 04/22/2018 Allocated Amount: 23.00
D2150:Amalgam-2 surf. prim/perm 156.00 1 CENTRAL04/22/2018 04/22/2018 Larson, Bill 

04/22/2018 04/22/2018 Larson, Bill <Family> Check Payment - Thank You -23.00 1 CENTRAL

DDS1- Insurance: 0.00 Non-Insurance: 23.00 Credit Adjustments: 10.00 Total: 33.00

Provider: DROBB
Allocate Date: 04/22/2018 Allocated Amount: 9.60

D1110:Prophylaxis-adult 48.00 2 CENTRAL01/07/2018 01/07/2018 Abbott, James S
04/22/2018 04/22/2018 Abbott, Patricia <Family> Check Payment - Thank You -125.00 2 CENTRAL

Allocate Date: 04/22/2018 Allocated Amount: 108.20
D8670:Periodic ortho visit (contract) 950.00 2 CENTRAL01/15/2018 01/15/2018 Abbott, James S

04/22/2018 04/22/2018 Abbott, Patricia <Family> Check Payment - Thank You -125.00 2 CENTRAL

DROBB- Insurance: 0.00 Non-Insurance: 117.80 Credit Adjustments: 0.00 Total: 117.80

Grand Totals- Insurance: 0.00 Non-Insurance: 140.80 Credit Adjustments: 10.00 Total: 150.80

A
B
C

E
D
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How do I run the Provider Revenue - Allocations Report?
From the DXOne Reporting module, select Ledger, and then double-click Provider Revenue. 
For additional details about running this report, see the “Provider Revenue Report” topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
For each provider, each allocation is listed with the corresponding charge, and payments and/or 
credit adjustments.

A.	Allocation – The date the allocation was posted and the amount that was allocated to a charge 
appear.

B.	 Charge – For the charge, the following details appear: entry date, procedure date, patient 
name, procedure description, amount, billing type, and clinic (where service was rendered).

C.	 Payment/Credit – For each payment or credit, the following details appear: entry date, 
procedure date, patient name, payment/credit adjustment description, amount, date the 
amount was allocated to the charge, amount allocated to the charge, billing type, and 
collecting/rendering clinic.

Note: It is essential that you understand the difference between Entry Dates and Procedure 
Dates. For details on these dates, see the “Tips for Understanding Dentrix Enterprise Reports” 
section in the Introduction of this book.

D.	Provider Totals – The insurance and non-insurance payments, credit adjustments, and total 
revenue (which is the sum of the payments and credits) for the provider.

E.	 Grand Totals – The totals for all providers on the report.



Dentrix Enterprise 11.0.2 Reports Reference

288   Provider Revenue - Charges Report

Provider Revenue - Charges Report
The Provider Revenue Detail for Charges Report lists payments and credits allocated to charges 
that have been posted for each provider.

Why:	 To have a record of revenue generated by each provider, to view the payments 
and adjustments that are being applied to charges, and to ensure correct 
allocation of payments and credits to procedures that have been performed

When:	 Daily

Report Date: 05/05/2018

Provider Revenue Detail for Charges
Date Range: 04/01/2018 - 05/05/2018

Include Allocations: <ALL>
Guarantor Range: <ALL> - <ALL>

Clinics: <ALL>(Collecting)
Providers: <ALL>

Billing Type: <ALL>
Adjustment Type(s): <ALL>
Payment Type(s): <ALL>

Report Generated By: enterprise Page 1 of 1

Entry Date Proc Date Patient Name Description Amount BT ClinicAlloc AmtAlloc Date

Provider: DDS01
D2160:Amalgam-3 surf. prim/perm 90.00 1 CENTRAL
Check Payment - Thank You -20.00 1 CENTRAL04/23/2009 20.00

04/23/2018 04/23/2018 Payne, Scott 
04/23/2018 04/23/2018 Payne, Mildred <Family> 
04/27/2018 04/27/2018 Payne, Mildred <Family> Cash Payment - Thank You -100.00 1 CENTRAL04/27/2009 18.00

DDS01- Insurance: 0.00 Non-Insurance: 38.00 Credit Adjustments: 0.00 Total: 38.00

Provider: DDS1
D2150:Amalgam-2 surf. prim/perm 156.00 1 CENTRAL
Check Payment - Thank You -23.00 1 CENTRAL04/22/2009 23.00

04/22/2018 04/22/2018 Larson, Bill 
04/22/2018 04/22/2018 Larson, Bill <Family> 
04/22/2018 04/22/2018 Larson, Bill <Family> -Professional Discount -10.00 1 CENTRAL04/22/2009 10.00

D7120:Extraction-each additional 71.00 1 CENTRAL04/23/2018 04/23/2018 Larson, Bill 
05/05/2018 05/05/2018 Larson, Bill Insurance Payment -71.00 1 CENTRAL05/05/2009 71.00

Finance Charge 100.00 1 CENTRAL
Cash Payment - Thank You -100.00 1 CENTRAL04/27/2009 82.00

+Debit Adjustment 90.00 1 CENTRAL

04/23/2018 04/23/2018 Payne, Mildred <Family> 
04/27/2018 04/27/2018 Payne, Mildred <Family>

04/30/2018   04/30/2018 Larson, Bill <Family> 
04/29/2018 04/22/2018 Larson, Bill <Family> Cash Payment - Thank You -20.00 1 CENTRAL04/30/2009 20.00

DDS1- Insurance: 71.00 Non-Insurance: 125.00 Credit Adjustments: 10.00 Total: 206.00

Provider: DROBB
D1110:Prophylaxis-adult 48.00 2 CENTRAL
Check Payment - Thank You -125.00 2 CENTRAL04/22/2009 9.60

D8670:Periodic ortho visit (contract) 950.00 2 CENTRAL
Check Payment - Thank You -125.00 2 CENTRAL04/22/2009 108.20
-Professional Discount -25.00 2 CENTRAL04/30/2009 25.00

90620:Exam and consultation 500.00 2 CENTRAL

04/07/2018 04/07/2018 Abbott, James S
04/22/2018 04/22/2018 Abbott, Patricia <Family>

04/15/2018 04/15/2018 Abbott, James S
04/22/2018 04/22/2018 Abbott, Patricia <Family> 
04/30/2018 04/30/2018 Abbott, Patricia <Family>

04/15/2018 04/15/2018 Abbott, James S
05/01/2018 05/01/2018 Abbott, Patricia <Family> Cash Payment - Thank You -20.00 2 CENTRAL05/01/2009 20.00

DROBB- Insurance: 0.00 Non-Insurance: 137.80 Credit Adjustments: 25.00 Total: 162.80

Grand Totals- Insurance: 71.00 Non-Insurance: 300.80 Credit Adjustments: 35.00 Total: 406.80

A

C

D

B
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How do I run the Provider Revenue - Charges Report?
From the DXOne Reporting module, select Ledger, and then double-click Provider Revenue. 
For additional details about running this report, see the “Provider Revenue Report” topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
For each provider, each charge is listed with the payments and/or credit adjustments allocated to 
that charge.

A.	Charges – For each charge, the following details appear: entry date, procedure date, patient 
name, procedure description, amount, billing type, and clinic (where service was rendered).

B.	 Allocations – For each payment or credit, the following details appear: entry date, procedure 
date, patient name, payment/credit adjustment description, amount, date the amount was 
allocated to the charge, amount allocated to the charge, billing type, and collecting/rendering 
clinic.

Note: It is essential that you understand the difference between Entry Dates and Procedure 
Dates. For details on these dates, see the “Tips for Understanding Dentrix Enterprise Reports“ 
section in the Introduction of this book.

C.	 Provider Totals – The insurance and non-insurance payments, credit adjustments, and total 
revenue (the sum of the payments and credits) for the provider.

D.	Grand Totals – The totals for all providers on the report.
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Provider Revenue - Credits Report
The Provider Revenue Detail for Credits Report lists payments and credits allocated to charges that 
have been posted for each provider.

Why:	 To have a record of revenue generated by each provider, to view the payments 
and adjustments that are being applied to charges, and to ensure correct 
allocation of payments and credits to procedures that have been performed

When:	 Daily

Report Date: 04/23/2018

Provider Revenue Detail for Credits
Date Range: 01/23/2018 - 04/23/2018

Include Allocations: <ALL>
Guarantor Range: <ALL> - <ALL>

Clinics: <ALL>(Collecting)
Providers: <ALL>

Billing Type: <ALL>
Adjustment Type(s): <ALL>
Payment Type(s): <ALL>

Report Generated By: enterprise Page 1 of 1

Entry Date Proc Date Patient Name Description Amount BT ClinicAlloc AmtAlloc Date

Provider: DDS1
Check Payment - Thank You 1 CENTRAL23.00
D2150:Amalgam-2 surf. prim/perm 1 CENTRAL23.00

-Professional Discount 1 CENTRAL10.00

04/22/2018 04/22/2018 Larson, Bill <Family> 
04/22/2018 04/22/2018 Larson, Bill 

04/22/2018 04/22/2018 Larson, Bill <Family> 
04/22/2018 04/22/2018 Larson, Bill D2150:Amalgam-2 surf. prim/perm 1 CENTRAL

-23.00
156.00 04/22/2018

-10.00
156.00 04/22/2018 10.00

DDS1- Insurance: 0.00 Non-Insurance: 23.00 Credit Adjustments: 10.00 Total: 33.00

Provider: DROBB
Check Payment - Thank You -125.00 2 CENTRAL117.80
D1110:Prophylaxis-adult 2 CENTRAL9.60

04/22/2018 04/22/2018 Abbott, Patricia <Family> 
01/27/2018 01/27/2018 Abbott, James S
02/15/2018 02/15/2018 Abbott, James S D8670:Periodic ortho visit (contract) 2 CENTRAL

48.00 04/22/2018 
950.00 04/22/2018 108.20

DROBB- Insurance: 0.00 Non-Insurance: 117.80 Credit Adjustments: 0.00 Total: 117.80

Grand Totals- Insurance: 0.00 Non-Insurance: 140.80 Credit Adjustments: 10.00 Total: 150.80

A
B

C

D
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How do I run the Provider Revenue - Credits Report?
From the DXOne Reporting module, select Ledger, and then double-click Provider Revenue. 
For additional details about running this report, see the “Provider Revenue Report” topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
For each provider, each payment and/or credit adjustment is listed with the charge to which it was 
allocated:

A.	Allocations – For each payment or credit, the following details appear: entry date, procedure 
date, patient name, payment/credit adjustment description, amount, amount allocated, billing 
type, and collecting/rendering clinic.

B.	 Charges – For each charge, the following details appear: entry date, procedure date, patient 
name, procedure description, amount, date an amount was allocated to the charge, amount 
allocated to the charge, billing type, and clinic (where service was rendered).

Note: It is essential that you understand the difference between Entry Dates and Procedure 
Dates. For details on these dates, see the “Tips for Understanding Dentrix Enterprise Reports“ 
section in the Introduction of this book.

C.	 Provider Totals – The insurance and non-insurance payments, credit adjustments, and total 
revenue (the sum of the payments and credits) for the provider.

D.	Grand Totals – The totals for all providers on the report.
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Provider Revenue - Summary Report
The Provider Revenue Detail Summary Report lists payments and credits allocated to charges that 
have been posted for each provider.

Why:	 To have a record of revenue generated by each provider, to view the payments 
and adjustments that are being applied to charges, and to ensure correct 
allocation of payments and credits to procedures that have been performed

When:	 Daily

Report Date: 12/23/2017

Provider Revenue Detail Summary
Date Range: 12/1/2017 - 12/23/2017

Include Allocations: <ALL>
Guarantor Range: <ALL> - <ALL>

Clinics: <ALL>(Collecting)
Providers: <ALL>

Billing Type: <ALL>
Adjustment Type(s): <ALL>
Payment Type(s): <ALL>

Report Generated By: ENTERPRISE Page 1 of 1

Provider Insurance Non-Insurance Cr Adjustments Total Revenue

AMCCLURE 145.00 50.00 22.00 217.00
DDS1 100.00 243.96 35.00 378.96
DDS-1 260.00 108.00 0.00 368.00
DDS2 0.00 100.00 0.00 100.00
DDS-2 105.00 0.00 0.00 105.00
DROBB 511.90 345.00 321.20 1,178.10

Grand Totals 1,121.90 846.96 378.20 2,347.06

A

B
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How do I run the Provider Revenue - Summary Report?
From the DXOne Reporting module, select Ledger, and then double-click Provider Revenue. 
For additional details about running this report, see the “Provider Revenue Report” topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
A.	Provider Totals – The provider is listed with the corresponding insurance and non-insurance 

payments, credit adjustments, and total revenue, which is the sum of the payments and credits.

B.	 Grand Totals – The totals for all providers on the report.
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Referral Analysis Report
The Referral Analysis report displays the number of referrals from each referral source. The report 
also displays the amount of production generated as a result of the referrals.

Why:	 To compare referral sources and to view the total number of referrals over a 
specified date range

When:	 As needed

Referral Analysis
First Visit Date Range: 12/01/2017 - 12/17/2017

Treatment Date Range: 12/01/2017 - 12/17/2017 - Entry Date
Clinic(s): <ALL>

Provider(s): <ALL>
Sort by: Referral Name

Page 1 of 1Report Generated By: enterprise

Number of
Patients

Total Production Average Per Patient Percent of Number
of Patients

Percent of
Production

10 $1,433.00 $143.30 %34.48 %54.74
5 $950.00 $190.00 %17.24 %36.29
2 $105.00 $52.50 %6.90 %4.01
1 $0.00 $0.00 %3.45 %0.00

Date: 12/31/2017

Patient Referred By

Dr. Evans, Jeff
Dr. Tyler, Mark 
Family
Phone Survey
Yellow Page Ad 11 $130.00 $11.82 %37.93 %4.97

Total 29 $2,618.00 $397.62 100.00 % 100.00 %

Clinic Name Number of
Patients

Total Production Average per patient

CENTRAL 3 $225.00 $75.00

Total Production 3 $225.00 $75.00

A

B

C
D
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How do I run the Referral Analysis Report?
From the DXOne Reporting module, select Analysis, and then double-click Referral Analysis. 
For additional details about running this report, see the “Referral Analysis Report” topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
This report can be sorted by the name of the referral source, number of patients referred, and 
production as a result of the referral. The report contains the following information:

A.	Referral Sources

•	 Patient Referred By – The name of the person or entity that referred the patient.

•	 Number of Patients – The number of referrals from the referral source.

•	 Total Production – The total amount of production resulting from the referral source.

•	 Average Per Patient – The average production resulting from the referral source (Total 
Production/Number of Patients).

•	 Percent of Number of Patients – The percent of the referred patients on the report that 
come from the referral source listed (the total number of patients divided by the number of 
patients for the given referral source).

•	 Percent of Production – The production total divided by the combined production total.

B.	 Total – The totals for all referral sources.

C.	 Clinic Totals – The number of patients, total production, and average production per patient for 
each clinic.

D.	Total Production – The total number of patients, total production, and average production per 
patient for all clinics on the report.



Dentrix Enterprise 11.0.2 Reports Reference

296   Referral Recap Report

Referral Recap Report
The Referral Recap report lists the work completed and/or treatment planned for patients referred 
to your practice.

Why:	 To inform the referring doctor of the work completed/planned as a result of the 
referral

When:	 Monthly or weekly

REFERRED DATE

COMPLETED DATE

Date: COMPLETED TREATMENT

TREATMENT STILL IN PROGRESS

REFERRAL INFORMATION

PATIENT INFORMATION

REFERRAL RECAP

©DENTRIX 1987-2018 DLRR 1

TOOTH

TOOTH

SURFACE

SURFACE

CODE

CODE

DESCRIPTION

DESCRIPTION

Additional Notes:

James S Abbott
123 S Oak Rd
Murray, UT 84123
555-1586

Dennis Smith, 
1234 South Pine St
Mesa, AZ 85210
(480)555-6525

Dr. Evans, Jeff
1234 N Maple
Provo, UT 84601
555-5622

04/23/2018

04/15/2018 17 D7230 Extraction-impacted/part bony
04/15/2018   16 D7140 Extract,erupted th/exposed rt
04/15/2018 32 D7140 Extract,erupted th/exposed rt
04/22/2018 D0274 Bitewings-four films

04/23/2018      UR D4341 Perio scale&root pln-4+per quad

Additional notes appear here.

A

B

C

D

E

F
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How do I run the Referral Recap Report?
•	 In the Office Manager, from the Reports menu, point to Ledger, and then click Referral Recap.

•	 In the Patient Chart, from the File menu, click Print Referral.

•	 In the Ledger, from the Print menu, click Referral Recap.

For additional details about running this report, see the “Referral Recap Report,” “Printing the 
Referral Recap Report,” and “Walkout statements” topics in the Dentrix Enterprise Help (from the 
Help menu of any module, click Contents).

What important information does this report provide?
A.	Provider – The provider associated with the referral.

B.	 Referring Doctor – The referring doctor.

C.	 Patient – The referred patient.

D.	Completed Procedures – All procedures completed as a result of the referral.

E.	 Treatment Plans – All procedures treatment planned as a result of the referral.

F.	 Additional Notes – Additional notes entered in the Referral Recap Report dialog box.

F



Dentrix Enterprise 11.0.2 Reports Reference

298   Referral Slip

Referral Slip
The Referral Slip allows you to provide patient referral information to other doctors.

Why:	 To provide specialists with referral information

When:	 After entering a referral in Dentrix Enterprise and before a patient leaves your 
office after being referred to a specialist

TP DATE

REFERRAL INFORMATION

PATIENT INFORMATION

PATIENT REFERRAL SLIP

©DENTRIX 1987-2018 DLPRS 1

TOOTH SURFACE CODE DESCRIPTION

Additional Notes:

James S Abbott
123 S Oak St
Murray, UT 84123
555-1586

Dennis Smith, 
1234 South Pine
Mesa, AZ 85210
(480)555-6525

Charles M. Clark, M.D.
1234 N Medical Way
Mesa, AZ 85210
(212)555-5511

05/13/2018 18 D7270 Reimplantation/stabilizationA

B
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How do I run the Referral Slip?
In the Patient Chart, from the File menu, point to Print Referral, and then click Referral Slip. For 
additional details about running this report, see the “Printing a referral slip” topic in the Patient 
Chart portion of the Dentrix Enterprise Help (from the Help menu of any module, click Contents).

What important information does this report provide?
A.	Procedures – The procedures that have been completed within the specified date range are 

listed.

B.	 Custom Note – The note that was entered in the Additional Notes field when setting up the 
options to run this report.
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Referred By Doctor/Other Report
The Referred By Doctor/Other report displays patients that have been referred to your practice by 
other doctors or non-person sources (such as, advertisements). This report also lists the production 
totals resulting from each referral.

Why:	 To identify effective referral sources, to track revenue generated as a result of a 
referral source, and to maintain professional relations

When:	 As needed

Date: Page:04/23/2018 1

REFERRED BY DOCTOR/OTHER REPORT
The Dentist Group

Referral Date:  01/16/2018 - 04/23/2018

DOCTOR/OTHER'S NAME PHONE
REFERRED PATIENT NAME REFERRAL DATE TREATMENT PLAN PRODUCTION BALANCE

Dr. Evans, Jeff 555-5622 Total Referrals:         13
1234 N Cherry Ln
Provo, UT 84601 Last Gratuity Date: 04/23/2018 

Gratuity Given: money

James S AbbottJames S Abbott 01/25/2018   5366.00 0.00 6573.84
James S AbbottJames S Abbott 01/26/2018     5366.00 0.00 6573.84
James S AbbottJames S Abbott 01/27/2018   5366.00 0.00 6573.84
James S AbbottJames S Abbott 04/23/2018   5366.00 0.00 6573.84

Listed Referrals: 4

Dr. Tyler, Mark 555-5962 Total Referrals:          5
1235 N. Cherry Ln
Provo, UT 84601 Last Gratuity Date:

Gratuity Given:

Patricia Abbott 01/25/2018 5235.00 0.00 6573.84

Listed Referrals: 1

Family Total Referrals: 2

Last Gratuity Date:
Gratuity Given:

Brian R Little 01/18/2018 765.00 0.00 200.00

Listed Referrals: 1

Yellow Page Ad Total Referrals: 12

Last Gratuity Date:
Gratuity Given:

Kevin, Little 04/23/2018 0.00 0.00 194.00
Mark Taylor 01/17/2018 484.00 0.00  130.00
Kerri Taylor 01/25/2018 484.00 0.00 130.00

Listed Referrals: 3

TOTAL REFERRALS:
TOTAL LISTED REFERRALS:

32
9D

C

BA
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How do I run the Referred By Doctor/Other Report?
From the DXOne Reporting module, select Management, and then double-click Referred By 
Doctor/Other. For additional details about running this report, see the “Referred By Doctor/Other 
Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu 
of any module, click Contents).

What important information does this report provide?
A.	Doctor Information – The name, mailing address, and phone number of the referring doctor.

B.	 Referral Details – In addition to the date and description of the last gratuity given to the 
referral source, the following information appears on this report:

•	 Total Referrals – The total number of patients referred by the referral source. Be aware 
that report filters have no affect on this number; this number represents the total number of 
patients ever referred by the referral source.

•	 Listed Referrals – The total number of referrals displayed on the report for the referring 
doctor.

Note: This number only appears if you select Include All Referral Sources when setting 
options for this report.

C.	 Referred Patients – If you select Include Referred Patients when setting options for this 
report, referred patients appear on the report. In addition to the name and referral date, the 
following information is listed for each referral displayed on the report:

•	 Treatment Plan – The total value of treatment plans for the patient.

•	 Production – The total value of completed procedures.

Note: If all production values are zero, clear Include Patients With No Production or 
Treatment Planned Procedures when setting options for this report.

•	 Balance – The patient’s current balance.

D.	Report Totals

•	 Total Referrals – The total number of patients referred by the referral sources.

•	 Listed Referrals – The total number of referrals listed in this report.

Note: This number only appears if you select Include All Referral Sources when setting 
options for this report.
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Referred By Patient Report
The Referred By Patient Report lists the patients that have been referred to your practice by other 
patients. This report also lists the production totals resulting from each referral.

Why:	 To track revenue resulting from patient referrals

When:	 As needed

Date: Page:03/08/2018 1

REFERRED BY PATIENT REPORT
The Dentist Group

Referral Date:  03/08/2018 - 03/08/2018
Production Date:  03/08/2018 - 03/08/2018

PATIENT'S NAME PHONE
REFERRED PATIENT NAME REFERRAL DATE TREATMENT PLAN PRODUCTION BALANCE

Crosby, Brent T. (Patient) (743)555-2381 Total Referrals: 1
123 Golden Pine Rd
Kailua, TN 77308
Male

Last Gratuity Date: 02/23/2018
Gratuity Given: 2 movie tickets

Shirley Crosby 03/08/2018 0.00 0.00 125.00

Listed Referrals: 1

Larson, Mark (Patient) Total Referrals: 3
123 W. Oak St
Mesa, AZ 85210
Male

Last Gratuity Date:
Gratuity Given:

Amy Larson 03/08/2018 220.00 292.00 337.00

Listed Referrals: 1

Perkins, Peggy M (Patient) (343)555-2507 Total Referrals: 1
12345 Oakwood
East Pointe, IN 40021
Female

Last Gratuity Date:
Gratuity Given:

Shelly Perkins 03/08/2018 1303.00 69.00 180.00

Listed Referrals: 1

Reeves, Elisabeth (Patient) (146)555-3896 Total Referrals: 1
12345 W.Country Ln
Shire Hill, MI 47032
Female

Last Gratuity Date:
Gratuity Given:

Joshua Reeves 03/08/2018 0.00 300.00 300.00

Listed Referrals: 1

TOTAL REFERRALS:
TOTAL LISTED REFERRALS:

6
4D

BA
C
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How do I run the Referred By Patient Report?
From the DXOne Reporting module, select Management, and then double-click Referred By 
Patient. For additional details about running this report, see the “Referred By Patient Report” 
topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any 
module, click Contents).

What important information does this report provide?
A.	Referring Patient Information – The name, mailing address, phone number, and gender of 

patients that have provided referrals to your practice.

B.	 Referral Details – In addition to the date and description of the last gratuity given to the 
referring patient, the following information appears on this report:

•	 Total Referrals – The total number of patients referred by the patient. Be aware that report 
filters have no affect on this number; this number represents the total number of patients 
ever referred by the patient.

•	 Listed Referrals – The total number of referrals displayed on the report for the referring 
patient.

C.	 Referred Patients – In addition to the name and referral date, the following information is listed 
for each referral displayed on the report:

•	 Treatment Plan – The total value of treatment plans for the referral.

•	 Production – The total value of completed procedures.

•	 Balance – The referral’s current balance.

D.	Report Totals

•	 Total Referrals – The total number of referrals provided by the referring patients.

•	 Listed Referrals – The total number of referrals listed in this report.
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Referred To Doctor Report
The Referred To Doctor Report lists the number of patients your practice has referred to another 
practice. Depending on report settings, this report also lists the name and referral date of each 
referral.

Why:	 To maintain professional relations

When:	 As needed

Server Name: <Default>

REFERRED TO DOCTOR REPORT

Clinics: <ALL>

Providers: <ALL>

ADA Codes: <ALL>

Referral Date: All Referral Sources

Page 1 of 1Report Generated By: ENTERPRISEReport Date: 9/18/2019

DOCTOR'S NAME

Referred Patient Name

PHONE

Referral 

Date

Scheduled 

Date

Completed  

Date
Referral Status

Days 

Referred

Total Referrals:  1

Listed Referrals:  1

(800) 555-6660

1234 Palma Rd

 Baker, Bruce (Periodontics)

Anytown, US 11111

#201

Brent Crosby 09/17/2019 1

Total Referrals:  12 
Listed Referrals:  5

(212) 555-5511

1750 N Medical Way

 Charles M. Clark, M.D. (Surgery, Oral & Maxillofacial)

Mesa, AZ 85210

05/05/2016 999+

06/15/2016 999+

11/22/2016 999+

10/09/2016 999+

Mary Brown

Joshua Reeves 
Patricia Abbott
Tom N Crosby  
Brent Crosby 06/17/2017 06/30/2017 Complete 1306/30/2017

Total Referrals:  1

Listed Referrals:  1

() 555-6423 Ext: 205

1750 University Ave.

Dr. Clark, Robert (Endodontist)

Anytown, PA 99999

Suite 200

Shirley Crosby 06/21/2005 999+

TOTAL REFERRALS:

TOTAL LISTED REFERRALS:

14

 7D

BA

C
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How do I run the Referred To Doctor Report?
From the DXOne Reporting module, select Management, and then double-click Referred To 
Doctor. For additional details about running this report, see the “Referred To Doctor Report” 
topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any 
module, click Contents).

What important information does this report provide?
A.	Doctor Information – The name, mailing address, and phone number of a doctor to which the 

practice provided referrals.

B.	 Doctor Totals

•	 Total Referrals – The total number of patients referred to the doctor. Be aware that report 
filters have no affect on this number; this number represents the total number of patients 
ever referred to the doctor.

•	 Listed Referrals – The total number of referrals listed for the doctor.

Note: This number only appears if you select Include Referred Patients when setting 
options for this report.

C.	 Referred Patients – If you select Include Referred Patients when running this report, the 
following details regarding each outbound referral appear on the report:

•	 Patient name

•	 Referred, scheduled, and completed dates

•	 Status

•	 Number of days referred out

D.	Report Totals

•	 Total Referrals – The total number of referred patients.

•	 Listed Referrals – The total number of referred patients listed in this report.

Note: Listed Referrals only appears if you select Include Referred Patients when setting 
options for this report.
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Registration Information Report
The Registration Information Report displays the practice’s registration information and Dentrix 
Enterprise serial number.

Why:	 To quickly access your registration information and serial number

When:	 As needed

REGISTRATION INFORMATION
The Dentist Group

Date: Page:04/22/2018 1

PRACTICE TITLE: [The Dentist Group]
STREET1: [123 East Valley Drive]
STREET2: []

CITY: [American Fork]
STATE: [UT]

ZIP: [84003]
PHONE: [(801)555-9300]

FISCAL MONTH: [January ]
COUNTRY: []
SERIAL #: [<EVALUATION COPY>]

B

A
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How do I run the Registration Information Report?
In the Office Manager, from the Reports menu, point to Reference, and then click Registration 
Information. For additional details about running this report, see the “Registration Information 
Report” topic in the Office Manager portion of the Dentrix Enterprise Help (from the Help menu of 
any module, click Contents).

What important information does this report provide?
A.	Practice Information – The practice information associated with your serial number.

B.	 Serial Number – The Dentrix Enterprise product serial number.
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RVU Day Sheet Report
The RVU Day Sheet report lists RVU production for procedures that have been posted to the 
Ledger.

Why:	 To print a record of transactions each day, to review RVU production totals for a 
date or date range

When:	 Daily

Production RVU Day Sheet
Date Range: 04/24/2018 - 04/24/2018 Procedure Date

Clinics: <ALL>
Providers: <ALL>

Billing Type: <ALL>

Page 1 of 1Report Date: 05/01/2018 Report Generated By: enterprise

Entry Date Proc Date Patient Name Chart # TH Code Description RVU Lab Exp. Net RVU BT

125.000.0025.00Prophylaxis-adultD1110SM0010
1-20.0045.0025.00Periodic oral evaluationD0120SM0010
1374.000.00374.00Bitewings-four filmsD0274SM0010

04/24/2018 04/24/2018 Smith, Brandon 
04/24/2018 04/24/2018 Smith, Brandon 
04/24/2018 04/24/2018 Smith, Brandon 

424.00 379.00

Total Summary RVU Net RVU

45.00

Lab Exp.

A

B

5018 


42484248



























  


4248 4248 
4248 4248 

428 4248 

4248 4248  
4248 4248 



  



C


42484248





5018 

          





















4248 4248 
4248 428 

428 428 

4248 4248  
424/8 4248 

  



  

 

  





D
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How do I run the RVU Day Sheet Report?
From the DXOne Reporting module, select Management, and then double-click RVU Day Sheet. 
For additional details about running this report, see the “RVU day sheet” topic in the DXOne 
Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
The report can be grouped and subtotaled by provider with a breakdown by clinic. Or, the report 
can be grouped and subtotaled by clinic with a breakdown by provider. The following information 
can be used to monitor RVU production for each provider and/or clinic:

A.	Procedures – The procedures posted to the Ledger are listed if Include Procedures is 
selected when setting up the options to run this report. Each procedure provides the following 
information:

•	 Entry Date – The date a procedure is posted to the Chart (and to the Ledger 
simultaneously).

•	 Procedure Date – The date a procedure is done in the Chart.

Note: It is essential that you understand the difference between Entry Dates and Procedure 
Dates. For details on these dates, see the “Tips for Understanding Dentrix Enterprise 
Reports“ section in the Introduction of this book.

•	 Patient Name – The name and chart number of the patient on whom the procedure was 
performed.

•	 TH – The tooth number(s) associated with a procedure.

•	 Code and Description – The ADA code and description of the procedure.

•	 RVU – The Relative Value Units that were assigned to the procedure from the Procedure 
Code Editor dialog box.

•	 Lab Expenses – The lab expenses that were assigned to the procedure from the Procedure 
Code Editor dialog box. This column appears if Subtract Lab Expenses is selected when 
setting up the options to run this report.

•	 Net RVU – The net RVU is calculated by subtracting lab expenses (if the Subtract Lab 
Expenses option was selected) from the RVU.

•	 BT – The billing type of the patient on whom the procedure was performed.

B.	 Total Summary – The total RVU, lab expenses, and net RVU.

C.	 Provider Totals – The RVU production is shown for the provider with a breakdown of the 
procedures for each clinic the provider works in. Each clinic’s RVU production is subtotaled. 
After the clinic subtotals, a totals summary for the provider appears. Also, for the provider, a 
unique patient count and unique visit count are given.

D.	Clinic Totals – The RVU production is shown for the clinic with a breakdown of the procedures 
performed by each provider at that clinic. Each provider’s RVU production is subtotaled. After 
the provider subtotals, a totals summary for the clinic appears. Also, for the provider, a unique 
patient count and unique visit count are given.
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RVU Production Summary Report
The RVU Production Summary Report lists RVU production for procedures that have been posted 
to the Ledger.

Why:	 To print a record of transactions each day, to review RVU production totals for a 
date or date range

When:	 Daily

RVU Production Summary
04/24/2018 - 04/24/2018  Procedure Date

Clinics: <ALL>
Provider: <ALL>

Billing Types: <ALL>

Page 1 of 1Report Date: 05/01/2018 Report Generated By: enterprise

Procedure Date Entry Date Patient Name BT Description Amount

Quantity Total Average Percent Lab Exp. Net RVU

Smith, Brandon                                1      D0120 - Periodic oral evaluation04/24/2018 04/24/2018                                                                                     25.00
Smith, Brandon                                1      D1110 - Prophylaxis-adult04/24/2018 04/24/2018                                                                           25.00
Smith, Brandon                                1      D0274 - Bitewings-four films04/24/2018 04/24/2018                                                                               374.00

GRAND TOTALS:
Medicaid %0.000.000 0.00 0.00 0.00
Non-Medicaid %100.00424.003 141.33 45.00 379.00

Total 100.00%3 424.00 141.33 45.00 379.00

A

B
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RVU Production Summary
04/24/2018 - 04/24/2018  Procedure Date

Clinics: <ALL>
Provider: <ALL>

Billing Types: <ALL>

Page 1 of 1Report Date: 04/24/2018 Report Generated By: enterprise

Procedure Date Entry Date Patient Name BT Description Amount

Quantity Total Average Percent Lab Exp. Net RVU

DDS1

CENTRAL
Larson, Bill                                       1      D7120 - Extraction-each additional04/24/2018 04/24/2018                                                                                 171.00

CENTRAL
Medicaid %0.000.000 0.00 0.00 0.00
Non-Medicaid %100.00171.001 171.00 0.00 171.00
Total %100.001 171.00 171.00 0.00 171.00

DDS1
Medicaid %0.000.000 0.00 0.00 0.00
Non-Medicaid %100.00171.001 171.00 0.00 171.00
Total %50.001 171.00 171.00 0.00 171.00

DROBB

CENTRAL
Abbott, James S                              2      D7110 - Extraction-single tooth04/24/2018 04/24/2018                                                                                     171.00

CENTRAL
Medicaid %0.000.000 0.00 0.00 0.00
Non-Medicaid %100.00171.001 171.00 0.00 171.00
Total %100.001 171.00 171.00 0.00 171.00

DROBB
Medicaid %0.000.000 0.00 0.00 0.00
Non-Medicaid %100.00171.001 171.00 0.00 171.00
Total %50.001 171.00 171.00 0.00 171.00

GRAND TOTALS:
Medicaid %0.000.000 0.00 0.00 0.00
Non-Medicaid %100.00342.002 171.00 0.00 342.00

Total 100.00%2 342.00 171.00 0.00 342.00

C
RVU Production Summary

04/24/2018 - 04/24/2018  Procedure Date
Clinics: <ALL>

Provider: <ALL>
Billing Types: <ALL>

Page 1 of 1Report Date: 05/01/2018 Report Generated By: enterprise

Procedure Date Entry Date Patient Name BT Description Amount

Quantity Total Average Percent Lab Exp. Net RVU

CENTRAL

DDS01
Smith, Brandon                                1      D0120 - Periodic oral evaluation04/24/2018 04/24/2018                                                                                     25.00
Smith, Brandon                                1      D1110 - Prophylaxis-adult04/24/2018 04/24/2018                                                                           125.00
Smith, Brandon                                1      D0274 - Bitewings-four films04/24/2018 04/24/2018                                                                               374.00

DDS01
Medicaid %0.000.000 0.00 0.00 0.00
Non-Medicaid %100.00424.003 141.33 45.00 379.00
Total %100.003 424.00 141.33 45.00 379.00

CENTRAL
Medicaid %0.000.000 0.00 0.00 0.00
Non-Medicaid %100.00424.003 141.33 45.00 379.00
Total %100.003 424.00 141.33 45.00 379.00

GRAND TOTALS:
Medicaid %0.000.000 0.00 0.00 0.00
Non-Medicaid %100.00424.003 141.33 45.00 379.00

Total 100.00%3 424.00 141.33 45.00 379.00

D

How do I run the RVU Production Summary Report?
From the DXOne Reporting module, select Management, and then double-click RVU Production 
Summary. For additional details about running this report, see the “RVU Production Summary 
Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu 
of any module, click Contents).

What important information does this report provide?
The report can be grouped and subtotaled by provider with a breakdown by clinic. Or, the report 
can be grouped and subtotaled by clinic with a breakdown by provider. The following information 
can be used to monitor RVU production for each provider and/or clinic:

A.	Procedures – The procedures posted to the Ledger are listed if Include Patient Detail is 
selected when setting up the options to run this report. Each procedure provides the following 
information:

•	 Procedure Date – The date a procedure is posted to the Chart.

•	 Entry Date – The date a procedure is posted to the Ledger.

Note: It is essential that you understand the difference between Entry Dates and Procedure 
Dates. For details on these dates, see the “Tips for Understanding Dentrix Enterprise 
Reports“ section in the Introduction of this book.
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•	 Patient Name – The name of the patient on whom the procedure was performed.

•	 Code and Description – The ADA code and description of the procedure.

•	 Amount – The Relative Value Units (RVU) that were assigned to the procedure from the 
Procedure Code Editor dialog box.

B.	 Grand Totals

•	 Medicaid Totals – If Separate Totals for Medicaid and Non-Medicaid Patients are 
selected when setting up options to run this report, the Grand Totals section will divide up 
the Totals to reflect production from patients with Medicaid and those without Medicaid.

•	 Totals – The Grand Totals section displays the Totals for the quantity of procedures, total 
amount of the procedures, average charge per procedure, percent of RVU, lab expenses 
assigned to the procedure from the Procedure Code Editor dialog box, and net RVU of the 
procedures, which is calculated by subtracting lab expenses (if the Subtract Lab Expenses 
option was selected) from the RVU.

C.	 Provider Totals – The RVU production is shown for the provider with a breakdown of the 
procedures for each clinic the provider works in. Each clinic’s RVU production is subtotaled. 
After the clinic subtotals, a totals summary for the provider appears.

D.	Clinic Totals – The RVU production is shown for the clinic with a breakdown of the procedures 
performed by each provider at that clinic. Each provider’s RVU production is subtotaled. After 
the provider subtotals, a totals summary for the clinic appears.
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RVU Schedules Report
The RVU Schedules report lists procedure RVUs for selected RVU schedules. This report also lists 
the lab expenses and material expenses associated with each procedure.

Why:	 To ensure each RVU schedule is set up properly, to compare multiple RVU 
schedules side by side, and to ensure lab expenses and material expenses are up 
to date

When:	 After Dentrix Enterprise setup, and as needed

RVU SCHEDULE
277, D0290, D0310, D0320, D0321, D0322, D0350, D0360, D0362, D0363, D0415, D0416, D0417, D0418, D0421, D0425, D0431, D0460, D0472, D0473, D047

Page 1 of 2Report Generated By: enterpriseReport Date: 04/22/2018

CODE DESCRIPTION LAB
EXPENSE MATERIALRVU 1 RVU 2 RVU 3 RVU 4 RVU 5

D0001 Oral Cancer Screening 15.00 16.00 0.00 0.00 0.00 9.00 15.00
D0120 Periodic oral evaluation 25.00 27.00 0.00 0.00 0.00 45.00 78.00
D0140 Limited oral evaluation 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0145 Oral evaluation < 3 yrs of age 5.00 5.00 0.00 0.00 0.00 0.00 0.00
D0150 Comp oral eval-new/estab pat 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0160 Detail/extensive oral eval, B/R 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0170 Limited re-evaluation estab pat 565.00 614.00 0.00 0.00 0.00 0.00 0.00
D0180 Comprehensive perio evaluation 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0210 Intraoral-complete series (bw) 9.00 10.00 0.00 0.00 0.00 0.00 23.00
D0220 Intraoral-periapical-1st film 6.00 7.00 0.00 0.00 0.00 0.00 24.00
D0230 Intraoral-periapical-each add'l 36.00 39.00 0.00 0.00 0.00 0.00 12.00
D0240 Intraoral-occlusal film 35.00 38.00 0.00 0.00 0.00 0.00 23.00
D0250 Extraoral-first film 6.00 7.00 0.00 0.00 0.00 0.00 25.00
D0260 Extraoral-each additional film 5.00 5.00 0.00 0.00 0.00 0.00 14.00
D0270 Bitewing-single film 321.00 349.00 0.00 0.00 0.00 0.00 24.00
D0272 Bitewings-two films 61.00 66.00 0.00 0.00 0.00 0.00 24.00
D0273 Bitewings-three films 98.00 107.00 0.00 0.00 0.00 0.00 25.00
D0274 Bitewings-four films 374.00 406.00 0.00 0.00 0.00 0.00 47.00
D0277 Vertical bitewings-7 to 8 films 67.00 73.00 0.00 0.00 0.00 0.00 326.00
D0290 Skull &facial bone survey film 3,499.00 3,802.00 0.00 0.00 0.00 0.00 233.00
D0310 Saliography 316.00 343.00 0.00 0.00 0.00 0.00 0.00
D0320 TMJ arthrogram, incl injection 64.00 70.00 0.00 0.00 0.00 0.00 2,344.00
D0321 Other TMJ films, by report 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0322 Tomographic survey 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0330 Panoramic film 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0340 Cephalometric film 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0350 Oral/Facial Photographic Images 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0360 Cone beam-CT/craniofacial data 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0362 Cone beam-2D multi img reconst 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0363 Cone beam-3D multi img reconst 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0415 Collection of microorg culture 25.00 27.00 0.00 0.00 0.00 23.00 15.00
D0416 Viral Culture 25.00 27.00 0.00 0.00 0.00 14.00 3.00
D0417 Collection of saliva sample 25.00 27.00 0.00 0.00 0.00
D0418 Analysis of saliva sample 25.00 27.00 0.00 0.00 0.00
D0421 Genetic test-suscept oral dis 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0425 Caries susceptibility tests 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0431 Adjunc pre-diag test-detect muc 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0460 Pulp vitality tests 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0470 Diagnostic casts 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0471 Diagnostic photographs 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0472 Accession of tiss, gr exam/rpt 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0473 Acc of tissue, gr mic exam/rpt 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0474 Acc of tiss-gr mic ex surg mar 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0475 Decalcification Procedure 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0476 Special stains for microorg 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0477 Special stains-not for microorg 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0478 Immunohistochemical stains 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0479 Tissue in-situ hybrid-inclu int 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0480 Accession exf cytologic smears 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0481 Electron microscopy-diagnostic 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0482 Direct immunofluorescence 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0483 Indirect immunofluorescence 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0484 Consult on slides prp elsewhere 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0485 Consult inc prep/slides biop mt 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0486 Accession of brush biopsy smpl 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0501 Histopathologic examinations 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0502 Other oral path procedure, B/R 25.00 27.00 0.00 0.00 0.00 0.00 0.00
D0999 Unspecified diag procedure, B/R 25.00 27.00 0.00 0.00 0.00 0.00 0.00

A B C D
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How do I run the RVU Schedules Report?
From the DXOne Reporting module, select Reference, and then double-click RVU Schedule. For 
additional details about running this report, see the “RVU Schedule Report” topic in the DXOne 
Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
The following report information is found in the Procedure Code Editor dialog box, which can 
be accessed from the Office Manager. See the “Procedure Code Setup” or “Auto RVU schedule 
changes” topic in the Office Manager portion of the Dentrix Enterprise Help for details on how to 
edit this information.

A.	Code – The procedure code.

B.	 Fee – The RVU assigned to a procedure.

C.	 Lab Expense – The estimated lab expense associated with the procedure.

D.	Material – The estimated materials expense for the procedure.

A

B

C D
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RVU Utilization Report
The RVU Utilization report lists insurance carriers and, for each carrier, the relevant RVU production 
and details for the procedures posted during a selected date range.

Why:	 To identify insurance carriers with low coverages (this is done by comparing the 
charges posted to the Ledger with the practice’s RVU fee schedule)

When:	 Yearly, and as needed

RVU UTILIZATION REPORT - DENTAL
Date Range: 05/01/2018 - 05/01/2018 Procedure Date

RVU: 002: RVU 2
Compare RVU Schedule With: Transaction Amount

Include: All Procedures
Clinic(s): <ALL>

Provider(s): <ALL>
Billing Type(s): <ALL>
ADA Code(s): <ALL>

Carrier From: Aetna Life and Casualty - Aetna - 321863 
Carrier To: Aetna Life and Casualty - Aetna - 321863

Page 1 of 1Report Date: 05/01/2018 Report Generated By: enterprise

INSURANCE CARRIER NAME GROUP PLAN GROUP NUMBER PHONE
SUBSCRIBER DATE ID # PATIENT NAME BIRTHDATE SS # CODE DESCRIPTION TH SURFACE PROVIDER CLINIC FEE RVU

(800) 555-6444Aetna Life and Casualty Aetna 321863

Abbott, Patricia 05/01/2018                                                                                                  D5214     Mand partial-metal base          12 DDS2 CENTRAL 702.00          701.00
w/sdls

5678910 Abbott, James S 11/11/1962     000-00-0000

Abbott, Patricia 05/01/2018                                               11/11/1962      000-00-0000        D7111    Extraction crnl remnts-decid    13 DDS2 CENTRAL 402.00          401.00 
th

5678910 Abbott, James S

Payne, Mildred 05/01/2018                                                             11/11/1980      000-00-0000        D5214    Mand partial-metal base          15 DDS01 CENTRAL 702.00         701.00 
w/sdls

000-00-0000          Perkins, Peggy

Payne, Mildred 05/01/2018                                                             11/11/1980      000-00-0000        D7111    Extraction crnl remnts-decid    9 DDS01 CENTRAL 402.00          401.00 
th

000-00-0000          Perkins, Peggy

Smith, Brandon 05/01/2018                                                             11/11/1973      000-00-0000        D5214    Mand partial-metal base          12 DDS01 CENTRAL 702.00          701.00 
w/sdls

000-00-0000          Smith, Michael

Smith, Brandon 05/01/2018                                                             11/11/1973      000-00-0000        D7111    Extraction crnl remnts-decid    7 DDS01 CENTRAL 402.00          401.00
th

000-00-0000          Smith, Michael

Fee: CoPay: (Fee - RVU): Total Office Visits: Total Patients Seen:Aetna Life and Casualty Totals:
3,312.00 3,306.00 6.00 33

Grand Totals: 3,312.00 3,306.00

6.00

Total Office Visits:

Total Patients Seen:

3

3

(Fee - RVU):

Fee: Co-Pay:

B

C

D

A
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How do I run the RVU Utilization Report?
From the DXOne Reporting module, select Management, and then double-click RVU Utilization. 
For additional details about running this report, see the “RVU Utilization Report” topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
A.	 Insurance Carriers – The report is divided by insurance carriers. The carrier’s name, group plan 

name and number, and phone number are shown.

B.	 Procedures – The procedures posted in the Ledger for patients with the displayed insurance 
carrier. For each procedure the following are shown:

•	 Fee – The RVU fee that would have been attached to a procedure had the RVU fee from the 
RVU schedule you selected (when setting up the report options) been used.

•	 RVU – The RVU fee attached to the procedure posted in the Ledger.

C.	 Insurance Carrier Totals – The total fees, co-pays, (Fee - RVU), office visits, and patients seen 
appear for each insurance carrier. The following is an explanation of the insurance carrier’s Fee 
and CoPay totals:

•	 Fee – The RVU fee that would have been attached to a procedure, had the RVU fee from the 
RVU schedule you selected (when setting up the report options) been used.

•	 CoPay – The RVU fee attached to the procedure posted in the Ledger.

D.	Grand Totals – The Grand Totals section displays the following information:

•	 Fee – The total RVU fees that would have been attached to a procedure, had the RVU fee 
from the RVU schedule you selected (when setting up the report options) been used.

•	 Co-Pay – The total RVU fees attached to the procedures posted in the Ledger.

•	 (Fee - RVU) – The total RVU revenue that would have been gained or lost, had the RVU fee 
schedule you selected (when setting up the report options) been used when posting the 
procedures. A positive number indicates the practice would have gained RVU revenue. A 
negative number indicates the practice would have lost RVU revenue.

•	 Total Office Visits – The total number of office visits (multiple procedures performed on a 
patient on the same date count as one office visit).

•	 Total Patients Seen – The total number of patients that appear on the report.
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Secondary Insurance Claims Not 
Created Report
The Secondary Insurance Claims Not Created Report displays primary insurance claims for which 
secondary insurance claims were never created. Claims are sorted according to the expiration date 
of the secondary insurance carrier.

Why:	 To ensure all possible secondary insurance claims are submitted

When:	 Weekly or daily

04/01/2018 - 05/05/2018 
<ALL> - <ALL>

Dental Secondary Insurance Claims Not Created
Date Range:

Patient Range:
Include Primary Claims not received: Yes

Carrier Range: Insurance Carriers: <ALL>    -    <ALL>
<ALL>Clinics:
<ALL>Providers:
<ALL>Billing Types:

Page 1 of 1Report Generated By: enterprise

SECONDARY INSURANCE COMPANY CLM AMOUNT EXPIRESPROVIDER CLINIC

Report Date: 05/05/2018

PRM CLAIM DATE PATIENT NAME 

05/05/2018 Abbott, James S Aetna Life and Casualty DROBB             CENTRAL 801.00         11/01/2011
05/05/2018   Little, Brian Metropolitan Life DDS1 CENTRAL 450.00          08/03/2011
05/05/2018 Perkins, Peggy Connecticut General DDS1 CENTRAL 800.00          05/05/2011
05/05/2018   Smith, Michael   Principal Mutual Life Ins Co DDS01             CENTRAL 501.00          05/05/2011

TOTAL OF CLAIMS NOT CREATED: 2,552.00

A B C
D
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How do I run the Secondary Insurance Claims Not 
Created Report?
From the DXOne Reporting module, select Ledger, and then double-click Secondary Insurance 
Claims Not Created. For additional details about running this report, see the “Secondary 
Insurance Claims Not Created Report” topic in the DXOne Reporting portion of the Dentrix 
Enterprise Help (from the Help menu of any module, click Contents).

What important information does this report provide?
A.	Prm Claim Date – The date of the primary insurance claim.

B.	 Clm Amount – The amount of the original claim.

C.	 Expires – The date the secondary 
insurance claim must be submitted to the 
insurance carrier. The expiration date is 
found in the Insurance Coverage dialog 
box. To access the Insurance Coverage 
dialog box, double-click the Insurance 
block in the Family File, select the 
secondary insurance carrier, and then click 
Coverage Table.

D.	Total Of Claims Not Created – The total 
amount of the secondary claims that were 
not created.

C
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Secondary Pre-Treatment Estimates 
Not Created Report
The Secondary Pre-treatment Estimates Not Created Report displays primary estimates for which 
secondary estimates were never created. Estimates are sorted according to the expiration date of 
the secondary insurance carrier.

Why:	 To ensure all possible secondary pre-treatment estimates are submitted

When:	 Weekly or daily

04/01/2018 - 05/05/2018 
<ALL> - <ALL>

Dental Secondary Pre-Treatment Estimates Not Created
Date Range:

Patient Range:
Include Primary Pre-Treatment Estimates not received: Yes

Carrier Range: Insurance Carriers: <ALL>    -    <ALL>
<ALL>Clinics:
<ALL>Providers:
<ALL>Billing Types:

Page 1 of 1Report Generated By: enterprise

SECONDARY INSURANCE COMPANY CLM AMOUNT EXPIRESPROVIDER CLINIC

Report Date: 05/05/2018

PRM CLAIM DATE PATIENT NAME 

04/23/2018 Abbott, James S Aetna Life and Casualty DROBB            CENTRAL 654.00         10/20/2018
04/23/2018 Abbott, James S Aetna Life and Casualty DROBB            CENTRAL 898.00         10/20/2018
05/05/2018 Little, Brian Metropolitan Life DDS1 CENTRAL 1,100.00          08/03/2018
05/05/2018 Perkins, Peggy Connecticut General DDS1 CENTRAL 300.00         05/05/2019
05/05/2018 Smith, Michael Principal Mutual Life Ins Co DDS01             CENTRAL 790.00         05/05/2019

TOTAL OF CLAIMS NOT CREATED: 3,742.00D
A B C
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How do I run the Secondary Pre-Treatment Estimates Not 
Created Report?
From the DXOne Reporting module, select Ledger, and then double-click Secondary Pre-
Treatment Est. Not Created. For additional details about running this report, see the “Secondary 
Pre-Treatment Estimates Not Created Report” topic in the DXOne Reporting portion of the Dentrix 
Enterprise Help (from the Help menu of any module, click Contents).

What important information does this report provide?
A.	Prm Claim Date – The date of the primary pre-treatment estimate.

B.	 Clm Amount – The amount of the original pre-treatment estimate.

C.	 Expires – The date the secondary 
insurance claim must be submitted to the 
insurance carrier. The expiration date is 
found in the Insurance Coverage dialog 
box. To access this dialog box, double-
click the Insurance block in the Family File, 
select the secondary insurance carrier, and 
then click Coverage Table.

D.	Total Of Claims Not Created – The total 
amount of the secondary pre-treatment 
estimates that were not created.

C
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Standard Coverage Tables Report
The Standard Coverage Table Report allows you to view and print standard coverage tables.

Note: If you want coverage information for a specific insurance carrier, see the “Insurance 
Coverage Tables Report” on page 120.

Why:	 To ensure standard coverage tables are set up properly

When:	 As needed

STANDARD COVERAGE TABLES
The Dentist Group

Date: Page:04/22/2018 1
Tables 1 - 5

Coverage Table 1: Default Coverage Table

BEGIN END COV CO PRE
PROC PROC   CATEGORY  % DEDUCTIBLE PAY AUTH?

D0100 D1999 Diag/Preventive 100 Standard 0.00 N
D2000 D2699 Basic Restor 80 Standard 0.00 N
D2700 D2899 Crowns 50 Standard 0.00 N
D2900 D2999 Restorative 80 Standard 0.00 N
D3000 D3999 Endodontics 80 Standard 0.00 N
D4000 D4999 Periodontics 80 Standard 0.00 N
D5000 D5999 Prostho, remov 50 Standard 0.00 N
D6000 D6999 Prostho, fixed 50 Standard 0.00 N
D7000 D7999 Oral Surgery 80 Standard 0.00 N
D8000 D8999 Orthodontics 50 Standard 0.00 N
D9000 D9999 General Service 80 Standard 0.00 N

Coverage Table 2: All Procedures (Cap Plan)

BEGIN END COV CO PRE
PROC PROC   CATEGORY  % DEDUCTIBLE PAY AUTH?

D0110 D0110 Initial oral ex 100 Standard 0.00 N
D0120 D0120 Periodic oral x 100 Standard 0.00 N
D0130 D0130 Emergency oral 100 Standard 0.00 N
D0210 D0210 Intraoral-compl 100 Standard 0.00 N
D0220 D0220 Intraoral-peria 100 Standard 0.00 N
D0230 D0230 Intraoral-peria 100 Standard 0.00 N
D0240 D0240 Intraoral-occlu 100 Standard 0.00 N
D0250 D0250 Extraoral-first 100 Standard 0.00 N
D0260 D0260 Extraoral-each 100 Standard 0.00 N
D0270 D0270 Bitewing-single 100 Standard 0.00 N
D0272 D0272 Bitewings-two f 100 Standard 0.00 N
D0274 D0274 Bitewings-four 100 Standard 0.00 N
D0290 D0290 Skull &facial b 100 Standard 0.00 N
D0315 D0315 Saliography 100 Standard 0.00 N
D0320 D0320 TMJ arthrogram, 100 Standard 0.00 N
D0321 D0321 Other TMJ films 100 Standard 0.00 N
D0322 D0322 Tomographic sur 100 Standard 0.00 N
D0330 D0330 Panoramic film 100 Standard 0.00 N
D0340 D0340 Cephalometric f 100 Standard 0.00 N
D0415 D0415 Bacteriologic s 100 Standard 0.00 N
D0425 D0425 Caries suscepti 100 Standard 0.00 N
D0460 D0460 Pulp vitality t 100 Standard 0.00 N
D0470 D0470 Diagnostic cast 100 Standard 0.00 N
D0471 D0471 Diagnostic phot 100 Standard 0.00 N
D0501 D0501 Histopathologic 100 Standard 0.00 N
D0502 D0502 Other oral path 100 Standard 0.00 N
D0999 D0999 Unspecified dia 100 Standard 0.00 N
D1110 D1110 Prophylaxis-adu 100 Standard 0.00 N
D1120 D1120 Prophylaxis-chi 100 Standard 0.00 N
D1201 D1201 Prophylaxis wit 100 Standard 0.00 N
D1203 D1203 Fluoride w/o pr 100 Standard 0.00 N
D1204 D1204 Fluoride w/o pr 100 Standard 0.00 N
D1205 D1205 Prophylaxis wit 100 Standard 0.00 N
D1310 D1310 Nutritional cou 100 Standard 0.00 N
D1330 D1330 Oral hygiene in 100 Standard 0.00 N
D1351 D1351 Sealant-per too 100 Standard 0.00 N
D1510 D1510 Space maint-fix 100 Standard 0.00 N
D1515 D1515 Space maint-fix 100 Standard 0.00 N
D1520 D1520 Space maint-rem 100 Standard 0.00 N

A B C D
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How do I run the Standard Coverage Tables Report?
In the Office Manager, from the Reports menu, point to Reference, and then click Standard 
Coverage Tables. For additional details about running this report, see the “Standard Coverage 
Table Report” topic in the Office Manager portion of the Dentrix Enterprise Help (from the Help 
menu of any module, click Contents).

What important information does this report provide?
The following report information is found in the Insurance Coverage Table dialog box, which can 
be accessed in the Office Manager. See the “Adding and editing insurance plans” topic in the 
Dentrix Enterprise Help for details on how to edit this information.

A.	Cov % – The percentage of a procedure 
covered by the insurance carrier.

B.	 Deductible – The type of deductible (for 
example, None, Standard, Preventive, or 
Other).

C.	 Co Pay – The co-pay amount.

D.	Pre Auth? – Indicates whether or 
not a procedure group requires pre-
authorization from the insurance carrier.

A B C D
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Suspended Credits Report
The Suspended Credits Report lists payments and credits that have been suspended. The report 
includes the guarantor of the account; the date, description, and amount of the credit; the amount 
that has been suspended; the balance on the Ledger; and the collecting clinic.

Why:	 To track accounts with suspended payments and/or credits

When:	 Monthly

Suspended Credits Report
All Current Suspended Credits

Clinics: <ALL>
Billing Types: <ALL>

Sort By: Date
Guarantor Range: <ALL> - <ALL>

Page 1 of 1Report Date: 05/05/2018 Report Generated By: enterprise

Entry Date Patient NameProc Date Description ClinicSuspendedAmount

Clinic: CENTRAL

Guarantor: Reeves, Joshua                    Ledger Balance: -100.00                                     Ledger Suspended: -100.00BT:1

-25.00 CENTRAL04/27/2018 04/27/2018       <FAMILY>                                        -Professional Discount                                  -25.00
-25.00 CENTRAL04/30/2018       <FAMILY>                                        -Credit Adjustment                                        -25.00
-50.00 CENTRAL

04/30/2018 
05/01/2018 05/01/2018       <FAMILY>                                        -Credit Adjustment                                        -50.00

-100.00Guarantor's Report Total:

Guarantor: Winters, Carl                    Ledger Balance: -900.00                                     Ledger Suspended: -900.00BT:1

-900.00 CENTRAL04/30/2018 04/30/2018       <FAMILY>                                        Initial Balance                                              -900.00
-900.00Guarantor's Report Total:

CENTRAL Total Suspended Amount: -1,000.00

Clinic: MESA

Guarantor: Smith, Michael                    Ledger Balance: -25.00                                       Ledger Suspended: -25.00BT:1

-25.00 MESA04/11/2018 04/11/2018 <FAMILY>                                        Special Adjustment                                       -25.00
-25.00Guarantor's Report Total:

MESA Total Suspended Amount: -25.00

Grand Total Suspended Amount: -1,025.00

A B

C

D
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How do I run the Suspended Credits Report?
From the DXOne Reporting module, select Ledger, and then double-click Suspended Credits. 
For additional details about running this report, see the “Suspended Credits Report” topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
For each collecting clinic on the report, the following information appears:

A.	Account Details – For each guarantor listed on the report, the following account details are 
shown:

•	 Ledger Balance – The account balance.

•	 Ledger Suspended – The total suspended credit amount on the account.

•	 Report Total – The total amount of the suspended credits listed on the report for the 
guarantor.

B.	 Credit Details – For each credit, the following details are shown: entry date, procedure date, 
patient name, adjustment description, amount of the adjustment, amount that was suspended, 
and clinic.

C.	 Clinic Total – The total amount of the suspended credits listed for the clinic.

D.	Grand Total – The total amount of the suspended credits listed for all clinics on the report.
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Treatment Case Report
The Treatment Case Report displays treatment-planned procedures for a specific treatment plan 
case. The report may also include other items, such as the patient’s graphical chart and account 
information, case notes, and insurance information.

Why:	 To print a treatment case created for a patient

When:	 As needed

My Dental Corporation Dennis Smith, D.M.D
1234 Pine Dr, 

Americcan Fork, UT 11111   PHONE: (801)555-1111

REPORT DATE: 02/24/2020Name Brent Crosby
Birthdate 11/11/1973
SSN 111-11-1111
Chart Number CRO101

Treatment Plan
DATE SEC INSPRI INSPATFEEPROVCODESURFTHVISIT DESCRIPTION

02/24/2020 1 4 D D2110 DSMITH 158.40 0.00 31.68126.72
Anticipate straightforward and low-risk procedure.Notes:

158.40 0.00 126.72 31.68Visit 1 Totals:

02/24/2020 2 13 D7280 DSMITH 825.92 0.00 165.18660.74 Surgical method to expose a 
covered tooth so it can grow in 
normally

825.92 0.00 660.74 165.18Visit 2 Totals:

02/24/2020 3 19 D2750 DSMITH 158.40 0.00 79.2079.20 Crown restoration made of 
porcelain fused to high noble 
metal (has a strong, 
hypo-allergenic base)

158.40 0.00 79.20 79.20Visit 3 Totals:

TOTALSINSURANCE PROVIDER(S)
Secondary

Delta PMI Aetna Life and Casualty 1,142.72 0.00 866.66 276.06
 Sec Ins Pri Ins Pat FeePrimary

FINANCIAL SUMMARY
1142.72Treatment Plan Total

Estimated Insurance Payment
Estimated Deductible to be Applied

Estimated Patient's Portion

0.00
1142.72

0.00
Finance Status

3323.50Patient Balance
4594.32Family Balance

Fee Expiration Date 04/04/2019

DENTAL INSURANCE BENEFITS
Patient Family

Secondary Primary SecondaryPrimary

Deductible Owed YTD
Benefits Expire
Est. Benefits Remaining YTD
Pending Insurance Est. YTD
Paid Benefits YTD
Annual Plan Benefits

Standard
Preventative
Other

0.00

0.00
0.00
0.00

0.00
0.00
0.00

12/31/2020 12/31/2020

0.00
0.00

0.00

0.00
0.00
0.00

1500.00

12/31/2020 2/31/2020
1500.00

0.00

0.00

0.00
50.00

0.00

0.00
0.00

0.00
0.00
0.00

0.00 0.000.00

Alternate Cases: New Case
Case Notes: - Mon - Feb 24 2020 - 
Patient will call back for an appointment if he wants to move forward with the treatment.

PAGE 01 of 02

B

C
D

E

F

A
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My Dental Corporation Dennis Smith, D.M.D
1234 Pine Dr, 

Americcan Fork, UT 11111   PHONE: (801)555-1111

REPORT DATE: 02/24/2020Brent CrosbyName
11/11/1973Birthdate
111-11-1111SSN
CRO101Chart Number

Consent for Treatment
Treatment Plan

I, the undersigned patient, hereby authorize the undersigned provider to perform the procedure(s). 

D2110:Amalgam-1 surface, primary [4 D]; Entry Date: 2/24/2020; Date: 2/24/2020; Visit: 1; Provider: DSMITH; 
Clinic: AF; Fee: $158.40; Patient Portion: $0.00; Primary Insurance Estimate: $126.72; Secondary Insurance 
Estimate: $31.68
D7280:Surgical access unreupted tooth [13 ]; Entry Date: 2/24/2020; Date: 2/24/2020; Visit: 2; Provider: 
DSMITH; Clinic: AF; Fee: $825.92; Patient Portion: $0.00; Primary Insurance Estimate: $660.73; Secondary 
Insurance Estimate: $165.19
D2750:Crown-porc fuse high noble mtl [19 ]; Entry Date: 2/24/2020; Date: 2/24/2020; Visit: 3; Provider: 
DSMITH; Clinic: AF; Fee: $158.40; Patient Portion: $0.00; Primary Insurance Estimate: $79.20; Secondary 
Insurance Estimate: $79.20

PAGE 02 of 02

Patient/Representative Signature: Practice Signature:

Name:
Date: 02/24/2020

Brent Crosby Name:
Date:

Dennis Smith, D.M.D
02/24/2020

G

How do I run the Treatment Case Report?
1.	 In the Treatment Planner, select the case of which you want to generate a report.

2.	 From the File menu, point to Print, and then click Print Treatment Case.

For additional details about running this report, see the “Printing the Treatment Case Report” 
topic in the Treatment Planner portion of the Dentrix Enterprise Help (from the Help menu of any 
module, click Contents).

What important information does this report provide?
A.	Treatment – The treatment-planned procedures are grouped by visit. A subtotal of fees, patient 

portions, and insurance estimates for each visit are given. If a treatment-planned procedure has 
notes entered, those notes appear after the treatment details of that  procedure.

B.	 Insurance Estimates – The patient’s insurance carriers are listed along with the fees, patient 
portions, and insurance estimates for the entire treatment plan.

C.	 Graphical Chart – The patient’s graphical chart is shown with all applicable treatment and 
conditions that have a paint type.

D.	Financial Summary – The treatment plan total, patient and insurance estimates, and account 
information are shown.

E.	 Insurance Benefits – Details of the current insurance plan maximums and deductibles for the 
patient and family are shown.

F.	 Treatment Case Note – Any linked cases are listed, and any notes attached to the case are 
shown.

G.	Consent Forms – Any consent forms and corresponding signatures that are attached to the 
case are printed on separate pages.
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Treatment Plan Approval Report
The Treatment Plan Approval Report displays all treatment-planned procedures.

Why:	 To ensure the practice follows up on treatment plans

When:	 Weekly

TREATMENT PLAN APPROVAL REPORT
CENTRAL

Sorted By: Patient
03/08/2018 - 03/08/2018 
Providers: ALL Providers

03/08/2018 Page: 1
Chart # Patient Patient DOB Guarantor Primary Insurance Carrier Group # Last Elig Date Ben Remain Ou

Home Phone Employer Secondary Insurance Carrier Group # Last Elig Date Ben Remain Ou
Prov Date Code Tooth Surfaces Description Order Appt Date Amount Pri Ins Est Sec Ins Est Pri Pre-Est S

LIT102 Little, Brian 11/11/1981 Little, Dean Acme Benefits Assoc CS1740 3000.00
(801)555-6241 Aetna Life and Casualty 321863

01/01/2018 
01/01/2018 2000.00

DDS1 03/08/2018 D6792 16 Retainer crn-full cast nob met 0 03/14/2018 570.00 550.00 20.00 03/08/2
DDS1 03/08/2018 D6792 17 Retainer crn-full cast nob met 0 03/14/2018 540.00 540.00 0.00 03/08/2
DDS1 03/08/2018 D6970 22 Post/core + brdg retainer, fabr 0 230.00 230.00 0.00 03/08/2

LIT101 Little, Carol 11/11/1960 Little, Dean Aetna Life and Casualty 321863 2000.00
(801)555-6241 Acme Clothing Acme Benefits Assoc CS1740

01/01/2018 
01/01/2018 3000.00

DDS1 03/08/2018 D6750  1 Retainer crn-porc fused-hi nob 0 03/14/2018 614.00 471.20 142.80 03/08/2
DDS1 03/08/2018 D6240  2 Pontic-porcelain fused to hnob 0 03/14/2018 621.00 496.80 124.20 03/08/2
DDS1 03/08/2018 D6750  3 Retainer crn-porc fused-hi nob 0 03/14/2018 614.00 491.20 122.80 03/08/2
DDS1 03/08/2018 D6750  5 Retainer crn-porc fused-hi nob 0 614.00 491.20 122.80 03/08/2
DDS1 03/08/2018 D6240  6 Pontic-porcelain fused to hnob 0 03/14/2018 621.00 49.60 571.40 03/08/2
DDS1 03/08/2018 D6750  7 Retainer crn-porc fused-hi nob 0 614.00 0.00 613.00 03/08/2

LIT105 Little, Chad 11/11/1988 Little, Dean Acme Benefits Assoc CS1740 3000.00
(801)555-6241 Aetna Life and Casualty 321863

01/01/2018 
01/01/2018 2000.00

DDS1 03/08/2018 D1120 Prophylaxis-child 0 03/14/2018 1240.00 14.00 972.00 03/08/2
DDS1 03/08/2018 D2110  6 D Amalgam-1 surface, primary 0 03/14/2018 300.00 51.00 240.00 03/08/2

LIT100 Little, Dean 11/11/1959 Little, Dean Acme Benefits Assoc CS1740 01/01/2018 3000.00
(801)555-6241 Acme Bank Aetna Life and Casualty 321863 2000.00

DDS1 03/08/2018 D0140 Limited oral evaluation 0 03/14/2018
01/01/2018 

80.00 5.00 44.00 03/08/2
DDS1 03/08/2018 D0120 Periodic oral evaluation 0 03/14/2018 31.00 20.00 11.00 03/08/2
DDS1 03/08/2018 D2150 14 MO Amalgam-2 surf. prim/perm 0 600.00 75.00 480.00 03/08/2

LIT106 Little, Kevin 04/23/1990 Little, Dean Acme Benefits Assoc CS1740 3000.00
(801)555-6241 Aetna Life and Casualty 321863

01/01/2018 
01/01/2018 2000.00

DDS1 03/08/2018 D2391 18 O Resin composite-1s, posterior 0 03/14/2018 274.00 199.20 74.80 03/08/2

Total of all Treatment Plans:  7563.00

Total of all Scheduled Treatment Plans:  5505.00C

B

A
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How do I run the Treatment Plan Approval Report?
In the Office Manager, from the Reports menu, point to Lists, and then click Treatment Plan 
Approval Report. For additional details about running this report, see the “Treatment Plan 
Approval Report” topic in the Office Manager portion of the Dentrix Enterprise Help (from the 
Help menu of any module, click Contents).

What important information does this report provide?
A.	Patient information – The patient’s name, phone number, insurance company, insurance 

eligibility, and remaining benefits.

B.	 Procedures – The treatment-planned procedures, insurance estimates, and approval statuses.

C.	 Totals

•	 Total Treatment Plans – The total amount of all procedures that have been treatment-
planned.

•	 Total Scheduled Treatment Plans – The total amount of all treatment-planned procedures 
that have been attached to appointments.
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Treatment Plan Approval Status 
Report
The Treatment Plan Approval Status Report displays all treatment-planned procedures for selected 
approval statuses.

Why:	 To ensure the practice follows up on treatment plans

When:	 Weekly

TREATMENT PLAN APPROVAL STATUS REPORT
CENTRAL

Sorted By: Patient
03/08/2018 - 03/08/2018 
Providers: ALL Providers

03/08/2018 Page: 1
Chart # Patient Patient DOB Guarantor Primary Insurance Carrier Group # Last Elig Date Ben Remain Ou

Home Phone Employer Secondary Insurance Carrier Group # Last Elig Date Ben Remain Ou
Prov Date Code Tooth Surfaces Description Order Appt Date Amount Pri Ins Est Sec Ins Est Pri Pre-Est S

LIT102 Little, Brian 11/11/1981 Little, Dean Acme Benefits Assoc CS1740 3000.00
(801)555-6241 Aetna Life and Casualty 321863

01/01/2018 
01/01/2018 2000.00

DDS1 03/08/2018 D6792 16 Retainer crn-full cast nob met 0 03/14/2018 570.00 550.00 20.00 03/08/2
DDS1 03/08/2018 D6792 17 Retainer crn-full cast nob met 0 03/14/2018 540.00 540.00 0.00 03/08/2
DDS1 03/08/2018 D6970 22 Post/core + brdg retainer, fabr 0 230.00 230.00 0.00 03/08/2

LIT101 Little, Carol 11/11/1960 Little, Dean Aetna Life and Casualty 321863 2000.00
(801)555-6241 Acme Clothing Acme Benefits Assoc CS1740

01/01/2018 
01/01/2018 3000.00

DDS1 03/08/2018 D6750  1 Retainer crn-porc fused-hi nob 0 03/14/2018 614.00 471.20 142.80 03/08/2
DDS1 03/08/2018 D6240  2 Pontic-porcelain fused to hnob 0 03/14/2018 621.00 496.80 124.20 03/08/2
DDS1 03/08/2018 D6750  3 Retainer crn-porc fused-hi nob 0 03/14/2018 614.00 491.20 122.80 03/08/2
DDS1 03/08/2018 D6750  5 Retainer crn-porc fused-hi nob 0 614.00 491.20 122.80 03/08/2
DDS1 03/08/2018 D6240  6 Pontic-porcelain fused to hnob 0 03/14/2018 621.00 49.60 571.40 03/08/2
DDS1 03/08/2018 D6750  7 Retainer crn-porc fused-hi nob 0 614.00 0.00 613.00 03/08/2

LIT105 Little, Chad 11/11/1988 Little, Dean Acme Benefits Assoc CS1740 3000.00
(801)555-6241 Aetna Life and Casualty 321863

01/01/2018 
01/01/2018 2000.00

DDS1 03/08/2018 D1120 Prophylaxis-child 0 03/14/2018 1240.00 14.00 972.00 03/08/2
DDS1 03/08/2018 D2110  6 D Amalgam-1 surface, primary 0 03/14/2018 300.00 51.00 240.00 03/08/2

LIT100 Little, Dean 11/11/1959 Little, Dean Acme Benefits Assoc CS1740 01/01/2018 3000.00
(801)555-6241 Acme Bank Aetna Life and Casualty 321863 2000.00

DDS1 03/08/2018 D0140 Limited oral evaluation 0 03/14/2018
01/01/2018 

80.00 5.00 44.00 03/08/2
DDS1 03/08/2018 D0120 Periodic oral evaluation 0 03/14/2018 31.00 20.00 11.00 03/08/2
DDS1 03/08/2018 D2150 14 MO Amalgam-2 surf. prim/perm 0 600.00 75.00 480.00 03/08/2

LIT106 Little, Kevin 04/23/1990 Little, Dean Acme Benefits Assoc CS1740 3000.00
(801)555-6241 Aetna Life and Casualty 321863

01/01/2018 
01/01/2018 2000.00

DDS1 03/08/2018 D2391 18 O Resin composite-1s, posterior 0 03/14/2018 274.00 199.20 74.80 03/08/2

Total of all Treatment Plans:  7563.00

Total of all Scheduled Treatment Plans:  5505.00C

B

A
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How do I run the Treatment Plan Approval Status 
Report?
In the Office Manager, from the Reports menu, point to Lists, and then click Treatment Plan 
Approval Status Report. For additional details about running this report, see the “Treatment Plan 
Approval Status Report” topic in the Office Manager portion of the Dentrix Enterprise Help (from 
the Help menu of any module, click Contents).

What important information does this report provide?
A.	Patient information – The patient’s name, phone number, insurance company, insurance 

eligibility, and remaining benefits.

B.	 Procedures – The treatment-planned procedures, insurance estimates, and approval statuses.

C.	 Totals

•	 Total Treatment Plans – The total amount of all procedures that have been treatment-
planned.

•	 Total Scheduled Treatment Plans – The total amount of all treatment-planned procedures 
that have been attached to appointments.
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Truth in Lending Disclosure 
Statement
The Truth in Lending disclosure statement is a legal document used to clarify the terms of a 
payment agreement. You might want to print this report and provide it to patients at the time a 
payment agreement is created.

Why:	 To ensure patients are adequately informed of the terms of a payment agreement

When:	 After creating a payment agreement, and as needed

PRACTICE NAME AND ADDRESS

The Allied Dentist Group
123 East Valley Dr
American Fork, UT  84003
(801)555-9300

GUARANTOR NAME AND ADDRESS

Patricia  Abbott
1234 Oak St
Murray, UT  84123
555-1586

Date: 04/23/2011
Chart #: ABB102

SS #: 000-00-0000
Loan Amount: $ 5956.04
Interest Rate: 12.000 %

FEDERAL TRUTH-IN-LENDING DISCLOSURE STATEMENT
ANNUAL
PERCENTAGE
RATE
The cost of your
credit as a yearly
rate.

%12.683

FINANCE
CHARGE
The dollar amount
the credit will cost
you.

$ 214.40

AMOUNT
FINANCED
The amount of credit
provided to you or
on your behalf.

$ 5956.04

TOTAL OF
PAYMENTS
The amount you
will have paid after
you have made all
payments as
scheduled.
$ 6170.44

PAYMENT SCHEDULE SUMMARY

Num Payments: 6 Amt Each Payment: $1000.00
Last Payment Amt: $1170.44

First Payment Due: 04/30/2018 
Last Payment Due: 09/30/2018

Late Charge: If any payment is late, you will be charged 0.417% of the installment, or at least $20.00.
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How do I generate a truth in lending statement?
1.	 From the Ledger, click the Payment Agreement button  to open the Billing/Payment 

Agreement Information dialog box.

2.	 Click Print to open the Print for Payment Agreement dialog box.

3.	 Select Truth in Lending Disclosure Statement.

4.	 Click Print or Send to Batch.

For additional details about running this report, see the “Printing payment agreement documents” 
topic in the Ledger portion of the Dentrix Enterprise Help (from the Help menu of any module, 
click Contents).
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UDS - Age/Gender Report
The UDS - Age/Gender report lists the patients of each gender for each age group and provides 
totals, using the UDS (Uniform Data System) standards for reporting.

Why:	 To generate a record of patient genders and ages for UDS reporting for 
comparison with national data, and to provide gender and age data for patients 
to grantees, partners, and communities

When:	 As needed

AGE/GENDER REPORT
01/01/2017 - 12/31/2017 Procedure Date

Clinics: AF, CENTRAL, DRAPER
Providers: <ALL>

Billing Types: <ALL>
ADA Codes: <ALL>

Ages: <ALL>

Report Generated By: enterprise Page 1 of 1Report Date: 12/31/2017

MALE FEMALE OTHER UNKNOWN TOTALAGE

PATIENT NAME SOCIAL SECURITY # EMR # CHART # BIRTHDATE GENDER

AGE 21 1 0 01 2
Little, Brian                                   000-00-0000                                                                       LIT123    11/11/1987 Male
Perkins, Shelly 000-00-0000 PER123 11/11/1987 Female

AGE 22 1 0 01 2
Johnson Roger    000-00-0000 JOH123   11/11/1986   Male
Perkins, Peggy 000-00-0000  PER124 11/11/1986                Female

AGE 38 0 0 02 2
Gleason, Gary 000-00-0000 GLE123 11/11/1970 Male
Smith, Michael                              000-00-0000 SMI123 11/11/1970 Male

AGE 40 1 0 01 2
Little, Carol                                   000-00-0000                                                                       LIT124                             11/11/1969 Female
Taylor, Mark                                 000-00-0000 TAY123 11/11/1969 Male

AGE 49 0 0 02 2
Abbott, James S             000-00-0000 ABB123 11/11/1960 Male
Perkins, Samuel           000-00-0000  PER127 11/11/1960 Male

AGE 51 0 0 02 2
Little, Matthew                              000-00-0000                                                                       LIT129   11/11/1957 Male
Nelson, Chris                                000-00-0000 NEL123 11/11/1957 Male

AGE 60 0 0 01 1
Taylor, Lissa                                 000-00-0000 TAY123 11/11/1949 Female

GRAND TOTALS 10 3 0 0 13

B

C A

D
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AGE/GENDER REPORT
01/01/2017 - 12/31/2017 Procedure Date

Clinics: AF, CENTRAL, DRAPER
Providers: <ALL>

Billing Types: <ALL>
ADA Codes: <ALL>

Ages: <ALL>

Report Generated By: enterprise Page 1 of 2Report Date: 12/31/2017

MALE FEMALE OTHER UNKNOWN TOTALAGE

PATIENT NAME SOCIAL SECURITY # EMR # CHART # BIRTHDATE GENDER

DDS01

CENTRAL

AGE 22 1 0 00 1
Perkins, Peggy                             000-00-0000                                                                       PER007    11/11/1987               Female

AGE 38 0 0 01 1
Smith, Michael                              000-00-0000                                                                      SMI008                           11/11/1970                  Male

AGE 49 0 0 01 1
Perkins, John 000-00-0000                                                                      PER008 11/11/1960 Male

CENTRAL TOTALS 2 1 0 0 3

DDS01 TOTALS 2 1 0 0 3

DDS1

CENTRAL

AGE 21 0 0 01 1
Little, Brian R 000-00-0000 LIT008                             11/11/1986 Male 12/12/1987

AGE 51 0 0 02 2
Reeves, Joshua 000-00-0000 REE008 11/11/1957 Male
Taylor, Mark 000-00-0000                                                                      PER008                           11/11/1957  Male

CENTRAL TOTALS 3 0 0 0 3

DRAPER

AGE 22 0 0 01 1
Johnson, Ron 000-00-0000 JOH008 11/11/1987   Male

AGE 38 0 0 01 1
Gleason, Gary                              000-00-0000  GLE008 11/11/1970  Male

AGE 40 1 0 00 1
Young, Tina

E

AGE/GENDER REPORT
01/01/2017 - 12/31/2017 Procedure Date

Clinics: AF, CENTRAL, DRAPER
Providers: <ALL>

Billing Types: <ALL>
ADA Codes: <ALL>

Ages: <ALL>

Report Generated By: enterprise Page 1 of 2Report Date: 12/31/2017

MALE FEMALE OTHER UNKNOWN TOTALAGE

PATIENT NAME SOCIAL SECURITY # EMR # CHART # BIRTHDATE GENDER

CENTRAL

DDS01

AGE 22 1 0 00 1
Perkins, Peggy                             000-00-0000                                                                      PER123                            11/11/1987 Female

AGE 38 0 0 01 1
Smith, Michael                              000-00-0000                                                                      SMI123                            11/11/1970 Male

AGE 49 0 0 01 1
Perkins, Scott                               000-00-0000                                                                      PER124                            11/11/1960 Male

DDS01 TOTALS 2 1 0 0 3

DDS1

AGE 21 0 0 01 1
Little, Brian R                                000-00-0000                                                                      LIT126                              11/11/1986 Male

AGE 51 0 0 02 2
Myers, Timothy                             000-00-0000                                                                      MYE123                           11/11/1957 Male
Perkins, Shelly                             000-00-0000                                                                       PER125                           11/11/1957 Female

DDS1 TOTALS 3 0 0 0 3

DROBB

AGE 49 0 0 01 1
Abbott, James S 000-00-0000 ABB125 11/11/1960 Male

DROBB TOTALS 1 0 0 0 1

MCCLURE

AGE 40 0 0 01 1
Taylor, Mark                                 000-00-0000                                                                       TAY123    11/11/1969 Male

MCCLURE TOTALS 1 0 0 0 1

CENTRAL TOTALS 7 1 0 0 8F
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How do I run the UDS - Age/Gender Report?
From the DXOne Reporting module, select UDS, and then double-click UDS - Age/Gender. For 
additional details about running this report, see the “UDS - Age/Gender Report” topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
The report can be grouped and subtotaled by provider with a breakdown by clinic. Or, the report 
can be grouped and subtotaled by clinic with a breakdown by provider. The following information 
appears on the report:

A.	Age – The patient’s age.

B.	 Patient – The patient’s name, Social Security number, EMR number, Chart number, birthdate, 
and gender. (This information appears only if Include Patient Info is selected when setting up 
options for this report.)

C.	 Gender Totals – The number of patients of the given age for each gender (male, female, other, 
and unknown) and a total of all genders for patients of the given age.

D.	Grand Totals – The gender totals for all ages that appear on the report.

E.	 Provider Totals – The gender totals of patients of all the given ages whose primary provider is 
the given provider.

F.	 Clinic Totals – The gender totals of patients of all the given ages that visit the given clinic.
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UDS - Encounters and Users by 
Selected Procedure Codes Report
The UDS - Encounters and Users by Selected Procedure Codes Report displays the number 
of patient encounters with primary and secondary providers that performed procedures in the 
specified range, using the UDS (Uniform Data System) standards for reporting.

Why:	 To generate a record of patient encounters for UDS reporting for comparison 
with national data, and to provide patient encounter data to grantees, partners, 
and communities

When:	 As needed

Encounters and Users by Selected Procedure Codes
05/13/2018 - 05/13/2018 Procedure Date

Clinics: <ALL>
Providers: <ALL>

Billing Types: <ALL>
ADA Codes: <ALL>

Report Generated By: enterprise Page 1 of 1Report Date: 05/13/2018

# Users:

51# Encounters:

27
A

B
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How do I run the UDS - Encounters and Users by 
Selected Procedure Codes Report?
From the DXOne Reporting module, select UDS, and then double-click UDS - Encounter/User 
Statistics. For additional details about running this report, see the “UDS - Encounter and User 
Statistics Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the 
Help menu of any module, click Contents).

What important information does this report provide?
A.	Encounters – The total number of patient encounters with providers.

B.	 Users – The total number of users that posted the procedures for the corresponding patient 
encounters total.
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UDS - Encounters by Provider 
Report
The UDS - Encounters by Provider Report displays the number of patient encounters with primary 
and secondary providers that performed procedures in the specified range, using the UDS 
(Uniform Data System) standards for reporting.

Why:	 To generate a record of patient encounters for UDS reporting for comparison 
with national data, and to provide patient encounter data to grantees, partners, 
and communities

When:	 As needed

Encounters by Provider
05/13/2018 - 05/13/2018 Procedure Date

Clinics: <ALL>
Providers: <ALL>

Billing Types: <ALL>
ADA Codes: <ALL>

Report Generated By: enterprise Page 1 of 1Report Date: 05/13/2018

PRIMARY PROVIDERS

Total # Encounters: 51

SECONDARY PROVIDERS

Total # Encounters: 0

A

B
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How do I run the UDS - Encounters by Provider Report?
From the DXOne Reporting module, select UDS, and then double-click UDS - Encounter/User 
Statistics. For additional details about running this report, see the “UDS - Encounter and User 
Statistics Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the 
Help menu of any module, click Contents).

What important information does this report provide?
A.	Encounters (Primary) – The total number of patient encounters with primary providers.

B.	 Encounters (Secondary) – The total number of patient encounters with secondary providers.
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UDS - Insurance Financial Class 
Report
The UDS - Insurance Financial Class Report lists the patients of the specified financial classes that 
had procedures performed and provides totals, using the UDS (Uniform Data System) standards for 
reporting.

Why:	 To generate a record of financial class statistics for UDS reporting for comparison 
with national data, and to provide financial class statistics to grantees, partners, 
and communities

When:	 As needed

INSURANCE FINANCIAL CLASS - UDS
05/13/2018 - 05/13/2018 Procedure Date

Clinics: <ALL>
Providers: <ALL>

Billing Types: <ALL>
ADA Codes: <ALL>

Financial Classes: <ALL>

Report Generated By: enterprise Page 1 of 1Report Date: 05/13/2018

TOTAL # USERSFINANCIAL CLASS TYPES 20+ YEARS OF AGE-19 YEARS OF AGE
PATIENT NAME SOCIAL SECURITY # EMR # CHART # BIRTHDATE

UnInsured/Self-Pay 440
Gleason, Gary                                       000-00-0000                                                                       GL0005                                                11/11/1970
Johnson, Ron J 000-00-0000 JO0005 11/11/1986
Little, Carol 000-00-0000 LIM0005 11/11/1969
Smith, Michael P                                   000-00-0000 SM0005                                               11/11/1950

GRAND TOTALS 440

A

B

C
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INSURANCE FINANCIAL CLASS - UDS
05/13/2018 - 05/13/2018 Procedure Date

Clinics: <ALL>
Providers: <ALL>

Billing Types: <ALL>
ADA Codes: <ALL>

Financial Classes: <ALL>

Report Generated By: enterprise Page 1 of 1Report Date: 05/13/2018

TOTAL # USERSFINANCIAL CLASS TYPES 20+ YEARS OF AGE-19 YEARS OF AGE
PATIENT NAME SOCIAL SECURITY # EMR # CHART # BIRTHDATE

DDS1

DRAPER

UnInsured/Self-Pay 330
Gleason, Gary                                       000-00-0000 GL0005                                              11/11/1970
Johnson, Ron J 000-00-0000 JO0005 11/11/1986
Little, Carol 000-00-0000 LI0005   11/11/1969

DRAPER TOTALS 330

DDS1 TOTALS 330

DDS2

MESA

UnInsured/Self-Pay 110
Smith, Michael P                                   000-00-0000 SM0005                                              11/11/1950

MESA TOTALS 110

DDS2 TOTALS 110

GRAND TOTALS 440

D

INSURANCE FINANCIAL CLASS - UDS
05/13/2018 - 05/13/2018 Procedure Date

Clinics: <ALL>
Providers: <ALL>

Billing Types: <ALL>
ADA Codes: <ALL>

Financial Classes: <ALL>

Report Generated By: enterprise Page 1 of 1Report Date: 05/13/2018

TOTAL # USERSFINANCIAL CLASS TYPES 20+ YEARS OF AGE-19 YEARS OF AGE
PATIENT NAME SOCIAL SECURITY # EMR # CHART # BIRTHDATE

DRAPER

DDS1

UnInsured/Self-Pay 330
Gleason, Gary 000-00-0000 GL0005 11/11/1970
Johnson, Ron J 000-00-0000 JO0005 11/11/1986
Little, Carol 000-00-0000  LI0005 11/11/1969

DDS1 TOTALS 330

DRAPER TOTALS 330

MESA

DDS2

UnInsured/Self-Pay 110
Smith, Michael                                      000-00-0000                                                                        SM0005                                              11/11/1950

DDS2 TOTALS 110

MESA TOTALS 110

GRAND TOTALS 440

E

How do I run the UDS - Insurance Financial Class Report?
From the DXOne Reporting module, select UDS, and then double-click UDS - Insurance Financial 
Class (2012 and Prior). For additional details about running this report, see the “UDS - Insurance 
Financial Class Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from 
the Help menu of any module, click Contents).

What important information does this report provide?
The report can be grouped and subtotaled by provider with a breakdown by clinic. Or, the report 
can be grouped and subtotaled by clinic with a breakdown by provider. The following information 
appears on the report:

A.	Financial Class – The financial class with totals by age range and a total number of users that 
posted the procedures.

B.	 Patient – The patient’s name, Social Security number, EMR number, Chart number, and 
birthdate. (This information appears only if Include Patient Info is selected when setting up 
options for this report.)

C.	 Grand Totals – The totals for all financial classes that appear on the report.

D.	Provider Totals – The financial class totals for patients of the given provider.

E.	 Clinic Totals – The financial class totals for patients that visit the given clinic.



Dentrix Enterprise 11.0.2 Reports Reference

344   UDS - Insurance Financial Class Report (2013)

UDS - Insurance Financial Class 
Report (2013)
The UDS - Insurance Financial Class Report (2013) lists the patients of the specified financial 
classes that had procedures performed and provides totals, using the UDS (Uniform Data System) 
standards for reporting.

Why:	 To generate a record of financial class statistics for UDS reporting for comparison 
with national data, and to provide financial class statistics to grantees, partners, 
and communities

When:	 As needed

7 7

8

A

C

B
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Totals Only (with Patient Information)

Insurance Financial Class
10/01/2013 - 12/31/2013 Entry Date

Insurance Type: Medical Insurance

Clinics: <ALL>

Providers: DSMITH

Billing Types: <ALL>

ADA Codes: <ALL>

Financial Classes: <ALL>

Report Generated By: DSMITH Page 1 of 1Report Date: 01/20/2014

PATIENT NAME EMR #CHART # BIRTHDATE SSNCLINIC PROVIDER

Allen, Test AL00012 1122502/15/1998 123-33-4444DSMITHALPINE

Crosby, Brent CR0004C 11/11/1973 123-45-6789DSMITHAF

18+ Years Old0-17 Years OldCount

Totals:  2  1  1

Grouped Only by Financial Class

Insurance Financial Class
10/01/2013 - 12/31/2013 Entry Date

Insurance Type: Medical Insurance

Clinics: <ALL>

Providers: DSMITH

Billing Types: <ALL>

ADA Codes: <ALL>

Financial Classes: <ALL>

Report Generated By: DSMITH Page 1 of 1Report Date: 01/20/2014

CountFinancial Class 0-17 Years Old 18+ Years Old

<No Insurance>  0  1 1

Other Public, Inc Non-Medicaid CHIP (MC Capitated)  1  0 1

18+ Years Old0-17 Years OldCount

Totals:  2  1  1

How do I run the UDS - Insurance Financial Class Report 
(2013)?
From the DXOne Reporting module, select UDS, and then double-click UDS - Insurance Financial 
Class (2013). For additional details about running this report, see the “UDS - Insurance Financial 
Class Report (2013)” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the 
Help menu of any module, click Contents).

What important information does this report provide?
There are five categories that you can use to group totals on the report: None, Clinic, Provider, ZIP 
Code, and Financial Class. The report displays totals without any groupings if “None” is selected 
for all Group By options when setting up options for this report; otherwise, the report groups 
totals by the first, and then the second, and then the third, and then the fourth selection. The 
following information appears on the report:

A.	Group Totals – Any of the following groups and the corresponding totals may appear:

•	 Clinic – The financial class totals for patients that visit the given clinic.

•	 Provider – The financial class totals for patients with the given primary provider.

•	 ZIp Code – The financial class totals for patients with the given ZIP Code.

•	 Financial Class – The financial class with totals by age range and a total number of users 
that posted the procedures.

B.	 Patient – The patient’s name, Social Security number, EMR number, Chart number, primary 
provider, and birthdate. (This information appears only if Include Patient Info is selected when 
setting up options for this report.)

C.	 Grand Totals – The total number of financial classes that appear on the report. Of the total, 
the number of patients in the first age group appear. Of the total, the number of patients in the 
second age group appear.
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UDS - Medicaid/Medicare Report
The UDS - Medicaid/Medicare Report displays a count of patients with Medicaid and/or Medicare 
and who have had a visit within the reporting period. Patients are counted on the report if they 
have had claims created during the reporting period for any insurance plans that have the specified 
financial classes attached.

Why:	 To generate a record of Medicaid and Medicare patients for UDS reporting 
for comparison with national data, and to provide Medicare/Medicaid patient 
statistics to grantees, partners, and communities

When:	 As needed

8 8
 

8
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How do I run the UDS - Medicaid/Medicare Report?
From the DXOne Reporting module, select UDS, and then double-click UDS - Medicaid/
Medicare. For additional details about running this report, see the “UDS - Medicaid/Medicare 
Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu 
of any module, click Contents).

What important information does this report provide?
The report can be grouped by Clinic, Provider, ZIP Code, and/or Financial Class. The report 
includes the following information:

A.	Patient – The patient’s name, Social Security number, EMR number, Chart number, birth date, 
assigned clinic, and primary provider. (This information appears only if Include Patient Info is 
selected when setting up options for this report.)

B.	 Statistics – The report presents the following statistics:

•	 Total number of Medicaid patients, and the count is broken down by age groups.

•	 Total number of Medicare patients, and the count is broken down by age groups.

•	 Total number of Medicaid and Medicare patients, and the count is broken down by age 
groups.

Notes:

•	 The age group counts appear only if Include Age Groups is selected when setting up options 
for this report

•	 The clinics and providers for the report are determined by each patient’s default provider and 
clinic (as set up from the Family File).
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UDS - Patient Related Revenue 
Report
The UDS - Patient Related Revenue Report displays revenue totals for patients with procedures that 
were completed within a specified date range and for which claims have been created. This report 
uses the UDS (Uniform Data System) standards for reporting.

Why:	 To generate a record of revenue for UDS reporting for comparison with national 
data, and to provide revenue totals to grantees, partners, and communities

When:	 As needed

Server Name: <Default>

PATIENT RELATED REVENUE

12/17/2018 - 12/17/2018  Procedure Date
Clinics: <ALL>

ADA Codes: <ALL>
Report Date: 12/17/2018 Report Generated By: DSMITH Page 1 of 1

Payer Category
Full Charges

This Period

Amount 

Collected

This Period (-)

Retroactive Settlements, Receipts and Paybacks

Allowances 
Sliding 

Discounts 

Bad Debt 

Write-Off 

Collection of

Reconciliation/Wrap

Around Current Year

Collection of

Reconciliation/Wrap

Around Previous 

Years

Collection of

Other Retro Payments: 

P4P, Risk Pools, 

Withholds, etc.

Penalty/Payback

Medicaid, MC  794.00  744.00 0.00 0.00 0.00 0.00 -50.00

Reyes, Jose  794.00  744.00 0.00 0.00 0.00 0.00 -50.00

Medicaid, Non-MC  794.00  794.00 -50.00 0.00 0.00 0.00 0.00

Reyes, Olivia  794.00  794.00 -50.00 0.00 0.00 0.00 0.00

Total Medicaid  1,588.00  1,538.00 -50.00 0.00 0.00 0.00 -50.00

Medicare, MC  794.00  794.00 0.00 0.00 -50.00 0.00 0.00

Reed, Sandy  794.00  794.00 0.00 0.00 -50.00 0.00 0.00

Medicare, Non-MC  734.00  694.00 0.00 0.00 0.00 50.00 0.00

Jackson, Paul  734.00  694.00 0.00 0.00 0.00 50.00 0.00

Total Medicare  1,528.00  1,488.00 0.00 0.00 -50.00 50.00 0.00

Other Public, MC  539.00  539.00 0.00 0.00 0.00 0.00 0.00

Reyes, Emilio  539.00  539.00 0.00 0.00 0.00 0.00 0.00

Other Public, Non-MC  544.00  544.00 0.00 0.00 0.00 0.00 0.00

Jones, Paula  544.00  544.00 0.00 0.00 0.00 0.00 0.00

Total Other Public  1,083.00  1,083.00 0.00 0.00 0.00 0.00 0.00

Private Comm  544.00  544.00 0.00 0.00 0.00

Morales, Debbie  544.00  544.00 0.00 0.00 0.00

Private Non-MC  544.00  544.00 0.00 0.00 0.00

Fisher, Dan  544.00  544.00 0.00 0.00 0.00

Total Private  1,088.00  1,088.00 0.00 0.00 0.00

Individual  994.00  669.00 -200.00 0.00

Tran, Thomas  994.00  669.00 -200.00 0.00

Self-Pay  2,099.00  1,808.00 0.00 -291.00

Jones, Michael  2,099.00  1,808.00 0.00 -291.00

Total Self-Pay  3,093.00  2,477.00 -200.00 -291.00

 8,380.00Total  7,674.00 -50.00  0.00 -50.00  50.00 -50.00 -200.00 -291.00D

A

B

C
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How do I run the UDS - Patient Related Revenue Report?
From the DXOne Reporting module, select UDS, and then double-click UDS - Patient Related 
Revenue. For additional details about running this report, see the “UDS - Patient Related Revenue 
Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu 
of any module, click Contents).

What important information does this report provide?
Patients on the report are grouped by financial class within each corresponding payer category.

A.	Financial class – A breakdown of the charges, collections, retroactive collections, allowances, 
sliding discounts, and write-offs for payers of this financial class.

B.	 Patient – A breakdown of the charges, collections, retroactive collections, allowances, sliding 
discounts, and write-offs for a patient.

Note: The report includes patient breakdowns only if Include Patient Info is selected when 
setting up options for this report.

C.	 Payer category total – A breakdown of the total charges, collections, retroactive collections, 
allowances, sliding discounts, and write-offs for payers of the same type of financial class.

D.	Grand total – A breakdown of the sum of the total charges, collections, retroactive collections, 
allowances, sliding discounts, and write-offs for payers in all categories.

Notes:

•	 Sliding discounts and write-offs apply only to uninsured individuals, self-pay patients, and 
insured patient whose charges are not billed to insurance.

•	 Retroactive collections and allowances apply only to insured patients.

•	 The report includes suspended payments and adjustments only if Include Suspended 
Payments and Adjustments is selected when setting up options for this report.
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UDS - Patient Status Report
The UDS - Patient Status Report displays the total the number of patients who have completed 
procedures within a specified date range and who have specified statuses (race, language, poverty 
level, worker status, homeless status, sexual orientation, homeless status, veteran status, ethnicity, 
religion, user-defined, housing status, and/or gender identity) attached to their Family File records. 
The report can also list patients on the report by ZIP Code (optionally sub-grouped by insurance 
carrier financial class) and display patient information for the patients on the report. This report 
uses the UDS (Uniform Data System) standards for reporting.

Why:	 To generate a record of patient statuses for UDS reporting for comparison with 
national data, and to provide patient and financial class statistics to grantees, 
partners, and communities

When:	 As needed

8 8

8
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PATIENT STATUS

5/14/2014 - 5/14/2014  Procedure Date
Clinics: <ALL>

Providers: <ALL>
Billing Types: <ALL>
ADA Codes: <ALL>

Report Date: 5/14/2014 Report Generated By: enterprise Page 1 of 1

REPORT TOTAL

PATIENT NAME SOCIAL SECURITY # EMR # CHART # BIRTHDATE

Race  5

County: Utah  5

Provider: DSMITH  5

Clinic: CENTRAL  5

Black or African American  1

Crosby, Brent 111-11-1111 CR93 11/11/1970
Declined to specify  1

Abbott, James P 333-33-3333 AB31 11/11/1976
White  3

Crosby, Shirley 222-22-2222 CR94 11/11/1972
Winters, Carl 000-00-0000 WI211 11/11/1980
Winters, Barbara 000-00-0001 WI212 11/11/1982

D
E

F

PATIENT STATUS

5/14/2014 - 5/14/2014  Procedure Date
Clinics: <ALL>

Providers: <ALL>
Billing Types: <ALL>
ADA Codes: <ALL>

Report Date: 5/14/2014 Report Generated By: enterprise Page 1 of 1

REPORT TOTAL

PATIENT NAME SOCIAL SECURITY # EMR # CHART # BIRTHDATE

Race  5

County: Utah  5

Clinic: CENTRAL  5

Provider: DSMITH  5

Black or African American  1

Crosby, Brent 111-11-1111 CR93 11/11/1970
Declined to specify  1

Abbott, James P 333-33-3333 AB31 11/11/1976
White  3

Crosby, Shirley 222-22-2222 CR94 11/11/1972
Winters, Carl 000-00-0000 WI211 11/11/1980
Winters, Barbara 000-00-0001 WI212 11/11/1982

How do I run the UDS - Patient Status Report?
From the DXOne Reporting module, select UDS, and then double-click UDS - Patient Status. For 
additional details about running this report, see the “UDS - Patient Status Report” topic in the  
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
The report can be grouped and subtotaled by provider with a breakdown by clinic. Or, the report 
can be grouped and subtotaled by clinic with a breakdown by provider. The report can also 
be grouped by county (either before or after the other grouping options) and subtotaled. The 
following information appears on the report:

A.	Status – The status (race, language, poverty level, worker status, sexual orientation, homeless 
status, veteran status, ethnicity, religion, user-defined, housing status, or gender identity) that 
is being reported on and the total number of patients with that status who have a completed 
procedure that falls within the date range of the report.

B.	 Patient – The patient’s name, Social Security number, EMR number, Chart number, and birth 
date. (This information appears only if Include Patient Info is selected when setting up options 
for this report.)

C.	 Zip Code Statistics – The patients that live in each ZIP Code.

D.	County Totals – The status totals for patients that live in the given county.

E.	 Provider Totals – The status totals for patients of the given provider.

F.	 Clinic Totals – The status totals for patients that visit the given clinic.
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UDS - Sealant Statistics Report
The UDS - Sealant Statistics Report displays the percentage of children, ages 6 through 9, who are 
at a moderate to high risk for caries and who received a sealant on a permanent first molar during 
the reporting period.

Why:	 To generate a record of sealant statistics for UDS reporting for comparison 
with national data, and to provide sealant statistics to grantees, partners, and 
communities

When:	 As needed

7 7

8
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How do I run the UDS - Sealant Statistics Report?
From the DXOne Reporting module, select UDS, and then double-click UDS - Sealant Statistics. For 
additional details about running this report, see the “UDS - Sealant Statistics Report” topic in the 
DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
The report can be grouped by Clinic, Provider, and/or ZIP Code. The report includes the following 
information:

A.	Patient – The patient’s name, Social Security number, EMR number, Chart number, birth date, 
assigned clinic, and primary provider. (This information appears only if Include Patient Info is 
selected when setting up options for this report.)

B.	 Statistics – The report presents the following statistics:

•	 The total number of 6-9 year old children with a moderate to high risk of caries.

•	 The total number of 6-9 year old children that were sampled.

•	 The total number of 6-9 year old children with a moderate to high risk of caries who got 
sealants on permanent first molars (tooth 3, 14, 19, and 30).

•	 The total number of 6-9 year old children with a moderate to high risk of caries but who are 
eligible for exclusion.

Exclusions (for all permanent first molar): the tooth is unerupted, has a restoration, has a 
sealant already (before the start of the measurement period), or cannot be sealed (due to caries 
or fracture).

The measure is calculated using the following numerator and denominator:

•	 Numerator – Number of patients, ages 6 through 9, who were at a moderate to high risk for 
caries and who received a sealant on a permanent first molar tooth during the reporting year. 

•	 Denominator – Number of patients, ages 6 through 9, who had an oral assessment, a 
comprehensive oral evaluation, or a periodic oral evaluation during the reporting year and 
who have a documented moderate to high risk for caries (for example, if the measurement 
year is 2015, the report includes patients whose dates of birth are between January 1, 2006 and 
December 31, 2009, inclusive. 

Note: The clinics and providers for the report are determined by each patient’s default provider 
and clinic (as set up from the Family File).
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UDS - Tobacco Use and Intervention 
Report
The UDS - Tobacco Use and Intervention Report displays the percentage of patients, ages 18 and 
older, who received screenings and interventions for cessation of tobacco use during the reporting 
period.

Why:	 To generate a record of tobacco cessation counseling statistics for UDS reporting 
for comparison with national data, and to provide tobacco cessation counseling 
statistics to grantees, partners, and communities

When:	 As needed

Tobacco Use and Intervention
1/30/2017 - 1/30/2017 Procedure Date

Clinics: <ALL>

Providers: <ALL>

Billing Types: <ALL>

Report Generated By: enterprise Page 1 of 1Report Date: 1/30/2017

PATIENT NAME SOCIAL SECURITY # EMR # CHART # BIRTHDATEBT MEETS 

NUM

MEETS 

DEN EXC

Abbott, James P  1 333-33-3333 AB31 11/11/1976 Y

Crosby, Brent  1 111-11-1111 CR93 11/11/1970 Y

Crosby, Shirley  1 222-22-2222 CR94 11/11/1972

Denominator ExceptionNumeratorDenominatorPatient PopulationGRAND TOTALS

 3  3  1  1

A

B
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How do I run the UDS - Tobacco Use and Intervention 
Report?
From the DXOne Reporting module, select UDS, and then double-click UDS - Tobacco Use and 
Intervention. For additional details about running this report, see the “UDS - Tobacco Use and 
Intervention Report” topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from 
the Help menu of any module, click Contents).

What important information does this report provide?
The report can be grouped by Clinic, Provider, and/or ZIP Code. The report includes the following 
information:

A.	Patient (in the Patient Population) – The patient’s name, billing type, Social Security number, 
EMR number, Chart number, birth date, assigned clinic, and primary provider. Also indicated 
are if the patient is in the numerator or if the patient is an exception in the denominator. (This 
information appears only if Include Patient Detail is selected when setting up options for this 
report.)

B.	 Statistics – The report presents the following statistics:

•	 Patient Population and Denominator –  Number of patients, who had at least one visit 
encounter1 or, depending on the codes used, at least two visit encounters, and who were 18 
years old or older either at the time of the visit or, if there were multiple visits, at the time of 
the earlier of the two most recent visits.

Denominator Exception: A tobacco use assessment was not done either for a medical 
reason2 or due to a limited life expectancy2.

•	 Numerator – Number of patients, ages 18 and older, who had a tobacco use assessment3 
up to 24 months before the end of the reporting period, and who met one of the following 
criteria:

•	 A reported tobacco non-user4 up to 24 months before the end of the reporting period, 
who, afterwards, did not become a tobacco user 24 months or less before the end of the 
reporting period.

•	 A reported tobacco user4 up to 24 months before the end of the reporting period, who, 
afterwards, did not become a tobacco non-user 24 months or less before the end of the 
reporting period, and who started tobacco cessation counseling5 or pharmacotherapy6 
24 months or less before the end of the reporting period.

Note: The clinics and providers for the report are determined by each patient’s default provider 
and clinic (as set up from the Family File).

Footnotes:

1.	 Medical Encounter with an applicable AMA-CPT or SNOMED code (such as 99212 or 12843005).

2.	 Medical Encounter with an applicable SNOMED code (such as 162607003).

3.	 Medical Encounter with an applicable LOINC code (such as 68535-4).

4.	 Medical Encounter with an applicable SNOMED code (such as 105539002).

5.	 Medical Encounter with an applicable SNOMED code (such as 171055003).

6.	 Prescription, or prescription order, with an applicable RXNORM code (such as 1046847).
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Unscheduled Appointment List (DX1)
The Unscheduled Appointment List displays appointments that have been broken or marked as 
wait/will call.

Why:	 To ensure the practice follows up on broken and wait/will call appointments

When:	 Weekly

Server Name: <Default>

Date Range: 01/01/2017 - 12/31/2017

Unscheduled Appointment List

Providers: <ALL>

Page 1 of 1Report Generated By: DSMITHReport Date: 12/19/2018

Status Appointment Reason Length Break ReasonDate Patient Name PhonePROV

11/08/2017 Smith, Angela MHAYES FMIrr  30m Phone 

Cancellation

Broken (801) 555-4321

11/08/2017 Winters, Carl DESMITH UnspcAdjP  10m In-Office 

Cancellation

Broken (801) 555-4444

11/09/2017 Crosby, Brent DESMITH PROPHY  40mWait / Will call

11/22/2017 Harmon, Karen MHAYES Compr Exa, FMX  40m In-Office 

Cancellation

Broken

Total Listed:  4

A

C

B

D E
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How do I run the Unscheduled Appointment List?
From the DXOne Reporting module, select List, and then double-click Unscheduled Appointment 
List. For additional details about running this report, see the “Unscheduled Appointment List” 
topic in the DXOne Reporting portion of the Dentrix Enterprise Help (from the Help menu of any 
module, click Contents).

What important information does this report provide?
The unscheduled appointments on the report can be sorted by the date broken or by the break 
reason. Each clinic’s unscheduled appointments can start on a new page.

A.	Appointment details – For each unscheduled appointment, the report displays the date, 
status, patient’s name, scheduled provider, appointment reason, appointment length, patient’s 
phone number, and break reason.

B.	 Date – The date the appointment was broken or placed on the wait/will call list.

C.	 Patient – The patient’s name.

D.	Phone – The patient’s phone number.

E.	 Break Reason – The reason that the appointment was broken (applies only to broken 
appointments).

Also, the total number of appointments on the report appears.
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Unscheduled Appointment List (OM)
The Unscheduled Appointment List displays patients that have broken an appointment and have 
not re-scheduled. The report includes broken appointments in all clinics.

Why:	 To ensure the practice follows up on broken appointments

When:	 Weekly

Date: Page:04/23/2018 1

UNSCHEDULED APPOINTMENT LIST
The Dentist Group
Provider  <ALL>

04/16/2018 - 04/23/2018

DATE BROKEN PATIENT NAME PROV APPOINTMENT REASON LENGTH PHONE STATUS

04/16/2018 Abbott, James S DDS1 CompEx 10m           555-1586 W/Call
04/16/2018 Brown, Mary L DDS2 ExtSingTh#1, ExtSingTh#16, ExtSingTh#17 90m       (919)555-1045           Broken
04/16/2018 Crosby, Brent J DDS2 CompEx, 2BWX, ImpltCnBr 30m       (919)555-1873            Broken
04/22/2018 Edwards, John S DDS1 CCAdult, Pano, FabPtCr+B#5 80m            555-1586 Broken
04/23/2018 Perkins, Peggy DDS1 ProphFlAd 50m           555-1586 Broken
04/23/2018 Reeves, Elisabeth D DDS2 Pano, EmergEx 40m       (919)555-1978            W/Call
04/23/2018 Winters, Carl DDS1 CCAdult   60m Broken

TOTAL LISTED: 7

A CB
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How do I run the Unscheduled Appointment List?
In the Office Manager, from the Reports menu, point to Lists, and then click Unscheduled 
Appointment List. For additional details about running this report, see the “Unscheduled 
Appointment List” topic in the Office Manager portion of the Dentrix Enterprise Help (from the 
Help menu of any module, click Contents).

What important information does this report provide?
A.	Date – The date the appointment was broken or placed on the wait/will call list.

B.	 Patient – The patient’s name.

C.	 Phone – The patient’s phone number.

Also, the total number of appointments on the report appears.
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Unscheduled Treatment Plans 
(Condensed) Report
The Unscheduled Treatment Plans (Condensed) Report displays treatment plans that have been 
posted to the Ledger but not scheduled in the Appointment Book.

Why:	 To ensure the practice follows up on treatment plans

When:	 Weekly

UNSCHEDULED TREATMENT PLANS (CONDENSED)

Date: Page:04/23/2018 1

The Dentist Group
04/23/2018  -  04/23/2018

APPT PATIENT AMOUNT PHONE

S U Abbott, James S 4397.00 (801)555-1586
Little, Brian R 765.00 (801)555-1234
Smith, Michael 56.00 (801)555-1586
Taylor, Mark 484.00 (801)555-7894

U Winters, Carl 301.00 (801)555-5567

UNSCHEDULED TREATMENT PLANS TOTAL: 6003.00

A
C

B
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How do I run the Unscheduled Treatment Plans 
(Condensed) Report?
In the Office Manager, from the Reports menu, point to Lists, and then click Unscheduled 
Treatment Plans. For additional details about running this report, see the “Unscheduled Treatment 
Plans Report” topic in the Office Manager portion of the Dentrix Enterprise Help (from the Help 
menu of any module, click Contents).

What important information does this report provide?
A.	Appt

•	 If a patient has a scheduled appointment for any work other than the treatment plan 
procedures, an “S” appears on the report.

•	 If a patient is on the Unscheduled Appointment list, a “U” appears on the report.

B.	 Treatment Plan Details – The patient, phone number, and treatment plan amount.

C.	 Report Totals – Combined total for all patients.
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Unscheduled Treatment Plans 
(Detailed) Report
The Unscheduled Treatment Plans (Detailed) Report displays treatment plans that have been 
posted to the Ledger but not scheduled in the Appointment Book.

Why:	 To ensure the practice follows up on treatment plans

When:	 Weekly

Date: Page:04/23/2018 1

UNSCHEDULED TREATMENT PLANS
The Dentist Group

04/23/2018  -  04/23/2018

APPT PATIENT PHONE #
DATE TH CODE RB/RT DESCRIPTION AMOUNT

DENTAL INS. COMPANY RENEWAL DATE BENEFITS REM.
MEDICAL INS. CO.

S U Abbott, James S (801)555-1586
04/23/18 12* D5213 Maxil partial-metal Base W/sdls 890.00
04/23/18 19 D6210  Pontic-cast high noble metal 603.00
04/23/18 20 D6210  Pontic-cast high noble metal 603.00
04/23/18 21 D6210  Pontic-cast high noble metal 603.00
04/23/18 22 D6210  Pontic-cast high noble metal 603.00
04/23/18  7 D6970  Post/core + brdg retainer, fabr 230.00
04/23/18 23 D6971  Cast post/part of brdg retainer 218.00
04/23/18 24 D6971  Cast post/part of brdg retainer 218.00
04/23/18 25 D6971  Cast post/part of brdg retainer 218.00
04/23/18 D0120  Periodic oral evaluation 25.00
04/23/18 D1120                        Prophylaxis-child                                                             34.00
04/23/18 D0272                        Bitewings-two films                                                          21.00
04/23/18 UR D4341          RB        Perio scale&root pln-4+per quad 131.00

P-Metropolitan Life Jan 1468.00
S-Aetna Life and Casualty Jan 1468.00 TREATMENT PLAN TOTAL: 4397.00

P-Aetna Medical

Little, Brian (801)555-0987
04/23/18 16 D7140 Extract,erupted th/exposed rt 255.00
04/23/18 17 D7140 Extract,erupted th/exposed rt 255.00
04/23/18 32 D7140  Extract,erupted th/exposed rt 255.00
04/23/18 18 D2393 Resin composite-3s, posterior 0.00
04/23/18 30 D2393 Resin composite-3s, posterior 0.00

P-Aetna Jan -105.00
S-Aetna Jan -105.00 TREATMENT PLAN TOTAL: 765.00

Smith, Michael (801)555-1586
04/23/18 D1204            Fluoride w/o prophylaxis-adult 56.00

P-Aetna Life and Casualty Jan 2000.00 TREATMENT PLAN TOTAL: 56.00

Taylor, Mark (801)555-4561
04/23/18 32 D7140  Extract,erupted th/exposed rt 152.00
04/23/18  2 D2160   Amalgam-3 surf. prim/perm 90.00
04/23/18  3 D2160   Amalgam-3 surf. prim/perm 90.00
04/23/18 17 D7140 Extract,erupted th/exposed rt 152.00

P-Met Life Jan 0.00 TREATMENT PLAN TOTAL: 484.00

U Winters, Carl (801)555-8314
04/23/18                          D1110 Prophylaxis-adult 78.00
04/23/18 D0120             Periodic oral evaluation 67.00
04/23/18                          D0274 Bitewings-four films                                                        156.00

P-Insurance Jan 0.00 TREATMENT PLAN TOTAL: 301.00

^ Flagged for Medical Cross Coding

UNSCHEDULED TREATMENT PLANS TOTAL: 6003.00 D

C

B
A
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How do I run the Unscheduled Treatment Plans (Detailed) 
Report?
In the Office Manager, from the Reports menu, point to Lists, and then click Unscheduled 
Treatment Plans. For additional details about running this report, see the “Unscheduled Treatment 
Plans Report” topic in the Office Manager portion of the Dentrix Enterprise Help (from the Help 
menu of any module, click Contents).

What important information does this report provide?
A.	Appt

•	 If a patient has a scheduled appointment for any work other than the treatment plan 
procedures, an “S” appears on the report.

•	 If a patient is on the Unscheduled Appointment list, a “U” appears on the report.

B.	 Treatment Plan Details – The patient, phone number, and treatment plan procedures.

C.	 Insurance Information – The insurance carrier, renewal month, benefits remaining, and 
treatment plan total.

D.	Report Totals – Combined total for all patients.
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Updated Dental Insurance Payment 
Table Report
The Updated Dental Insurance Payment Table Report allows you to view and print payment tables. 
Payment tables list the amount an insurance carrier will pay for a procedure.

Why:	 To ensure payment tables have been set up properly

When:	 After Dentrix Enterprise setup, and as needed

UPDATED INSURANCE PAYMENT TABLE
The Dentist Group

Date: Page:04/22/2018 1

Blue Cross Blue Shield of Fl. GROUP NAME: Dental Claims
P.O. Box 26355 Group #: 45067
Orlando, FL   84126

PROCEDURE CODE PAYMENT AMOUNT

10120 25.00
11111 25.00
15000 0.00
15001 0.00
15002 0.00
15003 0.00
15004 0.00
15005 0.00
15006 0.00
15007 0.00
15008 0.00
15009 0.00
15010 0.00
15011 0.00
15012 0.00
15100 0.00
D0120 25.00

D0120d 25.00
D0120p 15.00
D0120x 25.00
D0140 35.00
D0150 36.00
D0160 38.00
D0210 67.00
D0220 13.00
D0230 10.00
D0240 2512.00
D0250 39.00
D0260 30.00
D0270 15.00
D0272 21.00
D0274 32.00
D0290 81.00
D0310 67.00
D0320 250.00
D0321 125.00
D0322 112.00
D0330 58.00
D0340 81.00
D0415 60.00
D0425 53.00
D0460 40.00
D0470 53.00
D0471 41.00
D0501 123.00
D0502 135.00
D0999 75.00
D1120 34.00
D1201 50.00
D1203 21.00
D1204 21.00
D1205 64.00
D1310 45.00
D1320 45.00
D1330 30.00
D1351 30.00
D1510 186.00

A

B
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How do I run the Updated Dental Insurance Payment 
Table Report?
In the Office Manager, from the Reports  menu, point to Reference, and then click Ins Pmt Table. 
For additional details about running this report, see the “Updated Dental Insurance Payment Table 
Report” topic in the Office Manager portion of the Dentrix Enterprise Help (from the Help menu of 
any module, click Contents).

What important information does this report provide?
A.	 Insurance Carrier Details – The name, mailing address, 

group name, and group number of the insurance carrier. 
This information is found in the Dental Insurance Plan 
Information dialog box, which can be accessed in the 
Office Manager.

B.	 Payment Amount – The total amount the 
insurance carrier will pay for a procedure. The 
payment amount is found in the Edit Updated 
Insurance Payment Table dialog box, which can 
be accessed in the Office Manager. For details 
about how to edit an insurance carrier’s payment 
table, see the “Working with payment tables” 
topic in the Family File portion of the Dentrix 
Enterprise Help.

A

B
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Utilization Report
The Utilization Report lists insurance carriers, and for each carrier, the procedures posted during a 
selected date range.

Why:	 To identify insurance carriers with low coverages (this is done by comparing the 
charges posted to the Ledger with the practice’s UCR fee schedule)

When:	 Yearly, and as needed

UTILIZATION REPORT - DENTAL
Date Range: 05/01/2018 - 05/05/2018 Procedure Date

FEE: 001: Office
Compare FEE Schedule With: Transaction Amount

Include: All Procedures
Clinic(s): <ALL>

Provider(s): <ALL>
Billing Type(s): <ALL>
ADA Code(s): <ALL>

Carrier From: Aetna Life and Casualty - Aetna - 321863 
Carrier To: Aetna Life and Casualty - Aetna - 321863

Page 1 of 1Report Date: 05/05/2018 Report Generated By: enterprise

INSURANCE CARRIER NAME GROUP PLAN GROUP NUMBER PHONE
SUBSCRIBER DATE ID # PATIENT NAME BIRTHDATE SS # CODE DESCRIPTION TH SURFACE PROVIDER CLINIC FEE COPAY

(800) 555-6444Aetna Life and Casualty Aetna 321863

Abbott, Patricia 05/01/2018                                                                                                                           D5214     Mand partial-metal base         12 DDS2 CENTRAL 801.00          801.00  
w/sdls

5678910 Abbott, James S 11/11/1962      000-00-0000

Abbott, Patricia 05/01/2018                                                                                                                                     Extraction crnl remnts-decid    13 DDS2 CENTRAL 501.00          501.00
th

5678910 Abbott, James S 11/11/1962      000-00-0000        D7111

Abbott, Patricia 05/05/2018                                                                                                                  Mand partial-metal base          12 DDS2 CENTRAL 801.00         801.00 
w/sdls

5678910 Abbott, James S 11/11/1962      000-00-0000        D5214

Perkins, Peggy 05/01/2018                                                                                                                               Mand partial-metal base          15 DDS3 CENTRAL 801.00          801.00
w/sdls

000-00-0000          Perkins, Shelly 11/11/1980     000-000-0000      D5214

Perkins, Peggy 05/01/2018                                                                                                                               Extraction crnl remnts-decid    9 DDS3 CENTRAL 501.00          501.00 
th

000-00-0000          Perkins, Shelly 11/11/1980     000-00-0000        D7111

Perkins, Peggy 05/05/2018                                                                                                                               Pontic-porcelain fused to        10 DDS1 CENTRAL 620.00          200.00
hnob

000-00-0000          Perkins, Peggy 11/11/1957      000-00-0000        D6240

Perkins, Peggy 05/05/2018                                                                                                                               Pontic-porcelain fused to        11 DDS1 CENTRAL 620.00          200.00
hnob

000-00-0000          Perkins, Peggy 11/11/1957      000-00-0000        D6240

Perkins, Peggy 05/05/2018                                                                                                                                Retainer crn-porc fused-hi      12 DDS1 CENTRAL 613.00          200.00 
nob

000-00-0000          Perkins, Peggy 11/11/1957      000-00-0000        D66750

Perkins, Peggy 05/05/2018                                                                                                                               Retainer crn-porc fused-hi       9 DDS1 CENTRAL 613.00          200.00
nob

000-00-0000          Perkins, Peggy 11/11/1957      000-00-0000        D6750

Smith, Michael 05/01/2018                                                                                                                              Mand partial-metal base          12 DDS3 CENTRAL 801.00          801.00 
w/sdls

000-00-0000          Smith, Michael 11/11/1970     000-00-0000        D5214

Smith, Michael 05/01/2018                                                                                                                              Extraction crnl remnts-decid    7 DDS3 CENTRAL 501.00          501.00 
th

000-00-0000          Smith, Michael 11/11/1970     000-00-0000        D7111

Fee: CoPay: (Fee - CoPay): Total Office Visits: Total Patients Seen:Aetna Life and Casualty Totals:
7,173.00 5,507.00 1,666.00 45

Grand Totals: 7,173.00 5,507.00

1,666.00

Total Office Visits:

Total Patients Seen:

5

4

(Fee - CoPay):

Fee: Co-Pay:

B

C

D

A
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How do I run the Utilization Report?
From the DXOne Reporting module, select Ledger, and then double-click Utilization. For 
additional details about running this report, see the “Utilization Report” topic in the DXOne 
Reporting portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
A.	 Insurance Carriers – The report is divided by insurance carriers. The carrier’s name, group plan 

name and number, and phone number are shown:

B.	 Procedures – The procedures posted in the Ledger for patients with the displayed insurance 
carrier. (The procedures will show only if Insurance Plan Totals Only is cleared when setting up 
options for this report.) For each procedure, the following are shown:

•	 Fee – The fee that would have been attached to a procedure had the fee from the fee 
schedule you selected (when setting up the report options) been used.

•	 Copay – The fee attached to the procedure posted in the Ledger.

C.	 Insurance Carrier Totals – The total fees, co-pays, (Fee - Co-pay), office visits, and patients seen 
appear for each insurance carrier. The following is an explanation of the insurance carrier’s Fee 
and CoPay totals:

•	 Fee – The fee that would have been attached to a procedure, had the fee from the fee 
schedule you selected (when setting up the report options) been used.

•	 CoPay – The fee attached to the procedure posted in the Ledger.

D.	Grand Totals – The Grand Totals section displays the following information:

•	 Fee – The total fees that would have been attached to a procedures, had the fee from the 
fee schedule you selected (when setting up the report options) been used.

•	 Co-Pay – The total fees attached to the procedures posted in the Ledger.

•	 (Fee - CoPay) – The total revenue that would have been gained or lost, had the fee 
schedule you selected (when setting up the report options) been used when posting 
the procedures. A positive number indicates the practice would have gained revenue. A 
negative number indicates the practice would have lost revenue.

•	 Total Office Visits – The total number of office visits (multiple procedures performed on a 
patient on the same date count as one office visit).

•	 Total Patients Seen – The total number of patients that appear on the report.
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Walkout - Doctor’s Statement
The Walkout (Doctor’s Statement) itemizes today’s charges for an individual patient. This statement 
includes insurance information, billing details, and a line for the provider’s signature.

Why:	 To provide a patient with the information required to submit his/her insurance 
claim

When:	 At patient check-out, and as needed

ATTENDING DOCTOR'S STATEMENT

DATE TOOTH SURF. CODE PROCEDURE CHARGE

©DENTRIX 1987-2018

SIGNED (TREATING DENTIST) DATE

PATIENT NAME:

CHART NUMBER:

BIRTHDAY:

SOC. SEC. NUMBER:

NAME OF DENTIST:

LICENSE NUMBER:

SOC. SEC. OR T.I.N. NUMBER:

DLWLK 2

RELATION TO SUBSCRIBER:

CARRIER:
GROUP NUMBER:

EMPLOYER:

SUBSCRIBER:

Subscriber Birthday:Subscriber ID:

Remarks for unusual services:

DATE:

PATIENT INFORMATION PROVIDER INFORMATION

INSURANCE INFORMATION

05/15/20�8

�������������
123 Street
Philadelphia, PA 19102

��/1�/1987  (22)

�����������
PA0007

Other

������������, D��
The Allied Dentist Group
��� East Valley Dr
American Fork, UT 84003

(801)���-9300

���-��-����

Aetna Life and Casualty
321863

Mildred Payne
123 Street
Philadelphia, PA 19102

000-00-0000                            11/11/1957

05/15/20�8  4���������������������������������������761��������������rown Insert����������������������������������������������������������������������������������������������������.00
05/15/20�8  5��������������������������������������2954��������������refab post&core in add to crn��������������������������������������������������������������������75.00
05/15/20�8  6��������������������������������������2752��������������rown-porc fused noble metal���������������������������������������������������������������������90.00

TOTAL: 765.00

Signature On File 05/15/20�8

Do not eat or drink for one hour.

A

B

C

D
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How do I run the Walkout - Doctor’s Statement?
In the Ledger, from the Print menu, click Walkout; select Walkout/Doctor’s Statement; and then 
click Print. For additional details about running this report, see the “Walkout statements” topic 
in the Ledger portion of the Dentrix Enterprise Help (from the Help menu of any module, click 
Contents).

What important information does this report provide?
A.	Provider Information – The provider details required to submit an insurance claim.

B.	 Patient Insurance Information – The patient’s insurance details.

C.	 Services Rendered – The itemized charges for the current day.

D.	Doctor Recommendations – If you select Print Doctor Recommendations when setting 
options for this report, doctor recommendations appear on the walkout. See the “Adding and 
editing ADA-CDT dental codes” topic in the Office Manager portion of the Dentrix Enterprise 
Help for details on how to set up doctor recommendations for a procedure code.
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Walkout - Family Walkout
The Family Walkout itemizes today’s charges and payments for a family. The Family Walkout 
functions as a receipt and can include home care instructions and future appointment dates.

Why:	 To provide patients with a record of services rendered, and to provide patients 
with home care instructions

When:	 At patient check-out

PATIENT DATE TIME REASON

PATIENT TOOTH SURF DESCRIPTION CHARGE CREDIT

 GUARANTOR NAME AND MAILING ADDRESS

- + = - =

PRIOR BALANCE CURRENT CREDITS CURRENT CHARGES NEW BALANCE INSURANCE ESTIMATE PLEASE PAY

CHART NO. PAGE NO.

BILLING DATE

STATEMENT OF SERVICES RENDERED

©DENTRIX 1987-2018 DLWLK 1

1

05/15/2018

The Allied Dentist Group
123 East Valley Dr

American Fork, UT 84003

(801)555-9300

Peggy Perkins
123 Street
Philadelphia, PA 19102

Shelly 4 Crown Insert 0.00
Shelly 5 Prefab post&core in add to crn 175.00
Shelly 6 Crown-porc fused noble metal 590.00

11322.00 0.00 765.00 12087.00 800.00 11287.00

YTD Finance Charges: 100.00 YTD Late Charges: 7840.00 YTD Guar Payments: 120.00 YTD Ins Payments: 0.00

Shelly Tuesday - June 2,2018 9:20 am            Res2PosPm#4

Thanks for coming in!

Do not eat or drink for one hour.

A

B

G

D

C
E

F
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How do I run the Walkout - Family Walkout?
In the Ledger, from the Print menu, click Walkout; select Family Walkout; and then click Print. 
For additional details about running this report, see the “Walkout statements” topic in the Ledger 
portion of the Dentrix Enterprise Help (from the Help menu of any module, click Contents).

What important information does this report provide?
A.	Services Rendered and Payments Received – The services and payments made by each family 

member on the current day.

B.	 Doctor Recommendations – If you select Print Doctor Recommendations when setting 
options for this report, doctor recommendations notes appear on the walkout. See the “Adding 
and editing ADA-CDT dental codes” topic in the Office Manager portion of the Dentrix 
Enterprise Help for details on how to set up doctor recommendations for a procedure code.

C.	 Account Balance Details – The guarantor’s prior balance, total payments today, total charges 
today, and current balance.

D.	Dental Insurance Estimate – The estimated portion of charges (for procedures attached to 
claims or not) that are covered by the patients’ insurance (for procedures that are not attached 
to claims, the estimated insurance portion is based on the corresponding patient’s primary 
insurance).

E.	 Year-to-date Financial Details – If you select Print YTD Finance Charges, Late Charges, and 
Payments when setting options for this report, the guarantor’s year-to-date totals appear on the 
report.

F.	 Next Appointments – The next scheduled appointment for each family member.

G.	Walkout Message – The custom message entered when setting options for this report. You can 
only add custom messages to the Family Walkout by running the walkout from the Ledger menu 
bar.
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Adjustment Summary Report,  4
Aging/Credit Balance Report,  6
Analysis Summary Report - Daily,  8
Analysis Summary Report - Standard,  12
Appointment Book View Printout,  14
Appointment Cycle Time Report,  16
Appointment Reminder Cards,  18
Appointment Statistics Report,  20
As Soon As Possible List,  22
Assigned Rights Report,  24
Audit Report - Appointments,  26
Audit Report - Audit Log Status,  28
Audit Report - Clinics,  30
Audit Report - Combined,  32
Audit Report - Patients,  34
Audit Report - Providers/Staff,  36
Audit Report - Transactions,  38
Audit Rights Report - Assigned Individually,  40
Audit Rights Report - Assigned to Groups,  42
Audit Rights Report - Group Names,  44
Audit Rights Report - Users to Groups,  46
Billing Statement,  48
Birthday List,  50
Caries Prevalence and Periodontal Index Report,  52
Clinical Notes Report,  64
Clinical Quality Measures List,  66
Collections Manager List,  70
Continuing Care Cards - No Appointment,  74
Continuing Care Cards - with Appointment,  75
Continuing Care Display List,  76
Coupon Book - Future Due Payments,  78
Coupon Book - Payment Agreements,  79
Credit Card Transaction Report,  80
Custom Practice Information Report,  82
Daily Appointment List (DX1),  84
Daily Appointment List Report,  86
Daily Summary Report,  88
Day Sheet (Adjustments) Report,  90
Day Sheet (Charges and Receipts) Report,  94
Day Sheet (Receipts) Report,  98
Day Sheet Report,  100
Dental Diagnostic Code List,  104
Dental Encounters Report,  106
Deposit Slip,  108
Document Center - Documents List Report,  112
Document Center Audit Documents Report,  114
Document Center Document,  116
Document Center Documents Audited Report,  118
Document Center List,  120
Employers and Employed Patients Report,  122
Family Ledger Report,  124
Family Ledger Report (Single Family),  126
Fee Schedules Report,  128
Finance Charge Report,  130
Future Due Payment Plan Report - Monthly Totals,  132
Future Due Payment Plan Report - Standard,  134
Initial Health History Report,  136

Insurance Carrier List,  138
Insurance Carrier Production - Full Report,  142
Insurance Carrier Production - Summary Report,  144
Insurance Claim Aging Report,  146
Insurance Claims Not Sent Report,  148
Insurance Coverage Tables Report,  150
Insurance Eligibility Report,  152
Insurance Transaction Analysis Report,  154
Late Charge Report,  156
Letter Merge Reports,  158
Meaningful Use Measure Calculation List,  162
Medical Code List,  186
Multi-Code List,  188
New Patient List,  190
Office Journal Report,  192
Operator Day Sheet Report,  194
Operatory Appointment List Report,  196
Oral Health Education Report,  198
Oral Health Status Report,  200
Patient Chart and Progress Notes Printout,  202
Patient Chart Printout,  204
Patient Health Assessment Report,  206
Patient Information Accessed Report,  208
Patient Ledger Report,  210
Patient List,  212
Patient List (Filtered),  214
Patient Notes Report,  216
Patient Proposed Treatment Case Report (Your Care 
Plan),  220
Patient Questionnaire,  222
Patient Revenue List by Payer Report,  224
Patient Route Slip,  226
Patient Treatment Case Report,  228
Patient’s Ledger Report,  230
Payment Agreement Amortization Schedule,  232
Payment Agreement Report,  234
Payment Summary Report,  236
Perio - Combined Graphic & Data Chart Report,  238
Perio - Data Chart Report,  240
Perio - Exam Comparison Report,  242
Perio - Graphic Chart Report,  244
Perio - Pocket Depths Only Report,  246
Perio Exam List,  248
Periodontal Exam Report,  250
Practice Analysis Report,  252
Practice Organization List,  254
Practice Statistics Report,  256
Practice Treatment Case Report,  258
Prescription Printout,  260
Pre-Treatment Estimate Aging Report,  262
Pre-Treatment Estimates Not Sent Report,  264
Procedure Code List,  266
Procedures by Contracted Amount Report,  268
Procedures Not Attached to Insurance Report,  270
Production Summary Report,  272
Provider A/R Totals - Daily Report,  276
Provider A/R Totals - Standard Report,  278

Index by Report Name
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Provider IDs List,  284
Provider Revenue - Allocations Report,  286
Provider Revenue - Charges Report,  288
Provider Revenue - Credits Report,  290
Provider Revenue - Summary Report,  292
Referral Analysis Report,  294
Referral Recap Report,  296
Referral Slip,  298
Referred By Doctor/Other Report,  300
Referred By Patient Report,  302
Referred To Doctor Report,  304
Registration Information Report,  306
RVU Day Sheet Report,  308
RVU Production Summary Report,  310
RVU Schedules Report,  314
RVU Utilization Report,  316
Secondary Insurance Claims Not Created Report,  318
Secondary Pre-Treatment Estimates Not Created Report,  320
Standard Coverage Tables Report,  322
Suspended Credits Report,  324
Treatment Case Report,  326
Treatment Plan Approval Report,  328
Treatment Plan Approval Status Report,  330
Truth in Lending Disclosure Statement,  332
UDS - Age/Gender Report,  334
UDS - Encounters and Users by Selected Procedure Codes 
Report,  338
UDS - Encounters by Provider Report,  340
UDS - Insurance Financial Class Report,  342
UDS - Insurance Financial Class Report (2013),  344
UDS - Medicaid/Medicare Report,  346
UDS - Patient Related Revenue Report,  348
UDS - Patient Status Report,  350
UDS - Sealant Statistics Report,  352
UDS - Tobacco Use and Intervention Report,  354
Unscheduled Appointment List (DX1),  356
Unscheduled Appointment List (OM),  358
Unscheduled Treatment Plans (Condensed) Report,  360
Unscheduled Treatment Plans (Detailed) Report,  362
Updated Dental Insurance Payment Table Report,  364
Utilization Report,  366
Walkout - Doctor’s Statement,  368
Walkout - Family Walkout,  370



376   Index by Symbol

Dentrix Enterprise 11.0.2 Reports Reference

	 Patient Care
Appointment Cycle Time Report,  16
As Soon As Possible List,  22
Birthday List,  50
Caries Prevalence and Periodontal Index Report,  52
Continuing Care Cards - No Appointment,  74
Continuing Care Cards - with Appointment,  75
Daily Appointment List (DX1),  84
Daily Appointment List Report,  86
Initial Health History Report,  136
Letter Merge Reports,  158
Operatory Appointment List Report,  196
Oral Health Status Report,  200
Patient Chart and Progress Notes Printout,  202
Patient Chart Printout,  204
Patient Proposed Treatment Case Report (Your Care 
Plan),  220
Patient Route Slip,  226
Patient Treatment Case Report,  228
Payment Agreement Amortization Schedule,  232
Perio - Combined Graphic & Data Chart Report,  238
Perio - Data Chart Report,  240
Perio - Exam Comparison Report,  242
Perio - Graphic Chart Report,  244
Perio - Pocket Depths Only Report,  246
Practice Treatment Case Report,  258
Referral Recap Report,  296
Treatment Case Report,  326
Truth in Lending Disclosure Statement,  332
Walkout - Doctor’s Statement,  368
Walkout - Family Walkout,  370

	 Information
Appointment Book View Printout,  14
Assigned Rights Report,  24
Audit Report - Appointments,  26
Audit Report - Audit Log Status,  28
Audit Report - Clinics,  30
Audit Report - Combined,  32
Audit Report - Patients,  34
Audit Report - Providers/Staff,  36
Audit Report - Transactions,  38
Audit Rights Report - Assigned Individually,  40
Audit Rights Report - Assigned to Groups,  42
Audit Rights Report - Group Names,  44
Audit Rights Report - Users to Groups,  46
Caries Prevalence and Periodontal Index Report,  52
Clinical Notes Report,  64
Clinical Quality Measures List,  66
Continuing Care Display List,  76
Credit Card Transaction Report,  80
Credit Card Transaction Report,  80
Daily Summary Report,  88

Index by Symbol
Dental Diagnostic Code List,  104
Dental Encounters Report,  106
Dental Encounters Report,  106
Document Center - Documents List Report,  112
Document Center Audit Documents Report,  114
Document Center Document,  116
Document Center Documents Audited Report,  118
Document Center List,  120
Employers and Employed Patients Report,  122
Fee Schedules Report,  128
Insurance Carrier List,  138
Insurance Eligibility Report,  152
Letter Merge Reports,  158
Meaningful Use Measure Calculation List,  162
Medical Code List,  186
Multi-Code List,  188
Office Journal Report,  192
Oral Health Education Report,  198
Patient Chart and Progress Notes Printout,  202
Patient Chart Printout,  204
Patient Health Assessment Report,  206
Patient Information Accessed Report,  208
Patient List (Filtered),  214
Patient Notes Report,  216
Patient Questionnaire,  222
Perio Exam List,  248
Periodontal Exam Report,  250
Practice Organization List,  254
Practice Statistics Report,  256
Pre-Treatment Estimate Aging Report,  262
Procedure Code List,  266
Provider IDs List,  284
Registration Information Report,  306
RVU Schedules Report,  314
UDS - Age/Gender Report,  334
UDS - Encounters and Users by Selected Procedure 
Codes Report,  338
UDS - Encounters by Provider Report,  340
UDS - Insurance Financial Class Report,  342
UDS - Insurance Financial Class Report (2013),  344
UDS - Medicaid/Medicare Report,  346
UDS - Patient Related Revenue Report,  348
UDS - Patient Status Report,  350
UDS - Sealant Statistics Report,  352
UDS - Tobacco Use and Intervention Report,  354

	 Financial
Adjustment Summary Report,  4
Aging/Credit Balance Report,  6
Analysis Summary Report - Daily,  8
Analysis Summary Report - Standard,  12
Billing Statement,  48
Clinical Quality Measures List,  66
Collections Manager List,  70
Coupon Book - Future Due Payments,  78
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Coupon Book - Payment Agreements,  79
Credit Card Transaction Report,  80
Daily Summary Report,  88
Day Sheet (Adjustments) Report,  90
Day Sheet (Charges and Receipts) Report,  94
Day Sheet (Receipts) Report,  98
Day Sheet Report,  100
Deposit Slip,  108
Family Ledger Report,  124
Family Ledger Report (Single Family),  126
Fee Schedules Report,  128
Finance Charge Report,  130
Future Due Payment Plan Report - Monthly Totals,  132
Future Due Payment Plan Report - Standard,  134
Insurance Claim Aging Report,  146
Insurance Claims Not Sent Report,  148
Insurance Coverage Tables Report,  150
Insurance Eligibility Report,  152
Insurance Transaction Analysis Report,  154
Late Charge Report,  156
Letter Merge Reports,  158
Meaningful Use Measure Calculation List,  162
Operator Day Sheet Report,  194
Patient Ledger Report,  210
Patient Proposed Treatment Case Report (Your Care 
Plan),  220
Patient Revenue List by Payer Report,  224
Patient Route Slip,  226
Patient Treatment Case Report,  228
Patient’s Ledger Report,  230
Payment Agreement Report,  234
Payment Summary Report,  236
Practice Analysis Report,  252
Practice Treatment Case Report,  258
Pre-Treatment Estimates Not Sent Report,  264
Procedures by Contracted Amount Report,  268
Procedures Not Attached to Insurance Report,  270
Provider A/R Totals - Daily Report,  276
Provider A/R Totals - Standard Report,  278
Provider Revenue - Allocations Report,  286
Provider Revenue - Charges Report,  288
Provider Revenue - Credits Report,  290
Provider Revenue - Summary Report,  292
Referred By Doctor/Other Report,  300
Referred By Patient Report,  302
RVU Day Sheet Report,  308
RVU Production Summary Report,  310
RVU Schedules Report,  314
RVU Utilization Report,  316
Secondary Insurance Claims Not Created Report,  318
Secondary Pre-Treatment Estimates Not Created Re-
port,  320
Standard Coverage Tables Report,  322
Suspended Credits Report,  324
Treatment Case Report,  326
Truth in Lending Disclosure Statement,  332
Unscheduled Treatment Plans (Condensed) Report,  360
Unscheduled Treatment Plans (Detailed) Report,  362
Updated Dental Insurance Payment Table Report,  364
Utilization Report,  366

	 Production
Analysis Summary Report - Daily,  8
Analysis Summary Report - Standard,  12
Appointment Reminder Cards,  18
Appointment Statistics Report,  20
As Soon As Possible List,  22
Continuing Care Cards - No Appointment,  74
Continuing Care Cards - with Appointment,  75
Daily Appointment List (DX1),  84
Daily Appointment List Report,  86
Daily Summary Report,  88
Day Sheet (Charges and Receipts) Report,  94
Dental Encounters Report,  106
Insurance Carrier Production - Full Report,  142
Insurance Carrier Production - Summary Report,  144
Letter Merge Reports,  158
New Patient List,  190
Patient List,  212
Patient Revenue List by Payer Report,  224
Patient Revenue List by Payer Report,  224
Procedures by Contracted Amount Report,  268
Production Summary Report,  272
Referral Analysis Report,  294
Referred By Doctor/Other Report,  300
Referred By Patient Report,  302
Referred To Doctor Report,  304
RVU Day Sheet Report,  308
RVU Production Summary Report,  310
RVU Utilization Report,  316
Treatment Plan Approval Report,  328
Treatment Plan Approval Status Report,  330
Unscheduled Appointment List (DX1),  356
Unscheduled Appointment List (OM),  358
Unscheduled Treatment Plans (Condensed) Report,  360
Unscheduled Treatment Plans (Detailed) Report,  362

	 Time
Appointment Cycle Time Report,  16
Appointment Statistics Report,  20
Continuing Care Cards - No Appointment,  74
Continuing Care Cards - with Appointment,  75
Deposit Slip,  108
Letter Merge Reports,  158
Prescription Printout,  260
Referral Slip,  298
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Daily
Appointment Book View Printout,  14
Appointment Cycle Time Report,  16
As Soon As Possible List,  22
Credit Card Transaction Report,  80
Daily Appointment List (DX1),  84
Daily Appointment List Report,  86
Daily Summary Report,  88
Day Sheet (Adjustments) Report,  90
Day Sheet (Charges and Receipts) Report,  94
Day Sheet (Receipts) Report,  98
Day Sheet Report,  100
Deposit Slip,  108
Document Center Documents Audited Report,  118
Insurance Claims Not Sent Report,  148
Insurance Eligibility Report,  152
Operator Day Sheet Report,  194
Operatory Appointment List Report,  196
Patient Route Slip,  226
Pre-Treatment Estimates Not Sent Report,  264
Procedures Not Attached to Insurance Report,  270
Production Summary Report,  272
Provider Revenue - Allocations Report,  286
Provider Revenue - Charges Report,  288
Provider Revenue - Credits Report,  290
Provider Revenue - Summary Report,  292
RVU Day Sheet Report,  308
RVU Production Summary Report,  310
Secondary Insurance Claims Not Created Report,  318
Secondary Pre-Treatment Estimates Not Created Re-
port,  320

Weekly
As Soon As Possible List,  22
Insurance Claims Not Sent Report,  148
Pre-Treatment Estimates Not Sent Report,  264
Provider A/R Totals - Standard Report,  278
Referral Recap Report,  296
Secondary Insurance Claims Not Created Report,  318
Secondary Pre-Treatment Estimates Not Created Re-
port,  320
Treatment Plan Approval Report,  328
Treatment Plan Approval Status Report,  330
Unscheduled Appointment List (DX1),  356
Unscheduled Appointment List (OM),  358
Unscheduled Treatment Plans (Condensed) Report,  360
Unscheduled Treatment Plans (Detailed) Report,  362

Monthly
Aging/Credit Balance Report,  6
Analysis Summary Report - Daily,  8
Analysis Summary Report - Standard,  12
Appointment Reminder Cards,  18
Audit Report - Appointments,  26
Audit Report - Audit Log Status,  28
Audit Report - Clinics,  30
Audit Report - Combined,  32
Audit Report - Patients,  34
Audit Report - Providers/Staff,  36

Audit Report - Transactions,  38
Audit Rights Report - Assigned Individually,  40
Audit Rights Report - Assigned to Groups,  42
Audit Rights Report - Group Names,  44
Audit Rights Report - Users to Groups,  46
Billing Statement,  48
Collections Manager List,  70
Continuing Care Cards - No Appointment,  74
Continuing Care Cards - with Appointment,  75
Continuing Care Display List,  76
Document Center Audit Documents Report,  114
Finance Charge Report,  130
Future Due Payment Plan Report - Monthly Totals,  132
Future Due Payment Plan Report - Standard,  134
Insurance Carrier Production - Full Report,  142
Insurance Carrier Production - Summary Report,  144
Insurance Claim Aging Report,  146
Late Charge Report,  156
New Patient List,  190
Patient Information Accessed Report,  208
Provider A/R Totals - Standard Report,  278
Referral Recap Report,  296
Suspended Credits Report,  324

Quarterly
Adjustment Summary Report,  4
Caries Prevalence and Periodontal Index Report,  52
Insurance Carrier Production - Full Report,  142
Insurance Carrier Production - Summary Report,  144

Yearly
Adjustment Summary Report,  4
Initial Health History Report,  136
New Patient List,  190
Oral Health Education Report,  198
Periodontal Exam Report,  250
Procedures by Contracted Amount Report,  268
Production Summary Report,  272
Provider A/R Totals - Standard Report,  278
RVU Utilization Report,  316
Utilization Report,  366

As Needed
Appointment Book View Printout,  14
Appointment Reminder Cards,  18
Appointment Statistics Report,  20
Assigned Rights Report,  24
Audit Report - Appointments,  26
Audit Report - Audit Log Status,  28
Audit Report - Clinics,  30
Audit Report - Combined,  32
Audit Report - Patients,  34
Audit Report - Providers/Staff,  36
Audit Report - Transactions,  38
Audit Rights Report - Assigned Individually,  40
Audit Rights Report - Assigned to Groups,  42
Audit Rights Report - Group Names,  44
Audit Rights Report - Users to Groups,  46
Birthday List,  50
Clinical Notes Report,  64

Index by When to Run a Report



Index by When to Run a Report  379

Dentrix Enterprise 11.0.2 Reports Reference

RVU Utilization Report,  316
Standard Coverage Tables Report,  322
Treatment Case Report,  326
Truth in Lending Disclosure Statement,  332
UDS - Age/Gender Report,  334
UDS - Encounters and Users by Selected Procedure 
Codes Report,  338
UDS - Encounters by Provider Report,  340
UDS - Insurance Financial Class Report,  342
UDS - Insurance Financial Class Report (2013),  344
UDS - Medicaid/Medicare Report,  346
UDS - Patient Related Revenue Report,  348
UDS - Patient Status Report,  350
UDS - Sealant Statistics Report,  352
UDS - Tobacco Use and Intervention Report,  354
Updated Dental Insurance Payment Table Report,  364
Utilization Report,  366
Walkout - Doctor’s Statement,  368

After ADA Codes are Updated
Procedure Code List,  266

After Creating a Payment Agreement
Coupon Book - Payment Agreements,  79
Payment Agreement Amortization Schedule,  232
Truth in Lending Disclosure Statement,  332

After Creating a Future Due Payment Plan 
Coupon Book - Future Due Payments,  78

After Dentrix Enterprise Setup
Assigned Rights Report,  24
Custom Practice Information Report,  82
Dental Diagnostic Code List,  104
Fee Schedules Report,  128
Insurance Carrier List,  138
Insurance Coverage Tables Report,  150
Medical Code List,  186
Multi-Code List,  188
Procedure Code List,  266
Provider IDs List,  284
RVU Schedules Report,  314
Updated Dental Insurance Payment Table Report,  364

After Entering a Referral
Referral Slip,  298

After Performing a Perio Exam
Perio - Combined Graphic & Data Chart Report,  238
Perio - Data Chart Report,  240
Perio - Exam Comparison Report,  242
Perio - Graphic Chart Report,  244
Perio - Pocket Depths Only Report,  246

As Frequently as Payments Are Required
Payment Agreement Report,  234

At Patient Check-Out
Referral Slip,  298
Walkout - Doctor’s Statement,  368
Walkout - Family Walkout,  370

At the Beginning of Each Budgeting Cycle
Future Due Payment Plan Report - Monthly Totals,  132
Future Due Payment Plan Report - Standard,  134
Production Summary Report,  272

Before Month-End Close Out
Practice Analysis Report,  252

Clinical Quality Measures List,  66
Continuing Care Display List,  76
Coupon Book - Future Due Payments,  78
Coupon Book - Payment Agreements,  79
Credit Card Transaction Report,  80
Custom Practice Information Report,  82
Dental Diagnostic Code List,  104
Dental Encounters Report,  106
Document Center - Documents List Report,  112
Document Center Audit Documents Report,  114
Document Center Document,  116
Document Center Documents Audited Report,  118
Document Center List,  120
Employers and Employed Patients Report,  122
Family Ledger Report,  124
Family Ledger Report (Single Family),  126
Fee Schedules Report,  128
Insurance Carrier List,  138
Insurance Coverage Tables Report,  150
Insurance Transaction Analysis Report,  154
Letter Merge Reports,  158
Meaningful Use Measure Calculation List,  162
Medical Code List,  186
Multi-Code List,  188
Office Journal Report,  192
Oral Health Status Report,  200
Patient Chart and Progress Notes Printout,  202
Patient Chart Printout,  204
Patient Health Assessment Report,  206
Patient Information Accessed Report,  208
Patient Ledger Report,  210
Patient List,  212
Patient List (Filtered),  214
Patient Notes Report,  216
Patient Proposed Treatment Case Report (Your Care 
Plan),  220
Patient Revenue List by Payer Report,  224
Patient Route Slip,  226
Patient Treatment Case Report,  228
Patient’s Ledger Report,  230
Payment Agreement Amortization Schedule,  232
Payment Summary Report,  236
Perio - Combined Graphic & Data Chart Report,  238
Perio - Data Chart Report,  240
Perio - Exam Comparison Report,  242
Perio - Graphic Chart Report,  244
Perio - Pocket Depths Only Report,  246
Perio Exam List,  248
Practice Analysis Report,  252
Practice Organization List,  254
Practice Statistics Report,  256
Practice Treatment Case Report,  258
Prescription Printout,  260
Pre-Treatment Estimate Aging Report,  262
Provider A/R Totals - Daily Report,  276
Provider IDs List,  284
Referral Analysis Report,  294
Referred By Doctor/Other Report,  300
Referred By Patient Report,  302
Referred To Doctor Report,  304
Registration Information Report,  306
RVU Schedules Report,  314
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Semi-Monthly
Appointment Reminder Cards,  18
Billing Statement,  48

At Patient Check-In
Patient Questionnaire,  222
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Any Module
Continuing Care Display List,  76

Any Module (Except Office Manager)
Patient Questionnaire,  222
Prescription Printout,  260

Appointment Book
Appointment Book View Printout,  14

Collections Manager
Collections Manager List,  70

Continuing Care
Continuing Care Display List,  76

Document Center
Document Center Document,  116
Document Center List,  120

DXOne Reporting
Adjustment Summary Report,  4
Aging/Credit Balance Report,  6
Analysis Summary Report - Daily,  8
Analysis Summary Report - Standard,  12
Appointment Cycle Time Report,  16
Appointment Statistics Report,  20
As Soon As Possible List,  22
Assigned Rights Report,  24
Audit Report - Appointments,  26
Audit Report - Audit Log Status,  28
Audit Report - Clinics,  30
Audit Report - Combined,  32
Audit Report - Patients,  34
Audit Report - Providers/Staff,  36
Audit Report - Transactions,  38
Audit Rights Report - Assigned Individually,  40
Audit Rights Report - Assigned to Groups,  42
Audit Rights Report - Group Names,  44
Audit Rights Report - Users to Groups,  46
Birthday List,  50
Caries Prevalence and Periodontal Index Report,  52
Clinical Notes Report,  64
Credit Card Transaction Report,  80
Daily Appointment List (DX1),  84
Daily Summary Report,  88
Day Sheet (Adjustments) Report,  90
Day Sheet (Receipts) Report,  98
Day Sheet Report,  100
Dental Encounters Report,  106
Deposit Slip,  108
Document Center - Documents List Report,  112
Employers and Employed Patients Report,  122
Fee Schedules Report,  128
Finance Charge Report,  130
Initial Health History Report,  136
Insurance Carrier List,  138
Insurance Carrier Production - Full Report,  142
Insurance Carrier Production - Summary Report,  144
Insurance Claim Aging Report,  146
Insurance Claims Not Sent Report,  148
Insurance Transaction Analysis Report,  154
Oral Health Education Report,  198

Oral Health Status Report,  200
Patient Health Assessment Report,  206
Patient Information Accessed Report,  208
Patient List,  212
Patient Revenue List by Payer Report,  224
Payment Summary Report,  236
Periodontal Exam Report,  250
Practice Analysis Report,  252
Practice Organization List,  254
Practice Statistics Report,  256
Pre-Treatment Estimate Aging Report,  262
Pre-Treatment Estimates Not Sent Report,  264
Procedures by Contracted Amount Report,  268
Procedures Not Attached to Insurance Report,  270
Production Summary Report,  272
Provider A/R Totals - Daily Report,  276
Provider A/R Totals - Standard Report,  278
Provider IDs List,  284
Provider Revenue - Allocations Report,  286
Provider Revenue - Charges Report,  288
Provider Revenue - Credits Report,  290
Provider Revenue - Summary Report,  292
Referral Analysis Report,  294
Referred By Doctor/Other Report,  300
Referred By Patient Report,  302
Referred To Doctor Report,  304
RVU Day Sheet Report,  308
RVU Production Summary Report,  310
RVU Schedules Report,  314
RVU Utilization Report,  316
Secondary Insurance Claims Not Created Report,  318
Secondary Pre-Treatment Estimates Not Created Re-
port,  320
Suspended Credits Report,  324
UDS - Age/Gender Report,  334
UDS - Encounters and Users by Selected Procedure 
Codes Report,  338
UDS - Encounters by Provider Report,  340
UDS - Insurance Financial Class Report (2013),  344
UDS - Insurance Financial Class Report,  342
UDS - Medicaid/Medicare Report,  346
UDS - Patient Related Revenue Report,  348
UDS - Patient Status Report,  350
UDS - Sealant Statistics Report,  352
UDS - Tobacco Use and Intervention Report,  354
Unscheduled Appointment List (DX1),  356
Utilization Report,  366

Family File
Clinical Notes Report,  64

Ledger
Appointment Reminder Cards,  18
Clinical Notes Report,  64
Coupon Book - Future Due Payments,  78
Coupon Book - Payment Agreements,  79
Patient Ledger Report,  210
Payment Agreement Amortization Schedule,  232
Referral Recap Report,  296

Index by Module
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Perio - Pocket Depths Only Report,  246
Perio Exam List,  248

Prescriptions
Prescription Printout,  260

Treatment Planner
Patient Proposed Treatment Case Report (Your Care 
Plan),  220
Patient Treatment Case Report,  228
Practice Treatment Case Report,  258
Treatment Case Report,  326

Truth in Lending Disclosure Statement,  332
Walkout - Doctor’s Statement,  368
Walkout - Family Walkout,  370

Letters
Letter Merge Reports,  158

Office Journal
Office Journal Report,  192

Office Manager
Billing Statement,  48
Clinical Quality Measures List,  66
Continuing Care Cards - No Appointment,  74
Continuing Care Cards - with Appointment,  75
Custom Practice Information Report,  82
Daily Appointment List Report,  86
Day Sheet (Charges and Receipts) Report,  94
Dental Diagnostic Code List,  104
Document Center Audit Documents Report,  114
Document Center Documents Audited Report,  118
Family Ledger Report,  124
Family Ledger Report (Single Family),  126
Future Due Payment Plan Report - Monthly Totals,  132
Future Due Payment Plan Report - Standard,  134
Insurance Coverage Tables Report,  150
Insurance Eligibility Report,  152
Late Charge Report,  156
Letter Merge Reports,  158
Meaningful Use Measure Calculation List,  162
Medical Code List,  186
Multi-Code List,  188
New Patient List,  190
Operator Day Sheet Report,  194
Operatory Appointment List Report,  196
Patient List (Filtered),  214
Patient Notes Report,  216
Patient Route Slip,  226
Patient’s Ledger Report,  230
Payment Agreement Report,  234
Procedure Code List,  266
Referral Recap Report,  296
Registration Information Report,  306
Standard Coverage Tables Report,  322
Treatment Plan Approval Report,  328
Treatment Plan Approval Status Report,  330
Unscheduled Appointment List (OM),  358
Unscheduled Treatment Plans (Condensed) Report,  360
Unscheduled Treatment Plans (Detailed) Report,  362
Updated Dental Insurance Payment Table Report,  364

Patient Chart
Clinical Notes Report,  64
Patient Chart and Progress Notes Printout,  202
Patient Chart Printout,  204
Patient Health Assessment Report,  206
Referral Recap Report,  296
Referral Slip,  298

Patient Questionnaire
Patient Questionnaire,  222

Perio Chart
Perio - Combined Graphic & Data Chart Report,  238
Perio - Data Chart Report,  240
Perio - Exam Comparison Report,  242
Perio - Graphic Chart Report,  244
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Adjustment Summary Report,  4
Adjustment Types
Billing Types
Collecting Clinics
Date Type
Dates
Patient Tags
Providers
Rendering Clinics

Aging/Credit Balance Report,  6
Balance as of Date
Balances
Billing Types
Clinics
Date Type
Days Past Due
Guarantors
Include Guarantor Notes
Last Payment Before Date
Patient Tags
Providers

Analysis Summary Report - Daily,  8
Billing Types
Clinics
Date Type
Dates
Patient Tags
Providers
Staff

Analysis Summary Report - Standard,  12
Billing Types
Clinics
Date Type
Dates
Patient Tags
Providers
Staff

Appointment Book View Printout,  14
Dates
Operatories
Providers
Time

Appointment Cycle Time Report,  16
Appointment Providers
Appointment Statuses
Clinics
Dates
In-operatory Appointment Statuses
Patient Tags

Appointment Reminder Cards,  18
N/A

Appointment Statistics Report,  20
Appointment Providers
Appointment Status Duration
Appointment Statuses
Clinics

Dates
Maximum Appointment Status Duration (Cap)
Maximum Duration of Appointments in Status Range 
(Cap)
Time Zone

As Soon As Possible List,  22
Appointment Providers
Dates
Patient Tags
Primary Providers
Time Zone

Assigned Rights Report,  24
Clinics
Rights
Users

Audit Report - Appointments,  26
Changes
Dates
Operatories
Patient Tags
Patients
Time Zone
Users Changed

Audit Report - Audit Log Status,  28
Dates
Time Zone
Users

Audit Report - Clinics,  30
Changes
Clinics
Dates
Time Zone
Users Changed

Audit Report - Combined,  32
Actions
Changes
Clinics
Dates
Patient Tags
Patients
Time Zone
Users Changed

Audit Report - Patients,  34
Changes
Clinics
Dates
Patient Tags
Patients
Time Zone
Users Changed

Audit Report - Providers/Staff,  36
Changes
Clinics
Dates
Providers
Staff

Index of Filters by Report
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Time Zone
Users Changed

Audit Report - Transactions,  38
Changes
Clinics
Dates
Patient Tags
Patients
Time Zone
Users Changed

Audit Rights Report - Assigned Individually,  40
Clinics
Dates
Rights
Time Zone
Users
Users Changed

Audit Rights Report - Assigned to Groups,  42
Clinics
Dates
Rights
Time Zone
Users
Users Changed

Audit Rights Report - Group Names,  44
Dates
Time Zone
User Groups
Users Changed

Audit Rights Report - Users to Groups,  46
Clinics
Dates
Time Zone
User Groups
Users
Users Changed

Billing Statement,  48
Balance Forward Date
Billing Types
Guarantors
If not Billed since Date
Minimum Balance to Bill
Only Bill Aged Accounts
Primary Providers
Skip Account with Claim Pending
Skip Accounts with Claim Pending if Patient Portion 
Less than Amount

Birthday List,  50
Billing Types
Birth Dates
Clinics
Patient Tags
Patients
Providers
Search as Date Range
Staff

Caries Prevalence and Periodontal Index Report,  52
Clinics
Dates

Clinical Notes Report,  64
Approval Status
Clinics
Dates
Encounter Numbers
Patient Tags
Patients
Providers
Staff
Time Zone

Clinical Quality Measures List,  66
Dates
Providers

Collections Manager List,  70
Billing Types
Clinics
Guarantors
Insurance Minimum Days Past Due
Last Payment Before Date
Minimum Balance
Minimum Days Past Due
Not Billed Since Date
Number of Missed Payments
Pending Claims
Previous Office Journal Entry Before Date
Providers

Continuing Care Cards - No Appointment,  74
Appointment without Continuing Care Type Attached
Continuing Care Type
Due Dates

Continuing Care Cards - with Appointment,  75
Appointment Dates
Appointment with Continuing Care Attached
Continuing Care Type
Existing Patients with Appointment in Date Range

Continuing Care Display List,  76
Billing Types
Clinics
Continuing Care Status
Continuing Care Type
Due Dates
Last Visit Dates
Prior Treatment Dates
Providers
Scheduled Appointment
Unscheduled Appointment

Coupon Book - Future Due Payments,  78
N/A

Coupon Book - Payment Agreements,  79
N/A

Credit Card Transaction Report,  80
Billing Types
Dates
Include Refunds
Include Voids
Operators
Patient Tags

Custom Practice Information Report,  82
N/A
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Daily Appointment List (DX1),  84
Appointment Providers
Clinics
Dates
Exclude Chart-Pulled Appointments
Operatories
Patient Tags
Patients
Providers

Daily Appointment List Report,  86
Dates
Exclude Chart-Pulled Appointments
Operatories
Patients
Providers

Daily Summary Report,  88
Adjustment Types
Billing Types
Clinics
Date Type
Dates
Patient Tags
Payment Types
Time Zone

Day Sheet (Adjustments) Report,  90
Adjustment Types
Billing Types
Clinics
Date Type
Dates
Patient Tags
Providers

Day Sheet (Charges and Receipts) Report,  94
Billing Types
Clinics
Dates
Operators
Providers

Day Sheet (Receipts) Report,  98
Billing Types
Chart Numbers
Clinics
Date Type
Dates
Patient Tags
Payment Types
Providers

Day Sheet Report,  100
Billing Types
Clinics
Date Type
Dates
Patient Tags
Providers
Staff

Dental Diagnostic Code List,  104
N/A

Dental Encounters Report,  106
Clinics
Date Type
Insurance Carriers

Patient Tags
Patients
Procedure Dates
Providers

Deposit Slip,  108
Billing Types
Clinics
Date Type
Dates
Operators
Patient Tags
Payment Types

Document Center - Documents List Report,  112
Attached Dates
Clinics
Dental Insurance Plans
Document Center Paths
Employers
Medical Insurance Plans
Patient Tags
Patients
Providers
Refer to Patients
Referral Sources
Signed Dates
Staff
Users

Document Center Audit Documents Report,  114
Dental Insurance Plan Attachment
Employer Attachment
Medical Insurance Plan Attachment
Patient Attachment
Provider/Staff Attachment
Referred By Attachment
Referred To Attachment
Scan Dates

Document Center Document,  116
N/A

Document Center Documents Audited Report,  118
Audit Dates
Clinics
Dental Insurance Plan Attachment
Employer Attachment
Error Types
Medical Insurance Plan Attachment
Patient Attachment
Provider/Staff Attachment
Referred By Attachment
Referred To Attachment
Scan Dates
Users

Document Center List,  120
N/A

Employers and Employed Patients Report,  122
Clinics
Employers
Include Employees
Providers
Staff

Family Ledger Report,  124
Billing Types
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First Transaction Date
Guarantors
Providers

Family Ledger Report (Single Family),  126
First Transaction Date

Fee Schedules Report,  128
ADA Codes
Fee Schedule

Finance Charge Report,  130
Billing Types
Clinics
Date Type
Dates
Patient Tags
Providers
Staff

Future Due Payment Plan Report - Monthly Totals,  
132

Billing Types
Dates
Guarantors
Providers

Future Due Payment Plan Report - Standard,  134
Billing Types
Dates
Guarantors
Providers

Initial Health History Report,  136
ADA Codes
Ages
Clinics
Conditions
Date Type
Dates
Include Completed Procedures Only
Include Detail
Include Patients in Numerator Only if Exist in 
Denominator
Patient Tags
Providers

Insurance Carrier List,  138
Clinics
Financial Classes
Include All Patients
Include Provider IDs
Include Subscribers
Insurance Carriers
Insurance Type

Insurance Carrier Production - Full Report,  142
Clinics
Date Type
Dates
Financial Classes
Insurance Carriers
Insurance Type
Patient Tags
Patients
Providers

Insurance Carrier Production - Summary Report,  
144

Clinics
Date Type
Dates
Financial Classes
Insurance Carriers
Insurance Type
Patient Tags
Patients
Providers

Insurance Claim Aging Report,  146
Age Amount Outstanding
Age Insurance Estimate
Age Total Billed
Billing Types
Clinics
Insurance Carriers
Insurance Type
Minimum Days Past Due
Patient Tags
Patients
Providers
Show Open Claims Only

Insurance Claims Not Sent Report,  148
Billing Types
Clinics
Dates
Insurance Carriers
Insurance Type
Patient Tags
Patients
Providers
Staff

Insurance Coverage Tables Report,  150
N/A

Insurance Eligibility Report,  152
Appointment Dates
Clinics
Employers
Insurance Carriers
Patients
Providers

Insurance Transaction Analysis Report,  154
Billing Provider
Billing Types
Charge Date
Charge Provider
Claim Received Date
Claim Rendering Provider
Claim Sent Date
Clinics
Date Type
Dates
Display Allocate Date for Payments
Financial Classes
Include Charge Adjustments
Include Charges
Include Credit Adjustments
Include Grand Totals
Include Insurance Payments
Include Patient Payments
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Include Quaternary Claims
Include Secondary Claims
Include Subtotals by Carrier
Include Tertiary Claims
Insurance Carriers
Insurance Type
Patient Tags
Pay To Provider
Providers

Late Charge Report,  156
Billing Types
Clinics
Date Type
Dates
Patient Tags
Providers
Staff

Letter Merge Reports,  158
0 Account Balance
ADA Codes
Allergies
Amount Aged <30
Amount Aged <60
Amount Aged <90
Amount Aged <90+
Appointment Dates
Balances
Billing Types
Birthday Days
Birthday Months
Birthday Years
Cities
Clinics
Completed Procedures
Consent Dates
Continuing Care Attached to Appointment
Continuing Care Due Dates
Continuing Care Prior Treatment Dates
Continuing Care Type
Continuing Care not Attached to Appointment
Credit Balance
Employers
Existing Patients with Appointments in Date Range
Existing Patients with no Appointments in Date Range
Existing Procedures
First Visit Dates
Insurance Carriers
Last Payment Plan Payment Dates
Last Referral Dates
Last Visit Dates
Medical Alerts
Medications
No Insurance Coverage
Note Texts
Only Guarantors
Patient Gender
Patient Marital Status
Patient Names
Patient Status
Payment Plan Balances
Primary Insurance Coverage

Privacy Requests for no Correspondence for Patients 
and Guarantors
Privacy Requests for no Correspondence for Referred 
by Patients
Procedure Dates
Prospective Patients with Appointments in Date Range
Providers
Referred by Dates
Referred by Doctor/Other
Referred by Patient
Referred by Sources
Referred to Dates
Referred to Names
Remaining Insurance Benefit Amounts
Secondary Insurance Coverage
Treatment-planned Procedures
ZIP Codes

Meaningful Use Measure Calculation List,  162
Alternative Measure for CPOE
Alternative Measure for Vital Signs
Blood Pressure
Dates
Height/Length and Weight
Meaningful Use Stages
Providers

Medical Code List,  186
AMA CPT Codes
ICD-10CM Codes
ICD-9CM Codes
Modifier Codes
Place of Service Codes
Type of Service Codes

Multi-Code List,  188
Multi-Codes

New Patient List,  190
First Visit Dates
Patients
Providers

Office Journal Report,  192
N/A

Operator Day Sheet Report,  194
N/A

Operatory Appointment List Report,  196
Dates
Operatories
Patients
Providers

Oral Health Education Report,  198
ADA Codes
Ages
Clinics
Conditions
Date Type
Dates
Include Completed Procedures Only
Include Detail
Include Patients in Numerator Only if Exist in 
Denominator
Patient Tags
Providers
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Oral Health Status Report,  200
Ages
Caries Risk
Clinics
Dates
Diabetes
Dry Mouth
Oral Health Statuses
Patient Tags
Providers
Tobacco Use

Patient Chart and Progress Notes Printout,  202
N/A

Patient Chart Printout,  204
N/A

Patient Health Assessment Report,  206
Clinics
Dates
Patient Tags
Patients

Patient Information Accessed Report,  208
Clinics
Dates
Families
Modules
Patient Tags
Patients
Time Zone
Users Changed

Patient Ledger Report,  210
Billing Types
First Transaction Date
Patients
Providers

Patient List,  212
Billing Types
Clinics
Last Visit Before Date
No Continuing Care and no Future Appointments
Patient Statuses
Patient Tags
Patients
Providers

Patient List (Filtered),  214
Ages
Allergies
Clinics
Completed Procedures
Continuing Care
Dates
Ethnicity
Gender
Homeless Status
ICD-9-CM Diagnostic Codes
Laboratory Test Results
Language
Medical Alerts
Medications
Poverty Level
Preferred Contact Method
Prescriptions
Primary Provider

Race
Religion
User Defined Category
Veteran Status
Worker Status

Patient Notes Report,  216
Billing Types
Dates (for Appointment Notes)
Dates (for Clinical Notes)
Dates (for Patient Alert Notes)
Dates (for Perio Exam Notes)
Only Guarantors
Patients
Providers

Patient Proposed Treatment Case Report (Your Care 
Plan),  220

N/A
Patient Questionnaire,  222

N/A
Patient Revenue List by Payer Report,  224

Clinics
Date Type
Dates
Patient Statuses
Patient Tags
Patients

Patient Route Slip,  226
N/A

Patient Treatment Case Report,  228
Case Severity
Case Status
Expiration Dates
Procedure Dates
Providers

Patient’s Ledger Report,  230
N/A

Payment Agreement Amortization Schedule,  232
N/A

Payment Agreement Report,  234
Billing Types
Clinics
Guarantors
Number of Payments Missed
Payment Agreement Dates
Payment Agreement Intervals
Previous Payment Due Date
Providers
Remaining Balances
Remaining Number of Payments

Payment Summary Report,  236
Billing Types
Collecting Clinics
Date Type
Dates
Patient Tags
Payment Types
Providers
Rendering Clinics

Perio - Combined Graphic & Data Chart Report,  
238

N/A
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Perio - Data Chart Report,  240
N/A

Perio - Exam Comparison Report,  242
N/A

Perio - Graphic Chart Report,  244
N/A

Perio - Pocket Depths Only Report,  246
N/A

Perio Exam List,  248
Dates
Patients

Periodontal Exam Report,  250
ADA Codes
Ages
Clinics
Conditions
Date Type
Dates
Include Completed Procedures Only
Include Detail
Include Patients in Numerator Only if Exist in 
Denominator
Patient Tags
Providers

Practice Analysis Report,  252
Clinics
Date Type
Dates
Providers
Staff

Practice Organization List,  254
Clinics
Providers
Staff

Practice Statistics Report,  256
Age Statistics
Clinics
Continuing Care Statistics
New Patient Statistics
Patient Statistics
Prophy Types
Provider Statistics
Providers
Staff
ZIP Code Statistics

Practice Treatment Case Report,  258
Billing Types
Case Severity
Case Status
Expiration Dates
Patients
Procedure Dates
Providers

Prescription Printout,  260
N/A

Pre-Treatment Estimate Aging Report,  262
Age Insurance Estimate
Age Total Billed
Billing Types
Clinics
Insurance Carriers

Insurance Type
Minimum Days Past Due
Patient Tags
Patients
Providers
Staff

Pre-Treatment Estimates Not Sent Report,  264
Billing Types
Clinics
Dates
Insurance Carriers
Insurance Type
Patient Tags
Patients
Providers
Staff

Procedure Code List,  266
Procedure Codes

Procedures by Contracted Amount Report,  268
Clinics
Date Type
Dates
Patient Statuses
Patient Tags
Patients

Procedures Not Attached to Insurance Report,  270
Billing Types
Clinics
Dates
Insurance Type
Patient Tags
Patients
Providers
Staff
With a Medical Claim (Received)
With a Medical Claim (Sent or Received)
With a Medical Claim (Sent)
With or Without a Medical Claim
Without a Medical Claim

Production Summary Report,  272
ADA Codes
Billing Types
Clinics
Date Type
Dates
Include Patient Detail
Patient Tags
Production Categories
Providers
Separate Totals for Medicaid and Non-Medicaid 
Patients
Staff

Provider A/R Totals - Daily Report,  276
ADA Codes
Billing Types
Collecting Clinics
Collections Date Type
Date Type
Dates
Include Adjustment Type List
Providers
Rendering Clinics
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Provider A/R Totals - Standard Report,  278
ADA Codes
Billing Types
Collecting Clinics
Collections Date Type
Date Type
Dates
Include Adjustment Type List
Providers
Rendering Clinics

Provider IDs List,  284
Clinics
Insurance Carriers
Insurance Types
Providers
Staff

Provider Revenue - Allocations Report,  286
Allocations
Allocations for Credits Not Posted
Allocations for Credits Posted
Allocations for Previously Suspended Credits
Billing Types
Collecting Clinics
Credit Adjustment Types
Dates
Guarantors
Patient Tags
Payment Types
Providers
Rendering Clinics

Provider Revenue - Charges Report,  288
Allocations
Allocations for Credits Not Posted
Allocations for Credits Posted
Allocations for Previously Suspended Credits
Billing Types
Collecting Clinics
Credit Adjustment Types
Dates
Guarantors
Patient Tags
Payment Types
Providers
Rendering Clinics

Provider Revenue - Credits Report,  290
Allocations
Allocations for Credits Not Posted
Allocations for Credits Posted
Allocations for Previously Suspended Credits
Billing Types
Collecting Clinics
Credit Adjustment Types
Dates
Guarantors
Patient Tags
Payment Types
Providers
Rendering Clinics

Provider Revenue - Summary Report,  292
Allocations
Allocations for Credits Not Posted
Allocations for Credits Posted

Allocations for Previously Suspended Credits
Billing Types
Collecting Clinics
Credit Adjustment Types
Dates
Guarantors
Patient Tags
Payment Types
Providers
Rendering Clinics

Referral Analysis Report,  294
Clinics
Date Type
First Visit Dates
Patient Tags
Providers
Treatment Dates

Referral Recap Report,  296
ADA Codes
Billing Types
Completed Work Dates
Patients
Providers
Referral Sources

Referral Slip,  298
N/A

Referred By Doctor/Other Report,  300
ADA Codes
Include All Referral Sources
Patients with No Production or Treatment-planned 
Procedures
Production Dates
Providers
Referral Dates
Referring Doctors/Others
Skip Non-persons

Referred By Patient Report,  302
Production Dates
Providers
Referral Dates
Referring Patients

Referred To Doctor Report,  304
ADA Codes
Clinics
Days Referred Out
Include All Referral Sources
Include Patients without Production
Providers
Refer to Doctors
Referral Dates
Referral Status

Registration Information Report,  306
N/A

RVU Day Sheet Report,  308
Billing Types
Clinics
Date Type
Dates
Exclude RVU Fees Equal to Zero
Include Procedures
Patient Tags
Providers
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Staff
Subtract Lab Expenses
Unique Patient Count
Unique Visit Count

RVU Production Summary Report,  310
ADA Codes
Billing Types
Clinics
Date Type
Dates
Include Patient Detail
Patient Tags
Procedure Categories
Providers
Staff
Subtract Lab Expenses

RVU Schedules Report,  314
ADA Codes
RVU Schedules

RVU Utilization Report,  316
ADA Codes
Billing Types
Clinics
Compare Fee Schedule with Co-pay (from Coverage 
Table)
Compare Fee Schedule with Transaction Amount
Date Type
Dates
Include All Procedures
Include Only Procedures in Coverage Table
Insurance Carriers
Insurance Plan Totals Only
Patient Tags
Providers
RVU Schedule
Staff

Secondary Insurance Claims Not Created Report,  
318

Billing Types
Clinics
Dates
Include Primary Claims not Received
Insurance Carriers
Insurance Type
Patient Tags
Patients
Providers
Staff

Secondary Pre-Treatment Estimates Not Created 
Report,  320

Billing Types
Clinics
Dates
Include Primary Pre-treatment Estimates Not Received
Insurance Carriers
Patient Tags
Patients
Providers

Standard Coverage Tables Report,  322
Coverage Tables

Suspended Credits Report,  324
Billing Types
Clinics
Date Type
Dates
Guarantors
Patient Tags

Treatment Case Report,  326
Visits

Treatment Plan Approval Report,  328
Clinics
Dates
Employers
Insurance Carriers
Patients
Providers
Starting Treatment Plan Amount

Treatment Plan Approval Status Report,  330
Approval Status
Clinics
Dates
Employers
Insurance Carriers
Only Search for Procedures that Have Had a Pre-
treatment Estimate Created
Patients
Procedures
Providers
Starting Treatment Plan Amount

Truth in Lending Disclosure Statement,  332
N/A

UDS - Age/Gender Report,  334
ADA Codes
Ages
Billing Types
Calculate Ages Based On UDS Report Requirements (as 
of June 30th)
Clinics
Date Type
Dates
Include Patient Info
Patient Tags
Providers

UDS - Encounters and Users by Selected Procedure 
Codes Report,  338

ADA Codes
Billing Types
Clinics
Date Type
Dates
Include Patient Info
Patient Tags
Providers

UDS - Encounters by Provider Report,  340
ADA Codes
Billing Types
Clinics
Date Type
Dates
Include Patient Info
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Patient Tags
Providers

UDS - Insurance Financial Class Report,  342
ADA Codes
Billing Types
Clinics
Date Type
Dates
Financial Classes
Include Patient Info
Providers

UDS - Insurance Financial Class Report (2013),  344
ADA Codes
Age Group 1 Cutoff
Billing Types
Clinics
Date Type
Dates
Financial Classes
Include Age Groups (as of June 30th)
Include Patient Info
Insurance Types
Patient Tags
Providers

UDS - Medicaid/Medicare Report,  346
Age Group 1 Cutoff
Dates
Financial Classes
Include Age Groups (as of June 30th)
Include Patient Info

UDS - Patient Related Revenue Report,  348
ADA Codes
Adjustment Types
Clinics
Dates
Fee Schedules
Financial Classes
Include Patient Info
Include Suspended Payments and Adjustments
Providers
Staff

UDS - Patient Status Report,  350
ADA Codes
Billing Types
Clinics
Date Type
Dates
Ethnicities
Gender Identities
Health Insurances
Homeless Status
Housing Statuses
Include Patient Info
Languages
Patient Tags
Poverty Level
Providers
Races
Religions
Sexual Orientations
User-defined Category
Veteran Status

Worker Status
ZIP Codes

UDS - Sealant Statistics Report,  352
ADA Codes
Birth Dates
Caries Risk Codes
Dates
Include Patient Info
Sealant Codes
Sealant Ineligibility Codes
Visit Codes

UDS - Tobacco Use and Intervention Report,  354
Billing Types
Clinics
Dates
Include Patient Info
Providers

Unscheduled Appointment List (DX1),  356
Clinics
Dates
Include Appointment Break Reason
Patient Tags
Providers
Time Zone

Unscheduled Appointment List (OM),  358
Providers
Unscheduled Appointment Dates

Unscheduled Treatment Plans (Condensed) Report,  
360

Dates
Exclude Non-referred Procedures
Exclude Referred by Procedures
Exclude Referred to Procedures
Patients
Primary Providers
Treatment Plan Providers

Unscheduled Treatment Plans (Detailed) Report,  
362

Dates
Exclude Non-referred Procedures
Exclude Referred by Procedures
Exclude Referred to Procedures
Patients
Primary Providers
Treatment Plan Providers

Updated Dental Insurance Payment Table Report,  
364

Insurance Carriers
Utilization Report,  366

ADA Codes
Billing Types
Clinics
Compare Fee Schedule with Co-pay (from Coverage 
Table)
Compare Fee Schedule with Transaction Amount
Date Type
Dates
Fee Schedule
Include All Procedures
Include Only Procedures in Coverage Table
Insurance Carriers



Index of Filters by Report  393

Dentrix Enterprise 11.0.2 Reports Reference

Insurance Plan Totals Only
Patient Tags
Providers
Staff

Walkout - Doctor’s Statement,  368
N/A

Walkout - Family Walkout,  370
N/A
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0 Account Balance
Letter Merge Reports,  158

Actions
Audit Report - Combined,  32

ADA Codes
Fee Schedules Report,  128
Initial Health History Report,  136
Letter Merge Reports,  158
Oral Health Education Report,  198
Periodontal Exam Report,  250
Production Summary Report,  272
Provider A/R Totals - Daily Report,  276
Provider A/R Totals - Standard Report,  278
Referral Recap Report,  296
Referred By Doctor/Other Report,  300
Referred To Doctor Report,  304
RVU Production Summary Report,  310
RVU Schedules Report,  314
RVU Utilization Report,  316
UDS - Age/Gender Report,  334
UDS - Encounters and Users by Selected Procedure 
Codes Report,  338
UDS - Encounters by Provider Report,  340
UDS - Insurance Financial Class Report,  342
UDS - Insurance Financial Class Report (2013),  344
UDS - Patient Related Revenue Report,  348
UDS - Patient Status Report,  350
UDS - Sealant Statistics Report,  352
Utilization Report,  366

Adjustment Types
Adjustment Summary Report,  4
Daily Summary Report,  88
Day Sheet (Adjustments) Report,  90
UDS - Patient Related Revenue Report,  348

Age Amount Outstanding
Insurance Claim Aging Report,  146

Age Group 1 Cutoff
UDS - Insurance Financial Class Report (2013),  344
UDS - Medicaid/Medicare Report,  346

Age Insurance Estimate
Insurance Claim Aging Report,  146
Pre-Treatment Estimate Aging Report,  262

Age Statistics
Practice Statistics Report,  256

Age Total Billed
Insurance Claim Aging Report,  146
Pre-Treatment Estimate Aging Report,  262

Ages
Initial Health History Report,  136
Oral Health Education Report,  198
Oral Health Status Report,  200
Patient List (Filtered),  214
Periodontal Exam Report,  250
UDS - Age/Gender Report,  334

Allergies
Letter Merge Reports,  158
Patient List (Filtered),  214

Allocations
Provider Revenue - Allocations Report,  286
Provider Revenue - Charges Report,  288
Provider Revenue - Credits Report,  290
Provider Revenue - Summary Report,  292

Allocations for Credits Not Posted
Provider Revenue - Allocations Report,  286
Provider Revenue - Charges Report,  288
Provider Revenue - Credits Report,  290
Provider Revenue - Summary Report,  292

Allocations for Credits Posted
Provider Revenue - Allocations Report,  286
Provider Revenue - Charges Report,  288
Provider Revenue - Credits Report,  290
Provider Revenue - Summary Report,  292

Allocations for Previously Suspended Credits
Provider Revenue - Allocations Report,  286
Provider Revenue - Charges Report,  288
Provider Revenue - Credits Report,  290
Provider Revenue - Summary Report,  292

Alternative Measure for CPOE
Meaningful Use Measure Calculation List,  162

Alternative Measure for Vital Signs
Meaningful Use Measure Calculation List,  162

AMA CPT Codes
Medical Code List,  186

Amount Aged <30
Letter Merge Reports,  158

Amount Aged <60
Letter Merge Reports,  158

Amount Aged <90
Letter Merge Reports,  158

Amount Aged <90+
Letter Merge Reports,  158

Appointment Dates
Continuing Care Cards - with Appointment,  75
Insurance Eligibility Report,  152
Letter Merge Reports,  158

Appointment Providers
Appointment Cycle Time Report,  16
Appointment Statistics Report,  20
As Soon As Possible List,  22
Daily Appointment List (DX1),  84

Appointment Status Duration
Appointment Statistics Report,  20

Appointment Statuses
Appointment Cycle Time Report,  16
Appointment Statistics Report,  20

Appointment with Continuing Care Attached
Continuing Care Cards - with Appointment,  75

Appointment without Continuing Care Type 
Attached

Continuing Care Cards - No Appointment,  74

Index by Filter
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Approval Status
Clinical Notes Report,  64
Treatment Plan Approval Status Report,  330

Attached Dates
Document Center - Documents List Report,  112

Audit Dates
Document Center Documents Audited Report,  118

Balance as of Date
Aging/Credit Balance Report,  6

Balance Forward Date
Billing Statement,  48

Balances
Aging/Credit Balance Report,  6
Letter Merge Reports,  158

Billing Provider
Insurance Transaction Analysis Report,  154

Billing Types
Adjustment Summary Report,  4
Aging/Credit Balance Report,  6
Analysis Summary Report - Daily,  8
Analysis Summary Report - Standard,  12
Billing Statement,  48
Birthday List,  50
Collections Manager List,  70
Continuing Care Display List,  76
Credit Card Transaction Report,  80
Daily Summary Report,  88
Day Sheet (Adjustments) Report,  90
Day Sheet (Charges and Receipts) Report,  94
Day Sheet (Receipts) Report,  98
Day Sheet Report,  100
Deposit Slip,  108
Family Ledger Report,  124
Finance Charge Report,  130
Future Due Payment Plan Report - Monthly Totals,  132
Future Due Payment Plan Report - Standard,  134
Insurance Claim Aging Report,  146
Insurance Claims Not Sent Report,  148
Insurance Transaction Analysis Report,  154
Late Charge Report,  156
Letter Merge Reports,  158
Patient Ledger Report,  210
Patient List,  212
Patient Notes Report,  216
Payment Agreement Report,  234
Payment Summary Report,  236
Practice Treatment Case Report,  258
Pre-Treatment Estimate Aging Report,  262
Pre-Treatment Estimates Not Sent Report,  264
Procedures Not Attached to Insurance Report,  270
Production Summary Report,  272
Provider A/R Totals - Daily Report,  276
Provider A/R Totals - Standard Report,  278
Provider Revenue - Allocations Report,  286
Provider Revenue - Charges Report,  288
Provider Revenue - Credits Report,  290
Provider Revenue - Summary Report,  292
Referral Recap Report,  296
RVU Day Sheet Report,  308
RVU Production Summary Report,  310
RVU Utilization Report,  316
Secondary Insurance Claims Not Created Report,  318

Secondary Pre-Treatment Estimates Not Created Re-
port,  320
Suspended Credits Report,  324
UDS - Age/Gender Report,  334
UDS - Encounters and Users by Selected Procedure 
Codes Report,  338
UDS - Encounters by Provider Report,  340
UDS - Insurance Financial Class Report,  342
UDS - Insurance Financial Class Report (2013),  344
UDS - Patient Status Report,  350
UDS - Tobacco Use and Intervention Report,  354
Utilization Report,  366

Birth Dates
Birthday List,  50
UDS - Sealant Statistics Report,  352

Birthday Days
Letter Merge Reports,  158

Birthday Months
Letter Merge Reports,  158

Birthday Years
Letter Merge Reports,  158

Blood Pressure
Meaningful Use Measure Calculation List,  162

Calculate Ages Based On UDS Report Requirements 
(as of June 30th)

UDS - Age/Gender Report,  334
Caries Risk

Oral Health Status Report,  200
Caries Risk Codes

UDS - Sealant Statistics Report,  352
Case Severity

Patient Treatment Case Report,  228
Practice Treatment Case Report,  258

Case Status
Patient Treatment Case Report,  228
Practice Treatment Case Report,  258

Changes
Audit Report - Appointments,  26
Audit Report - Clinics,  30
Audit Report - Combined,  32
Audit Report - Patients,  34
Audit Report - Providers/Staff,  36
Audit Report - Transactions,  38

Charge Date
Insurance Transaction Analysis Report,  154

Charge Provider
Insurance Transaction Analysis Report,  154

Chart Numbers
Day Sheet (Receipts) Report,  98

Cities
Letter Merge Reports,  158

Claim Received Date
Insurance Transaction Analysis Report,  154

Claim Rendering Provider
Insurance Transaction Analysis Report,  154

Claim Sent Date
Insurance Transaction Analysis Report,  154

Clinics
Aging/Credit Balance Report,  6
Analysis Summary Report - Daily,  8
Analysis Summary Report - Standard,  12
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Appointment Cycle Time Report,  16
Appointment Statistics Report,  20
Assigned Rights Report,  24
Audit Report - Clinics,  30
Audit Report - Combined,  32
Audit Report - Patients,  34
Audit Report - Providers/Staff,  36
Audit Report - Transactions,  38
Audit Rights Report - Assigned Individually,  40
Audit Rights Report - Assigned to Groups,  42
Audit Rights Report - Users to Groups,  46
Birthday List,  50
Caries Prevalence and Periodontal Index Report,  52
Clinical Notes Report,  64
Collections Manager List,  70
Continuing Care Display List,  76
Daily Appointment List (DX1),  84
Daily Summary Report,  88
Day Sheet (Adjustments) Report,  90
Day Sheet (Charges and Receipts) Report,  94
Day Sheet (Receipts) Report,  98
Day Sheet Report,  100
Dental Encounters Report,  106
Deposit Slip,  108
Document Center - Documents List Report,  112
Document Center Documents Audited Report,  118
Employers and Employed Patients Report,  122
Finance Charge Report,  130
Initial Health History Report,  136
Insurance Carrier List,  138
Insurance Carrier Production - Full Report,  142
Insurance Carrier Production - Summary Report,  144
Insurance Claim Aging Report,  146
Insurance Claims Not Sent Report,  148
Insurance Eligibility Report,  152
Insurance Transaction Analysis Report,  154
Late Charge Report,  156
Letter Merge Reports,  158
Oral Health Education Report,  198
Oral Health Status Report,  200
Patient Health Assessment Report,  206
Patient Information Accessed Report,  208
Patient List,  212
Patient List (Filtered),  214
Patient Revenue List by Payer Report,  224
Payment Agreement Report,  234
Periodontal Exam Report,  250
Practice Analysis Report,  252
Practice Organization List,  254
Practice Statistics Report,  256
Pre-Treatment Estimate Aging Report,  262
Pre-Treatment Estimates Not Sent Report,  264
Procedures by Contracted Amount Report,  268
Procedures Not Attached to Insurance Report,  270
Production Summary Report,  272
Provider IDs List,  284
Referral Analysis Report,  294
Referred To Doctor Report,  304
RVU Day Sheet Report,  308
RVU Production Summary Report,  310
RVU Utilization Report,  316
Secondary Insurance Claims Not Created Report,  318

Secondary Pre-Treatment Estimates Not Created Re-
port,  320
Suspended Credits Report,  324
Treatment Plan Approval Report,  328
Treatment Plan Approval Status Report,  330
UDS - Age/Gender Report,  334
UDS - Encounters and Users by Selected Procedure 
Codes Report,  338
UDS - Encounters by Provider Report,  340
UDS - Insurance Financial Class Report,  342
UDS - Insurance Financial Class Report (2013),  344
UDS - Patient Related Revenue Report,  348
UDS - Patient Status Report,  350
UDS - Tobacco Use and Intervention Report,  354
Unscheduled Appointment List (DX1),  356
Utilization Report,  366

Collecting Clinics
Adjustment Summary Report,  4
Payment Summary Report,  236
Provider A/R Totals - Daily Report,  276
Provider A/R Totals - Standard Report,  278
Provider Revenue - Allocations Report,  286
Provider Revenue - Charges Report,  288
Provider Revenue - Credits Report,  290
Provider Revenue - Summary Report,  292

Collections Date Type
Provider A/R Totals - Daily Report,  276
Provider A/R Totals - Standard Report,  278

Compare Fee Schedule with Co-pay (from Coverage 
Table)

RVU Utilization Report,  316
Utilization Report,  366

Compare Fee Schedule with Transaction Amount
RVU Utilization Report,  316
Utilization Report,  366

Completed Procedures
Letter Merge Reports,  158
Patient List (Filtered),  214

Completed Work Dates
Referral Recap Report,  296

Conditions
Initial Health History Report,  136
Oral Health Education Report,  198
Periodontal Exam Report,  250

Consent Dates
Letter Merge Reports,  158

Continuing Care
Patient List (Filtered),  214

Continuing Care Attached to Appointment
Letter Merge Reports,  158

Continuing Care Due Dates
Letter Merge Reports,  158

Continuing Care not Attached to Appointment
Letter Merge Reports,  158

Continuing Care Prior Treatment Dates
Letter Merge Reports,  158

Continuing Care Statistics
Practice Statistics Report,  256

Continuing Care Status
Continuing Care Display List,  76
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Continuing Care Type
Continuing Care Cards - No Appointment,  74
Continuing Care Cards - with Appointment,  75
Continuing Care Display List,  76
Letter Merge Reports,  158

Coverage Tables
Standard Coverage Tables Report,  322

Credit Adjustment Types
Provider Revenue - Allocations Report,  286
Provider Revenue - Charges Report,  288
Provider Revenue - Credits Report,  290
Provider Revenue - Summary Report,  292

Credit Balance
Letter Merge Reports,  158

Date Type
Adjustment Summary Report,  4
Aging/Credit Balance Report,  6
Analysis Summary Report - Daily,  8
Analysis Summary Report - Standard,  12
Daily Summary Report,  88
Day Sheet (Adjustments) Report,  90
Day Sheet (Receipts) Report,  98
Day Sheet Report,  100
Dental Encounters Report,  106
Deposit Slip,  108
Finance Charge Report,  130
Initial Health History Report,  136
Insurance Carrier Production - Full Report,  142
Insurance Carrier Production - Summary Report,  144
Insurance Transaction Analysis Report,  154
Late Charge Report,  156
Oral Health Education Report,  198
Patient Revenue List by Payer Report,  224
Payment Summary Report,  236
Periodontal Exam Report,  250
Practice Analysis Report,  252
Procedures by Contracted Amount Report,  268
Production Summary Report,  272
Provider A/R Totals - Daily Report,  276
Provider A/R Totals - Standard Report,  278
Referral Analysis Report,  294
RVU Day Sheet Report,  308
RVU Production Summary Report,  310
RVU Utilization Report,  316
Suspended Credits Report,  324
UDS - Age/Gender Report,  334
UDS - Encounters and Users by Selected Procedure 
Codes Report,  338
UDS - Encounters by Provider Report,  340
UDS - Insurance Financial Class Report,  342
UDS - Insurance Financial Class Report (2013),  344
UDS - Patient Status Report,  350
Utilization Report,  366

Dates
Adjustment Summary Report,  4
Analysis Summary Report - Daily,  8
Analysis Summary Report - Standard,  12
Appointment Book View Printout,  14
Appointment Cycle Time Report,  16
Appointment Statistics Report,  20
As Soon As Possible List,  22
Audit Report - Appointments,  26

Audit Report - Audit Log Status,  28
Audit Report - Clinics,  30
Audit Report - Combined,  32
Audit Report - Patients,  34
Audit Report - Providers/Staff,  36
Audit Report - Transactions,  38
Audit Rights Report - Assigned Individually,  40
Audit Rights Report - Assigned to Groups,  42
Audit Rights Report - Group Names,  44
Audit Rights Report - Users to Groups,  46
Caries Prevalence and Periodontal Index Report,  52
Clinical Notes Report,  64
Clinical Quality Measures List,  66
Credit Card Transaction Report,  80
Daily Appointment List (DX1),  84
Daily Appointment List Report,  86
Daily Summary Report,  88
Day Sheet (Adjustments) Report,  90
Day Sheet (Charges and Receipts) Report,  94
Day Sheet (Receipts) Report,  98
Day Sheet Report,  100
Deposit Slip,  108
Finance Charge Report,  130
Future Due Payment Plan Report - Monthly Totals,  132
Future Due Payment Plan Report - Standard,  134
Initial Health History Report,  136
Insurance Carrier Production - Full Report,  142
Insurance Carrier Production - Summary Report,  144
Insurance Claims Not Sent Report,  148
Insurance Transaction Analysis Report,  154
Late Charge Report,  156
Meaningful Use Measure Calculation List,  162
Operatory Appointment List Report,  196
Oral Health Education Report,  198
Oral Health Status Report,  200
Patient Health Assessment Report,  206
Patient Information Accessed Report,  208
Patient List (Filtered),  214
Patient Revenue List by Payer Report,  224
Payment Summary Report,  236
Perio Exam List,  248
Periodontal Exam Report,  250
Practice Analysis Report,  252
Pre-Treatment Estimates Not Sent Report,  264
Procedures by Contracted Amount Report,  268
Procedures Not Attached to Insurance Report,  270
Production Summary Report,  272
Provider A/R Totals - Daily Report,  276
Provider A/R Totals - Standard Report,  278
Provider Revenue - Allocations Report,  286
Provider Revenue - Charges Report,  288
Provider Revenue - Credits Report,  290
Provider Revenue - Summary Report,  292
RVU Day Sheet Report,  308
RVU Production Summary Report,  310
RVU Utilization Report,  316
Secondary Insurance Claims Not Created Report,  318
Secondary Pre-Treatment Estimates Not Created Re-
port,  320
Suspended Credits Report,  324
Treatment Plan Approval Report,  328
Treatment Plan Approval Status Report,  330
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UDS - Age/Gender Report,  334
UDS - Encounters and Users by Selected Procedure 
Codes Report,  338
UDS - Encounters by Provider Report,  340
UDS - Insurance Financial Class Report,  342
UDS - Insurance Financial Class Report (2013),  344
UDS - Medicaid/Medicare Report,  346
UDS - Patient Related Revenue Report,  348
UDS - Patient Status Report,  350
UDS - Sealant Statistics Report,  352
UDS - Tobacco Use and Intervention Report,  354
Unscheduled Appointment List (DX1),  356
Unscheduled Treatment Plans (Condensed) Report,  360
Unscheduled Treatment Plans (Detailed) Report,  362
Utilization Report,  366

Dates (for Appointment Notes)
Patient Notes Report,  216

Dates (for Clinical Notes)
Patient Notes Report,  216

Dates (for Patient Alert Notes)
Patient Notes Report,  216

Dates (for Perio Exam Notes)
Patient Notes Report,  216

Days Past Due
Aging/Credit Balance Report,  6

Days Referred Out
Referred To Doctor Report,  304

Dental Insurance Plan Attachment
Document Center Audit Documents Report,  114
Document Center Documents Audited Report,  118

Dental Insurance Plans
Document Center - Documents List Report,  112

Diabetes
Oral Health Status Report,  200

Display Allocate Date for Payments
Insurance Transaction Analysis Report,  154

Document Center Paths
Document Center - Documents List Report,  112

Dry Mouth
Oral Health Status Report,  200

Due Dates
Continuing Care Cards - No Appointment,  74
Continuing Care Display List,  76

Employer Attachment
Document Center Audit Documents Report,  114
Document Center Documents Audited Report,  118

Employers
Document Center - Documents List Report,  112
Employers and Employed Patients Report,  122
Insurance Eligibility Report,  152
Letter Merge Reports,  158
Treatment Plan Approval Report,  328
Treatment Plan Approval Status Report,  330

Encounter Numbers
Clinical Notes Report,  64

Error Types
Document Center Documents Audited Report,  118

Ethnicities
UDS - Patient Status Report,  350

Ethnicity
Patient List (Filtered),  214

Exclude Chart-Pulled Appointments
Daily Appointment List (DX1),  84
Daily Appointment List Report,  86

Exclude Non-referred Procedures
Unscheduled Treatment Plans (Condensed) Report,  360
Unscheduled Treatment Plans (Detailed) Report,  362

Exclude Referred by Procedures
Unscheduled Treatment Plans (Condensed) Report,  360
Unscheduled Treatment Plans (Detailed) Report,  362

Exclude Referred to Procedures
Unscheduled Treatment Plans (Condensed) Report,  360
Unscheduled Treatment Plans (Detailed) Report,  362

Exclude RVU Fees Equal to Zero
RVU Day Sheet Report,  308

Existing Patients with Appointment in Date Range
Continuing Care Cards - with Appointment,  75

Existing Patients with Appointments in Date Range
Letter Merge Reports,  158

Existing Patients with no Appointments in Date 
Range

Letter Merge Reports,  158
Existing Procedures

Letter Merge Reports,  158
Expiration Dates

Patient Treatment Case Report,  228
Practice Treatment Case Report,  258

Families
Patient Information Accessed Report,  208

Fee Schedule
Fee Schedules Report,  128
Utilization Report,  366

Fee Schedules
UDS - Patient Related Revenue Report,  348

Financial Classes
Insurance Carrier List,  138
Insurance Carrier Production - Full Report,  142
Insurance Carrier Production - Summary Report,  144
Insurance Transaction Analysis Report,  154
UDS - Insurance Financial Class Report,  342
UDS - Insurance Financial Class Report (2013),  344
UDS - Medicaid/Medicare Report,  346
UDS - Patient Related Revenue Report,  348

First Transaction Date
Family Ledger Report,  124
Family Ledger Report (Single Family),  126
Patient Ledger Report,  210

First Visit Dates
Letter Merge Reports,  158
New Patient List,  190
Referral Analysis Report,  294

Gender
Patient List (Filtered),  214

Gender Identities
UDS - Patient Status Report,  350

Guarantors
Aging/Credit Balance Report,  6
Billing Statement,  48
Collections Manager List,  70
Family Ledger Report,  124
Future Due Payment Plan Report - Monthly Totals,  132
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Future Due Payment Plan Report - Standard,  134
Payment Agreement Report,  234
Provider Revenue - Allocations Report,  286
Provider Revenue - Charges Report,  288
Provider Revenue - Credits Report,  290
Provider Revenue - Summary Report,  292
Suspended Credits Report,  324

Health Insurances
UDS - Patient Status Report,  350

Height/Length and Weight
Meaningful Use Measure Calculation List,  162

Homeless Status
Patient List (Filtered),  214
UDS - Patient Status Report,  350

Housing Statuses
UDS - Patient Status Report,  350

ICD-10CM Codes
Medical Code List,  186

ICD-9CM Codes
Medical Code List,  186

ICD-9-CM Diagnostic Codes
Patient List (Filtered),  214

If not Billed since Date
Billing Statement,  48

Include Adjustment Type List
Provider A/R Totals - Daily Report,  276
Provider A/R Totals - Standard Report,  278

Include Age Groups (as of June 30th)
UDS - Insurance Financial Class Report (2013),  344
UDS - Medicaid/Medicare Report,  346

Include All Patients
Insurance Carrier List,  138

Include All Procedures
RVU Utilization Report,  316
Utilization Report,  366

Include All Referral Sources
Referred By Doctor/Other Report,  300
Referred To Doctor Report,  304

Include Appointment Break Reason
Unscheduled Appointment List (DX1),  356

Include Charge Adjustments
Insurance Transaction Analysis Report,  154

Include Charges
Insurance Transaction Analysis Report,  154

Include Completed Procedures Only
Initial Health History Report,  136
Oral Health Education Report,  198
Periodontal Exam Report,  250

Include Credit Adjustments
Insurance Transaction Analysis Report,  154

Include Detail
Initial Health History Report,  136
Oral Health Education Report,  198
Periodontal Exam Report,  250

Include Employees
Employers and Employed Patients Report,  122

Include Grand Totals
Insurance Transaction Analysis Report,  154

Include Guarantor Notes
Aging/Credit Balance Report,  6

Include Insurance Payments
Insurance Transaction Analysis Report,  154

Include Only Procedures in Coverage Table
RVU Utilization Report,  316
Utilization Report,  366

Include Patient Detail
Production Summary Report,  272
RVU Production Summary Report,  310

Include Patient Info
UDS - Age/Gender Report,  334
UDS - Encounters and Users by Selected Procedure 
Codes Report,  338
UDS - Encounters by Provider Report,  340
UDS - Insurance Financial Class Report,  342
UDS - Insurance Financial Class Report (2013),  344
UDS - Medicaid/Medicare Report,  346
UDS - Patient Related Revenue Report,  348
UDS - Patient Status Report,  350
UDS - Sealant Statistics Report,  352
UDS - Tobacco Use and Intervention Report,  354

Include Patient Payments
Insurance Transaction Analysis Report,  154

Include Patients in Numerator Only if Exist in 
Denominator

Initial Health History Report,  136
Oral Health Education Report,  198
Periodontal Exam Report,  250

Include Patients without Production
Referred To Doctor Report,  304

Include Primary Claims not Received
Secondary Insurance Claims Not Created Report,  318

Include Primary Pre-treatment Estimates Not 
Received

Secondary Pre-Treatment Estimates Not Created Re-
port,  320

Include Procedures
RVU Day Sheet Report,  308

Include Provider IDs
Insurance Carrier List,  138

Include Quaternary Claims
Insurance Transaction Analysis Report,  154

Include Refunds
Credit Card Transaction Report,  80

Include Secondary Claims
Insurance Transaction Analysis Report,  154

Include Subscribers
Insurance Carrier List,  138

Include Subtotals by Carrier
Insurance Transaction Analysis Report,  154

Include Suspended Payments and Adjustments
UDS - Patient Related Revenue Report,  348

Include Tertiary Claims
Insurance Transaction Analysis Report,  154

Include Voids
Credit Card Transaction Report,  80

In-operatory Appointment Statuses
Appointment Cycle Time Report,  16

Insurance Carriers
Dental Encounters Report,  106
Insurance Carrier List,  138
Insurance Carrier Production - Full Report,  142
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Insurance Carrier Production - Summary Report,  144
Insurance Claim Aging Report,  146
Insurance Claims Not Sent Report,  148
Insurance Eligibility Report,  152
Insurance Transaction Analysis Report,  154
Letter Merge Reports,  158
Pre-Treatment Estimate Aging Report,  262
Pre-Treatment Estimates Not Sent Report,  264
Provider IDs List,  284
RVU Utilization Report,  316
Secondary Insurance Claims Not Created Report,  318
Secondary Pre-Treatment Estimates Not Created Re-
port,  320
Treatment Plan Approval Report,  328
Treatment Plan Approval Status Report,  330
Updated Dental Insurance Payment Table Report,  364
Utilization Report,  366

Insurance Minimum Days Past Due
Collections Manager List,  70

Insurance Plan Totals Only
RVU Utilization Report,  316
Utilization Report,  366

Insurance Type
Insurance Carrier List,  138
Insurance Carrier Production - Full Report,  142
Insurance Carrier Production - Summary Report,  144
Insurance Claim Aging Report,  146
Insurance Claims Not Sent Report,  148
Insurance Transaction Analysis Report,  154
Pre-Treatment Estimate Aging Report,  262
Pre-Treatment Estimates Not Sent Report,  264
Procedures Not Attached to Insurance Report,  270
Secondary Insurance Claims Not Created Report,  318

Insurance Types
Provider IDs List,  284
UDS - Insurance Financial Class Report (2013),  344

Laboratory Test Results
Patient List (Filtered),  214

Language
Patient List (Filtered),  214

Languages
UDS - Patient Status Report,  350

Last Payment Before Date
Aging/Credit Balance Report,  6
Collections Manager List,  70

Last Payment Plan Payment Dates
Letter Merge Reports,  158

Last Referral Dates
Letter Merge Reports,  158

Last Visit Before Date
Patient List,  212

Last Visit Dates
Continuing Care Display List,  76
Letter Merge Reports,  158

Maximum Appointment Status Duration (Cap)
Appointment Statistics Report,  20

Maximum Duration of Appointments in Status 
Range (Cap)

Appointment Statistics Report,  20

Meaningful Use Stages
Meaningful Use Measure Calculation List,  162

Medical Alerts
Letter Merge Reports,  158
Patient List (Filtered),  214

Medical Insurance Plan Attachment
Document Center Audit Documents Report,  114
Document Center Documents Audited Report,  118

Medical Insurance Plans
Document Center - Documents List Report,  112

Medications
Letter Merge Reports,  158
Patient List (Filtered),  214

Minimum Balance
Collections Manager List,  70

Minimum Balance to Bill
Billing Statement,  48

Minimum Days Past Due
Collections Manager List,  70
Insurance Claim Aging Report,  146
Pre-Treatment Estimate Aging Report,  262

Modifier Codes
Medical Code List,  186

Modules
Patient Information Accessed Report,  208

Multi-Codes
Multi-Code List,  188

N/A
Appointment Reminder Cards,  18
Coupon Book - Future Due Payments,  78
Coupon Book - Payment Agreements,  79
Custom Practice Information Report,  82
Dental Diagnostic Code List,  104
Document Center Document,  116
Document Center List,  120
Insurance Coverage Tables Report,  150
Office Journal Report,  192
Operator Day Sheet Report,  194
Patient Chart and Progress Notes Printout,  202
Patient Chart Printout,  204
Patient Proposed Treatment Case Report (Your Care 
Plan),  220
Patient Questionnaire,  222
Patient Route Slip,  226
Patient’s Ledger Report,  230
Payment Agreement Amortization Schedule,  232
Perio - Combined Graphic & Data Chart Report,  238
Perio - Data Chart Report,  240
Perio - Exam Comparison Report,  242
Perio - Graphic Chart Report,  244
Perio - Pocket Depths Only Report,  246
Prescription Printout,  260
Referral Slip,  298
Registration Information Report,  306
Truth in Lending Disclosure Statement,  332
Walkout - Doctor’s Statement,  368
Walkout - Family Walkout,  370

New Patient Statistics
Practice Statistics Report,  256
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No Continuing Care and no Future Appointments
Patient List,  212

No Insurance Coverage
Letter Merge Reports,  158

Not Billed Since Date
Collections Manager List,  70

Note Texts
Letter Merge Reports,  158

Number of Missed Payments
Collections Manager List,  70

Number of Payments Missed
Payment Agreement Report,  234

Only Bill Aged Accounts
Billing Statement,  48

Only Guarantors
Letter Merge Reports,  158
Patient Notes Report,  216

Only Search for Procedures that Have Had a Pre-
treatment Estimate Created

Treatment Plan Approval Status Report,  330
Operatories

Appointment Book View Printout,  14
Audit Report - Appointments,  26
Daily Appointment List (DX1),  84
Daily Appointment List Report,  86
Operatory Appointment List Report,  196

Operators
Credit Card Transaction Report,  80
Day Sheet (Charges and Receipts) Report,  94
Deposit Slip,  108

Oral Health Statuses
Oral Health Status Report,  200

Patient Attachment
Document Center Audit Documents Report,  114
Document Center Documents Audited Report,  118

Patient Gender
Letter Merge Reports,  158

Patient Marital Status
Letter Merge Reports,  158

Patient Names
Letter Merge Reports,  158

Patient Statistics
Practice Statistics Report,  256

Patient Status
Letter Merge Reports,  158

Patient Statuses
Patient List,  212
Patient Revenue List by Payer Report,  224
Procedures by Contracted Amount Report,  268

Patient Tags
Adjustment Summary Report,  4
Aging/Credit Balance Report,  6
Analysis Summary Report - Daily,  8
Analysis Summary Report - Standard,  12
Appointment Cycle Time Report,  16
As Soon As Possible List,  22
Audit Report - Appointments,  26
Audit Report - Combined,  32
Audit Report - Patients,  34
Audit Report - Transactions,  38
Birthday List,  50

Clinical Notes Report,  64
Credit Card Transaction Report,  80
Daily Appointment List (DX1),  84
Daily Summary Report,  88
Day Sheet (Adjustments) Report,  90
Day Sheet (Receipts) Report,  98
Day Sheet Report,  100
Dental Encounters Report,  106
Deposit Slip,  108
Document Center - Documents List Report,  112
Finance Charge Report,  130
Initial Health History Report,  136
Insurance Carrier Production - Full Report,  142
Insurance Carrier Production - Summary Report,  144
Insurance Claim Aging Report,  146
Insurance Claims Not Sent Report,  148
Insurance Transaction Analysis Report,  154
Late Charge Report,  156
Oral Health Education Report,  198
Oral Health Status Report,  200
Patient Health Assessment Report,  206
Patient Information Accessed Report,  208
Patient List,  212
Patient Revenue List by Payer Report,  224
Payment Summary Report,  236
Periodontal Exam Report,  250
Pre-Treatment Estimate Aging Report,  262
Pre-Treatment Estimates Not Sent Report,  264
Procedures by Contracted Amount Report,  268
Procedures Not Attached to Insurance Report,  270
Production Summary Report,  272
Provider Revenue - Allocations Report,  286
Provider Revenue - Charges Report,  288
Provider Revenue - Credits Report,  290
Provider Revenue - Summary Report,  292
Referral Analysis Report,  294
RVU Day Sheet Report,  308
RVU Production Summary Report,  310
RVU Utilization Report,  316
Secondary Insurance Claims Not Created Report,  318
Secondary Pre-Treatment Estimates Not Created Re-
port,  320
Suspended Credits Report,  324
UDS - Age/Gender Report,  334
UDS - Encounters and Users by Selected Procedure 
Codes Report,  338
UDS - Encounters by Provider Report,  340
UDS - Insurance Financial Class Report (2013),  344
UDS - Patient Status Report,  350
Unscheduled Appointment List (DX1),  356
Utilization Report,  366

Patients
Audit Report - Appointments,  26
Audit Report - Combined,  32
Audit Report - Patients,  34
Audit Report - Transactions,  38
Birthday List,  50
Clinical Notes Report,  64
Daily Appointment List (DX1),  84
Daily Appointment List Report,  86
Dental Encounters Report,  106
Document Center - Documents List Report,  112
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Insurance Carrier Production - Full Report,  142
Insurance Carrier Production - Summary Report,  144
Insurance Claim Aging Report,  146
Insurance Claims Not Sent Report,  148
Insurance Eligibility Report,  152
New Patient List,  190
Operatory Appointment List Report,  196
Patient Health Assessment Report,  206
Patient Information Accessed Report,  208
Patient Ledger Report,  210
Patient List,  212
Patient Notes Report,  216
Patient Revenue List by Payer Report,  224
Perio Exam List,  248
Practice Treatment Case Report,  258
Pre-Treatment Estimate Aging Report,  262
Pre-Treatment Estimates Not Sent Report,  264
Procedures by Contracted Amount Report,  268
Procedures Not Attached to Insurance Report,  270
Referral Recap Report,  296
Secondary Insurance Claims Not Created Report,  318
Secondary Pre-Treatment Estimates Not Created Re-
port,  320
Treatment Plan Approval Report,  328
Treatment Plan Approval Status Report,  330
Unscheduled Treatment Plans (Condensed) Report,  360
Unscheduled Treatment Plans (Detailed) Report,  362

Patients with No Production or Treatment-planned 
Procedures

Referred By Doctor/Other Report,  300
Pay To Provider

Insurance Transaction Analysis Report,  154
Payment Agreement Dates

Payment Agreement Report,  234
Payment Agreement Intervals

Payment Agreement Report,  234
Payment Plan Balances

Letter Merge Reports,  158
Payment Types

Daily Summary Report,  88
Day Sheet (Receipts) Report,  98
Deposit Slip,  108
Payment Summary Report,  236
Provider Revenue - Allocations Report,  286
Provider Revenue - Charges Report,  288
Provider Revenue - Credits Report,  290
Provider Revenue - Summary Report,  292

Pending Claims
Collections Manager List,  70

Place of Service Codes
Medical Code List,  186

Poverty Level
Patient List (Filtered),  214
UDS - Patient Status Report,  350

Preferred Contact Method
Patient List (Filtered),  214

Prescriptions
Patient List (Filtered),  214

Previous Office Journal Entry Before Date
Collections Manager List,  70

Previous Payment Due Date
Payment Agreement Report,  234

Primary Insurance Coverage
Letter Merge Reports,  158

Primary Provider
Patient List (Filtered),  214

Primary Providers
As Soon As Possible List,  22
Billing Statement,  48
Unscheduled Treatment Plans (Condensed) Report,  360
Unscheduled Treatment Plans (Detailed) Report,  362

Prior Treatment Dates
Continuing Care Display List,  76

Privacy Requests for no Correspondence for 
Patients and Guarantors

Letter Merge Reports,  158
Privacy Requests for no Correspondence for 
Referred by Patients

Letter Merge Reports,  158
Procedure Categories

RVU Production Summary Report,  310
Procedure Codes

Procedure Code List,  266
Procedure Dates

Dental Encounters Report,  106
Letter Merge Reports,  158
Patient Treatment Case Report,  228
Practice Treatment Case Report,  258

Procedures
Treatment Plan Approval Status Report,  330

Production Categories
Production Summary Report,  272

Production Dates
Referred By Doctor/Other Report,  300
Referred By Patient Report,  302

Prophy Types
Practice Statistics Report,  256

Prospective Patients with Appointments in Date 
Range

Letter Merge Reports,  158
Provider Statistics

Practice Statistics Report,  256
Provider/Staff Attachment

Document Center Audit Documents Report,  114
Document Center Documents Audited Report,  118

Providers
Adjustment Summary Report,  4
Aging/Credit Balance Report,  6
Analysis Summary Report - Daily,  8
Analysis Summary Report - Standard,  12
Appointment Book View Printout,  14
Audit Report - Providers/Staff,  36
Birthday List,  50
Clinical Notes Report,  64
Clinical Quality Measures List,  66
Collections Manager List,  70
Continuing Care Display List,  76
Daily Appointment List (DX1),  84
Daily Appointment List Report,  86
Day Sheet (Adjustments) Report,  90
Day Sheet (Charges and Receipts) Report,  94
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Day Sheet (Receipts) Report,  98
Day Sheet Report,  100
Dental Encounters Report,  106
Document Center - Documents List Report,  112
Employers and Employed Patients Report,  122
Family Ledger Report,  124
Finance Charge Report,  130
Future Due Payment Plan Report - Monthly Totals,  132
Future Due Payment Plan Report - Standard,  134
Initial Health History Report,  136
Insurance Carrier Production - Full Report,  142
Insurance Carrier Production - Summary Report,  144
Insurance Claim Aging Report,  146
Insurance Claims Not Sent Report,  148
Insurance Eligibility Report,  152
Insurance Transaction Analysis Report,  154
Late Charge Report,  156
Letter Merge Reports,  158
Meaningful Use Measure Calculation List,  162
New Patient List,  190
Operatory Appointment List Report,  196
Oral Health Education Report,  198
Oral Health Status Report,  200
Patient Ledger Report,  210
Patient List,  212
Patient Notes Report,  216
Patient Treatment Case Report,  228
Payment Agreement Report,  234
Payment Summary Report,  236
Periodontal Exam Report,  250
Practice Analysis Report,  252
Practice Organization List,  254
Practice Statistics Report,  256
Practice Treatment Case Report,  258
Pre-Treatment Estimate Aging Report,  262
Pre-Treatment Estimates Not Sent Report,  264
Procedures Not Attached to Insurance Report,  270
Production Summary Report,  272
Provider A/R Totals - Daily Report,  276
Provider A/R Totals - Standard Report,  278
Provider IDs List,  284
Provider Revenue - Allocations Report,  286
Provider Revenue - Charges Report,  288
Provider Revenue - Credits Report,  290
Provider Revenue - Summary Report,  292
Referral Analysis Report,  294
Referral Recap Report,  296
Referred By Doctor/Other Report,  300
Referred By Patient Report,  302
Referred To Doctor Report,  304
RVU Day Sheet Report,  308
RVU Production Summary Report,  310
RVU Utilization Report,  316
Secondary Insurance Claims Not Created Report,  318
Secondary Pre-Treatment Estimates Not Created Re-
port,  320
Treatment Plan Approval Report,  328
Treatment Plan Approval Status Report,  330
UDS - Age/Gender Report,  334
UDS - Encounters and Users by Selected Procedure 
Codes Report,  338
UDS - Encounters by Provider Report,  340

UDS - Insurance Financial Class Report,  342
UDS - Insurance Financial Class Report (2013),  344
UDS - Patient Related Revenue Report,  348
UDS - Patient Status Report,  350
UDS - Tobacco Use and Intervention Report,  354
Unscheduled Appointment List (DX1),  356
Unscheduled Appointment List (OM),  358
Utilization Report,  366

Race
Patient List (Filtered),  214

Races
UDS - Patient Status Report,  350

Refer to Doctors
Referred To Doctor Report,  304

Refer to Patients
Document Center - Documents List Report,  112

Referral Dates
Referred By Doctor/Other Report,  300
Referred By Patient Report,  302
Referred To Doctor Report,  304

Referral Sources
Document Center - Documents List Report,  112
Referral Recap Report,  296

Referral Status
Referred To Doctor Report,  304

Referred By Attachment
Document Center Audit Documents Report,  114
Document Center Documents Audited Report,  118

Referred by Dates
Letter Merge Reports,  158

Referred by Doctor/Other
Letter Merge Reports,  158

Referred by Patient
Letter Merge Reports,  158

Referred by Sources
Letter Merge Reports,  158

Referred To Attachment
Document Center Audit Documents Report,  114
Document Center Documents Audited Report,  118

Referred to Dates
Letter Merge Reports,  158

Referred to Names
Letter Merge Reports,  158

Referring Doctors/Others
Referred By Doctor/Other Report,  300

Referring Patients
Referred By Patient Report,  302

Religion
Patient List (Filtered),  214

Religions
UDS - Patient Status Report,  350

Remaining Balances
Payment Agreement Report,  234

Remaining Insurance Benefit Amounts
Letter Merge Reports,  158

Remaining Number of Payments
Payment Agreement Report,  234

Rendering Clinics
Adjustment Summary Report,  4
Payment Summary Report,  236
Provider A/R Totals - Daily Report,  276
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Provider A/R Totals - Standard Report,  278
Provider Revenue - Allocations Report,  286
Provider Revenue - Charges Report,  288
Provider Revenue - Credits Report,  290
Provider Revenue - Summary Report,  292

Rights
Assigned Rights Report,  24
Audit Rights Report - Assigned Individually,  40
Audit Rights Report - Assigned to Groups,  42

RVU Schedule
RVU Utilization Report,  316

RVU Schedules
RVU Schedules Report,  314

Scan Dates
Document Center Audit Documents Report,  114
Document Center Documents Audited Report,  118

Scheduled Appointment
Continuing Care Display List,  76

Sealant Codes
UDS - Sealant Statistics Report,  352

Sealant Ineligibility Codes
UDS - Sealant Statistics Report,  352

Search as Date Range
Birthday List,  50

Secondary Insurance Coverage
Letter Merge Reports,  158

Separate Totals for Medicaid and Non-Medicaid 
Patients

Production Summary Report,  272
Sexual Orientations

UDS - Patient Status Report,  350
Show Open Claims Only

Insurance Claim Aging Report,  146
Signed Dates

Document Center - Documents List Report,  112
Skip Account with Claim Pending

Billing Statement,  48
Skip Accounts with Claim Pending if Patient Portion 
Less than Amount

Billing Statement,  48
Skip Non-persons

Referred By Doctor/Other Report,  300
Staff

Analysis Summary Report - Daily,  8
Analysis Summary Report - Standard,  12
Audit Report - Providers/Staff,  36
Birthday List,  50
Clinical Notes Report,  64
Day Sheet Report,  100
Document Center - Documents List Report,  112
Employers and Employed Patients Report,  122
Finance Charge Report,  130
Insurance Claims Not Sent Report,  148
Late Charge Report,  156
Practice Analysis Report,  252
Practice Organization List,  254
Practice Statistics Report,  256
Pre-Treatment Estimate Aging Report,  262
Pre-Treatment Estimates Not Sent Report,  264
Procedures Not Attached to Insurance Report,  270
Production Summary Report,  272

Provider IDs List,  284
RVU Day Sheet Report,  308
RVU Production Summary Report,  310
RVU Utilization Report,  316
Secondary Insurance Claims Not Created Report,  318
UDS - Patient Related Revenue Report,  348
Utilization Report,  366

Starting Treatment Plan Amount
Treatment Plan Approval Report,  328
Treatment Plan Approval Status Report,  330

Subtract Lab Expenses
RVU Day Sheet Report,  308
RVU Production Summary Report,  310

Time
Appointment Book View Printout,  14

Time Zone
Appointment Statistics Report,  20
As Soon As Possible List,  22
Audit Report - Appointments,  26
Audit Report - Audit Log Status,  28
Audit Report - Clinics,  30
Audit Report - Combined,  32
Audit Report - Patients,  34
Audit Report - Providers/Staff,  36
Audit Report - Transactions,  38
Audit Rights Report - Assigned Individually,  40
Audit Rights Report - Assigned to Groups,  42
Audit Rights Report - Group Names,  44
Audit Rights Report - Users to Groups,  46
Clinical Notes Report,  64
Daily Summary Report,  88
Patient Information Accessed Report,  208
Unscheduled Appointment List (DX1),  356

Tobacco Use
Oral Health Status Report,  200

Treatment Dates
Referral Analysis Report,  294

Treatment Plan Providers
Unscheduled Treatment Plans (Condensed) Report,  360
Unscheduled Treatment Plans (Detailed) Report,  362

Treatment-planned Procedures
Letter Merge Reports,  158

Type of Service Codes
Medical Code List,  186

Unique Patient Count
RVU Day Sheet Report,  308

Unique Visit Count
RVU Day Sheet Report,  308

Unscheduled Appointment
Continuing Care Display List,  76

Unscheduled Appointment Dates
Unscheduled Appointment List (OM),  358

User Defined Category
Patient List (Filtered),  214

User Groups
Audit Rights Report - Group Names,  44
Audit Rights Report - Users to Groups,  46

User-defined Category
UDS - Patient Status Report,  350
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Users
Assigned Rights Report,  24
Audit Report - Audit Log Status,  28
Audit Rights Report - Assigned Individually,  40
Audit Rights Report - Assigned to Groups,  42
Audit Rights Report - Users to Groups,  46
Document Center - Documents List Report,  112
Document Center Documents Audited Report,  118

Users Changed
Audit Report - Appointments,  26
Audit Report - Clinics,  30
Audit Report - Combined,  32
Audit Report - Patients,  34
Audit Report - Providers/Staff,  36
Audit Report - Transactions,  38
Audit Rights Report - Assigned Individually,  40
Audit Rights Report - Assigned to Groups,  42
Audit Rights Report - Group Names,  44
Audit Rights Report - Users to Groups,  46
Patient Information Accessed Report,  208

Veteran Status
Patient List (Filtered),  214
UDS - Patient Status Report,  350

Visit Codes
UDS - Sealant Statistics Report,  352

Visits
Treatment Case Report,  326

With a Medical Claim (Received)
Procedures Not Attached to Insurance Report,  270

With a Medical Claim (Sent or Received)
Procedures Not Attached to Insurance Report,  270

With a Medical Claim (Sent)
Procedures Not Attached to Insurance Report,  270

With or Without a Medical Claim
Procedures Not Attached to Insurance Report,  270

Without a Medical Claim
Procedures Not Attached to Insurance Report,  270

Worker Status
Patient List (Filtered),  214
UDS - Patient Status Report,  350

ZIP Code Statistics
Practice Statistics Report,  256

ZIP Codes
Letter Merge Reports,  158
UDS - Patient Status Report,  350
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Abbreviated Description
ADA Code Abbreviated Description

Procedure Code List	 266
Multi-Code List	 188

Vaccine Abbreviated Description
Patient List (Filtered)	 214

Accepted
Percent of Accepted Cases

Practice Treatment Case Report	 258
Access

Clinic of Access
Patient Information Accessed Report	 208

Date of Access
Patient Information Accessed Report	 208

Module of Access
Patient Information Accessed Report	 208

Number of Patients Provided API Access to Electronic 
Health Information

Meaningful Use Measure Calculation List	 162
Number of Patients Provided Timely Online Access to 
Electronic Health Information

Meaningful Use Measure Calculation List	 162
Number of Patients who Accessed Electronic Health 
Information with API

Meaningful Use Measure Calculation List	 162
Status of Access

Patient Information Accessed Report	 208
Time of Access

Patient Information Accessed Report	 208
Accessed

Accessed Patient Information
Audit Report - Combined	 32

Account
Account Amount Aged >90

Patient Route Slip	 226
Account Amount Aged 0 - 30

Patient Route Slip	 226
Account Amount Aged 181+

Pre-Treatment Estimate Aging Report	 262
Account Amount Aged 31 - 60

Patient Route Slip	 226
Account Amount Aged 61 - 90

Patient Route Slip	 226
Account Balance

Collections Manager List	 70
Family Ledger Report	 124
Family Ledger Report (Single Family)	 126
Insurance Claim Aging Report	 146
Letter Merge Reports	 158
Patient Route Slip	 226
Patient’s Ledger Report	 230
Payment Agreement Report	 234
Pre-Treatment Estimate Aging Report	 262
Aging/Credit Balance Report	 6

Account Balance Amount Aged 121 - 150
Pre-Treatment Estimate Aging Report	 262

Account Balance Amount Aged 151 - 180
Pre-Treatment Estimate Aging Report	 262

Account Balance Amount Aged 31 - 60
Pre-Treatment Estimate Aging Report	 262

Account Balance Amount Aged 61 - 90
Pre-Treatment Estimate Aging Report	 262

Account Balance Amount Aged 91 - 120
Pre-Treatment Estimate Aging Report	 262

Account Clinic
Collections Manager List	 70

Account Estimated Insurance Portion
Patient Route Slip	 226

Account Holder Name
Deposit Slip	 108

Account Note
Collections Manager List	 70

Account Provider
Collections Manager List	 70

Account Suspended Credit Amount
Patient Route Slip	 226

Amount of Account Balance Aged >90
Insurance Claim Aging Report	 146

Amount of Account Balance Aged 1 - 30
Insurance Claim Aging Report	 146

Amount of Account Balance Aged 31 - 60
Insurance Claim Aging Report	 146

Amount of Account Balance Aged 61 - 90
Insurance Claim Aging Report	 146

Bank Account Number
Deposit Slip	 108
Audit Report - Clinics	 30

Bank Account Number Change
Audit Report - Clinics	 30

Current Account Balance
Billing Statement	 48

Ledger Balance
Suspended Credits Report	 324

Prior Account Balance
Walkout - Family Walkout	 370

Total Account Balance
Insurance Claim Aging Report	 146
Billing Statement	 48

Total Amount of Account Bal
Collections Manager List	 70
Payment Agreement Report	 234
Aging/Credit Balance Report	 6

Total Amount of Account Balances Aged 1 - 30 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 1 - 30 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262

Index by Report Item
(Arranged in Categories)
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Total Amount of Account Balances Aged 181+ with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 181+ with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 181+ with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 31 - 60 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 31 - 60 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 31 - 60 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 61 - 90 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 61 - 90 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 61 - 90 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 91 - 120 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 91 - 120 with 
Primary Claims

Insurance Claim Aging Report	 146

Total Amount of Account Balances Aged 1 - 30 for Sec-
ondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 1 - 30 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 1 - 30 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 1 - 30 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 121 - 150 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 121 - 150 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 121 - 150 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 151 - 180 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 151 - 180 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 151 - 180 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 181+ for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 181+ for Pri-
mary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Pre-Treatment Estimate Aging Report	 262

Total Amount of Account Balances Aged 181+ for Sec-
ondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262

Account (continued)
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Total Amount of Account Balances Aged 91 - 120 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Pre-treatment 
Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances with Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Primary Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances with Secondary 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Secondary Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Account Holder

Account Holder Name
Deposit Slip	 108

Accounts Receivable
Current Receivables

Practice Analysis Report	 252
Percent of Receivables

Practice Analysis Report	 252
Receivables Aged 31 - 60

Practice Analysis Report	 252
Receivables Aged 61 - 90

Practice Analysis Report	 252
Receivables Aged Over 90

Practice Analysis Report	 252
Total Receivables

Practice Analysis Report	 252
Active

Number of Active Patient Guarantors
Practice Statistics Report	 256

Number of Active Patients
Practice Statistics Report	 256
Practice Analysis Report	 252

Number of Insured Active Patients
Practice Analysis Report	 252

Percent of Active Patient Guarantors
Practice Statistics Report	 256

Percent of Active Patients
Practice Statistics Report	 256

Total Active New Patients
New Patient List	 190

ADA Code
ADA Code

Day Sheet (Charges and Receipts) Report	 94
Dental Encounters Report	 106
Fee Schedules Report	 128
Insurance Carrier Production - Full Report	 142
Multi-Code List	 188
Operator Day Sheet Report	 194
Patient Chart and Progress Notes Printout	 202
Patient List (Filtered)	 214
Patient Treatment Case Report	 228

Practice Treatment Case Report	 258
Procedure Code List	 266
Procedures by Contracted Amount Report	 268
Procedures Not Attached to Insurance Report	270
Production Summary Report	 272
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
RVU Day Sheet Report	 308
RVU Production Summary Report	 310
RVU Schedules Report	 314
RVU Utilization Report	 316
Standard Coverage Tables Report	 322
Treatment Case Report	 326
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Unscheduled Treatment Plans (Detailed) Report	
362
Updated Dental Insurance Payment Table Report	
364
Utilization Report	 366
Walkout - Doctor’s Statement	 368
Appointment Cycle Time Report	 16

ADA Code Abbreviated Description
Procedure Code List	 266
Multi-Code List	 188

ADA Code Description
Fee Schedules Report	 128
Insurance Carrier Production - Full Report	 142
Multi-Code List	 188
Patient Chart and Progress Notes Printout	 202
Patient Ledger Report	 210
Patient Treatment Case Report	 228
Practice Treatment Case Report	 258
Procedure Code List	 266
Procedures by Contracted Amount Report	 268
Procedures Not Attached to Insurance Report	270
Production Summary Report	 272
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
RVU Day Sheet Report	 308
RVU Production Summary Report	 310
RVU Schedules Report	 314
RVU Utilization Report	 316
Treatment Case Report	 326
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Unscheduled Treatment Plans (Detailed) Report	
362
Utilization Report	 366
Walkout - Doctor’s Statement	 368
Walkout - Family Walkout	 370
Day Sheet (Charges and Receipts) Report	 94

ADA Code Description for Today’s Completed Work
Patient Chart Printout	 204

Account (continued)
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ADA Code Description for Treatment-planned Proce-
dure

Patient Chart Printout	 204
ADA Code Description of Completed Treatment

Referral Recap Report	 296
ADA Code Description of Treatment Still in Progress

Referral Recap Report	 296
ADA Code Description of Treatment-planned Proce-
dure

Referral Slip	 298
ADA Code Description or Transaction Description

Operator Day Sheet Report	 194
ADA Code of Completed Treatment

Referral Recap Report	 296
ADA Code of Treatment Still in Progress

Referral Recap Report	 296
ADA Code of Treatment-planned Procedure

Referral Slip	 298
Alternate ADA Code

Procedure Code List	 266
Insurance Carrier List	 138

Beginning ADA Code
Insurance Coverage Tables Report	 150

Denominator Codes for Provider
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Next Appointment ADA Code
Patient Route Slip	 226

Next Appointment ADA Code Description
Patient Route Slip	 226

Numerator Codes for Provider
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Paint Type
Procedure Code List	 266
Dental Diagnostic Code List	 104

Procedure Code Category
Standard Coverage Tables Report	 322
Insurance Coverage Tables Report	 150

Replace Initial Zero of Procedure Code on Claims
Insurance Carrier List	 138

Time Units
Procedure Code List	 266
Multi-Code List	 188

Total Denominator Codes for All Clinics
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Total Denominator Codes for Clinic
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Total Numerator Codes for All Clinics
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Total Numerator Codes for Clinic
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Address
Address of Patient on Appointment

Letter Merge Reports	 158
Change of Address

Coupon Book - Payment Agreements	 79
Coupon Book - Future Due Payments	 78

Employer Address
Letter Merge Reports	 158
Employers and Employed Patients Report	 122

Employer Address (for Guarantor)
Patient Questionnaire	 222

Employer Address (for Patient)
Patient Questionnaire	 222

Guarantor Address
Family Ledger Report	 124
Family Ledger Report (Single Family)	 126
Patient Route Slip	 226
Truth in Lending Disclosure Statement	 332
Walkout - Family Walkout	 370
Billing Statement	 48

Guarantor City
Collections Manager List	 70

Guarantor State
Collections Manager List	 70

Guarantor Zip Code
Collections Manager List	 70

Insurance Carrier Address
Insurance Coverage Tables Report	 150
Provider IDs List	 284
Updated Dental Insurance Payment Table Report	
364
Insurance Carrier List	 138

Insurance Carrier City and State
Insurance Eligibility Report	 152

Insurance Carrier Street Address
Insurance Eligibility Report	 152

Insurance Plan Name and Address for Primary Insurance
Patient Questionnaire	 222

Insurance Plan Name and Address for Secondary Insur-
ance

Patient Questionnaire	 222
Patient Address

Birthday List	 50
Continuing Care Cards - No Appointment	 74
Continuing Care Cards - with Appointment	 75
Coupon Book - Future Due Payments	 78
Coupon Book - Payment Agreements	 79
New Patient List	 190
Patient Ledger Report	 210
Patient List	 212
Patient Questionnaire	 222
Patient Route Slip	 226
Patient’s Ledger Report	 230
Prescription Printout	 260
Referral Recap Report	 296
Referral Slip	 298
Walkout - Doctor’s Statement	 368
Appointment Reminder Cards	 18

ADA Code (continued)
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Patient City
Patient List (Filtered)	 214
Letter Merge Reports	 158

Patient State
Patient List (Filtered)	 214
Letter Merge Reports	 158

Patient Street Address
Patient List (Filtered)	 214
Letter Merge Reports	 158

Practice Address
Billing Statement	 48
Continuing Care Cards - No Appointment	 74
Continuing Care Cards - with Appointment	 75
Coupon Book - Future Due Payments	 78
Coupon Book - Payment Agreements	 79
Patient Chart and Progress Notes Printout	 202
Patient Chart Printout	 204
Patient Treatment Case Report	 228
Perio - Combined Graphic & Data Chart Report	
238
Perio - Exam Comparison Report	 242
Perio - Graphic Chart Report	 244
Practice Organization List	 254
Prescription Printout	 260
Provider IDs List	 284
Referral Recap Report	 296
Referral Slip	 298
Truth in Lending Disclosure Statement	 332
Walkout - Family Walkout	 370
Appointment Reminder Cards	 18

Practice City
Registration Information Report	 306

Practice City State and ZIP Code
Letter Merge Reports	 158

Practice Country
Registration Information Report	 306

Practice State
Registration Information Report	 306

Practice Street Address
Registration Information Report	 306
Letter Merge Reports	 158

Practice ZIP Code
Registration Information Report	 306

Provider Address
Walkout - Doctor’s Statement	 368

Referral Address
Referral Slip	 298
Referral Recap Report	 296

Referred by Doctor/Other Address
Referred By Doctor/Other Report	 300

Referred by Source Address
Letter Merge Reports	 158

Referred to Address
Letter Merge Reports	 158

Referred to Doctor Address
Referred To Doctor Report	 304

Referring Patient Address
Referred By Patient Report	 302

Spouse Address
Patient Questionnaire	 222

Subscriber Address for Primary Insurance
Patient Questionnaire	 222

Subscriber Address for Secondary Insurance
Patient Questionnaire	 222

Subscriber’s Employer Address for Primary Insurance
Patient Questionnaire	 222

Subscriber’s Employer Address for Secondary Insurance
Patient Questionnaire	 222

Adjustment
Adjustment Date

Patient’s Ledger Report	 230
Adjustment Description

Patient’s Ledger Report	 230
Adjustment Type

Daily Summary Report	 88
Day Sheet (Adjustments) Report	 90
Adjustment Summary Report	 4

Adjustment Types
Custom Practice Information Report	 82

Amount of - Adjustments (Collection)
Provider A/R Totals - Daily Report	 276

Amount of - Adjustments (Collection) for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of - Adjustments (Production)
Provider A/R Totals - Daily Report	 276

Amount of - Adjustments (Production) for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of + Adjustments (Collection)
Provider A/R Totals - Daily Report	 276

Amount of + Adjustments (Collection) for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of + Adjustments (Production)
Provider A/R Totals - Daily Report	 276

Amount of + Adjustments (Production) for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of Adjustment Type
Adjustment Summary Report	 4

Amount of Adjustments
Procedures by Contracted Amount Report	 268

Amount of Allowances for Patient
UDS - Patient Related Revenue Report	 348

Amount of Applied Credit Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Applied Credit Adjustments for Previous 
Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Applied Credit Adjustments for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Bad Debt Write-offs for Patient
UDS - Patient Related Revenue Report	 348

Amount of Charge Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8
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Amount of Charge Adjustments for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Amount of Charge Adjustments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Credit Special Adjustments
Provider A/R Totals - Daily Report	 276

Amount of Credit Special Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Credit Special Adjustments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Current Applied Credit Adjustments for Prov
Day Sheet (Charges and Receipts) Report	 94

Amount of Current Applied Payments for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of Current Charge Adjustments for Provider
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Amount of Current Suspended Credit Adjustments for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Debit Adjustments (Average)

Practice Analysis Report	 252
Amount of Debit Adjustments (for Date Range)

Practice Analysis Report	 252
Amount of Debit Adjustments (MTD)

Practice Analysis Report	 252
Amount of Debit Adjustments (YTD)

Practice Analysis Report	 252
Amount of Debit Special Adjustments

Provider A/R Totals - Daily Report	 276
Amount of Debit Special Adjustments for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Debit Special Adjustments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of MTD Applied Credit Adjustments for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Charge Adjustments for Provider

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Amount of MTD Suspended Credit Adjustments for 
Provider

Day Sheet (Charges and Receipts) Report	 94

Amount of Other Applied Credit Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Credit Adjustments for 
Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Credit Special Adjustments 
for Clinic

Day Sheet Report	 100
Amount of Other Applied Credit Special Adjustments 
for Provider

Day Sheet Report	 100
Amount of Other Credit Special Adjustments for Clinic

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Other Credit Special Adjustments for Pro-
vider

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Other Debit Adjustments (Average)
Practice Analysis Report	 252

Amount of Other Debit Adjustments (for Date Range)
Practice Analysis Report	 252

Amount of Other Debit Adjustments (MTD)
Practice Analysis Report	 252

Amount of Other Debit Adjustments (YTD)
Practice Analysis Report	 252

Amount of Sliding Discounts for Patient
UDS - Patient Related Revenue Report	 348

Amount of Suspended Credit Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Credit Adjustments for Previous 
Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Suspended Credit Adjustments for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of YTD Applied Credit Adjustments for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of YTD Charge Adjustments for Provider

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Suspended Credit Adjustments for Prov
Day Sheet (Charges and Receipts) Report	 94

Applied Credit Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Average Amount of Adjustment Type
Adjustment Summary Report	 4

Average Amount of Adjustments
Day Sheet (Adjustments) Report	 90

Average Amount of Adjustments for Clinic
Day Sheet (Adjustments) Report	 90

Average Amount of Adjustments for Provider
Day Sheet (Adjustments) Report	 90

Adjustment (continued)
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Average Amount of Credit Adjustments
Day Sheet (Adjustments) Report	 90

Average Amount of Debit Adjustments
Day Sheet (Adjustments) Report	 90

Charge Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Collection Adjustments
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Credit Adjustment Amount
Insurance Carrier Production - Full Report	 142
Billing Statement	 48

Credit Adjustment Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Credit Special Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Debit Adjustment Amount
Insurance Carrier Production - Full Report	 142

Debit Adjustment Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Debit Special Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Grand Total Amount of Charge Adjustments
Insurance Transaction Analysis Report	 154

Grand Total Amount of Credit Adjustments
Insurance Transaction Analysis Report	 154

Grand Total Number of Charge Adjustments
Insurance Transaction Analysis Report	 154

Grand Total Number of Credit Adjustments
Insurance Transaction Analysis Report	 154

Other Applied Credit Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Other Credit Special Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Percent of Adjustment Type in Adjustment Type Cat-
egory

Adjustment Summary Report	 4
Production Adjustments

Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Quantity of Adjustment Type
Adjustment Summary Report	 4

Quantity of Adjustments for Clinic
Day Sheet (Adjustments) Report	 90

Quantity of Adjustments for Provider
Day Sheet (Adjustments) Report	 90

Revenue for Provider from Credit Adjustments
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Subtotal of Allowances for Financial Class Type
UDS - Patient Related Revenue Report	 348

Subtotal of Allowances for Payer Category
UDS - Patient Related Revenue Report	 348

Subtotal of Bad Debt Write-offs for Financial Class Type
UDS - Patient Related Revenue Report	 348

Subtotal of Bad Debt Write-offs for Payer Category
UDS - Patient Related Revenue Report	 348

Subtotal of Sliding Discounts for Financial Class Type
UDS - Patient Related Revenue Report	 348

Subtotal of Sliding Discounts for Payer Category
UDS - Patient Related Revenue Report	 348

Suspended Credit Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Adjustments
Patient Revenue List by Payer Report	 224

Total Amount of - Adjustments (Collection)
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Amount of - Adjustments (Production)
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Amount of + Adjustments (Collection)
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Amount of + Adjustments (Production)
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Amount of Adjustment Type
Daily Summary Report	 88

Total Amount of Adjustment Types
Adjustment Summary Report	 4

Total Amount of Adjustments
Day Sheet (Adjustments) Report	 90
Daily Summary Report	 88

Total Amount of Adjustments for Clinic
Day Sheet (Adjustments) Report	 90

Total Amount of Adjustments for Provider
Day Sheet (Adjustments) Report	 90

Total Amount of Allowances for Financial Class Type
UDS - Patient Related Revenue Report	 348

Total Amount of Allowances for Patient
UDS - Patient Related Revenue Report	 348

Total Amount of Allowances for Payer Category
UDS - Patient Related Revenue Report	 348

Total Amount of Applied Credit Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Applied Credit Adjustments for Previ-
ous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Bad Debt Write-offs for Financial Class 
Type

UDS - Patient Related Revenue Report	 348
Total Amount of Bad Debt Write-offs for Patient

UDS - Patient Related Revenue Report	 348
Total Amount of Bad Debt Write-offs for Payer Category

UDS - Patient Related Revenue Report	 348
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Total Amount of Charge Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Insurance Transaction Analysis Report	 154
Operator Day Sheet Report	 194
Analysis Summary Report - Daily	 8

Total Amount of Charge Adjustments for Previous 
Month

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Credit Adjustments
Day Sheet (Adjustments) Report	 90
Insurance Carrier Production - Full Report	 142
Insurance Carrier Production - Summary Report	
144
Insurance Transaction Analysis Report	 154
Operator Day Sheet Report	 194
Adjustment Summary Report	 4

Total Amount of Credit Special Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Total Amount of Current Applied Credit Adjustments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Charge Adjustments
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Suspended Credit Adjust-
ments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Debit Adjustments

Day Sheet (Adjustments) Report	 90
Insurance Carrier Production - Full Report	 142
Insurance Carrier Production - Summary Report	
144
Adjustment Summary Report	 4

Total Amount of Debit Special Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Total Amount of MTD Applied Credit Adjustments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Charge Adjustments
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Suspended Credit Adjustments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Other Applied Credit Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Other Applied Credit Special Adjust-
ments

Day Sheet Report	 100

Total Amount of Other Credit Special Adjustments
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Amount of Sliding Discounts for Financial Class 
Type

UDS - Patient Related Revenue Report	 348
Total Amount of Sliding Discounts for Patient

UDS - Patient Related Revenue Report	 348
Total Amount of Sliding Discounts for Payer Category

UDS - Patient Related Revenue Report	 348
Total Amount of YTD Applied Credit Adjustments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of YTD Charge Adjustments

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Suspended Credit Adjustments
Day Sheet (Charges and Receipts) Report	 94

Total Number of Charge Adjustments
Insurance Transaction Analysis Report	 154

Total Number of Credit Adjustments
Insurance Transaction Analysis Report	 154

Total Quantity of Adjustments
Day Sheet (Adjustments) Report	 90

Total Quantity of Credit Adjustments
Day Sheet (Adjustments) Report	 90

Total Quantity of Debit Adjustments
Day Sheet (Adjustments) Report	 90

Total Revenue from Credit Adjustments
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Adjustment Type
Adjustment Type

Daily Summary Report	 88
Day Sheet (Adjustments) Report	 90
Adjustment Summary Report	 4

Adjustment Types
Custom Practice Information Report	 82

Amount of Adjustment Type
Adjustment Summary Report	 4

Average Amount of Adjustment Type
Adjustment Summary Report	 4

Quantity of Adjustment Type
Adjustment Summary Report	 4

Total Amount of Adjustment Type
Daily Summary Report	 88

Total Amount of Adjustment Types
Adjustment Summary Report	 4

Adjustment Type Category
Percent of Adjustment Type in Adjustment Type Cat-
egory

Adjustment Summary Report	 4
Age

20+ Years Old for Financial Class Type
UDS - Insurance Financial Class Report	 342

20+ Years Old for Financial Class Type for Clinic
UDS - Insurance Financial Class Report	 342

20+ Years Old for Financial Class Type for Provider
UDS - Insurance Financial Class Report	 342

20+ Years Old for Financial Class Types
UDS - Insurance Financial Class Report	 342
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414   Index by Report Item

Dentrix Enterprise 11.0.2 Reports Reference

Age
UDS - Age/Gender Report	 334
Patient Health Assessment Report	 206

Ages 15 - 19 Years
Caries Prevalence and Periodontal Index Report	
52

Ages 2 - 5 Years
Caries Prevalence and Periodontal Index Report	
52

Ages 35 - 44 Years
Caries Prevalence and Periodontal Index Report	
52

Ages 55+ Years
Caries Prevalence and Periodontal Index Report	
52

Ages 6 - 14 Years
Caries Prevalence and Periodontal Index Report	
52

Guarantor Birth Date & Age
Collections Manager List	 70

Number <19 Years Old for Financial Class Type
UDS - Insurance Financial Class Report	 342

Number <19 Years Old for Financial Class Type for 
Clinic

UDS - Insurance Financial Class Report	 342
Number <19 Years Old for Financial Class Type for 
Provider

UDS - Insurance Financial Class Report	 342
Number 0 - 17 Years Old for Financial Class Type

UDS - Insurance Financial Class Report (2013)	344
Number 18+ for Financial Class Type

UDS - Insurance Financial Class Report (2013)	344
Number of Medicaid and Medicare Patients in First Age 
Group

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in First Age 
Group at Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in First Age 
Group for Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in First Age 
Group in ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in First Age 
Group with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group at Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group for Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group in ZIP Code

UDS - Medicaid/Medicare Report	 346

Number of Medicaid and Medicare Patients in Second 
Age Group with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in First Age Group

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in First Age Group at 
Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in First Age Group for 
Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in First Age Group in ZIP 
Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in First Age Group with 
Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in Second Age Group

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in Second Age Group at 
Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in Second Age Group for 
Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in Second Age Group in 
ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in Second Age Group 
with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in First Age Group

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in First Age Group at 
Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in First Age Group for 
Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in First Age Group in ZIP 
Code

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in First Age Group with 
Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in Second Age Group

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in Second Age Group at 
Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in Second Age Group for 
Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in Second Age Group in 
ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in Second Age Group 
with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Patients <6 or 65+ Years

Meaningful Use Measure Calculation List	 162
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Number of Patients <6 or 65+ Years who Received Ap-
pointment Reminders

Meaningful Use Measure Calculation List	 162
Number of Patients 0 - 19 Years

Clinical Quality Measures List	 66
Number of Patients 0 - 19 Years with Fluoride Varnish

Clinical Quality Measures List	 66
Number of Patients 0 - 19 Years with Tooth Decay or 
Cavities

Clinical Quality Measures List	 66
Number of Patients 0 - 2 Years

Practice Statistics Report	 256
Number of Patients 0 - 2 Years Seen

Meaningful Use Measure Calculation List	 162
Number of Patients 0 - 2 Years with Vital Sign Readings

Meaningful Use Measure Calculation List	 162
Meaningful Use Measure Calculation List	 162

Number of Patients 11 - 12 Years
Practice Statistics Report	 256

Number of Patients 13 - 14 Years
Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 13 - 14 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 13 - 14 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 13 - 14 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 13 - 14 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 13 - 14 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 13 - 14 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 13 - 14 Years without OHS
Oral Health Status Report	 200

Number of Patients 13+ Years Seen
Meaningful Use Measure Calculation List	 162
Meaningful Use Measure Calculation List	 162

Number of Patients 13+ Years with Smoking Status
Meaningful Use Measure Calculation List	 162
Meaningful Use Measure Calculation List	 162

Number of Patients 15 - 16 Years
Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 15 - 16 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 15 - 16 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 15 - 16 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 15 - 16 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 15 - 16 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 15 - 16 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 15 - 16 Years without OHS
Oral Health Status Report	 200

Number of Patients 17 - 20 Years
Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 17 - 20 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 17 - 20 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 17 - 20 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 17 - 20 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 17 - 20 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 17 - 20 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 17 - 20 Years without OHS
Oral Health Status Report	 200

Number of Patients 18 - 64 Years
Clinical Quality Measures List	 66

Number of Patients 18 - 64 Years  with Abnormal BMI 
Reading and Follow Up

Clinical Quality Measures List	 66
Number of Patients 18 - 64 Years with Medical Encoun-
ters (with Exclusions)

Clinical Quality Measures List	 66
Number of Patients 18 - 85 Years

Clinical Quality Measures List	 66
Number of Patients 18 - 85 Years with Abnormal Blood 
Pressure Reading

Clinical Quality Measures List	 66
Number of Patients 18 - 85 Years with Hypertension

Clinical Quality Measures List	 66
Number of Patients 18 - 85 Years with Outpatient Visits 
(with Exclusions)

Clinical Quality Measures List	 66
Number of Patients 18+ Years

Clinical Quality Measures List	 66
Number of Patients 18+ Years who Use Tobacco and 
Received Cessation Counseling

Clinical Quality Measures List	 66
Number of Patients 18+ Years with Current Medications

Clinical Quality Measures List	 66
Number of Patients 18+ Years with Medical Encounters 
or Patient Health Assessments

Clinical Quality Measures List	 66
Number of Patients 18+ Years with Visits

UDS - Tobacco Use and Intervention Report	 354
Clinical Quality Measures List	 66

Number of Patients 2+ Years Seen
Meaningful Use Measure Calculation List	 162

Number of Patients 2+ Years with Vital Sign Readings
Meaningful Use Measure Calculation List	 162

Number of Patients 21 - 30 Years
Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 21 - 30 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 21 - 30 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 21 - 30 Years with OHS 3
Oral Health Status Report	 200
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Number of Patients 21 - 30 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 21 - 30 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 21 - 30 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 21 - 30 Years without OHS
Oral Health Status Report	 200

Number of Patients 3 - 17 Years
Clinical Quality Measures List	 66

Number of Patients 3 - 17 Years who Received Nutrition 
Counseling

Clinical Quality Measures List	 66
Number of Patients 3 - 17 Years who Received Physical 
Activity Counseling

Clinical Quality Measures List	 66
Number of Patients 3 - 17 Years with BMI Percentile 
Reading

Clinical Quality Measures List	 66
Number of Patients 3 - 17 Years with Medical Encoun-
ters (with Exclusions)

Clinical Quality Measures List	 66
Number of Patients 3 - 17 Years with Outpatient Visits 
(with Exclusions)

Clinical Quality Measures List	 66
Number of Patients 3 - 4 Years

Practice Statistics Report	 256
Number of Patients 3+ Years  with Vital Sign Readings

Meaningful Use Measure Calculation List	 162
Number of Patients 3+ Years Seen

Meaningful Use Measure Calculation List	 162
Number of Patients 3+ Years with Vital Sign Readings

Meaningful Use Measure Calculation List	 162
Number of Patients 31 - 40 Years

Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 31 - 40 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 31 - 40 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 31 - 40 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 31 - 40 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 31 - 40 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 31 - 40 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 31 - 40 Years without OHS
Oral Health Status Report	 200

Number of Patients 41 - 50 Years
Practice Statistics Report	 256

Number of Patients 41-50 Years
Oral Health Status Report	 200

Number of Patients 41-50 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 41-50 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 41-50 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 41-50 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 41-50 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 41-50 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 41-50 Years without OHS
Oral Health Status Report	 200

Number of Patients 5 - 6 Years
Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 5 - 6 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 5 - 6 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 5 - 6 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 5 - 6 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 5 - 6 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 5 - 6 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 5 - 6 Years without OHS
Oral Health Status Report	 200

Number of Patients 51 - 60 Years
Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 51 - 60 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 51 - 60 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 51 - 60 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 51 - 60 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 51 - 60 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 51 - 60 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 51 - 60 Years without OHS
Oral Health Status Report	 200

Number of Patients 6+ Months
Clinical Quality Measures List	 66

Number of Patients 6+ Months who Received Influenza 
Vaccinations

Clinical Quality Measures List	 66
Number of Patients 61 - 70 Years

Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 61 - 70 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 61 - 70 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 61 - 70 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 61 - 70 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 61 - 70 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 61 - 70 Years with OHS 6
Oral Health Status Report	 200

Age (continued)



Index by Report Item   417

Dentrix Enterprise 11.0.2 Reports Reference

Number of Patients 61 - 70 Years without OHS
Oral Health Status Report	 200

Number of Patients 65+ Years
Clinical Quality Measures List	 66

Number of Patients 65+ Years with Abnormal BMI 
Reading and Follow Up

Clinical Quality Measures List	 66
Number of Patients 65+ Years with Medical Encounters 
(with Exclusions)

Clinical Quality Measures List	 66
Number of Patients 66+ Years

Clinical Quality Measures List	 66
Number of Patients 66+ Years Seen

Clinical Quality Measures List	 66
Number of Patients 66+ Years with 1+ High-risk Medica-
tions

Clinical Quality Measures List	 66
Number of Patients 66+ Years with 2+ High-risk Medica-
tions

Clinical Quality Measures List	 66
Number of Patients 7 - 8 Years

Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 7 - 8 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 7 - 8 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 7 - 8 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 7 - 8 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 7 - 8 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 7 - 8 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 7 - 8 Years without OHS
Oral Health Status Report	 200

Number of Patients 71 - 80 Years
Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 71 - 80 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 71 - 80 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 71 - 80 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 71 - 80 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 71 - 80 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 71 - 80 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 71 - 80 Years without OHS
Oral Health Status Report	 200

Number of Patients 81+ Years
Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 81+ Years with OHS 1
Oral Health Status Report	 200

Number of Patients 81+ Years with OHS 2
Oral Health Status Report	 200

Number of Patients 81+ Years with OHS 3
Oral Health Status Report	 200

Number of Patients 81+ Years with OHS 4
Oral Health Status Report	 200

Number of Patients 81+ Years with OHS 5
Oral Health Status Report	 200

Number of Patients 81+ Years with OHS 6
Oral Health Status Report	 200

Number of Patients 81+ Years without OHS
Oral Health Status Report	 200

Number of Patients 9 - 10 Years
Practice Statistics Report	 256

Number of Patients without Birth Date
Oral Health Status Report	 200

Number of Patients without Birth Date and with OHS 1
Oral Health Status Report	 200

Number of Patients without Birth Date and with OHS 2
Oral Health Status Report	 200

Number of Patients without Birth Date and with OHS 3
Oral Health Status Report	 200

Number of Patients without Birth Date and with OHS 4
Oral Health Status Report	 200

Number of Patients without Birth Date and with OHS 5
Oral Health Status Report	 200

Number of Patients without Birth Date and with OHS 6
Oral Health Status Report	 200

Number of Patients without Birth Date and without 
OHS

Oral Health Status Report	 200
Number of Tobacco Non-users 18+ Years with Tobacco 
Use Assessment

UDS - Tobacco Use and Intervention Report	 354
Number of Tobacco Users 18+ Years with Tobacco Use 
Assessment and Tobacco Cessation Counseling or 
Tobacco Cessation Pharmacotherapy

UDS - Tobacco Use and Intervention Report	 354
Patient Age

Patient List (Filtered)	 214
Patient Route Slip	 226
Walkout - Doctor’s Statement	 368
Continuing Care Display List	 76

Percent of Patients 0 - 2 Years
Practice Statistics Report	 256

Percent of Patients 11 - 12 Years
Practice Statistics Report	 256

Percent of Patients 13 - 14 Years
Practice Statistics Report	 256

Percent of Patients 15 - 16 Years
Practice Statistics Report	 256

Percent of Patients 17 - 20 Years
Practice Statistics Report	 256

Percent of Patients 21 - 30 Years
Practice Statistics Report	 256

Percent of Patients 3 - 4 Years
Practice Statistics Report	 256

Percent of Patients 31 - 40 Years
Practice Statistics Report	 256

Percent of Patients 41 - 50 Years
Practice Statistics Report	 256
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Percent of Patients 5 - 6 Years
Practice Statistics Report	 256

Percent of Patients 51 - 60 Years
Practice Statistics Report	 256

Percent of Patients 61 - 70 Years
Practice Statistics Report	 256

Percent of Patients 7 - 8 Years
Practice Statistics Report	 256

Percent of Patients 71 - 80 Years
Practice Statistics Report	 256

Percent of Patients 81+ Years
Practice Statistics Report	 256

Percent of Patients 9 - 10 Years
Practice Statistics Report	 256

Total Number <19 Years Old for Financial Class Types
UDS - Insurance Financial Class Report	 342

Aging
Account Amount Aged >90

Patient Route Slip	 226
Account Amount Aged 0 - 30

Patient Route Slip	 226
Account Amount Aged 181+

Pre-Treatment Estimate Aging Report	 262
Account Amount Aged 31 - 60

Patient Route Slip	 226
Account Amount Aged 61 - 90

Patient Route Slip	 226
Account Balance Amount Aged 121 - 150

Pre-Treatment Estimate Aging Report	 262
Account Balance Amount Aged 151 - 180

Pre-Treatment Estimate Aging Report	 262
Account Balance Amount Aged 31 - 60

Pre-Treatment Estimate Aging Report	 262
Account Balance Amount Aged 61 - 90

Pre-Treatment Estimate Aging Report	 262
Account Balance Amount Aged 91 - 120

Pre-Treatment Estimate Aging Report	 262
Aged Amount 0 - 30

Aging/Credit Balance Report	 6
Aged Amount 0 - 30 for Clinic

Aging/Credit Balance Report	 6
Aged Amount 0 - 30 for Provider

Aging/Credit Balance Report	 6
Aged Amount 121 - 150

Aging/Credit Balance Report	 6
Aged Amount 121 - 150 for Clinic

Aging/Credit Balance Report	 6
Aged Amount 121 - 150 for Provider

Aging/Credit Balance Report	 6
Aged Amount 151 - 180

Aging/Credit Balance Report	 6
Aged Amount 151 - 180 for Clinic

Aging/Credit Balance Report	 6
Aged Amount 151 - 180 for Provider

Aging/Credit Balance Report	 6
Aged Amount 31 - 60

Aging/Credit Balance Report	 6
Aged Amount 31 - 60 for Clinic

Aging/Credit Balance Report	 6

Aged Amount 31 - 60 for Provider
Aging/Credit Balance Report	 6

Aged Amount 61 - 90
Aging/Credit Balance Report	 6

Aged Amount 61 - 90 for Clinic
Aging/Credit Balance Report	 6

Aged Amount 61 - 90 for Provider
Aging/Credit Balance Report	 6

Aged Amount 90 - 120
Aging/Credit Balance Report	 6

Aged Amount 90 - 120 for Clinic
Aging/Credit Balance Report	 6

Aged Amount 90 - 120 for Provider
Aging/Credit Balance Report	 6

Aged Amount Over 180
Aging/Credit Balance Report	 6

Aged Amount Over 180 for Clinic
Aging/Credit Balance Report	 6

Aged Amount Over 180 for Provider
Aging/Credit Balance Report	 6

Aging 0 - 30
Letter Merge Reports	 158

Aging 31 - 60
Letter Merge Reports	 158

Aging 61 - 90
Letter Merge Reports	 158

Aging 91+
Letter Merge Reports	 158

Amount Aged >90
Continuing Care Display List	 76

Amount Aged 0 - 30
Continuing Care Display List	 76
Collections Manager List	 70

Amount Aged 31 - 60
Continuing Care Display List	 76
Collections Manager List	 70

Amount Aged 61 - 90
Continuing Care Display List	 76
Collections Manager List	 70

Amount Aged 91+
Collections Manager List	 70

Amount Aged Over 30 Days
Billing Statement	 48

Amount Aged Over 60 Days
Billing Statement	 48

Amount Aged Over 90 Days
Billing Statement	 48

Amount of Account Balance Aged >90
Insurance Claim Aging Report	 146

Amount of Account Balance Aged 1 - 30
Insurance Claim Aging Report	 146

Amount of Account Balance Aged 31 - 60
Insurance Claim Aging Report	 146

Amount of Account Balance Aged 61 - 90
Insurance Claim Aging Report	 146

Patient Amount Aged >90
Patient Route Slip	 226

Patient Amount Aged 0 - 30
Patient Route Slip	 226

Patient Amount Aged 31 - 60
Patient Route Slip	 226
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Patient Amount Aged 61 - 90
Patient Route Slip	 226

Percent of Amount Aged 0 - 30
Aging/Credit Balance Report	 6

Percent of Amount Aged 121 - 150
Aging/Credit Balance Report	 6

Percent of Amount Aged 151 - 180
Aging/Credit Balance Report	 6

Percent of Amount Aged 31 - 60
Aging/Credit Balance Report	 6

Percent of Amount Aged 61 - 90
Aging/Credit Balance Report	 6

Percent of Amount Aged 90 - 120
Aging/Credit Balance Report	 6

Percent of Amount Aged Over 180
Aging/Credit Balance Report	 6

Receivables Aged 31 - 60
Practice Analysis Report	 252

Receivables Aged 61 - 90
Practice Analysis Report	 252

Receivables Aged Over 90
Practice Analysis Report	 252

Total Amount Aged 0 - 30
Collections Manager List	 70
Aging/Credit Balance Report	 6

Total Amount Aged 121 - 150
Aging/Credit Balance Report	 6

Total Amount Aged 151 - 180
Aging/Credit Balance Report	 6

Total Amount Aged 31 - 60
Collections Manager List	 70
Aging/Credit Balance Report	 6

Total Amount Aged 61 - 90
Collections Manager List	 70
Aging/Credit Balance Report	 6

Total Amount Aged 90 - 120
Aging/Credit Balance Report	 6

Total Amount Aged 91+
Collections Manager List	 70

Total Amount Aged Over 180
Aging/Credit Balance Report	 6

Total Amount of Account Balances Aged 1 - 30 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 1 - 30 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 1 - 30 for Sec-
ondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 1 - 30 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 1 - 30 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 1 - 30 with 
Secondary Claims

Insurance Claim Aging Report	 146

Total Amount of Account Balances Aged 121 - 150 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 121 - 150 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 121 - 150 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 151 - 180 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 151 - 180 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 151 - 180 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 181+ for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 181+ for Pri-
mary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Pre-Treatment Estimate Aging Report	 262

Total Amount of Account Balances Aged 181+ for Sec-
ondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 181+ with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 181+ with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 181+ with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 31 - 60 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
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Total Amount of Account Balances Aged 31 - 60 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 31 - 60 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 31 - 60 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 61 - 90 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 61 - 90 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 61 - 90 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 91 - 120 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 91 - 120 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 91 - 120 with 
Secondary Claims

Insurance Claim Aging Report	 146
Alert

Alerts
Appointment Book View Printout	 14

Family Alert Note
Patient Notes Report	 216

Medical Alert
Patient Route Slip	 226
Patient Notes Report	 216

Patient Alert Note
Patient Notes Report	 216

Allergy
Allergy Description

Patient List (Filtered)	 214
Allergy Discovery Date

Patient List (Filtered)	 214
Allocate

Allocate Date
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Allocations Report	 286

Allocated
Allocated Amount

Provider Revenue - Credits Report	 290
Provider Revenue - Allocations Report	 286

Allowance
Amount of Allowances for Patient

UDS - Patient Related Revenue Report	 348
Subtotal of Allowances for Financial Class Type

UDS - Patient Related Revenue Report	 348
Subtotal of Allowances for Payer Category

UDS - Patient Related Revenue Report	 348
Total Amount of Allowances for Financial Class Type

UDS - Patient Related Revenue Report	 348
Total Amount of Allowances for Patient

UDS - Patient Related Revenue Report	 348
Total Amount of Allowances for Payer Category

UDS - Patient Related Revenue Report	 348
Allowed Amount

Contracted Rate
Procedures by Contracted Amount Report	 268

Alternate ADA Code
Alternate ADA Code

Procedure Code List	 266
Insurance Carrier List	 138

Alternate Case
Alternate Case Name

Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Alternate Fee Schedule
Fee from Alternate Fee Schedule

Treatment Case Report	 326
Fee from Alternate Fee Schedule for Visit

Treatment Case Report	 326
Total Fee from Alternate Fee Schedule for Case

Treatment Case Report	 326
AMA Code

Medical Code
Procedure Code List	 266

AMA CPT
AMA CPT Code

Procedure Code List	 266
Medical Code List	 186

AMA CPT Code Description
Medical Code List	 186

Amount
Account Amount Aged >90

Patient Route Slip	 226
Account Amount Aged 0 - 30

Patient Route Slip	 226

Aging (continued)
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Account Amount Aged 181+
Pre-Treatment Estimate Aging Report	 262

Account Amount Aged 31 - 60
Patient Route Slip	 226

Account Amount Aged 61 - 90
Patient Route Slip	 226

Account Balance Amount Aged 121 - 150
Pre-Treatment Estimate Aging Report	 262

Account Balance Amount Aged 151 - 180
Pre-Treatment Estimate Aging Report	 262

Account Balance Amount Aged 31 - 60
Pre-Treatment Estimate Aging Report	 262

Account Balance Amount Aged 61 - 90
Pre-Treatment Estimate Aging Report	 262

Account Balance Amount Aged 91 - 120
Pre-Treatment Estimate Aging Report	 262

Account Estimated Insurance Portion
Patient Route Slip	 226

Account Suspended Credit Amount
Patient Route Slip	 226

Aged Amount 0 - 30
Aging/Credit Balance Report	 6

Aged Amount 0 - 30 for Clinic
Aging/Credit Balance Report	 6

Aged Amount 0 - 30 for Provider
Aging/Credit Balance Report	 6

Aged Amount 121 - 150
Aging/Credit Balance Report	 6

Aged Amount 121 - 150 for Clinic
Aging/Credit Balance Report	 6

Aged Amount 121 - 150 for Provider
Aging/Credit Balance Report	 6

Aged Amount 151 - 180
Aging/Credit Balance Report	 6

Aged Amount 151 - 180 for Clinic
Aging/Credit Balance Report	 6

Aged Amount 151 - 180 for Provider
Aging/Credit Balance Report	 6

Aged Amount 31 - 60
Aging/Credit Balance Report	 6

Aged Amount 31 - 60 for Clinic
Aging/Credit Balance Report	 6

Aged Amount 31 - 60 for Provider
Aging/Credit Balance Report	 6

Aged Amount 61 - 90
Aging/Credit Balance Report	 6

Aged Amount 61 - 90 for Clinic
Aging/Credit Balance Report	 6

Aged Amount 61 - 90 for Provider
Aging/Credit Balance Report	 6

Aged Amount 90 - 120
Aging/Credit Balance Report	 6

Aged Amount 90 - 120 for Clinic
Aging/Credit Balance Report	 6

Aged Amount 90 - 120 for Provider
Aging/Credit Balance Report	 6

Aged Amount Over 180
Aging/Credit Balance Report	 6

Aged Amount Over 180 for Clinic
Aging/Credit Balance Report	 6

Aged Amount Over 180 for Provider
Aging/Credit Balance Report	 6

Allocated Amount
Provider Revenue - Credits Report	 290
Provider Revenue - Allocations Report	 286

Amount
Patient Chart and Progress Notes Printout	 202
Day Sheet (Adjustments) Report	 90

Amount Aged >90
Continuing Care Display List	 76

Amount Aged 0 - 30
Continuing Care Display List	 76
Collections Manager List	 70

Amount Aged 31 - 60
Continuing Care Display List	 76
Collections Manager List	 70

Amount Aged 61 - 90
Continuing Care Display List	 76
Collections Manager List	 70

Amount Aged 91+
Collections Manager List	 70

Amount Aged Over 30 Days
Billing Statement	 48

Amount Aged Over 60 Days
Billing Statement	 48

Amount Aged Over 90 Days
Billing Statement	 48

Amount Billed to Insurance
Analysis Summary Report - Standard	 12
Collections Manager List	 70
Analysis Summary Report - Daily	 8

Amount Billed to Insurance for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount Billed to Insurance for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount Collected for Patient
UDS - Patient Related Revenue Report	 348

Amount Due for Payment Agreement
Collections Manager List	 70

Amount Enclosed
Coupon Book - Future Due Payments	 78
Coupon Book - Payment Agreements	 79
Billing Statement	 48

Amount Financed
Truth in Lending Disclosure Statement	 332

Amount for Today’s Completed Work
Patient Chart Printout	 204

Amount of - Adjustments (Collection)
Provider A/R Totals - Daily Report	 276

Amount of - Adjustments (Collection) for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of - Adjustments (Production)
Provider A/R Totals - Daily Report	 276

Amount of - Adjustments (Production) for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount (continued)
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Amount of + Adjustments (Collection)
Provider A/R Totals - Daily Report	 276

Amount of + Adjustments (Collection) for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of + Adjustments (Production)
Provider A/R Totals - Daily Report	 276

Amount of + Adjustments (Production) for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of Account Balance Aged >90
Insurance Claim Aging Report	 146

Amount of Account Balance Aged 1 - 30
Insurance Claim Aging Report	 146

Amount of Account Balance Aged 31 - 60
Insurance Claim Aging Report	 146

Amount of Account Balance Aged 61 - 90
Insurance Claim Aging Report	 146

Amount of Adjustment Type
Adjustment Summary Report	 4

Amount of Adjustments
Procedures by Contracted Amount Report	 268

Amount of Allowances for Patient
UDS - Patient Related Revenue Report	 348

Amount of Annual Primary Insurance Plan Benefits for 
Family

Treatment Case Report	 326
Amount of Annual Primary Insurance Plan Benefits for 
Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Annual Secondary Insurance Plan Benefits 
for Family

Treatment Case Report	 326
Amount of Annual Secondary Insurance Plan Benefits 
for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Applied Credit Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Applied Credit Adjustments for Previous 
Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Applied Credit Adjustments for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Applied Insurance Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Applied Insurance Payments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Applied Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100

Analysis Summary Report - Daily	 8
Amount of Applied Payments for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Applied Payments for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Bad Debt Write-offs for Patient
UDS - Patient Related Revenue Report	 348

Amount of Beginning Balances for Clinic
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Beginning Balances for Provider
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Charge Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Charge Adjustments for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Amount of Charge Adjustments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Charges
Future Due Payment Plan Report - Monthly Totals	
132
Procedures by Contracted Amount Report	 268
Provider A/R Totals - Daily Report	 276
Daily Summary Report	 88

Amount of Charges Billed to Insurance for Previous 
Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Charges for Clinic

Day Sheet Report	 100
Amount of Charges for Patient

UDS - Patient Related Revenue Report	 348
Amount of Charges for Previous Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Charges for Provider

Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Day Sheet Report	 100

Amount of Claim
Insurance Claims Not Sent Report	 148

Amount of Completed Procedures for Patient
Procedures Not Attached to Insurance Report	270

Amount of Co-pays for Insurance Carrier
Utilization Report	 366

Amount of Credit Initial Balances
Provider A/R Totals - Daily Report	 276

Amount of Credit Initial Balances for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Credit Initial Balances for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100

Amount (continued)
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Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Credit Special Adjustments
Provider A/R Totals - Daily Report	 276

Amount of Credit Special Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Credit Special Adjustments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Current Applied Credit Adjustments for Prov
Day Sheet (Charges and Receipts) Report	 94

Amount of Current Applied Payments for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of Current Charge Adjustments for Provider
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Amount of Current Charges
Walkout - Family Walkout	 370

Amount of Current Charges Billed to Insurance for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Current Charges Compared to Fee Schedule 
for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Current Credits

Walkout - Family Walkout	 370
Amount of Current Finance Charges for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Current Late Charges for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Current Suspended Credit Adjustments for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Current Suspended Payments for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Debit Adjustments (Average)

Practice Analysis Report	 252
Amount of Debit Adjustments (for Date Range)

Practice Analysis Report	 252
Amount of Debit Adjustments (MTD)

Practice Analysis Report	 252
Amount of Debit Adjustments (YTD)

Practice Analysis Report	 252
Amount of Debit Initial Balances (Production)

Provider A/R Totals - Daily Report	 276
Amount of Debit Initial Balances (Production) for Prov

Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of Debit Initial Balances for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Debit Initial Balances for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Debit Special Adjustments
Provider A/R Totals - Daily Report	 276

Amount of Debit Special Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Debit Special Adjustments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Dental Insurance Portion
Patient Chart Printout	 204

Amount of Ending Balances for Clinic
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Ending Balances for Provider
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Estimated Insurance Portion
Insurance Claim Aging Report	 146

Amount of Estimated Primary Insurance Benefits Re-
maining YTD for Family

Treatment Case Report	 326
Amount of Estimated Primary Insurance Benefits Re-
maining YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Estimated Secondary Insurance Benefits 
Remaining YTD for Family

Treatment Case Report	 326
Amount of Estimated Secondary Insurance Benefits 
Remaining YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Fees - Co-pays for Insurance Carrier
Utilization Report	 366

Amount of Fees - RVU for Insurance Carrier
RVU Utilization Report	 316

Amount of Fees for Insurance Carrier
Utilization Report	 366
RVU Utilization Report	 316

Amount of Finance Charges
Provider A/R Totals - Daily Report	 276

Amount of Finance Charges (Average)
Practice Analysis Report	 252

Amount of Finance Charges (for Date Range)
Practice Analysis Report	 252

Amount of Finance Charges (MTD)
Practice Analysis Report	 252

Amount of Finance Charges (YTD)
Practice Analysis Report	 252

Amount of Finance Charges for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Finance Charge Report	 130
Analysis Summary Report - Daily	 8

Amount (continued)
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Amount of Finance Charges for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Finance Charges for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Finance Charge Report	 130
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Finance Charges YTD
Walkout - Family Walkout	 370

Amount of Future Due Payment Agreements
Practice Analysis Report	 252

Amount of Guarantor Payments YTD
Walkout - Family Walkout	 370

Amount of Insurance Estimate
Billing Statement	 48

Amount of Insurance Estimates
Aging/Credit Balance Report	 6

Amount of Insurance Payments
Provider A/R Totals - Daily Report	 276

Amount of Insurance Payments for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of Insurance Payments YTD
Walkout - Family Walkout	 370

Amount of Insured Charges (Average)
Practice Analysis Report	 252

Amount of Insured Charges (for Date Range)
Practice Analysis Report	 252

Amount of Insured Charges (MTD)
Practice Analysis Report	 252

Amount of Insured Charges (YTD)
Practice Analysis Report	 252

Amount of Lab Expenses for Clinic
RVU Day Sheet Report	 308

Amount of Lab Expenses for Medicaid Procedures for 
Clinic

RVU Production Summary Report	 310
Amount of Lab Expenses for Medicaid Procedures for 
Provider

RVU Production Summary Report	 310
Amount of Lab Expenses for Provider

RVU Day Sheet Report	 308
Amount of Lab Expenses of Non-Medicaid Procedures 
for Clinic

RVU Production Summary Report	 310
Amount of Lab Expenses of Non-Medicaid Procedures 
for Provider

RVU Production Summary Report	 310
Amount of Lab Expenses of Procedures for Clinic

RVU Production Summary Report	 310
Amount of Lab Expenses of Procedures for Provider

RVU Production Summary Report	 310
Amount of Last Payment Amount

Letter Merge Reports	 158
Amount of Late Charges

Provider A/R Totals - Daily Report	 276

Amount of Late Charges (Average)
Practice Analysis Report	 252

Amount of Late Charges (for Date Range)
Practice Analysis Report	 252

Amount of Late Charges (MTD)
Practice Analysis Report	 252

Amount of Late Charges (YTD)
Practice Analysis Report	 252

Amount of Late Charges for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Late Charge Report	 156
Analysis Summary Report - Daily	 8

Amount of Late Charges for Previous Month for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of Late Charges for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Late Charge Report	 156
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Late Charges YTD
Walkout - Family Walkout	 370

Amount of Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Amount of Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Amount of MTD Applied Credit Adjustments for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Applied Payments for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Charge Adjustments for Provider

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Amount of MTD Charges Billed to Insurance for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Charges for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Finance Charges for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Late Charges for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Suspended Credit Adjustments for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Suspended Payments for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Net Change

Provider A/R Totals - Daily Report	 276
Amount of Net Change for Clinic

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Net Change for Provider
Analysis Summary Report - Standard	 12
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278

Amount (continued)



Index by Report Item   425

Dentrix Enterprise 11.0.2 Reports Reference

Analysis Summary Report - Daily	 8
Amount of Non-insured Charges (Average)

Practice Analysis Report	 252
Amount of Non-insured Charges (for Date Range)

Practice Analysis Report	 252
Amount of Non-insured Charges (MTD)

Practice Analysis Report	 252
Amount of Non-insured Charges (YTD)

Practice Analysis Report	 252
Amount of Non-Medicaid Procedures for Clinic

RVU Production Summary Report	 310
Production Summary Report	 272

Amount of Non-Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Amount of Office Portion
Patient Treatment Case Report	 228

Amount of Office Portion for Case
Patient Treatment Case Report	 228

Amount of Office Portion for Visit
Patient Treatment Case Report	 228

Amount of Other Applied Credit Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Credit Adjustments for 
Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Credit Initial Balances for 
Clinic

Day Sheet Report	 100
Amount of Other Applied Credit Initial Balances for 
Provider

Day Sheet Report	 100
Amount of Other Applied Credit Special Adjustments 
for Clinic

Day Sheet Report	 100
Amount of Other Applied Credit Special Adjustments 
for Provider

Day Sheet Report	 100
Amount of Other Applied Insurance Payments for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Insurance Payments for 
Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Payments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Credit Initial Balances for Clinic
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Other Credit Initial Balances for Provider
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Other Credit Special Adjustments for Clinic
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Other Credit Special Adjustments for Pro-
vider

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Other Debit Adjustments (Average)
Practice Analysis Report	 252

Amount of Other Debit Adjustments (for Date Range)
Practice Analysis Report	 252

Amount of Other Debit Adjustments (MTD)
Practice Analysis Report	 252

Amount of Other Debit Adjustments (YTD)
Practice Analysis Report	 252

Amount of Other Deductible Owed by Family to Pri-
mary Insurance

Patient Route Slip	 226
Amount of Other Deductible Owed by Family to Sec-
ondary Insurance

Patient Route Slip	 226
Amount of Other Deductible Owed to Primary Insur-
ance

Patient Route Slip	 226
Amount of Other Deductible Owed to Secondary Insur-
ance

Patient Route Slip	 226
Amount of Patient Portion

Patient Treatment Case Report	 228
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Chart Printout	 204

Amount of Patient Portion for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Amount of Patient Portion for Visit
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Payment Agreements
Practice Analysis Report	 252

Amount of Payment Type
Payment Summary Report	 236

Amount of Payments
Provider A/R Totals - Daily Report	 276

Amount of Payments for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of Pending Estimated Primary Insurance Por-
tions YTD for Family

Treatment Case Report	 326
Amount of Pending Estimated Primary Insurance Por-
tions YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount (continued)
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Amount of Pending Estimated Secondary Insurance 
Portions YTD for Family

Treatment Case Report	 326
Amount of Pending Estimated Secondary Insurance 
Portions YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Preventative Deductible Owed by Family to 
Primary Insurance

Patient Route Slip	 226
Amount of Preventative Deductible Owed by Family to 
Secondary Insurance

Patient Route Slip	 226
Amount of Preventative Deductible Owed to Primary 
Insurance

Patient Route Slip	 226
Amount of Preventative Deductible Owed to Secondary 
Insurance

Patient Route Slip	 226
Amount of Primary Insurance Benefits Remaining

Unscheduled Treatment Plans (Detailed) Report	
362
Patient Route Slip	 226

Amount of Primary Insurance Benefits Used
Patient Route Slip	 226

Amount of Primary Insurance Paid Benefits YTD for 
Family

Treatment Case Report	 326
Amount of Primary Insurance Paid Benefits YTD for 
Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Primary Insurance Portion
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Primary Insurance Portion for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Amount of Primary Insurance Portion for Visit
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Procedure
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Amount of Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Amount of Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Amount of Remaining Benefits for Primary Insurance
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Amount of Remaining Benefits for Secondary Insurance
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Amount of RVUs for Insurance Carrier
RVU Utilization Report	 316

Amount of Secondary Insurance Benefits Remaining
Unscheduled Treatment Plans (Detailed) Report	
362
Patient Route Slip	 226

Amount of Secondary Insurance Benefits Used
Patient Route Slip	 226

Amount of Secondary Insurance Portion
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Secondary Insurance Portion for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Amount of Secondary Insurance Portion for Visit
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Secondary Paid Benefits for Family
Treatment Case Report	 326

Amount of Secondary Paid Benefits for Patient
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Sliding Discounts for Patient
UDS - Patient Related Revenue Report	 348

Amount of Standard Deductible Owed by Family to 
Primary Insurance

Patient Route Slip	 226
Amount of Standard Deductible Owed by Family to 
Secondary Insurance

Patient Route Slip	 226
Amount of Standard Deductible Owed to Primary Insur-
ance

Patient Route Slip	 226
Amount of Standard Deductible Owed to Secondary 
Insurance

Patient Route Slip	 226
Amount of Suspended Credit Adjustments for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Credit Adjustments for Previous 
Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Suspended Credit Adjustments for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Credits
Aging/Credit Balance Report	 6

Amount of Suspended Credits for Guarantor
Suspended Credits Report	 324

Amount of Suspended Insurance Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Insurance Payments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100

Amount (continued)
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Analysis Summary Report - Daily	 8
Amount of Suspended Payments for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Suspended Payments for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Treatment-planned Procedure
Patient Chart Printout	 204

Amount of YTD Applied Credit Adjustments for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of YTD Applied Payments for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of YTD Charge Adjustments for Provider

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Charges Billed to Insurance for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Finance Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Late Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Suspended Credit Adjustments for Prov
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Suspended Payments for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount Paid
Coupon Book - Payment Agreements	 79
Coupon Book - Future Due Payments	 78

Amount Paid by Insurance
Dental Encounters Report	 106

Amount to Pay
Billing Statement	 48

Applied Credit Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Applied Insurance Payment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Applied Payment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Appointment Amount
Audit Report - Appointments	 26

Appointment Amount Change
Audit Report - Appointments	 26

Appointment Production Amount
Appointment Book View Printout	 14

Average Amount of Adjustment Type
Adjustment Summary Report	 4

Average Amount of Adjustments
Day Sheet (Adjustments) Report	 90

Average Amount of Adjustments for Clinic
Day Sheet (Adjustments) Report	 90

Average Amount of Adjustments for Provider
Day Sheet (Adjustments) Report	 90

Average Amount of Credit Adjustments
Day Sheet (Adjustments) Report	 90

Average Amount of Debit Adjustments
Day Sheet (Adjustments) Report	 90

Average Amount of Finance Charges
Day Sheet (Adjustments) Report	 90

Average Amount of Late Charges
Day Sheet (Adjustments) Report	 90

Average Amount of Medicaid Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Non-Medicaid Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Non-Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Non-Medicaid Procedures for 
Provider

RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Payment Type
Payment Summary Report	 236

Average Amount of Payments
Payment Summary Report	 236

Average Amount of Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Average Monthly Charge Amount
Future Due Payment Plan Report - Monthly Totals	
132

Average Payment Amount
Day Sheet (Receipts) Report	 98

Average Payment Amount for Clinic
Day Sheet (Receipts) Report	 98

Average Payment Amount for Initial Provider
Day Sheet (Receipts) Report	 98

Average Payment Amount for Payment Type
Day Sheet (Receipts) Report	 98

Average Payment Amount for Provider
Day Sheet (Receipts) Report	 98

Case Amount
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Charge Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Charge Amount
Analysis Summary Report - Standard	 12
Day Sheet (Charges and Receipts) Report	 94
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Day Sheet Report	 100
Family Ledger Report	 124
Family Ledger Report (Single Family)	 126
Insurance Transaction Analysis Report	 154
Operator Day Sheet Report	 194
Patient Ledger Report	 210
Patient’s Ledger Report	 230
Walkout - Doctor’s Statement	 368
Walkout - Family Walkout	 370
Analysis Summary Report - Daily	 8

Claim Amount
Secondary Insurance Claims Not Created Report	
318
Insurance Transaction Analysis Report	 154

Collection Amount
Provider A/R Totals - Daily Report	 276

Collection Amount for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Co-pay Amount
Standard Coverage Tables Report	 322
Utilization Report	 366
Insurance Coverage Tables Report	 150

Credit Adjustment Amount
Insurance Carrier Production - Full Report	 142
Billing Statement	 48

Credit Adjustment Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Credit Amount
Walkout - Family Walkout	 370

Credit Special Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Debit Adjustment Amount
Insurance Carrier Production - Full Report	 142

Debit Adjustment Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Debit Special Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Estimated Amount of Deductibles to Be Applied
Treatment Case Report	 326
Patient Treatment Case Report	 228

Estimated Amount of Insurance Payments
Treatment Case Report	 326
Patient Treatment Case Report	 228

Estimated Amount of Patient’s Portion
Patient Treatment Case Report	 228
Treatment Case Report	 326
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Estimated Guarantor Portion
Patient Route Slip	 226

Estimated Insurance Portion
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220
Dental Encounters Report	 106

Estimated Patient Portion
Patient Route Slip	 226

Finance Charge Amount
Analysis Summary Report - Daily	 8
Analysis Summary Report - Standard	 12
Finance Charge Report	 130
Adjustment Summary Report	 4

First Payment Amount
Truth in Lending Disclosure Statement	 332

Future Due Payment Plan Total
Future Due Payment Plan Report - Standard	 134

Grand Total Amount of Charge Adjustments
Insurance Transaction Analysis Report	 154

Grand Total Amount of Credit Adjustments
Insurance Transaction Analysis Report	 154

Grand Total Amount of Insurance Payments Received
Insurance Transaction Analysis Report	 154

Grand Total Amount of Insured Charges
Insurance Transaction Analysis Report	 154

Grand Total Amount of Patient Payments Received
Insurance Transaction Analysis Report	 154

Guarantor Estimate Amount
Collections Manager List	 70

Insurance Estimate Amount
Collections Manager List	 70

Insurance Estimated Amount
Walkout - Family Walkout	 370

Insurance Payment Amount
Insurance Carrier Production - Full Report	 142

Insurance Payment Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Lab Expense Amount
RVU Day Sheet Report	 308

Last Gratuity Amount
Patient Route Slip	 226

Last Late Charge Amount
Payment Agreement Report	 234

Last Payment Agreement Payment Amount
Patient Route Slip	 226

Last Payment Amount
Truth in Lending Disclosure Statement	 332
Aging/Credit Balance Report	 6

Last Payment Amount for Payment Agreement
Collections Manager List	 70

Late Charge Amount
Analysis Summary Report - Daily	 8
Analysis Summary Report - Standard	 12
Late Charge Report	 156
Adjustment Summary Report	 4

Late Charge Percent or Amount
Truth in Lending Disclosure Statement	 332

Loan Amount
Truth in Lending Disclosure Statement	 332

Maximum Primary Insurance Benefit Amount
Patient Route Slip	 226
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Maximum Secondary Insurance Benefit Amount
Patient Route Slip	 226

Monthly Charge Amount
Future Due Payment Plan Report - Standard	 134

Next Appointment Procedure Amount
Patient Route Slip	 226

Next Appointment Production Amount
Patient Route Slip	 226

Next Appointment Total Amount
Patient Route Slip	 226

Next Charge Amount (after 18 Months from Current 
Month)

Future Due Payment Plan Report - Monthly Totals	
132

Next Payment Agreement Payment Due Amount
Patient Route Slip	 226

Next Payment Plan Payment Amount
Letter Merge Reports	 158

Other Applied Credit Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Other Applied Insurance Payment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Other Applied Payment Amount
Analysis Summary Report - Daily	 8

Other Credit Special Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Other Retroactive Payment Amount Collected for 
Patient

UDS - Patient Related Revenue Report	 348
Outstanding Primary Insurance Estimated Amount

Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Outstanding Secondary Insurance Estimated Amount
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Patient Amount Aged >90
Patient Route Slip	 226

Patient Amount Aged 0 - 30
Patient Route Slip	 226

Patient Amount Aged 31 - 60
Patient Route Slip	 226

Patient Amount Aged 61 - 90
Patient Route Slip	 226

Patient Estimated Insurance Portion
Patient Route Slip	 226

Patient Suspended Credit Amount
Patient Route Slip	 226

Payment Agreement Amount
Payment Agreement Report	 234

Payment Agreement Amount Past Due
Payment Agreement Report	 234

Payment Agreement Last Payment Amount
Payment Agreement Report	 234

Payment Agreement Next Payment Amount
Payment Agreement Report	 234

Payment Agreement Payment Amount
Payment Agreement Amortization Schedule	 232

Payment Amount
Family Ledger Report	 124
Family Ledger Report (Single Family)	 126
Insurance Transaction Analysis Report	 154
Operator Day Sheet Report	 194
Patient Ledger Report	 210
Patient’s Ledger Report	 230
Procedures by Contracted Amount Report	 268
Truth in Lending Disclosure Statement	 332
Updated Dental Insurance Payment Table Report	
364
Deposit Slip	 108

Payment Amount Due
Coupon Book - Payment Agreements	 79
Coupon Book - Future Due Payments	 78

Payment Amount for Payment Type
Day Sheet (Receipts) Report	 98

Payment Plan Total Amount
Letter Merge Reports	 158

Penalty or Payback Amount Collected for Patient
UDS - Patient Related Revenue Report	 348

Percent of Amount Aged 0 - 30
Aging/Credit Balance Report	 6

Percent of Amount Aged 121 - 150
Aging/Credit Balance Report	 6

Percent of Amount Aged 151 - 180
Aging/Credit Balance Report	 6

Percent of Amount Aged 31 - 60
Aging/Credit Balance Report	 6

Percent of Amount Aged 61 - 90
Aging/Credit Balance Report	 6

Percent of Amount Aged 90 - 120
Aging/Credit Balance Report	 6

Percent of Amount Aged Over 180
Aging/Credit Balance Report	 6

Percent of Insurance Estimate Amounts
Aging/Credit Balance Report	 6

Please Pay Amount
Walkout - Family Walkout	 370

Pre-treatment Estimate Amount
Patient Route Slip	 226
Pre-Treatment Estimate Aging Report	 262
Pre-Treatment Estimates Not Sent Report	 264
Secondary Pre-Treatment Estimates Not Created 
Report	 320
Insurance Transaction Analysis Report	 154

Primary Insurance Estimated Amount
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Primary Production Amount
Insurance Carrier Production - Full Report	 142

Primary Production Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Procedure Amount
Patient List (Filtered)	 214
Procedures Not Attached to Insurance Report	270
Production Summary Report	 272
Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
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RVU Production Summary Report	 310
Audit Report - Combined	 32

Production Amount
Referred By Doctor/Other Report	 300
Referred By Patient Report	 302
Provider A/R Totals - Daily Report	 276

Production Amount for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Projected Amount of Remaining Benefits
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Projected Amount of Remaining Benefits for Secondary 
Insurance

Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Remaining Payment Agreement Amount
Collections Manager List	 70

Secondary Insurance Estimated Amount
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Secondary Production Amount
Insurance Carrier Production - Full Report	 142

Secondary Production Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Subtotal of Allowances for Financial Class Type
UDS - Patient Related Revenue Report	 348

Subtotal of Allowances for Payer Category
UDS - Patient Related Revenue Report	 348

Subtotal of Amount Collected for Financial Class Type
UDS - Patient Related Revenue Report	 348

Subtotal of Amount Collected for Payer Category
UDS - Patient Related Revenue Report	 348

Subtotal of Bad Debt Write-offs for Financial Class Type
UDS - Patient Related Revenue Report	 348

Subtotal of Bad Debt Write-offs for Payer Category
UDS - Patient Related Revenue Report	 348

Subtotal of Charges for Financial Class Type
UDS - Patient Related Revenue Report	 348

Subtotal of Charges for Payer Category
UDS - Patient Related Revenue Report	 348

Subtotal of Other Retroactive Payment Amount Col-
lected for Financial Class Type

UDS - Patient Related Revenue Report	 348
Subtotal of Other Retroactive Payment Amount Col-
lected for Payer Category

UDS - Patient Related Revenue Report	 348
Subtotal of Penalty or Payback Amount Collected for 
Financial Class Type

UDS - Patient Related Revenue Report	 348
Subtotal of Penalty or Payback Amount Collected for 
Payer Category

UDS - Patient Related Revenue Report	 348
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Financial Class Type (Current Year)

UDS - Patient Related Revenue Report	 348

Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Financial Class Type (Previous Years)

UDS - Patient Related Revenue Report	 348
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Payer Category (Current Year)

UDS - Patient Related Revenue Report	 348
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Payer Category (Previous Years)

UDS - Patient Related Revenue Report	 348
Suspended Amount

Suspended Credits Report	 324
Suspended Amount on Ledger

Suspended Credits Report	 324
Suspended Credit Adjustment Amount

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Suspended Credit Amount
Continuing Care Display List	 76

Suspended Credit Amount for Clinic
Aging/Credit Balance Report	 6

Suspended Insurance Payment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Suspended Payment Amount
Analysis Summary Report - Daily	 8

Total Adjustments
Patient Revenue List by Payer Report	 224

Total Amount Aged 0 - 30
Collections Manager List	 70
Aging/Credit Balance Report	 6

Total Amount Aged 121 - 150
Aging/Credit Balance Report	 6

Total Amount Aged 151 - 180
Aging/Credit Balance Report	 6

Total Amount Aged 31 - 60
Collections Manager List	 70
Aging/Credit Balance Report	 6

Total Amount Aged 61 - 90
Collections Manager List	 70
Aging/Credit Balance Report	 6

Total Amount Aged 90 - 120
Aging/Credit Balance Report	 6

Total Amount Aged 91+
Collections Manager List	 70

Total Amount Aged Over 180
Aging/Credit Balance Report	 6

Total Amount Billed to Insurance
Analysis Summary Report - Standard	 12
Collections Manager List	 70
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount Collected for Financial Class Type
UDS - Patient Related Revenue Report	 348

Total Amount Collected for Patient
UDS - Patient Related Revenue Report	 348

Total Amount Collected for Payer Category
UDS - Patient Related Revenue Report	 348

Total Amount Due for Payment Agreements
Collections Manager List	 70

Total Amount for Primary Pre-treatment Estimates
Pre-Treatment Estimate Aging Report	 262
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Total Amount for Secondary Pre-treatment Estimates
Pre-Treatment Estimate Aging Report	 262

Total Amount of - Adjustments (Collection)
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Amount of - Adjustments (Production)
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Amount of + Adjustments (Collection)
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Amount of + Adjustments (Production)
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Amount of Account Bal
Collections Manager List	 70
Payment Agreement Report	 234
Aging/Credit Balance Report	 6

Total Amount of Account Balances Aged 1 - 30 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 1 - 30 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 1 - 30 for Sec-
ondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 1 - 30 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 1 - 30 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 1 - 30 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 121 - 150 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 121 - 150 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 121 - 150 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 151 - 180 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262

Total Amount of Account Balances Aged 151 - 180 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 151 - 180 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 151 - 180 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 181+ for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 181+ for Pri-
mary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Pre-Treatment Estimate Aging Report	 262

Total Amount of Account Balances Aged 181+ for Sec-
ondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 181+ with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 181+ with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 181+ with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 31 - 60 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 31 - 60 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 31 - 60 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 61 - 90 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 with 
Claims

Insurance Claim Aging Report	 146
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Total Amount of Account Balances Aged 61 - 90 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 61 - 90 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 91 - 120 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 91 - 120 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 91 - 120 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Pre-treatment 
Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances with Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Primary Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances with Secondary 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Secondary Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Adjustment Type

Daily Summary Report	 88
Total Amount of Adjustment Types

Adjustment Summary Report	 4
Total Amount of Adjustments

Day Sheet (Adjustments) Report	 90
Daily Summary Report	 88

Total Amount of Adjustments for Clinic
Day Sheet (Adjustments) Report	 90

Total Amount of Adjustments for Provider
Day Sheet (Adjustments) Report	 90

Total Amount of Allowances for Financial Class Type
UDS - Patient Related Revenue Report	 348

Total Amount of Allowances for Patient
UDS - Patient Related Revenue Report	 348

Total Amount of Allowances for Payer Category
UDS - Patient Related Revenue Report	 348

Total Amount of Applied Credit Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100

Analysis Summary Report - Daily	 8
Total Amount of Applied Credit Adjustments for Previ-
ous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Applied Insurance Payments

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Applied Payments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Applied Payments for Previous Month
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Bad Debt Write-offs for Financial Class 
Type

UDS - Patient Related Revenue Report	 348
Total Amount of Bad Debt Write-offs for Patient

UDS - Patient Related Revenue Report	 348
Total Amount of Bad Debt Write-offs for Payer Category

UDS - Patient Related Revenue Report	 348
Total Amount of Balances Remaining for Payment 
Agreements

Payment Agreement Report	 234
Total Amount of Beginning Balances

Analysis Summary Report - Standard	 12
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Total Amount of Cash Payments
Operator Day Sheet Report	 194

Total Amount of Charge Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Insurance Transaction Analysis Report	 154
Operator Day Sheet Report	 194
Analysis Summary Report - Daily	 8

Total Amount of Charge Adjustments for Previous 
Month

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Charges
Day Sheet Report	 100
Future Due Payment Plan Report - Monthly Totals	
132
Operator Day Sheet Report	 194
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Total Amount of Charges Billed to Insurance for Previ-
ous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Charges for Financial Class Type

UDS - Patient Related Revenue Report	 348
Total Amount of Charges for Patient

UDS - Patient Related Revenue Report	 348
Total Amount of Charges for Payer Category

UDS - Patient Related Revenue Report	 348
Total Amount of Charges for Previous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Charges for Today’s Completed Work

Patient Chart Printout	 204
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Total Amount of Charges Remaining (after 18 Mos from 
Curr Mo)

Future Due Payment Plan Report - Monthly Totals	
132

Total Amount of Check Payments
Operator Day Sheet Report	 194

Total Amount of Completed Procedures
Walkout - Doctor’s Statement	 368
Procedures Not Attached to Insurance Report	270

Total Amount of Co-pays
Utilization Report	 366

Total Amount of Credit Adjustments
Day Sheet (Adjustments) Report	 90
Insurance Carrier Production - Full Report	 142
Insurance Carrier Production - Summary Report	
144
Insurance Transaction Analysis Report	 154
Operator Day Sheet Report	 194
Adjustment Summary Report	 4

Total Amount of Credit Card Payments
Operator Day Sheet Report	 194

Total Amount of Credit Initial Balances
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Total Amount of Credit Special Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Total Amount of Current Applied Credit Adjustments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Applied Payments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Charge Adjustments
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Charges Billed to Insurance
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Charges Compared to Fee 
Schedule

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Current Finance Charges

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Current Late Charges

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Current Suspended Credit Adjust-
ments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Current Suspended Payments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Debit Adjustments

Day Sheet (Adjustments) Report	 90
Insurance Carrier Production - Full Report	 142

Insurance Carrier Production - Summary Report	
144
Adjustment Summary Report	 4

Total Amount of Debit Initial Balances
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Debit Initial Balances (Production)
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Amount of Debit Special Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Total Amount of Dental Insurance Portions
Patient Chart Printout	 204

Total Amount of Deposit
Deposit Slip	 108

Total Amount of Ending Balances
Analysis Summary Report - Standard	 12
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Total Amount of Estimated Insurance Portion for Pri-
mary and Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Estimated Insurance Portion for Pri-
mary Claims

Insurance Claim Aging Report	 146
Total Amount of Estimated Insurance Portion for Sec-
ondary Claims

Insurance Claim Aging Report	 146
Total Amount of Fees

Utilization Report	 366
RVU Utilization Report	 316

Total Amount of Fees - Co-pays
Utilization Report	 366

Total Amount of Fees - RVU
RVU Utilization Report	 316

Total Amount of Finance Charges
Analysis Summary Report - Daily	 8
Analysis Summary Report - Standard	 12
Day Sheet (Adjustments) Report	 90
Day Sheet Report	 100
Finance Charge Report	 130
Operator Day Sheet Report	 194
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Truth in Lending Disclosure Statement	 332
Adjustment Summary Report	 4

Total Amount of Finance Charges for Previous Month
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Guarantor Estimates
Collections Manager List	 70

Total Amount of Guarantor Portions
Aging/Credit Balance Report	 6

Total Amount of Insurance Estimates
Collections Manager List	 70
Aging/Credit Balance Report	 6
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Total Amount of Insurance Payments
Insurance Carrier Production - Summary Report	
144
Operator Day Sheet Report	 194
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Insurance Carrier Production - Full Report	 142

Total Amount of Insurance Payments Received
Insurance Transaction Analysis Report	 154

Total Amount of Insured Charges
Insurance Transaction Analysis Report	 154

Total Amount of Lab Expenses
RVU Day Sheet Report	 308

Total Amount of Lab Expenses of Medicaid Procedures
RVU Production Summary Report	 310

Total Amount of Lab Expenses of Non-Medicaid Proce-
dures

RVU Production Summary Report	 310
Total Amount of Lab Expenses of Procedures

RVU Production Summary Report	 310
Total Amount of Last Payments for Payment Agree-
ments

Collections Manager List	 70
Total Amount of Late Charges

Analysis Summary Report - Daily	 8
Analysis Summary Report - Standard	 12
Day Sheet (Adjustments) Report	 90
Day Sheet Report	 100
Late Charge Report	 156
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Adjustment Summary Report	 4

Total Amount of Late Charges for Previous Month
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Medicaid Payments
Operator Day Sheet Report	 194

Total Amount of Medicaid Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Total Amount of MTD Applied Credit Adjustments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Applied Payments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Charge Adjustments
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Charges Billed to Insurance
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Finance Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Late Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Suspended Credit Adjustments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Suspended Payments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Net Change
Analysis Summary Report - Standard	 12
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Total Amount of Non-Medicaid Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Total Amount of Other Applied Credit Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Other Applied Credit Initial Balances
Day Sheet Report	 100

Total Amount of Other Applied Credit Special Adjust-
ments

Day Sheet Report	 100
Total Amount of Other Applied Insurance Payments

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Other Applied Payments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Other Credit Initial Balances
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Amount of Other Credit Special Adjustments
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Amount of Patient Payments Received
Insurance Transaction Analysis Report	 154

Total Amount of Payment Agreement Payments Due
Payment Agreement Report	 234

Total Amount of Payment Agreements
Payment Agreement Report	 234

Total Amount of Payment Type
Deposit Slip	 108
Daily Summary Report	 88

Total Amount of Payment Type for Clinic
Deposit Slip	 108

Total Amount of Payment Type for Operator
Deposit Slip	 108

Total Amount of Payments
Day Sheet (Receipts) Report	 98
Operator Day Sheet Report	 194
Payment Summary Report	 236
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Truth in Lending Disclosure Statement	 332
Daily Summary Report	 88

Total Amount of Payments for Clinic
Day Sheet (Receipts) Report	 98

Total Amount of Payments for Initial Provider
Day Sheet (Receipts) Report	 98

Total Amount of Payments for Payment Type
Day Sheet (Receipts) Report	 98

Total Amount of Payments for Provider
Day Sheet (Receipts) Report	 98

Total Amount of Pre-treatment Estimates
Pre-Treatment Estimate Aging Report	 262

Amount (continued)
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Total Amount of Pre-treatment Estimates not Sent
Pre-Treatment Estimates Not Sent Report	 264

Total Amount of Primary and Secondary Claims not Sent
Insurance Claims Not Sent Report	 148

Total Amount of Primary Claims not Sent
Insurance Claims Not Sent Report	 148

Total Amount of Primary Insurance Portion for Case
Treatment Case Report	 326

Total Amount of Primary Pre-treatment Estimates not 
Sent

Pre-Treatment Estimates Not Sent Report	 264
Total Amount of Primary Production

Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Total Amount of Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Total Amount of Remaining Payment Agreements
Collections Manager List	 70

Total Amount of RVUs
RVU Utilization Report	 316

Total Amount of Scheduled Treatment Plans
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Total Amount of Secondary Claims not Created
Secondary Insurance Claims Not Created Report	
318

Total Amount of Secondary Claims not Sent
Insurance Claims Not Sent Report	 148

Total Amount of Secondary Insurance Portion for Case
Treatment Case Report	 326

Total Amount of Secondary Pre-treatment Estimates not 
Created

Secondary Pre-Treatment Estimates Not Created 
Report	 320

Total Amount of Secondary Pre-treatment Estimates not 
Sent

Pre-Treatment Estimates Not Sent Report	 264
Total Amount of Secondary Production

Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Total Amount of Sliding Discounts for Financial Class 
Type

UDS - Patient Related Revenue Report	 348
Total Amount of Sliding Discounts for Patient

UDS - Patient Related Revenue Report	 348
Total Amount of Sliding Discounts for Payer Category

UDS - Patient Related Revenue Report	 348
Total Amount of Suspended Credit Adjustments

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Suspended Credit Adjustments for 
Previous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Suspended Credits for Clinic

Suspended Credits Report	 324

Total Amount of Suspended Insurance Payments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Suspended Payments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Suspended Payments for Previous 
Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Transacations

Credit Card Transaction Report	 80
Total Amount of Treatment Plan

Treatment Case Report	 326
Patient Treatment Case Report	 228

Total Amount of Treatment Plans
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Total Amount of Treatment-planned Procedures
Practice Treatment Case Report	 258
Patient Chart Printout	 204

Total Amount of Unscheduled Treatment Plans
Unscheduled Treatment Plans (Detailed) Report	
362
Unscheduled Treatment Plans (Condensed) Re-
port	 360

Total Amount of YTD Applied Payments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Charge Adjustments
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Charges Billed to Insurance
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Finance Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Finance Charges for Family
Family Ledger Report (Single Family)	 126

Total Amount of YTD Late Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Late Charges for Family
Family Ledger Report (Single Family)	 126
Family Ledger Report	 124

Total Amount of YTD Payments for Family
Family Ledger Report (Single Family)	 126
Family Ledger Report	 124

Total Amount of YTD Suspended Credit Adjustments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Suspended Payments
Day Sheet (Charges and Receipts) Report	 94

Total Amount Remaining
Future Due Payment Plan Report - Standard	 134

Total Case Amount
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Total Collection Amount
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount (continued)
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Total Estimated Amount of Patient’s Portion
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Total Estimated Insurance Portion
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Total Fee for Case
Treatment Case Report	 326

Total Fee from Alternate Fee Schedule for Case
Treatment Case Report	 326

Total Other Retroactive Payment Amount Collected for 
Financial Class Type

UDS - Patient Related Revenue Report	 348
Total Other Retroactive Payment Amount Collected for 
Patient

UDS - Patient Related Revenue Report	 348
Total Other Retroactive Payment Amount Collected for 
Payer Category

UDS - Patient Related Revenue Report	 348
Total Payments

Patient Revenue List by Payer Report	 224
Total Penalty or Payback Amount Collected for Financial 
Class Type

UDS - Patient Related Revenue Report	 348
Total Penalty or Payback Amount Collected for Patient

UDS - Patient Related Revenue Report	 348
Total Penalty or Payback Amount Collected for Payer 
Category

UDS - Patient Related Revenue Report	 348
Total Production Amount

Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Revenue
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Total Revenue for Provider
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Total Revenue from Credit Adjustments
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Total Revenue from Insurance
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Total Revenue from Non-insurance
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Total RVU
RVU Day Sheet Report	 308

Total Suspended Credits
Aging/Credit Balance Report	 6

Total Wrap Around or Reconciliation Amount Collected 
for Financial Class Type (Current Year)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Financial Class Type (Previous Years)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Patient (Current Year)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Patient (Previous Years)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Payer Category (Current Year)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Payer Category (Previous Years)

UDS - Patient Related Revenue Report	 348
Total YTD Finance Charges for Family

Family Ledger Report	 124
Transaction Amount

Credit Card Transaction Report	 80
Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Suspended Credits Report	 324
Audit Report - Transactions	 38

Transaction Amount Change
Audit Report - Transactions	 38

Treatment Plan Amount
Referred By Patient Report	 302
Unscheduled Treatment Plans (Condensed) Re-
port	 360
Unscheduled Treatment Plans (Detailed) Report	
362
Referred By Doctor/Other Report	 300

Treatment-planned Procedure Amount
Unscheduled Treatment Plans (Detailed) Report	
362

Wrap Around or Reconciliation Amount Collected for 
Patient (Current Year)

UDS - Patient Related Revenue Report	 348
Wrap Around or Reconciliation Amount Collected for 
Patient (Previous Years)

UDS - Patient Related Revenue Report	 348
Annual

Amount of Annual Primary Insurance Plan Benefits for 
Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Annual Secondary Insurance Plan Benefits 
for Family

Treatment Case Report	 326
Amount of Annual Secondary Insurance Plan Benefits 
for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Annual Percentage Rate
Annual Percentage Rate

Truth in Lending Disclosure Statement	 332

Amount (continued)
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API
Number of Patients Provided API Access to Electronic 
Health Information

Meaningful Use Measure Calculation List	 162
Number of Patients who Accessed Electronic Health 
Information with API

Meaningful Use Measure Calculation List	 162
Applied

Amount of Applied Credit Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Applied Credit Adjustments for Previous 
Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Applied Credit Adjustments for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Applied Insurance Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Applied Insurance Payments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Applied Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Applied Payments for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Applied Payments for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Current Applied Credit Adjustments for Prov
Day Sheet (Charges and Receipts) Report	 94

Amount of Current Applied Payments for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of MTD Applied Credit Adjustments for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Applied Payments for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Other Applied Credit Adjustments for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Credit Adjustments for 
Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Credit Initial Balances for 
Clinic

Day Sheet Report	 100
Amount of Other Applied Credit Initial Balances for 
Provider

Day Sheet Report	 100

Amount of Other Applied Credit Special Adjustments 
for Clinic

Day Sheet Report	 100
Amount of Other Applied Credit Special Adjustments 
for Provider

Day Sheet Report	 100
Amount of Other Applied Insurance Payments for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Insurance Payments for 
Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Payments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of YTD Applied Credit Adjustments for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of YTD Applied Payments for Provider

Day Sheet (Charges and Receipts) Report	 94
Applied Credit Adjustment Amount

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Applied Insurance Payment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Applied Payment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Estimated Amount of Deductibles to Be Applied
Treatment Case Report	 326
Patient Treatment Case Report	 228

Other Applied Credit Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Other Applied Insurance Payment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Other Applied Payment
Analysis Summary Report - Standard	 12

Other Applied Payment Amount
Analysis Summary Report - Daily	 8

Payment Agreement Payment Portion Applied to Inter-
est

Payment Agreement Amortization Schedule	 232
Payment Agreement Payment Portion Applied to Prin-
ciple

Payment Agreement Amortization Schedule	 232
Total Amount of Applied Credit Adjustments

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8
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Total Amount of Applied Credit Adjustments for Previ-
ous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Applied Insurance Payments

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Applied Payments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Applied Payments for Previous Month
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Applied Credit Adjustments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Applied Payments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Applied Credit Adjustments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Applied Payments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Other Applied Credit Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Other Applied Credit Initial Balances
Day Sheet Report	 100

Total Amount of Other Applied Credit Special Adjust-
ments

Day Sheet Report	 100
Total Amount of Other Applied Insurance Payments

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Other Applied Payments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of YTD Applied Credit Adjustments
Day Sheet (Charges and Receipts) Report	 94

Applied Credit Adjustment
Amount of Other Applied Credit Adjustments for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Credit Adjustments for 
Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of YTD Applied Credit Adjustments for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Applied Credit Adjustment Amount

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Other Applied Credit Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Amount of Applied Credit Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Applied Credit Adjustments for Previ-
ous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Current Applied Credit Adjustments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of MTD Applied Credit Adjustments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Other Applied Credit Adjustments

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of YTD Applied Credit Adjustments
Day Sheet (Charges and Receipts) Report	 94

Applied Credit Special Adjustment
Amount of Other Applied Credit Special Adjustments 
for Clinic

Day Sheet Report	 100
Amount of Other Applied Credit Special Adjustments 
for Provider

Day Sheet Report	 100
Total Amount of Other Applied Credit Special Adjust-
ments

Day Sheet Report	 100
Applied Initial Balance

Amount of Other Applied Credit Initial Balances for 
Clinic

Day Sheet Report	 100
Amount of Other Applied Credit Initial Balances for 
Provider

Day Sheet Report	 100
Total Amount of Other Applied Credit Initial Balances

Day Sheet Report	 100
Applied Insurance Payment

Amount of Other Applied Insurance Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Insurance Payments for 
Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Applied Insurance Payment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Other Applied Insurance Payment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Amount of Applied Insurance Payments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Other Applied Insurance Payments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Applied (continued)
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Applied Payment
Amount of Other Applied Payments for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Payments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of YTD Applied Payments for Provider
Day Sheet (Charges and Receipts) Report	 94

Applied Payment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Other Applied Payment
Analysis Summary Report - Standard	 12

Other Applied Payment Amount
Analysis Summary Report - Daily	 8

Payment Agreement Payment Portion Applied to Inter-
est

Payment Agreement Amortization Schedule	 232
Payment Agreement Payment Portion Applied to Prin-
ciple

Payment Agreement Amortization Schedule	 232
Total Amount of Applied Payments

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Applied Payments for Previous Month
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Applied Payments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Applied Payments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Other Applied Payments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of YTD Applied Payments
Day Sheet (Charges and Receipts) Report	 94

Appointment
Address of Patient on Appointment

Letter Merge Reports	 158
Appointment Amount

Audit Report - Appointments	 26
Appointment Amount Change

Audit Report - Appointments	 26
Appointment Checklist Items

Custom Practice Information Report	 82
Appointment Date

Appointment Reminder Cards	 18
As Soon As Possible List	 22
Audit Report - Appointments	 26
Daily Appointment List (DX1)	 84
Daily Appointment List Report	 86
Letter Merge Reports	 158
Operatory Appointment List Report	 196
Patient List (Filtered)	 214
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Walkout - Family Walkout	 370
Appointment Cycle Time Report	 16

Appointment Date and Time
Insurance Eligibility Report	 152

Appointment Date Change
Audit Report - Appointments	 26

Appointment Length
Audit Report - Appointments	 26
Daily Appointment List (DX1)	 84
Daily Appointment List Report	 86
Operatory Appointment List Report	 196
Unscheduled Appointment List (DX1)	 356
Unscheduled Appointment List (OM)	 358
As Soon As Possible List	 22

Appointment Length Change
Audit Report - Appointments	 26

Appointment Note
Patient Notes Report	 216

Appointment Notes
Appointment Book View Printout	 14

Appointment Production Amount
Appointment Book View Printout	 14

Appointment Production Type
Audit Report - Appointments	 26
Multi-Code List	 188
Procedure Code List	 266
Appointment Book View Printout	 14

Appointment Production Type Change
Audit Report - Appointments	 26

Appointment Provider
Audit Report - Appointments	 26
Daily Appointment List (DX1)	 84
Daily Appointment List Report	 86
Letter Merge Reports	 158
Letter Merge Reports	 158
Operatory Appointment List Report	 196
Patient List (Filtered)	 214
As Soon As Possible List	 22

Appointment Provider Change
Audit Report - Appointments	 26

Appointment Provider ID
Letter Merge Reports	 158
Appointment Book View Printout	 14

Appointment Reason
As Soon As Possible List	 22
Daily Appointment List (DX1)	 84
Daily Appointment List Report	 86
Letter Merge Reports	 158
Operatory Appointment List Report	 196
Unscheduled Appointment List (DX1)	 356
Unscheduled Appointment List (OM)	 358
Walkout - Family Walkout	 370
Appointment Book View Printout	 14

Appointment Status
As Soon As Possible List	 22
Audit Report - Appointments	 26
Daily Appointment List (DX1)	 84
Daily Appointment List Report	 86
Operatory Appointment List Report	 196
Patient Chart and Progress Notes Printout	 202
Unscheduled Appointment List (DX1)	 356
Unscheduled Appointment List (OM)	 358
Appointment Cycle Time Report	 16
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Appointment Status Change
Audit Report - Appointments	 26

Appointment Statuses
Custom Practice Information Report	 82

Appointment Time
As Soon As Possible List	 22
Audit Report - Appointments	 26
Daily Appointment List (DX1)	 84
Daily Appointment List Report	 86
Letter Merge Reports	 158
Operatory Appointment List Report	 196
Patient List (Filtered)	 214
Walkout - Family Walkout	 370
Appointment Reminder Cards	 18

Appointment Time Change
Audit Report - Appointments	 26

Appointment Type
Audit Report - Appointments	 26
Appointment Cycle Time Report	 16

Appointment Type Change
Audit Report - Appointments	 26

Continuing Care Appointment Date
Continuing Care Display List	 76

Date Appointment Broken
Unscheduled Appointment List (OM)	 358
Unscheduled Appointment List (DX1)	 356

Deleted Appointment
Audit Report - Appointments	 26

Future Appointment Date
Patient Route Slip	 226

Future Appointment Provider ID
Patient Route Slip	 226

Future Appointment Reason
Patient Route Slip	 226

Future Appointment Time
Patient Route Slip	 226

Future Reminder Date
Collections Manager List	 70

Future Reminder Type
Collections Manager List	 70

Inserted Appointment
Audit Report - Appointments	 26

Last Missed Appointment Date
Patient Route Slip	 226

Length in Appointment Status
Appointment Cycle Time Report	 16

Next Appointment ADA Code
Patient Route Slip	 226

Next Appointment ADA Code Description
Patient Route Slip	 226

Next Appointment Date
Patient Route Slip	 226

Next Appointment Length
Patient Route Slip	 226

Next Appointment Note
Patient Route Slip	 226

Next Appointment Operatory ID
Patient Route Slip	 226

Next Appointment Procedure Amount
Patient Route Slip	 226

Next Appointment Procedure Date
Patient Route Slip	 226

Next Appointment Production Amount
Patient Route Slip	 226

Next Appointment Provider ID
Patient Route Slip	 226

Next Appointment Status
Patient Route Slip	 226

Next Appointment Time
Patient Route Slip	 226

Next Appointment Total Amount
Patient Route Slip	 226

Next Appointment Treatment Area
Patient Route Slip	 226

Next Appointment Treatment Plan Visit
Patient Route Slip	 226

Next Continuing Care Appointment Date
Patient Route Slip	 226
Letter Merge Reports	 158

Next Continuing Care Appointment Provider
Letter Merge Reports	 158

Next Continuing Care Appointment Reason
Letter Merge Reports	 158

Next Continuing Care Appointment Time
Letter Merge Reports	 158

Number of Appointments in Appointment Status for or 
Longer than Length of Time

Appointment Statistics Report	 20
Number of Appointments in Appointment Status Less 
than Length of Time

Appointment Statistics Report	 20
Number of Broken Appointments

Appointment Statistics Report	 20
Number of Late Appointments

Appointment Statistics Report	 20
Number of Missed Appointments

Patient Route Slip	 226
Number of New Appointments

Daily Summary Report	 88
Number of On Time Appointments

Appointment Statistics Report	 20
Number of Patients <6 or 65+ Years who Received Ap-
pointment Reminders

Meaningful Use Measure Calculation List	 162
Number of Scheduled Treatment-planned Procedures

Practice Treatment Case Report	 258
Number of Unscheduled Appointments Listed

Unscheduled Appointment List (OM)	 358
Unscheduled Appointment List (DX1)	 356

Number of Wait/Will Call Appointments
Appointment Statistics Report	 20

Patient Name on Appointment
Letter Merge Reports	 158

Percent Broken Appointments
Appointment Statistics Report	 20

Percent Late Appointments
Appointment Statistics Report	 20

Percent of Appointments in Appointment Status for or 
Longer than Length of Time

Appointment Statistics Report	 20
Phone Number of Patient on Appointment

Letter Merge Reports	 158

Appointment (continued)
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Reason Appointment Broken
Unscheduled Appointment List (DX1)	 356

Scheduled and/or Unscheduled Appointment
Unscheduled Treatment Plans (Detailed) Report	
362
Unscheduled Treatment Plans (Condensed) Re-
port	 360

Total Length in Appointment Statuses
Appointment Cycle Time Report	 16

Total Number of Appointments
As Soon As Possible List	 22
Appointment Statistics Report	 20

Total Number of Scheduled Appointments
Appointment Statistics Report	 20

Appointment Book
Day Note

Appointment Book View Printout	 14
Time Blocks

Appointment Book View Printout	 14
Time Units

Procedure Code List	 266
Multi-Code List	 188

Appointment Reminder
Number of Patients <6 or 65+ Years who Received Ap-
pointment Reminders

Meaningful Use Measure Calculation List	 162
Appointment Status

Average Length of Time Between Appointment Sta-
tuses

Appointment Statistics Report	 20
Next Appointment Status

Patient Route Slip	 226
Number of Appointments in Appointment Status for or 
Longer than Length of Time

Appointment Statistics Report	 20
Number of Appointments in Appointment Status Less 
than Length of Time

Appointment Statistics Report	 20
Percent of Appointments in Appointment Status for or 
Longer than Length of Time

Appointment Statistics Report	 20
Appointment Type

Appointment Type
Audit Report - Appointments	 26
Appointment Cycle Time Report	 16

Appointment Type Change
Audit Report - Appointments	 26

Approval Status
Treatment Plan Approval Status

Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Patient Chart and Progress Notes Printout	 202

APR
Annual Percentage Rate

Truth in Lending Disclosure Statement	 332
Archived

Total Archived New Patients
New Patient List	 190

Attachment
Attached Date

Document Center - Documents List Report	 112
Attachment Entity Name

Document Center Documents Audited Report	
118
Document Center - Documents List Report	 112

Attachment Entity Type
Document Center Documents Audited Report	
118
Document Center - Documents List Report	 112

Date Attached
Document Center List	 120

Attestation
Number of Patients with Medication Allergies or Attes-
tations of No Known Medication Allergies

Meaningful Use Measure Calculation List	 162
Number of Patients with Medications or Attestations of 
No Known Medications

Meaningful Use Measure Calculation List	 162
Number of Patients with Problems or Attestations of No 
Known Problems

Meaningful Use Measure Calculation List	 162
Audit

Appointment Amount Change
Audit Report - Appointments	 26

Appointment Date Change
Audit Report - Appointments	 26

Appointment Length Change
Audit Report - Appointments	 26

Appointment Production Type Change
Audit Report - Appointments	 26

Appointment Provider Change
Audit Report - Appointments	 26

Appointment Status Change
Audit Report - Appointments	 26

Appointment Time Change
Audit Report - Appointments	 26

Appointment Type Change
Audit Report - Appointments	 26

Audit Date
Document Center Documents Audited Report	
118

Audit Log Option
Audit Report - Audit Log Status	 28

Bank Account Number Change
Audit Report - Clinics	 30

Billing Type Change
Audit Report - Patients	 34

Change of Address
Coupon Book - Payment Agreements	 79
Coupon Book - Future Due Payments	 78

Date of Last Case Status Update
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Deleted Appointment
Audit Report - Appointments	 26

Deleted Entry
Audit Report - Patients	 34

Deleted Procedure
Audit Report - Combined	 32

Appointment (continued)
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Deleted Transaction
Audit Report - Transactions	 38

Encounter Number Change
Audit Report - Transactions	 38

Fiscal Year Month Change
Audit Report - Clinics	 30

Guarantor Name Change
Audit Report - Patients	 34

Initial Entry
Audit Report - Patients	 34

Inserted Appointment
Audit Report - Appointments	 26

Inserted Transaction
Audit Report - Transactions	 38

Login Name Change
Audit Report - Providers/Staff	 36

Number of Documents Audited
Document Center Audit Documents Report	 114

Operatory Change
Audit Report - Appointments	 26

Other ID Change
Audit Report - Patients	 34

Patient Name Change
Audit Report - Patients	 34
Audit Report - Transactions	 38
Audit Report - Appointments	 26

Patient Social Security Number or Request Date 
Change

Audit Report - Patients	 34
Patient Status Change

Audit Report - Patients	 34
Percent of Documents Audited

Document Center Audit Documents Report	 114
Perio Measurement Change

Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Practice Change
Audit Report - Clinics	 30

Practice Title Change
Audit Report - Clinics	 30

Primary Provider ID Change
Audit Report - Patients	 34

Procedure Date Change
Audit Report - Transactions	 38

Provider Class Change
Audit Report - Providers/Staff	 36

Provider Fee Schedule Change
Audit Report - Providers/Staff	 36

Provider ID Change
Audit Report - Transactions	 38
Audit Report - Providers/Staff	 36

Provider Name Change
Audit Report - Providers/Staff	 36

Provider Social Security Number Change
Audit Report - Providers/Staff	 36

Record Type Change
Audit Report - Patients	 34
Audit Report - Transactions	 38
Audit Rights Report - Assigned Individually	 40

Audit Rights Report - Assigned to Groups	 42
Audit Rights Report - Group Names	 44
Audit Rights Report - Users to Groups	 46
Audit Report - Combined	 32

Staff Social Security Number Change
Audit Report - Providers/Staff	 36

Time of Change
Audit Report - Appointments	 26
Audit Report - Audit Log Status	 28
Audit Report - Clinics	 30
Audit Report - Combined	 32
Audit Report - Patients	 34
Audit Report - Providers/Staff	 36
Audit Report - Transactions	 38
Audit Rights Report - Assigned Individually	 40
Audit Rights Report - Assigned to Groups	 42
Audit Rights Report - Group Names	 44
Audit Rights Report - Users to Groups	 46
Appointment Cycle Time Report	 16

Total Number of Documents Audited
Document Center Audit Documents Report	 114

Total Percent of Documents Audited
Document Center Audit Documents Report	 114

Transaction Amount Change
Audit Report - Transactions	 38

Transaction Description Change
Audit Report - Transactions	 38

User Changed
Audit Rights Report - Users to Groups	 46
Audit Rights Report - Assigned Individually	 40

User Group Change
Audit Rights Report - Group Names	 44

Average
Amount of Debit Adjustments (Average)

Practice Analysis Report	 252
Amount of Finance Charges (Average)

Practice Analysis Report	 252
Amount of Insured Charges (Average)

Practice Analysis Report	 252
Amount of Late Charges (Average)

Practice Analysis Report	 252
Amount of Non-insured Charges (Average)

Practice Analysis Report	 252
Amount of Other Debit Adjustments (Average)

Practice Analysis Report	 252
Average Amount of Adjustment Type

Adjustment Summary Report	 4
Average Amount of Adjustments

Day Sheet (Adjustments) Report	 90
Average Amount of Adjustments for Clinic

Day Sheet (Adjustments) Report	 90
Average Amount of Adjustments for Provider

Day Sheet (Adjustments) Report	 90
Average Amount of Credit Adjustments

Day Sheet (Adjustments) Report	 90
Average Amount of Debit Adjustments

Day Sheet (Adjustments) Report	 90
Average Amount of Finance Charges

Day Sheet (Adjustments) Report	 90
Average Amount of Late Charges

Day Sheet (Adjustments) Report	 90

Audit (continued)
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Average Amount of Medicaid Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Non-Medicaid Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Non-Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Non-Medicaid Procedures for 
Provider

RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Payment Type
Payment Summary Report	 236

Average Amount of Payments
Payment Summary Report	 236

Average Amount of Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Average Charge per Patient
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Charge per Patient for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Charge per Patient for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Charge per Patient MTD
Day Sheet (Charges and Receipts) Report	 94

Average Charge per Patient MTD for Provider
Day Sheet (Charges and Receipts) Report	 94

Average Length of Time Between Appointment Sta-
tuses

Appointment Statistics Report	 20
Average Monthly Charge Amount

Future Due Payment Plan Report - Monthly Totals	
132

Average Number of Charges
Future Due Payment Plan Report - Monthly Totals	
132

Average Payment Amount
Day Sheet (Receipts) Report	 98

Average Payment Amount for Clinic
Day Sheet (Receipts) Report	 98

Average Payment Amount for Initial Provider
Day Sheet (Receipts) Report	 98

Average Payment Amount for Payment Type
Day Sheet (Receipts) Report	 98

Average Payment Amount for Provider
Day Sheet (Receipts) Report	 98

Average Production per Patient
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Production per Patient for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Production per Patient for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Production Per Patient from Referral Source
Referral Analysis Report	 294

Average Production Per Patient from Referral Sources
Referral Analysis Report	 294

Average Production per Patient MTD
Day Sheet (Charges and Receipts) Report	 94

Average Production per Patient MTD for Provider
Day Sheet (Charges and Receipts) Report	 94

Average Wait Time
Appointment Cycle Time Report	 16

Beginning Balance (Average)
Practice Analysis Report	 252

Current Average Charge per Patient
Day Sheet (Charges and Receipts) Report	 94

Current Average Charge per Patient for Provider
Day Sheet (Charges and Receipts) Report	 94

Current Average Production per Patient
Day Sheet (Charges and Receipts) Report	 94

Current Average Production per Patient for Provider
Day Sheet (Charges and Receipts) Report	 94

Ending Balance (Average)
Practice Analysis Report	 252

New Patients (Average)
Practice Analysis Report	 252

Referred Patients (Average)
Practice Analysis Report	 252

Subtotal of Charges (Average)
Practice Analysis Report	 252

Total Average Charge per Patient
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Average Production per Patient
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Average Production per Patient at Clinics from 
Referral Source

Referral Analysis Report	 294
Total Charges (Average)

Practice Analysis Report	 252

Average (continued)
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Balance
Account Balance

Collections Manager List	 70
Family Ledger Report	 124
Family Ledger Report (Single Family)	 126
Insurance Claim Aging Report	 146
Letter Merge Reports	 158
Patient Route Slip	 226
Patient’s Ledger Report	 230
Payment Agreement Report	 234
Pre-Treatment Estimate Aging Report	 262
Aging/Credit Balance Report	 6

Account Balance Amount Aged 121 - 150
Pre-Treatment Estimate Aging Report	 262

Account Balance Amount Aged 151 - 180
Pre-Treatment Estimate Aging Report	 262

Account Balance Amount Aged 31 - 60
Pre-Treatment Estimate Aging Report	 262

Account Balance Amount Aged 61 - 90
Pre-Treatment Estimate Aging Report	 262

Account Balance Amount Aged 91 - 120
Pre-Treatment Estimate Aging Report	 262

Amount of Account Balance Aged >90
Insurance Claim Aging Report	 146

Amount of Account Balance Aged 1 - 30
Insurance Claim Aging Report	 146

Amount of Account Balance Aged 31 - 60
Insurance Claim Aging Report	 146

Amount of Account Balance Aged 61 - 90
Insurance Claim Aging Report	 146

Amount of Beginning Balances for Clinic
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Beginning Balances for Provider
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Credit Initial Balances
Provider A/R Totals - Daily Report	 276

Amount of Credit Initial Balances for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Credit Initial Balances for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Debit Initial Balances (Production)
Provider A/R Totals - Daily Report	 276

Amount of Debit Initial Balances for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Debit Initial Balances for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Ending Balances for Clinic
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Ending Balances for Provider
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Other Applied Credit Initial Balances for 
Clinic

Day Sheet Report	 100
Amount of Other Applied Credit Initial Balances for 
Provider

Day Sheet Report	 100
Amount of Other Credit Initial Balances for Clinic

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Other Credit Initial Balances for Provider
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Balance (as of a Date)
Day Sheet Report	 100
Day Sheet (Charges and Receipts) Report	 94

Balance (as of a Date) for Clinic
Day Sheet Report	 100

Balance (as of a Date) for Provider
Day Sheet Report	 100
Day Sheet (Charges and Receipts) Report	 94

Balance Due
Coupon Book - Payment Agreements	 79
Coupon Book - Future Due Payments	 78

Beginning Balance
Analysis Summary Report - Standard	 12
Provider A/R Totals - Daily Report	 276
Analysis Summary Report - Daily	 8

Beginning Balance (Average)
Practice Analysis Report	 252

Beginning Balance (for Date Range)
Practice Analysis Report	 252

Beginning Balance (MTD)
Practice Analysis Report	 252

Beginning Balance (YTD)
Practice Analysis Report	 252

Beginning Balance for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Credit Balance (as of Date)
Practice Analysis Report	 252

Credit Initial Balance
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Current Account Balance
Billing Statement	 48

Debit Initial Balance
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Debit Initial Balance
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Ending Balance
Analysis Summary Report - Standard	 12
Provider A/R Totals - Daily Report	 276
Analysis Summary Report - Daily	 8

Ending Balance (Average)
Practice Analysis Report	 252

Ending Balance (for Date Range)
Practice Analysis Report	 252
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Ending Balance (MTD)
Practice Analysis Report	 252

Ending Balance (YTD)
Practice Analysis Report	 252

Ending Balance for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Family Balance
Treatment Case Report	 326
Patient Treatment Case Report	 228

Family Member Balance (as of a Date)
Patient’s Ledger Report	 230

Ledger Balance
Suspended Credits Report	 324

Net Change in Balance
Day Sheet (Charges and Receipts) Report	 94

Net Change in Balance for Provider
Day Sheet (Charges and Receipts) Report	 94

New Balance
Walkout - Family Walkout	 370

Other Credit Initial Balance
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Patient Balance
Patient Route Slip	 226
Patient Treatment Case Report	 228
Patient’s Ledger Report	 230
Referred By Doctor/Other Report	 300
Referred By Patient Report	 302
Treatment Case Report	 326
Continuing Care Display List	 76

Patient Running Balance
Patient Ledger Report	 210

Payment Agreement Remaining Balance
Payment Agreement Report	 234
Payment Agreement Report	 234
Payment Agreement Amortization Schedule	 232

Payment Plan Remaining Balance
Letter Merge Reports	 158

Previous Balance
Day Sheet Report	 100
Day Sheet (Charges and Receipts) Report	 94

Previous Balance for Clinic
Day Sheet Report	 100

Previous Balance for Provider
Day Sheet Report	 100
Day Sheet (Charges and Receipts) Report	 94

Prior Account Balance
Walkout - Family Walkout	 370

Remaining Balance
Procedures by Contracted Amount Report	 268
Future Due Payment Plan Report - Standard	 134

Total Account Balance
Insurance Claim Aging Report	 146
Billing Statement	 48

Total Amount of Account Bal
Collections Manager List	 70
Payment Agreement Report	 234
Aging/Credit Balance Report	 6

Total Amount of Account Balances Aged 1 - 30 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 1 - 30 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 1 - 30 for Sec-
ondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 1 - 30 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 1 - 30 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 1 - 30 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 121 - 150 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 121 - 150 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 121 - 150 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 151 - 180 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 151 - 180 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 151 - 180 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 181+ for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 181+ for Pri-
mary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Pre-Treatment Estimate Aging Report	 262

Balance (continued)



446   Index by Report Item

Dentrix Enterprise 11.0.2 Reports Reference

Total Amount of Account Balances Aged 181+ for Sec-
ondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 181+ with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 181+ with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 181+ with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 31 - 60 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 31 - 60 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 31 - 60 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 61 - 90 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 61 - 90 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 61 - 90 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 91 - 120 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 with 
Claims

Insurance Claim Aging Report	 146

Total Amount of Account Balances Aged 91 - 120 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 91 - 120 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Pre-treatment 
Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances with Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Primary Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances with Secondary 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Secondary Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Balances Remaining for Payment 
Agreements

Payment Agreement Report	 234
Total Amount of Beginning Balances

Analysis Summary Report - Standard	 12
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Total Amount of Credit Initial Balances
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Total Amount of Debit Initial Balances
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Debit Initial Balances (Production)
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Amount of Ending Balances
Analysis Summary Report - Standard	 12
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Total Amount of Other Applied Credit Initial Balances
Day Sheet Report	 100

Total Amount of Other Credit Initial Balances
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Family Balance (as of a Date)
Family Ledger Report (Single Family)	 126
Family Ledger Report	 124

Total Family Balance as of a Date
Patient’s Ledger Report	 230

Total Patient Balance (as of Date)
Patient Ledger Report	 210

Total Patient Balance as of a Date
Patient’s Ledger Report	 230

Balance (continued)
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Bank Account
Bank Account Number

Deposit Slip	 108
Audit Report - Clinics	 30

Bank Account Number Change
Audit Report - Clinics	 30

Basic
Insurance Coverage Percent (Basic) for Primary Insur-
ance

Patient Route Slip	 226
Insurance Coverage Percent (Basic) for Secondary Insur-
ance

Patient Route Slip	 226
Beginning

Beginning ADA Code
Insurance Coverage Tables Report	 150

Beginning Balance
Amount of Beginning Balances for Clinic

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Beginning Balances for Provider
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Beginning Balance
Analysis Summary Report - Standard	 12
Provider A/R Totals - Daily Report	 276
Analysis Summary Report - Daily	 8

Beginning Balance (Average)
Practice Analysis Report	 252

Beginning Balance (for Date Range)
Practice Analysis Report	 252

Beginning Balance (MTD)
Practice Analysis Report	 252

Beginning Balance (YTD)
Practice Analysis Report	 252

Beginning Balance for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Amount of Beginning Balances
Analysis Summary Report - Standard	 12
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Beneficiary
Beneficiary ID

Dental Encounters Report	 106
Benefits

Amount of Annual Primary Insurance Plan Benefits for 
Family

Treatment Case Report	 326
Amount of Annual Primary Insurance Plan Benefits for 
Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Annual Secondary Insurance Plan Benefits 
for Family

Treatment Case Report	 326
Amount of Annual Secondary Insurance Plan Benefits 
for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Estimated Primary Insurance Benefits Re-
maining YTD for Family

Treatment Case Report	 326
Amount of Estimated Primary Insurance Benefits Re-
maining YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Estimated Secondary Insurance Benefits 
Remaining YTD for Family

Treatment Case Report	 326
Amount of Estimated Secondary Insurance Benefits 
Remaining YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Primary Insurance Benefits Remaining
Unscheduled Treatment Plans (Detailed) Report	
362
Patient Route Slip	 226

Amount of Primary Insurance Benefits Used
Patient Route Slip	 226

Amount of Primary Insurance Paid Benefits YTD for 
Family

Treatment Case Report	 326
Amount of Primary Insurance Paid Benefits YTD for 
Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Remaining Benefits for Primary Insurance
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Amount of Remaining Benefits for Secondary Insurance
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Amount of Secondary Insurance Benefits Remaining
Unscheduled Treatment Plans (Detailed) Report	
362
Patient Route Slip	 226

Amount of Secondary Insurance Benefits Used
Patient Route Slip	 226

Amount of Secondary Paid Benefits for Family
Treatment Case Report	 326

Amount of Secondary Paid Benefits for Patient
Treatment Case Report	 326
Patient Treatment Case Report	 228

Benefit Renewal Month
Insurance Carrier List	 138

Benefits Remaining
Insurance Carrier List	 138

Family Benefits
Insurance Carrier List	 138

Individual Benefits
Insurance Carrier List	 138

Maximum Primary Insurance Benefit Amount
Patient Route Slip	 226

Maximum Secondary Insurance Benefit Amount
Patient Route Slip	 226

Primary Insurance Benefits Expiration Date for Family
Treatment Case Report	 326

Primary Insurance Benefits Expiration Date for Patient
Treatment Case Report	 326
Patient Treatment Case Report	 228
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Primary Insurance Benefits Remaining
Letter Merge Reports	 158

Primary Insurance Benefits Renewal Month
Patient Route Slip	 226

Projected Amount of Remaining Benefits
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Projected Amount of Remaining Benefits for Secondary 
Insurance

Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Secondary Insurance Benefits Expiration Date for Family
Treatment Case Report	 326

Secondary Insurance Benefits Expiration Date for 
Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Secondary Insurance Benefits Remaining
Letter Merge Reports	 158

Secondary Insurance Benefits Renewal Month
Patient Route Slip	 226

Billed
Amount of Current Charges Billed to Insurance for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Billing

Amount Billed to Insurance
Analysis Summary Report - Standard	 12
Collections Manager List	 70
Analysis Summary Report - Daily	 8

Amount Billed to Insurance for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount Billed to Insurance for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Charges Billed to Insurance for Previous 
Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Charges Billed to Insurance for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of YTD Charges Billed to Insurance for Provider

Day Sheet (Charges and Receipts) Report	 94
Bill Date

Walkout - Family Walkout	 370
Billable to Insurance

Procedure Code List	 266
Billing Date

Billing Statement	 48
Do not Bill to Dental Insurance

Insurance Carrier List	 138
Do not Bill to Dental Insurance if 0% Coverage

Insurance Carrier List	 138
Total Amount Billed to Insurance

Analysis Summary Report - Standard	 12
Collections Manager List	 70
Day Sheet Report	 100

Analysis Summary Report - Daily	 8
Total Amount of Charges Billed to Insurance for Previ-
ous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Current Charges Billed to Insurance

Day Sheet (Charges and Receipts) Report	 94
Total Amount of MTD Charges Billed to Insurance

Day Sheet (Charges and Receipts) Report	 94
Total Amount of YTD Charges Billed to Insurance

Day Sheet (Charges and Receipts) Report	 94
Billing Type

Billing Type
Audit Report - Patients	 34
Collections Manager List	 70
Credit Card Transaction Report	 80
Day Sheet (Adjustments) Report	 90
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Receipts) Report	 98
Day Sheet Report	 100
Deposit Slip	 108
Family Ledger Report	 124
Family Ledger Report (Single Family)	 126
Finance Charge Report	 130
Future Due Payment Plan Report - Standard	 134
Late Charge Report	 156
Letter Merge Reports	 158
Operator Day Sheet Report	 194
Patient Ledger Report	 210
Patient List	 212
Patient’s Ledger Report	 230
Payment Agreement Report	 234
Practice Treatment Case Report	 258
Procedures Not Attached to Insurance Report	270
Production Summary Report	 272
Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
RVU Day Sheet Report	 308
RVU Production Summary Report	 310
Suspended Credits Report	 324
UDS - Tobacco Use and Intervention Report	 354
Aging/Credit Balance Report	 6

Billing Type Change
Audit Report - Patients	 34

Billing Types
Custom Practice Information Report	 82

Guarantor Billing Type
Patient Route Slip	 226

Birth Date
Birth Date

Insurance Claim Aging Report	 146
Insurance Eligibility Report	 152
Insurance Transaction Analysis Report	 154
Letter Merge Reports	 158
Birthday List	 50

Guarantor Birth Date & Age
Collections Manager List	 70

Number of Patients without a Birth Date Entered
Practice Statistics Report	 256

Patient Birth Date
Employers and Employed Patients Report	 122
Insurance Carrier List	 138

Benefits (continued)
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Patient Chart and Progress Notes Printout	 202
Patient Chart Printout	 204
Patient List	 212
Patient List (Filtered)	 214
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220
Patient Questionnaire	 222
Patient Route Slip	 226
Patient Treatment Case Report	 228
Perio - Combined Graphic & Data Chart Report	
238
Perio - Exam Comparison Report	 242
Perio - Graphic Chart Report	 244
Practice Treatment Case Report	 258
Prescription Printout	 260
Pre-Treatment Estimate Aging Report	 262
RVU Utilization Report	 316
Treatment Case Report	 326
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
UDS - Age/Gender Report	 334
UDS - Insurance Financial Class Report	 342
UDS - Insurance Financial Class Report (2013)	344
UDS - Medicaid/Medicare Report	 346
UDS - Patient Status Report	 350
UDS - Sealant Statistics Report	 352
UDS - Tobacco Use and Intervention Report	 354
Utilization Report	 366
Walkout - Doctor’s Statement	 368
Clinical Notes Report	 64

Percent of Patients without a Birth Date Entered
Practice Statistics Report	 256

Spouse Birth Date
Patient Questionnaire	 222

Subscriber Birth Date
Walkout - Doctor’s Statement	 368
Insurance Carrier List	 138

Subscriber Birth Date for Primary Insurance
Patient Questionnaire	 222

Subscriber Birth Date for Secondary Insurance
Patient Questionnaire	 222

Bleeding
Bleeding

Perio - Data Chart Report	 240
Perio - Combined Graphic & Data Chart Report	
238

Blood Pressure
Blood Pressure

Patient Health Assessment Report	 206
Number of Patients 18 - 85 Years with Abnormal Blood 
Pressure Reading

Clinical Quality Measures List	 66
Blue Cross/Blue Shield

Blue Cross/Blue Shield ID
Provider IDs List	 284

Blue Cross/Blue Shield Number
Practice Organization List	 254

BMI
Number of Patients 18 - 64 Years  with Abnormal BMI 
Reading and Follow Up

Clinical Quality Measures List	 66
Number of Patients 3 - 17 Years with BMI Percentile 
Reading

Clinical Quality Measures List	 66
Number of Patients 65+ Years with Abnormal BMI 
Reading and Follow Up

Clinical Quality Measures List	 66
BMI Percentile

Number of Patients 3 - 17 Years with BMI Percentile 
Reading

Clinical Quality Measures List	 66
Body Mass Index

Body Mass Index
Patient Health Assessment Report	 206

Number of Patients 3 - 17 Years with BMI Percentile 
Reading

Clinical Quality Measures List	 66
Number of Patients 65+ Years with Abnormal BMI 
Reading and Follow Up

Clinical Quality Measures List	 66
Bone Loss

Bone Loss
Perio - Data Chart Report	 240
Perio - Combined Graphic & Data Chart Report	
238

Break Appointment Reason
Reason Appointment Broken

Unscheduled Appointment List (DX1)	 356
Broken

Percent Broken Appointments
Appointment Statistics Report	 20

Broken Appointment
Date Appointment Broken

Unscheduled Appointment List (OM)	 358
Unscheduled Appointment List (DX1)	 356

Number of Broken Appointments
Appointment Statistics Report	 20

Calculation
Co-pay Calculation for Insurance Portion

Insurance Coverage Tables Report	 150
Co-pay Used in Calculations

Insurance Coverage Tables Report	 150
Call

Best Time to Call
Collections Manager List	 70

Best Time to Call Patient
Patient Questionnaire	 222

Best Time to Call Spouse
Patient Questionnaire	 222

Cardholder
Cardholder Name

Credit Card Transaction Report	 80
Caries

Percent of Caries Free Patients
Caries Prevalence and Periodontal Index Report	
52

Birth Date (continued)
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Percent of Patients with Caries History
Caries Prevalence and Periodontal Index Report	
52

Caries Risk
Number of Patients with Moderate to High Risk of Car-
ies

UDS - Sealant Statistics Report	 352
Number of Patients with Moderate to High Risk of Car-
ies for Provider

UDS - Sealant Statistics Report	 352
Number of Patients with Moderate to High Risk of Car-
ies in Clinic

UDS - Sealant Statistics Report	 352
Number of Patients with Moderate to High Risk of Car-
ies in ZIP Code

UDS - Sealant Statistics Report	 352
Number of Patients with Moderate to High Risk of Car-
ies who Got Sealants on Permanent First Molars

UDS - Sealant Statistics Report	 352
Number of Patients with Moderate to High Risk of 
Caries who Got Sealants on Permanent First Molars for 
Provider

UDS - Sealant Statistics Report	 352
Number of Patients with Moderate to High Risk of 
Caries who Got Sealants on Permanent First Molars in 
Clinic

UDS - Sealant Statistics Report	 352
Number of Patients with Moderate to High Risk of Car-
ies who Got Sealants on Permanent First Molars in ZIP 
Code

UDS - Sealant Statistics Report	 352
Case

Alternate Case Name
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Office Portion for Case
Patient Treatment Case Report	 228

Amount of Patient Portion for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Amount of Primary Insurance Portion for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Amount of Secondary Insurance Portion for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Case Amount
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Case Comments
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Case Expiration Date
Practice Treatment Case Report	 258

Case Finance Status
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Case Name
Patient Treatment Case Report	 228
Practice Treatment Case Report	 258
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Case Notes
Treatment Case Report	 326
Patient Treatment Case Report	 228

Case Priority
Patient Treatment Case Report	 228

Case Severity
Practice Treatment Case Report	 258

Case Status
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Date of Last Case Status Update
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Fee for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Lab Case Note
Patient Notes Report	 216

Percent of Accepted Cases
Practice Treatment Case Report	 258

Percent of Completed Cases
Practice Treatment Case Report	 258

Percent of Pre-authorized Cases
Practice Treatment Case Report	 258

Percent of Referred Cases
Practice Treatment Case Report	 258

Percent of Scheduled Cases
Practice Treatment Case Report	 258

Total Amount of Patient Portion for Case
Treatment Case Report	 326

Total Amount of Primary Insurance Portion for Case
Treatment Case Report	 326

Total Amount of Secondary Insurance Portion for Case
Treatment Case Report	 326

Total Case Amount
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Total Fee for Case
Treatment Case Report	 326

Total Fee from Alternate Fee Schedule for Case
Treatment Case Report	 326

Total Number of Cases
Practice Treatment Case Report	 258

Case Status
Case Status

Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Date of Last Case Status Update
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Cash
Total Amount of Cash Payments

Operator Day Sheet Report	 194
Cavities

Number of Patients 0 - 19 Years with Tooth Decay or 
Cavities

Clinical Quality Measures List	 66

Caries (continued)
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Change
Appointment Amount Change

Audit Report - Appointments	 26
Appointment Date Change

Audit Report - Appointments	 26
Appointment Length Change

Audit Report - Appointments	 26
Appointment Production Type Change

Audit Report - Appointments	 26
Appointment Provider Change

Audit Report - Appointments	 26
Appointment Status Change

Audit Report - Appointments	 26
Appointment Time Change

Audit Report - Appointments	 26
Appointment Type Change

Audit Report - Appointments	 26
Bank Account Number Change

Audit Report - Clinics	 30
Billing Type Change

Audit Report - Patients	 34
Change of Address

Coupon Book - Payment Agreements	 79
Coupon Book - Future Due Payments	 78

Check Number Change
Audit Report - Transactions	 38

Clinic Change
Audit Report - Patients	 34
Audit Report - Providers/Staff	 36
Audit Report - Clinics	 30

Clinic Number Change
Audit Report - Transactions	 38

Date of Change
Audit Report - Audit Log Status	 28
Audit Report - Clinics	 30
Audit Report - Combined	 32
Audit Report - Patients	 34
Audit Report - Providers/Staff	 36
Audit Report - Transactions	 38
Audit Rights Report - Assigned Individually	 40
Audit Rights Report - Assigned to Groups	 42
Audit Rights Report - Group Names	 44
Audit Rights Report - Users to Groups	 46
Audit Report - Appointments	 26

Date of Last Case Status Update
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Deleted Appointment
Audit Report - Appointments	 26

Deleted Entry
Audit Report - Patients	 34

Deleted Procedure
Audit Report - Combined	 32

Deleted Transaction
Audit Report - Transactions	 38

Encounter Number Change
Audit Report - Transactions	 38

Fiscal Year Month Change
Audit Report - Clinics	 30

Guarantor Name Change
Audit Report - Patients	 34

Login Name Change
Audit Report - Providers/Staff	 36

Operatory Change
Audit Report - Appointments	 26

Other ID Change
Audit Report - Patients	 34

Patient Name Change
Audit Report - Patients	 34
Audit Report - Transactions	 38
Audit Report - Appointments	 26

Patient Social Security Number or Request Date 
Change

Audit Report - Patients	 34
Patient Status Change

Audit Report - Patients	 34
Perio Measurement Change

Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Practice Change
Audit Report - Clinics	 30

Practice Title Change
Audit Report - Clinics	 30

Primary Provider ID Change
Audit Report - Patients	 34

Procedure Date Change
Audit Report - Transactions	 38

Provider Class Change
Audit Report - Providers/Staff	 36

Provider Fee Schedule Change
Audit Report - Providers/Staff	 36

Provider ID Change
Audit Report - Transactions	 38
Audit Report - Providers/Staff	 36

Provider Name Change
Audit Report - Providers/Staff	 36

Provider Social Security Number Change
Audit Report - Providers/Staff	 36

Record Type Change
Audit Report - Patients	 34
Audit Report - Transactions	 38
Audit Rights Report - Assigned Individually	 40
Audit Rights Report - Assigned to Groups	 42
Audit Rights Report - Group Names	 44
Audit Rights Report - Users to Groups	 46
Audit Report - Combined	 32

Staff Social Security Number Change
Audit Report - Providers/Staff	 36

Time of Change
Audit Report - Appointments	 26
Audit Report - Audit Log Status	 28
Audit Report - Clinics	 30
Audit Report - Combined	 32
Audit Report - Patients	 34
Audit Report - Providers/Staff	 36
Audit Report - Transactions	 38
Audit Rights Report - Assigned Individually	 40
Audit Rights Report - Assigned to Groups	 42
Audit Rights Report - Group Names	 44
Audit Rights Report - Users to Groups	 46
Appointment Cycle Time Report	 16
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Transaction Amount Change
Audit Report - Transactions	 38

Transaction Description Change
Audit Report - Transactions	 38

User Changed
Audit Rights Report - Users to Groups	 46
Audit Rights Report - Assigned Individually	 40

User Group Change
Audit Rights Report - Group Names	 44

Charge
Amount of Charge Adjustments for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Charge Adjustments for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Amount of Charge Adjustments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Charges
Future Due Payment Plan Report - Monthly Totals	
132
Procedures by Contracted Amount Report	 268
Provider A/R Totals - Daily Report	 276
Daily Summary Report	 88

Amount of Charges Billed to Insurance for Previous 
Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Charges for Clinic

Day Sheet Report	 100
Amount of Charges for Patient

UDS - Patient Related Revenue Report	 348
Amount of Charges for Previous Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Charges for Provider

Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Day Sheet Report	 100

Amount of Current Charge Adjustments for Provider
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Amount of Current Charges
Walkout - Family Walkout	 370

Amount of Current Charges Billed to Insurance for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Current Charges Compared to Fee Schedule 
for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Current Finance Charges for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Current Late Charges for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Finance Charges

Provider A/R Totals - Daily Report	 276
Amount of Finance Charges (Average)

Practice Analysis Report	 252

Amount of Finance Charges (for Date Range)
Practice Analysis Report	 252

Amount of Finance Charges (MTD)
Practice Analysis Report	 252

Amount of Finance Charges (YTD)
Practice Analysis Report	 252

Amount of Finance Charges for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Finance Charge Report	 130
Analysis Summary Report - Daily	 8

Amount of Finance Charges for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Finance Charges for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Finance Charge Report	 130
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Finance Charges YTD
Walkout - Family Walkout	 370

Amount of Insured Charges (Average)
Practice Analysis Report	 252

Amount of Insured Charges (for Date Range)
Practice Analysis Report	 252

Amount of Insured Charges (MTD)
Practice Analysis Report	 252

Amount of Insured Charges (YTD)
Practice Analysis Report	 252

Amount of Late Charges
Provider A/R Totals - Daily Report	 276

Amount of Late Charges (Average)
Practice Analysis Report	 252

Amount of Late Charges (for Date Range)
Practice Analysis Report	 252

Amount of Late Charges (MTD)
Practice Analysis Report	 252

Amount of Late Charges (YTD)
Practice Analysis Report	 252

Amount of Late Charges for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Late Charge Report	 156
Analysis Summary Report - Daily	 8

Amount of Late Charges for Previous Month for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of Late Charges for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Late Charge Report	 156
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Late Charges YTD
Walkout - Family Walkout	 370

Amount of MTD Charges Billed to Insurance for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94

Change (continued)
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Amount of MTD Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of MTD Finance Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of MTD Late Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of Non-insured Charges (Average)
Practice Analysis Report	 252

Amount of Non-insured Charges (for Date Range)
Practice Analysis Report	 252

Amount of Non-insured Charges (MTD)
Practice Analysis Report	 252

Amount of Non-insured Charges (YTD)
Practice Analysis Report	 252

Amount of YTD Charge Adjustments for Provider
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Charges Billed to Insurance for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Finance Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Late Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Average Amount of Finance Charges
Day Sheet (Adjustments) Report	 90

Average Amount of Late Charges
Day Sheet (Adjustments) Report	 90

Average Charge per Patient
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Charge per Patient for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Charge per Patient for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Charge per Patient MTD
Day Sheet (Charges and Receipts) Report	 94

Average Charge per Patient MTD for Provider
Day Sheet (Charges and Receipts) Report	 94

Average Monthly Charge Amount
Future Due Payment Plan Report - Monthly Totals	
132

Average Number of Charges
Future Due Payment Plan Report - Monthly Totals	
132

Charge
Procedures by Contracted Amount Report	 268
Billing Statement	 48

Charge Amount
Analysis Summary Report - Standard	 12
Day Sheet (Charges and Receipts) Report	 94
Day Sheet Report	 100
Family Ledger Report	 124
Family Ledger Report (Single Family)	 126

Insurance Transaction Analysis Report	 154
Operator Day Sheet Report	 194
Patient Ledger Report	 210
Patient’s Ledger Report	 230
Walkout - Doctor’s Statement	 368
Walkout - Family Walkout	 370
Analysis Summary Report - Daily	 8

Charges for Clinic
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Charges for Provider
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Current Average Charge per Patient
Day Sheet (Charges and Receipts) Report	 94

Current Average Charge per Patient for Provider
Day Sheet (Charges and Receipts) Report	 94

Current Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Finance Charge Amount
Analysis Summary Report - Daily	 8
Analysis Summary Report - Standard	 12
Finance Charge Report	 130
Adjustment Summary Report	 4

Finance Charge Date
Finance Charge Report	 130

Finance Charge Percent
Payment Agreement Report	 234

Grand Total Amount of Charge Adjustments
Insurance Transaction Analysis Report	 154

Grand Total Amount of Insured Charges
Insurance Transaction Analysis Report	 154

Grand Total Number of Charge Adjustments
Insurance Transaction Analysis Report	 154

Grand Total Number of Insured Charges
Insurance Transaction Analysis Report	 154

Last Late Charge Amount
Payment Agreement Report	 234

Last Late Charge Date
Payment Agreement Report	 234

Late Charge Amount
Analysis Summary Report - Daily	 8
Analysis Summary Report - Standard	 12
Late Charge Report	 156
Adjustment Summary Report	 4

Late Charge Date
Late Charge Report	 156

Late Charge Percent or Amount
Truth in Lending Disclosure Statement	 332

Monthly Charge Amount
Future Due Payment Plan Report - Standard	 134

Net Difference of Current Charges and Fee Schedule 
for Provider

Day Sheet (Charges and Receipts) Report	 94
Net Difference of Total Current Charges and Fee 
Schedule

Day Sheet (Charges and Receipts) Report	 94
Next Charge Amount (after 18 Months from Current 
Month)

Future Due Payment Plan Report - Monthly Totals	
132

Charge (continued)
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Number of Charges
Future Due Payment Plan Report - Monthly Totals	
132

Subtotal of Charges (Average)
Practice Analysis Report	 252

Subtotal of Charges (for Date Range)
Practice Analysis Report	 252

Subtotal of Charges (MTD)
Practice Analysis Report	 252

Subtotal of Charges (YTD)
Practice Analysis Report	 252

Subtotal of Charges for Financial Class Type
UDS - Patient Related Revenue Report	 348

Subtotal of Charges for Payer Category
UDS - Patient Related Revenue Report	 348

Total Amount of Charge Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Insurance Transaction Analysis Report	 154
Operator Day Sheet Report	 194
Analysis Summary Report - Daily	 8

Total Amount of Charge Adjustments for Previous 
Month

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Charges
Day Sheet Report	 100
Future Due Payment Plan Report - Monthly Totals	
132
Operator Day Sheet Report	 194
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Total Amount of Charges Billed to Insurance for Previ-
ous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Charges for Financial Class Type

UDS - Patient Related Revenue Report	 348
Total Amount of Charges for Patient

UDS - Patient Related Revenue Report	 348
Total Amount of Charges for Payer Category

UDS - Patient Related Revenue Report	 348
Total Amount of Charges for Previous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Charges for Today’s Completed Work

Patient Chart Printout	 204
Total Amount of Charges Remaining (after 18 Mos from 
Curr Mo)

Future Due Payment Plan Report - Monthly Totals	
132

Total Amount of Current Charge Adjustments
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Charges Billed to Insurance
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Charges Compared to Fee 
Schedule

Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Finance Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Late Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Finance Charges
Analysis Summary Report - Daily	 8
Analysis Summary Report - Standard	 12
Day Sheet (Adjustments) Report	 90
Day Sheet Report	 100
Finance Charge Report	 130
Operator Day Sheet Report	 194
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Truth in Lending Disclosure Statement	 332
Adjustment Summary Report	 4

Total Amount of Finance Charges for Previous Month
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Insured Charges
Insurance Transaction Analysis Report	 154

Total Amount of Late Charges
Analysis Summary Report - Daily	 8
Analysis Summary Report - Standard	 12
Day Sheet (Adjustments) Report	 90
Day Sheet Report	 100
Late Charge Report	 156
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Adjustment Summary Report	 4

Total Amount of Late Charges for Previous Month
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Charge Adjustments
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Charges Billed to Insurance
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Finance Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Late Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Charge Adjustments
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Charges Billed to Insurance
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Finance Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Finance Charges for Family
Family Ledger Report (Single Family)	 126

Total Amount of YTD Late Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Late Charges for Family
Family Ledger Report (Single Family)	 126
Family Ledger Report	 124

Total Average Charge per Patient
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Charge for Date of Service
Letter Merge Reports	 158

Charge (continued)
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Total Charges
Patient Revenue List by Payer Report	 224
Analysis Summary Report - Standard	 12

Total Charges (Average)
Practice Analysis Report	 252

Total Charges (for Date Range)
Practice Analysis Report	 252

Total Charges (MTD)
Practice Analysis Report	 252

Total Charges (YTD)
Practice Analysis Report	 252

Total Medicaid Charge
Operator Day Sheet Report	 194

Total Monthly Charges
Future Due Payment Plan Report - Standard	 134

Total Number of Charge Adjustments
Insurance Transaction Analysis Report	 154

Total Number of Charges
Future Due Payment Plan Report - Monthly Totals	
132

Total Number of Charges Remaining (after 18 Mos from 
Curr Mo)

Future Due Payment Plan Report - Monthly Totals	
132

Total Number of Insured Charges
Insurance Transaction Analysis Report	 154

Total Quantity of Finance Charges
Day Sheet (Adjustments) Report	 90

Total Quantity of Late Charges
Day Sheet (Adjustments) Report	 90

Total YTD Finance Charges for Family
Family Ledger Report	 124

Charge Adjustment
Amount of MTD Charge Adjustments for Provider

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Charge Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Grand Total Amount of Charge Adjustments
Insurance Transaction Analysis Report	 154

Grand Total Number of Charge Adjustments
Insurance Transaction Analysis Report	 154

Total Amount of Charge Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Insurance Transaction Analysis Report	 154
Operator Day Sheet Report	 194
Analysis Summary Report - Daily	 8

Total Amount of Charge Adjustments for Previous 
Month

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Charge Adjustments
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Charge Adjustments
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Charge Adjustments
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Total Number of Charge Adjustments
Insurance Transaction Analysis Report	 154

Chart
Clinical Attachment Level Graphic Chart

Perio - Exam Comparison Report	 242
Dental Chart

Patient Chart Printout	 204
Patient Chart and Progress Notes Printout	 202

Gingival Margin Graphic Chart
Perio - Exam Comparison Report	 242

Graphical Chart
Treatment Case Report	 326

Paint Type
Procedure Code List	 266
Dental Diagnostic Code List	 104

Perio Exam Comparison Data Chart
Perio - Combined Graphic & Data Chart Report	
238

Perio Exam Comparison Graphic Chart
Perio - Combined Graphic & Data Chart Report	
238

Perio Exam Graphic Chart
Perio - Combined Graphic & Data Chart Report	
238

Perio Graphic Chart
Perio - Graphic Chart Report	 244

Chart Number
Chart Number

Appointment Cycle Time Report	 16
Patient Revenue List by Payer Report	 224
Patient’s Ledger Report	 230
Procedures by Contracted Amount Report	 268
Appointment Book View Printout	 14

Guarantor Chart Number
Collections Manager List	 70
Family Ledger Report	 124
Family Ledger Report (Single Family)	 126
Payment Agreement Amortization Schedule	 232
Truth in Lending Disclosure Statement	 332
Walkout - Family Walkout	 370
Billing Statement	 48

Patient Chart Number
Clinical Notes Report	 64
Coupon Book - Future Due Payments	 78
Coupon Book - Payment Agreements	 79
Day Sheet (Adjustments) Report	 90
Day Sheet (Receipts) Report	 98
Employers and Employed Patients Report	 122
Insurance Carrier List	 138
Insurance Eligibility Report	 152
Letter Merge Reports	 158
Operator Day Sheet Report	 194
Patient Chart and Progress Notes Printout	 202
Patient Chart Printout	 204
Patient Information Accessed Report	 208
Patient Ledger Report	 210
Patient List	 212
Patient List (Filtered)	 214
Patient Notes Report	 216

Charge (continued)
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Patient Proposed Treatment Case Report (Your 
Care Plan)	 220
Patient Route Slip	 226
Patient Treatment Case Report	 228
Perio - Exam Comparison Report	 242
Perio - Graphic Chart Report	 244
Practice Treatment Case Report	 258
RVU Day Sheet Report	 308
Treatment Case Report	 326
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
UDS - Age/Gender Report	 334
UDS - Insurance Financial Class Report	 342
UDS - Insurance Financial Class Report (2013)	344
UDS - Medicaid/Medicare Report	 346
UDS - Patient Status Report	 350
UDS - Sealant Statistics Report	 352
UDS - Tobacco Use and Intervention Report	 354
Walkout - Doctor’s Statement	 368
Audit Report - Combined	 32

Subscriber Chart Number
Insurance Carrier List	 138

Check
Total Amount of Check Payments

Operator Day Sheet Report	 194
Check Number

Check Number
Coupon Book - Future Due Payments	 78
Coupon Book - Payment Agreements	 79
Deposit Slip	 108
Audit Report - Transactions	 38

Check Number Change
Audit Report - Transactions	 38

Checklist
Appointment Checklist Items

Custom Practice Information Report	 82
Child

Number or Child Patients
Practice Statistics Report	 256

Percent or Child Patients
Practice Statistics Report	 256

City
Guarantor City

Collections Manager List	 70
Insurance Carrier City and State

Insurance Eligibility Report	 152
Patient City

Patient List (Filtered)	 214
Letter Merge Reports	 158

Practice City
Registration Information Report	 306

Practice City State and ZIP Code
Letter Merge Reports	 158

Claim
Amount of Claim

Insurance Claims Not Sent Report	 148
Claim Amount

Secondary Insurance Claims Not Created Report	
318
Insurance Transaction Analysis Report	 154

Claim Date
Insurance Claims Not Sent Report	 148

Claim Expiration Date
Procedures Not Attached to Insurance Report	270
Secondary Insurance Claims Not Created Report	
318
Insurance Claims Not Sent Report	 148

Claim Format
Insurance Carrier List	 138

Claim On Hold Date
Insurance Claim Aging Report	 146

Claim Payment Received Date
Insurance Transaction Analysis Report	 154

Claim Re-sent Date
Insurance Claim Aging Report	 146

Claim Sent Date
Insurance Transaction Analysis Report	 154
Insurance Claim Aging Report	 146

Claim Tracer Date
Insurance Claim Aging Report	 146

Do not Print Dental Diagnostic Codes on Claim
Insurance Carrier List	 138

Grand Total Number of Insurance Claims Sent
Insurance Transaction Analysis Report	 154

Grand Total Number of Paid/Received Claims
Insurance Transaction Analysis Report	 154

Insurance Claim Note
Patient Notes Report	 216

Pending Claims
Patient Route Slip	 226

Primary Claim Date
Secondary Insurance Claims Not Created Report	
318

Remarks for Unusual Service
Walkout - Doctor’s Statement	 368

Rendering Provider NPI Number
Dental Encounters Report	 106

Replace Initial Zero of Procedure Code on Claims
Insurance Carrier List	 138

Total Amount of Account Balances Aged 1 - 30 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 1 - 30 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 1 - 30 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 121 - 150 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 121 - 150 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 121 - 150 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 151 - 180 with 
Claims

Insurance Claim Aging Report	 146

Chart Number (continued)
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Total Amount of Account Balances Aged 151 - 180 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 151 - 180 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 181+ with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 181+ with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 181+ with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 31 - 60 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 31 - 60 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 31 - 60 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 61 - 90 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 61 - 90 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 61 - 90 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 91 - 120 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 91 - 120 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 91 - 120 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Primary Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances with Secondary 
Claims

Insurance Claim Aging Report	 146
Total Amount of Estimated Insurance Portion for Pri-
mary and Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Estimated Insurance Portion for Pri-
mary Claims

Insurance Claim Aging Report	 146

Total Amount of Estimated Insurance Portion for Sec-
ondary Claims

Insurance Claim Aging Report	 146
Total Amount of Primary and Secondary Claims not Sent

Insurance Claims Not Sent Report	 148
Total Amount of Primary Claims not Sent

Insurance Claims Not Sent Report	 148
Total Amount of Secondary Claims not Created

Secondary Insurance Claims Not Created Report	
318

Total Amount of Secondary Claims not Sent
Insurance Claims Not Sent Report	 148

Total Number of Insurance Claims Sent
Insurance Transaction Analysis Report	 154

Total Number of Paid/Received Claims
Insurance Transaction Analysis Report	 154

Clinic
20+ Years Old for Financial Class Type for Clinic

UDS - Insurance Financial Class Report	 342
Account Clinic

Collections Manager List	 70
Aged Amount 0 - 30 for Clinic

Aging/Credit Balance Report	 6
Aged Amount 121 - 150 for Clinic

Aging/Credit Balance Report	 6
Aged Amount 151 - 180 for Clinic

Aging/Credit Balance Report	 6
Aged Amount 31 - 60 for Clinic

Aging/Credit Balance Report	 6
Aged Amount 61 - 90 for Clinic

Aging/Credit Balance Report	 6
Aged Amount 90 - 120 for Clinic

Aging/Credit Balance Report	 6
Aged Amount Over 180 for Clinic

Aging/Credit Balance Report	 6
Amount Billed to Insurance for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Applied Credit Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Applied Insurance Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Applied Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Beginning Balances for Clinic
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Charge Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Charges for Clinic
Day Sheet Report	 100
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Amount of Credit Initial Balances for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Credit Special Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Debit Initial Balances for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Debit Special Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Ending Balances for Clinic
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Finance Charges for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Finance Charge Report	 130
Analysis Summary Report - Daily	 8

Amount of Lab Expenses for Clinic
RVU Day Sheet Report	 308

Amount of Lab Expenses for Medicaid Procedures for 
Clinic

RVU Production Summary Report	 310
Amount of Lab Expenses of Non-Medicaid Procedures 
for Clinic

RVU Production Summary Report	 310
Amount of Lab Expenses of Procedures for Clinic

RVU Production Summary Report	 310
Amount of Late Charges for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Late Charge Report	 156
Analysis Summary Report - Daily	 8

Amount of Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Amount of Net Change for Clinic
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Non-Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Amount of Other Applied Credit Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Credit Initial Balances for 
Clinic

Day Sheet Report	 100
Amount of Other Applied Credit Special Adjustments 
for Clinic

Day Sheet Report	 100

Amount of Other Applied Insurance Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Credit Initial Balances for Clinic
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Other Credit Special Adjustments for Clinic
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Amount of Suspended Credit Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Insurance Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Amount of Adjustments for Clinic
Day Sheet (Adjustments) Report	 90

Average Amount of Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Non-Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Average Charge per Patient for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Payment Amount for Clinic
Day Sheet (Receipts) Report	 98

Average Production per Patient at Clinic from Referral 
Source

Referral Analysis Report	 294
Average Production per Patient for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Balance (as of a Date) for Clinic
Day Sheet Report	 100

Charges for Clinic
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Clinic
Analysis Summary Report - Daily	 8
Analysis Summary Report - Standard	 12
Appointment Cycle Time Report	 16

Clinic (continued)
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Assigned Rights Report	 24
Audit Report - Clinics	 30
Audit Report - Combined	 32
Audit Report - Patients	 34
Audit Report - Providers/Staff	 36
Audit Rights Report - Assigned Individually	 40
Continuing Care Display List	 76
Day Sheet (Adjustments) Report	 90
Day Sheet (Adjustments) Report	 90
Day Sheet (Receipts) Report	 98
Day Sheet Report	 100
Day Sheet Report	 100
Deposit Slip	 108
Deposit Slip	 108
Document Center - Documents List Report	 112
Document Center Document	 116
Document Center Documents Audited Report	
118
Document Center List	 120
Finance Charge Report	 130
Finance Charge Report	 130
Initial Health History Report	 136
Insurance Carrier Production - Full Report	 142
Insurance Claims Not Sent Report	 148
Insurance Transaction Analysis Report	 154
Late Charge Report	 156
Late Charge Report	 156
Operator Day Sheet Report	 194
Oral Health Education Report	 198
Patient Health Assessment Report	 206
Patient List	 212
Patient List (Filtered)	 214
Patient Revenue List by Payer Report	 224
Periodontal Exam Report	 250
Practice Organization List	 254
Pre-Treatment Estimates Not Sent Report	 264
Procedures by Contracted Amount Report	 268
Procedures Not Attached to Insurance Report	270
Production Summary Report	 272
Provider IDs List	 284
Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Referral Analysis Report	 294
RVU Day Sheet Report	 308
RVU Production Summary Report	 310
RVU Utilization Report	 316
Suspended Credits Report	 324
UDS - Age/Gender Report	 334
UDS - Insurance Financial Class Report	 342
UDS - Insurance Financial Class Report (2013)	344
UDS - Medicaid/Medicare Report	 346
UDS - Patient Status Report	 350
UDS - Sealant Statistics Report	 352
UDS - Tobacco Use and Intervention Report	 354
Utilization Report	 366
Aging/Credit Balance Report	 6

Clinic Change
Audit Report - Patients	 34
Audit Report - Providers/Staff	 36

Audit Report - Clinics	 30
Clinic Number

Audit Report - Transactions	 38
Clinic Number Change

Audit Report - Transactions	 38
Clinic of Access

Patient Information Accessed Report	 208
Clinic TIN Number

Provider IDs List	 284
Clinical Note Clinic

Clinical Notes Report	 64
File Location

Document Center - Documents List Report	 112
Net RVU for Clinic

RVU Day Sheet Report	 308
Net RVU of Medicaid Procedures for Clinic

RVU Production Summary Report	 310
Net RVU of Non-Medicaid Procedures for Clinic

RVU Production Summary Report	 310
Net RVU of Procedures for Clinic

RVU Production Summary Report	 310
Number <19 Years Old for Financial Class Type for 
Clinic

UDS - Insurance Financial Class Report	 342
Number of All Genders for Clinic

UDS - Age/Gender Report	 334
Number of Charts Sampled in Clinic

UDS - Sealant Statistics Report	 352
Number of Females for Clinic

UDS - Age/Gender Report	 334
Number of Incorrect Location Errors

Document Center Audit Documents Report	 114
Number of Males for Clinic

UDS - Age/Gender Report	 334
Number of Medicaid and Medicare Patients at Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in First Age 
Group at Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group at Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients at Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in First Age Group at 
Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in Second Age Group at 
Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients at Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in First Age Group at 
Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in Second Age Group at 
Clinic

UDS - Medicaid/Medicare Report	 346
Number of New Patients for Clinic

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Clinic (continued)
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Number of Other Gender for Clinic
UDS - Age/Gender Report	 334

Number of Patients at Clinic from Referral Source
Referral Analysis Report	 294

Number of Patients Seen at Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Number of Patients with Moderate to High Risk of Car-
ies in Clinic

UDS - Sealant Statistics Report	 352
Number of Patients with Moderate to High Risk of 
Caries who Got Sealants on Permanent First Molars in 
Clinic

UDS - Sealant Statistics Report	 352
Number of Patients with Status for Clinic

UDS - Patient Status Report	 350
Number of Unknown Gender for Clinic

UDS - Age/Gender Report	 334
Number of Users for Financial Class Type for Clinic

UDS - Insurance Financial Class Report	 342
Patient Clinic

Patient List (Filtered)	 214
Percent of Medicaid Procedures for Clinic

RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Non-Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Previous Balance for Clinic
Day Sheet Report	 100

Production at Clinic from Referral Source
Referral Analysis Report	 294

Quantity of Adjustments for Clinic
Day Sheet (Adjustments) Report	 90

Quantity of Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Quantity of Non-Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Quantity of Payments for Clinic
Day Sheet (Receipts) Report	 98

Quantity of Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

RVU for Clinic
RVU Day Sheet Report	 308

Suspended Credit Amount for Clinic
Aging/Credit Balance Report	 6

Total Amount of Adjustments for Clinic
Day Sheet (Adjustments) Report	 90

Total Amount of Payment Type for Clinic
Deposit Slip	 108

Total Amount of Payments for Clinic
Day Sheet (Receipts) Report	 98

Total Amount of Suspended Credits for Clinic
Suspended Credits Report	 324

Total Average Production per Patient at Clinics from 
Referral Source

Referral Analysis Report	 294
Total Denominator Codes for All Clinics

Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Total Denominator Codes for Clinic
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Total Number of Incorrect Location Errors
Document Center Audit Documents Report	 114

Total Number of New Patients for Clinic
Day Sheet Report	 100

Total Number of Patients at Clinics from Referral Source
Referral Analysis Report	 294

Total Number of Payment Type Items for Clinic
Deposit Slip	 108

Total Numerator Codes for All Clinics
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Total Numerator Codes for Clinic
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Total Percent for All Clinics
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Total Percent for Clinic
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Total Production at Clinics from Referral Source
Referral Analysis Report	 294

Clinical Attachment Level
Clinical Attachment Level

Perio - Data Chart Report	 240
Perio - Combined Graphic & Data Chart Report	
238

Clinical Attachment Level (Facial)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Clinical Attachment Level (Lingual)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Clinical Attachment Level Graphic Chart
Perio - Exam Comparison Report	 242

Clinical Information
Number of TCs (Transition of Care) and Referrals where 
Clinical Information Reconciliation Was Performed

Meaningful Use Measure Calculation List	 162
Clinical Note

Clinical Note
Patient Notes Report	 216
Patient Chart and Progress Notes Printout	 202
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Clinical Note Clinic
Clinical Notes Report	 64

Clinical Note Date
Patient Notes Report	 216
Clinical Notes Report	 64

Clinical Note Number
Clinical Notes Report	 64

Clinical Note Page Number
Clinical Notes Report	 64

Clinical Note Provider
Clinical Notes Report	 64

Clinical Note Status
Clinical Notes Report	 64

Clinical Note Text
Clinical Notes Report	 64

Clinical Note Time
Clinical Notes Report	 64

Number of Patients with Searchable Clinical Notes
Meaningful Use Measure Calculation List	 162

Clinical Summary
Number of Office Visits where Patient Received CS 
(Clinical Summary)

Meaningful Use Measure Calculation List	 162
Co-Pay

Amount of Co-pays for Insurance Carrier
Utilization Report	 366

Amount of Fees - Co-pays for Insurance Carrier
Utilization Report	 366

Co-pay Amount
Standard Coverage Tables Report	 322
Utilization Report	 366
Insurance Coverage Tables Report	 150

Co-pay Calculation for Insurance Portion
Insurance Coverage Tables Report	 150

Co-pay Used in Calculations
Insurance Coverage Tables Report	 150

Total Amount of Co-pays
Utilization Report	 366

Total Amount of Fees - Co-pays
Utilization Report	 366

Code
ADA Code

Day Sheet (Charges and Receipts) Report	 94
Dental Encounters Report	 106
Fee Schedules Report	 128
Insurance Carrier Production - Full Report	 142
Multi-Code List	 188
Operator Day Sheet Report	 194
Patient Chart and Progress Notes Printout	 202
Patient List (Filtered)	 214
Patient Treatment Case Report	 228
Practice Treatment Case Report	 258
Procedure Code List	 266
Procedures by Contracted Amount Report	 268
Procedures Not Attached to Insurance Report	270
Production Summary Report	 272
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288

Provider Revenue - Credits Report	 290
RVU Day Sheet Report	 308
RVU Production Summary Report	 310
RVU Schedules Report	 314
RVU Utilization Report	 316
Standard Coverage Tables Report	 322
Treatment Case Report	 326
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Unscheduled Treatment Plans (Detailed) Report	
362
Updated Dental Insurance Payment Table Report	
364
Utilization Report	 366
Walkout - Doctor’s Statement	 368
Appointment Cycle Time Report	 16

ADA Code Abbreviated Description
Procedure Code List	 266
Multi-Code List	 188

ADA Code Description
Fee Schedules Report	 128
Insurance Carrier Production - Full Report	 142
Multi-Code List	 188
Patient Chart and Progress Notes Printout	 202
Patient Ledger Report	 210
Patient Treatment Case Report	 228
Practice Treatment Case Report	 258
Procedure Code List	 266
Procedures by Contracted Amount Report	 268
Procedures Not Attached to Insurance Report	270
Production Summary Report	 272
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
RVU Day Sheet Report	 308
RVU Production Summary Report	 310
RVU Schedules Report	 314
RVU Utilization Report	 316
Treatment Case Report	 326
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Unscheduled Treatment Plans (Detailed) Report	
362
Utilization Report	 366
Walkout - Doctor’s Statement	 368
Walkout - Family Walkout	 370
Day Sheet (Charges and Receipts) Report	 94

ADA Code Description for Today’s Completed Work
Patient Chart Printout	 204

ADA Code Description for Treatment-planned Proce-
dure

Patient Chart Printout	 204
ADA Code Description of Completed Treatment

Referral Recap Report	 296
ADA Code Description of Treatment Still in Progress

Referral Recap Report	 296
ADA Code Description of Treatment-planned Proce-
dure

Referral Slip	 298

Clinical Note (continued)
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ADA Code Description or Transaction Description
Operator Day Sheet Report	 194

ADA Code of Completed Treatment
Referral Recap Report	 296

ADA Code of Treatment Still in Progress
Referral Recap Report	 296

ADA Code of Treatment-planned Procedure
Referral Slip	 298

Alternate ADA Code
Procedure Code List	 266
Insurance Carrier List	 138

AMA CPT Code
Procedure Code List	 266
Medical Code List	 186

AMA CPT Code Description
Medical Code List	 186

Beginning ADA Code
Insurance Coverage Tables Report	 150

CPT Code
Procedure Code List	 266

Dental Diagnostic Code
Multi-Code List	 188
Procedure Code List	 266
Dental Diagnostic Code List	 104

Dental Diagnostic Code Description
Dental Diagnostic Code List	 104

ICD-9-CM Code
Patient List (Filtered)	 214
Medical Code List	 186

ICD-9-CM Code Description
Medical Code List	 186

Medical Code
Procedure Code List	 266

Modifier Code
Medical Code List	 186

Modifier Code Description
Medical Code List	 186

Next Appointment ADA Code
Patient Route Slip	 226

Next Appointment ADA Code Description
Patient Route Slip	 226

Place of Service Code
Medical Code List	 186

Place of Service Code Description
Medical Code List	 186

Replace Initial Zero of Procedure Code on Claims
Insurance Carrier List	 138

Tooth Code
Perio - Data Chart Report	 240
Perio - Pocket Depths Only Report	 246
Perio - Combined Graphic & Data Chart Report	
238

Transaction Type/Code
Insurance Transaction Analysis Report	 154

Type of Service Code
Medical Code List	 186

Type of Service Code Description
Medical Code List	 186

Collections
Amount Collected for Patient

UDS - Patient Related Revenue Report	 348
Amount of - Adjustments (Collection)

Provider A/R Totals - Daily Report	 276
Amount of - Adjustments (Collection) for Provider

Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of + Adjustments (Collection)
Provider A/R Totals - Daily Report	 276

Amount of + Adjustments (Collection) for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Collection
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Collection Adjustments
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Collection Amount
Provider A/R Totals - Daily Report	 276

Collection Amount for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Other Retroactive Payment Amount Collected for 
Patient

UDS - Patient Related Revenue Report	 348
Penalty or Payback Amount Collected for Patient

UDS - Patient Related Revenue Report	 348
Percent Collected

Provider A/R Totals - Daily Report	 276
Percent Collected for Provider

Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Subtotal of Amount Collected for Financial Class Type
UDS - Patient Related Revenue Report	 348

Subtotal of Amount Collected for Payer Category
UDS - Patient Related Revenue Report	 348

Subtotal of Other Retroactive Payment Amount Col-
lected for Financial Class Type

UDS - Patient Related Revenue Report	 348
Subtotal of Other Retroactive Payment Amount Col-
lected for Payer Category

UDS - Patient Related Revenue Report	 348
Subtotal of Penalty or Payback Amount Collected for 
Financial Class Type

UDS - Patient Related Revenue Report	 348
Subtotal of Penalty or Payback Amount Collected for 
Payer Category

UDS - Patient Related Revenue Report	 348
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Financial Class Type (Current Year)

UDS - Patient Related Revenue Report	 348
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Financial Class Type (Previous Years)

UDS - Patient Related Revenue Report	 348
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Payer Category (Current Year)

UDS - Patient Related Revenue Report	 348
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Payer Category (Previous Years)

UDS - Patient Related Revenue Report	 348

Code (continued)
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Total Amount Collected for Financial Class Type
UDS - Patient Related Revenue Report	 348

Total Amount Collected for Patient
UDS - Patient Related Revenue Report	 348

Total Amount Collected for Payer Category
UDS - Patient Related Revenue Report	 348

Total Amount of - Adjustments (Collection)
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Amount of + Adjustments (Collection)
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Collection Amount
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Other Retroactive Payment Amount Collected for 
Financial Class Type

UDS - Patient Related Revenue Report	 348
Total Other Retroactive Payment Amount Collected for 
Patient

UDS - Patient Related Revenue Report	 348
Total Other Retroactive Payment Amount Collected for 
Payer Category

UDS - Patient Related Revenue Report	 348
Total Penalty or Payback Amount Collected for Financial 
Class Type

UDS - Patient Related Revenue Report	 348
Total Penalty or Payback Amount Collected for Patient

UDS - Patient Related Revenue Report	 348
Total Penalty or Payback Amount Collected for Payer 
Category

UDS - Patient Related Revenue Report	 348
Total Percent Collected

Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Wrap Around or Reconciliation Amount Collected 
for Financial Class Type (Current Year)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Financial Class Type (Previous Years)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Patient (Current Year)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Patient (Previous Years)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Payer Category (Current Year)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Payer Category (Previous Years)

UDS - Patient Related Revenue Report	 348
Wrap Around or Reconciliation Amount Collected for 
Patient (Current Year)

UDS - Patient Related Revenue Report	 348
Wrap Around or Reconciliation Amount Collected for 
Patient (Previous Years)

UDS - Patient Related Revenue Report	 348

Comment
Comments

Document Center Audit Documents Report	 114
Comments

Case Comments
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Comparison
Amount of Current Charges Compared to Fee Schedule 
for Provider

Day Sheet (Charges and Receipts) Report	 94
Perio Exam Comparison Data Chart

Perio - Combined Graphic & Data Chart Report	
238

Perio Exam Comparison Graphic Chart
Perio - Combined Graphic & Data Chart Report	
238

Total Amount of Current Charges Compared to Fee 
Schedule

Day Sheet (Charges and Receipts) Report	 94
Completed

ADA Code Description for Today’s Completed Work
Patient Chart Printout	 204

ADA Code Description of Completed Treatment
Referral Recap Report	 296

ADA Code of Completed Treatment
Referral Recap Report	 296

Amount for Today’s Completed Work
Patient Chart Printout	 204

Amount of Completed Procedures for Patient
Procedures Not Attached to Insurance Report	270

Completed Date
Referred To Doctor Report	 304

Date of Completed Procedure
Walkout - Doctor’s Statement	 368

Date of Completed Treatment
Referral Recap Report	 296

Percent of Completed Cases
Practice Treatment Case Report	 258

Tooth Number for Today’s Completed Work
Patient Chart Printout	 204

Tooth Number of Completed Treatment
Referral Recap Report	 296

Tooth Surface of Completed Treatment
Referral Recap Report	 296

Total Amount of Charges for Today’s Completed Work
Patient Chart Printout	 204

Total Amount of Completed Procedures
Walkout - Doctor’s Statement	 368
Procedures Not Attached to Insurance Report	270

Condition
Denominator Codes for Provider

Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Numerator Codes for Provider
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Total Denominator Codes for All Clinics
Oral Health Education Report	 198
Periodontal Exam Report	 250
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Initial Health History Report	 136
Total Denominator Codes for Clinic

Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Total Numerator Codes for All Clinics
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Total Numerator Codes for Clinic
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Consent Form
Consent Form

Treatment Case Report	 326
Patient Signature

Treatment Case Report	 326
Practice Signature

Treatment Case Report	 326
Representative Signature

Treatment Case Report	 326
Signature Date

Treatment Case Report	 326
Signer Name

Treatment Case Report	 326
Document Center - Documents List Report	 112

Staff Signature
Treatment Case Report	 326

Contact
Insurance Carrier Contact Name

Provider IDs List	 284
Insurance Carrier List	 138

Patient Contact
Patient List (Filtered)	 214

Continuing Care
Continuing Care Appointment Date

Continuing Care Display List	 76
Continuing Care Due Date

Letter Merge Reports	 158
Patient List (Filtered)	 214
Continuing Care Display List	 76

Continuing Care Due Dates
Patient Route Slip	 226

Continuing Care Note
Patient Notes Report	 216
Letter Merge Reports	 158

Continuing Care Note Continuing Care Due Date
Patient Notes Report	 216

Continuing Care Note Continuing Care Type
Patient Notes Report	 216

Continuing Care Prior Treatment Date
Continuing Care Display List	 76

Continuing Care Prior Work Date
Letter Merge Reports	 158

Continuing Care Status
Continuing Care Display List	 76

Continuing Care Type
Continuing Care Display List	 76

Continuing Care Type Description
Letter Merge Reports	 158

Continuing Care Type Name
Patient List (Filtered)	 214
Letter Merge Reports	 158

Next Continuing Care Appointment Date
Patient Route Slip	 226
Letter Merge Reports	 158

Next Continuing Care Appointment Provider
Letter Merge Reports	 158

Next Continuing Care Appointment Reason
Letter Merge Reports	 158

Next Continuing Care Appointment Time
Letter Merge Reports	 158

Number of Patients Eligible for Prophy Continuing Care
Practice Statistics Report	 256

Number of Patients not on Prophy Continuing Care
Practice Statistics Report	 256

Percent of Patients Eligible for Prophy Continuing Care
Practice Statistics Report	 256

Percent of Patients not on Prophy Continuing Care
Practice Statistics Report	 256

Contracted Fee
Contracted Rate

Procedures by Contracted Amount Report	 268
Contracted Rate

Contracted Rate
Procedures by Contracted Amount Report	 268

Count
Unique Patient Count for Provider

RVU Day Sheet Report	 308
Unique Visit Count for Provider

RVU Day Sheet Report	 308
Country

Practice Country
Registration Information Report	 306

County
Patient County

Patient List (Filtered)	 214
Coverage

Amount of Co-pays for Insurance Carrier
Utilization Report	 366

Amount of Fees - Co-pays for Insurance Carrier
Utilization Report	 366

Amount of Other Deductible Owed by Family to Pri-
mary Insurance

Patient Route Slip	 226
Amount of Other Deductible Owed by Family to Sec-
ondary Insurance

Patient Route Slip	 226
Amount of Other Deductible Owed to Primary Insur-
ance

Patient Route Slip	 226
Amount of Other Deductible Owed to Secondary Insur-
ance

Patient Route Slip	 226
Amount of Preventative Deductible Owed by Family to 
Primary Insurance

Patient Route Slip	 226
Amount of Preventative Deductible Owed by Family to 
Secondary Insurance

Patient Route Slip	 226

Condition (continued)
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Amount of Preventative Deductible Owed to Primary 
Insurance

Patient Route Slip	 226
Amount of Preventative Deductible Owed to Secondary 
Insurance

Patient Route Slip	 226
Amount of Primary Insurance Benefits Remaining

Unscheduled Treatment Plans (Detailed) Report	
362
Patient Route Slip	 226

Amount of Primary Insurance Benefits Used
Patient Route Slip	 226

Amount of Primary Insurance Paid Benefits YTD for 
Family

Treatment Case Report	 326
Amount of Remaining Benefits for Primary Insurance

Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Amount of Remaining Benefits for Secondary Insurance
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Amount of Secondary Insurance Benefits Remaining
Unscheduled Treatment Plans (Detailed) Report	
362
Patient Route Slip	 226

Amount of Secondary Insurance Benefits Used
Patient Route Slip	 226

Amount of Secondary Paid Benefits for Family
Treatment Case Report	 326

Amount of Secondary Paid Benefits for Patient
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Standard Deductible Owed by Family to 
Primary Insurance

Patient Route Slip	 226
Amount of Standard Deductible Owed by Family to 
Secondary Insurance

Patient Route Slip	 226
Amount of Standard Deductible Owed to Primary Insur-
ance

Patient Route Slip	 226
Amount of Standard Deductible Owed to Secondary 
Insurance

Patient Route Slip	 226
Benefit Renewal Month

Insurance Carrier List	 138
Coverage Percent

Standard Coverage Tables Report	 322
Insurance Coverage Tables Report	 150

Coverage Table Name
Standard Coverage Tables Report	 322

Deductible Type
Standard Coverage Tables Report	 322
Insurance Coverage Tables Report	 150

Do not Bill to Dental Insurance if 0% Coverage
Insurance Carrier List	 138

Estimated Amount of Deductibles to Be Applied
Treatment Case Report	 326
Patient Treatment Case Report	 228

Family Benefits
Insurance Carrier List	 138

Individual Benefits
Insurance Carrier List	 138

Insurance Coverage Percent (Basic) for Primary Insur-
ance

Patient Route Slip	 226
Insurance Coverage Percent (Basic) for Secondary Insur-
ance

Patient Route Slip	 226
Insurance Coverage Percent (Major) for Primary Insur-
ance

Patient Route Slip	 226
Insurance Coverage Percent (Major) for Secondary 
Insurance

Patient Route Slip	 226
Insurance Coverage Percent (Orthodontics) for Primary 
Insurance

Patient Route Slip	 226
Insurance Coverage Percent (Orthodontics) for Second-
ary Insurance

Patient Route Slip	 226
Insurance Coverage Percent (Preventative) for Primary 
Insurance

Patient Route Slip	 226
Insurance Coverage Percent (Preventative) for Second-
ary Insurance

Patient Route Slip	 226
Insurance Coverage Type

Insurance Claims Not Sent Report	 148
Insurance Eligibility Report	 152
Pre-Treatment Estimate Aging Report	 262
Pre-Treatment Estimates Not Sent Report	 264
Insurance Claim Aging Report	 146

Last Eligibility Date for Primary Insurance Coverage
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Last Eligibility Date for Secondary Insurance Coverage
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Lifetime/Individual/Standard Deductible
Insurance Carrier List	 138

Lifetime/Individual/Standard Other Deductible
Insurance Carrier List	 138

Lifetime/Individual/Standard Preventative Deductible
Insurance Carrier List	 138

Maximum Primary Insurance Benefit Amount
Patient Route Slip	 226

Maximum Secondary Insurance Benefit Amount
Patient Route Slip	 226

Other Deductible Met
Insurance Carrier List	 138

Other Deductible Owed by Family to Primary Insurance
Treatment Case Report	 326

Other Deductible Owed by Family to Secondary Insur-
ance

Treatment Case Report	 326
Other Deductible Owed by Patient to Primary Insurance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Coverage (continued)
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Other Deductible Owed by Patient to Secondary Insur-
ance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Preventative Deductible Met
Insurance Carrier List	 138

Preventative Deductible Owed by Family to Primary Ins
Treatment Case Report	 326

Preventative Deductible Owed by Family to Secondary 
Ins

Treatment Case Report	 326
Preventative Deductible Owed by Patient to Primary Ins

Treatment Case Report	 326
Patient Treatment Case Report	 228

Preventative Deductible Owed by Patient to Secondary 
Ins

Treatment Case Report	 326
Patient Treatment Case Report	 228

Primary Insurance Benefits Expiration Date for Family
Treatment Case Report	 326

Primary Insurance Benefits Expiration Date for Patient
Treatment Case Report	 326
Patient Treatment Case Report	 228

Primary Insurance Benefits Remaining
Letter Merge Reports	 158

Primary Insurance Benefits Renewal Month
Patient Route Slip	 226

Secondary Eligibility Date
Appointment Book View Printout	 14

Secondary Insurance Benefits Expiration Date for Family
Treatment Case Report	 326

Secondary Insurance Benefits Expiration Date for 
Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Secondary Insurance Benefits Remaining
Letter Merge Reports	 158

Secondary Insurance Benefits Renewal Month
Patient Route Slip	 226

Standard Deductible Met
Insurance Carrier List	 138

Standard Deductible Owed by Family to Primary Insur-
ance

Treatment Case Report	 326
Standard Deductible Owed by Family to Secondary 
Insurance

Treatment Case Report	 326
Standard Deductible Owed by Patient to Primary Insur-
ance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Standard Deductible Owed by Patient to Secondary 
Insurance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Coverage Table
Coverage Table Name

Standard Coverage Tables Report	 322

CPITN
Percent of Patients with Highest CPITN

Caries Prevalence and Periodontal Index Report	
52

CPOE
Number of Diagnostic Imaging Orders Recorded Using 
CPOE (Computerized Provider Order Entry)

Meaningful Use Measure Calculation List	 162
Number of Laboratory Tests Recorded Using CPOE 
(Computerized Provider Order Entry)

Meaningful Use Measure Calculation List	 162
Number of Patients with Medications Ordered Using 
CPOE (Computerized Provider Order Entry)

Meaningful Use Measure Calculation List	 162
Number of Prescriptions Ordered Using CPOE (Com-
puterized Provider Order Entry)

Meaningful Use Measure Calculation List	 162
Number of Radiology Orders Recorded Using CPOE 
(Computerized Provider Order Entry)

Meaningful Use Measure Calculation List	 162
CPT Code

AMA CPT Code
Procedure Code List	 266
Medical Code List	 186

AMA CPT Code Description
Medical Code List	 186

CPT Code
Procedure Code List	 266

Creation Date
Create Date

Document Center Documents Audited Report	
118

Credit
Account Suspended Credit Amount

Patient Route Slip	 226
Amount of Credit Initial Balances

Provider A/R Totals - Daily Report	 276
Amount of Credit Initial Balances for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Credit Initial Balances for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Current Credits
Walkout - Family Walkout	 370

Amount of Current Suspended Credit Adjustments for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Suspended Credit Adjustments for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Other Applied Credit Adjustments for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Coverage (continued)
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Amount of Other Applied Credit Adjustments for 
Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Credit Initial Balances for 
Clinic

Day Sheet Report	 100
Amount of Other Applied Credit Initial Balances for 
Provider

Day Sheet Report	 100
Amount of Other Applied Credit Special Adjustments 
for Clinic

Day Sheet Report	 100
Amount of Other Applied Credit Special Adjustments 
for Provider

Day Sheet Report	 100
Amount of Other Credit Initial Balances for Clinic

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Other Credit Initial Balances for Provider
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Other Credit Special Adjustments for Clinic
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Other Credit Special Adjustments for Pro-
vider

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Suspended Credit Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Credit Adjustments for Previous 
Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Suspended Credit Adjustments for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Credits
Aging/Credit Balance Report	 6

Amount of Suspended Credits for Guarantor
Suspended Credits Report	 324

Amount of YTD Applied Credit Adjustments for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of YTD Suspended Credit Adjustments for Prov

Day Sheet (Charges and Receipts) Report	 94
Applied Credit Adjustment Amount

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Credit
Day Sheet Report	 100

Credit Amount
Walkout - Family Walkout	 370

Credit Balance (as of Date)
Practice Analysis Report	 252

Credit Initial Balance
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Credit Special Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Grand Total Amount of Credit Adjustments
Insurance Transaction Analysis Report	 154

Grand Total Number of Credit Adjustments
Insurance Transaction Analysis Report	 154

Other Applied Credit Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Other Credit Initial Balance
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Other Credit Special Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Patient Suspended Credit Amount
Patient Route Slip	 226

Percent of Suspended Credits
Aging/Credit Balance Report	 6

Suspended Credit Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Suspended Credit Amount
Continuing Care Display List	 76

Suspended Credit Amount for Clinic
Aging/Credit Balance Report	 6

Suspended Credits
Practice Analysis Report	 252

Total Amount of Applied Credit Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Applied Credit Adjustments for Previ-
ous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Credit Adjustments

Day Sheet (Adjustments) Report	 90
Insurance Carrier Production - Full Report	 142
Insurance Carrier Production - Summary Report	
144
Insurance Transaction Analysis Report	 154
Operator Day Sheet Report	 194
Adjustment Summary Report	 4

Total Amount of Credit Initial Balances
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Total Amount of Credit Special Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Total Amount of Current Applied Credit Adjustments
Day Sheet (Charges and Receipts) Report	 94

Credit (continued)
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Total Amount of Current Suspended Credit Adjust-
ments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of MTD Applied Credit Adjustments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of MTD Suspended Credit Adjustments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Other Applied Credit Adjustments

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Other Applied Credit Initial Balances
Day Sheet Report	 100

Total Amount of Other Applied Credit Special Adjust-
ments

Day Sheet Report	 100
Total Amount of Other Credit Initial Balances

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Amount of Suspended Credit Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Suspended Credit Adjustments for 
Previous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Suspended Credits for Clinic

Suspended Credits Report	 324
Total Amount of YTD Applied Credit Adjustments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of YTD Suspended Credit Adjustments

Day Sheet (Charges and Receipts) Report	 94
Total Number of Credit Adjustments

Insurance Transaction Analysis Report	 154
Total Quantity of Credit Adjustments

Day Sheet (Adjustments) Report	 90
Total Revenue from Credit Adjustments

Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Total Suspended Credits
Aging/Credit Balance Report	 6

Credit Adjustment
Amount of Applied Credit Adjustments for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Applied Credit Adjustments for Previous 
Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Applied Credit Adjustments for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Current Applied Credit Adjustments for Prov
Day Sheet (Charges and Receipts) Report	 94

Amount of MTD Applied Credit Adjustments for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94

Average Amount of Credit Adjustments
Day Sheet (Adjustments) Report	 90

Credit Adjustment Amount
Insurance Carrier Production - Full Report	 142
Billing Statement	 48

Credit Adjustment Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Grand Total Amount of Credit Adjustments
Insurance Transaction Analysis Report	 154

Grand Total Number of Credit Adjustments
Insurance Transaction Analysis Report	 154

Other Applied Credit Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Revenue for Provider from Credit Adjustments
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Total Amount of Credit Adjustments
Day Sheet (Adjustments) Report	 90
Insurance Carrier Production - Full Report	 142
Insurance Carrier Production - Summary Report	
144
Insurance Transaction Analysis Report	 154
Operator Day Sheet Report	 194
Adjustment Summary Report	 4

Total Amount of Suspended Credit Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Suspended Credit Adjustments for 
Previous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of YTD Applied Credit Adjustments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of YTD Suspended Credit Adjustments

Day Sheet (Charges and Receipts) Report	 94
Total Number of Credit Adjustments

Insurance Transaction Analysis Report	 154
Total Quantity of Credit Adjustments

Day Sheet (Adjustments) Report	 90
Total Revenue from Credit Adjustments

Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Credit Card
Credit Card Number

Billing Statement	 48
Name on Credit Card

Billing Statement	 48
Total Amount of Credit Card Payments

Operator Day Sheet Report	 194
Type of Credit Card

Billing Statement	 48
Credit Card Terminal

Terminal Name
Credit Card Transaction Report	 80

Credit (continued)
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Credit Card Type
Card Type

Credit Card Transaction Report	 80
Credit Special Adjustment

Amount of Credit Special Adjustments
Provider A/R Totals - Daily Report	 276

Amount of Credit Special Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Credit Special Adjustments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Other Credit Special Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Amount of Other Credit Special Adjustments
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Cross Coding
AMA CPT Code

Procedure Code List	 266
Medical Code List	 186

AMA CPT Code Description
Medical Code List	 186

ICD-9-CM Code
Patient List (Filtered)	 214
Medical Code List	 186

ICD-9-CM Code Description
Medical Code List	 186

Modifier Code
Medical Code List	 186

Place of Service Code
Medical Code List	 186

Place of Service Code Description
Medical Code List	 186

Type of Service Code
Medical Code List	 186

Type of Service Code Description
Medical Code List	 186

Current
Amount of Current Applied Credit Adjustments for Prov

Day Sheet (Charges and Receipts) Report	 94
Amount of Current Applied Payments for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Current Charge Adjustments for Provider

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Amount of Current Charges
Walkout - Family Walkout	 370

Amount of Current Charges Billed to Insurance for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Current Charges Compared to Fee Schedule 
for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Current Credits

Walkout - Family Walkout	 370

Amount of Current Finance Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of Current Late Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of Current Suspended Credit Adjustments for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Current Suspended Payments for Provider

Day Sheet (Charges and Receipts) Report	 94
Current Account Balance

Billing Statement	 48
Current Average Charge per Patient

Day Sheet (Charges and Receipts) Report	 94
Current Average Charge per Patient for Provider

Day Sheet (Charges and Receipts) Report	 94
Current Average Production per Patient

Day Sheet (Charges and Receipts) Report	 94
Current Average Production per Patient for Provider

Day Sheet (Charges and Receipts) Report	 94
Current Charges for Provider

Day Sheet (Charges and Receipts) Report	 94
Current Number of New Patients

Day Sheet (Charges and Receipts) Report	 94
Current Number of New Patients for Provider

Day Sheet (Charges and Receipts) Report	 94
Current Number of Patients Seen

Day Sheet (Charges and Receipts) Report	 94
Current Number of Patients Seen by Provider

Day Sheet (Charges and Receipts) Report	 94
Current Receivables

Practice Analysis Report	 252
Net Difference of Current Charges and Fee Schedule 
for Provider

Day Sheet (Charges and Receipts) Report	 94
Net Difference of Total Current Charges and Fee 
Schedule

Day Sheet (Charges and Receipts) Report	 94
Next Charge Amount (after 18 Months from Current 
Month)

Future Due Payment Plan Report - Monthly Totals	
132

Total Amount of Charges Remaining (after 18 Mos from 
Curr Mo)

Future Due Payment Plan Report - Monthly Totals	
132

Total Amount of Current Applied Credit Adjustments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Applied Payments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Charge Adjustments
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Charges Billed to Insurance
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Charges Compared to Fee 
Schedule

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Current Finance Charges

Day Sheet (Charges and Receipts) Report	 94
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Total Amount of Current Late Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Current Suspended Credit Adjust-
ments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Current Suspended Payments

Day Sheet (Charges and Receipts) Report	 94
Total Number of Charges Remaining (after 18 Mos from 
Curr Mo)

Future Due Payment Plan Report - Monthly Totals	
132

Current Year
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Financial Class Type (Current Year)

UDS - Patient Related Revenue Report	 348
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Payer Category (Current Year)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Financial Class Type (Current Year)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Patient (Current Year)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Payer Category (Current Year)

UDS - Patient Related Revenue Report	 348
Wrap Around or Reconciliation Amount Collected for 
Patient (Current Year)

UDS - Patient Related Revenue Report	 348
Date

Adjustment Date
Patient’s Ledger Report	 230

Allergy Discovery Date
Patient List (Filtered)	 214

Allocate Date
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Allocations Report	 286

Amount of Debit Adjustments (for Date Range)
Practice Analysis Report	 252

Amount of Finance Charges (for Date Range)
Practice Analysis Report	 252

Amount of Insured Charges (for Date Range)
Practice Analysis Report	 252

Amount of Late Charges (for Date Range)
Practice Analysis Report	 252

Amount of Non-insured Charges (for Date Range)
Practice Analysis Report	 252

Amount of Other Debit Adjustments (for Date Range)
Practice Analysis Report	 252

Appointment Date
Appointment Reminder Cards	 18
As Soon As Possible List	 22
Audit Report - Appointments	 26
Daily Appointment List (DX1)	 84
Daily Appointment List Report	 86
Letter Merge Reports	 158
Operatory Appointment List Report	 196
Patient List (Filtered)	 214

Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Walkout - Family Walkout	 370
Appointment Cycle Time Report	 16

Appointment Date and Time
Insurance Eligibility Report	 152

Appointment Date Change
Audit Report - Appointments	 26

Attached Date
Document Center - Documents List Report	 112

Audit Date
Document Center Documents Audited Report	
118

Balance (as of a Date)
Day Sheet Report	 100
Day Sheet (Charges and Receipts) Report	 94

Balance (as of a Date) for Clinic
Day Sheet Report	 100

Balance (as of a Date) for Provider
Day Sheet Report	 100
Day Sheet (Charges and Receipts) Report	 94

Beginning Balance (for Date Range)
Practice Analysis Report	 252

Bill Date
Walkout - Family Walkout	 370

Billing Date
Billing Statement	 48

Case Expiration Date
Practice Treatment Case Report	 258

Claim Date
Insurance Claims Not Sent Report	 148

Claim Expiration Date
Procedures Not Attached to Insurance Report	270
Secondary Insurance Claims Not Created Report	
318
Insurance Claims Not Sent Report	 148

Claim On Hold Date
Insurance Claim Aging Report	 146

Claim Payment Received Date
Insurance Transaction Analysis Report	 154

Claim Re-sent Date
Insurance Claim Aging Report	 146

Claim Sent Date
Insurance Transaction Analysis Report	 154
Insurance Claim Aging Report	 146

Claim Tracer Date
Insurance Claim Aging Report	 146

Clinical Note Date
Patient Notes Report	 216
Clinical Notes Report	 64

Completed Date
Referred To Doctor Report	 304

Continuing Care Appointment Date
Continuing Care Display List	 76

Continuing Care Due Date
Letter Merge Reports	 158
Patient List (Filtered)	 214
Continuing Care Display List	 76

Continuing Care Due Dates
Patient Route Slip	 226

Continuing Care Note Continuing Care Due Date
Patient Notes Report	 216

Current (continued)



Index by Report Item   471

Dentrix Enterprise 11.0.2 Reports Reference

Continuing Care Prior Treatment Date
Continuing Care Display List	 76

Continuing Care Prior Work Date
Letter Merge Reports	 158

Create Date
Document Center Documents Audited Report	
118

Credit Balance (as of Date)
Practice Analysis Report	 252

Date
Appointment Book View Printout	 14
Document Center Audit Documents Report	 114
Document Center Document	 116
Patient Ledger Report	 210
Provider A/R Totals - Daily Report	 276
Analysis Summary Report - Daily	 8

Date Appointment Broken
Unscheduled Appointment List (OM)	 358
Unscheduled Appointment List (DX1)	 356

Date Attached
Document Center List	 120

Date Insurance Last Updated
Insurance Carrier List	 138

Date of Access
Patient Information Accessed Report	 208

Date of Change
Audit Report - Audit Log Status	 28
Audit Report - Clinics	 30
Audit Report - Combined	 32
Audit Report - Patients	 34
Audit Report - Providers/Staff	 36
Audit Report - Transactions	 38
Audit Rights Report - Assigned Individually	 40
Audit Rights Report - Assigned to Groups	 42
Audit Rights Report - Group Names	 44
Audit Rights Report - Users to Groups	 46
Audit Report - Appointments	 26

Date of Completed Procedure
Walkout - Doctor’s Statement	 368

Date of Completed Treatment
Referral Recap Report	 296

Date of Last Case Status Update
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Date of Last Payment Agreement Payment
Letter Merge Reports	 158

Date of Payment
Coupon Book - Future Due Payments	 78

Date of Treatment-planned Procedure
Referral Slip	 298

Date Signed
Perio - Exam Comparison Report	 242
Perio - Graphic Chart Report	 244
Perio - Combined Graphic & Data Chart Report	
238

Ending Balance (for Date Range)
Practice Analysis Report	 252

Entry Date
Audit Report - Transactions	 38
Day Sheet (Adjustments) Report	 90

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Receipts) Report	 98
Day Sheet Report	 100
Insurance Carrier Production - Full Report	 142
Operator Day Sheet Report	 194
Patient Health Assessment Report	 206
Patient List (Filtered)	 214
Patient Revenue List by Payer Report	 224
Patient Treatment Case Report	 228
Practice Treatment Case Report	 258
Procedures by Contracted Amount Report	 268
Production Summary Report	 272
Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
RVU Day Sheet Report	 308
RVU Production Summary Report	 310
Suspended Credits Report	 324
Audit Report - Combined	 32

Family Member Balance (as of a Date)
Patient’s Ledger Report	 230

Finance Charge Date
Finance Charge Report	 130

First Payment Date
Payment Agreement Report	 234

First Visit Date
New Patient List	 190
Patient List	 212
Patient Route Slip	 226
Letter Merge Reports	 158

Future Appointment Date
Patient Route Slip	 226

Future Due Payment Plan Date
Future Due Payment Plan Report - Standard	 134

Future Reminder Date
Collections Manager List	 70

Immunization Date
Patient List (Filtered)	 214

Insurance Eligibility Date
Insurance Eligibility Report	 152

Last Eligibility Date for Primary Insurance Coverage
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Last Eligibility Date for Secondary Insurance Coverage
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Last Gratuity Date
Referred By Patient Report	 302

Last Late Charge Date
Payment Agreement Report	 234

Last Missed Appointment Date
Patient Route Slip	 226

Last Payment Agreement Payment Date
Patient Route Slip	 226

Last Payment Date
Aging/Credit Balance Report	 6

Last Payment Date for Payment Agreement
Collections Manager List	 70

Last Prophylaxis Date
Patient Route Slip	 226

Last Referral Date
Letter Merge Reports	 158

Date (continued)
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Last Referral Name and Date
Patient Route Slip	 226

Last Referred By Source and Date
Patient Route Slip	 226

Last Referred To Name and Date
Patient Route Slip	 226

Last Statement Date
Collections Manager List	 70
Patient Route Slip	 226
Aging/Credit Balance Report	 6

Last Visit Date
Patient List	 212
Patient Notes Report	 216
Patient Route Slip	 226
Patient Route Slip	 226
Letter Merge Reports	 158

Late Charge Date
Late Charge Report	 156

Medication Date
Patient List (Filtered)	 214

New Patients (for Date Range)
Practice Analysis Report	 252

Next Appointment Date
Patient Route Slip	 226

Next Appointment Procedure Date
Patient Route Slip	 226

Next Continuing Care Appointment Date
Patient Route Slip	 226
Letter Merge Reports	 158

Next Payment Agreement Payment Due Date
Patient Route Slip	 226

Next Payment Plan Payment Date
Letter Merge Reports	 158

Number of Patients Seen During Past 24 Months
Meaningful Use Measure Calculation List	 162

Patient Social Security Number or Request Date
Audit Report - Patients	 34

Patient Social Security Number or Request Date 
Change

Audit Report - Patients	 34
Payment Agreement Date

Truth in Lending Disclosure Statement	 332
Payment Agreement Report	 234

Payment Agreement Last Payment Date
Payment Agreement Report	 234

Payment Agreement Next Payment Date
Payment Agreement Report	 234

Payment Agreement Payment Due Date
Payment Agreement Amortization Schedule	 232

Payment Date
Patient’s Ledger Report	 230
Deposit Slip	 108

Payment Due Date
Coupon Book - Payment Agreements	 79
Coupon Book - Future Due Payments	 78

Perio Exam Date
Perio - Combined Graphic & Data Chart Report	
238
Perio - Data Chart Report	 240
Perio - Exam Comparison Report	 242

Perio - Pocket Depths Only Report	 246
Perio Exam List	 248
Patient Notes Report	 216

Prescription Date
Prescription Printout	 260
Patient List (Filtered)	 214

Pre-treatment Estimate Date
Pre-Treatment Estimates Not Sent Report	 264

Pre-treatment Estimate Expiration Date
Secondary Pre-Treatment Estimates Not Created 
Report	 320
Pre-Treatment Estimates Not Sent Report	 264

Pre-treatment Estimate On Hold Date
Pre-Treatment Estimate Aging Report	 262

Pre-treatment Estimate Re-sent Date
Pre-Treatment Estimate Aging Report	 262

Pre-treatment Estimate Sent Date
Pre-Treatment Estimate Aging Report	 262

Pre-treatment Estimate Tracer Date
Pre-Treatment Estimate Aging Report	 262

Primary Claim Date
Secondary Insurance Claims Not Created Report	
318

Primary Eligibility Date
Appointment Book View Printout	 14

Primary Insurance Benefits Expiration Date for Family
Treatment Case Report	 326

Primary Insurance Benefits Expiration Date for Patient
Treatment Case Report	 326
Patient Treatment Case Report	 228

Primary Pre-treatment Estimate Date
Secondary Pre-Treatment Estimates Not Created 
Report	 320

Primary Pre-treatment Estimate Sent Date
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Problem Discovery Date
Patient List (Filtered)	 214

Procedure Date
Audit Report - Transactions	 38
Billing Statement	 48
Day Sheet (Adjustments) Report	 90
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Receipts) Report	 98
Day Sheet Report	 100
Operator Day Sheet Report	 194
Patient Chart and Progress Notes Printout	 202
Patient List (Filtered)	 214
Patient Treatment Case Report	 228
Practice Treatment Case Report	 258
Production Summary Report	 272
Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
RVU Day Sheet Report	 308
RVU Production Summary Report	 310
Suspended Credits Report	 324
Audit Report - Combined	 32

Procedure Date Change
Audit Report - Transactions	 38

Procedure Date for Date of Service
Letter Merge Reports	 158

Date (continued)
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Referral Date
Referral Slip	 298
Referred By Doctor/Other Report	 300
Referred By Patient Report	 302
Referred To Doctor Report	 304
Referral Recap Report	 296

Referred By Date
New Patient List	 190

Referred by Doctor/Other Last Gratuity Date
Referred By Doctor/Other Report	 300

Referred Date of Treatment Still in Progress
Referral Recap Report	 296

Referred Patients (for Date Range)
Practice Analysis Report	 252

Scheduled Date
Referred To Doctor Report	 304

Secondary Eligibility Date
Appointment Book View Printout	 14

Secondary Insurance Benefits Expiration Date for Family
Treatment Case Report	 326

Secondary Insurance Benefits Expiration Date for 
Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Secondary Pre-treatment Estimate Sent Date
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Service Date
Insurance Claim Aging Report	 146
Patient Revenue List by Payer Report	 224
Procedures by Contracted Amount Report	 268
RVU Utilization Report	 316
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Utilization Report	 366
Dental Encounters Report	 106

Signature Date
Treatment Case Report	 326

Signed Date
Document Center - Documents List Report	 112

Subtotal of Charges (for Date Range)
Practice Analysis Report	 252

Total Charges (for Date Range)
Practice Analysis Report	 252

Total Family Balance (as of a Date)
Family Ledger Report (Single Family)	 126
Family Ledger Report	 124

Total Family Balance as of a Date
Patient’s Ledger Report	 230

Total Patient Balance (as of Date)
Patient Ledger Report	 210

Total Patient Balance as of a Date
Patient’s Ledger Report	 230

Transaction Date
Family Ledger Report	 124
Family Ledger Report (Single Family)	 126
Insurance Transaction Analysis Report	 154
Patient’s Ledger Report	 230
Credit Card Transaction Report	 80

Treatment-planned Procedure Date
Unscheduled Treatment Plans (Detailed) Report	
362
Treatment Case Report	 326

Date of Service
Insurance Payment for Date of Service

Letter Merge Reports	 158
Service Date

Insurance Claim Aging Report	 146
Patient Revenue List by Payer Report	 224
Procedures by Contracted Amount Report	 268
RVU Utilization Report	 316
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Utilization Report	 366
Dental Encounters Report	 106

Total Charge for Date of Service
Letter Merge Reports	 158

Day
Amount for Today’s Completed Work

Patient Chart Printout	 204
Day Note

Appointment Book View Printout	 14
Tooth Number for Today’s Completed Work

Patient Chart Printout	 204
Total Amount of Charges for Today’s Completed Work

Patient Chart Printout	 204
Days

Days Referred Out
Referred To Doctor Report	 304

DEA Number
DEA Number

Practice Organization List	 254
Provider DEA Number

Prescription Printout	 260
Debit

Amount of Debit Initial Balances (Production)
Provider A/R Totals - Daily Report	 276

Amount of Debit Initial Balances (Production) for Prov
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of Debit Initial Balances for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Debit Initial Balances for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Debit Initial Balance
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Debit Special Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Amount of Debit Adjustments
Day Sheet (Adjustments) Report	 90
Insurance Carrier Production - Full Report	 142
Insurance Carrier Production - Summary Report	
144
Adjustment Summary Report	 4

Date (continued)
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Total Amount of Debit Initial Balances
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Debit Initial Balances (Production)
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Amount of Debit Special Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Total Quantity of Debit Adjustments
Day Sheet (Adjustments) Report	 90

Debit Adjustment
Amount of Debit Adjustments (Average)

Practice Analysis Report	 252
Amount of Debit Adjustments (for Date Range)

Practice Analysis Report	 252
Amount of Debit Adjustments (MTD)

Practice Analysis Report	 252
Amount of Debit Adjustments (YTD)

Practice Analysis Report	 252
Amount of Other Debit Adjustments (Average)

Practice Analysis Report	 252
Amount of Other Debit Adjustments (for Date Range)

Practice Analysis Report	 252
Amount of Other Debit Adjustments (MTD)

Practice Analysis Report	 252
Average Amount of Debit Adjustments

Day Sheet (Adjustments) Report	 90
Debit Adjustment Amount

Insurance Carrier Production - Full Report	 142
Debit Adjustment Amount for Insurance Plan

Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Total Amount of Debit Adjustments
Day Sheet (Adjustments) Report	 90
Insurance Carrier Production - Full Report	 142
Insurance Carrier Production - Summary Report	
144
Adjustment Summary Report	 4

Total Quantity of Debit Adjustments
Day Sheet (Adjustments) Report	 90

Debit Special Adjustment
Amount of Debit Special Adjustments

Provider A/R Totals - Daily Report	 276
Amount of Debit Special Adjustments for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Debit Special Adjustments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Debit Special Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Amount of Debit Special Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Decay
Number of Patients 0 - 19 Years with Tooth Decay or 
Cavities

Clinical Quality Measures List	 66
Percent of Patients with History of Decay

Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Untreated Decay
Caries Prevalence and Periodontal Index Report	
52

Deductible
Amount of Other Deductible Owed by Family to Pri-
mary Insurance

Patient Route Slip	 226
Amount of Other Deductible Owed by Family to Sec-
ondary Insurance

Patient Route Slip	 226
Amount of Other Deductible Owed to Primary Insur-
ance

Patient Route Slip	 226
Amount of Other Deductible Owed to Secondary Insur-
ance

Patient Route Slip	 226
Amount of Preventative Deductible Owed by Family to 
Primary Insurance

Patient Route Slip	 226
Amount of Preventative Deductible Owed by Family to 
Secondary Insurance

Patient Route Slip	 226
Amount of Preventative Deductible Owed to Primary 
Insurance

Patient Route Slip	 226
Amount of Preventative Deductible Owed to Secondary 
Insurance

Patient Route Slip	 226
Amount of Standard Deductible Owed by Family to 
Primary Insurance

Patient Route Slip	 226
Amount of Standard Deductible Owed by Family to 
Secondary Insurance

Patient Route Slip	 226
Amount of Standard Deductible Owed to Primary Insur-
ance

Patient Route Slip	 226
Amount of Standard Deductible Owed to Secondary 
Insurance

Patient Route Slip	 226
Estimated Amount of Deductibles to Be Applied

Treatment Case Report	 326
Patient Treatment Case Report	 228

Lifetime/Individual/Standard Deductible
Insurance Carrier List	 138

Debit (continued)
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Lifetime/Individual/Standard Other Deductible
Insurance Carrier List	 138

Lifetime/Individual/Standard Preventative Deductible
Insurance Carrier List	 138

Other Deductible Met
Insurance Carrier List	 138

Other Deductible Owed by Family to Primary Insurance
Treatment Case Report	 326

Other Deductible Owed by Family to Secondary Insur-
ance

Treatment Case Report	 326
Other Deductible Owed by Patient to Primary Insurance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Other Deductible Owed by Patient to Secondary Insur-
ance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Preventative Deductible Met
Insurance Carrier List	 138

Preventative Deductible Owed by Family to Primary Ins
Treatment Case Report	 326

Preventative Deductible Owed by Family to Secondary 
Ins

Treatment Case Report	 326
Preventative Deductible Owed by Patient to Primary Ins

Treatment Case Report	 326
Patient Treatment Case Report	 228

Preventative Deductible Owed by Patient to Secondary 
Ins

Treatment Case Report	 326
Patient Treatment Case Report	 228

Standard Deductible Met
Insurance Carrier List	 138

Standard Deductible Owed by Family to Primary Insur-
ance

Treatment Case Report	 326
Standard Deductible Owed by Family to Secondary 
Insurance

Treatment Case Report	 326
Standard Deductible Owed by Patient to Primary Insur-
ance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Standard Deductible Owed by Patient to Secondary 
Insurance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Deductible Type
Deductible Type

Standard Coverage Tables Report	 322
Insurance Coverage Tables Report	 150

Deleted
Deleted Appointment

Audit Report - Appointments	 26
Deleted Entry

Audit Report - Patients	 34
Deleted Procedure

Audit Report - Combined	 32

Deleted Transaction
Audit Report - Transactions	 38

Demographic
Number of Patients with Required Demographics

Meaningful Use Measure Calculation List	 162
Denominator Code

Denominator Codes for Provider
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Total Denominator Codes for All Clinics
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Total Denominator Codes for Clinic
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Dental
Amount of Dental Insurance Portion

Patient Chart Printout	 204
Do not Bill to Dental Insurance

Insurance Carrier List	 138
Do not Bill to Dental Insurance if 0% Coverage

Insurance Carrier List	 138
Number of Patients with Dental and Medical Insurance

Practice Statistics Report	 256
Number of Patients with Primary Dental Insurance Only

Practice Statistics Report	 256
Number of Patients with Secondary Dental Insurance

Practice Statistics Report	 256
Number of Patients without Dental and Medical Insur-
ance

Practice Statistics Report	 256
Number of Patients without Dental Insurance

Practice Statistics Report	 256
Percent of Patients with Dental and Medical Insurance

Practice Statistics Report	 256
Percent of Patients with Primary Dental Insurance Only

Practice Statistics Report	 256
Percent of Patients with Secondary Dental Insurance

Practice Statistics Report	 256
Percent of Patients without Dental and Medical Insur-
ance

Practice Statistics Report	 256
Percent of Patients without Dental Insurance

Practice Statistics Report	 256
Primary Dental Insurance Carrier Name

Patient List	 212
Secondary Dental Insurance Carrier Name

Patient List	 212
Total Amount of Dental Insurance Portions

Patient Chart Printout	 204
Dental Chart

Dental Chart
Patient Chart Printout	 204
Patient Chart and Progress Notes Printout	 202

Graphical Chart
Treatment Case Report	 326

Deductible (continued)
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Dental Diagnostic Code
Dental Diagnostic Code

Multi-Code List	 188
Procedure Code List	 266
Dental Diagnostic Code List	 104

Dental Diagnostic Code Description
Dental Diagnostic Code List	 104

Do not Print Dental Diagnostic Codes on Claim
Insurance Carrier List	 138

Dental Fluorosis
Percent of Patients with Dental Fluorosis

Caries Prevalence and Periodontal Index Report	
52

Dentition
Permanent/Temporary

Multi-Code List	 188
Deposit

Paid in by Name
Deposit Slip	 108

Total Amount of Deposit
Deposit Slip	 108

Description
ADA Code

Day Sheet (Charges and Receipts) Report	 94
Dental Encounters Report	 106
Fee Schedules Report	 128
Insurance Carrier Production - Full Report	 142
Multi-Code List	 188
Operator Day Sheet Report	 194
Patient Chart and Progress Notes Printout	 202
Patient List (Filtered)	 214
Patient Treatment Case Report	 228
Practice Treatment Case Report	 258
Procedure Code List	 266
Procedures by Contracted Amount Report	 268
Procedures Not Attached to Insurance Report	270
Production Summary Report	 272
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
RVU Day Sheet Report	 308
RVU Production Summary Report	 310
RVU Schedules Report	 314
RVU Utilization Report	 316
Standard Coverage Tables Report	 322
Treatment Case Report	 326
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Unscheduled Treatment Plans (Detailed) Report	
362
Updated Dental Insurance Payment Table Report	
364
Utilization Report	 366
Walkout - Doctor’s Statement	 368
Appointment Cycle Time Report	 16

ADA Code Abbreviated Description
Procedure Code List	 266
Multi-Code List	 188

ADA Code Description
Fee Schedules Report	 128
Insurance Carrier Production - Full Report	 142
Multi-Code List	 188
Patient Chart and Progress Notes Printout	 202
Patient Ledger Report	 210
Patient Treatment Case Report	 228
Practice Treatment Case Report	 258
Procedure Code List	 266
Procedures by Contracted Amount Report	 268
Procedures Not Attached to Insurance Report	270
Production Summary Report	 272
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
RVU Day Sheet Report	 308
RVU Production Summary Report	 310
RVU Schedules Report	 314
RVU Utilization Report	 316
Treatment Case Report	 326
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Unscheduled Treatment Plans (Detailed) Report	
362
Utilization Report	 366
Walkout - Doctor’s Statement	 368
Walkout - Family Walkout	 370
Day Sheet (Charges and Receipts) Report	 94

ADA Code Description for Today’s Completed Work
Patient Chart Printout	 204

ADA Code Description for Treatment-planned Proce-
dure

Patient Chart Printout	 204
ADA Code Description of Completed Treatment

Referral Recap Report	 296
ADA Code Description of Treatment Still in Progress

Referral Recap Report	 296
ADA Code Description of Treatment-planned Proce-
dure

Referral Slip	 298
ADA Code Description or Transaction Description

Operator Day Sheet Report	 194
Adjustment Description

Patient’s Ledger Report	 230
Allergy Description

Patient List (Filtered)	 214
AMA CPT Code Description

Medical Code List	 186
Continuing Care Type Description

Letter Merge Reports	 158
Dental Diagnostic Code Description

Dental Diagnostic Code List	 104
Description of Service

Billing Statement	 48
Document Description

Document Center List	 120
File Description

Document Center Documents Audited Report	
118
Document Center - Documents List Report	 112
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ICD-9-CM Code Description
Medical Code List	 186

Medication Description
Patient List (Filtered)	 214

Modifier Code Description
Medical Code List	 186

Multi-Code Description
Multi-Code List	 188

Next Appointment ADA Code Description
Patient Route Slip	 226

Payment Description
Patient’s Ledger Report	 230

Payment Type Description
Payment Summary Report	 236

Place of Service Code Description
Medical Code List	 186

Problem Description
Patient List (Filtered)	 214

Procedure Description
Day Sheet Report	 100
Audit Report - Combined	 32

Transaction Description
Family Ledger Report	 124
Family Ledger Report (Single Family)	 126
Insurance Transaction Analysis Report	 154
Patient’s Ledger Report	 230
Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Suspended Credits Report	 324
Audit Report - Transactions	 38

Transaction Description Change
Audit Report - Transactions	 38

Type of Service Code Description
Medical Code List	 186

Vaccine Abbreviated Description
Patient List (Filtered)	 214

Diagnostic Code
Dental Diagnostic Code

Multi-Code List	 188
Procedure Code List	 266
Dental Diagnostic Code List	 104

Dental Diagnostic Code Description
Dental Diagnostic Code List	 104

Do not Print Dental Diagnostic Codes on Claim
Insurance Carrier List	 138

Diagnostic Imaging
Number of Diagnostic Imaging Orders Recorded Using 
CPOE (Computerized Provider Order Entry)

Meaningful Use Measure Calculation List	 162
Disabled

Disabled/Enabled
Multi-Code List	 188

Discount
Amount of Sliding Discounts for Patient

UDS - Patient Related Revenue Report	 348
Subtotal of Sliding Discounts for Financial Class Type

UDS - Patient Related Revenue Report	 348
Subtotal of Sliding Discounts for Payer Category

UDS - Patient Related Revenue Report	 348

Total Amount of Sliding Discounts for Financial Class 
Type

UDS - Patient Related Revenue Report	 348
Total Amount of Sliding Discounts for Patient

UDS - Patient Related Revenue Report	 348
Total Amount of Sliding Discounts for Payer Category

UDS - Patient Related Revenue Report	 348
Dispense

Dispense as Written
Prescription Printout	 260

Divorced
Number of Divorced Patients

Practice Statistics Report	 256
Percent of Divorced Patients

Practice Statistics Report	 256
dmfs

dmfs
Caries Prevalence and Periodontal Index Report	
52

Mean dmfs
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with dmfs > 0
Caries Prevalence and Periodontal Index Report	
52

dmft
dmft

Caries Prevalence and Periodontal Index Report	
52

Mean dmft
Caries Prevalence and Periodontal Index Report	
52

DMFT
Mean DMFT

Caries Prevalence and Periodontal Index Report	
52

Do not Bill
Do not Bill to Dental Insurance

Insurance Carrier List	 138
Do not Bill to Dental Insurance if 0% Coverage

Insurance Carrier List	 138
Do not Print

Do not Print Dental Diagnostic Codes on Claim
Insurance Carrier List	 138

Doctor
Referred to Doctor Name

Referred To Doctor Report	 304
Document Center Document	 116

Referred to Doctor Phone Number
Referred To Doctor Report	 304

Doctor/Other
Number of Referred by Doctor/Other Patients Listed

Referred By Doctor/Other Report	 300
Referred by Doctor/Other Address

Referred By Doctor/Other Report	 300
Referred by Doctor/Other Gratuity Given

Referred By Doctor/Other Report	 300
Referred by Doctor/Other Last Gratuity Date

Referred By Doctor/Other Report	 300

Description (continued)
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Referred by Doctor/Other Name
Referred By Doctor/Other Report	 300
Document Center Document	 116

Referred by Doctor/Other Phone Number
Referred By Doctor/Other Report	 300

Referred by Doctor/Other Total Referrals
Referred By Doctor/Other Report	 300

Total Number of Referred by Doctor/Other Patients 
Listed

Referred By Doctor/Other Report	 300
Total Number of Referred by Doctor/Other Referrals

Referred By Doctor/Other Report	 300
Document

Date Attached
Document Center List	 120

Document
Document Center Document	 116

Document Description
Document Center List	 120

Document Error Type
Document Center Documents Audited Report	
118

Document Status
Document Center Documents Audited Report	
118

Document Type
Document Center List	 120

File Description
Document Center Documents Audited Report	
118
Document Center - Documents List Report	 112

File Location
Document Center - Documents List Report	 112

File Type
Document Center Documents Audited Report	
118
Document Center - Documents List Report	 112

Number of Document Errors
Document Center Audit Documents Report	 114

Number of Documents
Document Center Audit Documents Report	 114

Number of Documents Audited
Document Center Audit Documents Report	 114

Number of Incorrect Location Errors
Document Center Audit Documents Report	 114

Number of Incorrect Record Errors
Document Center Audit Documents Report	 114

Number of Other Errors
Document Center Audit Documents Report	 114

Number of Poor Scan Errors
Document Center Audit Documents Report	 114

Percent of Document Errors
Document Center Audit Documents Report	 114

Signed Date
Document Center - Documents List Report	 112

Signer Name
Treatment Case Report	 326
Document Center - Documents List Report	 112

Total Number of Document Errors
Document Center Audit Documents Report	 114

Total Number of Documents
Document Center Audit Documents Report	 114

Total Number of Documents Audited
Document Center Audit Documents Report	 114

Total Number of Incorrect Location Errors
Document Center Audit Documents Report	 114

Total Number of Incorrect Record Errors
Document Center Audit Documents Report	 114

Total Number of Other Errors
Document Center Audit Documents Report	 114

Total Number of Poor Scan Errors
Document Center Audit Documents Report	 114

Total Percent of Document Errors
Document Center Audit Documents Report	 114

Total Percent of Documents Audited
Document Center Audit Documents Report	 114

Document Center
Number of Pages

Document Center List	 120
Document Error

Number of Document Errors
Document Center Audit Documents Report	 114

Percent of Document Errors
Document Center Audit Documents Report	 114

Percent of Documents Audited
Document Center Audit Documents Report	 114

Total Number of Document Errors
Document Center Audit Documents Report	 114

Total Percent of Document Errors
Document Center Audit Documents Report	 114

Download
Number of Patients who Viewed or Downloaded or 
Transmitted (VDT) Electronic Health Information

Meaningful Use Measure Calculation List	 162
Driver’s License Number

Patient Driver’s License Number
Patient Questionnaire	 222
Patient List	 212

Spouse Drivers License Number
Patient Questionnaire	 222

Drug
Drug Name

Patient List (Filtered)	 214
Drug ID

Provider Drug ID
Provider IDs List	 284

Due
Amount Due for Payment Agreement

Collections Manager List	 70
Amount of Future Due Payment Agreements

Practice Analysis Report	 252
Balance Due

Coupon Book - Payment Agreements	 79
Coupon Book - Future Due Payments	 78

Next Payment Agreement Payment Due Amount
Patient Route Slip	 226

Number of Patients Due for Prophy (on Month and Year)
Practice Statistics Report	 256

Payment Amount Due
Coupon Book - Payment Agreements	 79
Coupon Book - Future Due Payments	 78

Doctor/Other (continued)
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Percent of Patients Due for Prophy (Month and Year)
Practice Statistics Report	 256

Total Amount Due for Payment Agreements
Collections Manager List	 70

Total Amount of Payment Agreement Payments Due
Payment Agreement Report	 234

Due Date
Continuing Care Due Date

Letter Merge Reports	 158
Patient List (Filtered)	 214
Continuing Care Display List	 76

Continuing Care Due Dates
Patient Route Slip	 226

Continuing Care Note Continuing Care Due Date
Patient Notes Report	 216

Next Payment Agreement Payment Due Date
Patient Route Slip	 226

Payment Agreement Payment Due Date
Payment Agreement Amortization Schedule	 232

Payment Due Date
Coupon Book - Payment Agreements	 79
Coupon Book - Future Due Payments	 78

Electronic Exchange
Number of TCs (Transition of Care) and Referrals where 
SCs (Summary of Care) Was Exchanged Electronically

Meaningful Use Measure Calculation List	 162
Electronic Health Information

Number of Patients Provided API Access to Electronic 
Health Information

Meaningful Use Measure Calculation List	 162
Number of Patients Provided Timely Online Access to 
Electronic Health Information

Meaningful Use Measure Calculation List	 162
Number of Patients who Accessed Electronic Health 
Information with API

Meaningful Use Measure Calculation List	 162
Number of Patients who Viewed or Downloaded or 
Transmitted (VDT) Electronic Health Information

Meaningful Use Measure Calculation List	 162
Electronic Prescription

Number of Electronic Prescriptions
Meaningful Use Measure Calculation List	 162

Number of Patients with Electronic Prescriptions
Meaningful Use Measure Calculation List	 162

Electronic Summary of Care
Number of TCs (Transition of Care) and Referrals where 
Electronic SCs (Summary of Care) Provided

Meaningful Use Measure Calculation List	 162
Eligibility

Insurance Eligibility Date
Insurance Eligibility Report	 152

Last Eligibility Date for Primary Insurance Coverage
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Last Eligibility Date for Secondary Insurance Coverage
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Number of Patients Eligible for Prophy Continuing Care
Practice Statistics Report	 256

Percent of Patients Eligible for Prophy Continuing Care
Practice Statistics Report	 256

Primary Eligibility Date
Appointment Book View Printout	 14

Secondary Eligibility Date
Appointment Book View Printout	 14

Email
Email Address

Collections Manager List	 70
Patient Email Address

Patient Questionnaire	 222
Patient List	 212

Spouse Email Address
Patient Questionnaire	 222

Employee
Number of Employees

Employers and Employed Patients Report	 122
Employer

Employer Address
Letter Merge Reports	 158
Employers and Employed Patients Report	 122

Employer Address (for Guarantor)
Patient Questionnaire	 222

Employer Address (for Patient)
Patient Questionnaire	 222

Employer Name
Employers and Employed Patients Report	 122
Letter Merge Reports	 158
Patient Route Slip	 226
Document Center Document	 116

Employer Name (for Guarantor)
Patient Questionnaire	 222

Employer Name (for Patient)
Patient Questionnaire	 222

Employer Phone Number
Letter Merge Reports	 158
Employers and Employed Patients Report	 122

Guarantor Employer
Patient Route Slip	 226

Insurance Plan Employer
Insurance Carrier List	 138

Insurance Plan Employer Name
Walkout - Doctor’s Statement	 368
Provider IDs List	 284

Patient Employer
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Patient Employer Name
Insurance Carrier List	 138

Primary Insurance Carrier Plan Employer
Patient Route Slip	 226

Secondary Insurance Carrier Plan Employer
Patient Route Slip	 226

Subscriber Employer Name
Insurance Carrier List	 138

Subscriber’s Employer Address for Primary Insurance
Patient Questionnaire	 222

Subscriber’s Employer Address for Secondary Insurance
Patient Questionnaire	 222

Subscriber’s Employer Name for Primary Insurance
Patient Questionnaire	 222

Due (continued)
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Subscriber’s Employer Name for Secondary Insurance
Patient Questionnaire	 222

EMR Number
Patient EMR Number

UDS - Insurance Financial Class Report	 342
UDS - Insurance Financial Class Report (2013)	344
UDS - Medicaid/Medicare Report	 346
UDS - Patient Status Report	 350
UDS - Sealant Statistics Report	 352
UDS - Tobacco Use and Intervention Report	 354
UDS - Age/Gender Report	 334

Enabled
Disabled/Enabled

Multi-Code List	 188
Enclosed

Amount Enclosed
Coupon Book - Future Due Payments	 78
Coupon Book - Payment Agreements	 79
Billing Statement	 48

Encounter
Encounter Number

Audit Report - Transactions	 38
Clinical Notes Report	 64
Operator Day Sheet Report	 194
Audit Report - Combined	 32

Encounter Number Change
Audit Report - Transactions	 38

Number of Encounters
UDS - Encounters and Users by Selected Proce-
dure Codes Report	 338

Number of Encounters for Primary Providers
UDS - Encounters by Provider Report	 340

Number of Encounters for Secondary Providers
UDS - Encounters by Provider Report	 340

Number of New-patient Encounters
Meaningful Use Measure Calculation List	 162

Total Number of Encounters
Operator Day Sheet Report	 194

Total Number of Unique Encounters
Operator Day Sheet Report	 194

Ending Balance
Amount of Ending Balances for Clinic

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Ending Balances for Provider
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Ending Balance
Analysis Summary Report - Standard	 12
Provider A/R Totals - Daily Report	 276
Analysis Summary Report - Daily	 8

Ending Balance (Average)
Practice Analysis Report	 252

Ending Balance (for Date Range)
Practice Analysis Report	 252

Ending Balance (MTD)
Practice Analysis Report	 252

Ending Balance (YTD)
Practice Analysis Report	 252

Ending Balance for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Amount of Ending Balances
Analysis Summary Report - Standard	 12
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Entity Name
Attachment Entity Name

Document Center Documents Audited Report	
118
Document Center - Documents List Report	 112

Entity Type
Attachment Entity Type

Document Center Documents Audited Report	
118
Document Center - Documents List Report	 112

Entry
Deleted Entry

Audit Report - Patients	 34
Initial Entry

Audit Report - Patients	 34
Office Journal Entry

Office Journal Report	 192
Office Journal Entry Date

Office Journal Report	 192
Office Journal Entry Information

Office Journal Report	 192
Office Journal Entry Time

Office Journal Report	 192
Previous Office Journal Entry

Collections Manager List	 70
Entry Date

Entry Date
Audit Report - Transactions	 38
Day Sheet (Adjustments) Report	 90
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Receipts) Report	 98
Day Sheet Report	 100
Insurance Carrier Production - Full Report	 142
Operator Day Sheet Report	 194
Patient Health Assessment Report	 206
Patient List (Filtered)	 214
Patient Revenue List by Payer Report	 224
Patient Treatment Case Report	 228
Practice Treatment Case Report	 258
Procedures by Contracted Amount Report	 268
Production Summary Report	 272
Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
RVU Day Sheet Report	 308
RVU Production Summary Report	 310
Suspended Credits Report	 324
Audit Report - Combined	 32

Office Journal Entry Date
Office Journal Report	 192

Error Type
Document Error Type

Document Center Documents Audited Report	
118

Employer (continued)
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Number of Document Errors
Document Center Audit Documents Report	 114

Number of Incorrect Location Errors
Document Center Audit Documents Report	 114

Number of Incorrect Record Errors
Document Center Audit Documents Report	 114

Number of Other Errors
Document Center Audit Documents Report	 114

Number of Poor Scan Errors
Document Center Audit Documents Report	 114

Percent of Document Errors
Document Center Audit Documents Report	 114

Total Number of Document Errors
Document Center Audit Documents Report	 114

Total Number of Incorrect Location Errors
Document Center Audit Documents Report	 114

Total Number of Incorrect Record Errors
Document Center Audit Documents Report	 114

Total Number of Other Errors
Document Center Audit Documents Report	 114

Total Number of Poor Scan Errors
Document Center Audit Documents Report	 114

Total Percent of Document Errors
Document Center Audit Documents Report	 114

Estimate
Account Estimated Insurance Portion

Patient Route Slip	 226
Amount of Estimated Insurance Portion

Insurance Claim Aging Report	 146
Amount of Estimated Primary Insurance Benefits Re-
maining YTD for Family

Treatment Case Report	 326
Amount of Estimated Primary Insurance Benefits Re-
maining YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Estimated Secondary Insurance Benefits 
Remaining YTD for Family

Treatment Case Report	 326
Amount of Estimated Secondary Insurance Benefits 
Remaining YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Insurance Estimate
Billing Statement	 48

Amount of Insurance Estimates
Aging/Credit Balance Report	 6

Amount of Pending Estimated Primary Insurance Por-
tions YTD for Family

Treatment Case Report	 326
Amount of Pending Estimated Primary Insurance Por-
tions YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Pending Estimated Secondary Insurance 
Portions YTD for Family

Treatment Case Report	 326

Amount of Pending Estimated Secondary Insurance 
Portions YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Estimated Amount of Deductibles to Be Applied
Treatment Case Report	 326
Patient Treatment Case Report	 228

Estimated Amount of Insurance Payments
Treatment Case Report	 326
Patient Treatment Case Report	 228

Estimated Amount of Patient’s Portion
Patient Treatment Case Report	 228
Treatment Case Report	 326
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Estimated Guarantor Portion
Patient Route Slip	 226

Estimated Insurance Portion
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220
Dental Encounters Report	 106

Estimated Patient Portion
Patient Route Slip	 226

Guarantor Estimate Amount
Collections Manager List	 70

Insurance Estimate Amount
Collections Manager List	 70

Insurance Estimated Amount
Walkout - Family Walkout	 370

Outstanding Primary Insurance Estimated Amount
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Outstanding Secondary Insurance Estimated Amount
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Patient Estimated Insurance Portion
Patient Route Slip	 226

Percent of Insurance Estimate Amounts
Aging/Credit Balance Report	 6

Pre-treatment Estimate Amount
Patient Route Slip	 226
Pre-Treatment Estimate Aging Report	 262
Pre-Treatment Estimates Not Sent Report	 264
Secondary Pre-Treatment Estimates Not Created 
Report	 320
Insurance Transaction Analysis Report	 154

Pre-treatment Estimate Date
Pre-Treatment Estimates Not Sent Report	 264

Pre-treatment Estimate Expiration Date
Secondary Pre-Treatment Estimates Not Created 
Report	 320
Pre-Treatment Estimates Not Sent Report	 264

Pre-treatment Estimate On Hold Date
Pre-Treatment Estimate Aging Report	 262

Pre-treatment Estimate Re-sent Date
Pre-Treatment Estimate Aging Report	 262

Pre-treatment Estimate Sent Date
Pre-Treatment Estimate Aging Report	 262

Pre-treatment Estimate Tracer Date
Pre-Treatment Estimate Aging Report	 262

Error Type (continued)
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Primary Insurance Estimated Amount
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Primary Pre-treatment Estimate Date
Secondary Pre-Treatment Estimates Not Created 
Report	 320

Primary Pre-treatment Estimate Sent Date
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Secondary Insurance Estimated Amount
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Secondary Pre-treatment Estimate Sent Date
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Total Amount for Primary Pre-treatment Estimates
Pre-Treatment Estimate Aging Report	 262

Total Amount for Secondary Pre-treatment Estimates
Pre-Treatment Estimate Aging Report	 262

Total Amount of Account Balances Aged 1 - 30 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 1 - 30 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 1 - 30 for Sec-
ondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 181+ for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 181+ for Pri-
mary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Pre-Treatment Estimate Aging Report	 262

Total Amount of Account Balances Aged 181+ for Sec-
ondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262

Total Amount of Account Balances Aged 31 - 60 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances with Pre-treatment 
Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances with Primary Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances with Secondary Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Estimated Insurance Portion for Pri-
mary and Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Estimated Insurance Portion for Pri-
mary Claims

Insurance Claim Aging Report	 146
Total Amount of Estimated Insurance Portion for Sec-
ondary Claims

Insurance Claim Aging Report	 146
Total Amount of Guarantor Estimates

Collections Manager List	 70
Total Amount of Insurance Estimates

Collections Manager List	 70
Aging/Credit Balance Report	 6

Total Amount of Pre-treatment Estimates
Pre-Treatment Estimate Aging Report	 262

Total Amount of Pre-treatment Estimates not Sent
Pre-Treatment Estimates Not Sent Report	 264

Total Amount of Primary Pre-treatment Estimates not 
Sent

Pre-Treatment Estimates Not Sent Report	 264
Total Amount of Secondary Pre-treatment Estimates not 
Created

Secondary Pre-Treatment Estimates Not Created 
Report	 320

Total Estimated Amount of Patient’s Portion
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Estimate (continued)
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Total Estimated Insurance Portion
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Ethnicity
Ethnicity

UDS - Patient Status Report	 350
Patient Ethnicity

Patient List (Filtered)	 214
Exam

Perio Exam Comparison Data Chart
Perio - Combined Graphic & Data Chart Report	
238

Perio Exam Comparison Graphic Chart
Perio - Combined Graphic & Data Chart Report	
238

Perio Exam Date
Perio - Combined Graphic & Data Chart Report	
238
Perio - Data Chart Report	 240
Perio - Exam Comparison Report	 242
Perio - Pocket Depths Only Report	 246
Perio Exam List	 248
Patient Notes Report	 216

Perio Exam Graphic Chart
Perio - Combined Graphic & Data Chart Report	
238

Perio Exam Note
Patient Notes Report	 216

Perio Exam Provider Name
Perio - Data Chart Report	 240
Perio - Pocket Depths Only Report	 246
Perio - Combined Graphic & Data Chart Report	
238

Expense
Amount of Lab Expenses for Clinic

RVU Day Sheet Report	 308
Amount of Lab Expenses for Medicaid Procedures for 
Clinic

RVU Production Summary Report	 310
Amount of Lab Expenses for Medicaid Procedures for 
Provider

RVU Production Summary Report	 310
Amount of Lab Expenses for Provider

RVU Day Sheet Report	 308
Amount of Lab Expenses of Non-Medicaid Procedures 
for Clinic

RVU Production Summary Report	 310
Amount of Lab Expenses of Non-Medicaid Procedures 
for Provider

RVU Production Summary Report	 310
Amount of Lab Expenses of Procedures for Clinic

RVU Production Summary Report	 310
Amount of Lab Expenses of Procedures for Provider

RVU Production Summary Report	 310
Lab Expense

RVU Schedules Report	 314
Fee Schedules Report	 128

Lab Expense Amount
RVU Day Sheet Report	 308

Total Amount of Lab Expenses
RVU Day Sheet Report	 308

Total Amount of Lab Expenses of Medicaid Procedures
RVU Production Summary Report	 310

Total Amount of Lab Expenses of Non-Medicaid Proce-
dures

RVU Production Summary Report	 310
Total Amount of Lab Expenses of Procedures

RVU Production Summary Report	 310
Expiration Date

Case Expiration Date
Practice Treatment Case Report	 258

Claim Expiration Date
Procedures Not Attached to Insurance Report	270
Secondary Insurance Claims Not Created Report	
318
Insurance Claims Not Sent Report	 148

Pre-treatment Estimate Expiration Date
Secondary Pre-Treatment Estimates Not Created 
Report	 320
Pre-Treatment Estimates Not Sent Report	 264

Primary Insurance Benefits Expiration Date for Patient
Treatment Case Report	 326
Patient Treatment Case Report	 228

Secondary Insurance Benefits Expiration Date for Family
Treatment Case Report	 326

Secondary Insurance Benefits Expiration Date for 
Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Export
Exported Patient Health Information

Audit Report - Combined	 32
Extension

Guarantor Work Phone Number & Extension
Collections Manager List	 70

Patient Work Phone Extension
Patient Ledger Report	 210
Patient Questionnaire	 222
Letter Merge Reports	 158

Practice Phone Extension
Letter Merge Reports	 158

Spouse Work Phone Extension
Patient Questionnaire	 222

ExtID
Patient Ext ID

Patient List (Filtered)	 214
Facial

Clinical Attachment Level (Facial)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Furcation Involvement (Facial)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Gingival Margin (Facial)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Estimate (continued)
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Mobility (Facial)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Probing Depth (Facial)
Perio - Data Chart Report	 240
Perio - Exam Comparison Report	 242
Perio - Pocket Depths Only Report	 246
Perio - Combined Graphic & Data Chart Report	
238

Family
Amount of Annual Primary Insurance Plan Benefits for 
Family

Treatment Case Report	 326
Amount of Annual Secondary Insurance Plan Benefits 
for Family

Treatment Case Report	 326
Amount of Estimated Primary Insurance Benefits Re-
maining YTD for Family

Treatment Case Report	 326
Amount of Estimated Secondary Insurance Benefits 
Remaining YTD for Family

Treatment Case Report	 326
Amount of Other Deductible Owed by Family to Pri-
mary Insurance

Patient Route Slip	 226
Amount of Other Deductible Owed by Family to Sec-
ondary Insurance

Patient Route Slip	 226
Amount of Pending Estimated Primary Insurance Por-
tions YTD for Family

Treatment Case Report	 326
Amount of Pending Estimated Secondary Insurance 
Portions YTD for Family

Treatment Case Report	 326
Amount of Preventative Deductible Owed by Family to 
Primary Insurance

Patient Route Slip	 226
Amount of Preventative Deductible Owed by Family to 
Secondary Insurance

Patient Route Slip	 226
Amount of Primary Insurance Paid Benefits YTD for 
Family

Treatment Case Report	 326
Amount of Secondary Paid Benefits for Family

Treatment Case Report	 326
Amount of Standard Deductible Owed by Family to 
Primary Insurance

Patient Route Slip	 226
Amount of Standard Deductible Owed by Family to 
Secondary Insurance

Patient Route Slip	 226
Family Alert Note

Patient Notes Report	 216
Family Balance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Family Benefits
Insurance Carrier List	 138

Number of Families
Practice Analysis Report	 252

Other Deductible Owed by Family to Primary Insurance
Treatment Case Report	 326

Other Deductible Owed by Family to Secondary Insur-
ance

Treatment Case Report	 326
Preventative Deductible Owed by Family to Primary Ins

Treatment Case Report	 326
Preventative Deductible Owed by Family to Secondary 
Ins

Treatment Case Report	 326
Primary Insurance Benefits Expiration Date for Family

Treatment Case Report	 326
Secondary Insurance Benefits Expiration Date for Family

Treatment Case Report	 326
Standard Deductible Owed by Family to Primary Insur-
ance

Treatment Case Report	 326
Standard Deductible Owed by Family to Secondary 
Insurance

Treatment Case Report	 326
Total Amount of YTD Finance Charges for Family

Family Ledger Report (Single Family)	 126
Total Amount of YTD Insurance Payments for Family

Family Ledger Report (Single Family)	 126
Family Ledger Report	 124

Total Amount of YTD Late Charges for Family
Family Ledger Report (Single Family)	 126
Family Ledger Report	 124

Total Amount of YTD Payments for Family
Family Ledger Report (Single Family)	 126
Family Ledger Report	 124

Total Family Balance (as of a Date)
Family Ledger Report (Single Family)	 126
Family Ledger Report	 124

Total Family Balance as of a Date
Patient’s Ledger Report	 230

Total YTD Finance Charges for Family
Family Ledger Report	 124

Family Alert
Family Alert Note

Patient Notes Report	 216
Family Health History

Number of Patients with Family Health History Re-
corded

Meaningful Use Measure Calculation List	 162
Family Member

Family Member Balance (as of a Date)
Patient’s Ledger Report	 230

Family Position
Family Position

Collections Manager List	 70
Fax

Patient Fax Number
Patient Questionnaire	 222
Patient List	 212

Spouse Fax Number
Patient Questionnaire	 222

Facial (continued)
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Fee
Amount of Current Charges Compared to Fee Schedule 
for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Fees - Co-pays for Insurance Carrier

Utilization Report	 366
Amount of Fees for Insurance Carrier

Utilization Report	 366
RVU Utilization Report	 316

Case Amount
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Fee
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Fee for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Fee for Visit
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Fee from Alternate Fee Schedule
Treatment Case Report	 326

Fee from Alternate Fee Schedule for Visit
Treatment Case Report	 326

Fee Schedule
Fee Schedules Report	 128

Net Difference of Current Charges and Fee Schedule 
for Provider

Day Sheet (Charges and Receipts) Report	 94
Net Difference of Total Current Charges and Fee 
Schedule

Day Sheet (Charges and Receipts) Report	 94
Procedure Fee

Utilization Report	 366
RVU Utilization Report	 316

Total Amount of Current Charges Compared to Fee 
Schedule

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Fees

Utilization Report	 366
RVU Utilization Report	 316

Total Amount of Fees - Co-pays
Utilization Report	 366

Total Amount of Fees - RVU
RVU Utilization Report	 316

Total Case Amount
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Total Fee for Case
Treatment Case Report	 326

Total Fee from Alternate Fee Schedule for Case
Treatment Case Report	 326

Fee Schedule
Amount of Current Charges Compared to Fee Schedule 
for Provider

Day Sheet (Charges and Receipts) Report	 94
Fee from Alternate Fee Schedule

Treatment Case Report	 326

Fee from Alternate Fee Schedule for Visit
Treatment Case Report	 326

Fee Schedule
Fee Schedules Report	 128

Net Difference of Current Charges and Fee Schedule 
for Provider

Day Sheet (Charges and Receipts) Report	 94
Net Difference of Total Current Charges and Fee 
Schedule

Day Sheet (Charges and Receipts) Report	 94
Provider Fee Schedule

Practice Organization List	 254
Provider IDs List	 284
Audit Report - Providers/Staff	 36

Provider Fee Schedule Change
Audit Report - Providers/Staff	 36

Total Amount of Current Charges Compared to Fee 
Schedule

Day Sheet (Charges and Receipts) Report	 94
FeeInsurance Carrier

Amount of Fees - RVU for Insurance Carrier
RVU Utilization Report	 316

Female
Number of Female Patients

Practice Statistics Report	 256
Number of Females

UDS - Age/Gender Report	 334
Number of Females for Clinic

UDS - Age/Gender Report	 334
Number of Females for Provider

UDS - Age/Gender Report	 334
Percent of Female Patients

Practice Statistics Report	 256
Total Number of Females

UDS - Age/Gender Report	 334
File

File Description
Document Center Documents Audited Report	
118
Document Center - Documents List Report	 112

File Location
Document Center - Documents List Report	 112

File Type
Document Center Documents Audited Report	
118
Document Center - Documents List Report	 112

Finance Charge
Amount of Current Finance Charges for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Finance Charges

Provider A/R Totals - Daily Report	 276
Amount of Finance Charges (Average)

Practice Analysis Report	 252
Amount of Finance Charges (for Date Range)

Practice Analysis Report	 252
Amount of Finance Charges (MTD)

Practice Analysis Report	 252
Amount of Finance Charges (YTD)

Practice Analysis Report	 252
Amount of Finance Charges for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
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Finance Charge Report	 130
Analysis Summary Report - Daily	 8

Amount of Finance Charges for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Finance Charges for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Finance Charge Report	 130
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Finance Charges YTD
Walkout - Family Walkout	 370

Amount of MTD Finance Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Finance Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Average Amount of Finance Charges
Day Sheet (Adjustments) Report	 90

Finance Charge Amount
Analysis Summary Report - Daily	 8
Analysis Summary Report - Standard	 12
Finance Charge Report	 130
Adjustment Summary Report	 4

Finance Charge Date
Finance Charge Report	 130

Finance Charge Percent
Payment Agreement Report	 234

Total Amount of Current Finance Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Finance Charges
Analysis Summary Report - Daily	 8
Analysis Summary Report - Standard	 12
Day Sheet (Adjustments) Report	 90
Day Sheet Report	 100
Finance Charge Report	 130
Operator Day Sheet Report	 194
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Truth in Lending Disclosure Statement	 332
Adjustment Summary Report	 4

Total Amount of Finance Charges for Previous Month
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Finance Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Finance Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Finance Charges for Family
Family Ledger Report (Single Family)	 126

Total Quantity of Finance Charges
Day Sheet (Adjustments) Report	 90

Total YTD Finance Charges for Family
Family Ledger Report	 124

Finance Status
Case Finance Status

Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Financed
Amount Financed

Truth in Lending Disclosure Statement	 332
Financial Class

20+ Years Old for Financial Class Type
UDS - Insurance Financial Class Report	 342

20+ Years Old for Financial Class Type for Clinic
UDS - Insurance Financial Class Report	 342

20+ Years Old for Financial Class Type for Provider
UDS - Insurance Financial Class Report	 342

20+ Years Old for Financial Class Types
UDS - Insurance Financial Class Report	 342

Financial Class
UDS - Insurance Financial Class Report (2013)	344
UDS - Medicaid/Medicare Report	 346
UDS - Patient Status Report	 350
Insurance Carrier List	 138

Number <19 Years Old for Financial Class Type
UDS - Insurance Financial Class Report	 342

Number <19 Years Old for Financial Class Type for 
Clinic

UDS - Insurance Financial Class Report	 342
Number <19 Years Old for Financial Class Type for 
Provider

UDS - Insurance Financial Class Report	 342
Number 0 - 17 Years Old for Financial Class Type

UDS - Insurance Financial Class Report (2013)	344
Number 18+ for Financial Class Type

UDS - Insurance Financial Class Report (2013)	344
Number of Medicaid and Medicare Patients in First Age 
Group with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients with Finan-
cial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in First Age Group with 
Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in Second Age Group 
with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in First Age Group with 
Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in Second Age Group 
with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Users for Financial Class Type

UDS - Insurance Financial Class Report	 342
Number of Users for Financial Class Type for Clinic

UDS - Insurance Financial Class Report	 342
Number of Users for Financial Class Type for Provider

UDS - Insurance Financial Class Report	 342
Total Number <19 Years Old for Financial Class Types

UDS - Insurance Financial Class Report	 342

Finance Charge (continued)
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Total Number for Financial Class Type
UDS - Insurance Financial Class Report (2013)	344

Total Number of Users for Financial Class Types
UDS - Insurance Financial Class Report	 342

Financial Class Type
20+ Years Old for Financial Class Type

UDS - Insurance Financial Class Report	 342
20+ Years Old for Financial Class Type for Clinic

UDS - Insurance Financial Class Report	 342
20+ Years Old for Financial Class Type for Provider

UDS - Insurance Financial Class Report	 342
20+ Years Old for Financial Class Types

UDS - Insurance Financial Class Report	 342
Financial Class Type

UDS - Patient Related Revenue Report	 348
UDS - Insurance Financial Class Report	 342

Subtotal of Allowances for Financial Class Type
UDS - Patient Related Revenue Report	 348

Subtotal of Amount Collected for Financial Class Type
UDS - Patient Related Revenue Report	 348

Subtotal of Bad Debt Write-offs for Financial Class Type
UDS - Patient Related Revenue Report	 348

Subtotal of Charges for Financial Class Type
UDS - Patient Related Revenue Report	 348

Subtotal of Other Retroactive Payment Amount Col-
lected for Financial Class Type

UDS - Patient Related Revenue Report	 348
Subtotal of Penalty or Payback Amount Collected for 
Financial Class Type

UDS - Patient Related Revenue Report	 348
Subtotal of Sliding Discounts for Financial Class Type

UDS - Patient Related Revenue Report	 348
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Financial Class Type (Current Year)

UDS - Patient Related Revenue Report	 348
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Financial Class Type (Previous Years)

UDS - Patient Related Revenue Report	 348
Total Amount Collected for Financial Class Type

UDS - Patient Related Revenue Report	 348
Total Amount of Allowances for Financial Class Type

UDS - Patient Related Revenue Report	 348
Total Amount of Bad Debt Write-offs for Financial Class 
Type

UDS - Patient Related Revenue Report	 348
Total Amount of Charges for Financial Class Type

UDS - Patient Related Revenue Report	 348
Total Amount of Sliding Discounts for Financial Class 
Type

UDS - Patient Related Revenue Report	 348
Total Other Retroactive Payment Amount Collected for 
Financial Class Type

UDS - Patient Related Revenue Report	 348
Total Penalty or Payback Amount Collected for Financial 
Class Type

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Financial Class Type (Current Year)

UDS - Patient Related Revenue Report	 348

Total Wrap Around or Reconciliation Amount Collected 
for Financial Class Type (Previous Years)

UDS - Patient Related Revenue Report	 348
First Visit Date

First Visit Date
New Patient List	 190
Patient List	 212
Patient Route Slip	 226
Letter Merge Reports	 158

Fiscal Year
Fiscal Year Month

Audit Report - Clinics	 30
Fiscal Year Month Change

Audit Report - Clinics	 30
Practice Fiscal Year Month

Registration Information Report	 306
Fluoride Varnish

Number of Patients 0 - 19 Years with Fluoride Varnish
Clinical Quality Measures List	 66

Follow up
Number of Patients 65+ Years with Abnormal BMI 
Reading and Follow Up

Clinical Quality Measures List	 66
Form

Consent Form
Treatment Case Report	 326

Format
Claim Format

Insurance Carrier List	 138
Furcation Grade

Furcation Grade
Perio - Data Chart Report	 240
Perio - Combined Graphic & Data Chart Report	
238

Furcation Involvement
Furcation Involvement (Facial)

Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Furcation Involvement (Lingual)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Future Due Payment Agreement
Future Due Payment Plan Total

Future Due Payment Plan Report - Standard	 134
Future Due Payment Plan

Amount of Future Due Payment Agreements
Practice Analysis Report	 252

Future Due Payment Plan Date
Future Due Payment Plan Report - Standard	 134

Gender
Number of All Genders

UDS - Age/Gender Report	 334
Number of All Genders for Clinic

UDS - Age/Gender Report	 334
Number of All Genders for Provider

UDS - Age/Gender Report	 334
Number of Female Patients

Practice Statistics Report	 256

Financial Class (continued)
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Number of Females
UDS - Age/Gender Report	 334

Number of Females for Clinic
UDS - Age/Gender Report	 334

Number of Females for Provider
UDS - Age/Gender Report	 334

Number of Male Patients
Practice Statistics Report	 256

Number of Males
UDS - Age/Gender Report	 334

Number of Males for Clinic
UDS - Age/Gender Report	 334

Number of Males for Provider
UDS - Age/Gender Report	 334

Number of Other Gender
UDS - Age/Gender Report	 334

Number of Other Gender for Clinic
UDS - Age/Gender Report	 334

Number of Other Gender for Provider
UDS - Age/Gender Report	 334

Number of Unknown Gender
UDS - Age/Gender Report	 334

Number of Unknown Gender for Clinic
UDS - Age/Gender Report	 334

Number of Unknown Gender for Provider
UDS - Age/Gender Report	 334

Patient Gender
Patient List	 212
Patient Questionnaire	 222
Patient Route Slip	 226
UDS - Age/Gender Report	 334
Letter Merge Reports	 158

Percent of Female Patients
Practice Statistics Report	 256

Percent of Male Patients
Practice Statistics Report	 256

Spouse Gender
Patient Questionnaire	 222

Total Number of All Genders
UDS - Age/Gender Report	 334

Total Number of Females
UDS - Age/Gender Report	 334

Total Number of Males
UDS - Age/Gender Report	 334

Total Number of Other Gender
UDS - Age/Gender Report	 334

Total Number of Unknown Gender
UDS - Age/Gender Report	 334

Gender Identity
Gender Identity

UDS - Patient Status Report	 350
Generic

Generic Substitution Permitted
Prescription Printout	 260

Gingival Margin
Gingival Margin

Perio - Data Chart Report	 240
Perio - Combined Graphic & Data Chart Report	
238

Gingival Margin (Facial)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Gingival Margin (Lingual)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Gingival Margin Graphic Chart
Perio - Exam Comparison Report	 242

Grace Period
Grace Period

Payment Agreement Report	 234
Gratuity

Gratuity Given
Referred By Patient Report	 302

Last Gratuity Amount
Patient Route Slip	 226

Last Gratuity Date
Referred By Patient Report	 302

Referred by Doctor/Other Gratuity Given
Referred By Doctor/Other Report	 300

Referred by Doctor/Other Last Gratuity Date
Referred By Doctor/Other Report	 300

Group
Insurance Plan Group Name

Insurance Claim Aging Report	 146
Insurance Coverage Tables Report	 150
Insurance Eligibility Report	 152
Patient Treatment Case Report	 228
Pre-Treatment Estimate Aging Report	 262
Provider IDs List	 284
RVU Utilization Report	 316
Updated Dental Insurance Payment Table Report	
364
Utilization Report	 366
Insurance Carrier List	 138

Insurance Plan Group NPI Number
Dental Encounters Report	 106

Group Number
Insurance Plan Group Number

Insurance Claim Aging Report	 146
Insurance Coverage Tables Report	 150
Insurance Eligibility Report	 152
Pre-Treatment Estimate Aging Report	 262
Provider IDs List	 284
RVU Utilization Report	 316
Updated Dental Insurance Payment Table Report	
364
Utilization Report	 366
Walkout - Doctor’s Statement	 368
Insurance Carrier List	 138

Insurance Plan Group Number for Primary Insurance
Patient Questionnaire	 222

Insurance Plan Group Number for Secondary Insurance
Patient Questionnaire	 222

Primary Insurance Plan Group Number
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Patient Route Slip	 226

Gender (continued)
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Secondary Insurance Plan Group Number
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Patient Route Slip	 226

Guarantor
Amount of Guarantor Payments YTD

Walkout - Family Walkout	 370
Amount of Suspended Credits for Guarantor

Suspended Credits Report	 324
Employer Address (for Guarantor)

Patient Questionnaire	 222
Employer Name (for Guarantor)

Patient Questionnaire	 222
Estimated Guarantor Portion

Patient Route Slip	 226
Family Position

Collections Manager List	 70
Guarantor Address

Family Ledger Report	 124
Family Ledger Report (Single Family)	 126
Patient Route Slip	 226
Truth in Lending Disclosure Statement	 332
Walkout - Family Walkout	 370
Billing Statement	 48

Guarantor Billing Type
Patient Route Slip	 226

Guarantor Birth Date & Age
Collections Manager List	 70

Guarantor Chart Number
Collections Manager List	 70
Family Ledger Report	 124
Family Ledger Report (Single Family)	 126
Payment Agreement Amortization Schedule	 232
Truth in Lending Disclosure Statement	 332
Walkout - Family Walkout	 370
Billing Statement	 48

Guarantor City
Collections Manager List	 70

Guarantor Employer
Patient Route Slip	 226

Guarantor Estimate Amount
Collections Manager List	 70

Guarantor First Name
Letter Merge Reports	 158

Guarantor Home Phone Number
Collections Manager List	 70
Collections Manager List	 70
Future Due Payment Plan Report - Standard	 134
Patient Route Slip	 226
Payment Agreement Report	 234
Truth in Lending Disclosure Statement	 332
Aging/Credit Balance Report	 6

Guarantor Last Name
Letter Merge Reports	 158

Guarantor Name
Audit Report - Patients	 34
Billing Statement	 48
Collections Manager List	 70
Family Ledger Report	 124
Family Ledger Report (Single Family)	 126

Finance Charge Report	 130
Future Due Payment Plan Report - Standard	 134
Late Charge Report	 156
Patient Route Slip	 226
Patient’s Ledger Report	 230
Payment Agreement Amortization Schedule	 232
Payment Agreement Report	 234
Suspended Credits Report	 324
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Truth in Lending Disclosure Statement	 332
Walkout - Family Walkout	 370
Aging/Credit Balance Report	 6

Guarantor Name Change
Audit Report - Patients	 34

Guarantor Note
Patient Notes Report	 216
Aging/Credit Balance Report	 6

Guarantor Portions
Aging/Credit Balance Report	 6

Guarantor Social Security Number
Patient Route Slip	 226
Truth in Lending Disclosure Statement	 332
Collections Manager List	 70

Guarantor State
Collections Manager List	 70

Guarantor Work Phone Number
Patient Route Slip	 226

Guarantor Work Phone Number & Extension
Collections Manager List	 70

Guarantor Zip Code
Collections Manager List	 70

Number of Active Patient Guarantors
Practice Statistics Report	 256

Number of Non-patient Guarantors
Practice Statistics Report	 256

Percent of Active Patient Guarantors
Practice Statistics Report	 256

Percent of Guarantor Portions
Aging/Credit Balance Report	 6

Percent of Non-patient Guarantors
Practice Statistics Report	 256

Total Amount of Guarantor Estimates
Collections Manager List	 70

Total Amount of Guarantor Portions
Aging/Credit Balance Report	 6

Guarantor Portion
Estimated Guarantor Portion

Patient Route Slip	 226
Guarantor Estimate Amount

Collections Manager List	 70
Guarantor Portions

Aging/Credit Balance Report	 6
Percent of Guarantor Portions

Aging/Credit Balance Report	 6
Total Amount of Guarantor Estimates

Collections Manager List	 70
Total Amount of Guarantor Portions

Aging/Credit Balance Report	 6
Health Information

Number of Patients with Incorporated Health Data
Meaningful Use Measure Calculation List	 162

Group Number (continued)



490   Index by Report Item

Dentrix Enterprise 11.0.2 Reports Reference

Height
Height

Patient Health Assessment Report	 206
High-risk

Number of Patients 66+ Years with 1+ High-risk Medica-
tions

Clinical Quality Measures List	 66
Number of Patients 66+ Years with 2+ High-risk Medica-
tions

Clinical Quality Measures List	 66
Homeless Status

Homeless Status
UDS - Patient Status Report	 350

Patient Homeless Status
Patient List (Filtered)	 214

Housing Status
Housing Status

UDS - Patient Status Report	 350
Hypertension

Number of Patients 18 - 85 Years with Hypertension
Clinical Quality Measures List	 66

ICD-9CM Code
ICD-9-CM Code

Patient List (Filtered)	 214
Medical Code List	 186

ICD-9-CM Code Description
Medical Code List	 186

ID
Patient Ext ID

Patient List (Filtered)	 214
Immunization

Immunization Date
Patient List (Filtered)	 214

Immunization Time
Patient List (Filtered)	 214

Inactive
Total Inactive New Patients

New Patient List	 190
Incorporate

Number of Incorporated Electronic Summary of Care 
Documents

Meaningful Use Measure Calculation List	 162
Number of Patients with Incorporated Health Data

Meaningful Use Measure Calculation List	 162
Incorrect Location

Number of Incorrect Location Errors
Document Center Audit Documents Report	 114

Total Number of Incorrect Location Errors
Document Center Audit Documents Report	 114

Incorrect Record
Number of Incorrect Record Errors

Document Center Audit Documents Report	 114
Total Number of Incorrect Record Errors

Document Center Audit Documents Report	 114
Individual

Individual Benefits
Insurance Carrier List	 138

Lifetime/Individual/Standard Deductible
Insurance Carrier List	 138

Lifetime/Individual/Standard Other Deductible
Insurance Carrier List	 138

Lifetime/Individual/Standard Preventative Deductible
Insurance Carrier List	 138

Influenza Vaccination
Number of Patients 6+ Months who Received Influenza 
Vaccinations

Clinical Quality Measures List	 66
Information

Accessed Patient Information
Audit Report - Combined	 32

Exported Patient Health Information
Audit Report - Combined	 32

Initial Balance
Amount of Credit Initial Balances

Provider A/R Totals - Daily Report	 276
Amount of Credit Initial Balances for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Credit Initial Balances for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Debit Initial Balances (Production)
Provider A/R Totals - Daily Report	 276

Amount of Debit Initial Balances (Production) for Prov
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of Debit Initial Balances for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Debit Initial Balances for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Credit Initial Balances for 
Clinic

Day Sheet Report	 100
Amount of Other Applied Credit Initial Balances for 
Provider

Day Sheet Report	 100
Amount of Other Credit Initial Balances for Clinic

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Other Credit Initial Balances for Provider
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Credit Initial Balance
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Debit Initial Balance
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Other Credit Initial Balance
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Amount of Credit Initial Balances
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
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Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Total Amount of Debit Initial Balances
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Debit Initial Balances (Production)
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Amount of Other Applied Credit Initial Balances
Day Sheet Report	 100

Total Amount of Other Credit Initial Balances
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Initial Provider
Average Payment Amount for Initial Provider

Day Sheet (Receipts) Report	 98
Initial Provider

Day Sheet (Receipts) Report	 98
Quantity of Payments for Initial Provider

Day Sheet (Receipts) Report	 98
Total Amount of Payments for Initial Provider

Day Sheet (Receipts) Report	 98
Inserted

Inserted Appointment
Audit Report - Appointments	 26

Inserted Procedure
Audit Report - Combined	 32

Inserted Transaction
Audit Report - Transactions	 38

Insurance
Account Estimated Insurance Portion

Patient Route Slip	 226
Amount Billed to Insurance

Analysis Summary Report - Standard	 12
Collections Manager List	 70
Analysis Summary Report - Daily	 8

Amount Billed to Insurance for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount Billed to Insurance for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Annual Primary Insurance Plan Benefits for 
Family

Treatment Case Report	 326
Amount of Annual Secondary Insurance Plan Benefits 
for Family

Treatment Case Report	 326
Amount of Annual Secondary Insurance Plan Benefits 
for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Applied Insurance Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Applied Insurance Payments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Charges Billed to Insurance for Previous 
Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Claim

Insurance Claims Not Sent Report	 148
Amount of Co-pays for Insurance Carrier

Utilization Report	 366
Amount of Current Charges Billed to Insurance for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Dental Insurance Portion

Patient Chart Printout	 204
Amount of Estimated Insurance Portion

Insurance Claim Aging Report	 146
Amount of Estimated Primary Insurance Benefits Re-
maining YTD for Family

Treatment Case Report	 326
Amount of Estimated Primary Insurance Benefits Re-
maining YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Estimated Secondary Insurance Benefits 
Remaining YTD for Family

Treatment Case Report	 326
Amount of Estimated Secondary Insurance Benefits 
Remaining YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Fees - Co-pays for Insurance Carrier
Utilization Report	 366

Amount of Insurance Estimate
Billing Statement	 48

Amount of Insurance Estimates
Aging/Credit Balance Report	 6

Amount of Insurance Payments
Provider A/R Totals - Daily Report	 276

Amount of Insurance Payments for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of Insurance Payments YTD
Walkout - Family Walkout	 370

Amount of MTD Charges Billed to Insurance for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of Other Applied Insurance Payments for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Insurance Payments for 
Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Deductible Owed by Family to Pri-
mary Insurance

Patient Route Slip	 226

Initial Balance (continued)
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Amount of Other Deductible Owed by Family to Sec-
ondary Insurance

Patient Route Slip	 226
Amount of Other Deductible Owed to Primary Insur-
ance

Patient Route Slip	 226
Amount of Other Deductible Owed to Secondary Insur-
ance

Patient Route Slip	 226
Amount of Pending Estimated Primary Insurance Por-
tions YTD for Family

Treatment Case Report	 326
Amount of Pending Estimated Primary Insurance Por-
tions YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Pending Estimated Secondary Insurance 
Portions YTD for Family

Treatment Case Report	 326
Amount of Pending Estimated Secondary Insurance 
Portions YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Preventative Deductible Owed by Family to 
Primary Insurance

Patient Route Slip	 226
Amount of Preventative Deductible Owed by Family to 
Secondary Insurance

Patient Route Slip	 226
Amount of Preventative Deductible Owed to Primary 
Insurance

Patient Route Slip	 226
Amount of Preventative Deductible Owed to Secondary 
Insurance

Patient Route Slip	 226
Amount of Primary Insurance Benefits Remaining

Unscheduled Treatment Plans (Detailed) Report	
362
Patient Route Slip	 226

Amount of Primary Insurance Benefits Used
Patient Route Slip	 226

Amount of Primary Insurance Paid Benefits YTD for 
Family

Treatment Case Report	 326
Amount of Primary Insurance Paid Benefits YTD for 
Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Primary Insurance Portion
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Primary Insurance Portion for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Amount of Primary Insurance Portion for Visit
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Remaining Benefits for Primary Insurance
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Amount of Remaining Benefits for Secondary Insurance
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Amount of Secondary Insurance Benefits Remaining
Unscheduled Treatment Plans (Detailed) Report	
362
Patient Route Slip	 226

Amount of Secondary Insurance Benefits Used
Patient Route Slip	 226

Amount of Secondary Insurance Portion
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Secondary Insurance Portion for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Amount of Secondary Insurance Portion for Visit
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Standard Deductible Owed by Family to 
Primary Insurance

Patient Route Slip	 226
Amount of Standard Deductible Owed by Family to 
Secondary Insurance

Patient Route Slip	 226
Amount of Standard Deductible Owed to Primary Insur-
ance

Patient Route Slip	 226
Amount of Standard Deductible Owed to Secondary 
Insurance

Patient Route Slip	 226
Amount of Suspended Insurance Payments for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Insurance Payments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of YTD Charges Billed to Insurance for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount Paid by Insurance
Dental Encounters Report	 106

Applied Insurance Payment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Benefit Renewal Month
Insurance Carrier List	 138

Billable to Insurance
Procedure Code List	 266

Claim Amount
Secondary Insurance Claims Not Created Report	
318
Insurance Transaction Analysis Report	 154

Claim Date
Insurance Claims Not Sent Report	 148

Insurance (continued)
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Claim Expiration Date
Procedures Not Attached to Insurance Report	270
Secondary Insurance Claims Not Created Report	
318
Insurance Claims Not Sent Report	 148

Claim Format
Insurance Carrier List	 138

Claim On Hold Date
Insurance Claim Aging Report	 146

Claim Payment Received Date
Insurance Transaction Analysis Report	 154

Co-pay Calculation for Insurance Portion
Insurance Coverage Tables Report	 150

Coverage Table Name
Standard Coverage Tables Report	 322

Credit Adjustment Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Date Insurance Last Updated
Insurance Carrier List	 138

Debit Adjustment Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Deductible Type
Standard Coverage Tables Report	 322
Insurance Coverage Tables Report	 150

Do not Bill to Dental Insurance
Insurance Carrier List	 138

Do not Bill to Dental Insurance if 0% Coverage
Insurance Carrier List	 138

Do not Print Dental Diagnostic Codes on Claim
Insurance Carrier List	 138

Estimated Amount of Deductibles to Be Applied
Treatment Case Report	 326
Patient Treatment Case Report	 228

Estimated Amount of Insurance Payments
Treatment Case Report	 326
Patient Treatment Case Report	 228

Estimated Insurance Portion
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220
Dental Encounters Report	 106

Family Benefits
Insurance Carrier List	 138

Grand Total Amount of Insurance Payments Received
Insurance Transaction Analysis Report	 154

Grand Total Amount of Insured Charges
Insurance Transaction Analysis Report	 154

Grand Total Number of Insurance Claims Sent
Insurance Transaction Analysis Report	 154

Grand Total Number of Insurance Payments Received
Insurance Transaction Analysis Report	 154

Grand Total Number of Insured Charges
Insurance Transaction Analysis Report	 154

Grand Total Number of Paid/Received Claims
Insurance Transaction Analysis Report	 154

Individual Benefits
Insurance Carrier List	 138

Insurance Claim Note
Patient Notes Report	 216

Insurance Coverage Percent (Basic) for Primary Insur-
ance

Patient Route Slip	 226
Insurance Coverage Percent (Basic) for Secondary Insur-
ance

Patient Route Slip	 226
Insurance Coverage Percent (Major) for Primary Insur-
ance

Patient Route Slip	 226
Insurance Coverage Percent (Major) for Secondary 
Insurance

Patient Route Slip	 226
Insurance Coverage Percent (Orthodontics) for Primary 
Insurance

Patient Route Slip	 226
Insurance Coverage Percent (Orthodontics) for Second-
ary Insurance

Patient Route Slip	 226
Insurance Coverage Percent (Preventative) for Primary 
Insurance

Patient Route Slip	 226
Insurance Coverage Percent (Preventative) for Second-
ary Insurance

Patient Route Slip	 226
Insurance Coverage Type

Insurance Claims Not Sent Report	 148
Insurance Eligibility Report	 152
Pre-Treatment Estimate Aging Report	 262
Pre-Treatment Estimates Not Sent Report	 264
Insurance Claim Aging Report	 146

Insurance Eligibility Date
Insurance Eligibility Report	 152

Insurance Estimate Amount
Collections Manager List	 70

Insurance Estimated Amount
Walkout - Family Walkout	 370

Insurance Payment Amount
Insurance Carrier Production - Full Report	 142

Insurance Payment Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Insurance Payment for Date of Service
Letter Merge Reports	 158

Last Eligibility Date for Primary Insurance Coverage
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Last Eligibility Date for Secondary Insurance Coverage
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Lifetime/Individual/Standard Deductible
Insurance Carrier List	 138

Lifetime/Individual/Standard Other Deductible
Insurance Carrier List	 138

Lifetime/Individual/Standard Preventative Deductible
Insurance Carrier List	 138

Maximum Primary Insurance Benefit Amount
Patient Route Slip	 226

Maximum Secondary Insurance Benefit Amount
Patient Route Slip	 226

Insurance (continued)
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Number of Patients with Dental and Medical Insurance
Practice Statistics Report	 256

Number of Patients with Primary Dental Insurance Only
Practice Statistics Report	 256

Number of Patients with Primary Medical Insurance
Practice Statistics Report	 256

Number of Patients with Secondary Dental Insurance
Practice Statistics Report	 256

Number of Patients without Dental and Medical Insur-
ance

Practice Statistics Report	 256
Number of Patients without Dental Insurance

Practice Statistics Report	 256
Number of Patients without Medical Insurance

Practice Statistics Report	 256
Other Applied Insurance Payment Amount

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Other Deductible Met
Insurance Carrier List	 138

Other Deductible Owed by Family to Primary Insurance
Treatment Case Report	 326

Other Deductible Owed by Family to Secondary Insur-
ance

Treatment Case Report	 326
Other Deductible Owed by Patient to Primary Insurance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Other Deductible Owed by Patient to Secondary Insur-
ance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Outstanding Primary Insurance Estimated Amount
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Outstanding Secondary Insurance Estimated Amount
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Patient Estimated Insurance Portion
Patient Route Slip	 226

Patient Relationship to Subscriber for Primary Insurance
Patient Questionnaire	 222

Patient Relationship to Subscriber for Secondary Insur-
ance

Patient Questionnaire	 222
Payor ID

Insurance Carrier List	 138
Pending Claims

Patient Route Slip	 226
Percent of Insurance Estimate Amounts

Aging/Credit Balance Report	 6
Percent of Patients with Dental and Medical Insurance

Practice Statistics Report	 256
Percent of Patients with Primary Dental Insurance Only

Practice Statistics Report	 256
Percent of Patients with Primary Medical Insurance

Practice Statistics Report	 256
Percent of Patients with Secondary Dental Insurance

Practice Statistics Report	 256

Percent of Patients without Dental and Medical Insur-
ance

Practice Statistics Report	 256
Percent of Patients without Dental Insurance

Practice Statistics Report	 256
Percent of Patients without Medical Insurance

Practice Statistics Report	 256
Pre-authorization Required

Standard Coverage Tables Report	 322
Insurance Coverage Tables Report	 150

Pre-treatment Estimate Amount
Patient Route Slip	 226
Pre-Treatment Estimate Aging Report	 262
Pre-Treatment Estimates Not Sent Report	 264
Secondary Pre-Treatment Estimates Not Created 
Report	 320
Insurance Transaction Analysis Report	 154

Preventative Deductible Met
Insurance Carrier List	 138

Preventative Deductible Owed by Family to Primary Ins
Treatment Case Report	 326

Preventative Deductible Owed by Family to Secondary 
Ins

Treatment Case Report	 326
Preventative Deductible Owed by Patient to Primary Ins

Treatment Case Report	 326
Patient Treatment Case Report	 228

Preventative Deductible Owed by Patient to Secondary 
Ins

Treatment Case Report	 326
Patient Treatment Case Report	 228

Primary Claim Date
Secondary Insurance Claims Not Created Report	
318

Primary Eligibility Date
Appointment Book View Printout	 14

Primary Insurance Benefits Expiration Date for Family
Treatment Case Report	 326

Primary Insurance Benefits Expiration Date for Patient
Treatment Case Report	 326
Patient Treatment Case Report	 228

Primary Insurance Benefits Remaining
Letter Merge Reports	 158

Primary Insurance Benefits Renewal Month
Patient Route Slip	 226

Primary Insurance Estimated Amount
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Primary Insurance Subscriber ID
Letter Merge Reports	 158

Projected Amount of Remaining Benefits for Secondary 
Insurance

Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Remarks for Unusual Service
Walkout - Doctor’s Statement	 368

Rendering Provider NPI Number
Dental Encounters Report	 106

Replace Initial Zero of Procedure Code on Claims
Insurance Carrier List	 138

Insurance (continued)
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Revenue for Provider from Insurance
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Secondary Eligibility Date
Appointment Book View Printout	 14

Secondary Insurance Benefits Expiration Date for Family
Treatment Case Report	 326

Secondary Insurance Benefits Expiration Date for 
Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Secondary Insurance Benefits Remaining
Letter Merge Reports	 158

Secondary Insurance Benefits Renewal Month
Patient Route Slip	 226

Secondary Insurance Estimated Amount
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Standard Deductible Met
Insurance Carrier List	 138

Standard Deductible Owed by Family to Primary Insur-
ance

Treatment Case Report	 326
Standard Deductible Owed by Family to Secondary 
Insurance

Treatment Case Report	 326
Standard Deductible Owed by Patient to Primary Insur-
ance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Standard Deductible Owed by Patient to Secondary 
Insurance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Subscriber Address for Primary Insurance
Patient Questionnaire	 222

Subscriber Address for Secondary Insurance
Patient Questionnaire	 222

Subscriber Birth Date for Primary Insurance
Patient Questionnaire	 222

Subscriber Birth Date for Secondary Insurance
Patient Questionnaire	 222

Subscriber ID for Primary Insurance
Patient Questionnaire	 222

Subscriber ID for Secondary Insurance
Patient Questionnaire	 222

Subscriber Name for Primary Insurance
Patient Route Slip	 226
Patient Questionnaire	 222

Subscriber Name for Secondary Insurance
Patient Route Slip	 226
Patient Questionnaire	 222

Subscriber’s Employer Address for Primary Insurance
Patient Questionnaire	 222

Subscriber’s Employer Address for Secondary Insurance
Patient Questionnaire	 222

Subscriber’s Employer Name for Primary Insurance
Patient Questionnaire	 222

Subscriber’s Employer Name for Secondary Insurance
Patient Questionnaire	 222

Suspended Insurance Payment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Amount Billed to Insurance
Analysis Summary Report - Standard	 12
Collections Manager List	 70
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount for Primary Pre-treatment Estimates
Pre-Treatment Estimate Aging Report	 262

Total Amount for Secondary Pre-treatment Estimates
Pre-Treatment Estimate Aging Report	 262

Total Amount of Account Balances Aged 1 - 30 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 1 - 30 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 1 - 30 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 1 - 30 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 121 - 150 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 121 - 150 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 121 - 150 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 151 - 180 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 151 - 180 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 151 - 180 with 
Secondary Claims

Insurance Claim Aging Report	 146

Insurance (continued)
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Total Amount of Account Balances Aged 181+ for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 181+ for Pri-
mary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Pre-Treatment Estimate Aging Report	 262

Total Amount of Account Balances Aged 181+ for Sec-
ondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 181+ with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 181+ with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 181+ with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 31 - 60 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 31 - 60 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 31 - 60 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 61 - 90 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 61 - 90 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 61 - 90 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 91 - 120 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262

Total Amount of Account Balances Aged 91 - 120 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 with 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 91 - 120 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 91 - 120 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Pre-treatment 
Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances with Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Primary Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances with Secondary 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Secondary Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Applied Insurance Payments

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Charges Billed to Insurance for Previ-
ous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Co-pays

Utilization Report	 366
Total Amount of Current Charges Billed to Insurance

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Dental Insurance Portions

Patient Chart Printout	 204
Total Amount of Estimated Insurance Portion for Pri-
mary and Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Estimated Insurance Portion for Pri-
mary Claims

Insurance Claim Aging Report	 146
Total Amount of Estimated Insurance Portion for Sec-
ondary Claims

Insurance Claim Aging Report	 146
Total Amount of Fees - Co-pays

Utilization Report	 366
Total Amount of Insurance Estimates

Collections Manager List	 70
Aging/Credit Balance Report	 6

Total Amount of Insurance Payments
Insurance Carrier Production - Summary Report	
144
Operator Day Sheet Report	 194

Insurance (continued)
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Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Insurance Carrier Production - Full Report	 142

Total Amount of Insurance Payments Received
Insurance Transaction Analysis Report	 154

Total Amount of Insured Charges
Insurance Transaction Analysis Report	 154

Total Amount of MTD Charges Billed to Insurance
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Other Applied Insurance Payments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Pre-treatment Estimates
Pre-Treatment Estimate Aging Report	 262

Total Amount of Pre-treatment Estimates not Sent
Pre-Treatment Estimates Not Sent Report	 264

Total Amount of Primary and Secondary Claims not Sent
Insurance Claims Not Sent Report	 148

Total Amount of Primary Claims not Sent
Insurance Claims Not Sent Report	 148

Total Amount of Primary Insurance Portion for Case
Treatment Case Report	 326

Total Amount of Primary Pre-treatment Estimates not 
Sent

Pre-Treatment Estimates Not Sent Report	 264
Total Amount of Primary Production

Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Total Amount of Secondary Claims not Created
Secondary Insurance Claims Not Created Report	
318

Total Amount of Secondary Claims not Sent
Insurance Claims Not Sent Report	 148

Total Amount of Secondary Insurance Portion for Case
Treatment Case Report	 326

Total Amount of Secondary Pre-treatment Estimates not 
Created

Secondary Pre-Treatment Estimates Not Created 
Report	 320

Total Amount of Secondary Pre-treatment Estimates not 
Sent

Pre-Treatment Estimates Not Sent Report	 264
Total Amount of Secondary Production

Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Total Amount of YTD Charges Billed to Insurance
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Insurance Payments for Family
Family Ledger Report (Single Family)	 126
Family Ledger Report	 124

Total Estimated Insurance Portion
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Total Number of Insurance Claims Sent
Insurance Transaction Analysis Report	 154

Total Number of Insurance Payments Received
Insurance Transaction Analysis Report	 154

Total Number of Insured Charges
Insurance Transaction Analysis Report	 154

Total Number of Paid/Received Claims
Insurance Transaction Analysis Report	 154

Total Revenue from Insurance
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Insurance Carrier
Amount of Co-pays for Insurance Carrier

Utilization Report	 366
Amount of Fees - Co-pays for Insurance Carrier

Utilization Report	 366
Amount of Fees for Insurance Carrier

Utilization Report	 366
RVU Utilization Report	 316

Amount of RVUs for Insurance Carrier
RVU Utilization Report	 316

Insurance Carrier Address
Insurance Coverage Tables Report	 150
Provider IDs List	 284
Updated Dental Insurance Payment Table Report	
364
Insurance Carrier List	 138

Insurance Carrier City and State
Insurance Eligibility Report	 152

Insurance Carrier Contact Name
Provider IDs List	 284
Insurance Carrier List	 138

Insurance Carrier Name
Insurance Claim Aging Report	 146
Insurance Claims Not Sent Report	 148
Insurance Coverage Tables Report	 150
Insurance Eligibility Report	 152
Pre-Treatment Estimate Aging Report	 262
Pre-Treatment Estimates Not Sent Report	 264
Provider IDs List	 284
RVU Utilization Report	 316
Treatment Case Report	 326
Updated Dental Insurance Payment Table Report	
364
Utilization Report	 366
Walkout - Doctor’s Statement	 368
Insurance Carrier List	 138

Insurance Carrier Payor ID
Provider IDs List	 284

Insurance Carrier Phone Number
Insurance Claim Aging Report	 146
Insurance Eligibility Report	 152
Pre-Treatment Estimate Aging Report	 262
Provider IDs List	 284
RVU Utilization Report	 316
Utilization Report	 366
Insurance Carrier List	 138

Insurance Carrier Street Address
Insurance Eligibility Report	 152

Number of Office Visits for Insurance Carrier
Utilization Report	 366
RVU Utilization Report	 316
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Number of Patients Seen for Insurance Carrier
Utilization Report	 366
RVU Utilization Report	 316

Patient Insurance Carrier Name
Continuing Care Display List	 76

Primary Dental Insurance Carrier Name
Patient List	 212

Primary Insurance Carrier Name
Patient Route Slip	 226
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Unscheduled Treatment Plans (Detailed) Report	
362
Letter Merge Reports	 158

Primary Insurance Carrier Plan Employer
Patient Route Slip	 226

Primary Medical Insurance Carrier Name
Patient List	 212

Secondary Dental Insurance Carrier Name
Patient List	 212

Secondary Insurance Carrier Name
Patient Route Slip	 226
Secondary Insurance Claims Not Created Report	
318
Secondary Pre-Treatment Estimates Not Created 
Report	 320
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Unscheduled Treatment Plans (Detailed) Report	
362
Letter Merge Reports	 158

Secondary Insurance Carrier Plan Employer
Patient Route Slip	 226

Secondary Medical Insurance Carrier Name
Patient List	 212

Insurance Payment
Total Amount of Suspended Insurance Payments

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of YTD Insurance Payments for Family
Family Ledger Report (Single Family)	 126
Family Ledger Report	 124

Insurance Plan
Amount of Annual Primary Insurance Plan Benefits for 
Family

Treatment Case Report	 326
Amount of Annual Primary Insurance Plan Benefits for 
Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Annual Secondary Insurance Plan Benefits 
for Family

Treatment Case Report	 326
Amount of Annual Secondary Insurance Plan Benefits 
for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Credit Adjustment Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Debit Adjustment Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Insurance Payment Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Insurance Plan Employer
Insurance Carrier List	 138

Insurance Plan Employer Name
Walkout - Doctor’s Statement	 368
Provider IDs List	 284

Insurance Plan Group Name
Insurance Claim Aging Report	 146
Insurance Coverage Tables Report	 150
Insurance Eligibility Report	 152
Patient Treatment Case Report	 228
Pre-Treatment Estimate Aging Report	 262
Provider IDs List	 284
RVU Utilization Report	 316
Updated Dental Insurance Payment Table Report	
364
Utilization Report	 366
Insurance Carrier List	 138

Insurance Plan Group NPI Number
Dental Encounters Report	 106

Insurance Plan Group Number
Insurance Claim Aging Report	 146
Insurance Coverage Tables Report	 150
Insurance Eligibility Report	 152
Pre-Treatment Estimate Aging Report	 262
Provider IDs List	 284
RVU Utilization Report	 316
Updated Dental Insurance Payment Table Report	
364
Utilization Report	 366
Walkout - Doctor’s Statement	 368
Insurance Carrier List	 138

Insurance Plan Group Number for Primary Insurance
Patient Questionnaire	 222

Insurance Plan Group Number for Secondary Insurance
Patient Questionnaire	 222

Insurance Plan Name
Insurance Carrier Production - Full Report	 142
Insurance Carrier Production - Summary Report	
144
Document Center Document	 116

Insurance Plan Name and Address for Primary Insurance
Patient Questionnaire	 222

Insurance Plan Name and Address for Secondary Insur-
ance

Patient Questionnaire	 222
Insurance Plan Note

Patient Notes Report	 216
Insurance Plan Union Number

Provider IDs List	 284
Insurance Carrier List	 138

Insurance Carrier (continued)
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Primary Insurance Carrier Plan Employer
Patient Route Slip	 226

Primary Insurance Plan Group Number
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Patient Route Slip	 226

Primary Insurance Plan Renewal Month
Unscheduled Treatment Plans (Detailed) Report	
362

Primary Production Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Secondary Insurance Carrier Plan Employer
Patient Route Slip	 226

Secondary Insurance Plan Group Number
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Patient Route Slip	 226

Secondary Insurance Plan Renewal Month
Unscheduled Treatment Plans (Detailed) Report	
362

Secondary Production Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Insurance Portion
Account Estimated Insurance Portion

Patient Route Slip	 226
Amount of Dental Insurance Portion

Patient Chart Printout	 204
Amount of Estimated Insurance Portion

Insurance Claim Aging Report	 146
Amount of Pending Estimated Primary Insurance Por-
tions YTD for Family

Treatment Case Report	 326
Amount of Pending Estimated Primary Insurance Por-
tions YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Pending Estimated Secondary Insurance 
Portions YTD for Family

Treatment Case Report	 326
Amount of Pending Estimated Secondary Insurance 
Portions YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Primary Insurance Portion
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Primary Insurance Portion for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Amount of Primary Insurance Portion for Visit
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Secondary Insurance Portion
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Secondary Insurance Portion for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Amount of Secondary Insurance Portion for Visit
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Co-pay Calculation for Insurance Portion
Insurance Coverage Tables Report	 150

Estimated Insurance Portion
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220
Dental Encounters Report	 106

Patient Estimated Insurance Portion
Patient Route Slip	 226

Total Amount of Dental Insurance Portions
Patient Chart Printout	 204

Total Amount of Estimated Insurance Portion for Pri-
mary and Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Estimated Insurance Portion for Pri-
mary Claims

Insurance Claim Aging Report	 146
Total Amount of Estimated Insurance Portion for Sec-
ondary Claims

Insurance Claim Aging Report	 146
Total Amount of Primary Insurance Portion for Case

Treatment Case Report	 326
Total Amount of Secondary Insurance Portion for Case

Treatment Case Report	 326
Total Estimated Insurance Portion

Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Insured
Amount of Insured Charges (Average)

Practice Analysis Report	 252
Amount of Insured Charges (for Date Range)

Practice Analysis Report	 252
Amount of Insured Charges (MTD)

Practice Analysis Report	 252
Amount of Insured Charges (YTD)

Practice Analysis Report	 252
Number of Insured Active Patients

Practice Analysis Report	 252
Number of Insured Patients

Insurance Carrier List	 138
Interest

Payment Agreement Payment Portion Applied to Inter-
est

Payment Agreement Amortization Schedule	 232
Interest Rate

Interest Rate
Truth in Lending Disclosure Statement	 332

Interval
Payment Agreement Interval

Payment Agreement Report	 234
Payment Interval

Payment Agreement Amortization Schedule	 232

Insurance Plan (continued)



500   Index by Report Item

Dentrix Enterprise 11.0.2 Reports Reference

Lab
Amount of Lab Expenses for Clinic

RVU Day Sheet Report	 308
Amount of Lab Expenses for Medicaid Procedures for 
Clinic

RVU Production Summary Report	 310
Amount of Lab Expenses for Medicaid Procedures for 
Provider

RVU Production Summary Report	 310
Amount of Lab Expenses for Provider

RVU Day Sheet Report	 308
Amount of Lab Expenses of Non-Medicaid Procedures 
for Clinic

RVU Production Summary Report	 310
Amount of Lab Expenses of Non-Medicaid Procedures 
for Provider

RVU Production Summary Report	 310
Amount of Lab Expenses of Procedures for Clinic

RVU Production Summary Report	 310
Amount of Lab Expenses of Procedures for Provider

RVU Production Summary Report	 310
Lab Case Note

Patient Notes Report	 216
Lab Expense

RVU Schedules Report	 314
Fee Schedules Report	 128

Lab Expense Amount
RVU Day Sheet Report	 308

Total Amount of Lab Expenses
RVU Day Sheet Report	 308

Total Amount of Lab Expenses of Medicaid Procedures
RVU Production Summary Report	 310

Total Amount of Lab Expenses of Non-Medicaid Proce-
dures

RVU Production Summary Report	 310
Total Amount of Lab Expenses of Procedures

RVU Production Summary Report	 310
Lab Case

Lab Case Note
Patient Notes Report	 216

Lab Expense
Amount of Lab Expenses for Clinic

RVU Day Sheet Report	 308
Amount of Lab Expenses for Medicaid Procedures for 
Clinic

RVU Production Summary Report	 310
Amount of Lab Expenses for Medicaid Procedures for 
Provider

RVU Production Summary Report	 310
Amount of Lab Expenses for Provider

RVU Day Sheet Report	 308
Amount of Lab Expenses of Non-Medicaid Procedures 
for Clinic

RVU Production Summary Report	 310
Amount of Lab Expenses of Non-Medicaid Procedures 
for Provider

RVU Production Summary Report	 310
Amount of Lab Expenses of Procedures for Clinic

RVU Production Summary Report	 310
Amount of Lab Expenses of Procedures for Provider

RVU Production Summary Report	 310

Lab Expense
RVU Schedules Report	 314
Fee Schedules Report	 128

Lab Expense Amount
RVU Day Sheet Report	 308

Total Amount of Lab Expenses
RVU Day Sheet Report	 308

Total Amount of Lab Expenses of Medicaid Procedures
RVU Production Summary Report	 310

Total Amount of Lab Expenses of Non-Medicaid Proce-
dures

RVU Production Summary Report	 310
Total Amount of Lab Expenses of Procedures

RVU Production Summary Report	 310
Laboratory Test

Number of Laboratory Tests Ordered
Meaningful Use Measure Calculation List	 162

Number of Laboratory Tests Recorded Using CPOE 
(Computerized Provider Order Entry)

Meaningful Use Measure Calculation List	 162
Language

Language
UDS - Patient Status Report	 350

Patient Language
Patient List (Filtered)	 214
Letter Merge Reports	 158

Last Visit Date
Last Visit Date

Patient List	 212
Patient Notes Report	 216
Patient Route Slip	 226
Patient Route Slip	 226
Letter Merge Reports	 158

Late
Number of Late Appointments

Appointment Statistics Report	 20
Percent Late Appointments

Appointment Statistics Report	 20
Late Charge

Amount of Current Late Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of Late Charges
Provider A/R Totals - Daily Report	 276

Amount of Late Charges (Average)
Practice Analysis Report	 252

Amount of Late Charges (for Date Range)
Practice Analysis Report	 252

Amount of Late Charges (MTD)
Practice Analysis Report	 252

Amount of Late Charges (YTD)
Practice Analysis Report	 252

Amount of Late Charges for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Late Charge Report	 156
Analysis Summary Report - Daily	 8

Amount of Late Charges for Previous Month for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of Late Charges for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
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Late Charge Report	 156
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Late Charges YTD
Walkout - Family Walkout	 370

Amount of MTD Late Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Late Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Average Amount of Late Charges
Day Sheet (Adjustments) Report	 90

Last Late Charge Amount
Payment Agreement Report	 234

Last Late Charge Date
Payment Agreement Report	 234

Late Charge Amount
Analysis Summary Report - Daily	 8
Analysis Summary Report - Standard	 12
Late Charge Report	 156
Adjustment Summary Report	 4

Late Charge Date
Late Charge Report	 156

Late Charge Percent or Amount
Truth in Lending Disclosure Statement	 332

Total Amount of Current Late Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Late Charges
Analysis Summary Report - Daily	 8
Analysis Summary Report - Standard	 12
Day Sheet (Adjustments) Report	 90
Day Sheet Report	 100
Late Charge Report	 156
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Adjustment Summary Report	 4

Total Amount of Late Charges for Previous Month
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Late Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Late Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Late Charges for Family
Family Ledger Report (Single Family)	 126
Family Ledger Report	 124

Total Quantity of Late Charges
Day Sheet (Adjustments) Report	 90

Ledger
Ledger Balance

Suspended Credits Report	 324
Suspended Amount on Ledger

Suspended Credits Report	 324
Length

Appointment Length
Audit Report - Appointments	 26
Daily Appointment List (DX1)	 84
Daily Appointment List Report	 86
Operatory Appointment List Report	 196
Unscheduled Appointment List (DX1)	 356
Unscheduled Appointment List (OM)	 358

As Soon As Possible List	 22
Appointment Length Change

Audit Report - Appointments	 26
Length in Appointment Status

Appointment Cycle Time Report	 16
Next Appointment Length

Patient Route Slip	 226
Total Length in Appointment Statuses

Appointment Cycle Time Report	 16
License Number

Provider License Number
Walkout - Doctor’s Statement	 368

Lifetime
Lifetime/Individual/Standard Deductible

Insurance Carrier List	 138
Lifetime/Individual/Standard Other Deductible

Insurance Carrier List	 138
Lifetime/Individual/Standard Preventative Deductible

Insurance Carrier List	 138
Limit

Time Limit
Insurance Carrier List	 138

Lingual
Clinical Attachment Level (Lingual)

Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Furcation Involvement (Lingual)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Gingival Margin (Lingual)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Mobility (Lingual)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Probing Depth (Lingual)
Perio - Data Chart Report	 240
Perio - Exam Comparison Report	 242
Perio - Pocket Depths Only Report	 246
Perio - Combined Graphic & Data Chart Report	
238

Loan
Loan Amount

Truth in Lending Disclosure Statement	 332
Locked

Clinical Note Status
Clinical Notes Report	 64

Signed Date
Document Center - Documents List Report	 112

Login
Login Name

Audit Report - Providers/Staff	 36
Login Name Change

Audit Report - Providers/Staff	 36
Loss of Attachment

Percent of Patients with Loss of Attachment < 3 mm
Caries Prevalence and Periodontal Index Report	
52

Late Charge (continued)
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Percent of Patients with Loss of Attachment >= 3 & < 5 
mm

Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Loss of Attachment >= 5 mm
Caries Prevalence and Periodontal Index Report	
52

Major
Insurance Coverage Percent (Major) for Primary Insur-
ance

Patient Route Slip	 226
Insurance Coverage Percent (Major) for Secondary 
Insurance

Patient Route Slip	 226
Male

Number of Male Patients
Practice Statistics Report	 256

Number of Males
UDS - Age/Gender Report	 334

Number of Males for Clinic
UDS - Age/Gender Report	 334

Number of Males for Provider
UDS - Age/Gender Report	 334

Percent of Male Patients
Practice Statistics Report	 256

Total Number of Males
UDS - Age/Gender Report	 334

Marital Status
Number of Divorced Patients

Practice Statistics Report	 256
Number of Married Patients

Practice Statistics Report	 256
Number of Separated Patients

Practice Statistics Report	 256
Number of Single Patients

Practice Statistics Report	 256
Number of Widowed Patients

Practice Statistics Report	 256
Patient Marital Status

Insurance Carrier List	 138
Letter Merge Reports	 158
Patient List	 212
Patient Route Slip	 226
Employers and Employed Patients Report	 122

Percent of Divorced Patients
Practice Statistics Report	 256

Percent of Married Patients
Practice Statistics Report	 256

Percent of Separated Patients
Practice Statistics Report	 256

Percent of Single Patients
Practice Statistics Report	 256

Percent of Widowed Patients
Practice Statistics Report	 256

Subscriber Marital Status
Insurance Carrier List	 138

Married
Number of Married Patients

Practice Statistics Report	 256

Percent of Married Patients
Practice Statistics Report	 256

Material
Material

RVU Schedules Report	 314
Fee Schedules Report	 128

Maximum
Maximum Primary Insurance Benefit Amount

Patient Route Slip	 226
Maximum Secondary Insurance Benefit Amount

Patient Route Slip	 226
Mean

Mean dmfs
Caries Prevalence and Periodontal Index Report	
52

Mean dmft
Caries Prevalence and Periodontal Index Report	
52

Mean DMFT
Caries Prevalence and Periodontal Index Report	
52

Mean Number of Sealed Teeth
Caries Prevalence and Periodontal Index Report	
52

Median
Median Wait Time

Appointment Cycle Time Report	 16
Medicaid

Amount of Lab Expenses for Medicaid Procedures for 
Clinic

RVU Production Summary Report	 310
Amount of Lab Expenses for Medicaid Procedures for 
Provider

RVU Production Summary Report	 310
Amount of Medicaid Procedures for Clinic

RVU Production Summary Report	 310
Production Summary Report	 272

Amount of Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Medicaid Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Net RVU for Medicaid Procedures
RVU Production Summary Report	 310

Net RVU of Medicaid Procedures for Clinic
RVU Production Summary Report	 310

Net RVU of Medicaid Procedures for Provider
RVU Production Summary Report	 310

Number of Medicaid and Medicare Patients
UDS - Medicaid/Medicare Report	 346

Number of Medicaid and Medicare Patients at Clinic
UDS - Medicaid/Medicare Report	 346

Number of Medicaid and Medicare Patients for Pro-
vider

UDS - Medicaid/Medicare Report	 346

Loss of Attachment (continued)
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Number of Medicaid and Medicare Patients in First Age 
Group

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in First Age 
Group at Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in First Age 
Group for Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in First Age 
Group in ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in First Age 
Group with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group at Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group for Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group in ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in ZIP 
Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients with Finan-
cial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients at Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients for Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in First Age Group

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in First Age Group at 
Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in First Age Group for 
Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in First Age Group in ZIP 
Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in First Age Group with 
Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in Second Age Group

UDS - Medicaid/Medicare Report	 346

Number of Medicaid Patients in Second Age Group at 
Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in Second Age Group for 
Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in Second Age Group in 
ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in Second Age Group 
with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients with Financial Class

UDS - Medicaid/Medicare Report	 346
Percent of Medicaid Procedures

RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Quantity of Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Quantity of Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Total Amount of Lab Expenses of Medicaid Procedures
RVU Production Summary Report	 310

Total Amount of Medicaid Payments
Operator Day Sheet Report	 194

Total Amount of Medicaid Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Total Medicaid Charge
Operator Day Sheet Report	 194

Total Number of Patient with Medicaid
Operator Day Sheet Report	 194

Total Quantity of Medicaid Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Medicaid Number
Medicaid Number

Practice Organization List	 254
Provider Medicaid Number

Provider IDs List	 284
Medical

Number of Patients with Dental and Medical Insurance
Practice Statistics Report	 256

Number of Patients with Primary Medical Insurance
Practice Statistics Report	 256

Number of Patients without Dental and Medical Insur-
ance

Practice Statistics Report	 256
Number of Patients without Medical Insurance

Practice Statistics Report	 256
Percent of Patients with Dental and Medical Insurance

Practice Statistics Report	 256
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Percent of Patients with Primary Medical Insurance
Practice Statistics Report	 256

Percent of Patients without Dental and Medical Insur-
ance

Practice Statistics Report	 256
Percent of Patients without Medical Insurance

Practice Statistics Report	 256
Primary Medical Insurance Carrier Name

Patient List	 212
Secondary Medical Insurance Carrier Name

Patient List	 212
Medical Alert

Medical Alert
Patient Route Slip	 226
Patient Notes Report	 216

Number of Patients with Problems or Attestations of No 
Known Problems

Meaningful Use Measure Calculation List	 162
Problem Description

Patient List (Filtered)	 214
Problem Discovery Date

Patient List (Filtered)	 214
Medical Code

AMA CPT Code
Procedure Code List	 266
Medical Code List	 186

AMA CPT Code Description
Medical Code List	 186

ICD-9-CM Code
Patient List (Filtered)	 214
Medical Code List	 186

ICD-9-CM Code Description
Medical Code List	 186

Medical Code
Procedure Code List	 266

Modifier Code
Medical Code List	 186

Modifier Code Description
Medical Code List	 186

Place of Service Code
Medical Code List	 186

Place of Service Code Description
Medical Code List	 186

Type of Service Code
Medical Code List	 186

Type of Service Code Description
Medical Code List	 186

Medical Encounter
Number of Patients 18 - 64 Years with Medical Encoun-
ters (with Exclusions)

Clinical Quality Measures List	 66
Number of Patients 18+ Years with Medical Encounters 
or Patient Health Assessments

Clinical Quality Measures List	 66
Number of Patients 3 - 17 Years with Medical Encoun-
ters (with Exclusions)

Clinical Quality Measures List	 66
Number of Patients 65+ Years with Medical Encounters 
(with Exclusions)

Clinical Quality Measures List	 66

Medical/Other ID
Patient Medical/Other ID

Patient List	 212
Medicare

Number of Medicaid and Medicare Patients
UDS - Medicaid/Medicare Report	 346

Number of Medicaid and Medicare Patients at Clinic
UDS - Medicaid/Medicare Report	 346

Number of Medicaid and Medicare Patients for Pro-
vider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in First Age 
Group

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in First Age 
Group at Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in First Age 
Group for Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in First Age 
Group in ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in First Age 
Group with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group at Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group for Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group in ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in ZIP 
Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients with Finan-
cial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients at Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients for Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in First Age Group

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in First Age Group at 
Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in First Age Group for 
Provider

UDS - Medicaid/Medicare Report	 346

Medical (continued)



Index by Report Item   505

Dentrix Enterprise 11.0.2 Reports Reference

Number of Medicare Patients in First Age Group in ZIP 
Code

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in First Age Group with 
Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in Second Age Group

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in Second Age Group at 
Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in Second Age Group for 
Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in Second Age Group in 
ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in Second Age Group 
with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients with Financial Class

UDS - Medicaid/Medicare Report	 346
Medication

Medication Date
Patient List (Filtered)	 214

Medication Description
Patient List (Filtered)	 214

Number of Patients 18+ Years with Current Medications
Clinical Quality Measures List	 66

Number of Patients 66+ Years with 1+ High-risk Medica-
tions

Clinical Quality Measures List	 66
Number of Patients 66+ Years with 2+ High-risk Medica-
tions

Clinical Quality Measures List	 66
Number of Patients with Medications

Meaningful Use Measure Calculation List	 162
Number of Patients with Medications or Attestations of 
No Known Medications

Meaningful Use Measure Calculation List	 162
Number of Patients with Medications Ordered Using 
CPOE (Computerized Provider Order Entry)

Meaningful Use Measure Calculation List	 162
Prescribed Medication

Prescription Printout	 260
Medication Allergy

Number of Patients with Medication Allergies or Attes-
tations of No Known Medication Allergies

Meaningful Use Measure Calculation List	 162
Medication Reconciliation

Number of TCs (Transition of Care) where Medication 
Reconciliation Was Performed

Meaningful Use Measure Calculation List	 162
Message

Custom Message
Appointment Reminder Cards	 18

Missed Appointment
Last Missed Appointment Date

Patient Route Slip	 226
Number of Missed Appointments

Patient Route Slip	 226
Missed Payment

Number of Missed Payment Agreement Payments
Practice Analysis Report	 252

Number of Missed Payments
Payment Agreement Report	 234

Number of Missed Payments for Payment Agreement
Collections Manager List	 70

Total Number of Missed Payments for Payment Agree-
ments

Collections Manager List	 70
Mobile Number

Patient Mobile Number
Patient List (Filtered)	 214
Patient Questionnaire	 222
Patient List	 212

Spouse Mobile Number
Patient Questionnaire	 222

Mobility
Mobility

Perio - Data Chart Report	 240
Perio - Combined Graphic & Data Chart Report	
238

Mobility (Facial)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Mobility (Lingual)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Modified
Modified Procedure

Audit Report - Combined	 32
Modifier Code

Modifier Code
Medical Code List	 186

Modifier Code Description
Medical Code List	 186

Module
Module of Access

Patient Information Accessed Report	 208
Month

Amount of Applied Credit Adjustments for Previous 
Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Applied Payments for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Charge Adjustments for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Amount of Charges Billed to Insurance for Previous 
Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Charges for Previous Month for Provider

Day Sheet (Charges and Receipts) Report	 94
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Amount of Finance Charges for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Late Charges for Previous Month for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of Suspended Credit Adjustments for Previous 
Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Suspended Payments for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Average Monthly Charge Amount

Future Due Payment Plan Report - Monthly Totals	
132

Benefit Renewal Month
Insurance Carrier List	 138

Fiscal Year Month
Audit Report - Clinics	 30

Fiscal Year Month Change
Audit Report - Clinics	 30

Month
Future Due Payment Plan Report - Monthly Totals	
132

Monthly Charge Amount
Future Due Payment Plan Report - Standard	 134

Next Charge Amount (after 18 Months from Current 
Month)

Future Due Payment Plan Report - Monthly Totals	
132

Number of New Patients (in Month and Year)
Practice Statistics Report	 256

Number of New Patients from Previous Month
Day Sheet (Charges and Receipts) Report	 94

Number of New Patients from Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Number of Patients Due for Prophy (on Month and Year)

Practice Statistics Report	 256
Number of Referred New Patients (in Month and Year)

Practice Statistics Report	 256
Percent of Patients Due for Prophy (Month and Year)

Practice Statistics Report	 256
Percent of Referred New Patients (in Month and Year)

Practice Statistics Report	 256
Practice Fiscal Year Month

Registration Information Report	 306
Primary Insurance Benefits Renewal Month

Patient Route Slip	 226
Primary Insurance Plan Renewal Month

Unscheduled Treatment Plans (Detailed) Report	
362

Remaining Number of Months
Future Due Payment Plan Report - Standard	 134

Secondary Insurance Benefits Renewal Month
Patient Route Slip	 226

Secondary Insurance Plan Renewal Month
Unscheduled Treatment Plans (Detailed) Report	
362

Total Amount of Applied Credit Adjustments for Previ-
ous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Applied Payments for Previous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Charge Adjustments for Previous 
Month

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Charges Billed to Insurance for Previ-
ous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Charges for Previous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Charges Remaining (after 18 Mos from 
Curr Mo)

Future Due Payment Plan Report - Monthly Totals	
132

Total Amount of Finance Charges for Previous Month
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Late Charges for Previous Month
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Suspended Credit Adjustments for 
Previous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Suspended Payments for Previous 
Month

Day Sheet (Charges and Receipts) Report	 94
Total Monthly Charges

Future Due Payment Plan Report - Standard	 134
Total Number of Charges Remaining (after 18 Mos from 
Curr Mo)

Future Due Payment Plan Report - Monthly Totals	
132

MTD
Amount of Debit Adjustments (MTD)

Practice Analysis Report	 252
Amount of Finance Charges (MTD)

Practice Analysis Report	 252
Amount of Insured Charges (MTD)

Practice Analysis Report	 252
Amount of Late Charges (MTD)

Practice Analysis Report	 252
Amount of MTD Applied Credit Adjustments for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Applied Payments for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Charge Adjustments for Provider

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Amount of MTD Charges Billed to Insurance for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Charges for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Finance Charges for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Late Charges for Provider

Day Sheet (Charges and Receipts) Report	 94
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Amount of MTD Suspended Credit Adjustments for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Suspended Payments for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Non-insured Charges (MTD)

Practice Analysis Report	 252
Amount of Other Debit Adjustments (MTD)

Practice Analysis Report	 252
Average Charge per Patient MTD

Day Sheet (Charges and Receipts) Report	 94
Average Charge per Patient MTD for Provider

Day Sheet (Charges and Receipts) Report	 94
Average Production per Patient MTD

Day Sheet (Charges and Receipts) Report	 94
Average Production per Patient MTD for Provider

Day Sheet (Charges and Receipts) Report	 94
Beginning Balance (MTD)

Practice Analysis Report	 252
Ending Balance (MTD)

Practice Analysis Report	 252
New Patients (MTD)

Practice Analysis Report	 252
Number of New Patients MTD

Day Sheet (Charges and Receipts) Report	 94
Number of New Patients MTD for Provider

Day Sheet (Charges and Receipts) Report	 94
Number of Patients Seen MTD

Day Sheet (Charges and Receipts) Report	 94
Number of Patients Seen MTD by Provider

Day Sheet (Charges and Receipts) Report	 94
Referred Patients (MTD)

Practice Analysis Report	 252
Subtotal of Charges (MTD)

Practice Analysis Report	 252
Total Amount of MTD Applied Credit Adjustments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of MTD Applied Payments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of MTD Charge Adjustments

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Charges Billed to Insurance
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Finance Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Late Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Suspended Credit Adjustments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Suspended Payments
Day Sheet (Charges and Receipts) Report	 94

Total Charges (MTD)
Practice Analysis Report	 252

Mucogingival Junction
Mucogingival Junction

Perio - Data Chart Report	 240
Perio - Combined Graphic & Data Chart Report	
238

Multi-Code
Disabled/Enabled

Multi-Code List	 188
Multi-Code

Multi-Code List	 188
Multi-Code Description

Multi-Code List	 188
Multi-Code Type

Multi-Code List	 188
Name

Account Holder Name
Deposit Slip	 108

Cardholder Name
Credit Card Transaction Report	 80

First Name of Referred by Source
Letter Merge Reports	 158

Guarantor First Name
Letter Merge Reports	 158

Guarantor Last Name
Letter Merge Reports	 158

Guarantor Name
Audit Report - Patients	 34
Billing Statement	 48
Collections Manager List	 70
Family Ledger Report	 124
Family Ledger Report (Single Family)	 126
Finance Charge Report	 130
Future Due Payment Plan Report - Standard	 134
Late Charge Report	 156
Patient Route Slip	 226
Patient’s Ledger Report	 230
Payment Agreement Amortization Schedule	 232
Payment Agreement Report	 234
Suspended Credits Report	 324
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Truth in Lending Disclosure Statement	 332
Walkout - Family Walkout	 370
Aging/Credit Balance Report	 6

Guarantor Name Change
Audit Report - Patients	 34

Insurance Carrier Contact Name
Provider IDs List	 284
Insurance Carrier List	 138

Last Name of Referred by Source
Letter Merge Reports	 158

Last Referral Name and Date
Patient Route Slip	 226

Last Referred To Name and Date
Patient Route Slip	 226

Middle Initial of Referred by Source
Letter Merge Reports	 158

Name on Credit Card
Billing Statement	 48

Paid in by Name
Deposit Slip	 108
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Patient First Name
Letter Merge Reports	 158

Patient Last Name
Letter Merge Reports	 158

Patient Middle Initial
Letter Merge Reports	 158

Patient Name
Appointment Cycle Time Report	 16
Appointment Reminder Cards	 18
As Soon As Possible List	 22
Audit Report - Appointments	 26
Audit Report - Combined	 32
Audit Report - Patients	 34
Audit Report - Transactions	 38
Billing Statement	 48
Birthday List	 50
Clinical Notes Report	 64
Continuing Care Cards - No Appointment	 74
Continuing Care Cards - with Appointment	 75
Continuing Care Display List	 76
Coupon Book - Future Due Payments	 78
Coupon Book - Payment Agreements	 79
Daily Appointment List (DX1)	 84
Daily Appointment List Report	 86
Day Sheet (Adjustments) Report	 90
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Receipts) Report	 98
Day Sheet Report	 100
Dental Encounters Report	 106
Document Center Document	 116
Document Center List	 120
Employers and Employed Patients Report	 122
Family Ledger Report	 124
Family Ledger Report (Single Family)	 126
Future Due Payment Plan Report - Standard	 134
Insurance Carrier List	 138
Insurance Carrier Production - Full Report	 142
Insurance Claim Aging Report	 146
Insurance Claims Not Sent Report	 148
Insurance Eligibility Report	 152
Insurance Transaction Analysis Report	 154
New Patient List	 190
Operator Day Sheet Report	 194
Operatory Appointment List Report	 196
Patient Chart and Progress Notes Printout	 202
Patient Chart Printout	 204
Patient Health Assessment Report	 206
Patient Information Accessed Report	 208
Patient Ledger Report	 210
Patient Ledger Report	 210
Patient List	 212
Patient List (Filtered)	 214
Patient Notes Report	 216
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220
Patient Questionnaire	 222
Patient Revenue List by Payer Report	 224
Patient Route Slip	 226
Patient Route Slip	 226
Patient Treatment Case Report	 228

Patient’s Ledger Report	 230
Patient’s Ledger Report	 230
Perio - Combined Graphic & Data Chart Report	
238
Perio - Data Chart Report	 240
Perio - Exam Comparison Report	 242
Perio - Graphic Chart Report	 244
Perio - Pocket Depths Only Report	 246
Perio Exam List	 248
Practice Treatment Case Report	 258
Prescription Printout	 260
Pre-Treatment Estimate Aging Report	 262
Pre-Treatment Estimates Not Sent Report	 264
Procedures by Contracted Amount Report	 268
Procedures Not Attached to Insurance Report	270
Production Summary Report	 272
Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Referral Recap Report	 296
Referral Slip	 298
Referred By Doctor/Other Report	 300
RVU Day Sheet Report	 308
RVU Production Summary Report	 310
RVU Utilization Report	 316
Secondary Insurance Claims Not Created Report	
318
Secondary Pre-Treatment Estimates Not Created 
Report	 320
Suspended Credits Report	 324
Treatment Case Report	 326
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
UDS - Age/Gender Report	 334
UDS - Insurance Financial Class Report	 342
UDS - Insurance Financial Class Report (2013)	344
UDS - Medicaid/Medicare Report	 346
UDS - Patient Related Revenue Report	 348
UDS - Patient Status Report	 350
UDS - Sealant Statistics Report	 352
UDS - Tobacco Use and Intervention Report	 354
Unscheduled Appointment List (DX1)	 356
Unscheduled Appointment List (OM)	 358
Unscheduled Treatment Plans (Condensed) Re-
port	 360
Unscheduled Treatment Plans (Detailed) Report	
362
Utilization Report	 366
Walkout - Doctor’s Statement	 368
Walkout - Family Walkout	 370
Appointment Book View Printout	 14

Patient Name Change
Audit Report - Patients	 34
Audit Report - Transactions	 38
Audit Report - Appointments	 26

Patient Name on Appointment
Letter Merge Reports	 158

Patient’s Preferred Name
Letter Merge Reports	 158
Appointment Book View Printout	 14
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Payer Name
Procedures by Contracted Amount Report	 268
Patient Revenue List by Payer Report	 224

Practice Name
Billing Statement	 48
Continuing Care Cards - No Appointment	 74
Continuing Care Cards - with Appointment	 75
Coupon Book - Future Due Payments	 78
Coupon Book - Payment Agreements	 79
Letter Merge Reports	 158
Perio - Combined Graphic & Data Chart Report	
238
Prescription Printout	 260
Truth in Lending Disclosure Statement	 332
Walkout - Family Walkout	 370
Appointment Reminder Cards	 18

Provider Name
Audit Report - Providers/Staff	 36
Document Center Document	 116
Insurance Carrier List	 138
Letter Merge Reports	 158
Patient Chart and Progress Notes Printout	 202
Patient Chart Printout	 204
Patient Treatment Case Report	 228
Perio - Combined Graphic & Data Chart Report	
238
Perio - Exam Comparison Report	 242
Perio - Graphic Chart Report	 244
Practice Organization List	 254
Practice Statistics Report	 256
Prescription Printout	 260
Procedures by Contracted Amount Report	 268
Provider IDs List	 284
Referral Recap Report	 296
Referral Slip	 298
Treatment Case Report	 326
Walkout - Doctor’s Statement	 368
Appointment Reminder Cards	 18

Provider Name Change
Audit Report - Providers/Staff	 36

Referral Name
Referral Slip	 298
Referral Recap Report	 296

Referral Source Name
Patient Questionnaire	 222

Referred by Doctor/Other Name
Referred By Doctor/Other Report	 300
Document Center Document	 116

Referred By Name
New Patient List	 190

Referred by Patient Name
Document Center Document	 116

Referred Patient Name
Referred To Doctor Report	 304

Referred to Doctor Name
Referred To Doctor Report	 304
Document Center Document	 116

Referred to First Name
Letter Merge Reports	 158

Referred to Last Name
Letter Merge Reports	 158

Referred to Middle Initial
Letter Merge Reports	 158

Referring Patient Name
Referred By Patient Report	 302

Signer Name
Treatment Case Report	 326
Document Center - Documents List Report	 112

Spouse Name
Patient Questionnaire	 222

Subscriber Name for Primary Insurance
Patient Route Slip	 226
Patient Questionnaire	 222

Subscriber Name for Secondary Insurance
Patient Route Slip	 226
Patient Questionnaire	 222

Net
Net Difference of Current Charges and Fee Schedule 
for Provider

Day Sheet (Charges and Receipts) Report	 94
Net Difference of Total Current Charges and Fee 
Schedule

Day Sheet (Charges and Receipts) Report	 94
Net RVU

RVU Day Sheet Report	 308
Net RVU for Clinic

RVU Day Sheet Report	 308
Net RVU for Medicaid Procedures

RVU Production Summary Report	 310
Net RVU for Provider

RVU Day Sheet Report	 308
Net RVU of Medicaid Procedures for Clinic

RVU Production Summary Report	 310
Net RVU of Medicaid Procedures for Provider

RVU Production Summary Report	 310
Net RVU of Non-Medicaid Procedures

RVU Production Summary Report	 310
Net RVU of Non-Medicaid Procedures for Clinic

RVU Production Summary Report	 310
Net RVU of Non-Medicaid Procedures for Provider

RVU Production Summary Report	 310
Net RVU of Procedures

RVU Production Summary Report	 310
Net RVU of Procedures for Clinic

RVU Production Summary Report	 310
Net RVU of Procedures for Provider

RVU Production Summary Report	 310
Total Net RVU

RVU Day Sheet Report	 308
Net Change

Amount of Net Change
Provider A/R Totals - Daily Report	 276

Amount of Net Change for Clinic
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Net Change for Provider
Analysis Summary Report - Standard	 12
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Name (continued)



510   Index by Report Item

Dentrix Enterprise 11.0.2 Reports Reference

Net Change
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Net Change in Balance
Day Sheet (Charges and Receipts) Report	 94

Net Change in Balance for Provider
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Net Change
Analysis Summary Report - Standard	 12
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

New Appointment
Number of New Appointments

Daily Summary Report	 88
New Family

Number of New Families
Daily Summary Report	 88

New Head of House
Number of New Families

Daily Summary Report	 88
New Patient

Current Number of New Patients
Day Sheet (Charges and Receipts) Report	 94

Current Number of New Patients for Provider
Day Sheet (Charges and Receipts) Report	 94

New Patients (Average)
Practice Analysis Report	 252

New Patients (for Date Range)
Practice Analysis Report	 252

New Patients (MTD)
Practice Analysis Report	 252

New Patients (YTD)
Practice Analysis Report	 252

Number of New Families
Daily Summary Report	 88

Number of New Patients
Analysis Summary Report - Standard	 12
Daily Summary Report	 88
Analysis Summary Report - Daily	 8

Number of New Patients (in Month and Year)
Practice Statistics Report	 256

Number of New Patients for Clinic
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Number of New Patients for Provider
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Number of New Patients from Previous Month
Day Sheet (Charges and Receipts) Report	 94

Number of New Patients from Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Number of New Patients MTD

Day Sheet (Charges and Receipts) Report	 94
Number of New Patients MTD for Provider

Day Sheet (Charges and Receipts) Report	 94
Number of New Patients YTD

Day Sheet (Charges and Receipts) Report	 94

Number of New Patients YTD for Provider
Day Sheet (Charges and Receipts) Report	 94

Number of New-patient Encounters
Meaningful Use Measure Calculation List	 162

Number of Referred New Patients (in Month and Year)
Practice Statistics Report	 256

Percent of Referred New Patients (in Month and Year)
Practice Statistics Report	 256

Total Active New Patients
New Patient List	 190

Total Archived New Patients
New Patient List	 190

Total Inactive New Patients
New Patient List	 190

Total New Patients
New Patient List	 190

Total Non-patient New Patients
New Patient List	 190

Total Number of New Patients
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Number of New Patients for Clinic
Day Sheet Report	 100

Total Number of New Patients for Provider
Day Sheet Report	 100

Non-guarantor
Number of Patient Non-guarantors

Practice Statistics Report	 256
Percent of Patient Non-guarantors

Practice Statistics Report	 256
Non-insurance

Revenue for Provider from Non-insurance Sources
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Total Revenue from Non-insurance
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Non-insured
Amount of Non-insured Charges (Average)

Practice Analysis Report	 252
Amount of Non-insured Charges (for Date Range)

Practice Analysis Report	 252
Amount of Non-insured Charges (MTD)

Practice Analysis Report	 252
Amount of Non-insured Charges (YTD)

Practice Analysis Report	 252
Non-Medicaid

Amount of Lab Expenses of Non-Medicaid Procedures 
for Clinic

RVU Production Summary Report	 310
Amount of Lab Expenses of Non-Medicaid Procedures 
for Provider

RVU Production Summary Report	 310
Amount of Non-Medicaid Procedures for Clinic

RVU Production Summary Report	 310
Production Summary Report	 272

Net Change (continued)
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Amount of Non-Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Non-Medicaid Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Non-Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Non-Medicaid Procedures for 
Provider

RVU Production Summary Report	 310
Production Summary Report	 272

Net RVU of Non-Medicaid Procedures
RVU Production Summary Report	 310

Net RVU of Non-Medicaid Procedures for Clinic
RVU Production Summary Report	 310

Net RVU of Non-Medicaid Procedures for Provider
RVU Production Summary Report	 310

Percent of Non-Medicaid Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Non-Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Non-Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Quantity of Non-Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Quantity of Non-Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Total Amount of Lab Expenses of Non-Medicaid Proce-
dures

RVU Production Summary Report	 310
Total Amount of Non-Medicaid Procedures

RVU Production Summary Report	 310
Production Summary Report	 272

Total Quantity of Non-Medicaid Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Non-patient
Number of Non-patient Guarantors

Practice Statistics Report	 256
Percent of Non-patient Guarantors

Practice Statistics Report	 256
Not Created

Total Amount of Secondary Claims not Created
Secondary Insurance Claims Not Created Report	
318

Not Sent
Total Amount of Pre-treatment Estimates not Sent

Pre-Treatment Estimates Not Sent Report	 264
Total Amount of Primary and Secondary Claims not Sent

Insurance Claims Not Sent Report	 148
Total Amount of Primary Claims not Sent

Insurance Claims Not Sent Report	 148

Total Amount of Primary Pre-treatment Estimates not 
Sent

Pre-Treatment Estimates Not Sent Report	 264
Total Amount of Secondary Claims not Sent

Insurance Claims Not Sent Report	 148
Total Amount of Secondary Pre-treatment Estimates not 
Created

Secondary Pre-Treatment Estimates Not Created 
Report	 320

Total Amount of Secondary Pre-treatment Estimates not 
Sent

Pre-Treatment Estimates Not Sent Report	 264
Note

Account Note
Collections Manager List	 70

Appointment Note
Patient Notes Report	 216

Appointment Notes
Appointment Book View Printout	 14

Clinical Note
Patient Notes Report	 216
Patient Chart and Progress Notes Printout	 202

Clinical Note Clinic
Clinical Notes Report	 64

Clinical Note Date
Patient Notes Report	 216
Clinical Notes Report	 64

Clinical Note Number
Clinical Notes Report	 64

Clinical Note Page Number
Clinical Notes Report	 64

Clinical Note Provider
Clinical Notes Report	 64

Clinical Note Text
Clinical Notes Report	 64

Clinical Note Time
Clinical Notes Report	 64

Continuing Care Note
Patient Notes Report	 216
Letter Merge Reports	 158

Continuing Care Note Continuing Care Due Date
Patient Notes Report	 216

Continuing Care Note Continuing Care Type
Patient Notes Report	 216

Custom Message
Appointment Reminder Cards	 18

Custom Note
Walkout - Family Walkout	 370
Walkout - Doctor’s Statement	 368

Custom Notes
Custom Practice Information Report	 82

Day Note
Appointment Book View Printout	 14

Family Alert Note
Patient Notes Report	 216

Guarantor Note
Patient Notes Report	 216
Aging/Credit Balance Report	 6

Insurance Claim Note
Patient Notes Report	 216

Insurance Plan Note
Patient Notes Report	 216

Non-Medicaid (continued)
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Lab Case Note
Patient Notes Report	 216

Last Payment Agreement Note
Payment Agreement Report	 234

Next Appointment Note
Patient Route Slip	 226

Note
Document Center List	 120

Number of Patients with Searchable Clinical Notes
Meaningful Use Measure Calculation List	 162

Patient Alert Note
Patient Notes Report	 216

Patient Note
Patient Route Slip	 226
Patient Notes Report	 216

Payment Plan Note
Patient Notes Report	 216

Perio Exam Note
Patient Notes Report	 216

Prescription Note
Prescription Printout	 260

Procedure Note
Treatment Case Report	 326
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Patient Chart and Progress Notes Printout	 202

Referral Note
Referral Slip	 298
Referral Recap Report	 296

Statement Note
Patient Notes Report	 216

Note Status
Clinical Note Status

Clinical Notes Report	 64
Notes

Case Notes
Treatment Case Report	 326
Patient Treatment Case Report	 228

NPI Number
Insurance Plan Group NPI Number

Dental Encounters Report	 106
NPI Number

Practice Organization List	 254
Provider NPI Number

Provider IDs List	 284
Prescription Printout	 260

Rendering Provider NPI Number
Dental Encounters Report	 106

Number
Clinical Note Number

Clinical Notes Report	 64
Number

UDS - Insurance Financial Class Report	 342
UDS - Insurance Financial Class Report	 342
UDS - Insurance Financial Class Report	 342

Patient Home Phone Number
As Soon As Possible List	 22
Clinical Notes Report	 64
Continuing Care Display List	 76
Daily Appointment List (DX1)	 84

Daily Appointment List Report	 86
Day Sheet (Charges and Receipts) Report	 94
Day Sheet Report	 100
Letter Merge Reports	 158
Patient Ledger Report	 210
Patient List	 212
Patient List (Filtered)	 214
Patient Notes Report	 216
Patient Questionnaire	 222
Patient Route Slip	 226
Prescription Printout	 260
Referral Recap Report	 296
Referral Slip	 298
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Unscheduled Appointment List (DX1)	 356
Unscheduled Appointment List (OM)	 358
Unscheduled Treatment Plans (Condensed) Re-
port	 360
Unscheduled Treatment Plans (Detailed) Report	
362
Appointment Book View Printout	 14

Payment Agreement Payment Number
Payment Agreement Amortization Schedule	 232

Payment Number
Coupon Book - Payment Agreements	 79
Coupon Book - Future Due Payments	 78

Numerator Code
Numerator Codes for Provider

Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Total Numerator Codes for All Clinics
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Total Numerator Codes for Clinic
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Nutrition Counseling
Number of Patients 3 - 17 Years who Received Nutrition 
Counseling

Clinical Quality Measures List	 66
Office

Amount of Office Portion
Patient Treatment Case Report	 228

Amount of Office Portion for Case
Patient Treatment Case Report	 228

Amount of Office Portion for Visit
Patient Treatment Case Report	 228

Number of Office Visits
Meaningful Use Measure Calculation List	 162

Number of Office Visits where Patient Received CS 
(Clinical Summary)

Meaningful Use Measure Calculation List	 162
Provider Office Phone Number

Provider IDs List	 284
Office Journal

Office Journal Entry
Office Journal Report	 192

Note (continued)
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Office Journal Entry Date
Office Journal Report	 192

Office Journal Entry Information
Office Journal Report	 192

Office Journal Entry Time
Office Journal Report	 192

Previous Office Journal Entry
Collections Manager List	 70

Previous Office Journal Type
Collections Manager List	 70

Office Journal Type
Previous Office Journal Type

Collections Manager List	 70
Office Phone

Office Number
Practice Organization List	 254

Office Portion
Amount of Office Portion

Patient Treatment Case Report	 228
Amount of Office Portion for Case

Patient Treatment Case Report	 228
Amount of Office Portion for Visit

Patient Treatment Case Report	 228
Office Visit

Number of Office Visits for Insurance Carrier
Utilization Report	 366
RVU Utilization Report	 316

Total Number of Office Visits
Utilization Report	 366
RVU Utilization Report	 316

On Hold
Claim On Hold Date

Insurance Claim Aging Report	 146
Pre-treatment Estimate On Hold Date

Pre-Treatment Estimate Aging Report	 262
On Time

Number of On Time Appointments
Appointment Statistics Report	 20

On-Patient
Total Non-patient New Patients

New Patient List	 190
Operator

Operator
Deposit Slip	 108
Appointment Book View Printout	 14

Operator ID
Day Sheet (Receipts) Report	 98
Day Sheet (Adjustments) Report	 90

Total Amount of Payment Type for Operator
Deposit Slip	 108

Total Number of Payment Type Items for Operator
Deposit Slip	 108

Operatory
Next Appointment Operatory ID

Patient Route Slip	 226
Operatory

Audit Report - Appointments	 26
Appointment Book View Printout	 14

Operatory Change
Audit Report - Appointments	 26

Operatory ID
Daily Appointment List (DX1)	 84
Daily Appointment List Report	 86
Operatory Appointment List Report	 196
As Soon As Possible List	 22

Option
Audit Log Option

Audit Report - Audit Log Status	 28
Oral Health Status

Number of Patients 13 - 14 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 13 - 14 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 13 - 14 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 13 - 14 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 13 - 14 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 13 - 14 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 13 - 14 Years without OHS
Oral Health Status Report	 200

Number of Patients 15 - 16 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 15 - 16 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 15 - 16 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 15 - 16 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 15 - 16 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 15 - 16 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 15 - 16 Years without OHS
Oral Health Status Report	 200

Number of Patients 17 - 20 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 17 - 20 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 17 - 20 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 17 - 20 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 17 - 20 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 17 - 20 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 17 - 20 Years without OHS
Oral Health Status Report	 200

Number of Patients 21 - 30 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 21 - 30 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 21 - 30 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 21 - 30 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 21 - 30 Years with OHS 5
Oral Health Status Report	 200

Office Journal (continued)
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Number of Patients 21 - 30 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 21 - 30 Years without OHS
Oral Health Status Report	 200

Number of Patients 31 - 40 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 31 - 40 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 31 - 40 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 31 - 40 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 31 - 40 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 31 - 40 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 31 - 40 Years without OHS
Oral Health Status Report	 200

Number of Patients 41-50 Years
Oral Health Status Report	 200

Number of Patients 41-50 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 41-50 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 41-50 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 41-50 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 41-50 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 41-50 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 41-50 Years without OHS
Oral Health Status Report	 200

Number of Patients 5 - 6 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 5 - 6 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 5 - 6 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 5 - 6 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 5 - 6 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 5 - 6 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 5 - 6 Years without OHS
Oral Health Status Report	 200

Number of Patients 51 - 60 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 51 - 60 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 51 - 60 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 51 - 60 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 51 - 60 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 51 - 60 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 51 - 60 Years without OHS
Oral Health Status Report	 200

Number of Patients 61 - 70 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 61 - 70 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 61 - 70 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 61 - 70 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 61 - 70 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 61 - 70 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 61 - 70 Years without OHS
Oral Health Status Report	 200

Number of Patients 7 - 8 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 7 - 8 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 7 - 8 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 7 - 8 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 7 - 8 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 7 - 8 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 7 - 8 Years without OHS
Oral Health Status Report	 200

Number of Patients 71 - 80 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 71 - 80 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 71 - 80 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 71 - 80 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 71 - 80 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 71 - 80 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 71 - 80 Years without OHS
Oral Health Status Report	 200

Number of Patients 81+ Years with OHS 1
Oral Health Status Report	 200

Number of Patients 81+ Years with OHS 2
Oral Health Status Report	 200

Number of Patients 81+ Years with OHS 3
Oral Health Status Report	 200

Number of Patients 81+ Years with OHS 4
Oral Health Status Report	 200

Number of Patients 81+ Years with OHS 5
Oral Health Status Report	 200

Number of Patients 81+ Years with OHS 6
Oral Health Status Report	 200

Number of Patients 81+ Years without OHS
Oral Health Status Report	 200

Number of Patients without Birth Date
Oral Health Status Report	 200

Number of Patients without Birth Date and with OHS 1
Oral Health Status Report	 200

Oral Health Status (continued)
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Number of Patients without Birth Date and with OHS 2
Oral Health Status Report	 200

Number of Patients without Birth Date and with OHS 3
Oral Health Status Report	 200

Number of Patients without Birth Date and with OHS 4
Oral Health Status Report	 200

Number of Patients without Birth Date and with OHS 5
Oral Health Status Report	 200

Number of Patients without Birth Date and with OHS 6
Oral Health Status Report	 200

Number of Patients without Birth Date and without 
OHS

Oral Health Status Report	 200
Total Number of Patients with OHS 1

Oral Health Status Report	 200
Total Number of Patients with OHS 2

Oral Health Status Report	 200
Total Number of Patients with OHS 3

Oral Health Status Report	 200
Total Number of Patients with OHS 4

Oral Health Status Report	 200
Total Number of Patients with OHS 5

Oral Health Status Report	 200
Total Number of Patients with OHS 6

Oral Health Status Report	 200
Total Number of Patients without OHS

Oral Health Status Report	 200
Order

Number of Diagnostic Imaging Orders Recorded Using 
CPOE (Computerized Provider Order Entry)

Meaningful Use Measure Calculation List	 162
Number of Laboratory Tests Ordered

Meaningful Use Measure Calculation List	 162
Number of Prescriptions Ordered

Meaningful Use Measure Calculation List	 162
Number of Prescriptions Ordered Using CPOE (Com-
puterized Provider Order Entry)

Meaningful Use Measure Calculation List	 162
Number of Radiology Orders

Meaningful Use Measure Calculation List	 162
Number of Radiology Orders Recorded Using CPOE 
(Computerized Provider Order Entry)

Meaningful Use Measure Calculation List	 162
Orthodontics

Insurance Coverage Percent (Orthodontics) for Primary 
Insurance

Patient Route Slip	 226
Insurance Coverage Percent (Orthodontics) for Second-
ary Insurance

Patient Route Slip	 226
Other

Amount of Other Applied Credit Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Credit Adjustments for 
Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Credit Initial Balances for 
Clinic

Day Sheet Report	 100
Amount of Other Applied Credit Initial Balances for 
Provider

Day Sheet Report	 100
Amount of Other Applied Credit Special Adjustments 
for Clinic

Day Sheet Report	 100
Amount of Other Applied Credit Special Adjustments 
for Provider

Day Sheet Report	 100
Amount of Other Applied Insurance Payments for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Insurance Payments for 
Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Payments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Credit Initial Balances for Clinic
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Other Credit Initial Balances for Provider
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Other Credit Special Adjustments for Clinic
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Other Credit Special Adjustments for Pro-
vider

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Other Debit Adjustments (Average)
Practice Analysis Report	 252

Amount of Other Debit Adjustments (for Date Range)
Practice Analysis Report	 252

Amount of Other Debit Adjustments (MTD)
Practice Analysis Report	 252

Amount of Other Debit Adjustments (YTD)
Practice Analysis Report	 252

Amount of Other Deductible Owed by Family to Pri-
mary Insurance

Patient Route Slip	 226
Amount of Other Deductible Owed by Family to Sec-
ondary Insurance

Patient Route Slip	 226
Amount of Other Deductible Owed to Primary Insur-
ance

Patient Route Slip	 226
Amount of Other Deductible Owed to Secondary Insur-
ance

Patient Route Slip	 226

Oral Health Status (continued)
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Lifetime/Individual/Standard Other Deductible
Insurance Carrier List	 138

Number of Other Errors
Document Center Audit Documents Report	 114

Number of Other Gender
UDS - Age/Gender Report	 334

Number of Other Gender for Clinic
UDS - Age/Gender Report	 334

Number of Other Gender for Provider
UDS - Age/Gender Report	 334

Number of Other Patients
Practice Statistics Report	 256

Other Applied Credit Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Other Applied Insurance Payment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Other Applied Payment
Analysis Summary Report - Standard	 12

Other Applied Payment Amount
Analysis Summary Report - Daily	 8

Other Credit Initial Balance
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Other Credit Special Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Other Deductible Met
Insurance Carrier List	 138

Other Deductible Owed by Family to Primary Insurance
Treatment Case Report	 326

Other Deductible Owed by Family to Secondary Insur-
ance

Treatment Case Report	 326
Other Deductible Owed by Patient to Primary Insurance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Other Deductible Owed by Patient to Secondary Insur-
ance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Percent of Other Patients
Practice Statistics Report	 256

Total Amount of Other Applied Credit Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Other Applied Credit Initial Balances
Day Sheet Report	 100

Total Amount of Other Applied Credit Special Adjust-
ments

Day Sheet Report	 100
Total Amount of Other Applied Insurance Payments

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Other Applied Payments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100

Analysis Summary Report - Daily	 8
Total Amount of Other Credit Initial Balances

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Amount of Other Credit Special Adjustments
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Number of Other Errors
Document Center Audit Documents Report	 114

Total Number of Other Gender
UDS - Age/Gender Report	 334

Other ID
Other ID

Audit Report - Patients	 34
Other ID Change

Audit Report - Patients	 34
Patient Other ID

Patient List (Filtered)	 214
Letter Merge Reports	 158

Other Number
Patient Other Number

Patient Questionnaire	 222
Patient List	 212

Spouse Other Number
Patient Questionnaire	 222

Other Payment
Subtotal of Other Retroactive Payment Amount Col-
lected for Financial Class Type

UDS - Patient Related Revenue Report	 348
Subtotal of Other Retroactive Payment Amount Col-
lected for Payer Category

UDS - Patient Related Revenue Report	 348
Total Other Retroactive Payment Amount Collected for 
Financial Class Type

UDS - Patient Related Revenue Report	 348
Total Other Retroactive Payment Amount Collected for 
Patient

UDS - Patient Related Revenue Report	 348
Total Other Retroactive Payment Amount Collected for 
Payer Category

UDS - Patient Related Revenue Report	 348
Outpatient Visit

Number of Patients 18 - 85 Years with Outpatient Visits 
(with Exclusions)

Clinical Quality Measures List	 66
Number of Patients 3 - 17 Years with Outpatient Visits 
(with Exclusions)

Clinical Quality Measures List	 66
Outstanding

Outstanding Primary Insurance Estimated Amount
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Outstanding Secondary Insurance Estimated Amount
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Override
Overriding User

Audit Report - Clinics	 30
Audit Report - Combined	 32
Audit Report - Patients	 34
Audit Report - Providers/Staff	 36
Audit Report - Transactions	 38

Other (continued)



Index by Report Item   517

Dentrix Enterprise 11.0.2 Reports Reference

Audit Report - Appointments	 26
Owed

Amount of Other Deductible Owed by Family to Pri-
mary Insurance

Patient Route Slip	 226
Amount of Other Deductible Owed by Family to Sec-
ondary Insurance

Patient Route Slip	 226
Amount of Other Deductible Owed to Primary Insur-
ance

Patient Route Slip	 226
Amount of Other Deductible Owed to Secondary Insur-
ance

Patient Route Slip	 226
Amount of Preventative Deductible Owed by Family to 
Primary Insurance

Patient Route Slip	 226
Amount of Preventative Deductible Owed by Family to 
Secondary Insurance

Patient Route Slip	 226
Amount of Preventative Deductible Owed to Primary 
Insurance

Patient Route Slip	 226
Amount of Preventative Deductible Owed to Secondary 
Insurance

Patient Route Slip	 226
Amount of Standard Deductible Owed by Family to 
Primary Insurance

Patient Route Slip	 226
Amount of Standard Deductible Owed by Family to 
Secondary Insurance

Patient Route Slip	 226
Amount of Standard Deductible Owed to Primary Insur-
ance

Patient Route Slip	 226
Amount of Standard Deductible Owed to Secondary 
Insurance

Patient Route Slip	 226
Other Deductible Owed by Family to Primary Insurance

Treatment Case Report	 326
Other Deductible Owed by Family to Secondary Insur-
ance

Treatment Case Report	 326
Other Deductible Owed by Patient to Primary Insurance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Other Deductible Owed by Patient to Secondary Insur-
ance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Preventative Deductible Owed by Family to Primary Ins
Treatment Case Report	 326

Preventative Deductible Owed by Family to Secondary 
Ins

Treatment Case Report	 326
Preventative Deductible Owed by Patient to Primary Ins

Treatment Case Report	 326
Patient Treatment Case Report	 228

Preventative Deductible Owed by Patient to Secondary 
Ins

Treatment Case Report	 326
Patient Treatment Case Report	 228

Standard Deductible Owed by Family to Primary Insur-
ance

Treatment Case Report	 326
Standard Deductible Owed by Family to Secondary 
Insurance

Treatment Case Report	 326
Standard Deductible Owed by Patient to Primary Insur-
ance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Standard Deductible Owed by Patient to Secondary 
Insurance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Page
Clinical Note Page Number

Clinical Notes Report	 64
Number of Pages

Document Center List	 120
Paid

Amount of Primary Insurance Paid Benefits YTD for 
Family

Treatment Case Report	 326
Paid in by

Paid in by Name
Deposit Slip	 108

Paint Type
Paint Type

Procedure Code List	 266
Dental Diagnostic Code List	 104

Participating Provider
Number of Participating Providers

Insurance Carrier List	 138
Past Due

Payment Agreement Amount Past Due
Payment Agreement Report	 234

Total Amount of Payment Agreement Payments Past 
Due

Payment Agreement Report	 234
Patient

Accessed Patient Information
Audit Report - Combined	 32

Address of Patient on Appointment
Letter Merge Reports	 158

Amount Collected for Patient
UDS - Patient Related Revenue Report	 348

Amount of Allowances for Patient
UDS - Patient Related Revenue Report	 348

Amount of Annual Primary Insurance Plan Benefits for 
Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Annual Secondary Insurance Plan Benefits 
for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Bad Debt Write-offs for Patient
UDS - Patient Related Revenue Report	 348

Override (continued)
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Amount of Charges for Patient
UDS - Patient Related Revenue Report	 348

Amount of Completed Procedures for Patient
Procedures Not Attached to Insurance Report	270

Amount of Estimated Primary Insurance Benefits Re-
maining YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Estimated Secondary Insurance Benefits 
Remaining YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Patient Portion
Patient Treatment Case Report	 228
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Chart Printout	 204

Amount of Patient Portion for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Amount of Patient Portion for Visit
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Pending Estimated Primary Insurance Por-
tions YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Pending Estimated Secondary Insurance 
Portions YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Primary Insurance Paid Benefits YTD for 
Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Secondary Paid Benefits for Patient
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Sliding Discounts for Patient
UDS - Patient Related Revenue Report	 348

Average Charge per Patient
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Charge per Patient for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Charge per Patient for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Charge per Patient MTD
Day Sheet (Charges and Receipts) Report	 94

Average Charge per Patient MTD for Provider
Day Sheet (Charges and Receipts) Report	 94

Average Production per Patient
Analysis Summary Report - Standard	 12
Day Sheet Report	 100

Analysis Summary Report - Daily	 8
Average Production per Patient at Clinic from Referral 
Source

Referral Analysis Report	 294
Average Production per Patient for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Production per Patient for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Production Per Patient from Referral Source
Referral Analysis Report	 294

Average Production Per Patient from Referral Sources
Referral Analysis Report	 294

Average Production per Patient MTD
Day Sheet (Charges and Receipts) Report	 94

Average Production per Patient MTD for Provider
Day Sheet (Charges and Receipts) Report	 94

Best Time to Call Patient
Patient Questionnaire	 222

Birth Date
Insurance Claim Aging Report	 146
Insurance Eligibility Report	 152
Insurance Transaction Analysis Report	 154
Letter Merge Reports	 158
Birthday List	 50

Chart Number
Appointment Cycle Time Report	 16
Patient Revenue List by Payer Report	 224
Patient’s Ledger Report	 230
Procedures by Contracted Amount Report	 268
Appointment Book View Printout	 14

Current Average Charge per Patient
Day Sheet (Charges and Receipts) Report	 94

Current Average Charge per Patient for Provider
Day Sheet (Charges and Receipts) Report	 94

Current Average Production per Patient
Day Sheet (Charges and Receipts) Report	 94

Current Average Production per Patient for Provider
Day Sheet (Charges and Receipts) Report	 94

Current Number of Patients Seen
Day Sheet (Charges and Receipts) Report	 94

Current Number of Patients Seen by Provider
Day Sheet (Charges and Receipts) Report	 94

Employer Address (for Patient)
Patient Questionnaire	 222

Employer Name (for Patient)
Patient Questionnaire	 222

Estimated Amount of Patient’s Portion
Patient Treatment Case Report	 228
Treatment Case Report	 326
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Estimated Patient Portion
Patient Route Slip	 226

Ethnicity
UDS - Patient Status Report	 350

Exported Patient Health Information
Audit Report - Combined	 32
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Financial Class
UDS - Insurance Financial Class Report (2013)	344
UDS - Medicaid/Medicare Report	 346
UDS - Patient Status Report	 350
Insurance Carrier List	 138

Financial Class Type
UDS - Patient Related Revenue Report	 348
UDS - Insurance Financial Class Report	 342

Gender Identity
UDS - Patient Status Report	 350

Grand Total Amount of Patient Payments Received
Insurance Transaction Analysis Report	 154

Grand Total Number of Patient Payments Received
Insurance Transaction Analysis Report	 154

Homeless Status
UDS - Patient Status Report	 350

Housing Status
UDS - Patient Status Report	 350

Language
UDS - Patient Status Report	 350

Number of Active Patient Guarantors
Practice Statistics Report	 256

Number of Active Patients
Practice Statistics Report	 256
Practice Analysis Report	 252

Number of Charts Sampled
UDS - Sealant Statistics Report	 352

Number of Divorced Patients
Practice Statistics Report	 256

Number of Female Patients
Practice Statistics Report	 256

Number of Insured Active Patients
Practice Analysis Report	 252

Number of Insured Patients
Insurance Carrier List	 138

Number of Male Patients
Practice Statistics Report	 256

Number of Married Patients
Practice Statistics Report	 256

Number of Medicaid and Medicare Patients
UDS - Medicaid/Medicare Report	 346

Number of Medicaid and Medicare Patients at Clinic
UDS - Medicaid/Medicare Report	 346

Number of Medicaid and Medicare Patients for Pro-
vider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in First Age 
Group

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in First Age 
Group at Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in First Age 
Group for Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in First Age 
Group in ZIP Code

UDS - Medicaid/Medicare Report	 346

Number of Medicaid and Medicare Patients in First Age 
Group with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group at Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group for Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group in ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in ZIP 
Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients with Finan-
cial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients at Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients for Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in First Age Group

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in First Age Group at 
Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in First Age Group for 
Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in First Age Group in ZIP 
Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in First Age Group with 
Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in Second Age Group

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in Second Age Group at 
Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in Second Age Group for 
Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in Second Age Group in 
ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in Second Age Group 
with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients with Financial Class

UDS - Medicaid/Medicare Report	 346
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Number of Medicare Patients
UDS - Medicaid/Medicare Report	 346

Number of Medicare Patients at Clinic
UDS - Medicaid/Medicare Report	 346

Number of Medicare Patients for Provider
UDS - Medicaid/Medicare Report	 346

Number of Medicare Patients in First Age Group
UDS - Medicaid/Medicare Report	 346

Number of Medicare Patients in First Age Group at 
Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in First Age Group for 
Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in First Age Group in ZIP 
Code

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in First Age Group with 
Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in Second Age Group

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in Second Age Group at 
Clinic

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in Second Age Group for 
Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in Second Age Group in 
ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in Second Age Group 
with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients with Financial Class

UDS - Medicaid/Medicare Report	 346
Number of Other Patients

Practice Statistics Report	 256
Number of Patient Non-guarantors

Practice Statistics Report	 256
Number of Patients <6 or 65+ Years

Meaningful Use Measure Calculation List	 162
Number of Patients <6 or 65+ Years who Received Ap-
pointment Reminders

Meaningful Use Measure Calculation List	 162
Number of Patients 0 - 19 Years

Clinical Quality Measures List	 66
Number of Patients 0 - 19 Years with Fluoride Varnish

Clinical Quality Measures List	 66
Number of Patients 0 - 19 Years with Tooth Decay or 
Cavities

Clinical Quality Measures List	 66
Number of Patients 0 - 19 Years with Visit

Clinical Quality Measures List	 66
Number of Patients 0 - 2 Years

Practice Statistics Report	 256
Number of Patients 0 - 2 Years Seen

Meaningful Use Measure Calculation List	 162

Number of Patients 0 - 2 Years with Vital Sign Readings
Meaningful Use Measure Calculation List	 162
Meaningful Use Measure Calculation List	 162

Number of Patients 11 - 12 Years
Practice Statistics Report	 256

Number of Patients 13 - 14 Years
Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 13 - 14 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 13 - 14 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 13 - 14 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 13 - 14 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 13 - 14 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 13 - 14 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 13 - 14 Years without OHS
Oral Health Status Report	 200

Number of Patients 13+ Years Seen
Meaningful Use Measure Calculation List	 162
Meaningful Use Measure Calculation List	 162

Number of Patients 13+ Years with Smoking Status
Meaningful Use Measure Calculation List	 162
Meaningful Use Measure Calculation List	 162

Number of Patients 15 - 16 Years
Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 15 - 16 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 15 - 16 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 15 - 16 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 15 - 16 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 15 - 16 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 15 - 16 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 15 - 16 Years without OHS
Oral Health Status Report	 200

Number of Patients 17 - 20 Years
Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 17 - 20 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 17 - 20 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 17 - 20 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 17 - 20 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 17 - 20 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 17 - 20 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 17 - 20 Years without OHS
Oral Health Status Report	 200
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Number of Patients 18 - 64 Years
Clinical Quality Measures List	 66

Number of Patients 18 - 64 Years  with Abnormal BMI 
Reading and Follow Up

Clinical Quality Measures List	 66
Number of Patients 18 - 64 Years with Medical Encoun-
ters (with Exclusions)

Clinical Quality Measures List	 66
Number of Patients 18 - 85 Years

Clinical Quality Measures List	 66
Number of Patients 18 - 85 Years with Abnormal Blood 
Pressure Reading

Clinical Quality Measures List	 66
Number of Patients 18 - 85 Years with Hypertension

Clinical Quality Measures List	 66
Number of Patients 18 - 85 Years with Outpatient Visits 
(with Exclusions)

Clinical Quality Measures List	 66
Number of Patients 18+ Years

Clinical Quality Measures List	 66
Number of Patients 18+ Years who Use Tobacco and 
Received Cessation Counseling

Clinical Quality Measures List	 66
Number of Patients 18+ Years with Current Medications

Clinical Quality Measures List	 66
Number of Patients 18+ Years with Medical Encounters 
or Patient Health Assessments

Clinical Quality Measures List	 66
Number of Patients 18+ Years with Visits

UDS - Tobacco Use and Intervention Report	 354
Clinical Quality Measures List	 66

Number of Patients 2+ Years Seen
Meaningful Use Measure Calculation List	 162

Number of Patients 2+ Years with Vital Sign Readings
Meaningful Use Measure Calculation List	 162

Number of Patients 21 - 30 Years
Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 21 - 30 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 21 - 30 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 21 - 30 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 21 - 30 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 21 - 30 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 21 - 30 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 21 - 30 Years without OHS
Oral Health Status Report	 200

Number of Patients 3 - 17 Years
Clinical Quality Measures List	 66

Number of Patients 3 - 17 Years who Received Nutrition 
Counseling

Clinical Quality Measures List	 66
Number of Patients 3 - 17 Years who Received Physical 
Activity Counseling

Clinical Quality Measures List	 66

Number of Patients 3 - 17 Years with BMI Percentile 
Reading

Clinical Quality Measures List	 66
Number of Patients 3 - 17 Years with Medical Encoun-
ters (with Exclusions)

Clinical Quality Measures List	 66
Number of Patients 3 - 17 Years with Outpatient Visits 
(with Exclusions)

Clinical Quality Measures List	 66
Number of Patients 3 - 4 Years

Practice Statistics Report	 256
Number of Patients 3+ Years  with Vital Sign Readings

Meaningful Use Measure Calculation List	 162
Number of Patients 3+ Years Seen

Meaningful Use Measure Calculation List	 162
Number of Patients 3+ Years with Vital Sign Readings

Meaningful Use Measure Calculation List	 162
Number of Patients 31 - 40 Years

Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 31 - 40 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 31 - 40 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 31 - 40 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 31 - 40 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 31 - 40 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 31 - 40 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 31 - 40 Years without OHS
Oral Health Status Report	 200

Number of Patients 41 - 50 Years
Practice Statistics Report	 256

Number of Patients 41-50 Years
Oral Health Status Report	 200

Number of Patients 41-50 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 41-50 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 41-50 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 41-50 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 41-50 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 41-50 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 41-50 Years without OHS
Oral Health Status Report	 200

Number of Patients 5 - 6 Years
Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 5 - 6 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 5 - 6 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 5 - 6 Years with OHS 3
Oral Health Status Report	 200
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Number of Patients 5 - 6 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 5 - 6 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 5 - 6 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 5 - 6 Years without OHS
Oral Health Status Report	 200

Number of Patients 51 - 60 Years
Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 51 - 60 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 51 - 60 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 51 - 60 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 51 - 60 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 51 - 60 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 51 - 60 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 51 - 60 Years without OHS
Oral Health Status Report	 200

Number of Patients 6+ Months
Clinical Quality Measures List	 66

Number of Patients 6+ Months who Received Influenza 
Vaccinations

Clinical Quality Measures List	 66
Number of Patients 61 - 70 Years

Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 61 - 70 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 61 - 70 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 61 - 70 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 61 - 70 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 61 - 70 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 61 - 70 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 61 - 70 Years without OHS
Oral Health Status Report	 200

Number of Patients 65+ Years
Clinical Quality Measures List	 66

Number of Patients 65+ Years with Abnormal BMI 
Reading and Follow Up

Clinical Quality Measures List	 66
Number of Patients 65+ Years with Medical Encounters 
(with Exclusions)

Clinical Quality Measures List	 66
Number of Patients 66+ Years

Clinical Quality Measures List	 66
Number of Patients 66+ Years Seen

Clinical Quality Measures List	 66

Number of Patients 66+ Years with 1+ High-risk Medica-
tions

Clinical Quality Measures List	 66
Number of Patients 66+ Years with 2+ High-risk Medica-
tions

Clinical Quality Measures List	 66
Number of Patients 7 - 8 Years

Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 7 - 8 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 7 - 8 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 7 - 8 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 7 - 8 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 7 - 8 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 7 - 8 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 7 - 8 Years without OHS
Oral Health Status Report	 200

Number of Patients 71 - 80 Years
Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 71 - 80 Years with OHS 1
Oral Health Status Report	 200

Number of Patients 71 - 80 Years with OHS 2
Oral Health Status Report	 200

Number of Patients 71 - 80 Years with OHS 3
Oral Health Status Report	 200

Number of Patients 71 - 80 Years with OHS 4
Oral Health Status Report	 200

Number of Patients 71 - 80 Years with OHS 5
Oral Health Status Report	 200

Number of Patients 71 - 80 Years with OHS 6
Oral Health Status Report	 200

Number of Patients 71 - 80 Years without OHS
Oral Health Status Report	 200

Number of Patients 81+ Years
Practice Statistics Report	 256
Oral Health Status Report	 200

Number of Patients 81+ Years with OHS 1
Oral Health Status Report	 200

Number of Patients 81+ Years with OHS 2
Oral Health Status Report	 200

Number of Patients 81+ Years with OHS 3
Oral Health Status Report	 200

Number of Patients 81+ Years with OHS 4
Oral Health Status Report	 200

Number of Patients 81+ Years with OHS 5
Oral Health Status Report	 200

Number of Patients 81+ Years with OHS 6
Oral Health Status Report	 200

Number of Patients 81+ Years without OHS
Oral Health Status Report	 200

Number of Patients 9 - 10 Years
Practice Statistics Report	 256

Number of Patients at Clinic from Referral Source
Referral Analysis Report	 294
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Number of Patients Due for Prophy (on Month and Year)
Practice Statistics Report	 256

Number of Patients Eligible for Prophy Continuing Care
Practice Statistics Report	 256

Number of Patients for Provider
Practice Statistics Report	 256

Number of Patients from Referral Source
Referral Analysis Report	 294

Number of Patients in ZIP Code
Practice Statistics Report	 256

Number of Patients not on Prophy Continuing Care
Practice Statistics Report	 256

Number of Patients Provided API Access to Electronic 
Health Information

Meaningful Use Measure Calculation List	 162
Number of Patients Provided Patient Education Re-
sources

Meaningful Use Measure Calculation List	 162
Number of Patients Provided Timely Online Access to 
Electronic Health Information

Meaningful Use Measure Calculation List	 162
Number of Patients Seen

Analysis Summary Report - Standard	 12
Daily Summary Report	 88
Meaningful Use Measure Calculation List	 162
Analysis Summary Report - Daily	 8

Number of Patients Seen at Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Number of Patients Seen by Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Number of Patients Seen During Past 24 Months
Meaningful Use Measure Calculation List	 162

Number of Patients Seen for Insurance Carrier
Utilization Report	 366
RVU Utilization Report	 316

Number of Patients Seen MTD
Day Sheet (Charges and Receipts) Report	 94

Number of Patients Seen MTD by Provider
Day Sheet (Charges and Receipts) Report	 94

Number of Patients Sent Reminders
Meaningful Use Measure Calculation List	 162

Number of Patients who Accessed Electronic Health 
Information with API

Meaningful Use Measure Calculation List	 162
Number of Patients who Sent Secure Electronic Mes-
sages

Meaningful Use Measure Calculation List	 162
Number of Patients who Viewed or Downloaded or 
Transmitted (VDT) Electronic Health Information

Meaningful Use Measure Calculation List	 162
Number of Patients Who Were Sent Secure Electronic 
Messages

Meaningful Use Measure Calculation List	 162
Number of Patients with Dental and Medical Insurance

Practice Statistics Report	 256

Number of Patients with Electronic Prescriptions
Meaningful Use Measure Calculation List	 162

Number of Patients with Family Health History Re-
corded

Meaningful Use Measure Calculation List	 162
Number of Patients with Incorporated Health Data

Meaningful Use Measure Calculation List	 162
Number of Patients with Medication Allergies or Attes-
tations of No Known Medication Allergies

Meaningful Use Measure Calculation List	 162
Number of Patients with Medications

Meaningful Use Measure Calculation List	 162
Number of Patients with Medications or Attestations of 
No Known Medications

Meaningful Use Measure Calculation List	 162
Number of Patients with Medications Ordered Using 
CPOE (Computerized Provider Order Entry)

Meaningful Use Measure Calculation List	 162
Number of Patients with Moderate to High Risk of Car-
ies

UDS - Sealant Statistics Report	 352
Number of Patients with Moderate to High Risk of Car-
ies for Provider

UDS - Sealant Statistics Report	 352
Number of Patients with Moderate to High Risk of Car-
ies in Clinic

UDS - Sealant Statistics Report	 352
Number of Patients with Moderate to High Risk of Car-
ies in ZIP Code

UDS - Sealant Statistics Report	 352
Number of Patients with Moderate to High Risk of Car-
ies who Got Sealants on Permanent First Molars

UDS - Sealant Statistics Report	 352
Number of Patients with Moderate to High Risk of 
Caries who Got Sealants on Permanent First Molars for 
Provider

UDS - Sealant Statistics Report	 352
Number of Patients with Moderate to High Risk of 
Caries who Got Sealants on Permanent First Molars in 
Clinic

UDS - Sealant Statistics Report	 352
Number of Patients with Moderate to High Risk of Car-
ies who Got Sealants on Permanent First Molars in ZIP 
Code

UDS - Sealant Statistics Report	 352
Number of Patients with Primary Dental Insurance Only

Practice Statistics Report	 256
Number of Patients with Primary Medical Insurance

Practice Statistics Report	 256
Number of Patients with Problems or Attestations of No 
Known Problems

Meaningful Use Measure Calculation List	 162
Number of Patients with Required Demographics

Meaningful Use Measure Calculation List	 162
Number of Patients with Searchable Clinical Notes

Meaningful Use Measure Calculation List	 162
Number of Patients with Secondary Dental Insurance

Practice Statistics Report	 256
Number of Patients with Status

UDS - Patient Status Report	 350
Number of Patients with Status for Clinic

UDS - Patient Status Report	 350
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Number of Patients with Status for Provider
UDS - Patient Status Report	 350

Number of Patients with Vital Sign Readings
Meaningful Use Measure Calculation List	 162

Number of Patients without a Birth Date Entered
Practice Statistics Report	 256

Number of Patients without a ZIP Code
Practice Statistics Report	 256

Number of Patients without Birth Date
Oral Health Status Report	 200

Number of Patients without Birth Date and with OHS 1
Oral Health Status Report	 200

Number of Patients without Birth Date and with OHS 2
Oral Health Status Report	 200

Number of Patients without Birth Date and with OHS 3
Oral Health Status Report	 200

Number of Patients without Birth Date and with OHS 4
Oral Health Status Report	 200

Number of Patients without Birth Date and with OHS 5
Oral Health Status Report	 200

Number of Patients without Birth Date and with OHS 6
Oral Health Status Report	 200

Number of Patients without Birth Date and without 
OHS

Oral Health Status Report	 200
Number of Patients without Dental and Medical Insur-
ance

Practice Statistics Report	 256
Number of Patients without Dental Insurance

Practice Statistics Report	 256
Number of Patients without Medical Insurance

Practice Statistics Report	 256
Number of Referred by Doctor/Other Patients Listed

Referred By Doctor/Other Report	 300
Number of Separated Patients

Practice Statistics Report	 256
Number of Single Patients

Practice Statistics Report	 256
Number of Tobacco Non-users 18+ Years with Tobacco 
Use Assessment

UDS - Tobacco Use and Intervention Report	 354
Number of Widowed Patients

Practice Statistics Report	 256
Number or Child Patients

Practice Statistics Report	 256
Other Deductible Owed by Patient to Primary Insurance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Other Deductible Owed by Patient to Secondary Insur-
ance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Other Retroactive Payment Amount Collected for 
Patient

UDS - Patient Related Revenue Report	 348
Patient Address

Birthday List	 50
Continuing Care Cards - No Appointment	 74
Continuing Care Cards - with Appointment	 75
Coupon Book - Future Due Payments	 78

Coupon Book - Payment Agreements	 79
New Patient List	 190
Patient Ledger Report	 210
Patient List	 212
Patient Questionnaire	 222
Patient Route Slip	 226
Patient’s Ledger Report	 230
Prescription Printout	 260
Referral Recap Report	 296
Referral Slip	 298
Walkout - Doctor’s Statement	 368
Appointment Reminder Cards	 18

Patient Age
Patient List (Filtered)	 214
Patient Route Slip	 226
Walkout - Doctor’s Statement	 368
Continuing Care Display List	 76

Patient Alert Note
Patient Notes Report	 216

Patient Amount Aged >90
Patient Route Slip	 226

Patient Amount Aged 0 - 30
Patient Route Slip	 226

Patient Amount Aged 31 - 60
Patient Route Slip	 226

Patient Amount Aged 61 - 90
Patient Route Slip	 226

Patient Balance
Patient Route Slip	 226
Patient Treatment Case Report	 228
Patient’s Ledger Report	 230
Referred By Doctor/Other Report	 300
Referred By Patient Report	 302
Treatment Case Report	 326
Continuing Care Display List	 76

Patient Birth Date
Employers and Employed Patients Report	 122
Insurance Carrier List	 138
Patient Chart and Progress Notes Printout	 202
Patient Chart Printout	 204
Patient List	 212
Patient List (Filtered)	 214
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220
Patient Questionnaire	 222
Patient Route Slip	 226
Patient Treatment Case Report	 228
Perio - Combined Graphic & Data Chart Report	
238
Perio - Exam Comparison Report	 242
Perio - Graphic Chart Report	 244
Practice Treatment Case Report	 258
Prescription Printout	 260
Pre-Treatment Estimate Aging Report	 262
RVU Utilization Report	 316
Treatment Case Report	 326
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
UDS - Age/Gender Report	 334
UDS - Insurance Financial Class Report	 342
UDS - Insurance Financial Class Report (2013)	344
UDS - Medicaid/Medicare Report	 346
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UDS - Patient Status Report	 350
UDS - Sealant Statistics Report	 352
UDS - Tobacco Use and Intervention Report	 354
Utilization Report	 366
Walkout - Doctor’s Statement	 368
Clinical Notes Report	 64

Patient Chart Number
Clinical Notes Report	 64
Coupon Book - Future Due Payments	 78
Coupon Book - Payment Agreements	 79
Day Sheet (Adjustments) Report	 90
Day Sheet (Receipts) Report	 98
Employers and Employed Patients Report	 122
Insurance Carrier List	 138
Insurance Eligibility Report	 152
Letter Merge Reports	 158
Operator Day Sheet Report	 194
Patient Chart and Progress Notes Printout	 202
Patient Chart Printout	 204
Patient Information Accessed Report	 208
Patient Ledger Report	 210
Patient List	 212
Patient List (Filtered)	 214
Patient Notes Report	 216
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220
Patient Route Slip	 226
Patient Treatment Case Report	 228
Perio - Exam Comparison Report	 242
Perio - Graphic Chart Report	 244
Practice Treatment Case Report	 258
RVU Day Sheet Report	 308
Treatment Case Report	 326
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
UDS - Age/Gender Report	 334
UDS - Insurance Financial Class Report	 342
UDS - Insurance Financial Class Report (2013)	344
UDS - Medicaid/Medicare Report	 346
UDS - Patient Status Report	 350
UDS - Sealant Statistics Report	 352
UDS - Tobacco Use and Intervention Report	 354
Walkout - Doctor’s Statement	 368
Audit Report - Combined	 32

Patient City
Patient List (Filtered)	 214
Letter Merge Reports	 158

Patient Clinic
Patient List (Filtered)	 214

Patient Contact
Patient List (Filtered)	 214

Patient County
Patient List (Filtered)	 214

Patient Driver’s License Number
Patient Questionnaire	 222
Patient List	 212

Patient Email Address
Patient Questionnaire	 222
Patient List	 212

Patient Employer
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Patient Employer Name
Insurance Carrier List	 138

Patient EMR Number
UDS - Insurance Financial Class Report	 342
UDS - Insurance Financial Class Report (2013)	344
UDS - Medicaid/Medicare Report	 346
UDS - Patient Status Report	 350
UDS - Sealant Statistics Report	 352
UDS - Tobacco Use and Intervention Report	 354
UDS - Age/Gender Report	 334

Patient Estimated Insurance Portion
Patient Route Slip	 226

Patient Ethnicity
Patient List (Filtered)	 214

Patient Ext ID
Patient List (Filtered)	 214

Patient Fax Number
Patient Questionnaire	 222
Patient List	 212

Patient First Name
Letter Merge Reports	 158

Patient Gender
Patient List	 212
Patient Questionnaire	 222
Patient Route Slip	 226
UDS - Age/Gender Report	 334
Letter Merge Reports	 158

Patient Homeless Status
Patient List (Filtered)	 214

Patient Insurance Carrier Name
Continuing Care Display List	 76

Patient Language
Patient List (Filtered)	 214
Letter Merge Reports	 158

Patient Last Name
Letter Merge Reports	 158

Patient Marital Status
Insurance Carrier List	 138
Letter Merge Reports	 158
Patient List	 212
Patient Route Slip	 226
Employers and Employed Patients Report	 122

Patient Medical/Other ID
Patient List	 212

Patient Middle Initial
Letter Merge Reports	 158

Patient Mobile Number
Patient List (Filtered)	 214
Patient Questionnaire	 222
Patient List	 212

Patient Name
Appointment Cycle Time Report	 16
Appointment Reminder Cards	 18
As Soon As Possible List	 22
Audit Report - Appointments	 26
Audit Report - Combined	 32
Audit Report - Patients	 34
Audit Report - Transactions	 38
Billing Statement	 48
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Birthday List	 50
Clinical Notes Report	 64
Continuing Care Cards - No Appointment	 74
Continuing Care Cards - with Appointment	 75
Continuing Care Display List	 76
Coupon Book - Future Due Payments	 78
Coupon Book - Payment Agreements	 79
Daily Appointment List (DX1)	 84
Daily Appointment List Report	 86
Day Sheet (Adjustments) Report	 90
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Receipts) Report	 98
Day Sheet Report	 100
Dental Encounters Report	 106
Document Center Document	 116
Document Center List	 120
Employers and Employed Patients Report	 122
Family Ledger Report	 124
Family Ledger Report (Single Family)	 126
Future Due Payment Plan Report - Standard	 134
Insurance Carrier List	 138
Insurance Carrier Production - Full Report	 142
Insurance Claim Aging Report	 146
Insurance Claims Not Sent Report	 148
Insurance Eligibility Report	 152
Insurance Transaction Analysis Report	 154
New Patient List	 190
Operator Day Sheet Report	 194
Operatory Appointment List Report	 196
Patient Chart and Progress Notes Printout	 202
Patient Chart Printout	 204
Patient Health Assessment Report	 206
Patient Information Accessed Report	 208
Patient Ledger Report	 210
Patient Ledger Report	 210
Patient List	 212
Patient List (Filtered)	 214
Patient Notes Report	 216
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220
Patient Questionnaire	 222
Patient Revenue List by Payer Report	 224
Patient Route Slip	 226
Patient Route Slip	 226
Patient Treatment Case Report	 228
Patient’s Ledger Report	 230
Patient’s Ledger Report	 230
Perio - Combined Graphic & Data Chart Report	
238
Perio - Data Chart Report	 240
Perio - Exam Comparison Report	 242
Perio - Graphic Chart Report	 244
Perio - Pocket Depths Only Report	 246
Perio Exam List	 248
Practice Treatment Case Report	 258
Prescription Printout	 260
Pre-Treatment Estimate Aging Report	 262
Pre-Treatment Estimates Not Sent Report	 264
Procedures by Contracted Amount Report	 268
Procedures Not Attached to Insurance Report	270

Production Summary Report	 272
Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Referral Recap Report	 296
Referral Slip	 298
Referred By Doctor/Other Report	 300
RVU Day Sheet Report	 308
RVU Production Summary Report	 310
RVU Utilization Report	 316
Secondary Insurance Claims Not Created Report	
318
Secondary Pre-Treatment Estimates Not Created 
Report	 320
Suspended Credits Report	 324
Treatment Case Report	 326
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
UDS - Age/Gender Report	 334
UDS - Insurance Financial Class Report	 342
UDS - Insurance Financial Class Report (2013)	344
UDS - Medicaid/Medicare Report	 346
UDS - Patient Related Revenue Report	 348
UDS - Patient Status Report	 350
UDS - Sealant Statistics Report	 352
UDS - Tobacco Use and Intervention Report	 354
Unscheduled Appointment List (DX1)	 356
Unscheduled Appointment List (OM)	 358
Unscheduled Treatment Plans (Condensed) Re-
port	 360
Unscheduled Treatment Plans (Detailed) Report	
362
Utilization Report	 366
Walkout - Doctor’s Statement	 368
Walkout - Family Walkout	 370
Appointment Book View Printout	 14

Patient Name Change
Audit Report - Patients	 34
Audit Report - Transactions	 38
Audit Report - Appointments	 26

Patient Name on Appointment
Letter Merge Reports	 158

Patient Note
Patient Route Slip	 226
Patient Notes Report	 216

Patient Other ID
Patient List (Filtered)	 214
Letter Merge Reports	 158

Patient Other Number
Patient Questionnaire	 222
Patient List	 212

Patient Poverty Level
Patient List (Filtered)	 214

Patient Preferred Contact Method
Patient List (Filtered)	 214

Patient Race
Patient List (Filtered)	 214

Patient Relationship to Subscriber for Primary Insurance
Patient Questionnaire	 222

Patient Relationship to Subscriber for Secondary Insur-
ance

Patient Questionnaire	 222
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Patient Religion
Patient List (Filtered)	 214

Patient Running Balance
Patient Ledger Report	 210

Patient Salutation
Continuing Care Cards - with Appointment	 75
Letter Merge Reports	 158
Continuing Care Cards - No Appointment	 74

Patient Signature
Treatment Case Report	 326

Patient Social Security Number
Coupon Book - Future Due Payments	 78
Coupon Book - Payment Agreements	 79
Employers and Employed Patients Report	 122
Insurance Transaction Analysis Report	 154
Letter Merge Reports	 158
Patient Chart and Progress Notes Printout	 202
Patient Chart Printout	 204
Patient List	 212
Patient Notes Report	 216
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220
Patient Questionnaire	 222
Patient Route Slip	 226
Patient Treatment Case Report	 228
Perio - Combined Graphic & Data Chart Report	
238
Perio - Exam Comparison Report	 242
Perio - Graphic Chart Report	 244
Practice Treatment Case Report	 258
RVU Utilization Report	 316
Treatment Case Report	 326
UDS - Age/Gender Report	 334
UDS - Insurance Financial Class Report	 342
UDS - Insurance Financial Class Report (2013)	344
UDS - Medicaid/Medicare Report	 346
UDS - Patient Status Report	 350
UDS - Sealant Statistics Report	 352
UDS - Tobacco Use and Intervention Report	 354
Utilization Report	 366
Walkout - Doctor’s Statement	 368
Clinical Notes Report	 64

Patient Social Security Number or Request Date
Audit Report - Patients	 34

Patient Social Security Number or Request Date 
Change

Audit Report - Patients	 34
Patient State

Patient List (Filtered)	 214
Letter Merge Reports	 158

Patient Status
Letter Merge Reports	 158
New Patient List	 190
Patient List	 212
Audit Report - Patients	 34

Patient Status Change
Audit Report - Patients	 34

Patient Street Address
Patient List (Filtered)	 214
Letter Merge Reports	 158

Patient Suspended Credit Amount
Patient Route Slip	 226

Patient Title
Letter Merge Reports	 158

Patient User Defined Category
Patient List (Filtered)	 214

Patient Veteran Status
Patient List (Filtered)	 214

Patient Work Phone Extension
Patient Ledger Report	 210
Patient Questionnaire	 222
Letter Merge Reports	 158

Patient Work Phone Number
Continuing Care Display List	 76
Letter Merge Reports	 158
Patient Ledger Report	 210
Patient List	 212
Patient List (Filtered)	 214
Patient Notes Report	 216
Patient Questionnaire	 222
Patient Route Slip	 226
Appointment Book View Printout	 14

Patient Worker Status
Patient List (Filtered)	 214

Patient ZIP Code
Patient List (Filtered)	 214
Letter Merge Reports	 158

Patient’s Preferred Name
Letter Merge Reports	 158
Appointment Book View Printout	 14

Penalty or Payback Amount Collected for Patient
UDS - Patient Related Revenue Report	 348

Percent of Active Patient Guarantors
Practice Statistics Report	 256

Percent of Active Patients
Practice Statistics Report	 256

Percent of Divorced Patients
Practice Statistics Report	 256

Percent of Female Patients
Practice Statistics Report	 256

Percent of Male Patients
Practice Statistics Report	 256

Percent of Married Patients
Practice Statistics Report	 256

Percent of Other Patients
Practice Statistics Report	 256

Percent of Patient Non-guarantors
Practice Statistics Report	 256

Percent of Patients Due for Prophy (Month and Year)
Practice Statistics Report	 256

Percent of Patients for Provider
Practice Statistics Report	 256

Percent of Patients in ZIP Code
Practice Statistics Report	 256

Percent of Patients not on Prophy Continuing Care
Practice Statistics Report	 256

Percent of Patients with Dental and Medical Insurance
Practice Statistics Report	 256

Percent of Patients with Dental Fluorosis
Caries Prevalence and Periodontal Index Report	
52
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Percent of Patients with dmfs > 0
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Highest CPITN
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with History of Decay
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Loss of Attachment < 3 mm
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Loss of Attachment >= 3 & < 5 
mm

Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Loss of Attachment >= 5 mm
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Perio Pockets < 4 mm
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Perio Pockets >= 4 & 6 mm
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Perio Pockets >= 6 mm
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Primary Dental Insurance Only
Practice Statistics Report	 256

Percent of Patients with Primary Medical Insurance
Practice Statistics Report	 256

Percent of Patients with Secondary Dental Insurance
Practice Statistics Report	 256

Percent of Patients without a Birth Date Entered
Practice Statistics Report	 256

Percent of Patients without Dental and Medical Insur-
ance

Practice Statistics Report	 256
Percent of Patients without Dental Insurance

Practice Statistics Report	 256
Percent of Patients without Medical Insurance

Practice Statistics Report	 256
Percent of Separated Patients

Practice Statistics Report	 256
Percent of Single Patients

Practice Statistics Report	 256
Percent of Widowed Patients

Practice Statistics Report	 256
Percent or Child Patients

Practice Statistics Report	 256
Phone Number of Patient on Appointment

Letter Merge Reports	 158
Poverty Level

UDS - Patient Status Report	 350
Preventative Deductible Owed by Patient to Primary Ins

Treatment Case Report	 326
Patient Treatment Case Report	 228

Preventative Deductible Owed by Patient to Secondary 
Ins

Treatment Case Report	 326
Patient Treatment Case Report	 228

Primary Insurance Benefits Expiration Date for Patient
Treatment Case Report	 326
Patient Treatment Case Report	 228

Printed Patient Report
Audit Report - Combined	 32

Race
UDS - Patient Status Report	 350

Referred by Patient Name
Document Center Document	 116

Referred Patient
Referred By Patient Report	 302

Referred Patient Name
Referred To Doctor Report	 304

Referred Patients (Average)
Practice Analysis Report	 252

Referred Patients (for Date Range)
Practice Analysis Report	 252

Referred Patients (MTD)
Practice Analysis Report	 252

Referred Patients (YTD)
Practice Analysis Report	 252

Referring Patient Address
Referred By Patient Report	 302

Referring Patient Home Phone Number
Referred By Patient Report	 302

Referring Patient Name
Referred By Patient Report	 302

Religion
UDS - Patient Status Report	 350

Secondary Insurance Benefits Expiration Date for 
Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Sexual Orientation
UDS - Patient Status Report	 350

Standard Deductible Owed by Patient to Primary Insur-
ance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Standard Deductible Owed by Patient to Secondary 
Insurance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Total Amount Collected for Patient
UDS - Patient Related Revenue Report	 348

Total Amount of Allowances for Patient
UDS - Patient Related Revenue Report	 348

Total Amount of Bad Debt Write-offs for Patient
UDS - Patient Related Revenue Report	 348

Total Amount of Charges for Patient
UDS - Patient Related Revenue Report	 348

Total Amount of Patient Payments Received
Insurance Transaction Analysis Report	 154

Total Amount of Patient Portion for Case
Treatment Case Report	 326

Total Amount of Patient Portions
Patient Chart Printout	 204
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Total Amount of Sliding Discounts for Patient
UDS - Patient Related Revenue Report	 348

Total Average Charge per Patient
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Average Production per Patient
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Average Production per Patient at Clinics from 
Referral Source

Referral Analysis Report	 294
Total Estimated Amount of Patient’s Portion

Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Total Number
UDS - Insurance Financial Class Report	 342

Total Number <19 Years Old for Financial Class Types
UDS - Insurance Financial Class Report	 342

Total Number of All Genders
UDS - Age/Gender Report	 334

Total Number of Females
UDS - Age/Gender Report	 334

Total Number of Males
UDS - Age/Gender Report	 334

Total Number of Other Gender
UDS - Age/Gender Report	 334

Total Number of Patient Payments Received
Insurance Transaction Analysis Report	 154

Total Number of Patient with Medicaid
Operator Day Sheet Report	 194

Total Number of Patients
Oral Health Status Report	 200
Operator Day Sheet Report	 194

Total Number of Patients (any Status)
Practice Statistics Report	 256

Total Number of Patients at Clinics from Referral Source
Referral Analysis Report	 294

Total Number of Patients from Referral Sources
Referral Analysis Report	 294

Total Number of Patients Seen
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
RVU Utilization Report	 316
Utilization Report	 366
Analysis Summary Report - Daily	 8

Total Number of Patients with OHS 1
Oral Health Status Report	 200

Total Number of Patients with OHS 2
Oral Health Status Report	 200

Total Number of Patients with OHS 3
Oral Health Status Report	 200

Total Number of Patients with OHS 4
Oral Health Status Report	 200

Total Number of Patients with OHS 5
Oral Health Status Report	 200

Total Number of Patients with OHS 6
Oral Health Status Report	 200

Total Number of Patients with Statuses
UDS - Patient Status Report	 350

Total Number of Patients without OHS
Oral Health Status Report	 200

Total Number of Referred by Doctor/Other Patients 
Listed

Referred By Doctor/Other Report	 300
Total Number of Unknown Gender

UDS - Age/Gender Report	 334
Total Other Retroactive Payment Amount Collected for 
Patient

UDS - Patient Related Revenue Report	 348
Total Patient Balance (as of Date)

Patient Ledger Report	 210
Total Patient Balance as of a Date

Patient’s Ledger Report	 230
Total Penalty or Payback Amount Collected for Patient

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Patient (Current Year)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Patient (Previous Years)

UDS - Patient Related Revenue Report	 348
Unique Patient Count for Provider

RVU Day Sheet Report	 308
User Defined Category

UDS - Patient Status Report	 350
Veteran Status

UDS - Patient Status Report	 350
Worker Status

UDS - Patient Status Report	 350
Wrap Around or Reconciliation Amount Collected for 
Patient (Current Year)

UDS - Patient Related Revenue Report	 348
Wrap Around or Reconciliation Amount Collected for 
Patient (Previous Years)

UDS - Patient Related Revenue Report	 348
Years as Patient

Patient Route Slip	 226
Patient Alert

Alerts
Appointment Book View Printout	 14

Patient Alert Note
Patient Notes Report	 216

Patient Education Resource
Number of Patients Provided Patient Education Re-
sources

Meaningful Use Measure Calculation List	 162
Patient Health Assessment

Number of Patients 18+ Years with Medical Encounters 
or Patient Health Assessments

Clinical Quality Measures List	 66
Patient Note

Patient Note
Patient Route Slip	 226
Patient Notes Report	 216

Patient Portion
Amount of Patient Portion

Patient Treatment Case Report	 228
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Chart Printout	 204
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Amount of Patient Portion for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Amount of Patient Portion for Visit
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Estimated Amount of Patient’s Portion
Patient Treatment Case Report	 228
Treatment Case Report	 326
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Estimated Patient Portion
Patient Route Slip	 226

Total Amount of Patient Portion for Case
Treatment Case Report	 326

Total Amount of Patient Portions
Patient Chart Printout	 204

Total Estimated Amount of Patient’s Portion
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Pay
Amount to Pay

Billing Statement	 48
Payback

Penalty or Payback Amount Collected for Patient
UDS - Patient Related Revenue Report	 348

Subtotal of Penalty or Payback Amount Collected for 
Financial Class Type

UDS - Patient Related Revenue Report	 348
Subtotal of Penalty or Payback Amount Collected for 
Payer Category

UDS - Patient Related Revenue Report	 348
Total Penalty or Payback Amount Collected for Financial 
Class Type

UDS - Patient Related Revenue Report	 348
Total Penalty or Payback Amount Collected for Patient

UDS - Patient Related Revenue Report	 348
Total Penalty or Payback Amount Collected for Payer 
Category

UDS - Patient Related Revenue Report	 348
Payer

Payer Category
UDS - Patient Related Revenue Report	 348

Payer Name
Procedures by Contracted Amount Report	 268
Patient Revenue List by Payer Report	 224

Subtotal of Allowances for Payer Category
UDS - Patient Related Revenue Report	 348

Subtotal of Amount Collected for Payer Category
UDS - Patient Related Revenue Report	 348

Subtotal of Bad Debt Write-offs for Payer Category
UDS - Patient Related Revenue Report	 348

Subtotal of Charges for Payer Category
UDS - Patient Related Revenue Report	 348

Subtotal of Other Retroactive Payment Amount Col-
lected for Payer Category

UDS - Patient Related Revenue Report	 348

Subtotal of Penalty or Payback Amount Collected for 
Payer Category

UDS - Patient Related Revenue Report	 348
Subtotal of Sliding Discounts for Payer Category

UDS - Patient Related Revenue Report	 348
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Payer Category (Current Year)

UDS - Patient Related Revenue Report	 348
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Payer Category (Previous Years)

UDS - Patient Related Revenue Report	 348
Total Amount Collected for Payer Category

UDS - Patient Related Revenue Report	 348
Total Amount of Allowances for Payer Category

UDS - Patient Related Revenue Report	 348
Total Amount of Bad Debt Write-offs for Payer Category

UDS - Patient Related Revenue Report	 348
Total Amount of Charges for Payer Category

UDS - Patient Related Revenue Report	 348
Total Amount of Sliding Discounts for Payer Category

UDS - Patient Related Revenue Report	 348
Total Other Retroactive Payment Amount Collected for 
Payer Category

UDS - Patient Related Revenue Report	 348
Total Penalty or Payback Amount Collected for Payer 
Category

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Payer Category (Current Year)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Payer Category (Previous Years)

UDS - Patient Related Revenue Report	 348
Payment

Amount Due for Payment Agreement
Collections Manager List	 70

Amount of Applied Insurance Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Applied Insurance Payments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Applied Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Applied Payments for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Applied Payments for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Current Applied Payments for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of Current Suspended Payments for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of Future Due Payment Agreements
Practice Analysis Report	 252
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Amount of Guarantor Payments YTD
Walkout - Family Walkout	 370

Amount of Insurance Payments
Provider A/R Totals - Daily Report	 276

Amount of Insurance Payments for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of Insurance Payments YTD
Walkout - Family Walkout	 370

Amount of Last Payment Amount
Letter Merge Reports	 158

Amount of MTD Applied Payments for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of MTD Suspended Payments for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of Other Applied Insurance Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Insurance Payments for 
Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Payments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Payment Agreements
Practice Analysis Report	 252

Amount of Payment Type
Payment Summary Report	 236

Amount of Payments
Provider A/R Totals - Daily Report	 276

Amount of Payments for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of Primary Insurance Paid Benefits YTD for 
Family

Treatment Case Report	 326
Amount of Primary Insurance Paid Benefits YTD for 
Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Secondary Paid Benefits for Family
Treatment Case Report	 326

Amount of Secondary Paid Benefits for Patient
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Suspended Insurance Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Insurance Payments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100

Analysis Summary Report - Daily	 8
Amount of Suspended Payments for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Payments for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Suspended Payments for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of YTD Applied Payments for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Suspended Payments for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount Paid
Coupon Book - Payment Agreements	 79
Coupon Book - Future Due Payments	 78

Amount Paid by Insurance
Dental Encounters Report	 106

Amount to Pay
Billing Statement	 48

Applied Insurance Payment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Applied Payment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Average Amount of Payment Type
Payment Summary Report	 236

Average Amount of Payments
Payment Summary Report	 236

Average Payment Amount
Day Sheet (Receipts) Report	 98

Average Payment Amount for Clinic
Day Sheet (Receipts) Report	 98

Average Payment Amount for Initial Provider
Day Sheet (Receipts) Report	 98

Average Payment Amount for Payment Type
Day Sheet (Receipts) Report	 98

Average Payment Amount for Provider
Day Sheet (Receipts) Report	 98

Claim Payment Received Date
Insurance Transaction Analysis Report	 154

Date of Last Payment Agreement Payment
Letter Merge Reports	 158

Date of Payment
Coupon Book - Future Due Payments	 78

Estimated Amount of Insurance Payments
Treatment Case Report	 326
Patient Treatment Case Report	 228

First Payment Amount
Truth in Lending Disclosure Statement	 332

First Payment Date
Payment Agreement Report	 234

Grand Total Amount of Insurance Payments Received
Insurance Transaction Analysis Report	 154

Grand Total Amount of Patient Payments Received
Insurance Transaction Analysis Report	 154

Grand Total Number of Insurance Payments Received
Insurance Transaction Analysis Report	 154
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Grand Total Number of Patient Payments Received
Insurance Transaction Analysis Report	 154

Insurance Payment Amount
Insurance Carrier Production - Full Report	 142

Insurance Payment Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Insurance Payment for Date of Service
Letter Merge Reports	 158

Last Payment Agreement Payment Amount
Patient Route Slip	 226

Last Payment Agreement Payment Date
Patient Route Slip	 226

Last Payment Amount
Truth in Lending Disclosure Statement	 332
Aging/Credit Balance Report	 6

Last Payment Amount for Payment Agreement
Collections Manager List	 70

Last Payment Date
Aging/Credit Balance Report	 6

Last Payment Date for Payment Agreement
Collections Manager List	 70

Next Payment Agreement Payment Due Amount
Patient Route Slip	 226

Next Payment Agreement Payment Due Date
Patient Route Slip	 226

Next Payment Plan Payment Amount
Letter Merge Reports	 158

Next Payment Plan Payment Date
Letter Merge Reports	 158

Number of Missed Payment Agreement Payments
Practice Analysis Report	 252

Number of Missed Payments
Payment Agreement Report	 234

Number of Missed Payments for Payment Agreement
Collections Manager List	 70

Number of Payment Agreement Payments Remaining
Payment Agreement Report	 234

Other Applied Insurance Payment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Other Applied Payment
Analysis Summary Report - Standard	 12

Other Applied Payment Amount
Analysis Summary Report - Daily	 8

Other Retroactive Payment Amount Collected for 
Patient

UDS - Patient Related Revenue Report	 348
Payment

Day Sheet (Charges and Receipts) Report	 94
Payment Agreement Last Payment Amount

Payment Agreement Report	 234
Payment Agreement Last Payment Date

Payment Agreement Report	 234
Payment Agreement Next Payment Amount

Payment Agreement Report	 234
Payment Agreement Next Payment Date

Payment Agreement Report	 234

Payment Agreement Payment Amount
Payment Agreement Amortization Schedule	 232

Payment Agreement Payment Due Date
Payment Agreement Amortization Schedule	 232

Payment Agreement Payment Number
Payment Agreement Amortization Schedule	 232

Payment Agreement Payment Portion Applied to Inter-
est

Payment Agreement Amortization Schedule	 232
Payment Agreement Payment Portion Applied to Prin-
ciple

Payment Agreement Amortization Schedule	 232
Payment Agreement Remaining Balance

Payment Agreement Report	 234
Payment Agreement Report	 234
Payment Agreement Amortization Schedule	 232

Payment Agreement Total Number of Payments
Payment Agreement Report	 234

Payment Amount
Family Ledger Report	 124
Family Ledger Report (Single Family)	 126
Insurance Transaction Analysis Report	 154
Operator Day Sheet Report	 194
Patient Ledger Report	 210
Patient’s Ledger Report	 230
Procedures by Contracted Amount Report	 268
Truth in Lending Disclosure Statement	 332
Updated Dental Insurance Payment Table Report	
364
Deposit Slip	 108

Payment Amount Due
Coupon Book - Payment Agreements	 79
Coupon Book - Future Due Payments	 78

Payment Amount for Payment Type
Day Sheet (Receipts) Report	 98

Payment Date
Patient’s Ledger Report	 230
Deposit Slip	 108

Payment Description
Patient’s Ledger Report	 230

Payment Due Date
Coupon Book - Payment Agreements	 79
Coupon Book - Future Due Payments	 78

Payment Interval
Payment Agreement Amortization Schedule	 232

Payment Number
Coupon Book - Payment Agreements	 79
Coupon Book - Future Due Payments	 78

Payment Status
Credit Card Transaction Report	 80

Payment Type
Daily Summary Report	 88
Day Sheet (Receipts) Report	 98
Deposit Slip	 108
Credit Card Transaction Report	 80

Payment Type Description
Payment Summary Report	 236

Payment Types
Custom Practice Information Report	 82

Please Pay Amount
Walkout - Family Walkout	 370
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Quantity of Payment Type
Payment Summary Report	 236

Quantity of Payments for Clinic
Day Sheet (Receipts) Report	 98

Quantity of Payments for Initial Provider
Day Sheet (Receipts) Report	 98

Quantity of Payments for Payment Type
Day Sheet (Receipts) Report	 98

Quantity of Payments for Provider
Day Sheet (Receipts) Report	 98

Quantity of Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Source of Payment
Insurance Carrier List	 138

Subtotal of Other Retroactive Payment Amount Col-
lected for Financial Class Type

UDS - Patient Related Revenue Report	 348
Subtotal of Other Retroactive Payment Amount Col-
lected for Payer Category

UDS - Patient Related Revenue Report	 348
Suspended Insurance Payment Amount

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Suspended Payment
Analysis Summary Report - Standard	 12

Suspended Payment Amount
Analysis Summary Report - Daily	 8

Total Amount of Applied Insurance Payments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Applied Payments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Balances Remaining for Payment 
Agreements

Payment Agreement Report	 234
Total Amount of Cash Payments

Operator Day Sheet Report	 194
Total Amount of Check Payments

Operator Day Sheet Report	 194
Total Amount of Credit Card Payments

Operator Day Sheet Report	 194
Total Amount of Current Applied Payments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Current Suspended Payments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Insurance Payments

Insurance Carrier Production - Summary Report	
144
Operator Day Sheet Report	 194
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Insurance Carrier Production - Full Report	 142

Total Amount of Insurance Payments Received
Insurance Transaction Analysis Report	 154

Total Amount of Last Payments for Payment Agree-
ments

Collections Manager List	 70
Total Amount of Medicaid Payments

Operator Day Sheet Report	 194
Total Amount of MTD Applied Payments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of MTD Suspended Payments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Other Applied Insurance Payments

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Other Applied Payments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Patient Payments Received
Insurance Transaction Analysis Report	 154

Total Amount of Payment Agreement Payments Due
Payment Agreement Report	 234

Total Amount of Payment Agreement Payments Past 
Due

Payment Agreement Report	 234
Total Amount of Payment Agreement Payments Past 
Due

Payment Agreement Report	 234
Total Amount of Payment Type

Deposit Slip	 108
Daily Summary Report	 88

Total Amount of Payment Type for Clinic
Deposit Slip	 108

Total Amount of Payment Type for Operator
Deposit Slip	 108

Total Amount of Payments
Day Sheet (Receipts) Report	 98
Operator Day Sheet Report	 194
Payment Summary Report	 236
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Truth in Lending Disclosure Statement	 332
Daily Summary Report	 88

Total Amount of Payments for Clinic
Day Sheet (Receipts) Report	 98

Total Amount of Payments for Initial Provider
Day Sheet (Receipts) Report	 98

Total Amount of Payments for Payment Type
Day Sheet (Receipts) Report	 98

Total Amount of Payments for Provider
Day Sheet (Receipts) Report	 98

Total Amount of Suspended Insurance Payments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Suspended Payments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Suspended Payments for Previous 
Month

Day Sheet (Charges and Receipts) Report	 94

Payment (continued)



534   Index by Report Item

Dentrix Enterprise 11.0.2 Reports Reference

Total Amount of Transacations
Credit Card Transaction Report	 80

Total Amount of YTD Applied Payments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Insurance Payments for Family
Family Ledger Report (Single Family)	 126
Family Ledger Report	 124

Total Amount of YTD Payments for Family
Family Ledger Report (Single Family)	 126
Family Ledger Report	 124

Total Amount of YTD Suspended Payments
Day Sheet (Charges and Receipts) Report	 94

Total Number of Insurance Payments Received
Insurance Transaction Analysis Report	 154

Total Number of Missed Payments for Payment Agree-
ments

Collections Manager List	 70
Total Number of Patient Payments Received

Insurance Transaction Analysis Report	 154
Total Number of Payments

Truth in Lending Disclosure Statement	 332
Total Number of Transactions

Credit Card Transaction Report	 80
Total Other Retroactive Payment Amount Collected for 
Financial Class Type

UDS - Patient Related Revenue Report	 348
Total Other Retroactive Payment Amount Collected for 
Patient

UDS - Patient Related Revenue Report	 348
Total Other Retroactive Payment Amount Collected for 
Payer Category

UDS - Patient Related Revenue Report	 348
Total Payments

Patient Revenue List by Payer Report	 224
Total Quantity of Payments

Payment Summary Report	 236
Day Sheet (Receipts) Report	 98

Payment Agreement
Amount Due for Payment Agreement

Collections Manager List	 70
Amount of Payment Agreements

Practice Analysis Report	 252
Date of Last Payment Agreement Payment

Letter Merge Reports	 158
Grace Period

Payment Agreement Report	 234
Last Payment Agreement Note

Payment Agreement Report	 234
Last Payment Agreement Payment Amount

Patient Route Slip	 226
Last Payment Agreement Payment Date

Patient Route Slip	 226
Last Payment Amount for Payment Agreement

Collections Manager List	 70
Last Payment Date for Payment Agreement

Collections Manager List	 70
Next Payment Agreement Payment Due Amount

Patient Route Slip	 226
Next Payment Agreement Payment Due Date

Patient Route Slip	 226

Next Payment Plan Payment Amount
Letter Merge Reports	 158

Next Payment Plan Payment Date
Letter Merge Reports	 158

Number of Missed Payment Agreement Payments
Practice Analysis Report	 252

Number of Missed Payments for Payment Agreement
Collections Manager List	 70

Number of Payment Agreement Payments Remaining
Payment Agreement Report	 234

Payment Agreement Amount
Payment Agreement Report	 234

Payment Agreement Amount Past Due
Payment Agreement Report	 234

Payment Agreement Date
Truth in Lending Disclosure Statement	 332
Payment Agreement Report	 234

Payment Agreement Interval
Payment Agreement Report	 234

Payment Agreement Last Payment Amount
Payment Agreement Report	 234

Payment Agreement Last Payment Date
Payment Agreement Report	 234

Payment Agreement Next Payment Amount
Payment Agreement Report	 234

Payment Agreement Next Payment Date
Payment Agreement Report	 234

Payment Agreement Payment Amount
Payment Agreement Amortization Schedule	 232

Payment Agreement Payment Due Date
Payment Agreement Amortization Schedule	 232

Payment Agreement Payment Number
Payment Agreement Amortization Schedule	 232

Payment Agreement Payment Portion Applied to Inter-
est

Payment Agreement Amortization Schedule	 232
Payment Agreement Payment Portion Applied to Prin-
ciple

Payment Agreement Amortization Schedule	 232
Payment Agreement Remaining Balance

Payment Agreement Report	 234
Payment Agreement Report	 234
Payment Agreement Amortization Schedule	 232

Payment Agreement Total Number of Payments
Payment Agreement Report	 234

Payment Due Date
Coupon Book - Payment Agreements	 79
Coupon Book - Future Due Payments	 78

Payment Plan Remaining Balance
Letter Merge Reports	 158

Payment Plan Total Amount
Letter Merge Reports	 158

Remaining Payment Agreement Amount
Collections Manager List	 70

Total Amount Due for Payment Agreements
Collections Manager List	 70

Total Amount of Balances Remaining for Payment 
Agreements

Payment Agreement Report	 234
Total Amount of Last Payments for Payment Agree-
ments

Collections Manager List	 70

Payment (continued)
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Total Amount of Payment Agreement Payments Due
Payment Agreement Report	 234

Total Amount of Payment Agreement Payments Past 
Due

Payment Agreement Report	 234
Total Amount of Payment Agreements

Payment Agreement Report	 234
Total Amount of Remaining Payment Agreements

Collections Manager List	 70
Total Number of Missed Payments for Payment Agree-
ments

Collections Manager List	 70
Total Number of Payment Agreements

Payment Agreement Report	 234
Payment Agreement Note

Payment Plan Note
Patient Notes Report	 216

Payment Status
Payment Status

Credit Card Transaction Report	 80
Payment Type

Amount of Payment Type
Payment Summary Report	 236

Average Amount of Payment Type
Payment Summary Report	 236

Average Payment Amount for Payment Type
Day Sheet (Receipts) Report	 98

Payment Amount for Payment Type
Day Sheet (Receipts) Report	 98

Payment Type
Daily Summary Report	 88
Day Sheet (Receipts) Report	 98
Deposit Slip	 108
Credit Card Transaction Report	 80

Payment Type Description
Payment Summary Report	 236

Payment Types
Custom Practice Information Report	 82

Percent of Payment Types
Payment Summary Report	 236

Quantity of Payment Type
Payment Summary Report	 236

Quantity of Payments for Payment Type
Day Sheet (Receipts) Report	 98

Total Amount of Payment Type
Deposit Slip	 108
Daily Summary Report	 88

Total Amount of Payment Type for Clinic
Deposit Slip	 108

Total Amount of Payment Type for Operator
Deposit Slip	 108

Total Amount of Payments for Payment Type
Day Sheet (Receipts) Report	 98

Total Number of Payment Type Items
Deposit Slip	 108

Total Number of Payment Type Items for Clinic
Deposit Slip	 108

Total Number of Payment Type Items for Operator
Deposit Slip	 108

Payor
Payer Category

UDS - Patient Related Revenue Report	 348
Payer Name

Procedures by Contracted Amount Report	 268
Patient Revenue List by Payer Report	 224

Subtotal of Allowances for Payer Category
UDS - Patient Related Revenue Report	 348

Subtotal of Amount Collected for Payer Category
UDS - Patient Related Revenue Report	 348

Subtotal of Bad Debt Write-offs for Payer Category
UDS - Patient Related Revenue Report	 348

Subtotal of Charges for Payer Category
UDS - Patient Related Revenue Report	 348

Subtotal of Other Retroactive Payment Amount Col-
lected for Payer Category

UDS - Patient Related Revenue Report	 348
Subtotal of Penalty or Payback Amount Collected for 
Payer Category

UDS - Patient Related Revenue Report	 348
Subtotal of Sliding Discounts for Payer Category

UDS - Patient Related Revenue Report	 348
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Payer Category (Current Year)

UDS - Patient Related Revenue Report	 348
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Payer Category (Previous Years)

UDS - Patient Related Revenue Report	 348
Total Amount Collected for Payer Category

UDS - Patient Related Revenue Report	 348
Total Amount of Allowances for Payer Category

UDS - Patient Related Revenue Report	 348
Total Amount of Bad Debt Write-offs for Payer Category

UDS - Patient Related Revenue Report	 348
Total Amount of Charges for Payer Category

UDS - Patient Related Revenue Report	 348
Total Amount of Sliding Discounts for Payer Category

UDS - Patient Related Revenue Report	 348
Total Other Retroactive Payment Amount Collected for 
Payer Category

UDS - Patient Related Revenue Report	 348
Total Penalty or Payback Amount Collected for Payer 
Category

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Payer Category (Current Year)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Payer Category (Previous Years)

UDS - Patient Related Revenue Report	 348
Payor ID

Insurance Carrier Payor ID
Provider IDs List	 284

Payor ID
Insurance Carrier List	 138

Penalty
Penalty or Payback Amount Collected for Patient

UDS - Patient Related Revenue Report	 348
Subtotal of Penalty or Payback Amount Collected for 
Financial Class Type

UDS - Patient Related Revenue Report	 348

Payment Agreement (continued)
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Subtotal of Penalty or Payback Amount Collected for 
Payer Category

UDS - Patient Related Revenue Report	 348
Total Penalty or Payback Amount Collected for Financial 
Class Type

UDS - Patient Related Revenue Report	 348
Total Penalty or Payback Amount Collected for Patient

UDS - Patient Related Revenue Report	 348
Total Penalty or Payback Amount Collected for Payer 
Category

UDS - Patient Related Revenue Report	 348
Pending

Amount of Pending Estimated Primary Insurance Por-
tions YTD for Family

Treatment Case Report	 326
Amount of Pending Estimated Primary Insurance Por-
tions YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Pending Estimated Secondary Insurance 
Portions YTD for Family

Treatment Case Report	 326
Amount of Pending Estimated Secondary Insurance 
Portions YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Pending Claim
Pending Claims

Patient Route Slip	 226
Percent

Coverage Percent
Standard Coverage Tables Report	 322
Insurance Coverage Tables Report	 150

Finance Charge Percent
Payment Agreement Report	 234

Insurance Coverage Percent (Basic) for Primary Insur-
ance

Patient Route Slip	 226
Insurance Coverage Percent (Basic) for Secondary Insur-
ance

Patient Route Slip	 226
Insurance Coverage Percent (Major) for Primary Insur-
ance

Patient Route Slip	 226
Insurance Coverage Percent (Major) for Secondary 
Insurance

Patient Route Slip	 226
Insurance Coverage Percent (Orthodontics) for Primary 
Insurance

Patient Route Slip	 226
Insurance Coverage Percent (Orthodontics) for Second-
ary Insurance

Patient Route Slip	 226
Insurance Coverage Percent (Preventative) for Primary 
Insurance

Patient Route Slip	 226
Insurance Coverage Percent (Preventative) for Second-
ary Insurance

Patient Route Slip	 226

Late Charge Percent or Amount
Truth in Lending Disclosure Statement	 332

Percent Broken Appointments
Appointment Statistics Report	 20

Percent Collected
Provider A/R Totals - Daily Report	 276

Percent Collected for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Percent for Provider
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Percent Late Appointments
Appointment Statistics Report	 20

Percent of Accepted Cases
Practice Treatment Case Report	 258

Percent of Active Patient Guarantors
Practice Statistics Report	 256

Percent of Active Patients
Practice Statistics Report	 256

Percent of Adjustment Type in Adjustment Type Cat-
egory

Adjustment Summary Report	 4
Percent of Amount Aged 0 - 30

Aging/Credit Balance Report	 6
Percent of Amount Aged 121 - 150

Aging/Credit Balance Report	 6
Percent of Amount Aged 151 - 180

Aging/Credit Balance Report	 6
Percent of Amount Aged 31 - 60

Aging/Credit Balance Report	 6
Percent of Amount Aged 61 - 90

Aging/Credit Balance Report	 6
Percent of Amount Aged 90 - 120

Aging/Credit Balance Report	 6
Percent of Amount Aged Over 180

Aging/Credit Balance Report	 6
Percent of Appointments in Appointment Status for or 
Longer than Length of Time

Appointment Statistics Report	 20
Percent of Caries Free Patients

Caries Prevalence and Periodontal Index Report	
52

Percent of Completed Cases
Practice Treatment Case Report	 258

Percent of Divorced Patients
Practice Statistics Report	 256

Percent of Document Errors
Document Center Audit Documents Report	 114

Percent of Documents Audited
Document Center Audit Documents Report	 114

Percent of Female Patients
Practice Statistics Report	 256

Percent of Guarantor Portions
Aging/Credit Balance Report	 6

Percent of Insurance Estimate Amounts
Aging/Credit Balance Report	 6

Percent of Male Patients
Practice Statistics Report	 256

Percent of Married Patients
Practice Statistics Report	 256

Penalty (continued)
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Percent of Medicaid Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Non-Medicaid Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Non-Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Non-Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Non-patient Guarantors
Practice Statistics Report	 256

Percent of Other Patients
Practice Statistics Report	 256

Percent of Patient Non-guarantors
Practice Statistics Report	 256

Percent of Patients 0 - 2 Years
Practice Statistics Report	 256

Percent of Patients 11 - 12 Years
Practice Statistics Report	 256

Percent of Patients 13 - 14 Years
Practice Statistics Report	 256

Percent of Patients 15 - 16 Years
Practice Statistics Report	 256

Percent of Patients 17 - 20 Years
Practice Statistics Report	 256

Percent of Patients 21 - 30 Years
Practice Statistics Report	 256

Percent of Patients 3 - 4 Years
Practice Statistics Report	 256

Percent of Patients 31 - 40 Years
Practice Statistics Report	 256

Percent of Patients 41 - 50 Years
Practice Statistics Report	 256

Percent of Patients 5 - 6 Years
Practice Statistics Report	 256

Percent of Patients 51 - 60 Years
Practice Statistics Report	 256

Percent of Patients 61 - 70 Years
Practice Statistics Report	 256

Percent of Patients 7 - 8 Years
Practice Statistics Report	 256

Percent of Patients 71 - 80 Years
Practice Statistics Report	 256

Percent of Patients 81+ Years
Practice Statistics Report	 256

Percent of Patients 9 - 10 Years
Practice Statistics Report	 256

Percent of Patients Due for Prophy (Month and Year)
Practice Statistics Report	 256

Percent of Patients Eligible for Prophy Continuing Care
Practice Statistics Report	 256

Percent of Patients for Provider
Practice Statistics Report	 256

Percent of Patients in ZIP Code
Practice Statistics Report	 256

Percent of Patients not on Prophy Continuing Care
Practice Statistics Report	 256

Percent of Patients with Caries History
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Dental and Medical Insurance
Practice Statistics Report	 256

Percent of Patients with Dental Fluorosis
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with dmfs > 0
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Highest CPITN
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with History of Decay
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Loss of Attachment < 3 mm
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Loss of Attachment >= 3 & < 5 
mm

Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Loss of Attachment >= 5 mm
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Perio Pockets < 4 mm
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Perio Pockets >= 4 & 6 mm
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Perio Pockets >= 6 mm
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Primary Dental Insurance Only
Practice Statistics Report	 256

Percent of Patients with Primary Medical Insurance
Practice Statistics Report	 256

Percent of Patients with Sealants
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Secondary Dental Insurance
Practice Statistics Report	 256

Percent of Patients with Untreated Decay
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Using Tobacco
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients without a Birth Date Entered
Practice Statistics Report	 256

Percent of Patients without a ZIP Code
Practice Statistics Report	 256

Percent (continued)
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Percent of Patients without Dental and Medical Insur-
ance

Practice Statistics Report	 256
Percent of Patients without Dental Insurance

Practice Statistics Report	 256
Percent of Patients without Medical Insurance

Practice Statistics Report	 256
Percent of Payment Types

Payment Summary Report	 236
Percent of Pre-authorized Cases

Practice Treatment Case Report	 258
Percent of Procedures

RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Production from Referral Source
Referral Analysis Report	 294

Percent of Production from Referral Sources
Referral Analysis Report	 294

Percent of Receivables
Practice Analysis Report	 252

Percent of Referred Cases
Practice Treatment Case Report	 258

Percent of Referred New Patients (in Month and Year)
Practice Statistics Report	 256

Percent of Scheduled Cases
Practice Treatment Case Report	 258

Percent of Separated Patients
Practice Statistics Report	 256

Percent of Single Patients
Practice Statistics Report	 256

Percent of Suspended Credits
Aging/Credit Balance Report	 6

Percent of Widowed Patients
Practice Statistics Report	 256

Percent or Child Patients
Practice Statistics Report	 256

Total Percent for All Clinics
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Total Percent for Clinic
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Total Percent of Document Errors
Document Center Audit Documents Report	 114

Total Percent of Documents Audited
Document Center Audit Documents Report	 114

Perio
Perio Exam Graphic Chart

Perio - Combined Graphic & Data Chart Report	
238

Perio Graphic Chart
Perio - Graphic Chart Report	 244

Perio Exam
Perio Exam Comparison Data Chart

Perio - Combined Graphic & Data Chart Report	
238

Perio Exam Comparison Graphic Chart
Perio - Combined Graphic & Data Chart Report	
238

Perio Exam Date
Perio - Combined Graphic & Data Chart Report	
238
Perio - Data Chart Report	 240
Perio - Exam Comparison Report	 242
Perio - Pocket Depths Only Report	 246
Perio Exam List	 248
Patient Notes Report	 216

Perio Exam Note
Patient Notes Report	 216

Perio Exam Provider Name
Perio - Data Chart Report	 240
Perio - Pocket Depths Only Report	 246
Perio - Combined Graphic & Data Chart Report	
238

Perio Measurement
Bleeding

Perio - Data Chart Report	 240
Perio - Combined Graphic & Data Chart Report	
238

Bone Loss
Perio - Data Chart Report	 240
Perio - Combined Graphic & Data Chart Report	
238

Clinical Attachment Level
Perio - Data Chart Report	 240
Perio - Combined Graphic & Data Chart Report	
238

Clinical Attachment Level (Facial)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Clinical Attachment Level (Lingual)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Clinical Attachment Level Graphic Chart
Perio - Exam Comparison Report	 242

Furcation Grade
Perio - Data Chart Report	 240
Perio - Combined Graphic & Data Chart Report	
238

Furcation Involvement (Facial)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Furcation Involvement (Lingual)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Gingival Margin
Perio - Data Chart Report	 240
Perio - Combined Graphic & Data Chart Report	
238

Percent (continued)
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Gingival Margin (Facial)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Gingival Margin (Lingual)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Gingival Margin Graphic Chart
Perio - Exam Comparison Report	 242

Mobility
Perio - Data Chart Report	 240
Perio - Combined Graphic & Data Chart Report	
238

Mobility (Facial)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Mobility (Lingual)
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Mucogingival Junction
Perio - Data Chart Report	 240
Perio - Combined Graphic & Data Chart Report	
238

Perio Measurement Change
Perio - Exam Comparison Report	 242
Perio - Combined Graphic & Data Chart Report	
238

Probing Depth (Facial)
Perio - Data Chart Report	 240
Perio - Exam Comparison Report	 242
Perio - Pocket Depths Only Report	 246
Perio - Combined Graphic & Data Chart Report	
238

Probing Depth (Lingual)
Perio - Data Chart Report	 240
Perio - Exam Comparison Report	 242
Perio - Pocket Depths Only Report	 246
Perio - Combined Graphic & Data Chart Report	
238

Suppuration
Perio - Data Chart Report	 240
Perio - Combined Graphic & Data Chart Report	
238

Permanent
Permanent/Temporary

Multi-Code List	 188
Phone

Employer Phone Number
Letter Merge Reports	 158
Employers and Employed Patients Report	 122

Guarantor Home Phone Number
Collections Manager List	 70
Collections Manager List	 70
Future Due Payment Plan Report - Standard	 134
Patient Route Slip	 226
Payment Agreement Report	 234
Truth in Lending Disclosure Statement	 332

Aging/Credit Balance Report	 6
Insurance Carrier Phone Number

Insurance Claim Aging Report	 146
Insurance Eligibility Report	 152
Pre-Treatment Estimate Aging Report	 262
Provider IDs List	 284
RVU Utilization Report	 316
Utilization Report	 366
Insurance Carrier List	 138

Patient Home Phone Number
As Soon As Possible List	 22
Clinical Notes Report	 64
Continuing Care Display List	 76
Daily Appointment List (DX1)	 84
Daily Appointment List Report	 86
Day Sheet (Charges and Receipts) Report	 94
Day Sheet Report	 100
Letter Merge Reports	 158
Patient Ledger Report	 210
Patient List	 212
Patient List (Filtered)	 214
Patient Notes Report	 216
Patient Questionnaire	 222
Patient Route Slip	 226
Prescription Printout	 260
Referral Recap Report	 296
Referral Slip	 298
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Unscheduled Appointment List (DX1)	 356
Unscheduled Appointment List (OM)	 358
Unscheduled Treatment Plans (Condensed) Re-
port	 360
Unscheduled Treatment Plans (Detailed) Report	
362
Appointment Book View Printout	 14

Phone Number of Patient on Appointment
Letter Merge Reports	 158

Practice Phone Extension
Letter Merge Reports	 158

Practice Phone Number
Billing Statement	 48
Continuing Care Cards - No Appointment	 74
Continuing Care Cards - with Appointment	 75
Coupon Book - Future Due Payments	 78
Coupon Book - Payment Agreements	 79
Letter Merge Reports	 158
Patient Treatment Case Report	 228
Perio - Combined Graphic & Data Chart Report	
238
Perio - Exam Comparison Report	 242
Perio - Graphic Chart Report	 244
Practice Organization List	 254
Prescription Printout	 260
Provider IDs List	 284
Registration Information Report	 306
Truth in Lending Disclosure Statement	 332
Walkout - Family Walkout	 370
Appointment Reminder Cards	 18

Provider Office Phone Number
Provider IDs List	 284

Perio Measurement (continued)
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Provider Phone Number
Patient Chart Printout	 204
Referral Recap Report	 296
Referral Slip	 298
Walkout - Doctor’s Statement	 368
Patient Chart and Progress Notes Printout	 202

Referral Phone Number
Referral Slip	 298
Referral Recap Report	 296

Referred by Doctor/Other Phone Number
Referred By Doctor/Other Report	 300

Referred by Source Phone Number
Letter Merge Reports	 158

Referred to Doctor Phone Number
Referred To Doctor Report	 304

Referred to Phone Number
Letter Merge Reports	 158

Referring Patient Home Phone Number
Referred By Patient Report	 302

Spouse Home Phone Number
Patient Questionnaire	 222

Physical Activity Counseling
Number of Patients 3 - 17 Years who Received Physical 
Activity Counseling

Clinical Quality Measures List	 66
Place of Service Code

Place of Service Code
Medical Code List	 186

Place of Service Code Description
Medical Code List	 186

Plaque
Plaque

Perio - Data Chart Report	 240
Perio - Combined Graphic & Data Chart Report	
238

Pocket Depth
Percent of Patients with Perio Pockets < 4 mm

Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Perio Pockets >= 4 & 6 mm
Caries Prevalence and Periodontal Index Report	
52

Percent of Patients with Perio Pockets >= 6 mm
Caries Prevalence and Periodontal Index Report	
52

Poor Scan
Number of Poor Scan Errors

Document Center Audit Documents Report	 114
Total Number of Poor Scan Errors

Document Center Audit Documents Report	 114
Portion

Account Estimated Insurance Portion
Patient Route Slip	 226

Amount of Dental Insurance Portion
Patient Chart Printout	 204

Amount of Estimated Insurance Portion
Insurance Claim Aging Report	 146

Amount of Office Portion
Patient Treatment Case Report	 228

Amount of Office Portion for Case
Patient Treatment Case Report	 228

Amount of Office Portion for Visit
Patient Treatment Case Report	 228

Amount of Patient Portion
Patient Treatment Case Report	 228
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Chart Printout	 204

Amount of Patient Portion for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Amount of Patient Portion for Visit
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Pending Estimated Primary Insurance Por-
tions YTD for Family

Treatment Case Report	 326
Amount of Pending Estimated Primary Insurance Por-
tions YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Primary Insurance Portion
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Primary Insurance Portion for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Amount of Primary Insurance Portion for Visit
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Secondary Insurance Portion
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Secondary Insurance Portion for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Amount of Secondary Insurance Portion for Visit
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Co-pay Calculation for Insurance Portion
Insurance Coverage Tables Report	 150

Estimated Amount of Patient’s Portion
Patient Treatment Case Report	 228
Treatment Case Report	 326
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Estimated Guarantor Portion
Patient Route Slip	 226

Estimated Insurance Portion
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220
Dental Encounters Report	 106

Estimated Patient Portion
Patient Route Slip	 226

Guarantor Estimate Amount
Collections Manager List	 70

Phone (continued)
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Guarantor Portions
Aging/Credit Balance Report	 6

Patient Estimated Insurance Portion
Patient Route Slip	 226

Payment Agreement Payment Portion Applied to Inter-
est

Payment Agreement Amortization Schedule	 232
Payment Agreement Payment Portion Applied to Prin-
ciple

Payment Agreement Amortization Schedule	 232
Percent of Guarantor Portions

Aging/Credit Balance Report	 6
Total Amount of Dental Insurance Portions

Patient Chart Printout	 204
Total Amount of Estimated Insurance Portion for Pri-
mary and Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Estimated Insurance Portion for Pri-
mary Claims

Insurance Claim Aging Report	 146
Total Amount of Estimated Insurance Portion for Sec-
ondary Claims

Insurance Claim Aging Report	 146
Total Amount of Guarantor Estimates

Collections Manager List	 70
Total Amount of Guarantor Portions

Aging/Credit Balance Report	 6
Total Amount of Patient Portion for Case

Treatment Case Report	 326
Total Amount of Patient Portions

Patient Chart Printout	 204
Total Amount of Primary Insurance Portion for Case

Treatment Case Report	 326
Total Amount of Secondary Insurance Portion for Case

Treatment Case Report	 326
Total Estimated Amount of Patient’s Portion

Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Total Estimated Insurance Portion
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Poverty Level
Patient Poverty Level

Patient List (Filtered)	 214
Poverty Level

UDS - Patient Status Report	 350
Practice

Blue Cross/Blue Shield Number
Practice Organization List	 254

Practice
Audit Report - Clinics	 30

Practice Address
Billing Statement	 48
Continuing Care Cards - No Appointment	 74
Continuing Care Cards - with Appointment	 75
Coupon Book - Future Due Payments	 78
Coupon Book - Payment Agreements	 79
Patient Chart and Progress Notes Printout	 202
Patient Chart Printout	 204
Patient Treatment Case Report	 228

Perio - Combined Graphic & Data Chart Report	
238
Perio - Exam Comparison Report	 242
Perio - Graphic Chart Report	 244
Practice Organization List	 254
Prescription Printout	 260
Provider IDs List	 284
Referral Recap Report	 296
Referral Slip	 298
Truth in Lending Disclosure Statement	 332
Walkout - Family Walkout	 370
Appointment Reminder Cards	 18

Practice Change
Audit Report - Clinics	 30

Practice City
Registration Information Report	 306

Practice City State and ZIP Code
Letter Merge Reports	 158

Practice Country
Registration Information Report	 306

Practice Fiscal Year Month
Registration Information Report	 306

Practice Name
Billing Statement	 48
Continuing Care Cards - No Appointment	 74
Continuing Care Cards - with Appointment	 75
Coupon Book - Future Due Payments	 78
Coupon Book - Payment Agreements	 79
Letter Merge Reports	 158
Perio - Combined Graphic & Data Chart Report	
238
Prescription Printout	 260
Truth in Lending Disclosure Statement	 332
Walkout - Family Walkout	 370
Appointment Reminder Cards	 18

Practice Phone Extension
Letter Merge Reports	 158

Practice Phone Number
Billing Statement	 48
Continuing Care Cards - No Appointment	 74
Continuing Care Cards - with Appointment	 75
Coupon Book - Future Due Payments	 78
Coupon Book - Payment Agreements	 79
Letter Merge Reports	 158
Patient Treatment Case Report	 228
Perio - Combined Graphic & Data Chart Report	
238
Perio - Exam Comparison Report	 242
Perio - Graphic Chart Report	 244
Practice Organization List	 254
Prescription Printout	 260
Provider IDs List	 284
Registration Information Report	 306
Truth in Lending Disclosure Statement	 332
Walkout - Family Walkout	 370
Appointment Reminder Cards	 18

Practice Signature
Treatment Case Report	 326

Practice State
Registration Information Report	 306

Portion (continued)
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Practice Street Address
Registration Information Report	 306
Letter Merge Reports	 158

Practice Title
Registration Information Report	 306
Audit Report - Clinics	 30

Practice Title Change
Audit Report - Clinics	 30

Practice ZIP Code
Registration Information Report	 306

Pre-Authorization
Percent of Pre-authorized Cases

Practice Treatment Case Report	 258
Pre-authorization Required

Standard Coverage Tables Report	 322
Insurance Coverage Tables Report	 150

Pre-Treatment Estimate
Pre-treatment Estimate Amount

Patient Route Slip	 226
Pre-Treatment Estimate Aging Report	 262
Pre-Treatment Estimates Not Sent Report	 264
Secondary Pre-Treatment Estimates Not Created 
Report	 320
Insurance Transaction Analysis Report	 154

Pre-treatment Estimate Date
Pre-Treatment Estimates Not Sent Report	 264

Pre-treatment Estimate Expiration Date
Secondary Pre-Treatment Estimates Not Created 
Report	 320
Pre-Treatment Estimates Not Sent Report	 264

Pre-treatment Estimate On Hold Date
Pre-Treatment Estimate Aging Report	 262

Pre-treatment Estimate Re-sent Date
Pre-Treatment Estimate Aging Report	 262

Pre-treatment Estimate Sent Date
Pre-Treatment Estimate Aging Report	 262

Pre-treatment Estimate Tracer Date
Pre-Treatment Estimate Aging Report	 262

Primary Pre-treatment Estimate Date
Secondary Pre-Treatment Estimates Not Created 
Report	 320

Primary Pre-treatment Estimate Sent Date
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Secondary Pre-treatment Estimate Sent Date
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Total Amount for Primary Pre-treatment Estimates
Pre-Treatment Estimate Aging Report	 262

Total Amount for Secondary Pre-treatment Estimates
Pre-Treatment Estimate Aging Report	 262

Total Amount of Account Balances Aged 1 - 30 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 1 - 30 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 1 - 30 for Sec-
ondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262

Total Amount of Account Balances Aged 121 - 150 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 181+ for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 181+ for Pri-
mary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Pre-Treatment Estimate Aging Report	 262

Total Amount of Account Balances Aged 181+ for Sec-
ondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 for Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 for 
Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances with Pre-treatment 
Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances with Primary Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
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Total Amount of Account Balances with Secondary Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Pre-treatment Estimates not Sent

Pre-Treatment Estimates Not Sent Report	 264
Total Amount of Primary Pre-treatment Estimates not 
Sent

Pre-Treatment Estimates Not Sent Report	 264
Total Amount of Secondary Pre-treatment Estimates not 
Created

Secondary Pre-Treatment Estimates Not Created 
Report	 320

Total Amount of Secondary Pre-treatment Estimates not 
Sent

Pre-Treatment Estimates Not Sent Report	 264
Preferred Contact Method

Patient Preferred Contact Method
Patient List (Filtered)	 214

Preferred Name
Patient’s Preferred Name

Letter Merge Reports	 158
Appointment Book View Printout	 14

Prescription
Dispense as Written

Prescription Printout	 260
Generic Substitution Permitted

Prescription Printout	 260
Number of Electronic Prescriptions

Meaningful Use Measure Calculation List	 162
Number of Patients with Electronic Prescriptions

Meaningful Use Measure Calculation List	 162
Number of Prescriptions

Meaningful Use Measure Calculation List	 162
Number of Prescriptions Ordered

Meaningful Use Measure Calculation List	 162
Number of Prescriptions Ordered Using CPOE (Com-
puterized Provider Order Entry)

Meaningful Use Measure Calculation List	 162
Prescribed Medication

Prescription Printout	 260
Prescription Date

Prescription Printout	 260
Patient List (Filtered)	 214

Prescription Details
Prescription Printout	 260

Prescription Note
Prescription Printout	 260

Preventative
Amount of Preventative Deductible Owed by Family to 
Primary Insurance

Patient Route Slip	 226
Amount of Preventative Deductible Owed by Family to 
Secondary Insurance

Patient Route Slip	 226
Amount of Preventative Deductible Owed to Primary 
Insurance

Patient Route Slip	 226

Amount of Preventative Deductible Owed to Secondary 
Insurance

Patient Route Slip	 226
Insurance Coverage Percent (Preventative) for Primary 
Insurance

Patient Route Slip	 226
Insurance Coverage Percent (Preventative) for Second-
ary Insurance

Patient Route Slip	 226
Lifetime/Individual/Standard Preventative Deductible

Insurance Carrier List	 138
Preventative Deductible Met

Insurance Carrier List	 138
Preventative Deductible Owed by Family to Primary Ins

Treatment Case Report	 326
Preventative Deductible Owed by Family to Secondary 
Ins

Treatment Case Report	 326
Preventative Deductible Owed by Patient to Primary Ins

Treatment Case Report	 326
Patient Treatment Case Report	 228

Preventative Deductible Owed by Patient to Secondary 
Ins

Treatment Case Report	 326
Patient Treatment Case Report	 228

Previous Balance
Previous Balance

Day Sheet Report	 100
Day Sheet (Charges and Receipts) Report	 94

Previous Balance for Clinic
Day Sheet Report	 100

Previous Balance for Provider
Day Sheet Report	 100
Day Sheet (Charges and Receipts) Report	 94

Previous Year
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Financial Class Type (Previous Years)

UDS - Patient Related Revenue Report	 348
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Payer Category (Previous Years)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Financial Class Type (Previous Years)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Patient (Previous Years)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Payer Category (Previous Years)

UDS - Patient Related Revenue Report	 348
Wrap Around or Reconciliation Amount Collected for 
Patient (Previous Years)

UDS - Patient Related Revenue Report	 348
Primary

Amount of Annual Primary Insurance Plan Benefits for 
Family

Treatment Case Report	 326
Amount of Annual Primary Insurance Plan Benefits for 
Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Pre-Treatment Estimate (continued)
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Amount of Estimated Primary Insurance Benefits Re-
maining YTD for Family

Treatment Case Report	 326
Amount of Estimated Primary Insurance Benefits Re-
maining YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Other Deductible Owed by Family to Pri-
mary Insurance

Patient Route Slip	 226
Amount of Other Deductible Owed to Primary Insur-
ance

Patient Route Slip	 226
Amount of Pending Estimated Primary Insurance Por-
tions YTD for Family

Treatment Case Report	 326
Amount of Pending Estimated Primary Insurance Por-
tions YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Preventative Deductible Owed by Family to 
Primary Insurance

Patient Route Slip	 226
Amount of Preventative Deductible Owed to Primary 
Insurance

Patient Route Slip	 226
Amount of Primary Insurance Benefits Remaining

Unscheduled Treatment Plans (Detailed) Report	
362
Patient Route Slip	 226

Amount of Primary Insurance Benefits Used
Patient Route Slip	 226

Amount of Primary Insurance Paid Benefits YTD for 
Family

Treatment Case Report	 326
Amount of Primary Insurance Paid Benefits YTD for 
Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Primary Insurance Portion
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Primary Insurance Portion for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Amount of Primary Insurance Portion for Visit
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Remaining Benefits for Primary Insurance
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Amount of Standard Deductible Owed by Family to 
Primary Insurance

Patient Route Slip	 226
Amount of Standard Deductible Owed to Primary Insur-
ance

Patient Route Slip	 226

Insurance Coverage Percent (Basic) for Primary Insur-
ance

Patient Route Slip	 226
Insurance Coverage Percent (Major) for Primary Insur-
ance

Patient Route Slip	 226
Insurance Coverage Percent (Orthodontics) for Primary 
Insurance

Patient Route Slip	 226
Insurance Coverage Percent (Preventative) for Primary 
Insurance

Patient Route Slip	 226
Insurance Plan Group Number for Primary Insurance

Patient Questionnaire	 222
Insurance Plan Name and Address for Primary Insurance

Patient Questionnaire	 222
Last Eligibility Date for Primary Insurance Coverage

Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Maximum Primary Insurance Benefit Amount
Patient Route Slip	 226

Number of Encounters for Primary Providers
UDS - Encounters by Provider Report	 340

Number of Patients with Primary Dental Insurance Only
Practice Statistics Report	 256

Number of Patients with Primary Medical Insurance
Practice Statistics Report	 256

Other Deductible Owed by Family to Primary Insurance
Treatment Case Report	 326

Other Deductible Owed by Patient to Primary Insurance
Treatment Case Report	 326
Patient Treatment Case Report	 228

Outstanding Primary Insurance Estimated Amount
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Patient Relationship to Subscriber for Primary Insurance
Patient Questionnaire	 222

Percent of Patients with Primary Dental Insurance Only
Practice Statistics Report	 256

Percent of Patients with Primary Medical Insurance
Practice Statistics Report	 256

Preventative Deductible Owed by Family to Primary Ins
Treatment Case Report	 326

Preventative Deductible Owed by Patient to Primary Ins
Treatment Case Report	 326
Patient Treatment Case Report	 228

Primary Claim Date
Secondary Insurance Claims Not Created Report	
318

Primary Dental Insurance Carrier Name
Patient List	 212

Primary Eligibility Date
Appointment Book View Printout	 14

Primary Insurance Benefits Expiration Date for Family
Treatment Case Report	 326

Primary Insurance Benefits Expiration Date for Patient
Treatment Case Report	 326
Patient Treatment Case Report	 228

Primary Insurance Benefits Remaining
Letter Merge Reports	 158

Primary Insurance Benefits Renewal Month
Patient Route Slip	 226
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Primary Insurance Carrier Name
Patient Route Slip	 226
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Unscheduled Treatment Plans (Detailed) Report	
362
Letter Merge Reports	 158

Primary Insurance Carrier Plan Employer
Patient Route Slip	 226

Primary Insurance Estimated Amount
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Primary Insurance Plan Group Number
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Patient Route Slip	 226

Primary Insurance Plan Renewal Month
Unscheduled Treatment Plans (Detailed) Report	
362

Primary Insurance Subscriber ID
Letter Merge Reports	 158

Primary Medical Insurance Carrier Name
Patient List	 212

Primary Pre-treatment Estimate Date
Secondary Pre-Treatment Estimates Not Created 
Report	 320

Primary Pre-treatment Estimate Sent Date
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Primary Production Amount
Insurance Carrier Production - Full Report	 142

Primary Production Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Primary Provider
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220
UDS - Insurance Financial Class Report (2013)	344
UDS - Medicaid/Medicare Report	 346
UDS - Sealant Statistics Report	 352
UDS - Tobacco Use and Intervention Report	 354
Patient List (Filtered)	 214

Primary Provider ID
Patient Route Slip	 226
Audit Report - Patients	 34

Primary Provider ID Change
Audit Report - Patients	 34

Standard Deductible Owed by Family to Primary Insur-
ance

Treatment Case Report	 326
Standard Deductible Owed by Patient to Primary Insur-
ance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Subscriber Address for Primary Insurance
Patient Questionnaire	 222

Subscriber Birth Date for Primary Insurance
Patient Questionnaire	 222

Subscriber ID for Primary Insurance
Patient Questionnaire	 222

Subscriber Name for Primary Insurance
Patient Route Slip	 226
Patient Questionnaire	 222

Subscriber’s Employer Address for Primary Insurance
Patient Questionnaire	 222

Subscriber’s Employer Name for Primary Insurance
Patient Questionnaire	 222

Total Amount for Primary Pre-treatment Estimates
Pre-Treatment Estimate Aging Report	 262

Total Amount of Account Balances Aged 1 - 30 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 1 - 30 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 121 - 150 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 121 - 150 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 151 - 180 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 181+ for Pri-
mary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Pre-Treatment Estimate Aging Report	 262

Total Amount of Account Balances Aged 181+ with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 31 - 60 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 61 - 90 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 91 - 120 for 
Primary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 with 
Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Primary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Primary Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Estimated Insurance Portion for Pri-
mary and Secondary Claims

Insurance Claim Aging Report	 146

Primary (continued)
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Total Amount of Estimated Insurance Portion for Pri-
mary Claims

Insurance Claim Aging Report	 146
Total Amount of Primary and Secondary Claims not Sent

Insurance Claims Not Sent Report	 148
Total Amount of Primary Claims not Sent

Insurance Claims Not Sent Report	 148
Total Amount of Primary Pre-treatment Estimates not 
Sent

Pre-Treatment Estimates Not Sent Report	 264
Total Amount of Primary Production

Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Principle
Payment Agreement Payment Portion Applied to Prin-
ciple

Payment Agreement Amortization Schedule	 232
Printed

Printed Patient Report
Audit Report - Combined	 32

Prior Balance
Prior Account Balance

Walkout - Family Walkout	 370
Prior Treatment

Continuing Care Prior Treatment Date
Continuing Care Display List	 76

Prior Work
Continuing Care Prior Work Date

Letter Merge Reports	 158
Priority

Case Priority
Patient Treatment Case Report	 228

Probing Depth
Probing Depth (Facial)

Perio - Data Chart Report	 240
Perio - Exam Comparison Report	 242
Perio - Pocket Depths Only Report	 246
Perio - Combined Graphic & Data Chart Report	
238

Probing Depth (Lingual)
Perio - Data Chart Report	 240
Perio - Exam Comparison Report	 242
Perio - Pocket Depths Only Report	 246
Perio - Combined Graphic & Data Chart Report	
238

Problem
Number of Patients with Problems or Attestations of No 
Known Problems

Meaningful Use Measure Calculation List	 162
Problem Description

Patient List (Filtered)	 214
Problem Discovery Date

Patient List (Filtered)	 214
Procedure

ADA Code Description for Treatment-planned Proce-
dure

Patient Chart Printout	 204

ADA Code Description of Treatment-planned Proce-
dure

Referral Slip	 298
ADA Code of Treatment-planned Procedure

Referral Slip	 298
Amount of Completed Procedures for Patient

Procedures Not Attached to Insurance Report	270
Amount of Lab Expenses for Medicaid Procedures for 
Clinic

RVU Production Summary Report	 310
Amount of Lab Expenses for Medicaid Procedures for 
Provider

RVU Production Summary Report	 310
Amount of Lab Expenses of Non-Medicaid Procedures 
for Clinic

RVU Production Summary Report	 310
Amount of Lab Expenses of Non-Medicaid Procedures 
for Provider

RVU Production Summary Report	 310
Amount of Lab Expenses of Procedures for Clinic

RVU Production Summary Report	 310
Amount of Lab Expenses of Procedures for Provider

RVU Production Summary Report	 310
Amount of Medicaid Procedures for Clinic

RVU Production Summary Report	 310
Production Summary Report	 272

Amount of Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Amount of Non-Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Amount of Non-Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Amount of Procedure
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Amount of Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Amount of Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Amount of Treatment-planned Procedure
Patient Chart Printout	 204

Average Amount of Medicaid Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Non-Medicaid Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Non-Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272
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Average Amount of Non-Medicaid Procedures for 
Provider

RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Date of Completed Procedure
Walkout - Doctor’s Statement	 368

Date of Treatment-planned Procedure
Referral Slip	 298

Deleted Procedure
Audit Report - Combined	 32

First Procedure
New Patient List	 190

Inserted Procedure
Audit Report - Combined	 32

Modified Procedure
Audit Report - Combined	 32

Net RVU for Medicaid Procedures
RVU Production Summary Report	 310

Net RVU of Medicaid Procedures for Clinic
RVU Production Summary Report	 310

Net RVU of Medicaid Procedures for Provider
RVU Production Summary Report	 310

Net RVU of Non-Medicaid Procedures
RVU Production Summary Report	 310

Net RVU of Non-Medicaid Procedures for Clinic
RVU Production Summary Report	 310

Net RVU of Non-Medicaid Procedures for Provider
RVU Production Summary Report	 310

Net RVU of Procedures
RVU Production Summary Report	 310

Net RVU of Procedures for Clinic
RVU Production Summary Report	 310

Net RVU of Procedures for Provider
RVU Production Summary Report	 310

Next Appointment Procedure Amount
Patient Route Slip	 226

Next Appointment Procedure Date
Patient Route Slip	 226

Number of Scheduled Treatment-planned Procedures
Practice Treatment Case Report	 258

Number of Unscheduled Treatment-planned Proce-
dures

Practice Treatment Case Report	 258
Percent of Medicaid Procedures

RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Non-Medicaid Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Non-Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Non-Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Procedure Amount
Patient List (Filtered)	 214
Procedures Not Attached to Insurance Report	270
Production Summary Report	 272
Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
RVU Production Summary Report	 310
Audit Report - Combined	 32

Procedure Date
Audit Report - Transactions	 38
Billing Statement	 48
Day Sheet (Adjustments) Report	 90
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Receipts) Report	 98
Day Sheet Report	 100
Operator Day Sheet Report	 194
Patient Chart and Progress Notes Printout	 202
Patient List (Filtered)	 214
Patient Treatment Case Report	 228
Practice Treatment Case Report	 258
Production Summary Report	 272
Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
RVU Day Sheet Report	 308
RVU Production Summary Report	 310
Suspended Credits Report	 324
Audit Report - Combined	 32

Procedure Date Change
Audit Report - Transactions	 38

Procedure Date for Date of Service
Letter Merge Reports	 158

Procedure Description
Day Sheet Report	 100
Audit Report - Combined	 32

Procedure Fee
Utilization Report	 366
RVU Utilization Report	 316

Procedure (continued)
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Procedure Note
Treatment Case Report	 326
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Patient Chart and Progress Notes Printout	 202

Procedure RVU
RVU Utilization Report	 316

Quantity of Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Quantity of Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Quantity of Non-Medicaid Procedures for Clinic
RVU Production Summary Report	 310
Production Summary Report	 272

Quantity of Non-Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Quantity of Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Replace Initial Zero of Procedure Code on Claims
Insurance Carrier List	 138

Time Units
Procedure Code List	 266
Multi-Code List	 188

Tooth Number for Treatment-planned Procedure
Patient Chart Printout	 204

Tooth Number of Treatment-Planned Procedure
Referral Slip	 298

Tooth Surface of Treatment-planned Procedure
Referral Slip	 298

Total Amount of Completed Procedures
Walkout - Doctor’s Statement	 368
Procedures Not Attached to Insurance Report	270

Total Amount of Lab Expenses of Medicaid Procedures
RVU Production Summary Report	 310

Total Amount of Lab Expenses of Non-Medicaid Proce-
dures

RVU Production Summary Report	 310
Total Amount of Lab Expenses of Procedures

RVU Production Summary Report	 310
Total Amount of Medicaid Procedures

RVU Production Summary Report	 310
Production Summary Report	 272

Total Amount of Non-Medicaid Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Total Amount of Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Total Amount of Treatment-planned Procedures
Practice Treatment Case Report	 258
Patient Chart Printout	 204

Total Quantity of Medicaid Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Total Quantity of Non-Medicaid Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Total Quantity of Procedures
RVU Production Summary Report	 310
Production Summary Report	 272

Treatment-planned Procedure Amount
Unscheduled Treatment Plans (Detailed) Report	
362

Treatment-planned Procedure Date
Unscheduled Treatment Plans (Detailed) Report	
362
Treatment Case Report	 326

Procedure Code Category
Procedure Code Category

Standard Coverage Tables Report	 322
Insurance Coverage Tables Report	 150

Production
Amount of - Adjustments (Production)

Provider A/R Totals - Daily Report	 276
Amount of - Adjustments (Production) for Provider

Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of + Adjustments (Production)
Provider A/R Totals - Daily Report	 276

Amount of + Adjustments (Production) for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of Debit Initial Balances (Production)
Provider A/R Totals - Daily Report	 276

Amount of Debit Initial Balances (Production) for Prov
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Appointment Production Amount
Appointment Book View Printout	 14

Appointment Production Type
Audit Report - Appointments	 26
Multi-Code List	 188
Procedure Code List	 266
Appointment Book View Printout	 14

Appointment Production Type Change
Audit Report - Appointments	 26

Average Production per Patient
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Production per Patient at Clinic from Referral 
Source

Referral Analysis Report	 294
Average Production per Patient for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Production per Patient for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Production Per Patient from Referral Source
Referral Analysis Report	 294

Average Production Per Patient from Referral Sources
Referral Analysis Report	 294
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Average Production per Patient MTD
Day Sheet (Charges and Receipts) Report	 94

Average Production per Patient MTD for Provider
Day Sheet (Charges and Receipts) Report	 94

Current Average Production per Patient
Day Sheet (Charges and Receipts) Report	 94

Current Average Production per Patient for Provider
Day Sheet (Charges and Receipts) Report	 94

Next Appointment Production Amount
Patient Route Slip	 226

Percent of Production from Referral Source
Referral Analysis Report	 294

Percent of Production from Referral Sources
Referral Analysis Report	 294

Primary Production Amount
Insurance Carrier Production - Full Report	 142

Primary Production Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Production
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Production Adjustments
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Production Amount
Referred By Doctor/Other Report	 300
Referred By Patient Report	 302
Provider A/R Totals - Daily Report	 276

Production Amount for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Production at Clinic from Referral Source
Referral Analysis Report	 294

Production from Referral Source
Referral Analysis Report	 294

Secondary Production Amount
Insurance Carrier Production - Full Report	 142

Secondary Production Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Total Amount of - Adjustments (Production)
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Amount of + Adjustments (Production)
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Amount of Debit Initial Balances (Production)
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Amount of Primary Production
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Total Amount of Secondary Production
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Total Average Production per Patient
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Average Production per Patient at Clinics from 
Referral Source

Referral Analysis Report	 294
Total Production Amount

Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Total Production at Clinics from Referral Source
Referral Analysis Report	 294

Total Production from Referral Sources
Referral Analysis Report	 294

Production Type
Appointment Production Type

Audit Report - Appointments	 26
Multi-Code List	 188
Procedure Code List	 266
Appointment Book View Printout	 14

Appointment Production Type Change
Audit Report - Appointments	 26

Projected
Projected Amount of Remaining Benefits

Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Projected Amount of Remaining Benefits for Secondary 
Insurance

Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Prophy
Number of Patients Eligible for Prophy Continuing Care

Practice Statistics Report	 256
Number of Patients not on Prophy Continuing Care

Practice Statistics Report	 256
Percent of Patients Due for Prophy (Month and Year)

Practice Statistics Report	 256
Percent of Patients Eligible for Prophy Continuing Care

Practice Statistics Report	 256
Percent of Patients not on Prophy Continuing Care

Practice Statistics Report	 256
Prophylaxis

Last Prophylaxis
Patient Route Slip	 226

Last Prophylaxis Date
Patient Route Slip	 226

Number of Patients Due for Prophy (on Month and Year)
Practice Statistics Report	 256

Number of Patients Eligible for Prophy Continuing Care
Practice Statistics Report	 256

Number of Patients not on Prophy Continuing Care
Practice Statistics Report	 256

Percent of Patients Due for Prophy (Month and Year)
Practice Statistics Report	 256

Provider
20+ Years Old for Financial Class Type for Provider

UDS - Insurance Financial Class Report	 342
Account Provider

Collections Manager List	 70
Aged Amount 0 - 30 for Provider

Aging/Credit Balance Report	 6
Aged Amount 121 - 150 for Provider

Aging/Credit Balance Report	 6
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Aged Amount 151 - 180 for Provider
Aging/Credit Balance Report	 6

Aged Amount 31 - 60 for Provider
Aging/Credit Balance Report	 6

Aged Amount 61 - 90 for Provider
Aging/Credit Balance Report	 6

Aged Amount 90 - 120 for Provider
Aging/Credit Balance Report	 6

Aged Amount Over 180 for Provider
Aging/Credit Balance Report	 6

Amount Billed to Insurance for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of - Adjustments (Collection) for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of - Adjustments (Production) for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of + Adjustments (Collection) for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of + Adjustments (Production) for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of Applied Credit Adjustments for Previous 
Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Applied Credit Adjustments for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Applied Insurance Payments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Applied Payments for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Applied Payments for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Beginning Balances for Provider
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Charge Adjustments for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Amount of Charge Adjustments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Charges Billed to Insurance for Previous 
Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Charges for Previous Month for Provider

Day Sheet (Charges and Receipts) Report	 94

Amount of Charges for Provider
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Day Sheet Report	 100

Amount of Credit Initial Balances for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Credit Special Adjustments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Current Applied Credit Adjustments for Prov
Day Sheet (Charges and Receipts) Report	 94

Amount of Current Applied Payments for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of Current Charge Adjustments for Provider
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Amount of Current Charges Billed to Insurance for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Current Charges Compared to Fee Schedule 
for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Current Finance Charges for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Current Late Charges for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Current Suspended Credit Adjustments for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Current Suspended Payments for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Debit Initial Balances (Production) for Prov

Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of Debit Initial Balances for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Debit Special Adjustments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Ending Balances for Provider
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Finance Charges for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Finance Charges for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Finance Charge Report	 130
Provider A/R Totals - Daily Report	 276
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Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Insurance Payments for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of Lab Expenses for Medicaid Procedures for 
Provider

RVU Production Summary Report	 310
Amount of Lab Expenses for Provider

RVU Day Sheet Report	 308
Amount of Lab Expenses of Non-Medicaid Procedures 
for Provider

RVU Production Summary Report	 310
Amount of Lab Expenses of Procedures for Provider

RVU Production Summary Report	 310
Amount of Late Charges for Previous Month for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of Late Charges for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Late Charge Report	 156
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Amount of MTD Applied Credit Adjustments for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Applied Payments for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Charge Adjustments for Provider

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Amount of MTD Charges Billed to Insurance for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Charges for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Finance Charges for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Late Charges for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Suspended Credit Adjustments for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Suspended Payments for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Net Change for Provider

Analysis Summary Report - Standard	 12
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Non-Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Amount of Other Applied Credit Adjustments for 
Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Credit Initial Balances for 
Provider

Day Sheet Report	 100
Amount of Other Applied Credit Special Adjustments 
for Provider

Day Sheet Report	 100
Amount of Other Applied Insurance Payments for 
Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Applied Payments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Other Credit Initial Balances for Provider
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Other Credit Special Adjustments for Pro-
vider

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Payments for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Amount of Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Amount of Suspended Credit Adjustments for Previous 
Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Suspended Credit Adjustments for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Insurance Payments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Payments for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Suspended Payments for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of YTD Applied Credit Adjustments for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of YTD Applied Payments for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of YTD Charge Adjustments for Provider

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Charges Billed to Insurance for Provider
Day Sheet (Charges and Receipts) Report	 94
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Amount of YTD Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Finance Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Late Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Suspended Credit Adjustments for Prov
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Suspended Payments for Provider
Day Sheet (Charges and Receipts) Report	 94

Appointment Provider
Audit Report - Appointments	 26
Daily Appointment List (DX1)	 84
Daily Appointment List Report	 86
Letter Merge Reports	 158
Letter Merge Reports	 158
Operatory Appointment List Report	 196
Patient List (Filtered)	 214
As Soon As Possible List	 22

Appointment Provider Change
Audit Report - Appointments	 26

Appointment Provider ID
Letter Merge Reports	 158
Appointment Book View Printout	 14

Average Amount of Adjustments for Provider
Day Sheet (Adjustments) Report	 90

Average Amount of Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Non-Medicaid Procedures for 
Provider

RVU Production Summary Report	 310
Production Summary Report	 272

Average Amount of Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Average Charge per Patient for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Charge per Patient MTD for Provider
Day Sheet (Charges and Receipts) Report	 94

Average Payment Amount for Initial Provider
Day Sheet (Receipts) Report	 98

Average Payment Amount for Provider
Day Sheet (Receipts) Report	 98

Average Production per Patient for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Average Production per Patient MTD for Provider
Day Sheet (Charges and Receipts) Report	 94

Balance (as of a Date) for Provider
Day Sheet Report	 100
Day Sheet (Charges and Receipts) Report	 94

Beginning Balance for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Blue Cross/Blue Shield ID
Provider IDs List	 284

Charges for Provider
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Clinical Note Provider
Clinical Notes Report	 64

Collection Amount for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Current Average Charge per Patient for Provider
Day Sheet (Charges and Receipts) Report	 94

Current Average Production per Patient for Provider
Day Sheet (Charges and Receipts) Report	 94

Current Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Current Number of New Patients for Provider
Day Sheet (Charges and Receipts) Report	 94

Current Number of Patients Seen by Provider
Day Sheet (Charges and Receipts) Report	 94

DEA Number
Practice Organization List	 254

Denominator Codes for Provider
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Ending Balance for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Initial Provider
Day Sheet (Receipts) Report	 98

Medicaid Number
Practice Organization List	 254

Net Change in Balance for Provider
Day Sheet (Charges and Receipts) Report	 94

Net Difference of Current Charges and Fee Schedule 
for Provider

Day Sheet (Charges and Receipts) Report	 94
Net RVU for Provider

RVU Day Sheet Report	 308
Net RVU of Medicaid Procedures for Provider

RVU Production Summary Report	 310
Net RVU of Non-Medicaid Procedures for Provider

RVU Production Summary Report	 310
Net RVU of Procedures for Provider

RVU Production Summary Report	 310
Next Appointment Provider ID

Patient Route Slip	 226
Next Continuing Care Appointment Provider

Letter Merge Reports	 158
NPI Number

Practice Organization List	 254
Number <19 Years Old for Financial Class Type for 
Provider

UDS - Insurance Financial Class Report	 342
Number of All Genders for Provider

UDS - Age/Gender Report	 334
Number of Charts Sampled for Provider

UDS - Sealant Statistics Report	 352
Number of Encounters for Primary Providers

UDS - Encounters by Provider Report	 340
Number of Encounters for Secondary Providers

UDS - Encounters by Provider Report	 340
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Number of Females for Provider
UDS - Age/Gender Report	 334

Number of Males for Provider
UDS - Age/Gender Report	 334

Number of Medicaid and Medicare Patients for Pro-
vider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in First Age 
Group for Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group for Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients for Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in First Age Group for 
Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in Second Age Group for 
Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients for Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in First Age Group for 
Provider

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in Second Age Group for 
Provider

UDS - Medicaid/Medicare Report	 346
Number of New Patients for Provider

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Number of New Patients from Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Number of New Patients MTD for Provider

Day Sheet (Charges and Receipts) Report	 94
Number of New Patients YTD for Provider

Day Sheet (Charges and Receipts) Report	 94
Number of Other Gender for Provider

UDS - Age/Gender Report	 334
Number of Participating Providers

Insurance Carrier List	 138
Number of Patients for Provider

Practice Statistics Report	 256
Number of Patients Seen by Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Number of Patients Seen MTD by Provider
Day Sheet (Charges and Receipts) Report	 94

Number of Patients with Moderate to High Risk of Car-
ies for Provider

UDS - Sealant Statistics Report	 352
Number of Patients with Moderate to High Risk of 
Caries who Got Sealants on Permanent First Molars for 
Provider

UDS - Sealant Statistics Report	 352
Number of Patients with Status for Provider

UDS - Patient Status Report	 350

Number of Unknown Gender for Provider
UDS - Age/Gender Report	 334

Number of Users for Financial Class Type for Provider
UDS - Insurance Financial Class Report	 342

Numerator Codes for Provider
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Percent Collected for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Percent for Provider
Oral Health Education Report	 198
Periodontal Exam Report	 250
Initial Health History Report	 136

Percent of Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Non-Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Percent of Patients for Provider
Practice Statistics Report	 256

Percent of Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Perio Exam Provider Name
Perio - Data Chart Report	 240
Perio - Pocket Depths Only Report	 246
Perio - Combined Graphic & Data Chart Report	
238

Previous Balance for Provider
Day Sheet Report	 100
Day Sheet (Charges and Receipts) Report	 94

Primary Provider
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220
UDS - Insurance Financial Class Report (2013)	344
UDS - Medicaid/Medicare Report	 346
UDS - Sealant Statistics Report	 352
UDS - Tobacco Use and Intervention Report	 354
Patient List (Filtered)	 214

Primary Provider ID
Patient Route Slip	 226
Audit Report - Patients	 34

Primary Provider ID Change
Audit Report - Patients	 34

Production Amount for Provider
Provider A/R Totals - Standard Report	 278
Provider A/R Totals - Daily Report	 276

Provider
Analysis Summary Report - Daily	 8
Analysis Summary Report - Standard	 12
Audit Report - Combined	 32
Day Sheet (Adjustments) Report	 90
Day Sheet (Receipts) Report	 98
Day Sheet Report	 100
Finance Charge Report	 130
Late Charge Report	 156
Patient Health Assessment Report	 206
Patient List (Filtered)	 214
Production Summary Report	 272
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Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
RVU Day Sheet Report	 308
RVU Production Summary Report	 310
UDS - Age/Gender Report	 334
UDS - Insurance Financial Class Report	 342
UDS - Patient Status Report	 350
Aging/Credit Balance Report	 6

Provider Address
Walkout - Doctor’s Statement	 368

Provider Class
Practice Organization List	 254
Provider IDs List	 284
Audit Report - Providers/Staff	 36

Provider Class Change
Audit Report - Providers/Staff	 36

Provider DEA Number
Prescription Printout	 260

Provider Drug ID
Provider IDs List	 284

Provider Fee Schedule
Practice Organization List	 254
Provider IDs List	 284
Audit Report - Providers/Staff	 36

Provider Fee Schedule Change
Audit Report - Providers/Staff	 36

Provider ID
Audit Report - Providers/Staff	 36
Audit Report - Transactions	 38
Day Sheet (Adjustments) Report	 90
Day Sheet (Charges and Receipts) Report	 94
Day Sheet Report	 100
Deposit Slip	 108
Finance Charge Report	 130
Initial Health History Report	 136
Insurance Carrier List	 138
Insurance Carrier Production - Full Report	 142
Insurance Claims Not Sent Report	 148
Late Charge Report	 156
New Patient List	 190
Office Journal Report	 192
Operator Day Sheet Report	 194
Oral Health Education Report	 198
Patient Chart and Progress Notes Printout	 202
Patient List	 212
Payment Agreement Report	 234
Periodontal Exam Report	 250
Practice Organization List	 254
Practice Statistics Report	 256
Practice Treatment Case Report	 258
Practice Treatment Case Report	 258
Pre-Treatment Estimates Not Sent Report	 264
Procedures Not Attached to Insurance Report	270
Provider IDs List	 284
Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
RVU Utilization Report	 316
Treatment Case Report	 326

Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Unscheduled Appointment List (DX1)	 356
Unscheduled Appointment List (OM)	 358
Utilization Report	 366
Appointment Cycle Time Report	 16

Provider ID Change
Audit Report - Transactions	 38
Audit Report - Providers/Staff	 36

Provider ID Code
Provider IDs List	 284
Insurance Carrier List	 138

Provider ID Number
Insurance Carrier List	 138
Insurance Transaction Analysis Report	 154
Provider IDs List	 284
Continuing Care Display List	 76

Provider License Number
Walkout - Doctor’s Statement	 368

Provider Medicaid Number
Provider IDs List	 284

Provider Name
Audit Report - Providers/Staff	 36
Document Center Document	 116
Insurance Carrier List	 138
Letter Merge Reports	 158
Patient Chart and Progress Notes Printout	 202
Patient Chart Printout	 204
Patient Treatment Case Report	 228
Perio - Combined Graphic & Data Chart Report	
238
Perio - Exam Comparison Report	 242
Perio - Graphic Chart Report	 244
Practice Organization List	 254
Practice Statistics Report	 256
Prescription Printout	 260
Procedures by Contracted Amount Report	 268
Provider IDs List	 284
Referral Recap Report	 296
Referral Slip	 298
Treatment Case Report	 326
Walkout - Doctor’s Statement	 368
Appointment Reminder Cards	 18

Provider Name Change
Audit Report - Providers/Staff	 36

Provider NPI Number
Provider IDs List	 284
Prescription Printout	 260

Provider Number
Provider IDs List	 284
Practice Organization List	 254

Provider Office Phone Number
Provider IDs List	 284

Provider Phone Number
Patient Chart Printout	 204
Referral Recap Report	 296
Referral Slip	 298
Walkout - Doctor’s Statement	 368
Patient Chart and Progress Notes Printout	 202

Provider RVU Schedule
Provider IDs List	 284
Practice Organization List	 254

Provider (continued)



Index by Report Item   555

Dentrix Enterprise 11.0.2 Reports Reference

Provider Signature
Treatment Case Report	 326
Prescription Printout	 260

Provider Social Security Number
Practice Organization List	 254
Provider IDs List	 284
Audit Report - Providers/Staff	 36

Provider Social Security Number Change
Audit Report - Providers/Staff	 36

Provider Social Security Number or TIN Number
Walkout - Doctor’s Statement	 368

Provider Specialty
Provider IDs List	 284

Provider State ID
Provider IDs List	 284

Provider TIN Number
Provider IDs List	 284

Provider Title
Practice Organization List	 254
Provider IDs List	 284
Letter Merge Reports	 158

Provider’s Signature
Perio - Exam Comparison Report	 242
Perio - Graphic Chart Report	 244
Perio - Combined Graphic & Data Chart Report	
238

Quantity of Adjustments for Provider
Day Sheet (Adjustments) Report	 90

Quantity of Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Quantity of Non-Medicaid Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Quantity of Payments for Initial Provider
Day Sheet (Receipts) Report	 98

Quantity of Payments for Provider
Day Sheet (Receipts) Report	 98

Quantity of Procedures for Provider
RVU Production Summary Report	 310
Production Summary Report	 272

Rendering Provider NPI Number
Dental Encounters Report	 106

Revenue for Provider from Credit Adjustments
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Revenue for Provider from Insurance
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Revenue for Provider from Non-insurance Sources
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

RVU for Provider
RVU Day Sheet Report	 308

Secondary Provider ID
Patient Route Slip	 226

Specialty
Practice Organization List	 254

State ID
Practice Organization List	 254

Total Amount of Adjustments for Provider
Day Sheet (Adjustments) Report	 90

Total Amount of Payments for Initial Provider
Day Sheet (Receipts) Report	 98

Total Amount of Payments for Provider
Day Sheet (Receipts) Report	 98

Total Number of New Patients for Provider
Day Sheet Report	 100

Total Revenue for Provider
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Unique Patient Count for Provider
RVU Day Sheet Report	 308

Unique Visit Count for Provider
RVU Day Sheet Report	 308

Provider Class
20+ Years Old for Financial Class Type for Provider

UDS - Insurance Financial Class Report	 342
Provider Class

Practice Organization List	 254
Provider IDs List	 284
Audit Report - Providers/Staff	 36

Provider Class Change
Audit Report - Providers/Staff	 36

Provider ID
Future Appointment Provider ID

Patient Route Slip	 226
Provider ID Code

Provider ID Code
Provider IDs List	 284
Insurance Carrier List	 138

Provider Number
Provider Number

Provider IDs List	 284
Practice Organization List	 254

Provider Specialty
Provider Specialty

Provider IDs List	 284
Pulse

Pulse
Patient Health Assessment Report	 206

Question
Questions

Patient Questionnaire	 222
Race

Patient Race
Patient List (Filtered)	 214

Race
UDS - Patient Status Report	 350

Radiology
Number of Diagnostic Imaging Orders Recorded Using 
CPOE (Computerized Provider Order Entry)

Meaningful Use Measure Calculation List	 162

Provider (continued)
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Number of Radiology Orders
Meaningful Use Measure Calculation List	 162

Number of Radiology Orders Recorded Using CPOE 
(Computerized Provider Order Entry)

Meaningful Use Measure Calculation List	 162
Rate

Annual Percentage Rate
Truth in Lending Disclosure Statement	 332

Interest Rate
Truth in Lending Disclosure Statement	 332

Re-sent
Claim Re-sent Date

Insurance Claim Aging Report	 146
Pre-treatment Estimate Re-sent Date

Pre-Treatment Estimate Aging Report	 262
Reason

Appointment Reason
As Soon As Possible List	 22
Daily Appointment List (DX1)	 84
Daily Appointment List Report	 86
Letter Merge Reports	 158
Operatory Appointment List Report	 196
Unscheduled Appointment List (DX1)	 356
Unscheduled Appointment List (OM)	 358
Walkout - Family Walkout	 370
Appointment Book View Printout	 14

Future Appointment Reason
Patient Route Slip	 226

Next Continuing Care Appointment Reason
Letter Merge Reports	 158

Receivables
Current Receivables

Practice Analysis Report	 252
Percent of Receivables

Practice Analysis Report	 252
Receivables Aged 31 - 60

Practice Analysis Report	 252
Receivables Aged 61 - 90

Practice Analysis Report	 252
Receivables Aged Over 90

Practice Analysis Report	 252
Total Receivables

Practice Analysis Report	 252
Received Date

Claim Payment Received Date
Insurance Transaction Analysis Report	 154

Reconciliation
Number of TCs (Transition of Care) and Referrals where 
Clinical Information Reconciliation Was Performed

Meaningful Use Measure Calculation List	 162
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Financial Class Type (Current Year)

UDS - Patient Related Revenue Report	 348
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Financial Class Type (Previous Years)

UDS - Patient Related Revenue Report	 348
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Payer Category (Current Year)

UDS - Patient Related Revenue Report	 348

Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Payer Category (Previous Years)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Financial Class Type (Current Year)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Financial Class Type (Previous Years)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Patient (Current Year)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Patient (Previous Years)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Payer Category (Current Year)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Payer Category (Previous Years)

UDS - Patient Related Revenue Report	 348
Wrap Around or Reconciliation Amount Collected for 
Patient (Current Year)

UDS - Patient Related Revenue Report	 348
Wrap Around or Reconciliation Amount Collected for 
Patient (Previous Years)

UDS - Patient Related Revenue Report	 348
Record Type

Record Type Change
Audit Report - Patients	 34
Audit Report - Transactions	 38
Audit Rights Report - Assigned Individually	 40
Audit Rights Report - Assigned to Groups	 42
Audit Rights Report - Group Names	 44
Audit Rights Report - Users to Groups	 46
Audit Report - Combined	 32

Referral
Average Production per Patient at Clinic from Referral 
Source

Referral Analysis Report	 294
Average Production Per Patient from Referral Source

Referral Analysis Report	 294
Average Production Per Patient from Referral Sources

Referral Analysis Report	 294
Completed Date

Referred To Doctor Report	 304
Days Referred Out

Referred To Doctor Report	 304
First Name of Referred by Source

Letter Merge Reports	 158
Gratuity Given

Referred By Patient Report	 302
Last Gratuity Amount

Patient Route Slip	 226
Last Gratuity Date

Referred By Patient Report	 302
Last Name of Referred by Source

Letter Merge Reports	 158
Last Referral Date

Letter Merge Reports	 158
Last Referral Name and Date

Patient Route Slip	 226

Radiology (continued)
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Last Referred By Source and Date
Patient Route Slip	 226

Last Referred To Name and Date
Patient Route Slip	 226

Middle Initial of Referred by Source
Letter Merge Reports	 158

Number of Patients at Clinic from Referral Source
Referral Analysis Report	 294

Number of Patients from Referral Source
Referral Analysis Report	 294

Number of Referrals
Referred By Patient Report	 302
Referred To Doctor Report	 304
Patient Route Slip	 226

Number of Referrals Listed
Referred To Doctor Report	 304
Referred By Patient Report	 302

Number of Referred by Doctor/Other Patients Listed
Referred By Doctor/Other Report	 300

Number of Referred New Patients (in Month and Year)
Practice Statistics Report	 256

Number of TCs (Transition of Care) and Referrals
Meaningful Use Measure Calculation List	 162

Number of TCs (Transition of Care) and Referrals where 
Clinical Information Reconciliation Was Performed

Meaningful Use Measure Calculation List	 162
Number of TCs (Transition of Care) and Referrals where 
Electronic SCs (Summary of Care) Provided

Meaningful Use Measure Calculation List	 162
Number of TCs (Transition of Care) and Referrals where 
SCs (Summary of Care) Provided

Meaningful Use Measure Calculation List	 162
Number of TCs (Transition of Care) and Referrals where 
SCs (Summary of Care) Was Exchanged Electronically

Meaningful Use Measure Calculation List	 162
Percent of Production from Referral Source

Referral Analysis Report	 294
Percent of Production from Referral Sources

Referral Analysis Report	 294
Percent of Referred New Patients (in Month and Year)

Practice Statistics Report	 256
Production at Clinic from Referral Source

Referral Analysis Report	 294
Production from Referral Source

Referral Analysis Report	 294
Referral Address

Referral Slip	 298
Referral Recap Report	 296

Referral Date
Referral Slip	 298
Referred By Doctor/Other Report	 300
Referred By Patient Report	 302
Referred To Doctor Report	 304
Referral Recap Report	 296

Referral Name
Referral Slip	 298
Referral Recap Report	 296

Referral Note
Referral Slip	 298
Referral Recap Report	 296

Referral Phone Number
Referral Slip	 298
Referral Recap Report	 296

Referral Source
Referral Analysis Report	 294

Referral Source Name
Patient Questionnaire	 222

Referral Status
Referred To Doctor Report	 304

Referred By (RB)
Unscheduled Treatment Plans (Detailed) Report	
362

Referred By Date
New Patient List	 190

Referred by Doctor/Other Address
Referred By Doctor/Other Report	 300

Referred by Doctor/Other Gratuity Given
Referred By Doctor/Other Report	 300

Referred by Doctor/Other Last Gratuity Date
Referred By Doctor/Other Report	 300

Referred by Doctor/Other Name
Referred By Doctor/Other Report	 300
Document Center Document	 116

Referred by Doctor/Other Phone Number
Referred By Doctor/Other Report	 300

Referred by Doctor/Other Total Referrals
Referred By Doctor/Other Report	 300

Referred By Name
New Patient List	 190

Referred by Patient Name
Document Center Document	 116

Referred by Source Address
Letter Merge Reports	 158

Referred by Source Phone Number
Letter Merge Reports	 158

Referred by Source Salutation
Letter Merge Reports	 158

Referred by Source Title
Letter Merge Reports	 158

Referred Date of Treatment Still in Progress
Referral Recap Report	 296

Referred Patient
Referred By Patient Report	 302

Referred Patient Name
Referred To Doctor Report	 304

Referred Patients (Average)
Practice Analysis Report	 252

Referred Patients (for Date Range)
Practice Analysis Report	 252

Referred Patients (MTD)
Practice Analysis Report	 252

Referred Patients (YTD)
Practice Analysis Report	 252

Referred To (RT)
Unscheduled Treatment Plans (Detailed) Report	
362

Referred to Address
Letter Merge Reports	 158

Referred to Doctor Address
Referred To Doctor Report	 304

Referral (continued)
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Referred to Doctor Name
Referred To Doctor Report	 304
Document Center Document	 116

Referred to Doctor Phone Number
Referred To Doctor Report	 304

Referred to First Name
Letter Merge Reports	 158

Referred to Last Name
Letter Merge Reports	 158

Referred to Middle Initial
Letter Merge Reports	 158

Referred to Phone Number
Letter Merge Reports	 158

Referred to Salutation
Letter Merge Reports	 158

Referred to Title
Letter Merge Reports	 158

Referring Patient Address
Referred By Patient Report	 302

Referring Patient Home Phone Number
Referred By Patient Report	 302

Referring Patient Name
Referred By Patient Report	 302

Scheduled Date
Referred To Doctor Report	 304

Total Average Production per Patient at Clinics from 
Referral Source

Referral Analysis Report	 294
Total Number of Patients at Clinics from Referral Source

Referral Analysis Report	 294
Total Number of Patients from Referral Sources

Referral Analysis Report	 294
Total Number of Referrals

Referred To Doctor Report	 304
Referred By Patient Report	 302

Total Number of Referrals Listed
Referred To Doctor Report	 304

Total Number of Referred by Doctor/Other Patients 
Listed

Referred By Doctor/Other Report	 300
Total Number of Referred by Doctor/Other Referrals

Referred By Doctor/Other Report	 300
Total Number Referrals Listed

Referred By Patient Report	 302
Total Production at Clinics from Referral Source

Referral Analysis Report	 294
Total Production from Referral Sources

Referral Analysis Report	 294
Referred

Number of Referred New Patients (in Month and Year)
Practice Statistics Report	 256

Percent of Referred Cases
Practice Treatment Case Report	 258

Percent of Referred New Patients (in Month and Year)
Practice Statistics Report	 256

Referred Date of Treatment Still in Progress
Referral Recap Report	 296

Referred Patient
Referred By Patient Report	 302

Referred Patient Name
Referred To Doctor Report	 304

Referred Patients (Average)
Practice Analysis Report	 252

Referred Patients (for Date Range)
Practice Analysis Report	 252

Referred Patients (MTD)
Practice Analysis Report	 252

Referred Patients (YTD)
Practice Analysis Report	 252

Referred by
First Name of Referred by Source

Letter Merge Reports	 158
Last Name of Referred by Source

Letter Merge Reports	 158
Last Referred By Source and Date

Patient Route Slip	 226
Middle Initial of Referred by Source

Letter Merge Reports	 158
Number of Referred by Doctor/Other Patients Listed

Referred By Doctor/Other Report	 300
Referred By (RB)

Unscheduled Treatment Plans (Detailed) Report	
362

Referred By Date
New Patient List	 190

Referred by Doctor/Other Address
Referred By Doctor/Other Report	 300

Referred by Doctor/Other Gratuity Given
Referred By Doctor/Other Report	 300

Referred by Doctor/Other Last Gratuity Date
Referred By Doctor/Other Report	 300

Referred by Doctor/Other Name
Referred By Doctor/Other Report	 300
Document Center Document	 116

Referred by Doctor/Other Phone Number
Referred By Doctor/Other Report	 300

Referred by Doctor/Other Total Referrals
Referred By Doctor/Other Report	 300

Referred By Name
New Patient List	 190

Referred by Patient Name
Document Center Document	 116

Referred by Source Address
Letter Merge Reports	 158

Referred by Source Phone Number
Letter Merge Reports	 158

Referred by Source Salutation
Letter Merge Reports	 158

Referred by Source Title
Letter Merge Reports	 158

Total Number of Referred by Doctor/Other Patients 
Listed

Referred By Doctor/Other Report	 300
Total Number of Referred by Doctor/Other Referrals

Referred By Doctor/Other Report	 300
Referred out

Days Referred Out
Referred To Doctor Report	 304

Referred to
Last Referred To Name and Date

Patient Route Slip	 226

Referral (continued)
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Referred To (RT)
Unscheduled Treatment Plans (Detailed) Report	
362

Referred to Address
Letter Merge Reports	 158

Referred to Doctor Address
Referred To Doctor Report	 304

Referred to Doctor Name
Referred To Doctor Report	 304
Document Center Document	 116

Referred to Doctor Phone Number
Referred To Doctor Report	 304

Referred to First Name
Letter Merge Reports	 158

Referred to Last Name
Letter Merge Reports	 158

Referred to Middle Initial
Letter Merge Reports	 158

Referred to Phone Number
Letter Merge Reports	 158

Referred to Salutation
Letter Merge Reports	 158

Referred to Title
Letter Merge Reports	 158

Relationship
Patient Relationship to Subscriber for Primary Insurance

Patient Questionnaire	 222
Patient Relationship to Subscriber for Secondary Insur-
ance

Patient Questionnaire	 222
Relation to Subscriber

Walkout - Doctor’s Statement	 368
Religion

Patient Religion
Patient List (Filtered)	 214

Religion
UDS - Patient Status Report	 350

Remaining
Remaining Number of Months

Future Due Payment Plan Report - Standard	 134
Remaining Payment Agreement Amount

Collections Manager List	 70
Total Amount of Charges Remaining (after 18 Mos from 
Curr Mo)

Future Due Payment Plan Report - Monthly Totals	
132

Total Amount of Remaining Payment Agreements
Collections Manager List	 70

Total Amount Remaining
Future Due Payment Plan Report - Standard	 134

Total Number of Charges Remaining (after 18 Mos from 
Curr Mo)

Future Due Payment Plan Report - Monthly Totals	
132

Remaining Balance
Payment Agreement Remaining Balance

Payment Agreement Report	 234
Payment Agreement Report	 234
Payment Agreement Amortization Schedule	 232

Payment Plan Remaining Balance
Letter Merge Reports	 158

Remaining Balance
Procedures by Contracted Amount Report	 268
Future Due Payment Plan Report - Standard	 134

Total Amount of Balances Remaining for Payment 
Agreements

Payment Agreement Report	 234
Remaining Benefits

Amount of Estimated Primary Insurance Benefits Re-
maining YTD for Family

Treatment Case Report	 326
Amount of Estimated Primary Insurance Benefits Re-
maining YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Estimated Secondary Insurance Benefits 
Remaining YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Primary Insurance Benefits Remaining
Unscheduled Treatment Plans (Detailed) Report	
362
Patient Route Slip	 226

Amount of Remaining Benefits for Primary Insurance
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Amount of Remaining Benefits for Secondary Insurance
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Amount of Secondary Insurance Benefits Remaining
Unscheduled Treatment Plans (Detailed) Report	
362
Patient Route Slip	 226

Benefits Remaining
Insurance Carrier List	 138

Primary Insurance Benefits Remaining
Letter Merge Reports	 158

Projected Amount of Remaining Benefits
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Projected Amount of Remaining Benefits for Secondary 
Insurance

Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Secondary Insurance Benefits Remaining
Letter Merge Reports	 158

Remarks for Unusual Services
Remarks for Unusual Service

Walkout - Doctor’s Statement	 368
Reminder

Future Reminder Date
Collections Manager List	 70

Future Reminder Type
Collections Manager List	 70

Number of Patients Sent Reminders
Meaningful Use Measure Calculation List	 162

Reminder Text
Continuing Care Cards - with Appointment	 75
Continuing Care Cards - No Appointment	 74

Referred to (continued)
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Reminder Type
Future Reminder Type

Collections Manager List	 70
Rendering Provider

Rendering Provider NPI Number
Dental Encounters Report	 106

Renew
Benefit Renewal Month

Insurance Carrier List	 138
Primary Insurance Plan Renewal Month

Unscheduled Treatment Plans (Detailed) Report	
362

Secondary Insurance Benefits Renewal Month
Patient Route Slip	 226

Secondary Insurance Plan Renewal Month
Unscheduled Treatment Plans (Detailed) Report	
362

Replace
Replace Initial Zero of Procedure Code on Claims

Insurance Carrier List	 138
Report

Printed Patient Report
Audit Report - Combined	 32

Representative
Representative Signature

Treatment Case Report	 326
Request

Patient Social Security Number or Request Date
Audit Report - Patients	 34

Patient Social Security Number or Request Date 
Change

Audit Report - Patients	 34
Required

Pre-authorization Required
Standard Coverage Tables Report	 322
Insurance Coverage Tables Report	 150

Retroactive Payment
Other Retroactive Payment Amount Collected for 
Patient

UDS - Patient Related Revenue Report	 348
Subtotal of Other Retroactive Payment Amount Col-
lected for Financial Class Type

UDS - Patient Related Revenue Report	 348
Subtotal of Other Retroactive Payment Amount Col-
lected for Payer Category

UDS - Patient Related Revenue Report	 348
Total Other Retroactive Payment Amount Collected for 
Financial Class Type

UDS - Patient Related Revenue Report	 348
Total Other Retroactive Payment Amount Collected for 
Patient

UDS - Patient Related Revenue Report	 348
Total Other Retroactive Payment Amount Collected for 
Payer Category

UDS - Patient Related Revenue Report	 348
Revenue

Revenue for Provider from Credit Adjustments
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Revenue for Provider from Insurance
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Revenue for Provider from Non-insurance Sources
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Total Revenue
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Total Revenue for Provider
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Total Revenue from Credit Adjustments
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Total Revenue from Insurance
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Total Revenue from Non-insurance
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Provider Revenue - Summary Report	 292
Provider Revenue - Allocations Report	 286

Right
Right

Audit Rights Report - Assigned to Groups	 42
Audit Rights Report - Assigned Individually	 40

Rights
Audit Report - Appointments	 26
Audit Report - Clinics	 30
Audit Report - Patients	 34
Audit Report - Providers/Staff	 36
Audit Report - Transactions	 38
Assigned Rights Report	 24

Running Balance
Patient Running Balance

Patient Ledger Report	 210
RVU

Amount of RVUs for Insurance Carrier
RVU Utilization Report	 316

Net RVU
RVU Day Sheet Report	 308

Net RVU for Clinic
RVU Day Sheet Report	 308

Net RVU for Medicaid Procedures
RVU Production Summary Report	 310

Net RVU for Provider
RVU Day Sheet Report	 308

Net RVU of Medicaid Procedures for Clinic
RVU Production Summary Report	 310
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Net RVU of Medicaid Procedures for Provider
RVU Production Summary Report	 310

Net RVU of Non-Medicaid Procedures
RVU Production Summary Report	 310

Net RVU of Non-Medicaid Procedures for Clinic
RVU Production Summary Report	 310

Net RVU of Non-Medicaid Procedures for Provider
RVU Production Summary Report	 310

Net RVU of Procedures
RVU Production Summary Report	 310

Net RVU of Procedures for Clinic
RVU Production Summary Report	 310

Net RVU of Procedures for Provider
RVU Production Summary Report	 310

Procedure RVU
RVU Utilization Report	 316

RVU
RVU Day Sheet Report	 308

RVU for Clinic
RVU Day Sheet Report	 308

RVU for Provider
RVU Day Sheet Report	 308

RVU Schedule
RVU Schedules Report	 314

Total Amount of Fees - RVU
RVU Utilization Report	 316

Total Amount of RVUs
RVU Utilization Report	 316

Total Net RVU
RVU Day Sheet Report	 308

Total RVU
RVU Day Sheet Report	 308

RVU Schedule
Amount of Fees - RVU for Insurance Carrier

RVU Utilization Report	 316
Provider RVU Schedule

Provider IDs List	 284
Practice Organization List	 254

RVU Schedule
RVU Schedules Report	 314

Salutation
Patient Salutation

Continuing Care Cards - with Appointment	 75
Letter Merge Reports	 158
Continuing Care Cards - No Appointment	 74

Referred by Source Salutation
Letter Merge Reports	 158

Referred to Salutation
Letter Merge Reports	 158

Sampled Chart
Number of Charts Sampled

UDS - Sealant Statistics Report	 352
Number of Charts Sampled for Provider

UDS - Sealant Statistics Report	 352
Number of Charts Sampled in Clinic

UDS - Sealant Statistics Report	 352
Number of Charts Sampled in ZIP Code

UDS - Sealant Statistics Report	 352

Scheduled
Number of Scheduled Treatment-planned Procedures

Practice Treatment Case Report	 258
Percent of Scheduled Cases

Practice Treatment Case Report	 258
Scheduled and/or Unscheduled Appointment

Unscheduled Treatment Plans (Detailed) Report	
362
Unscheduled Treatment Plans (Condensed) Re-
port	 360

Scheduled Date
Referred To Doctor Report	 304

Total Amount of Scheduled Treatment Plans
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Total Number of Scheduled Appointments
Appointment Statistics Report	 20

Sealant
Number of Patients with Moderate to High Risk of Car-
ies who Got Sealants on Permanent First Molars

UDS - Sealant Statistics Report	 352
Number of Patients with Moderate to High Risk of 
Caries who Got Sealants on Permanent First Molars for 
Provider

UDS - Sealant Statistics Report	 352
Number of Patients with Moderate to High Risk of 
Caries who Got Sealants on Permanent First Molars in 
Clinic

UDS - Sealant Statistics Report	 352
Number of Patients with Moderate to High Risk of Car-
ies who Got Sealants on Permanent First Molars in ZIP 
Code

UDS - Sealant Statistics Report	 352
Percent of Patients with Sealants

Caries Prevalence and Periodontal Index Report	
52

Sealed
Mean Number of Sealed Teeth

Caries Prevalence and Periodontal Index Report	
52

Secondary
Amount of Annual Secondary Insurance Plan Benefits 
for Family

Treatment Case Report	 326
Amount of Annual Secondary Insurance Plan Benefits 
for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Estimated Secondary Insurance Benefits 
Remaining YTD for Family

Treatment Case Report	 326
Amount of Estimated Secondary Insurance Benefits 
Remaining YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Other Deductible Owed by Family to Sec-
ondary Insurance

Patient Route Slip	 226
Amount of Other Deductible Owed to Secondary Insur-
ance

Patient Route Slip	 226

RVU (continued)
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Amount of Pending Estimated Secondary Insurance 
Portions YTD for Family

Treatment Case Report	 326
Amount of Pending Estimated Secondary Insurance 
Portions YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Preventative Deductible Owed by Family to 
Secondary Insurance

Patient Route Slip	 226
Amount of Preventative Deductible Owed to Secondary 
Insurance

Patient Route Slip	 226
Amount of Remaining Benefits for Secondary Insurance

Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Amount of Secondary Insurance Benefits Remaining
Unscheduled Treatment Plans (Detailed) Report	
362
Patient Route Slip	 226

Amount of Secondary Insurance Benefits Used
Patient Route Slip	 226

Amount of Secondary Insurance Portion
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Secondary Insurance Portion for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Amount of Secondary Insurance Portion for Visit
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Secondary Paid Benefits for Family
Treatment Case Report	 326

Amount of Secondary Paid Benefits for Patient
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Standard Deductible Owed by Family to 
Secondary Insurance

Patient Route Slip	 226
Amount of Standard Deductible Owed to Secondary 
Insurance

Patient Route Slip	 226
Insurance Coverage Percent (Basic) for Secondary Insur-
ance

Patient Route Slip	 226
Insurance Coverage Percent (Major) for Secondary 
Insurance

Patient Route Slip	 226
Insurance Coverage Percent (Orthodontics) for Second-
ary Insurance

Patient Route Slip	 226
Insurance Coverage Percent (Preventative) for Second-
ary Insurance

Patient Route Slip	 226
Insurance Plan Group Number for Secondary Insurance

Patient Questionnaire	 222

Insurance Plan Name and Address for Secondary Insur-
ance

Patient Questionnaire	 222
Last Eligibility Date for Secondary Insurance Coverage

Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Maximum Secondary Insurance Benefit Amount
Patient Route Slip	 226

Number of Encounters for Secondary Providers
UDS - Encounters by Provider Report	 340

Number of Patients with Secondary Dental Insurance
Practice Statistics Report	 256

Other Deductible Owed by Family to Secondary Insur-
ance

Treatment Case Report	 326
Other Deductible Owed by Patient to Secondary Insur-
ance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Outstanding Secondary Insurance Estimated Amount
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Patient Relationship to Subscriber for Secondary Insur-
ance

Patient Questionnaire	 222
Percent of Patients with Secondary Dental Insurance

Practice Statistics Report	 256
Preventative Deductible Owed by Family to Secondary 
Ins

Treatment Case Report	 326
Preventative Deductible Owed by Patient to Secondary 
Ins

Treatment Case Report	 326
Patient Treatment Case Report	 228

Projected Amount of Remaining Benefits for Secondary 
Insurance

Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Secondary Dental Insurance Carrier Name
Patient List	 212

Secondary Eligibility Date
Appointment Book View Printout	 14

Secondary Insurance Benefits Expiration Date for Family
Treatment Case Report	 326

Secondary Insurance Benefits Expiration Date for 
Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Secondary Insurance Benefits Remaining
Letter Merge Reports	 158

Secondary Insurance Benefits Renewal Month
Patient Route Slip	 226

Secondary Insurance Carrier Name
Patient Route Slip	 226
Secondary Insurance Claims Not Created Report	
318
Secondary Pre-Treatment Estimates Not Created 
Report	 320
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Unscheduled Treatment Plans (Detailed) Report	
362

Secondary (continued)



Index by Report Item   563

Dentrix Enterprise 11.0.2 Reports Reference

Letter Merge Reports	 158
Secondary Insurance Carrier Plan Employer

Patient Route Slip	 226
Secondary Insurance Estimated Amount

Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Secondary Insurance Plan Group Number
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Patient Route Slip	 226

Secondary Insurance Plan Renewal Month
Unscheduled Treatment Plans (Detailed) Report	
362

Secondary Medical Insurance Carrier Name
Patient List	 212

Secondary Pre-treatment Estimate Sent Date
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Secondary Production Amount
Insurance Carrier Production - Full Report	 142

Secondary Production Amount for Insurance Plan
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Secondary Provider ID
Patient Route Slip	 226

Secondary Subscriber ID
Letter Merge Reports	 158

Standard Deductible Owed by Family to Secondary 
Insurance

Treatment Case Report	 326
Standard Deductible Owed by Patient to Secondary 
Insurance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Subscriber Address for Secondary Insurance
Patient Questionnaire	 222

Subscriber Birth Date for Secondary Insurance
Patient Questionnaire	 222

Subscriber ID for Secondary Insurance
Patient Questionnaire	 222

Subscriber Name for Secondary Insurance
Patient Route Slip	 226
Patient Questionnaire	 222

Subscriber’s Employer Address for Secondary Insurance
Patient Questionnaire	 222

Subscriber’s Employer Name for Secondary Insurance
Patient Questionnaire	 222

Total Amount for Secondary Pre-treatment Estimates
Pre-Treatment Estimate Aging Report	 262

Total Amount of Account Balances Aged 1 - 30 for Sec-
ondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 1 - 30 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 121 - 150 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262

Total Amount of Account Balances Aged 121 - 150 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 151 - 180 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 151 - 180 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 181+ for Sec-
ondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 181+ with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 31 - 60 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 31 - 60 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 61 - 90 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 61 - 90 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances Aged 91 - 120 for 
Secondary Pre-treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Account Balances Aged 91 - 120 with 
Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Secondary 
Claims

Insurance Claim Aging Report	 146
Total Amount of Account Balances with Secondary Pre-
treatment Estimates

Pre-Treatment Estimate Aging Report	 262
Total Amount of Estimated Insurance Portion for Pri-
mary and Secondary Claims

Insurance Claim Aging Report	 146
Total Amount of Estimated Insurance Portion for Sec-
ondary Claims

Insurance Claim Aging Report	 146
Total Amount of Primary and Secondary Claims not Sent

Insurance Claims Not Sent Report	 148
Total Amount of Secondary Claims not Created

Secondary Insurance Claims Not Created Report	
318

Total Amount of Secondary Claims not Sent
Insurance Claims Not Sent Report	 148

Total Amount of Secondary Insurance Portion for Case
Treatment Case Report	 326

Total Amount of Secondary Pre-treatment Estimates not 
Created

Secondary Pre-Treatment Estimates Not Created 
Report	 320

Total Amount of Secondary Pre-treatment Estimates not 
Sent

Pre-Treatment Estimates Not Sent Report	 264

Secondary (continued)
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Total Amount of Secondary Production
Insurance Carrier Production - Summary Report	
144
Insurance Carrier Production - Full Report	 142

Secure Electronic Message
Number of Patients who Sent Secure Electronic Mes-
sages

Meaningful Use Measure Calculation List	 162
Number of Patients Who Were Sent Secure Electronic 
Messages

Meaningful Use Measure Calculation List	 162
Seen

Current Number of Patients Seen
Day Sheet (Charges and Receipts) Report	 94

Current Number of Patients Seen by Provider
Day Sheet (Charges and Receipts) Report	 94

Number of Patients 0 - 2 Years Seen
Meaningful Use Measure Calculation List	 162

Number of Patients 13+ Years Seen
Meaningful Use Measure Calculation List	 162
Meaningful Use Measure Calculation List	 162

Number of Patients 2+ Years Seen
Meaningful Use Measure Calculation List	 162

Number of Patients 3+ Years Seen
Meaningful Use Measure Calculation List	 162

Number of Patients 66+ Years Seen
Clinical Quality Measures List	 66

Number of Patients Seen
Analysis Summary Report - Standard	 12
Daily Summary Report	 88
Meaningful Use Measure Calculation List	 162
Analysis Summary Report - Daily	 8

Number of Patients Seen at Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Number of Patients Seen by Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Number of Patients Seen During Past 24 Months
Meaningful Use Measure Calculation List	 162

Number of Patients Seen for Insurance Carrier
Utilization Report	 366
RVU Utilization Report	 316

Number of Patients Seen MTD
Day Sheet (Charges and Receipts) Report	 94

Number of Patients Seen MTD by Provider
Day Sheet (Charges and Receipts) Report	 94

Total Number of Patients Seen
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
RVU Utilization Report	 316
Utilization Report	 366
Analysis Summary Report - Daily	 8

Sent
Claim Sent Date

Insurance Transaction Analysis Report	 154
Insurance Claim Aging Report	 146

Pre-treatment Estimate Sent Date
Pre-Treatment Estimate Aging Report	 262

Primary Pre-treatment Estimate Sent Date
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Secondary Pre-treatment Estimate Sent Date
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Separated
Number of Separated Patients

Practice Statistics Report	 256
Percent of Separated Patients

Practice Statistics Report	 256
Serial Number

DENTRIX Enterprise Serial Number
Registration Information Report	 306

Service
Description of Service

Billing Statement	 48
Procedure Date for Date of Service

Letter Merge Reports	 158
Service Date

Insurance Claim Aging Report	 146
Patient Revenue List by Payer Report	 224
Procedures by Contracted Amount Report	 268
RVU Utilization Report	 316
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Utilization Report	 366
Dental Encounters Report	 106

Total Charge for Date of Service
Letter Merge Reports	 158

Type of Service Code
Medical Code List	 186

Type of Service Code Description
Medical Code List	 186

Setting
Status of Setting

Audit Report - Audit Log Status	 28
Severity

Case Severity
Practice Treatment Case Report	 258

Sexual Orientation
Sexual Orientation

UDS - Patient Status Report	 350
Signature

Date Signed
Perio - Exam Comparison Report	 242
Perio - Graphic Chart Report	 244
Perio - Combined Graphic & Data Chart Report	
238

Patient Signature
Treatment Case Report	 326

Practice Signature
Treatment Case Report	 326

Provider Signature
Treatment Case Report	 326
Prescription Printout	 260

Provider’s Signature
Perio - Exam Comparison Report	 242
Perio - Graphic Chart Report	 244

Secondary (continued)
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Perio - Combined Graphic & Data Chart Report	
238

Representative Signature
Treatment Case Report	 326

Signature Date
Treatment Case Report	 326

Staff Signature
Treatment Case Report	 326

Signed
Clinical Note Status

Clinical Notes Report	 64
Date Signed

Perio - Exam Comparison Report	 242
Perio - Graphic Chart Report	 244
Perio - Combined Graphic & Data Chart Report	
238

Signed Date
Document Center - Documents List Report	 112

Signer
Signer Name

Treatment Case Report	 326
Document Center - Documents List Report	 112

Single
Number of Single Patients

Practice Statistics Report	 256
Percent of Single Patients

Practice Statistics Report	 256
Smoking Status

Number of Patients 13+ Years with Smoking Status
Meaningful Use Measure Calculation List	 162
Meaningful Use Measure Calculation List	 162

Social Security Number
Guarantor Social Security Number

Patient Route Slip	 226
Truth in Lending Disclosure Statement	 332
Collections Manager List	 70

Patient Social Security Number
Coupon Book - Future Due Payments	 78
Coupon Book - Payment Agreements	 79
Employers and Employed Patients Report	 122
Insurance Transaction Analysis Report	 154
Letter Merge Reports	 158
Patient Chart and Progress Notes Printout	 202
Patient Chart Printout	 204
Patient List	 212
Patient Notes Report	 216
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220
Patient Questionnaire	 222
Patient Route Slip	 226
Patient Treatment Case Report	 228
Perio - Combined Graphic & Data Chart Report	
238
Perio - Exam Comparison Report	 242
Perio - Graphic Chart Report	 244
Practice Treatment Case Report	 258
RVU Utilization Report	 316
Treatment Case Report	 326
UDS - Age/Gender Report	 334
UDS - Insurance Financial Class Report	 342

UDS - Insurance Financial Class Report (2013)	344
UDS - Medicaid/Medicare Report	 346
UDS - Patient Status Report	 350
UDS - Sealant Statistics Report	 352
UDS - Tobacco Use and Intervention Report	 354
Utilization Report	 366
Walkout - Doctor’s Statement	 368
Clinical Notes Report	 64

Patient Social Security Number or Request Date
Audit Report - Patients	 34

Patient Social Security Number or Request Date 
Change

Audit Report - Patients	 34
Provider Social Security Number

Practice Organization List	 254
Provider IDs List	 284
Audit Report - Providers/Staff	 36

Provider Social Security Number Change
Audit Report - Providers/Staff	 36

Provider Social Security Number or TIN Number
Walkout - Doctor’s Statement	 368

Spouse Social Security Number
Patient Questionnaire	 222

Staff Social Security Number
Audit Report - Providers/Staff	 36

Staff Social Security Number Change
Audit Report - Providers/Staff	 36

Special Adjustment
Amount of Credit Special Adjustments

Provider A/R Totals - Daily Report	 276
Amount of Credit Special Adjustments for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Credit Special Adjustments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Debit Special Adjustments
Provider A/R Totals - Daily Report	 276

Amount of Debit Special Adjustments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Debit Special Adjustments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Amount of Other Applied Credit Special Adjustments 
for Clinic

Day Sheet Report	 100
Amount of Other Credit Special Adjustments for Clinic

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Amount of Other Credit Special Adjustments for Pro-
vider

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Signature (continued)
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Credit Special Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Debit Special Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Other Credit Special Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Amount of Credit Special Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Total Amount of Debit Special Adjustments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Provider A/R Totals - Daily Report	 276
Provider A/R Totals - Standard Report	 278
Analysis Summary Report - Daily	 8

Total Amount of Other Applied Credit Special Adjust-
ments

Day Sheet Report	 100
Total Amount of Other Credit Special Adjustments

Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Specialty
Specialty

Practice Organization List	 254
Spouse

Best Time to Call Spouse
Patient Questionnaire	 222

Spouse Address
Patient Questionnaire	 222

Spouse Birth Date
Patient Questionnaire	 222

Spouse Drivers License Number
Patient Questionnaire	 222

Spouse Email Address
Patient Questionnaire	 222

Spouse Fax Number
Patient Questionnaire	 222

Spouse Gender
Patient Questionnaire	 222

Spouse Home Phone Number
Patient Questionnaire	 222

Spouse Mobile Number
Patient Questionnaire	 222

Spouse Name
Patient Questionnaire	 222

Spouse Other Number
Patient Questionnaire	 222

Spouse Social Security Number
Patient Questionnaire	 222

Spouse Work Phone Extension
Patient Questionnaire	 222

Spouse Work Phone Number
Patient Questionnaire	 222

Staff
Staff ID

Audit Report - Providers/Staff	 36
Appointment Book View Printout	 14

Staff ID Change
Audit Report - Providers/Staff	 36

Staff Name
Audit Report - Providers/Staff	 36

Staff Name Change
Audit Report - Providers/Staff	 36

Staff Signature
Treatment Case Report	 326

Staff Social Security Number
Audit Report - Providers/Staff	 36

Staff Social Security Number Change
Audit Report - Providers/Staff	 36

Standard
Amount of Standard Deductible Owed by Family to 
Primary Insurance

Patient Route Slip	 226
Amount of Standard Deductible Owed by Family to 
Secondary Insurance

Patient Route Slip	 226
Amount of Standard Deductible Owed to Primary Insur-
ance

Patient Route Slip	 226
Amount of Standard Deductible Owed to Secondary 
Insurance

Patient Route Slip	 226
Lifetime/Individual/Standard Deductible

Insurance Carrier List	 138
Lifetime/Individual/Standard Other Deductible

Insurance Carrier List	 138
Lifetime/Individual/Standard Preventative Deductible

Insurance Carrier List	 138
Standard Deductible Met

Insurance Carrier List	 138
Standard Deductible Owed by Family to Primary Insur-
ance

Treatment Case Report	 326
Standard Deductible Owed by Family to Secondary 
Insurance

Treatment Case Report	 326
Standard Deductible Owed by Patient to Primary Insur-
ance

Treatment Case Report	 326
Patient Treatment Case Report	 228

Standard Deductible Owed by Patient to Secondary 
Insurance

Treatment Case Report	 326
Patient Treatment Case Report	 228

State
Guarantor State

Collections Manager List	 70
Insurance Carrier City and State

Insurance Eligibility Report	 152
Patient State

Patient List (Filtered)	 214
Letter Merge Reports	 158

Practice City State and ZIP Code
Letter Merge Reports	 158

Special Adjustment (continued)



Index by Report Item   567

Dentrix Enterprise 11.0.2 Reports Reference

Practice State
Registration Information Report	 306

State ID
Provider State ID

Provider IDs List	 284
State ID

Practice Organization List	 254
Statement

Last Statement Date
Collections Manager List	 70
Patient Route Slip	 226
Aging/Credit Balance Report	 6

Statement Note
Patient Notes Report	 216

Status
Appointment Status

As Soon As Possible List	 22
Audit Report - Appointments	 26
Daily Appointment List (DX1)	 84
Daily Appointment List Report	 86
Operatory Appointment List Report	 196
Patient Chart and Progress Notes Printout	 202
Unscheduled Appointment List (DX1)	 356
Unscheduled Appointment List (OM)	 358
Appointment Cycle Time Report	 16

Appointment Status Change
Audit Report - Appointments	 26

Appointment Statuses
Custom Practice Information Report	 82

Claim On Hold Date
Insurance Claim Aging Report	 146

Claim Re-sent Date
Insurance Claim Aging Report	 146

Claim Sent Date
Insurance Transaction Analysis Report	 154
Insurance Claim Aging Report	 146

Claim Tracer Date
Insurance Claim Aging Report	 146

Continuing Care Status
Continuing Care Display List	 76

Document Status
Document Center Documents Audited Report	
118

Length in Appointment Status
Appointment Cycle Time Report	 16

Number of Patients with Status
UDS - Patient Status Report	 350

Number of Patients with Status for Clinic
UDS - Patient Status Report	 350

Number of Patients with Status for Provider
UDS - Patient Status Report	 350

Patient Homeless Status
Patient List (Filtered)	 214

Patient Marital Status
Insurance Carrier List	 138
Letter Merge Reports	 158
Patient List	 212
Patient Route Slip	 226
Employers and Employed Patients Report	 122

Patient Status
Letter Merge Reports	 158
New Patient List	 190
Patient List	 212
Audit Report - Patients	 34

Patient Status Change
Audit Report - Patients	 34

Patient Veteran Status
Patient List (Filtered)	 214

Patient Worker Status
Patient List (Filtered)	 214

Payment Status
Credit Card Transaction Report	 80

Pre-treatment Estimate On Hold Date
Pre-Treatment Estimate Aging Report	 262

Pre-treatment Estimate Re-sent Date
Pre-Treatment Estimate Aging Report	 262

Pre-treatment Estimate Sent Date
Pre-Treatment Estimate Aging Report	 262

Pre-treatment Estimate Tracer Date
Pre-Treatment Estimate Aging Report	 262

Primary Pre-treatment Estimate Sent Date
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Referral Status
Referred To Doctor Report	 304

Secondary Pre-treatment Estimate Sent Date
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Status of Access
Patient Information Accessed Report	 208

Status of Setting
Audit Report - Audit Log Status	 28

Subscriber Marital Status
Insurance Carrier List	 138

Total Amount of Pre-treatment Estimates not Sent
Pre-Treatment Estimates Not Sent Report	 264

Total Amount of Primary and Secondary Claims not Sent
Insurance Claims Not Sent Report	 148

Total Amount of Primary Claims not Sent
Insurance Claims Not Sent Report	 148

Total Amount of Primary Pre-treatment Estimates not 
Sent

Pre-Treatment Estimates Not Sent Report	 264
Total Amount of Secondary Claims not Created

Secondary Insurance Claims Not Created Report	
318

Total Amount of Secondary Claims not Sent
Insurance Claims Not Sent Report	 148

Total Amount of Secondary Pre-treatment Estimates not 
Created

Secondary Pre-Treatment Estimates Not Created 
Report	 320

Total Amount of Secondary Pre-treatment Estimates not 
Sent

Pre-Treatment Estimates Not Sent Report	 264
Total Length in Appointment Statuses

Appointment Cycle Time Report	 16
Total Number of Patients (any Status)

Practice Statistics Report	 256
Total Number of Patients with Statuses

UDS - Patient Status Report	 350

State (continued)
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Treatment Plan Approval Status
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Patient Chart and Progress Notes Printout	 202

Treatment Plan Status
Patient Route Slip	 226

Subscriber
Beneficiary ID

Dental Encounters Report	 106
Number of Subscribers

Insurance Carrier List	 138
Patient Relationship to Subscriber for Primary Insurance

Patient Questionnaire	 222
Patient Relationship to Subscriber for Secondary Insur-
ance

Patient Questionnaire	 222
Primary Insurance Subscriber ID

Letter Merge Reports	 158
Relation to Subscriber

Walkout - Doctor’s Statement	 368
Secondary Subscriber ID

Letter Merge Reports	 158
Subscriber Address for Primary Insurance

Patient Questionnaire	 222
Subscriber Address for Secondary Insurance

Patient Questionnaire	 222
Subscriber Birth Date

Walkout - Doctor’s Statement	 368
Insurance Carrier List	 138

Subscriber Birth Date for Primary Insurance
Patient Questionnaire	 222

Subscriber Birth Date for Secondary Insurance
Patient Questionnaire	 222

Subscriber Chart Number
Insurance Carrier List	 138

Subscriber Employer Name
Insurance Carrier List	 138

Subscriber ID
Insurance Carrier List	 138
Insurance Claim Aging Report	 146
Insurance Eligibility Report	 152
Insurance Transaction Analysis Report	 154
Pre-Treatment Estimate Aging Report	 262
RVU Utilization Report	 316
Utilization Report	 366
Walkout - Doctor’s Statement	 368
Dental Encounters Report	 106

Subscriber ID for Primary Insurance
Patient Questionnaire	 222

Subscriber ID for Secondary Insurance
Patient Questionnaire	 222

Subscriber Marital Status
Insurance Carrier List	 138

Subscriber Name
Insurance Claim Aging Report	 146
Insurance Eligibility Report	 152
Pre-Treatment Estimate Aging Report	 262
RVU Utilization Report	 316
Utilization Report	 366
Insurance Carrier List	 138

Subscriber Name for Primary Insurance
Patient Route Slip	 226
Patient Questionnaire	 222

Subscriber Name for Secondary Insurance
Patient Route Slip	 226
Patient Questionnaire	 222

Subscriber’s Employer Address for Primary Insurance
Patient Questionnaire	 222

Subscriber’s Employer Address for Secondary Insurance
Patient Questionnaire	 222

Subscriber’s Employer Name for Primary Insurance
Patient Questionnaire	 222

Subscriber’s Employer Name for Secondary Insurance
Patient Questionnaire	 222

Substitution
Generic Substitution Permitted

Prescription Printout	 260
Summary of Care

Number of Incorporated Electronic Summary of Care 
Documents

Meaningful Use Measure Calculation List	 162
Number of TCs (Transition of Care) and Referrals where 
SCs (Summary of Care) Provided

Meaningful Use Measure Calculation List	 162
Number of TCs (Transition of Care) and Referrals where 
SCs (Summary of Care) Was Exchanged Electronically

Meaningful Use Measure Calculation List	 162
Suppuration

Suppuration
Perio - Data Chart Report	 240
Perio - Combined Graphic & Data Chart Report	
238

Surface
Tooth Surface

Patient Treatment Case Report	 228
Perio - Combined Graphic & Data Chart Report	
238
Perio - Data Chart Report	 240
Perio - Exam Comparison Report	 242
Perio - Pocket Depths Only Report	 246
Practice Treatment Case Report	 258
RVU Utilization Report	 316
Treatment Case Report	 326
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Utilization Report	 366
Walkout - Doctor’s Statement	 368
Walkout - Family Walkout	 370
Patient Chart and Progress Notes Printout	 202

Tooth Surface of Completed Treatment
Referral Recap Report	 296

Tooth Surface of Treatment Still in Progress
Referral Recap Report	 296

Tooth Surface of Treatment-planned Procedure
Referral Slip	 298

Suspended
Account Suspended Credit Amount

Patient Route Slip	 226
Amount of Current Suspended Credit Adjustments for 
Provider

Day Sheet (Charges and Receipts) Report	 94

Status (continued)
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Amount of Current Suspended Payments for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of MTD Suspended Credit Adjustments for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Suspended Payments for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Suspended Credit Adjustments for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Credit Adjustments for Previous 
Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Suspended Credit Adjustments for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Credits
Aging/Credit Balance Report	 6

Amount of Suspended Credits for Guarantor
Suspended Credits Report	 324

Amount of Suspended Insurance Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Insurance Payments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Payments for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Suspended Payments for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of YTD Suspended Credit Adjustments for Prov
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Suspended Payments for Provider
Day Sheet (Charges and Receipts) Report	 94

Patient Suspended Credit Amount
Patient Route Slip	 226

Suspended Amount
Suspended Credits Report	 324

Suspended Amount on Ledger
Suspended Credits Report	 324

Suspended Credit Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Suspended Credit Amount
Continuing Care Display List	 76

Suspended Credit Amount for Clinic
Aging/Credit Balance Report	 6

Suspended Credits
Practice Analysis Report	 252

Suspended Insurance Payment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Suspended Payment Amount
Analysis Summary Report - Daily	 8

Total Amount of Current Suspended Credit Adjust-
ments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Current Suspended Payments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of MTD Suspended Credit Adjustments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of MTD Suspended Payments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Suspended Credit Adjustments

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Suspended Credit Adjustments for 
Previous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Suspended Credits for Clinic

Suspended Credits Report	 324
Total Amount of Suspended Insurance Payments

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Suspended Payments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Suspended Payments for Previous 
Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of YTD Suspended Credit Adjustments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of YTD Suspended Payments

Day Sheet (Charges and Receipts) Report	 94
Total Suspended Credits

Aging/Credit Balance Report	 6
Suspended Adjustment

Amount of Current Suspended Credit Adjustments for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Suspended Credit Adjustments for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Suspended Amount

Suspended Amount
Suspended Credits Report	 324

Suspended Amount on Ledger
Suspended Credits Report	 324

Suspended Credit
Account Suspended Credit Amount

Patient Route Slip	 226
Amount of Suspended Credits

Aging/Credit Balance Report	 6
Amount of Suspended Credits for Guarantor

Suspended Credits Report	 324
Patient Suspended Credit Amount

Patient Route Slip	 226

Suspended (continued)
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Percent of Suspended Credits
Aging/Credit Balance Report	 6

Suspended Credit Amount
Continuing Care Display List	 76

Suspended Credit Amount for Clinic
Aging/Credit Balance Report	 6

Suspended Credits
Practice Analysis Report	 252

Total Amount of Suspended Credits for Clinic
Suspended Credits Report	 324

Total Suspended Credits
Aging/Credit Balance Report	 6

Suspended Credit Adjustment
Amount of Current Suspended Credit Adjustments for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Suspended Credit Adjustments for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Suspended Credit Adjustments for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Credit Adjustments for Previous 
Month for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Suspended Credit Adjustments for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of YTD Suspended Credit Adjustments for Prov
Day Sheet (Charges and Receipts) Report	 94

Suspended Credit Adjustment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Total Amount of Current Suspended Credit Adjust-
ments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of MTD Suspended Credit Adjustments

Day Sheet (Charges and Receipts) Report	 94
Total Amount of Suspended Credit Adjustments

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Suspended Credit Adjustments for 
Previous Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of YTD Suspended Credit Adjustments

Day Sheet (Charges and Receipts) Report	 94
Suspended Insurance Payment

Amount of Suspended Insurance Payments for Provider
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Suspended Insurance Payments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Suspended Payment
Amount of Current Suspended Payments for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of MTD Suspended Payments for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Suspended Insurance Payments for Clinic

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Payments for Clinic
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of Suspended Payments for Previous Month for 
Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of Suspended Payments for Provider

Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Amount of YTD Suspended Payments for Provider
Day Sheet (Charges and Receipts) Report	 94

Suspended Insurance Payment Amount
Analysis Summary Report - Standard	 12
Analysis Summary Report - Daily	 8

Suspended Payment
Analysis Summary Report - Standard	 12

Suspended Payment Amount
Analysis Summary Report - Daily	 8

Total Amount of Current Suspended Payments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of MTD Suspended Payments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of Suspended Payments
Analysis Summary Report - Standard	 12
Day Sheet Report	 100
Analysis Summary Report - Daily	 8

Total Amount of Suspended Payments for Previous 
Month

Day Sheet (Charges and Receipts) Report	 94
Total Amount of YTD Suspended Payments

Day Sheet (Charges and Receipts) Report	 94
Tax

Tax Identification Number
Practice Organization List	 254

Tax Identification Number
Clinic TIN Number

Provider IDs List	 284
Provider Social Security Number or TIN Number

Walkout - Doctor’s Statement	 368
Provider TIN Number

Provider IDs List	 284
Tax Identification Number

Practice Organization List	 254
Temporary

Permanent/Temporary
Multi-Code List	 188

Terminal
Terminal Name

Credit Card Transaction Report	 80

Suspended Credit (continued)
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Time
Appointment Date and Time

Insurance Eligibility Report	 152
Appointment Time

As Soon As Possible List	 22
Audit Report - Appointments	 26
Daily Appointment List (DX1)	 84
Daily Appointment List Report	 86
Letter Merge Reports	 158
Operatory Appointment List Report	 196
Patient List (Filtered)	 214
Walkout - Family Walkout	 370
Appointment Reminder Cards	 18

Appointment Time Change
Audit Report - Appointments	 26

Average Length of Time Between Appointment Sta-
tuses

Appointment Statistics Report	 20
Average Wait Time

Appointment Cycle Time Report	 16
Best Time to Call

Collections Manager List	 70
Best Time to Call Patient

Patient Questionnaire	 222
Best Time to Call Spouse

Patient Questionnaire	 222
Clinical Note Time

Clinical Notes Report	 64
Future Appointment Time

Patient Route Slip	 226
Immunization Time

Patient List (Filtered)	 214
Median Wait Time

Appointment Cycle Time Report	 16
Next Appointment Time

Patient Route Slip	 226
Next Continuing Care Appointment Time

Letter Merge Reports	 158
Number of Appointments in Appointment Status for or 
Longer than Length of Time

Appointment Statistics Report	 20
Number of Appointments in Appointment Status Less 
than Length of Time

Appointment Statistics Report	 20
Office Journal Entry Time

Office Journal Report	 192
Percent of Appointments in Appointment Status for or 
Longer than Length of Time

Appointment Statistics Report	 20
Time

Appointment Book View Printout	 14
Time Limit

Insurance Carrier List	 138
Time of Access

Patient Information Accessed Report	 208
Time of Change

Audit Report - Appointments	 26
Audit Report - Audit Log Status	 28
Audit Report - Clinics	 30
Audit Report - Combined	 32
Audit Report - Patients	 34
Audit Report - Providers/Staff	 36

Audit Report - Transactions	 38
Audit Rights Report - Assigned Individually	 40
Audit Rights Report - Assigned to Groups	 42
Audit Rights Report - Group Names	 44
Audit Rights Report - Users to Groups	 46
Appointment Cycle Time Report	 16

Time Units
Procedure Code List	 266
Multi-Code List	 188

Wait Time
Appointment Cycle Time Report	 16

Time Block
Time Blocks

Appointment Book View Printout	 14
TIN

Clinic TIN Number
Provider IDs List	 284

Provider Social Security Number or TIN Number
Walkout - Doctor’s Statement	 368

Provider TIN Number
Provider IDs List	 284

Tax Identification Number
Practice Organization List	 254

Title
Patient Title

Letter Merge Reports	 158
Practice Title

Registration Information Report	 306
Audit Report - Clinics	 30

Practice Title Change
Audit Report - Clinics	 30

Provider Title
Practice Organization List	 254
Provider IDs List	 284
Letter Merge Reports	 158

Referred by Source Title
Letter Merge Reports	 158

Referred to Title
Letter Merge Reports	 158

Tobacco
Number of Patients 18+ Years who Use Tobacco and 
Received Cessation Counseling

Clinical Quality Measures List	 66
Percent of Patients with Using Tobacco

Caries Prevalence and Periodontal Index Report	
52

Tobacco Cessation Counseling
Number of Tobacco Users 18+ Years with Tobacco Use 
Assessment and Tobacco Cessation Counseling or 
Tobacco Cessation Pharmacotherapy

UDS - Tobacco Use and Intervention Report	 354
Tobacco Cessation Pharmacotherapy

Number of Tobacco Users 18+ Years with Tobacco Use 
Assessment and Tobacco Cessation Counseling or 
Tobacco Cessation Pharmacotherapy

UDS - Tobacco Use and Intervention Report	 354
Tobacco Non-user

Number of Tobacco Non-users 18+ Years with Tobacco 
Use Assessment

UDS - Tobacco Use and Intervention Report	 354
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Tobacco Use Assessment
Number of Tobacco Non-users 18+ Years with Tobacco 
Use Assessment

UDS - Tobacco Use and Intervention Report	 354
Number of Tobacco Users 18+ Years with Tobacco Use 
Assessment and Tobacco Cessation Counseling or 
Tobacco Cessation Pharmacotherapy

UDS - Tobacco Use and Intervention Report	 354
Tobacco User

Number of Tobacco Users 18+ Years with Tobacco Use 
Assessment and Tobacco Cessation Counseling or 
Tobacco Cessation Pharmacotherapy

UDS - Tobacco Use and Intervention Report	 354
Tooth

Mandibular Tooth Number
Perio - Data Chart Report	 240
Perio - Pocket Depths Only Report	 246
Perio - Combined Graphic & Data Chart Report	
238

Maxillary Tooth Number
Perio - Data Chart Report	 240
Perio - Exam Comparison Report	 242
Perio - Pocket Depths Only Report	 246
Perio - Combined Graphic & Data Chart Report	
238

Mean Number of Sealed Teeth
Caries Prevalence and Periodontal Index Report	
52

Number of Patients 0 - 19 Years with Tooth Decay or 
Cavities

Clinical Quality Measures List	 66
Tooth Code

Perio - Data Chart Report	 240
Perio - Pocket Depths Only Report	 246
Perio - Combined Graphic & Data Chart Report	
238

Tooth Number
Insurance Transaction Analysis Report	 154
Operator Day Sheet Report	 194
Patient Chart and Progress Notes Printout	 202
Patient Ledger Report	 210
Patient Treatment Case Report	 228
Practice Treatment Case Report	 258
Procedures Not Attached to Insurance Report	270
RVU Day Sheet Report	 308
RVU Utilization Report	 316
Treatment Case Report	 326
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Unscheduled Treatment Plans (Detailed) Report	
362
Utilization Report	 366
Walkout - Doctor’s Statement	 368
Walkout - Family Walkout	 370
Day Sheet (Charges and Receipts) Report	 94

Tooth Number for Today’s Completed Work
Patient Chart Printout	 204

Tooth Number for Treatment-planned Procedure
Patient Chart Printout	 204

Tooth Number of Completed Treatment
Referral Recap Report	 296

Tooth Number of Treatment Still in Progress
Referral Recap Report	 296

Tooth Number of Treatment-Planned Procedure
Referral Slip	 298

Tooth Surface
Patient Treatment Case Report	 228
Perio - Combined Graphic & Data Chart Report	
238
Perio - Data Chart Report	 240
Perio - Exam Comparison Report	 242
Perio - Pocket Depths Only Report	 246
Practice Treatment Case Report	 258
RVU Utilization Report	 316
Treatment Case Report	 326
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Utilization Report	 366
Walkout - Doctor’s Statement	 368
Walkout - Family Walkout	 370
Patient Chart and Progress Notes Printout	 202

Tooth Surface of Completed Treatment
Referral Recap Report	 296

Tooth Surface of Treatment Still in Progress
Referral Recap Report	 296

Tooth Surface of Treatment-planned Procedure
Referral Slip	 298

Tracer
Claim Tracer Date

Insurance Claim Aging Report	 146
Pre-treatment Estimate Tracer Date

Pre-Treatment Estimate Aging Report	 262
Transaction

ADA Code Description or Transaction Description
Operator Day Sheet Report	 194

Deleted Transaction
Audit Report - Transactions	 38

Inserted Transaction
Audit Report - Transactions	 38

Total Amount of Transacations
Credit Card Transaction Report	 80

Total Number of Transactions
Credit Card Transaction Report	 80

Transaction Amount
Credit Card Transaction Report	 80
Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Suspended Credits Report	 324
Audit Report - Transactions	 38

Transaction Amount Change
Audit Report - Transactions	 38

Transaction Date
Family Ledger Report	 124
Family Ledger Report (Single Family)	 126
Insurance Transaction Analysis Report	 154
Patient’s Ledger Report	 230
Credit Card Transaction Report	 80

Transaction Description
Family Ledger Report	 124
Family Ledger Report (Single Family)	 126
Insurance Transaction Analysis Report	 154
Patient’s Ledger Report	 230
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Provider Revenue - Allocations Report	 286
Provider Revenue - Charges Report	 288
Provider Revenue - Credits Report	 290
Suspended Credits Report	 324
Audit Report - Transactions	 38

Transaction Description Change
Audit Report - Transactions	 38

Transaction ID
Credit Card Transaction Report	 80

Transaction Type/Code
Insurance Transaction Analysis Report	 154

Transaction Status
Payment Status

Credit Card Transaction Report	 80
Transition of Care

Number of TCs (Transition of Care)
Meaningful Use Measure Calculation List	 162

Number of TCs (Transition of Care) and Referrals
Meaningful Use Measure Calculation List	 162

Number of TCs (Transition of Care) and Referrals where 
Clinical Information Reconciliation Was Performed

Meaningful Use Measure Calculation List	 162
Number of TCs (Transition of Care) and Referrals where 
Electronic SCs (Summary of Care) Provided

Meaningful Use Measure Calculation List	 162
Number of TCs (Transition of Care) and Referrals where 
SCs (Summary of Care) Provided

Meaningful Use Measure Calculation List	 162
Number of TCs (Transition of Care) and Referrals where 
SCs (Summary of Care) Was Exchanged Electronically

Meaningful Use Measure Calculation List	 162
Number of TCs (Transition of Care) where Medication 
Reconciliation Was Performed

Meaningful Use Measure Calculation List	 162
Transmit

Number of Patients who Viewed or Downloaded or 
Transmitted (VDT) Electronic Health Information

Meaningful Use Measure Calculation List	 162
Treatment

ADA Code Description for Today’s Completed Work
Patient Chart Printout	 204

ADA Code Description of Completed Treatment
Referral Recap Report	 296

ADA Code Description of Treatment Still in Progress
Referral Recap Report	 296

ADA Code of Completed Treatment
Referral Recap Report	 296

ADA Code of Treatment Still in Progress
Referral Recap Report	 296

Amount for Today’s Completed Work
Patient Chart Printout	 204

Amount of Completed Procedures for Patient
Procedures Not Attached to Insurance Report	270

Continuing Care Prior Work Date
Letter Merge Reports	 158

Date of Completed Treatment
Referral Recap Report	 296

Tooth Number for Today’s Completed Work
Patient Chart Printout	 204

Tooth Number of Completed Treatment
Referral Recap Report	 296

Tooth Surface of Completed Treatment
Referral Recap Report	 296

Total Amount of Charges for Today’s Completed Work
Patient Chart Printout	 204

Treatment Area
Next Appointment Treatment Area

Patient Route Slip	 226
Tooth Surface

Patient Treatment Case Report	 228
Perio - Combined Graphic & Data Chart Report	
238
Perio - Data Chart Report	 240
Perio - Exam Comparison Report	 242
Perio - Pocket Depths Only Report	 246
Practice Treatment Case Report	 258
RVU Utilization Report	 316
Treatment Case Report	 326
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Utilization Report	 366
Walkout - Doctor’s Statement	 368
Walkout - Family Walkout	 370
Patient Chart and Progress Notes Printout	 202

Tooth Surface of Completed Treatment
Referral Recap Report	 296

Tooth Surface of Treatment Still in Progress
Referral Recap Report	 296

Treatment Area
Family Ledger Report	 124
Family Ledger Report (Single Family)	 126
Multi-Code List	 188
Patient’s Ledger Report	 230
Procedure Code List	 266
Dental Diagnostic Code List	 104

Treatment In Progress
ADA Code Description of Treatment Still in Progress

Referral Recap Report	 296
Referred Date of Treatment Still in Progress

Referral Recap Report	 296
Tooth Number of Treatment Still in Progress

Referral Recap Report	 296
Tooth Surface of Treatment Still in Progress

Referral Recap Report	 296
Treatment Plan

ADA Code Description for Treatment-planned Proce-
dure

Patient Chart Printout	 204
ADA Code Description of Treatment-planned Proce-
dure

Referral Slip	 298
ADA Code of Treatment-planned Procedure

Referral Slip	 298
Alternate Case Name

Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Office Portion for Case
Patient Treatment Case Report	 228

Transaction (continued)
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Amount of Patient Portion for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Amount of Primary Insurance Portion for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Amount of Secondary Insurance Portion for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Amount of Treatment-planned Procedure
Patient Chart Printout	 204

Case Comments
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Case Expiration Date
Practice Treatment Case Report	 258

Case Finance Status
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Case Name
Patient Treatment Case Report	 228
Practice Treatment Case Report	 258
Patient Proposed Treatment Case Report (Your 
Care Plan)	 220

Case Notes
Treatment Case Report	 326
Patient Treatment Case Report	 228

Case Priority
Patient Treatment Case Report	 228

Case Severity
Practice Treatment Case Report	 258

Case Status
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Date of Last Case Status Update
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Date of Treatment-planned Procedure
Referral Slip	 298

Fee for Case
Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Next Appointment Treatment Plan Visit
Patient Route Slip	 226

Number of Scheduled Treatment-planned Procedures
Practice Treatment Case Report	 258

Number of Unscheduled Treatment-planned Proce-
dures

Practice Treatment Case Report	 258
Percent of Accepted Cases

Practice Treatment Case Report	 258
Percent of Completed Cases

Practice Treatment Case Report	 258
Percent of Pre-authorized Cases

Practice Treatment Case Report	 258
Percent of Referred Cases

Practice Treatment Case Report	 258
Percent of Scheduled Cases

Practice Treatment Case Report	 258

Pre-authorization Required
Standard Coverage Tables Report	 322
Insurance Coverage Tables Report	 150

Tooth Number for Treatment-planned Procedure
Patient Chart Printout	 204

Tooth Number of Treatment-Planned Procedure
Referral Slip	 298

Tooth Surface of Treatment-planned Procedure
Referral Slip	 298

Total Amount of Patient Portion for Case
Treatment Case Report	 326

Total Amount of Primary Insurance Portion for Case
Treatment Case Report	 326

Total Amount of Scheduled Treatment Plans
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Total Amount of Secondary Insurance Portion for Case
Treatment Case Report	 326

Total Amount of Treatment Plan
Treatment Case Report	 326
Patient Treatment Case Report	 228

Total Amount of Treatment Plans
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Total Amount of Treatment-planned Procedures
Practice Treatment Case Report	 258
Patient Chart Printout	 204

Total Amount of Unscheduled Treatment Plans
Unscheduled Treatment Plans (Detailed) Report	
362
Unscheduled Treatment Plans (Condensed) Re-
port	 360

Total Fee for Case
Treatment Case Report	 326

Total Fee from Alternate Fee Schedule for Case
Treatment Case Report	 326

Total Number of Cases
Practice Treatment Case Report	 258

Treatment Plan Amount
Referred By Patient Report	 302
Unscheduled Treatment Plans (Condensed) Re-
port	 360
Unscheduled Treatment Plans (Detailed) Report	
362
Referred By Doctor/Other Report	 300

Treatment Plan Approval Status
Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330
Patient Chart and Progress Notes Printout	 202

Treatment Plan Status
Patient Route Slip	 226

Treatment-planned Procedure Amount
Unscheduled Treatment Plans (Detailed) Report	
362

Treatment-planned Procedure Date
Unscheduled Treatment Plans (Detailed) Report	
362
Treatment Case Report	 326

Treatment Plan Approval Status
Treatment Plan Approval Status

Treatment Plan Approval Report	 328
Treatment Plan Approval Status Report	 330

Treatment Plan (continued)
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Patient Chart and Progress Notes Printout	 202
Type

20+ Years Old for Financial Class Type
UDS - Insurance Financial Class Report	 342

Deductible Type
Standard Coverage Tables Report	 322
Insurance Coverage Tables Report	 150

Document Type
Document Center List	 120

File Type
Document Center Documents Audited Report	
118
Document Center - Documents List Report	 112

Transaction Type/Code
Insurance Transaction Analysis Report	 154

Type of Service Code
Type of Service Code

Medical Code List	 186
Type of Service Code Description

Medical Code List	 186
Uninsured

Number of Patients without Dental and Medical Insur-
ance

Practice Statistics Report	 256
Number of Patients without Dental Insurance

Practice Statistics Report	 256
Number of Patients without Medical Insurance

Practice Statistics Report	 256
Union Number

Insurance Plan Union Number
Provider IDs List	 284
Insurance Carrier List	 138

Unit
Time Units

Procedure Code List	 266
Multi-Code List	 188

Unknown
Number of Unknown Gender

UDS - Age/Gender Report	 334
Number of Unknown Gender for Clinic

UDS - Age/Gender Report	 334
Number of Unknown Gender for Provider

UDS - Age/Gender Report	 334
Unscheduled Appointment

Number of Unscheduled Appointments Listed
Unscheduled Appointment List (OM)	 358
Unscheduled Appointment List (DX1)	 356

Scheduled and/or Unscheduled Appointment
Unscheduled Treatment Plans (Detailed) Report	
362
Unscheduled Treatment Plans (Condensed) Re-
port	 360

Unscheduled Treatment
Number of Unscheduled Treatment-planned Proce-
dures

Practice Treatment Case Report	 258

Total Amount of Unscheduled Treatment Plans
Unscheduled Treatment Plans (Detailed) Report	
362
Unscheduled Treatment Plans (Condensed) Re-
port	 360

Update
Date of Last Case Status Update

Practice Treatment Case Report	 258
Patient Treatment Case Report	 228

Updated
Date Insurance Last Updated

Insurance Carrier List	 138
User

Number of Users
UDS - Encounters and Users by Selected Proce-
dure Codes Report	 338

Number of Users for Financial Class Type
UDS - Insurance Financial Class Report	 342

Number of Users for Financial Class Type for Clinic
UDS - Insurance Financial Class Report	 342

Number of Users for Financial Class Type for Provider
UDS - Insurance Financial Class Report	 342

Overriding User
Audit Report - Clinics	 30
Audit Report - Combined	 32
Audit Report - Patients	 34
Audit Report - Providers/Staff	 36
Audit Report - Transactions	 38
Audit Report - Appointments	 26

Total Number of Users for Financial Class Types
UDS - Insurance Financial Class Report	 342

User
Audit Report - Appointments	 26
Audit Report - Audit Log Status	 28
Audit Report - Clinics	 30
Audit Report - Combined	 32
Audit Report - Patients	 34
Audit Report - Providers/Staff	 36
Audit Report - Transactions	 38
Audit Rights Report - Assigned Individually	 40
Audit Rights Report - Assigned to Groups	 42
Audit Rights Report - Group Names	 44
Audit Rights Report - Users to Groups	 46
Credit Card Transaction Report	 80
Document Center - Documents List Report	 112
Document Center Documents Audited Report	
118
Patient Information Accessed Report	 208
Patient Treatment Case Report	 228
Assigned Rights Report	 24

User Changed
Audit Rights Report - Users to Groups	 46
Audit Rights Report - Assigned Individually	 40

User Defined Category
Patient User Defined Category

Patient List (Filtered)	 214
User Defined Category

UDS - Patient Status Report	 350
User Group

User Group
Audit Rights Report - Users to Groups	 46
Audit Rights Report - Assigned to Groups	 42

Treatment Plan Approval Status (continued)
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User Group Change
Audit Rights Report - Group Names	 44

Vaccine
Vaccine Abbreviated Description

Patient List (Filtered)	 214
Veteran Status

Patient Veteran Status
Patient List (Filtered)	 214

Veteran Status
UDS - Patient Status Report	 350

View
Number of Patients who Viewed or Downloaded or 
Transmitted (VDT) Electronic Health Information

Meaningful Use Measure Calculation List	 162
Visit

Amount of Office Portion for Visit
Patient Treatment Case Report	 228

Amount of Patient Portion for Visit
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Primary Insurance Portion for Visit
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Secondary Insurance Portion for Visit
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Fee for Visit
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Fee from Alternate Fee Schedule for Visit
Treatment Case Report	 326

Next Appointment Treatment Plan Visit
Patient Route Slip	 226

Number of Office Visits
Meaningful Use Measure Calculation List	 162

Number of Office Visits for Insurance Carrier
Utilization Report	 366
RVU Utilization Report	 316

Number of Office Visits where Patient Received CS 
(Clinical Summary)

Meaningful Use Measure Calculation List	 162
Number of Patients 0 - 19 Years with Visit

Clinical Quality Measures List	 66
Number of Patients 18 - 85 Years with Outpatient Visits 
(with Exclusions)

Clinical Quality Measures List	 66
Number of Patients 18+ Years with Visits

UDS - Tobacco Use and Intervention Report	 354
Clinical Quality Measures List	 66

Number of Patients 3 - 17 Years with Outpatient Visits 
(with Exclusions)

Clinical Quality Measures List	 66
Unique Visit Count for Provider

RVU Day Sheet Report	 308

Visit
Treatment Plan Approval Status Report	 330
Treatment Plan Approval Report	 328

Visit Number
Practice Treatment Case Report	 258
Treatment Case Report	 326
Patient Treatment Case Report	 228

Vital Sign
Number of Patients 0 - 2 Years with Vital Sign Readings

Meaningful Use Measure Calculation List	 162
Meaningful Use Measure Calculation List	 162

Number of Patients 2+ Years with Vital Sign Readings
Meaningful Use Measure Calculation List	 162

Number of Patients 3+ Years  with Vital Sign Readings
Meaningful Use Measure Calculation List	 162

Number of Patients 3+ Years with Vital Sign Readings
Meaningful Use Measure Calculation List	 162

Number of Patients with Vital Sign Readings
Meaningful Use Measure Calculation List	 162

Vitals
Age

UDS - Age/Gender Report	 334
Patient Health Assessment Report	 206

Blood Pressure
Patient Health Assessment Report	 206

Body Mass Index
Patient Health Assessment Report	 206

Height
Patient Health Assessment Report	 206

Pulse
Patient Health Assessment Report	 206

Weight
Patient Health Assessment Report	 206

Wait
Number of Wait/Will Call Appointments

Appointment Statistics Report	 20
Weight

Weight
Patient Health Assessment Report	 206

Widowed
Number of Widowed Patients

Practice Statistics Report	 256
Percent of Widowed Patients

Practice Statistics Report	 256
Will Call

Number of Wait/Will Call Appointments
Appointment Statistics Report	 20

Work Phone
Guarantor Work Phone Number

Patient Route Slip	 226
Guarantor Work Phone Number & Extension

Collections Manager List	 70
Patient Work Phone Extension

Patient Ledger Report	 210
Patient Questionnaire	 222
Letter Merge Reports	 158

Patient Work Phone Number
Continuing Care Display List	 76
Letter Merge Reports	 158
Patient Ledger Report	 210
Patient List	 212
Patient List (Filtered)	 214

User Group (continued)
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Patient Notes Report	 216
Patient Questionnaire	 222
Patient Route Slip	 226
Appointment Book View Printout	 14

Spouse Work Phone Extension
Patient Questionnaire	 222

Spouse Work Phone Number
Patient Questionnaire	 222

Worker Status
Patient Worker Status

Patient List (Filtered)	 214
Worker Status

UDS - Patient Status Report	 350
Wrap Around

Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Financial Class Type (Current Year)

UDS - Patient Related Revenue Report	 348
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Financial Class Type (Previous Years)

UDS - Patient Related Revenue Report	 348
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Payer Category (Current Year)

UDS - Patient Related Revenue Report	 348
Subtotal of Wrap Around or Reconciliation Amount Col-
lected for Payer Category (Previous Years)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Financial Class Type (Current Year)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Financial Class Type (Previous Years)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Patient (Current Year)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Patient (Previous Years)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Payer Category (Current Year)

UDS - Patient Related Revenue Report	 348
Total Wrap Around or Reconciliation Amount Collected 
for Payer Category (Previous Years)

UDS - Patient Related Revenue Report	 348
Wrap Around or Reconciliation Amount Collected for 
Patient (Current Year)

UDS - Patient Related Revenue Report	 348
Wrap Around or Reconciliation Amount Collected for 
Patient (Previous Years)

UDS - Patient Related Revenue Report	 348
Write-off

Amount of Bad Debt Write-offs for Patient
UDS - Patient Related Revenue Report	 348

Subtotal of Bad Debt Write-offs for Financial Class Type
UDS - Patient Related Revenue Report	 348

Subtotal of Bad Debt Write-offs for Payer Category
UDS - Patient Related Revenue Report	 348

Total Amount of Bad Debt Write-offs for Financial Class 
Type

UDS - Patient Related Revenue Report	 348

Total Amount of Bad Debt Write-offs for Patient
UDS - Patient Related Revenue Report	 348

Total Amount of Bad Debt Write-offs for Payer Category
UDS - Patient Related Revenue Report	 348

Year
Number of New Patients (in Month and Year)

Practice Statistics Report	 256
Number of Patients Due for Prophy (on Month and Year)

Practice Statistics Report	 256
Number of Referred New Patients (in Month and Year)

Practice Statistics Report	 256
Percent of Patients Due for Prophy (Month and Year)

Practice Statistics Report	 256
Percent of Referred New Patients (in Month and Year)

Practice Statistics Report	 256
Practice Fiscal Year Month

Registration Information Report	 306
Year

Future Due Payment Plan Report - Monthly Totals	
132

Years as Patient
Patient Route Slip	 226

YTD
Amount of Debit Adjustments (YTD)

Practice Analysis Report	 252
Amount of Estimated Primary Insurance Benefits Re-
maining YTD for Family

Treatment Case Report	 326
Amount of Estimated Primary Insurance Benefits Re-
maining YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Estimated Secondary Insurance Benefits 
Remaining YTD for Family

Treatment Case Report	 326
Amount of Estimated Secondary Insurance Benefits 
Remaining YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Finance Charges (YTD)
Practice Analysis Report	 252

Amount of Finance Charges YTD
Walkout - Family Walkout	 370

Amount of Guarantor Payments YTD
Walkout - Family Walkout	 370

Amount of Insurance Payments YTD
Walkout - Family Walkout	 370

Amount of Insured Charges (YTD)
Practice Analysis Report	 252

Amount of Late Charges (YTD)
Practice Analysis Report	 252

Amount of Late Charges YTD
Walkout - Family Walkout	 370

Amount of Non-insured Charges (YTD)
Practice Analysis Report	 252

Amount of Other Debit Adjustments (YTD)
Practice Analysis Report	 252

Amount of Pending Estimated Primary Insurance Por-
tions YTD for Family

Treatment Case Report	 326

Work Phone (continued)
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Amount of Pending Estimated Primary Insurance Por-
tions YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Pending Estimated Secondary Insurance 
Portions YTD for Family

Treatment Case Report	 326
Amount of Pending Estimated Secondary Insurance 
Portions YTD for Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of Primary Insurance Paid Benefits YTD for 
Family

Treatment Case Report	 326
Amount of Primary Insurance Paid Benefits YTD for 
Patient

Treatment Case Report	 326
Patient Treatment Case Report	 228

Amount of YTD Applied Credit Adjustments for Pro-
vider

Day Sheet (Charges and Receipts) Report	 94
Amount of YTD Applied Payments for Provider

Day Sheet (Charges and Receipts) Report	 94
Amount of YTD Charge Adjustments for Provider

Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Charges Billed to Insurance for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Finance Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Late Charges for Provider
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Suspended Credit Adjustments for Prov
Day Sheet (Charges and Receipts) Report	 94

Amount of YTD Suspended Payments for Provider
Day Sheet (Charges and Receipts) Report	 94

Beginning Balance (YTD)
Practice Analysis Report	 252

Ending Balance (YTD)
Practice Analysis Report	 252

New Patients (YTD)
Practice Analysis Report	 252

Number of New Patients YTD
Day Sheet (Charges and Receipts) Report	 94

Number of New Patients YTD for Provider
Day Sheet (Charges and Receipts) Report	 94

Referred Patients (YTD)
Practice Analysis Report	 252

Subtotal of Charges (YTD)
Practice Analysis Report	 252

Total Amount of YTD Applied Credit Adjustments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Applied Payments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Charge Adjustments
Day Sheet (Charges and Receipts) Report	 94
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Charges Billed to Insurance
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Finance Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Finance Charges for Family
Family Ledger Report (Single Family)	 126

Total Amount of YTD Insurance Payments for Family
Family Ledger Report (Single Family)	 126
Family Ledger Report	 124

Total Amount of YTD Late Charges
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Late Charges for Family
Family Ledger Report (Single Family)	 126
Family Ledger Report	 124

Total Amount of YTD Payments for Family
Family Ledger Report (Single Family)	 126
Family Ledger Report	 124

Total Amount of YTD Suspended Credit Adjustments
Day Sheet (Charges and Receipts) Report	 94

Total Amount of YTD Suspended Payments
Day Sheet (Charges and Receipts) Report	 94

Total Charges (YTD)
Practice Analysis Report	 252

Total YTD Finance Charges for Family
Family Ledger Report	 124

Zero
Replace Initial Zero of Procedure Code on Claims

Insurance Carrier List	 138
ZIP Code

Number of Charts Sampled in ZIP Code
UDS - Sealant Statistics Report	 352

Number of Medicaid and Medicare Patients in First Age 
Group in ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in Second 
Age Group in ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid and Medicare Patients in ZIP 
Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in First Age Group in ZIP 
Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in Second Age Group in 
ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicaid Patients in ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in First Age Group in ZIP 
Code

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in Second Age Group in 
ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Medicare Patients in ZIP Code

UDS - Medicaid/Medicare Report	 346
Number of Patients in ZIP Code

Practice Statistics Report	 256
Number of Patients with Moderate to High Risk of Car-
ies in ZIP Code

UDS - Sealant Statistics Report	 352
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Number of Patients with Moderate to High Risk of Car-
ies who Got Sealants on Permanent First Molars in ZIP 
Code

UDS - Sealant Statistics Report	 352
Number of Patients without a ZIP Code

Practice Statistics Report	 256
Patient ZIP Code

Patient List (Filtered)	 214
Letter Merge Reports	 158

Percent of Patients in ZIP Code
Practice Statistics Report	 256

Percent of Patients without a ZIP Code
Practice Statistics Report	 256

Practice City State and ZIP Code
Letter Merge Reports	 158

Practice ZIP Code
Registration Information Report	 306

ZIP Code
UDS - Insurance Financial Class Report (2013)	344
UDS - Medicaid/Medicare Report	 346
UDS - Patient Status Report	 350
UDS - Sealant Statistics Report	 352
UDS - Tobacco Use and Intervention Report	 354
Practice Statistics Report	 256


	Introduction
	Adjustment Summary Report
	Aging/Credit Balance Report
	Analysis Summary Report - Daily
	Analysis Summary Report - Standard
	Appointment Book View Printout
	Appointment Cycle Time Report
	Appointment Reminder Cards
	Appointment Statistics Report
	As Soon As Possible List
	Assigned Rights Report
	Audit Report - Appointments
	Audit Report - Audit Log Status
	Audit Report - Clinics
	Audit Report - Combined
	Audit Report - Patients
	Audit Report - Providers/Staff
	Audit Report - Transactions
	Audit Rights Report - Assigned Individually
	Audit Rights Report - Assigned to Groups
	Audit Rights Report - Group Names
	Audit Rights Report - Users to Groups
	Billing Statement
	Birthday List
	Caries Prevalence and Periodontal Index Report
	Clinical Notes Report
	Clinical Quality Measures List
	Collections Manager List
	Continuing Care Cards - No Appointment
	Continuing Care Cards - with Appointment
	Continuing Care Display List
	Coupon Book - Future Due Payments
	Coupon Book - Payment Agreements
	Credit Card Transaction Report
	Custom Practice Information Report
	Daily Appointment List (DX1)
	Daily Appointment List Report
	Daily Summary Report
	Day Sheet (Adjustments) Report
	Day Sheet (Charges and Receipts) Report
	Day Sheet (Receipts) Report
	Day Sheet Report
	Dental Diagnostic Code List
	Dental Encounters Report
	Deposit Slip
	Document Center - Documents List Report
	Document Center Audit Documents Report
	Document Center Document
	Document Center Documents Audited Report
	Document Center List
	Employers and Employed Patients Report
	Family Ledger Report
	Family Ledger Report (Single Family)
	Fee Schedules Report
	Finance Charge Report
	Future Due Payment Plan Report - Monthly Totals
	Future Due Payment Plan Report - Standard
	Initial Health History Report
	Insurance Carrier List
	Insurance Carrier Production - Full Report
	Insurance Carrier Production - Summary Report
	Insurance Claim Aging Report
	Insurance Claims Not Sent Report
	Insurance Coverage Tables Report
	Insurance Eligibility Report
	Insurance Transaction Analysis Report
	Late Charge Report
	Letter Merge Reports
	Meaningful Use Measure Calculation List
	Medical Code List
	Multi-Code List
	New Patient List
	Office Journal Report
	Operator Day Sheet Report
	Operatory Appointment List Report
	Oral Health Education Report
	Oral Health Status Report
	Patient Chart and Progress Notes Printout
	Patient Chart Printout
	Patient Health Assessment Report
	Patient Information Accessed Report
	Patient Ledger Report
	Patient List
	Patient List (Filtered)
	Patient Notes Report
	Patient Proposed Treatment Case Report (Your Care Plan)
	Patient Questionnaire
	Patient Revenue List by Payer Report
	Patient Route Slip
	Patient Treatment Case Report
	Patient’s Ledger Report
	Payment Agreement Amortization Schedule
	Payment Agreement Report
	Payment Summary Report
	Perio - Combined Graphic & Data Chart Report
	Perio - Data Chart Report
	Perio - Exam Comparison Report
	Perio - Graphic Chart Report
	Perio - Pocket Depths Only Report
	Perio Exam List
	Periodontal Exam Report
	Practice Analysis Report
	Practice Organization List
	Practice Statistics Report
	Practice Treatment Case Report
	Prescription Printout
	Pre-Treatment Estimate Aging Report
	Pre-Treatment Estimates Not Sent Report
	Procedure Code List
	Procedures by Contracted Amount Report
	Procedures Not Attached to Insurance Report
	Production Summary Report
	Provider A/R Totals - Daily Report
	Provider A/R Totals - Standard Report
	Provider IDs List
	Provider Revenue - Allocations Report
	Provider Revenue - Charges Report
	Provider Revenue - Credits Report
	Provider Revenue - Summary Report
	Referral Analysis Report
	Referral Recap Report
	Referral Slip
	Referred By Doctor/Other Report
	Referred By Patient Report
	Referred To Doctor Report
	Registration Information Report
	RVU Day Sheet Report
	RVU Production Summary Report
	RVU Schedules Report
	RVU Utilization Report
	Secondary Insurance Claims Not Created Report
	Secondary Pre-Treatment Estimates Not Created Report
	Standard Coverage Tables Report
	Suspended Credits Report
	Treatment Case Report
	Treatment Plan Approval Report
	Treatment Plan Approval Status Report
	Truth in Lending Disclosure Statement
	UDS - Age/Gender Report
	UDS - Encounters and Users by Selected Procedure Codes Report
	UDS - Encounters by Provider Report
	UDS - Insurance Financial Class Report
	UDS - Insurance Financial Class Report (2013)
	UDS - Medicaid/Medicare Report
	UDS - Patient Related Revenue Report
	UDS - Patient Status Report
	UDS - Sealant Statistics Report
	UDS - Tobacco Use and Intervention Report
	Unscheduled Appointment List (DX1)
	Unscheduled Appointment List (OM)
	Unscheduled Treatment Plans (Condensed) Report
	Unscheduled Treatment Plans (Detailed) Report
	Updated Dental Insurance Payment Table Report
	Utilization Report
	Walkout - Doctor’s Statement
	Walkout - Family Walkout
	Index by Symbol
	Index by When to Run a Report
	Index by Module
	Index of Filters by Report
	Index by Filter
	Index by Report Item
	Adjustment Summary Report
	Aging/Credit Balance Report
	Analysis Summary Report - Daily
	Analysis Summary Report - Standard
	Appointment Book View Printout
	Appointment Cycle Time Report
	Appointment Reminder Cards
	Appointment Statistics Report
	As Soon As Possible List
	Assigned Rights Report
	Audit Report - Appointments
	Audit Report - Audit Log Status
	Audit Report - Clinics
	Audit Report - Combined
	Audit Report - Patients
	Audit Report - Providers/Staff
	Audit Report - Transactions
	Audit Rights Report - Assigned Individually
	Audit Rights Report - Assigned to Groups
	Audit Rights Report - Group Names
	Audit Rights Report - Users to Groups
	Billing Statement
	Birthday List
	Caries Prevalence and Periodontal Index Report
	Clinical Notes Report
	Clinical Quality Measures List
	Collections Manager List
	Continuing Care Cards - No Appointment
	Continuing Care Cards - with Appointment
	Continuing Care Display List
	Coupon Book - Future Due Payments
	Coupon Book - Payment Agreements
	Credit Card Transaction Report
	Custom Practice Information Report
	Daily Appointment List (DX1)
	Daily Appointment List Report
	Daily Summary Report
	Day Sheet (Adjustments) Report
	Day Sheet (Charges and Receipts) Report
	Day Sheet (Receipts) Report
	Day Sheet Report
	Dental Diagnostic Code List
	Dental Encounters Report
	Deposit Slip
	Document Center - Documents List Report
	Document Center Audit Documents Report
	Document Center Document
	Document Center Documents Audited Report
	Document Center List
	Employers and Employed Patients Report
	Family Ledger Report
	Family Ledger Report (Single Family)
	Fee Schedules Report
	Finance Charge Report
	Future Due Payment Plan Report - Monthly Totals
	Future Due Payment Plan Report - Standard
	Initial Health History Report
	Insurance Carrier List
	Insurance Carrier Production - Full Report
	Insurance Carrier Production - Summary Report
	Insurance Claim Aging Report
	Insurance Claims Not Sent Report
	Insurance Coverage Tables Report
	Insurance Eligibility Report
	Insurance Transaction Analysis Report
	Late Charge Report
	Letter Merge Reports
	Meaningful Use Measure Calculation List
	Medical Code List
	Multi-Code List
	New Patient List
	Office Journal Report
	Operator Day Sheet Report
	Operatory Appointment List Report
	Oral Health Education Report
	Oral Health Status Report
	Patient Chart and Progress Notes Printout
	Patient Chart Printout
	Patient Health Assessment Report
	Patient Information Accessed Report
	Patient Ledger Report
	Patient List
	Patient List (Filtered)
	Patient Notes Report
	Patient Proposed Treatment Case Report (Your Care Plan)
	Patient Questionnaire
	Patient Revenue List by Payer Report
	Patient Route Slip
	Patient Treatment Case Report
	Patient’s Ledger Report
	Payment Agreement Amortization Schedule
	Payment Agreement Report
	Payment Summary Report
	Perio - Combined Graphic & Data Chart Report
	Perio - Data Chart Report
	Perio - Exam Comparison Report
	Perio - Graphic Chart Report
	Perio - Pocket Depths Only Report
	Perio Exam List
	Periodontal Exam Report
	Practice Analysis Report
	Practice Organization List
	Practice Statistics Report
	Practice Treatment Case Report
	Prescription Printout
	Pre-Treatment Estimate Aging Report
	Pre-Treatment Estimates Not Sent Report
	Procedure Code List
	Procedures by Contracted Amount Report
	Procedures Not Attached to Insurance Report
	Production Summary Report
	Provider A/R Totals - Daily Report
	Provider A/R Totals - Standard Report
	Provider IDs List
	Provider Revenue - Allocations Report
	Provider Revenue - Charges Report
	Provider Revenue - Credits Report
	Provider Revenue - Summary Report
	Referral Analysis Report
	Referral Recap Report
	Referral Slip
	Referred By Doctor/Other Report
	Referred By Patient Report
	Referred To Doctor Report
	Registration Information Report
	RVU Day Sheet Report
	RVU Production Summary Report
	RVU Schedules Report
	RVU Utilization Report
	Secondary Insurance Claims Not Created Report
	Secondary Pre-Treatment Estimates Not Created Report
	Standard Coverage Tables Report
	Suspended Credits Report
	Treatment Case Report
	Treatment Plan Approval Report
	Treatment Plan Approval Status Report
	Truth in Lending Disclosure Statement
	UDS - Age/Gender Report
	UDS - Encounters and Users by Selected Procedure Codes Report
	UDS - Encounters by Provider Report
	UDS - Insurance Financial Class Report
	UDS - Insurance Financial Class Report (2013)
	UDS - Medicaid/Medicare Report
	UDS - Patient Related Revenue Report
	UDS - Patient Status Report
	UDS - Sealant Statistics Report
	UDS - Tobacco Use and Intervention Report
	Unscheduled Appointment List (DX1)
	Unscheduled Appointment List (OM)
	Unscheduled Treatment Plans (Condensed) Report
	Unscheduled Treatment Plans (Detailed) Report
	Updated Dental Insurance Payment Table Report
	Utilization Report
	Walkout - Doctor’s Statement
	Walkout - Family Walkout

